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 Spatialفیلترگذاري و جلوه هايِ  _________________________

) با DOF، و چگونگی همانند سازيِ محو شدگی عمقِ میدان ( Convolveدر این بخش می توانید ساختن جلوه هايِ رایجِ فیلتر با تکمه يِ 

 را بیاموزید. ZDefocusتکمه يِ 

 Convolve تکمه هايِ به کار بردن

ید. جلوه هايِ رایجِ فیلتر را بسازبتوانید ،  فراهم می کنید دتانخوکه نگاره يِ فیلتر  از یکاین امکان را به شما می دهد که  Convolveتکمه يِ 

 ه ومرکزیت یافت پیکسل یک نگاره يِ فیلتر بر رويشود. به سخنی دیگر ،  به کار گرفته می Convolutionاین نگاره به عنوان ماتریکسِ 

متناظر در نگاره يِ فیلتر ضرب شده ، و در پایان برآیند  در ارزش هايِ پیکسلِ پیکسل ه بررسی می شوند ؛ سپس ارزشِ هرپیکسل هايِ همسای

 . این سبب می شود که بتوانیدارزشِ جدیدي براي یک پیکسل ارزیابی می گردد بدین شکل هايِ به دست آمده به همدیگر افزوده می شوند.

 ) را درست کنید.Bokeh( Lens Blur) و بر اساسِ شکلِ نگاره يِ فیلتر جلوه هايِ Defocusیک کلیپ را از فوکوس در آورده (

   
The Image Input        The Filter Input به دست آمده برآیند 

 Convolveروش کار با تکمه يِ 

درست پس از نگاره اي بنشیند که می خواهید جلوه يِ فیلترِ  Convolveکلیک کنید تا یک تکمه يِ  Filter > Convolveبر رويِ  .1

Convolution ) را بگیردimage Input.( 

 بچسبانید. Convolveرا به بیرون رفت تکمه يِ  Viewerیک تکمه يِ  .2

 روبرو می شوید. Viewerدر تکمه يِ نچسبانده اید با پیامِ خطایی  Filter نگاره اي به درون رفت چون هنوز

3.  یک نگاره يِ فیلتر را به درون رفتFilter  شکل و اندازه يِ ده يِ نشان دهنبچسبانید. این نگارهCamera Aperture  است که به

 درون رفتimage .(براي نمونه ، یک پنج گوشه اي یا شش گوشه اي) تکمه داده می شود. این نگاره می تواند هر شکلی باشد 

 < Roto )Drawاگر نگاره يِ فیلتري را ندارید می توانید به کمک تکمه يِ 

Roto ِو یا تکمه ي ، (Flare ) Draw > Flare.یکی بسازید ( 

ه يِ کوچک ید تا اندازبه یاد داشته باشید که حتماً نیاز نیست نگاره يِ فیلتر را ببرّ

زمانی که با نگاره هايِ فیلتر بزرگی سر و کار دارید براي بیش  داشته باشید. يتر

 تر شدن سرعتConvolution  ، هاFourier Transform  هايِ سریع به

 کار گرفته می شوند.
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را بر رويِ کانال هايِ نگاره يِ منبع پیکربندي کنید که می خواهید به  Channels، گزینه يِ  Convolveدر بخشِ کنترل هايِ تکمه يِ  .4

 به همه يِ کانال ها داده می شود. Convolveآن جلوه بدهید. به طور پیش فرض ، جلوه يِ 

 به کار برود ، یکی از کارهايِ زیر را انجام بدهید : filterکه از نگاره يِ درون رفت  براي برگزیدنِ کانالی .5

را بر رويِ کانالی پیکربندي کنید که می خواهید به کار بگیرید. به طور پیش فرض ، این  filter channelفهرست پایین افتادنیِ  •

 ربندي شده است.پیک rgba.alphaفهرست بر رويِ 

 use input channelsاست ، گزینه يِ  imageکه در درون رفتfilter  گرفتن همان کانال هایی از درون رفت براي به کار  •

 را نشان بزنید.

 filterرا بدون این که نشان خورده باشد بگذارید بماند. این یعنی این که درون رفتnormalize  در بیش تر جاها می توانید گزینه يِ  .6

ار گرفته شود به مجموع همه يِ پیکسل هایی که در آن است بخش می شود ؛ و بنا بر این ، می شود مطمئن شد که ، پیش از این که به ک

Convolution .روشناییِ همگانیِ نگاره را تغییر نمی دهد 

می خواهید گزینید که را بر زیر ايِهگزینه یکی از  filter bounds، از فهرست پایین افتادنی  Convolveدر بخشِ کنترل هايِ تکمه يِ  .7

 نگاره يِ فیلتر را به آن محدود کنید :

• Shape  به :Bounding Box  درون رفتfilter  ، محدود می شود. در این جاConvolve  ِتنها منطقه يBounding Box 

است. این گزینه ارزشِ پیش فرض است. اگر ، براي نمونه ، درون رفتBounding Box  ا به کار گرفته ، و مرکزِ فیلتر مرکزِ ر

filter  ِتان یک شکلroto  با یکbounding Box  ر نمی کند ، می توانید این گزینهکوچک باشد که همه يِ منطقه يِ فرُمت را پ

 را به کار بگیرید.

• Format  درون رفت محدود به فرُمت :filter  ِمی شود. در این جا ، تکمه يConvolve  همه يِ منطقه يِ فرُمت را به کار گرفته

 کنید. offset، و این اجازه را به شما می دهد که نگاره يِ فیلتر را درونِ این فرُمت 

راست است کانالِ  را نشان بزنید و از کنترل هایی که در سمتmask را ماسک کنید ، گزینه يِ  Convolveاگر می خواهید جلوه يِ  .8

را به عنوانِ  depth، یک کانالِ  Depth-of-fieldماسک را برگزینید. براي نمونه ، می توانید براي همانند سازي جلوه يِ محو شدگیِ 

 ماسک برگزینید.

  
 برآیند به دست آمده     ساده که به عنوانِ ماسک Rampیک تکمه يِ 

 به کار گرفته شده است.

 را به کار ببرید. ZDefocusدقیق تر می توانید تکمه يِ  depth-of-fieldبه یاد داشته باشید که براي محو شدگیِ 

9.  براي این که میان درون رفتimage  اصلی و جلوه يِ کاملیconvolve  یکDissolve  ِداشته باشید ، لغزنده يmix .را میزان کنید 
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 GPU (Graphics Processing Units)، بر رويِ  CPU (Central Processing Unit) اگر می خواهید تکمه به جايِ نکته :

 Nvidiaهايِ  GPUبر رويِ  CPUو  GPUرا نشان بزنید. بیرون رفت میان  Use GPU if Availableاجرا شود ، گزینه يِ 

 را تا حد قابل توجهی بهبود ببخشید. Processingرا به کار بگیرید  ، کارکردGPU  یکسان است ؛ ولی اگر 

 OSX 10.9.3با سیستم عامل  Mac Pro 6.1 2013نیز افزوده ایم (بر رويِ  AMDهايِ  GPUپشتیبانی براي  Nuke 9.0در 

‘Mavericks’  یا پس از آن). براي دانستن بیش تر در این باره بهRequirements for GPU Acceleration  ِو یا راهنماي

 ) رجوع کنید.Help > Release Noteمه (خود برنا

باز شود. به برگه يِ  Preferencesرا فشار بدهید تا پنجره يِ گفت و گويِ  Shift + Sمی توانید  GPUبراي به کار گرفتنِ 

Performance > Hardware و گزینه يِ  برویدDefault Blink Device  کنید که می  پیکربنديرا  بر روي دستگاهی

 را ببندید و آن را دوباره باز کنید. Nukeخواهید به کار بگیرید. براي این که تغییرات کار کنند باید از برنامه يِ 

) Command Lineفرمان ( را به خطِّ gpu–کار می کنید ، باید  Nukeاز برنامه يِ  Render Licenseاگر دارید با یک 

 بیافزایید.

 Depth-of-Fieldیِ همانند سازيِ محوشدگ

-Depth) می کند. بر این اساس می توانید محو شدگیِ ناشی از Blurمحو ( Depthنگاره را بر پایه يِ کانالِ نگاشتZDefocus  تکمه يِ 

of-Field )DOF.را همانند سازي کنید ( 

  
همانند سازي شده  ZDefocusبه کمک تکمه يِ  Depth-of-Fieldدر بالا سمت راست نگاره يِ اصلی را می بینید. در نگاره يِ سمت چپ یک 

 است. در این جا بخش هایی که در زیرِ تابلويِ سبز هستند در فوکوس مانده اند ؛ ولی بخش هايِ جلو و پشت همین ناحیه محو شده اند.

لایه ها بخش بخش می کند ؛ که هر یک از این لایه ها ، آن نگاره را در  براي این که فوکوسِ نگاره اي را از بین ببرد،  Defocusتکمه يِ 

همه يِ لایه ها را آماده  Defocusآماده سازي می شوند. پس از این که تکمه يِ  Blurیکسانی را دارند و با یک اندازه يِ  Depthارزشِ 

جدید بر رويِ لایه يِ پیشین می نشیند. بدین سان  سازي کرد ، آن ها را از پشت تا جلويِ نگاره با همدیگر در هم می آمیزد. یعنی هر لایه يِ

 ، چیدمانِ اشیاء در نگاره همان جور که هست نگه داشته می شود.

 یک آغازِ تنُد و سریع

 تان بچسبانید. Scriptبسازید و آن را به  ZDefocusیک تکمه يِ  .1

 را میزان کنید. Blurپیکربندي هايِ  .2
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 ا میزان کنید.هايِ بیرون از فوکوس ر Highlightشکلِ  .3

 را بیش تر به چشم بیاورید. Lens Shapeها را زیاد کرده و جلوه هايِ  Highlightدر صورت لزوم ،  .4

 را ماسک کنید. Blurدر صورت لزوم ، جلوه يِ  .5

 ZDefocusچسباندن تکمه يِ 

 ساخته شود. ZDefocusکلیک کنید تا یک تکمه يِ  Filter > ZDefocusبر رويِ  .1

2.  درون رفتimage  ِاز تکمه يZDefocus  را به نگاره اي بچسبانید که می خواهید آن راBlur.کنید 

تان در دو  rgbaو کانال هايِ  Depthنیز باشد. اگر کانالِ  Depth Mapبه یاد داشته باشید که این نگاره می باید دارايِ یک کانالِ 

 آن ها را به هم بیامیزید. ShuffleCopyپرونده يِ جداگانه باشند ، می توانید به کمک یک تکمه يِ 

 شوند. Blurکانال هایی را برگزینید که می خواهید  channelsاز فهرست پایین افتادنیِ  .3

4. Depth channel  را به کانالی در درون رفتimage  پیکربندي نمایید که دارايِ نگاشتdepth  است. به طور پیش فرض ، داده

 می شود. گرفته depth.zاز  depthهايِ 

 به یاد داشته باشید که نگاشتdepth  نبایدAnti-aliased  باشد. اگر این نگاشتanti-aliased  باشد پیکسل ها در راستايِ لبه اي

 که میانِ دو شیء هستند می توانند ژرفایی را تعریف کنند که میانِ دو ژرفايِ شیء جلویی و شیء پشتی است.

را به کار  bladedیا  discاگر می خواهید نگاره يِ فیلترِ خودتان را به کار بگیرید (به جايِ این که نگاره هايِ از پیش تعریف شده يِ  .5

 ببرید) ، نگاره را به درون رفتfilter  ِاز تکمه يZDefocus  ِبچسبانید و در بخشِ ویژه گی هايِ تکمه ، گزینه يfilter type  را بر

 بگذارید. imageرويِ 

است که براي گرفتن عکس به کار رفته است. هم چنان که کلیپ در درون  Camera apertureنگاره يِ فیلتر نشانگرِ شکل و اندازه يِ 

 رفتimage  محو می شود ، هر یک ازhighlight  ِهایی که در کلیپ هستند شکلِ نگاره يfilter  ِرا به خود می گیرند و جلوه ي

Bokeh .را درست می کنند 

به برنامه بارگذاري می کنید ، براي سازگاري با نسخه يِ پیشین ، گزینه يِ  Nuke 8.0v7هایی که از  Scriptدر  یادداشت :

legacy resize mode  ِپایین افتادنی خود به خود نشان می خورد ، و فهرستfilter bounds  براي این به کار می رود که

 به کار رفته و اندازه شان چه تغییري بکند. filteringا چگونه در نشان بدهد نگاره ه

پنهان شده و این اجازه به شما داده می شود که  legacy resize modeجدید ، گزینه يِ  ZDefocusيِ ها با افزودن یک تکمه

محو شدگی انعطاف پذیريِ بیش تري به شما را به کار بگیرید. در واقع ، به هنگامِ ارزیابیِ  image filterفهرست پایین افتادنیِ 

 داده می شود.

به  ) نیز می توانید یک نگاره يِ فیلتر را بسازید.Draw > Flare( Flare) ، و یا تکمه يِ Roto )Draw > Rotoبه کمک تکمه يِ 

رگی سر زیاد داشته باشید که حتماً نیاز نیست نگاره يِ فیلتر را ببرید تا اندازه يِ کوچک تري داشته باشید. زمانی که با نگاره هايِ فیلتر ب

 و کار دارید براي بیش تر شدن سرعتConvolution  ، هاFourier Transform .هايِ سریع به کار گرفته می شوند 

 بچسبانید. ZDefocusا به تکمه يِ ر Viewerیک تکمه يِ  .6
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 ادامه يِ کار را در بخشِ بعد دنبال کنید. .7

 

 Blurمیزان کردن پیکربندي هايِ 

را چگونه می خواهید براي ارزیابیِ فاصله يِ میان دوربین و شیء به کار بگیرید ، گزینه يِ  Depth channelبراي معلوم کردن این که  .1

math نه ، برخی برنامه ها هستند که براي مشخص کردن فاصله هايِ دورتر ارزش هايِ بالاتري را به کار می را کنترل نمایید. براي نمو

 معنا می یابند.گیرند ؛ ولی در برنامه هايِ دیگر فاصله هايِ نزدیک تر به دوربین 

• Direct  ِارزش :Z  درDepth channel  یکراست ،Blur  را کنترل می کند. براي نمونه ، اگرZ باشد ، اندازه يِ  0.5بر با برا

باشد که در این جا در ارزشِ  maximumخواهد بود (مگر این که این کنترل بزرگ تر از  sizeمحو شدگی نیم برابرِ ارزشِ کنترلِ 

maximum .(نگه داشته می شود 

• Depth  ِارزش :Z  درDepth channel آن پیکسل است. له يِ میانِ دوربین و هر آن چیزي است که در نگاره درفاص 

• Far=0  ِارزش :Z  درDepth channel  1برابر با/distance  است. انتظار می رود که ارزش ها از ارزش هايِ مثبت بزرگ

ساخته شده  Rendermanو  Nukeکه با  depthکاهش یابد. این گزینه با نگاشت هايِ  صفر در بی نهایتنزدیک به دوربین تا 

 اند سازگاري دارد.

• Far=1 : near plane=0  ،far plane=1 با نگاشت هايِ  الگو. اینdepth  که باOpenGL .ساخته شده اند سازگاري دارد 

• -direct :  ِهمانند الگويdirect ،  ِارزشZ  درDepth channel  یکراست ،Blur  را کنترل می کند. به سخنی دیگر ، هر لایه

به هر روي ، در این الگو لایه ها در جهتیِ مخالف تفسیر شده اند ؛ بنا  است محو می شود. directبا مقدارِ یکسانی که در الگويِ 

 بزرگ تر ، لایه را به جايِ این که در پشت لایه يِ دیگر بنشاند در جلويِ آن می نشاند. depthبر این ، یک ارزشِ 

• -depth  ِارزش :Z  درdepth channel  ،-distance این الگو همان الگويِ در جلويِ دوربین است .depth ولی  است ،

 فاصله ها منفی شده اند.

• Far=-0  ِارزش :Z  درDepth channel  1-برابر با/distance  ِاست. این الگو با نگاشت هايdepth  ِکه با برنامه يMaya 

 ساخته شده اند سازگاري دارد.

• Far=-1  :near plane=0  ،far plane=-1. 

 را به بالايِ بخشی بکشید که می خواهید کاملاً در فوکوس باشد. focal point widgetدر نمایشگر ،  .2
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 این کار خود به خود مختصاتfocal point  ِرا در بخشِ ویژه گی هايZDefocus  ِبه روز رسانی کرده و کنترلfocus plane  را با

باشد در فوکوس باقی می مانند.  Z Depthه با این ارزشِ هر یک از لایه ها ک پیکربندي می کند. آن ها مختصات در Z Depthارزشِ 

به این موضوع پرداخته  4را پیکربندي نمایید که در فوکوس بماند (در گامِ  depth sliceیک  focus planeهم چنین می توانید به دورِ 

 ایم) ، ولی بخش هايِ دیگرِ نگاره بر حسبِ نگاشتdepth .محو شوند 

  
Focal point widget در زیرِ نشانه يِ سبز رنگ.      Focal point widget .نزدیک به خودرو هایی که در دوردست هستند 

اطلاّعات از دست رفته را جبران کند. که به طورِ پیش فرض فعال است ، تلاش می کند  fill foregroundکنترلِ  نکته :

هنگامی که پیش زمینه از فوکوس بیرون می شود بخش هایی از آن از دست می روند که این گزینه این بخش ها را پر می 

می تواند گاهی با افزودنِ  fill foregroundکند. به هر روي ، چون اطلاعات واقعیِ نگاره در این بخش ها وجود ندارند ، 

 ناخواسته اي را به همراه داشته باشد. اثرات مصنوعیِزهایی که در آن بخش ها نیستند ، چی

این گزینه را از کار ) را می بینید ، Blurryتاري ( مصنوعی ، آثارِ Sharpبه جايِ آثاري با لبه هايِ اگر در پیش زمینه 

 بیاندازید.

نیز پیکربندي کنید. اکنون تکمه يِ  focal plane setupرا بر رويِ  Outputبراي آن که تغییراتی که می دهید را بتوانید ببینید ، می توانید 

ZDefocus  ِداده هايDOF  ِرا در کانال هايrgb .به نمایش می گذارد 

• Red  کم تر از :DOF .(در جلويِ بخشی که در فوکوس است) 

• Green نِ : دروDOF  (در فوکوس). به یاد داشته باشید که اگرdepth of field  ِگذاشته شده باشد ، هیچ چیزي در  0بر روي

 به نمایش در نمی آید. greenکانالِ 

• Blue  بزرگ تر از :DOF .(بخشی که در فوکوس است پشت) 

 بر رويِ نگاره يِ درون رفت پوشش داده می شوند. دانسته هارا به کار انداخته باشید ، این  show imageگزینه يِ هنگامی که 

 
Focal point widget .نزدیک خودروها در دوردست است    Focal point widget .در زیرِ نشانه يِ سبز رنگ است 
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 focusبه دورِ  depth sliceرا زیاد کنید. با این کار یک  depth of fieldبراي پهن کردن بخشی که کاملاً در فوکوس است ، ارزشِ  .3

plane  پیکربندي می شود که کاملاً در فوکوس است (و هر زمان کهoutput  ِبر رويfocal plane setup  پیکربندي شده باشد به

 راستین این بخش را بر رويِ صفر پیکربندي می کند. DOFرنگ سبز نشان داده می شود). از دید تئوري 

  
Depth of field set to 1.      Depth of field set to 0. 

را به کار بیاندازید. با این کار به مرزِ میانِ  blur insideبراي این که کمی محو شدگی به بخشی که در فوکوس است بدهید ، گزینه يِ  .4

 جایی که در فوکوس است و بخش هايِ پیرامونِ آن که در فوکوس نیستند ، کمی نرمی و همواري افزوده می شود.

، میزانِ محو شدگی را در ژرفايِ بی نهایت میزان کنید. باید بدانید  sizeبرگردانید و با پیکربنديِ ارزشِ  resultرا به  outputگزینه يِ  .5

 شود. focus planeهر چه به دوربین نزدیک تر باشید ممکن است میزانِ محو شدگی بزرگ تر از 

ضرب می شود تا اندازه يِ محو شدگی در ژرفا به دست بیاید. چنان  depthدر  size گذاشته باشید ، directرا بر رويِ  mathاگر 

است را یکراست به عنوانِ اندازه يِ محو شدگی  depthدر نگاشت یی که ارزش ها می توانیدپیکربندي کنید  1را به  sizeچه گزینه يِ 

 بگیرید.به کار 

را نیز افزایش بدهید. در ارزش هايِ بزرگ تر از این ارزش  maximumزیاد کنید ، خوب است که ارزشِ  5را در گامِ  Sizeاگر ارزشِ  .6

 هیچ محو شدگی به دست نمی آید و به این که شیء نسبت به دوربین کجا نشسته است ربطی ندارد.

 می شود پایین نگه دارید. براي بیش ترین سرعت پردازش شاید بخواهید که این ارزش را تا آن جا که

خود به خود به  ZDefocusفعال است. این بدان معناست که تکمه يِ  automatic layer spacingبه طور پیش فرض ، گزینه يِ  .7

 را به کار بگیرد. در این الگو ، لایه هایی depth) چند لایه يِ maximumکار می افتد تا بر اساسِ بیش ترین اندازه يِ محو شدگی (

هستند به هم نزدیک تر هستند. در این جا یک تغییر کوچک در میزانِ محو شدگی خیلی به چشم می آید و  focal planeکه نزدیک به 

ه ، زمانی ک انجام بدهید(هنگامی که کنترلِ لایه ها را دستی  لایه ها بیش تر می شود. میانِ هر چه دور تر می شویم گستردگیِ فضايِ

layer curve  ِرا ببینید). 8پیکربندي کنید ، به این حالت دست می یابید ؛ گامِ  1را برابر با ارزش 

است ، ولی  focal plane setupبگذارید. این مانند  layer setupرا بر رويِ  outputبراي تجسم بخشیدن به لایه ها می توانید 

 اطلاّعاتDOF  را پس از این کهdepth د ، به نمایش می گذارد.به لایه ها بخش بخش ش 
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 output  ِبر رويlayer setup .پیکربندي شده است 

لایه  256) است. این یعنی این که شما می توانید تا maximum )256و  0که به کار گرفته می شود میانِ  blur sizeبیش ترین شمارِ 

 در پشتfocal plane  لایه در جلويِ آن داشته باشید. 256، و نیز تا 

شمارِ لایه ها را دستی کنترل نمایید. به یاد  depth layersرا بردارید ، می توانید به کمکautomatic layer spacing  اگر نشانِ  .8

 به زمان بیش تري نیاز خواهد داشت. Blurداشته باشید که هر چه لایه يِ بیش تري را به کار بگیرید ، پردازشِ 

 
Depth layer  ِندي شده است.پیکرب 50بر روي     Depth layer  ِپیکربندي شده است. 10بر روي 

(نگاره يِ  زیاد کنیدنیز را  layer curveهستند ، گزینه يِ  focal planeاگر نیاز باشد ، می توانید براي فشرده سازيِ لایه هایی که پیرامونِ 

(نگاره يِ پایین سمت  است فضايِ یکنواختی را میانِ لایه ها درست می کند 0. ارزشِ پیش فرض این گزینه که برابر با پایین سمت راست)

 .چپ)

  
 

 دنبال کنید. "هایی که بیرون از فوکوس هستند Highlightمیزان کردن شکلِ "ادامه يِ کار را در بخشِ  .9

 هایی که بیرون از فوکوس هستند Highlightمیزان کردن شکلِ 
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 با محو شدن کلیپی که به درون رفتimage  ، چسبانده شده استhighlight ) هايِ بیرون از فوکوسBokeh ِدر کلیپ شکلِ نگاره ي (

filter  را به خود می گیرند (این نگاره ازfilter type .(برگزیده می شود 

  
Highlight هايِ بیرون از فوکوس )bokeh(  ِکه شکلِ نگاره يfilter  نگاره يِ اصلی 

 را به خود می گیرند.

 براي نگاره يِ فیلتر می توانید :

 از پیش تعریف شده را به کار ببرید. discیک شکلِ  •

 یک نگاره يِ تیغه اي (چندگوشه اي) از پیش تعریف شده را به کار بگیرید. •

 بچسبانید. filterخودتان را به درون رفت سفارشیِ نگاره يِ  •

 از پیش تعریف شده Discک نگاره يِ یبه کار بردن روشِ 

 filter shape setupرا بر رويِ  ZDefocus  ،outputبراي این که بتوانید تغییراتی که می دهید را ببینید ، در بخشِ کنترل هايِ  .1

 بگذارید.

2. Filter type  ِرا بر رويdisc .پیکربندي نمایید 

 بازي کنید. filter shape) ، با کنترلِ 1(ارزش برابر با  disc) و 0(ارزشِ برابر با  Gaussianکردن شکلِ فیلتر میانِ  dissolveبراي  .3

 Filter shape  ِ1بر روي )disc.پیکربندي شده است. ارزشِ پیش فرضِ برنامه است ( 

 Filter shape  ِ0بر روي )Gaussian.پیکربندي شده است ( 

است.  1:1را به دست بگیرید. ارزشِ پیش فرضِ این گزینه  aspect ratioنگاره يِ فیلتر کنترلِ  aspect ratioبراي پیکربندي کردن  .4

فشرده می کند.  Yنگاره يِ فیلتر را در راستايِ آسه يِ  1، و ارزشِ بزرگ تر از  Xنگاره يِ فیلتر را در راستايِ آسه يِ  1ارزشِ کم تر از 

 اي را همانند سازي کنید.بدین سان می توانید جلوه يِ چشم گربه 
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Aspect ratio = 1.5  Aspect ratio = 0.5 

 
 دنبال کنید. "هایی که بیرون از فوکوس هستند highlight شدت بالا بردن"ادامه يِ کار را در بخشِ  .5

 روشِ به کار بردن یک نگاره يِ تیغه اي از پیش تعریف شده

 filter shape setupرا بر رويِ  ZDefocus  ،outputرا ببینید ، در بخشِ کنترل هايِ براي این که بتوانید تغییراتی که می دهید  .1

 بگذارید.

2. Filter type  ِرا بر رويBladed .پیکربندي نمایید 

ا برابر را به کار بگیرید. اگر ارزشِ این گزینه ر bladesبراي پیکربندي کردن شمارِ تیغه هایی که دیافراگم دوربین را می سازند ، کنترلِ  .3

) ، اگر برابر با شش pentagonبگیرید یک پنج گوشه ( 5بگیرید یک چهارگوش ، اگر برابر با  4بگیرید یک سه گوش ، اگر برابر با  3با 

 را قبول می کند. 1) ، و .... خواهید داشت. این میدان تنها شماره هايِ صحیح بزرگ تر از hexagonبگیرید یک شش گوشه (

  Blades  ِپیکربندي شده است. 8بر روي 

  Blades  ِاین شماره ارزشِ پیش فرضِ برنامه است. پیکربندي شده است. 5بر روي 

بگیرید  0بازي کنید. اگر ارزشِ این گزینه را برابر با  roundnessبراي کنترل نمودن گرديِ کناره هايِ چندگوشه ايِ فیلتر ، با گزینه يِ  .4

 د داشت.گوشه ها هیچ گردي نخواهن

  
Roundness = 8 Roundness = 0 
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را به دست بگیرید. اگر ارزش هايِ مثبت به این گزینه بدهید ، نگاره يِ فیلتر در  rotationبراي چرخاندنِ نگاره بر حسبِ درجه کنترلِ  .5

 خلاف جهت عقربه هايِ ساعت ، و اگر ارزش هايِ منفی به این گزینه بدهید نگاره يِ فیلتر در جهت عقربه هايِ ساعت چرخ می خورد.

است.  1:1را به دست بگیرید. ارزشِ پیش فرضِ این گزینه  aspect ratioنگاره يِ فیلتر کنترلِ  aspect ratioبراي پیکربندي کردن  .6

فشرده می کند.  Yنگاره يِ فیلتر را در راستايِ آسه يِ  1، و ارزشِ بزرگ تر از  Xنگاره يِ فیلتر را در راستايِ آسه يِ  1ارزشِ کم تر از 

 بدین سان می توانید جلوه يِ چشم گربه اي را همانند سازي کنید.

  
Aspect ratio = 2 Aspect ratio = 0 

 هايِ بیرون از فوکوس :highlightبراي میزان کردن پراکندگیِ نور درونِ  .7

 را میزان کنید. Inner sizeبراي کنترل کردن اندازه يِ چندگوشه ايِ درونی بر حسب درصدي از چندگوشه ايِ بیرونی ،  •

  
Inner size = 0.8  inner size = 0.2 

را به دست بگیرید.  inner featherبه سمت درون و یا بیرون از پیرامونِ چندگوشه ايِ درونی ، کنترلِ  featherودنِ براي افز •

در سمت بیرون ، و اگر ارزش ها کوچک تر از  featherباشد ، جلوه يِ  0.5اگر ارزشی که به این گزینه می دهید بزرگ تر از 

 درست نمی شود. featherهیچ گونه  0.5در سمت درونیِ درست می شود. در ارزشِ برابر با  featherباشد ، جلوه يِ  0.5

  
Inner feather = 0.8 Inner feather = 0.2 

 
را به کار ببرید. اگر ارزشِ این گزینه را برابر با صفر  inner brightnessبراي میزان کردن روشناییِ چندگوشه ايِ درونی ، کنترلِ  •

 بگیرید سفید خواهد بود. 1بگیرید چندگوشه اي درونی سیاه ، و اگر برابر با 
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Inner brightness = 0.7 inner brightness = 0.3 

را نشان بزنید. هنگامی که با لنز هايِ  catadioptricرا همانند سازي کنید ، گزینه يِ  catadioptricاگر می خواهید لنز هايِ  •

catadioptric  کار می کنید ، بخش هایی از نگاره که فوکوس نیستند حلقوي بوده و یکbokeh ) به شکلِ دوناتDonut-

shaped bokeh ِرا درست می کنند. براي میزان کردن اندازه يِ سوراخ (catadioptric  ِدر فیلتر می توانید کنترل

catadioptric size .را به کار بگیرید 

  
Catadioptric size = 0.7 Catadioptric size = 0.3 

 دنبال کنید. "هایی که بیرون از فوکوس هستند highlight شدت بالا بردن"ادامه يِ کار را در بخشِ  .8

 روشِ به کار بردن یک نگاره يِ فیلترِ سفارشی

1. Filter type  ِرا در بخشِ کنترل هايِ تکمه يZDefocus  ِبر رويimage پیکربندي کنید 

، به جايِ یک شکلِ از پیش  filterمی گوییم که براي درون رفتZDefocus  با این پیکربندي به تکمه يِ 

 تعریف شده ، یک نگاره يِ فیلتر را به کار بگیرد. 

نه ، اگر بخواهید براي می تواند یک نگاره يِ رنگ آمیزي باشد. براي نمو filterباید بدانید که نگاره يِ 

هايِ بیرون از فوکوس تان بیافزایید ، این نگاره می  highlightیک کناره يِ رنگی را به  chromatic aberrationهمانند سازيِ 

 تواند سودمند باشد.

 بگذارید. filter shape setupرا بر رويِ  outputدر نمایشگر نشان داده شود ،  filterاگر بخواهید نگاره يِ  .2

3.  براي این که معلوم کنید از درون رفتfilter : چه کانالی براي کار برگزیده شود ، یکی از کارهايِ زیر را انجام بدهید 

بر رويِ کانالی بگذارید که می خواهید به کار گرفته شود. به طورِ پیش فرض ، این فهرست  filter channelفهرست پایین افتادنیِ  •

 پیکربندي شده است. rgba.alphaبر رويِ 

•  براي به کار گرفتن همان کانال هایی از درون رفتfilter  که در درون رفتimage  ِاست ، گزینه يuse input channels 

 را نشان بزنید.

 گزینید.را به کار بگیرید و فیلتري که می خواهید را بر image filter، فهرست پایین افتادنیِ  Nukeهايِ جدیدترِ  scriptدر  .4

 )Lanczosو  Rifmanرا به خدمت می گیرند (مانند  sharpeningهنگامی که فیلتر هایی را به کار می برید که  یادداشت :

 clamp imageسوراخ شدگی را ببینید. اگر نیاز باشد ، براي درست کردن این مشکل ، گزینه يِ  ممکن است یک جلوه يِ

filter .را نشان بزنید 



14 | N u k / U s e r  G u i d e  
 
 

Vahid Velayati 
 

 filterبه کار انداخته شده است ، از فهرست پایین افتادنیِ  legacy resize modeکه گزینه يِ  Nukeهايِ قدیمی ترِ  scriptدر 

bounds  پایین افتادنی از فهرستfilter bounds  یکی از گزینه هايِ زیر را برگزینید که می خواهید نگاره يِ فیلتر را به آن محدود

 کنید :

• Shape  به :Bounding Box  درون رفتfilter  ، محدود می شود. در این جاZDefocus  ِتنها منطقه يBounding Box 

است. این گزینه ارزشِ پیش فرض است. اگر ، براي نمونه ، درون رفتBounding Box  را به کار گرفته ، و مرکزِ فیلتر مرکزِ 

filter  ِتان یک شکلroto  با یکbounding Box  ر نمی کند ، می توانید این گزینهکوچک باشد که همه يِ منطقه يِ فرُمت را پ

 را به کار بگیرید.

• Format  درون رفت محدود به فرُمت :filter  ِمی شود. در این جا ، تکمه يZDefocus  همه يِ منطقه يِ فرُمت را به کار گرفته

 کنید. offsetرا درونِ این فرُمت  ، و این اجازه را به شما می دهد که نگاره يِ فیلتر

 دنبال کنید. "هایی که بیرون از فوکوس هستند highlightشدت  بالا بردن"ادامه يِ کار را در بخشِ  .5

 هایی که بیرون از فوکوس هستند highlight شدت بالا بردن

 را نشان بزنید. gamma correctionتاثیر گرم تري داشته و بیش تر به چشم بیاید ،  bokehبراي این که شکلِ لنزِ  .1

، پیش از این که محو شدگی انجام بگیرد به نگاره داده شده و  2.2با ارزشِ  gamma تبدیلِ ارزشِ نمودارِاین بدان معناست که یک 

 سپس براي بیرون رفت پایانی وارونه می شود.

  
 gamma correctionبدونِ         gamma correctionبا 

 نیز می توانید جلوه هايِ شکلِ لنز را بیش تر به چشم بیاورید. bloomبا به کار انداختنِ  .2

هایی که در  highlightضرب می شود.  bloom gainباشد ، در ارزشِ  bloom thresholdکه در بالايِ ارزشِ  highlightهر 

 هستند تاثیري نمی گیرند. bloom thresholdزیرِ 

 gammaداشته باشید. به هر روي ،  gamma correctionاز  ها کنترل بیش تري highlightدهد که بر رويِ  این به شما اجازه می

correction  ممکن است برخی ازhighlight .ها را به تر به نمود بیاورد 
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 bloomبدونِ             bloomبا 

 دنبال کنید. "blurماسک کردن جلوه يِ "ادامه يِ کار را در بخشِ  .3

 blurماسک کردن جلوه يِ 

 از کار هايِ زیر را انجام بدهید : یکی .1

•  مطمئن شوید که یک کانالِ ماسک در درون رفتimage  ِاز تکمه يZDefecus  باشد و چیزي به درون رفتmask  چسبانده

 نشده باشد.

•  ماسکی را به درون رفتmask  ِاز تکمه يZDefocus  بچسبانید. اگر نمی توانید درون رفتmask  را ببینید ، کنترل هايِ تکمه

 پیکربندي شده باشد. noneبر رويِ mask را باز کنید و ببینید که گزینه يِ 

 اگر می خواهید از درون رفتmask  ِماسک را به کانالِ از پیش تعریف شده يmask.a  ِرونوشت بگیرید ، گزینه يinject  را

 را دوباره در پایین دست تکمه به کار بگیرید. maskشان بزنید. با این کار می توانید درون رفت نیز ن

 کانالی که می خواهید را به کار بگیرید. maskبه کار ببرید ، از فهرست پایین افتادنیِ  matteاگر نمی خواهید کانالِ آلفا را به عنوانِ  .2

 ز این کانال که سیاه نیستند محدود می شود.به بخش هایی ا blurبه طورِ پیش فرض ، 

به بخش هایی از ماسک محدود می شود که سفید  Blurرا نشان بزنید تا ماسک وارونه شود. بدین سان  invertاگر نیاز باشد ، گزینه يِ  .3

 نیستند.

 را نشان بزنید. fringeبراي محو کردن لبه هايِ ماسک ، گزینه يِ  .4

باشد) لغزنده  1شده (لغزنده در ارزشِ  ZDefocusباشد) و جلوه يِ تمام  0گاره يِ اصلی (لغزنده در ارزشِ کردن میان ن dissolveبراي  .5

، یک چهارگوشِ کوچک به رنگ خاکستري روشن بر رويِ تکمه پدیدار می شود که نشان  Node Graphرا میزان کنید. در  mixيِ 

 می دهد همه يِ جلوه به کار گرفته نشده است.
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 ساختنِ افکت ها ___________________________________

نگاره که به کمک آن ها می توانید افکت هايِ گوناگونی را بر رويِ  )Textو  LightWrap  ،Glint( هستند Nukeچندین تکمه در برنامه يِ 

 .بسازید هايِ درون رفت

 یک آغازِ تنُد و سریع

) که در مرزِ میانِ پیش زمینه و پس زمینه تان رخ می دهد light spill) و نشت هايِ نور (soft edgesبراي میزان کردن لبه هايِ نرم ( .1

 ) را به کار ببرید.LightWrap )Draw > LightWrap، می توانید تکمه يِ 

 می توانید تابش هايِ ستاره اي شکلی را بر رويِ نگاره تان بیافزایید. Glintبا تکمه يِ  .2

 می توانید عناصرِ نوشتاري ، مانند یادداشت ها را به فیلم تان بیافزایید. Textبه کمک تکمه يِ  .3

 پس زمینه بر رويِ عناصرِ پس زمینههايِ  بازتاب

این تکمه با در هم آمیختنِ هر آن  را به کار ببرید. LightWrapمی توانید براي بازتاب هايِ پس زمینه بر رويِ عناصرِ پیش زمینه تکمه يِ 

 س زمینه دارید با عناصرِ پیش زمینه ، بازتابی از نور را در کناره يِ لبه هايِ عناصرِ پیش زمینه تان درست می کند.چه که در پ

 
 LightWrapکامپوزیت بدون جلوه يِ        LightWrapکامپوزیت با جلوه يِ 

هر پس زمینه يِ روشنی فیلمبرداري شده باشند ، لبه هايِ نرم و هموار شده اي دارند که  ممکن است متوجه شده باشید اشیایی که در جلويِ

يِ  هنشت هايِ نور را از پس زمینه گرفته اند. هنگامی که لایه هايِ پیش زمینه را بر روي یک گستره يِ پس زمینه می گسترانید ، به کمک تکم

LightWrap  کامپوزیت تان را تهنرمندانه بهبود ببخشید.می توانید کیفی 
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 به لبه هايِ زمخت در کناره هايِ . LightWrapتکمه يِ  بدونکامپوزیت  . توجه کنید که چگونه LightWrapکامپوزیت با تکمه يِ 

    دست و پایینِ دامن توجه کنید.  پیش زمینه در پس زمینه به خوبی آمیخته شده است.

کامپوزیت  پیش زمینه را بر رويِ پس زمینه Mergeرا به کار ببرید می باید پیش از این که با تکمه يِ  LightWrapاگر می خواهید تکمه يِ 

 عنصرِ پیش زمینه تان بدهید. آن را به ، کنید

 LightWrapروشِ به کار بردنِ تکمه يِ 

1. Draw > LightWrap  ِرا برگزینید تا یک تکمه يLightWrap  پس زمینه تان افزوده شود.پس از نگاره هايِ پیش زمینه و 

2.  درون رفت عنصرِ پیش زمینه تان را به درگاهA  ِاز تکمه يLightWrap در بچسبانید وو نگاره يِ پس زمینه را به درگاه ن رفتB 

 بچسبانید.

 بچسبانید تا بتوانید تغییراتی که می دهید را ببینید. LightWrapرا به بیرون رفت تکمه يِ  Viewerیک تکمه يِ  .3

را میزان کنید. می باید  Intensityو  Diffuseبراي کنترل کردن پراکندگی و روشناییِ بازتاب هايِ رويِ عنصرِ پیش زمینه ، لغزنده هايِ  .4

را تمام پایین بکشید تا به تر بتوانید ببینید که چه چیزي  Diffuseاین لغزنده ها با همدیگر در توازن باشند. ممکن براي آغازِ کار بخواهید 

برگردید ، لغزنده يِ  Diffuseاز پس زمینه را دارید با عنصرِ پیش زمینه تان در هم می آمیزید. سپس ، پیش از این که به کار با لغزنده يِ 

Intensity  ِرا میزان کنید. اگر نیاز باشد ، دوباره با لغزنده يIntensity .کامل را به دست بیاورید بازي کنید تا از برآیند کار رضایت 

  
High Diffuse     Low Diffuse 

  
High Intensity     Low Intensity 

 اگر می خواهید به جايِ این که جلوه خودش را بر حسبِ پس زمینه میزان کند ، جلوه يِ یکنواختی دور تا دورِ لبه هايِ پیش زمینه درست .5

 نشان بزنید. LightWrapرا در برگه يِ  Disable luminance based wrapید ، گزینه يِ کن

به مانند یک  LightWrapرا با عنصرِ پیش زمینه در هم بیامیزید و در واقع جلوه يِ  LightWrapدر جایی که نمی خواهید جلوه يِ  .6

 نشان بزنید (نگاره يِ سمت راست). LightWrapدر برگه يِ  را Generate Wrap onlyعنصرِ جداگانه نگه داشته شود ، گزینه يِ 



18 | N u k / U s e r  G u i d e  
 
 

Vahid Velayati 
 

تنها به درونِ آلفايِ عنصرِ پیش زمینه داده می شود. اگر می خواهید جلوه به بیرونِ آن نیز  LightWrapجلوه يِ به طورِ پیش فرض ،  .7

 را نشان بزنید (نگاره يِ سمت راست). Enable Glow) به چشم بیاید ، گزینه يِ Glowبرافروخته (کشیده شود ، جوري که عنصر 

  

 می توانید کنترل هايِ زیر را میزان کنید : Tweaksدر برگه يِ  .8

• FGBlur  این گزینه معلوم می کند که :Matte  پیش زمینه تا چه اندازه محو شود. هر چه بیش تر محو کنید ، پس زمینه يِ بیش

 تري به پیش زمینه افزوده می شود.

• BGBlur ه محو شود.، تا چه انداز بیامیزداین گزینه می توانید کنترل کنید که پس زمینه ، پیش از این که با عنصرِ پیش زمینه  : با 

• Saturation .اشباعِ جلوه را میزان می کند : 

• Luma Tolerance .براي افزایش یا کاهشِ ارزش هايِ درخشندگیِ جلوه به کار می آید : 

• Highlight Merge :  پیش این که عنصرِ پیش زمینه تا چه اندازه با پس زمینه در هم آمیخته شوند را کنترل می کند. کارکرد

 ) را درست می کند.Glowخوانده می شود ، عناصر را به هم می افزاید ، و یک جلوه يِ برافروختگی ( Plus، که  Mergeفرضِ 

 Useداشته باشید ، گزینه يِ  LightWrapاین که به جايِ پس زمینه ، یک رنگ پایداري به انتخابِ خودتان در جلوه يِ براي  •

constant highlight  ِکنترل هایی که در کنار گزینه ي را نشان بزنید. به کمکConstant Highlights Color  هستند می

 توانید رنگ را برگزینید.

 را اصلاحِ رنگ کنید. LightWrap، می توانید جلوه يِ ساخته شده يِ  CCorrectدر برگه يِ  •

 هايِ نگاره Highlightساختنِ جلوه هايِ ستاره اي شکل بر رويِ 

 هست درست کنید.در یک نگاره  ی کهمی توانید پرتوهايِ ستاره اي شکلی را در همه يِ نقطه هايِ روشن Glintبا تکمه يِ 

  
 Glintهمان نگاره پس از به کار بردنِ تکمه يِ    نقطه هايِ روشننگاره يِ اصلی با 
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 Glintروشِ به کار بردنِ تکمه يِ 

1. Draw > Glint  ِرا برگزینید تا یک تکمه يGlint .پس از نگاره اي بنشیند که می خواهید پرتوهايِ ستاره اي شکل به آن بدهید 

 کانال هایی را برگزینید که می خواهید جلوه به آن داده شود. channelsاز فهرست پایین افتادنی و چهارگوش هايِ نشان خورِ  .2

شمارِ پرتوهایی را بنویسید که می خواهید از نقطه هايِ روشنی که در نگاره دارید به بیرون کشیده شوند. براي  no. of raysدر میدانِ  .3

 را در این میدان بنویسید. 5اهید یک ستاره يِ پنج پر بسازید ، شماره يِ نمونه ، اگر می خو

دست یافت  Glintها در نگاره يِ درون رفت تا چه اندازه باید روشن شوند که بشود به جلوه يِ  highlightبراي این که مشخص شود  .4

میزان کنید. تنها پیکسل هایی که در بالايِ آستانه باشند با این را  tolerance، می باید آستانه را تغییر بدهید. براي این کار لغزنده يِ 

 جلوه شکوفا می شوند.

  
High tolerance value   Low tolerance value 

 oddبراي این که هر پرتوي درازيِ گوناگونی داشته باشد ، لغزنده يِ  بازي کنید. lengthبراي میزان کردن درازيِ پرتوها ، با لغزنده يِ  .5

ray length .را میزان کنید 

ها  stepبنویسید. هر چه شماره يِ  stepsبراي این که معلوم کنید پرتوها از چند تا نقطه شکل بگیرند ، ارزشِ دلخواه تان را در میدانِ  .6

 بیش تر بوده و پرتو ها کوتاه تر باشند ، به پرتو هايِ نرم تر و هموار تري می رسید.

  
  Steps = 5    Steps = 3 

را به کار بگیرید. با زیاد کردن ارزشِ این لغزنده پرتوها در جهت عقربه  rotationبراي چرخاندنِ پرتوهايِ ستاره اي شکل ، لغزنده يِ  .7

 هايِ ساعت ، و با کم کردن ارزشِ این لغزنده پرتوها در خلاف جهت عقربه هايِ ساعت می چرخند.

را میزان کنید. براي  from colorاست ، لغزنده يِ  ینِ پرتو ، نزدیک به نقطه يِ مرکزيِ ستاره هابراي تغییر دادن رنگی که در بخشِ آغاز .8

بر رويِ سفید ، و  from colorرا میزان کنید. به طور پیش فرض ، لغزنده يِ  to colorتغییر دادن رنگ پایانی پرتوها نیز لغزنده يِ 

 شده است.بر رويِ سیاه پیکربندي  to colorلغزنده يِ 
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From color  بر رويِ سفید ، وto color  ِبر روي       From color  ِو  صورتیبر روي ،to color  ِبر روي 

 .پیکربندي شده است زرد          .سیاه پیکربندي شده است

 اگر نیاز باشد ، می توانید لغزنده ها و گزینه هايِ زیر را نیز میزان کنید : .9

 را میزان کنید. aspect ratioستاره ها را تغییر بدهید ، لغزنده يِ  aspect ratioاگر می خواهید  •

به هر  .به کار گرفته می شودستاره براي  ، به عنوانِ نقطه يِ مرکزي ِ پرتوها استبه طورِ پیش فرض ، روشن ترین جایی که بر روي •

را  maxبراي تشکیلِ نقطه يِ مرکزي افزوده شوند ، نشانِ گزینه يِ  روي ، اگر بخواهید نگاره هایی که پرتوها را شکل می دهند

 بردارید.

بیرون فرستاده شود (بدون این که با نگاره يِ درون رفت اصلی که براي ساخت جلوه به کار رفته  Glintبراي این که تنها جلوه يِ  •

 را نشان بزنید. effect onlyشود) گزینه يِ  mergeاست ، 

  
 از کار انداخته شده است. Effect onlyگزینه يِ  به کار انداخته شده است. Effect onlyگزینه يِ 

کانالِ ، را نشان بزنید و از فهرست پایین افتادنی  Wبراي ماسک کردن شکلی که براي ساخت پرتوها به کار رفته است ، گزینه يِ  •

 ماسک را برگزینید.

را  gammaرا درست می کنند ، لغزنده يِ  glintهایی که جلوه يِ  highlightبر رويِ  gamma correctionبراي انجامِ  •

 داده شود ، میزان کنید. glintپیش از این که جلوه يِ 

را نشان بزنید و به کمک کنترل هایی که در سمت راست است ، یک کانالِ  mask، گزینه يِ  glintبراي ماسک کردن جلوه يِ  •

 ید.ماسک را برگزین

 را میزان کنید. mix، لغزنده يِ  glintشدن میانِ نگاره يِ درون رفت اصلی و جلوه يِ کاملِ  dissolveبراي  •

 )Text Overlay( و نگاره ساخت نوشته بر رويِ فیلم
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می توانید نوشته اي که می  می توانید نوشته هایی را بر رويِ نگاره هایتان بیافزایید. به آسانی Nukeدر برنامه يِ  Textبه کمک تکمه يِ 

 را به کار ببرید. TCLیا متغیرهايِ  )[metadata values](مانند  TCLهايِ  Expressionخواهید را در نمایشگر بنویسید ، یا 

که می توانید در  decimal، و نهادهايِ  hex، نهادهايِ  HTML، نهادهایی به نام  TCL، متغیرهايِ  TCLهايِ  Expressionفهرستی از 

 ارائه شده اند. "نمونه اي از متغیرها و نهادها"به کار بگیرید در بخشِ Textتکمه يِ 

پویانمایی کنید. در این جا می توانید ویژه گی هایی  animationنوشته هایی که رويِ فیلم و نگاره انداخته اید را می توانید به کمک لایه هايِ 

 را در بخشی از زمان تغییر داده و پویانمایی کنید. colorو  ، position  ،sizeمانند 

 آماده سازيِ نوشته اي بر رويِ فیلم و نگاره

 براي ساختText overlay ؛ به ویژه می باید معلوم کنید چه کانال هایی نوشته را در خود نگه داشته و  ی را انجام بدهیدیها می باید کارها

 باید بنشیند. گريِ نمایشچهارچوبِ نوشتاري کجا

1. Draw > Text  ِرا برگزینید تا یک تکمه يText  ِساخته شود. آن را به یک تکمه يViewer .بچسبانید 

نشان  output، کانال هایی را برگزینید که می خواهید نوشته در آن از بخشِ کنترل هايِ  Text از تکمه يِ Propertiesدر چهارچوبِ  .2

 بیابد.

بندي به رنگ سیاه پیکر هستندبیرون از شکلِ نوشته  آن هایی کهاگر می خواهید هر کدام از کانال ها در نوشته ضرب شود به گونه اي که  .3

 آن کانال ها را برگزینید. premultد ، به کمک کنترل هايِ نشو

 ه چیزي می خواهید محدود کنید :بیرون رفت را به چمشخص کنید که نگاره يِ  clip toاز فهرست پایین افتادنیِ  .4

• No clip .نگاره يِ بیرون رفت به چیزي محدود نمی شود : 

• Bbox  نگاره يِ بیرون رفت به :bounding box .ورودي محدود می شود 

• Format :  نگاره يِ بیرون رفت بهformat area .ورودي محدود می شود 

• Union bbox+format  ِنگاره يِ بیرون رفت به مجموع :bounding box  وformat area .ورودي محدود می شود 

• Intersect bbox+format  نگاره يِ بیرون رفت به اشتراك :bounding box  وformat area .ورودي محدود می شود 

را نشان  replaceه يِ ، گزین کنید، کانال هايِ تاثیر گرفته را پاك کرده و سیاه اگر می خواهید پیش از کشیدن نوشته بر رويِ کانال ها  .5

 درون رفت کشیده می شود. نشان دار نیست و نوشته بر بالايِ نگاره يِ replaceبزنید. به طور پیش فرض ، گزینه يِ 

 نوشته تان را بنویسید. messageنمایان شود ، می توانید در میدانِ  format areaاگر می خواهید نوشته در همان گوشه يِ بالا و چپِ  .6

) را بکشید text boxو یا یک چهارچوبِ نوشتاري ( داشته باشید ،اگر می خواهید براي جاي گیريِ نوشته در همان ابتدا کنترل بیش تري  .7

 : در بالايِ نمایشگر را نشان بزنید و سپس edit textو نوشته تان را در آن بنویسید ، می باید گزینه يِ 

 ماوس در همان جایی که می خواهید بنویسید پدیدار شود. یا ... بر رويِ نمایشگر کلیک کنید تا نشانگرِ •

 یک چهارچوب در نمایشگر بکشید که می خواهید نوشته تان را در آن چهارچوب بنویسید. •

 در نمایشگر پدیدار می شود. را می افزایید ، نشانگرِ ماوس به شکلِ  Textهنگامی که براي نخستین بار تکمه يِ  نکته :
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که در یک چهارچوبِ سفارشی می نویسید ، به مرزبندي هايِ  را نوشته اي

box x  ،box r  و ،box t  ِکه در برگه يTransform  معلوم می کنید

 را نیز می توانید داشته باشید. y، ولی مرزبنديِ  می شودمحدود 

، و یا با کشیدنِ دستگیره هایی  box xyrtبه کمک کنترل هايِ  نکته :

که در نمایشگر می بینید ، می توانید در هر زمان چهارچوبِ نوشتاري را 

 میزان کنید.

 را نگاه کنید. "ماسک کردن بخش هایی از نمایشگر"اگر می خواهید بخشی از نگاره را ماسک کنید ،  .8

 دنبال کنید. "وارد کردن نوشته"امه يِ کار را در بخشِ اگر از جایی که نشانگرِ ماوس تان نشسته است راضی هستید ،  اد .9

 وارد کردن نوشته

، یا ترکیبی از این ها ، که می خواهید در بیرون رفت تان به نمایش در بیایند را می توانید  TCLمتغیرهايِ ،  TCLهايِ  Expressionنوشته ، 

 بنویسید (جدولِ زیر را ببینید). Textاز تکمه يِ  propertiesدر قابِ  messageدر میدانِ 

ولی چند  ؛ با آن ها سر و کار داریدکه در ویراستارهايِ نوشتاري  باید رفتار کنیدهمان قوانینی  با ، بیش تر اي را بنویسید نوشته اگر بخواهید

 قانونی هم هست که در زیر به آن می پردازیم :

می نویسید)  messageبنویسید (درست مانند زمانی که نوشته اي را در میدانِ  اگر می خواهید یکراست در خود نمایشگر نوشته اي را •

 نمایشگر است را به کار بیاندازید.که در بالايِ  edit textمی باید کنترلِ 

 را فشار بدهید. Returnو چه در خود نمایشگر ، کلیدmessage  جدید بروید ، چه در میدانِ  براي این که به خطِّ •

 باشید و چه در نمایشگر ، می توانید به بالا ، پایین ، چپ و راست بروید. messageدادن کلید هايِ پیکان دار ، چه در میدانِ با فشار  •

• Expression  ِهايTCL  را می باید درونِ براکت ها بنویسید ؛ مانند[date]. 

 ) :copyrightبیگانه و نشانه هايِ حقِ نشر ( مخصوص ، مانند نویسه هايِ یک زبانِ Unicodeبراي نمایش دادنِ نویسه هايِ  •

o  به نام  توانید نهادهاییمیHTML  مانند را به کار ببرید ؛&lt;  ِیا  >براي نمایش ،&copy;  ِبراي نمایش©. 

o  ِمی توانید نهادهايhex  را به کار ببرید ؛ مانند&#x3c;  ِیا  >براي نمایش ،&#xa9;  ِبراي نمایش©. 

o  ِمی توانید نهادهايdecimal  براي نمایشِ  ;169#&، یا  >براي نمایشِ  ;60#&(دهدهی) را به کار ببرید ؛ مانند©. 

o  ِنویسه هايUnicode  را بر رويِ صفحه کلیدتان بزنید ، یا آن ها را از برنامه هايِ دیگر بریده و بچسبانید ©یا  >(مانند (

)cut & paste .(UTF-8 character encoding  براي ذخیره کردن آنها در ارزشِ کنترل و درScript  ِذخیره شده ي

Nuke   .به کار برده می شود 

 زمانی کار می کند که فونتی که به کار می برید آن نویسه را پشتیبانی کند.این نویسه هايِ ویژه تنها 

، نهادهايِ بالا را به کار ببرید. این براي این است که شاید  >به جايِ نوشتنِ  ، براي نمونه پیشنهاد می کنیم یادداشت :

، برخی از نویسه ها مانند نشانه هايِ بزرگ  HTMLرا تفسیر کند. در  HTMLنشانه گذاريِ  Textنسخه هايِ آتی تکمه يِ 

 باشید ، نسخه هايِ آتی براياگر این نشانه ها را اکنون در نوشته تان به کار برده  تر از و کوچک تر از ، وارونه می شوند.

 می توانند آن ها را اشتباه بگیرند. HTMLنشانه گذاريِ 
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 نمونه اي از متغیرها و نهادها

 
 decimal، و نهادهايِ  hex، نهادهايِ  HTML، نهادهایی به نامِ  TCL، متغیرهايِ  TCLهايِ  Expressionدر جدولِ زیر نمونه هایی از 

 به کار بگیرید. Textاز تکمه يِ  messageآن ها را در میدانِ  آورده ایم که می توانید

Prints Message 
TCL Expressions 

 Thu Jan 15 14:22:20 GMT [date]. براي نمونه : time zone، و  hh:mm:ssروزِ هفته ، روز ، ماه ، 

 Thu [date %a]روزِ هفته. براي نمونه :  کوچک شده براينامِ 

 Thursday [date %A]نامِ کاملِ روزِ هفته. براي نمونه : 

 Jan [date %b]ماه. براي نمونه :  کوچک شده براينامِ 

 January [date %B]نامِ کاملِ ماه. براي نمونه : 

 [date %d] ).31-01روز (

 [date %D] 15/01/10 ) براي نمونه :dd/mm/yyتاریخ (

 [date %H] ).23-00ساعت (

 [date %I] ).12-01ساعت (

 [date %m] ).12-01ماه (

 [date %M] ).59-00دقیقه ها (

AM  یاPM [date %p] 

 AM [date %r] 11:04:07ساعت). براي نمونه :  12زمان (

 [date %S] ).59-00ثانیه ها (

 [date %T] 14:06:54ساعت). براي نمونه :  24زمان (

 [date %y] 10). براي نمونه : 99-00سال به شکلِ مخفف (

 [date %Y] 2010سال به شکلِ کاملِ آن. براي نمونه : 

Numeric time zone : 8800-. براي نمونه [date %z] 

Time Zone : براي نمونه .GMT [date %Z] 

 [frame] 23شماره يِ فریم. براي نمونه : 

 [metadata] ورودي است. metadataفهرستی از همه يِ کلید هایی است که در 

 [metadata values] ورودي هستند. metadataفهرستی از همه يِ کلید ها و ارزش هایی است که در 

را با نامِ کلیدي جایگزین کنید که می  keyورودي می آید. واژه يِ  metadata کلیدي است که درارزشِ 

براي به نمایش در آوردنِ نام و جايِ ممکن است بتوانید خواهید ارزشِ آن به نمایش در بیاید. براي نمونه ، 

[metadata key] 
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، یا براي نشان دادن برچسبِ زمانی براي یک پرونده  [metadata/filename] ، پرونده يِ تصویري

 را به کار ببرید. [meatadata/ctime] ، يِ درون رفت

 است.  Scriptو نامِ  Script Directoryمسیرِ 

 .User/john/Nuke_scripts/myscript.nkبراي نمونه : 

[value root.name] 

TCL Variables 
را با یک متغیرِ محیطی که  ENVIRONMENT_VARIABLEارزشِ متغیرِ محیطی معینی است. نوشته يِ 

 Linuxو  Mac OSXرا در  env(USER)$پیکربندي کرده اید جایگزین نمایید. براي نمونه ، می توانید 

) johnبه کار ببرید تا نامِ کاربر (براي نمونه  Linuxو  Windowsرا در  env(USERNAME)$، یا 

 به نمایش در بیاید.

$env(ENVIRONMENT 
_VARIABLE) 

 9.0v4 $version_longاست. براي نمونه :  Nukeشماره يِ نسخه يِ کاملِ 

هایی است که براي ارزیابیِ نگاره ها به کار رفته است. این شماره علاوه بر  render thread شماره يِ

thread) گرافیکیِ کاربر اصلی است که براي به روز شدنِ رابطGUI.به کار می رود ( 

$threads 

HTML named entities 
& &amp; 
' &apos; 
Å &Aring; 
Á &Aacute; 
Â &Acirc; 
Æ &AElig; 
À &Agrave; 
Ç &Ccedil; 
© &copy; 
é &eacute; 
ê &ecirc; 
è &egrave; 
ë &euml; 
€ &euro; 
> &gt; 
< &It; 
Ñ &Ntilde; 
ø &oslash; 
õ &otilde; 
Ö &Ouml; 
ö &ouml; 
" &quot; 
® &reg; 
ß &szlig; 
Ü &Uuml; 
ü &uuml; 

Hex entities 
# &#x23; 
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% &#x25; 
& &#x26; 
* &#x2a; 
@ &#x40; 
TM &#x99; 
oe &#x153; 
š &#x161; 
< &#x3c; 
> &#x3e; 
© &#xa9; 
é &#xe9; 

decimal entities 
£ &#163; 
© &#169; 
® &#174; 
¿ &#191; 
ê &#234; 
ß &#223; 
à &#224; 

 Node Graphبه دست بیاورید می توانید در پنجره يِ  TCLهايِ  expressionبراي آن که فهرستی از همه يِ  نکته :

پیکربندي  TCLکه باز می شود رويِ  script commandرا بنویسید ، پنجره يِ گفت و گويِ  x، نویسه يِ  dateبا واژه يِ 

 را بزنید. okرا نوشته و دکمه يِ  date –hکنید ، 

 آن ها فونت ها و ویژه گی هايِ

،  TrueTypeآن را به کار می گیرد ، شمارِ بسیار زیادي از فونت ها ، از جمله فونت هايِ  Text، که تکمه يِ  FreeTypeکتابخانه يِ 

OpenType  و ،PostScript پایین افتادنیِ را پشتی بانی می کند. براي آن که فونت ها در فهرستfont  ، سریع تر به نمایش در بیایند

 XMLمی شوند. این پرونده يِ  XML  ،cacheرا باز می کنید به عنوانِ یک پرونده يِ  Textتکمه يِ  Propertiesهنگامی که چهارچوبِ 

 مشخص می شود. NUKE_TEMP_DIRخوانده شده و جايِ آن با متغیرِ محیطی  fontmapping.fcacheبه نامِ 

 render farmرويِ یک  نیستنیازي به کار گرفته نمی شود و  font cacheدر زمانِ پردازش ، پرونده يِ  یادداشت :

 باشد.

کند ، آن ها را از جاهايِ گوناگون ، با یک ترتیبِ پیکربندي  cacheرا  Text، پیش از این که فونت هايِ موجود در تکمه يِ  Nukeبرنامه يِ 

 شده بازیابی می کند :

 ه است.مشخص شد Project Settings > Font > Project font pathجایی که در کنترلِ  .1

 و همه يِ پوشه هايِ پلاگین. nuke/fonts.پوشه يِ  .2

 مشخص شده است. NUKE_FONT_PATHجایی که با متغیرِ محیطیِ  .3
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استاندارد سیستمِ عامل مسیرهايِ  syntaxاین امکان را به شما می دهند که به کمک  3و  1جایگاه هايِ شماره يِ  یادداشت :

و...  ; c:\windows\font1 ; c:\windows\font2چندگانه اي را مشخص نمایید. براي نمونه در سیستمِ ویندوز ، می توانید 

 را مشخص کنید.

 پوشه يِ بومیِ فونت ها. .4

به کار انداخته شده است.  Project Settings > Font > include system fontsپوشه يِ فونت هايِ سیستم ، با فرضِ این که  .5

 .\C:\Windows\Fontsبراي نمونه در سیستمِ ویندوز : 

فونت را از نخستین پوشه اي که پیدا نموده به کار می  Nukeاگر چندین جایگاه فونت یکسانی را داشته باشند ،  یادداشت :

 گیرد.

سیستم هايِ عامل  میان }) درست به یک شکل درArial : Regular(مانند {معمولاً ، هیچ ضمانتی نیست که یک فونت آشنا و با سبک 

با چندین فونتی که براي همه يِ سیستم ها مشترك است همراه می شود.  Nukeمختلف پردازش شود. براي جلوگیري از این کار ، برنامه يِ 

ارائه  Nukeتنها فونت هایی که با برنامه يِ ر بیاندازید ، را از کا Project Settings > Font > include system fontsاگر گزینه يِ 

 موجود خواهند بود. fontشده اند در بخشِ کنترل هايِ 

بر این ، موجود هستند. بنا  fontتنها فونت هایی که در یک پوشه ذخیره سازي شده اند در بخشِ کنترل هايِ  یادداشت :

فونت هایی که در  فهرستNuke  فونت ها در برنامه يِ نرم افزاري دیگر بر رويِ همان هستند ممکن است با فهرست

 رایانه گوناگون باشد.

 برگزیدنِ یک فونت

 کنید. highlightرا  آن کار کنیدرويِ ، می خواهید بر یا نمایشگر messageنوشته اي که در میدانِ  .1

کلیک کنید و خانواده اي از فونت که می  font familyت پایین افتادنیِ بر رويِ فهرس،  Textتکمه يِ  propertiesدر چهارچوبِ  .2

 خواهید را برگزینید.

3. Font style نیازتان پایین افتادنی برگزینید. مورد را از فهرست 

 ) ، بسته به خانواده اي که بر می گزینید موجود می شوند.styleسبک ها ( یادداشت :

 کلیک کنید تا جایگاه فونتی که برگزیده اید به نمایش در بیاید. براي نمونه : informationبر رويِ شمایلِ  .4

 



27 | N u k / U s e r  G u i d e  
 
 

Vahid Velayati 
 

Font family  وfont style  به همراه برخی از داده هايِ دیگر ، در ،Nuke script  ذخیره می شوند. بدین سان می توانید مطمئن باشید

را در یک رایانه یا سیستمِ عاملِ دیگري باز کنید ، همان خانواده يِ فونت با همان سبک که به کار برده اید را خواهید داشت.  scriptکه اگر 

 یک پیامِ هشدار را به نمایش می گذارد. Nukeاگر همان خانواده يِ فونت یا سبک آن نباشد ، برنامه يِ 

 میزان کردن اندازه و فضابنديِ فونت

 کنید. highlightآن کار کنید را یا نمایشگر ، می خواهید بر رويِ messageي که در میدانِ نوشته ا .1

گذاشته شده است ،  0بر رويِ  leadingرا به دست بگیرید. هنگامی که  font sizeبراي میزان کردن اندازه يِ کلیِ فونت ، لغزنده يِ  .2

 می کند. این نماد فضايِ میانِ هر خطّ از نوشته را نیز کنترل

پیکسل هایی را میزان  Font hintingبه کار رفته را کنترل می کند.  font size  ،font hintingزمانی که فونت را پردازش می کنید ، 

می کند که براي پردازشِ تر و تمیزترِ یک فونت درون یابی می شوند. اگر اندازه يِ فونت خیلی کوچک باشد و بر رويِ دستگاه هایی با 

در برگه  scaleپایین به نمایش در بیاید ، خوانایی فونت خیلی مشکل ساز می شود. براي به ترین برآیند ، می باید به جايِ کنترلِ  وضوحِ

 نگه دارید. 1را بر رويِ ارزشِ  font scaleرا دستکاري کنید.  font size، نمادGroup  يِ 

 انید اندازه يِ فونت را به شکلی ناهمسان بزرگ و کوچک کنید.می تو font heightو  font widthبه کمک کنترل هايِ  .3

 هم چنین براي میزان کردن اندازه يِ فونت ، می توانید کنترل هایی که در بالايِ نمایشگر دارید را دستکاري کنید.

 
منفی به کار را میزان کنید. اگر براي این گزینه ارزش هايِ  kerningبراي زیاد و کم کردن فضايِ میان هر یک از نویسه ها ، لغزنده يِ  .4

 ببرید ، می توانید نویسه ها را بر رويِ هم بیاندازید.

 از کار می افتد. kerningاگر بیش از یک نویسه ، یا آخرین نویسه را برگزیده باشید ، لغزنده يِ  یادداشت :

 نمایشگر دارید را نیز دستکاري کنید.در بالايِ  ، می توانید کنترلی که kerningبراي میزان کردن 

 
منفی براي این با به کار بردن ارزش هايِرا میزان کنید.  trackingبراي زیاد و کم کردن فضايِ میان هر نویسه با نویسه يِ پیشین ، کنترلِ  .5

 گزینه ، نویسه ها به سمت نویسه يِ پیشین پیش می روند.

 نمایشگر دارید را نیز دستکاري کنید.، می توانید کنترلی که در بالايِ  trackingبراي میزان کردن 
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را به کار بگیرید. خطِّ تراز یک خطِّ  baseline shiftبراي میزان نمودن جايِ نشستن نوشته يِ برگزیده شده در بالايِ خطِّ تراز ، کنترلِ  .6

اري گوناگون را دستکفرضی است که نویسه ها رويِ آن می نشینند. این کنترل این اجازه را به شما می دهد که خطِّ تراز را براي فونت هايِ

 کنید.

 کنید.نمایشگر دارید را نیز میزان براي میزان کردن خطِّ تراز ، می توانید کنترلی که در بالايِ 

 

میزان کنید. با به کار بردن  leadingاگر چندین خط نوشته داشته باشید ، می توانید فضايِ میانِ هر خطِّ نوشته را به کمک لغزنده يِ  .7

 ارزش هايِ منفی براي این گزینه نویسه ها بر روي هم می افتند.

همه يِ نوشته بر رويِ ، صرف نظر از آن چه برگزیده اید ،  leading، لغزنده يِ  baseline shiftبر خلاف کنترلِ  یادداشت :

 است تاثیر می گذارد. bounding boxاي که درون 

 تراز کردن فونت ها

 تاثیر می گذارد. yو  xاست ، در راستايِ آسه هايِ  bonding box) بر رويِ جایگاه نوشته اي که درون justifyکنترل هايِ تراز (

 است می توانید معلوم کنید که نوشته در راستايِ افق چگونه چیدمان شود : xjustifyه در فهرست پایین افتادنیِ به کمک گزینه هایی ک .1

• Left ) نوشته را با لبه يِ چپِ چهارچوبِ نوشتاري :text box نوشته جلو و عقب است هم تراز می کند. در این جا لبه يِ راست (

 سمت راست ، پایین).و در یک راستا قرار ندارد (نگاره يِ 

• Center :  نوشته هر دو جلو نوشته را درست با خطِّ میانیِ چهارچوبِ نوشتاري هم تراز می کند. در این جا لبه هايِ چپ و راست

 ، پایین). سمت چپو عقب هستند (نگاره يِ 

   
• Right : چهارچوبِ نوشتاري هم تراز می کند. در این ج ا لبه يِ چپِ نوشته جلو و عقب است و در یک نوشته را با لبه يِ راست

 راستا قرار ندارد (نگاره يِ سمت راست ، پایین).

• Justify :  نوشته نوشته را با هر دو لبه يِ راست و چپِ چهارچوبِ نوشتاري هم تراز می کند. در این جا لبه هايِ چپ و راست

میانِ نویسه ها را گسترش می دهد. اگر فضایی میان نویسه ها نباشد و یا جلو و عقب نیستند. این گزینه براي ترازبندي ، فضاهايِ 

 فضاها بیش تر از سه بار پهن تر شده باشند ، نویسه ها گسترش می یابند (نگاره يِ سمت چپ ، پایین).
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 چگونه چیدمان شود : عمودر راستايِ است می توانید معلوم کنید که نوشته د yjustifyبه کمک گزینه هایی که در فهرست پایین افتادنیِ  .2

• Top .(راست ، پایین نگاره يِ سمت) نوشته را با لبه يِ بالایی چهارچوبِ نوشتاري تراز می کند : 

• Center : .(نگاره يِ میانی ، پایین)نوشته را با خطِّ میانی چهارچوبِ نوشتاري تراز می کند 

• Bottom : .(چپ ، پایین نگاره يِ سمت) نوشته را با لبه يِ پایینیِ چهارچوبِ نوشتاري تراز می کند 

  

 Font Cacheبه روز رسانیِ 

، فونتی درخواست می  fontرا پذیرفته و هر زمان که از بخشِ کنترل هايِ  cacheمحتوايِ  Nukeدرست شد ،  font cacheهنگامی که 

خود به  cacheافزوده و یا از آن پاك کنید ،  font cacheرا بسازد. اگر فونت هایی را به این  font cacheشود دیگر نیاز نمی شود که 

 را به روز کنید. براي این کار چندین راه وجود دارد : font cacheخود به روز رسانی نمی شود. می باید دستی 

 کلیک کنید. Rescan font pathsبروید و بر رويِ  Project Settings > Fontبه  •

را دوباره آغاز  Nukeپاك کرده و برنامه يِ  NUKE_TEMP_DIRرا دستی از  fontmapping.fcache.xmlپرونده يِ  •

 کنید.

 را اجرا کنید. ()nuke.rescanFontFoldersرا باز کرده و  Nukeبرنامه يِ  Scriptویراستاريِ  •

 Help > Documentation > Pythonمربوط می شوند ، به  font cacheکه به  Pythonي آگاهی بیش تر در باره يِ فرمان هايِ برا

Developer’s Guide .بروید 

 تغییر شکل دادن نوشته



30 | N u k / U s e r  G u i d e  
 
 

Vahid Velayati 
 

چندین  animation layersمی توانید نوشته هایی که برگزیده اید را در نمایشگر تغییر شکل داده ، و یا در جدولِ  Textبه کمک تکمه يِ 

انی می بنوشته يِ برگزیده شده را با هم گروه کرده و همه يِ آن ها را با هم تغییر بدهید. در هر دو روش ، پویانمایی با فریم هايِ کلیدي پشتی

 شود.

 ن نوشته هایی که برگزیده ایدتغییر شکل داد

ده ش نوشته هایی که برگزیده شده اند را می توانید در نمایشگر با دست (یعنی با دستکاري کردن دستگیره هایی که بر رويِ نوشته هايِ برگزیده

 پدیدار می شوند) تغییر شکل بدهید.

 را به کار بیاندازید. transformدر بخشِ کنترل هایی که در بالايِ نمایشگر هستند ، گزینه يِ  .1

 نویسه (ها) اي که می خواهید تغییر بدهید را در نمایشگر برگزینید تا دستگیره هايِ تغییر شکل نمایان شوند. .2

 دستگیره را کرده و کارکردتغییر بسته به جایی که هست اگر نشانگرِ ماوس را بر رويِ یک نوشته يِ برگزیده شده ببرید ، شکلِ نشانگر  .3

 دهد.نشان می 

 

) Rotate) ، چرخانده (Translateبا کشیدنِ دستگیره ها ، بسته به کاري که می خواهید بکنید ، نوشته يِ برگزیده شده را جا به جا کرده ( .4

 ).Scaleو بزرگ و کوچک کنید (

واهید نوشته د. اگر می خگیربه طورِ پیش فرض ، بزرگ و کوچک شدن نوشته به شکلی یکسان از مرکزِ نوشته انجام می  نکته :

 تان را نسبت به گوشه یا کناره ها بزرگ و کوچک کنید ، کلیدCtrl .را پایین نگه داشته و دستگیره را بکشید 

 تغییر شکل دادن گروه ها

در یک گروه جاي بدهید. این به شما اجازه می دهد  animation layersمی توانید نوشته هايِ برگزیده را در جدولِ  Groupاز برگه يِ 

 ، بر رويِ لایه ها را جدا از هم کار کنید. transformکه به کمک کنترل هايِ 

 animation layersو جدولِ  transformبروید. در این می توانید کنترل هايِ  Groupرا باز کنید و به برگه يِ  propertiesقابِ  .1

 را ببینید.
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برگزیده ، و سپس بر رويِ  messageي که می خواهید رويِ آن ها تغییر شکل بدهید را در پنجره يِ نمایشگر ، یا در میدانِ ا) انویسه (ه .2

در بالايِ پنجره يِ  create groupساخته شود. براي این کار می توانید بر رويِ  animation layerکلیک کنید تا یک  +دکمه يِ 

 نمایشگر نیز کلیک کنید.

که خواسته باشید را می توانید بسازید ؛ که هر کدام بسته به آن نوشته اي که در نمایشگر برگزیده اید  animation layerر چند تا ه

 نامگذاري می شود.

را  animation layerیک  .3

برگزینید و براي تغییر شکل دادن آن 

که در  transform، کنترل هايِ 

هست را به کار  Groupبرگه يِ 

 .ببرید

اگر می خواهید تغییراتی که می دهید 

را پویانمایی کنید ، به بخشِ 

 "پویانمایی کردن تغییر شکل ها"

 بروید.

 کلیک کنید. –، بر رويِ دکمه يِ  animation layerبراي پاك کردن یک  .4

 پویانمایی کردن تغییر شکل ها

است پشتیبانی می کند. در این جا می توانید هر یک از کنترل  Nukeپویانمایی را به همان روشی که در بیش ترِ تکمه هايِ  Textتکمه يِ 

این  Groupدر برگه يِ  animation layerدارید را جدا از دیگر کنترل ها پویانمایی کنید ؛ ولی جدولِ  propertiesهایی که در قابِ 

 توانایی را به شما می دهد که پویانمایی هایتان را هر چه آسان تر ببینید.

 پویانمایی کردن نوشته هايِ برگزیده شده

 به کمک دستگیره هايِ نمایشگر ، جايِ آغاز براي نوشته هايِ برگزیده شده را پیکربندي نمایید. .1

 در بالايِ نمایشگر کلیک کنید تا یک فریم کلیدي به آغازِ کار افزوده شود. بر رويِ دکمه يِ  .2

 به کمک دستگیره هايِ نمایشگر نوشته يِ برگزیده شده را تغییر شکل بدهید.نشانگرِ بازپخش را به فریمِ جدید ببرید و  .3

 یک فریمِ کلیدي خود به خود بر رويِ فریمِ جدید افزوده می شود.

 .بسازیدروند کار را ادامه بدهید و پویانمایی که می خواهید را  .4

 .را کلیک کنید براي پاك کردن یک فریمِ کلیدي در فریمِ جاري دکمه يِ  .5

 پویانمایی کردن گروه ها

 ، جايِ آغاز براي گروه ها را پیکربندي نمایید. transformبه کمک کنترل هايِ  .1
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در بالايِ نمایشگر را کلیک کنید تا یک فریم کلید آغازین   ، گروهی را برگزیده و سپس دکمه يِ animation layersدر جدولِ  .2

 افزوده شود.

یا دستگیره هایی که در نمایشگر است ، گروه را تغییر شکل  transformید ببرید و به کمک کنترل هايِ نشانگرِ بازپخش را به فریمِ جد .3

 بدهید.

 روند کار را ادامه بدهید و پویانمایی که می خواهید را بسازید. .4

 را کلیک کنید. براي پاك کردن یک فریمِ کلیدي در فریمِ جاري دکمه يِ  .5

 تغییر دادن رنگ نوشته

 بروید. color، به برگه يِ  Textتکمه يِ  Propertiesدر قابِ  .1

2.  نمادcolor  ِرا میزان کرده ، یا بر رويِ دکمه يcolor picker  .کلیک کرده و رنگی را براي نوشته تان برگزینید 

 برگزینید : rampفهرست  را از noneاگر می خواهید در سراسرِ نوشته تان یک گرادیانت رنگ بسازید ، هر یک از گزینه به جز  .3

• Linear .دیگر به شکلِ خطی تغییر می کند گرادیانت از یک رنگ به رنگ : 

• Smooth0  رنگ به آرامی در :ramp انتهايِ  بهpoint 0  ِفروکش می کند. این بدان معناست که رنگ ها در انتهايpoint 0 

 هستند. point 1پهن تر از رنگ ها در انتهايِ 

• Smooth1  رنگ در :ramp  ِبه انتهايpoint 1  ِفروکش می کند. این بدان معناست که رنگ ها در انتهايpoint 1  پهن تر از

 هستند. point 0رنگ ها در انتهايِ 

• Smooth  رنگ در :ramp  ِبه آرامی به هر دو انتها فروکش می کند. این بدان معناست که رنگ ها در هر دو انتهايpoint 0  و

point 1  ِاز بخشِ میانیramp .پهنايِ بیش تري دارند 

  
Linear ramp    Smooth ramp 

  
Smooth 0 ramp    Smooth 1 ramp 
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را به دست بگیرید.  color(به طور پیش فرض ، انتهايِ بالایی) برگزینید ، کنترلِ  point 1در انتهايِ  rampبراي این که رنگی را براي  .4

 رنگی را برگزینید. (به طور پیش فرض ، انتهايِ پایینی) point 0در انتهايِ  rampا به کار بگیرید تا براي ر color 0سپس ، کنترلِ 

در نمایشگر را به جايِ جدید بکشید. ممکن است نیاز باشد  p1و  p0، دستگیره هايِ  rampبراي میزان کردن گستردگی و زاویه يِ  .5

 کلیدO .را دو بار در نمایشگر فشار بدهید تا این کنترل ها نمایان شوند 

 بنویسید. textتکمه يِ  propertiesدر قابِ  point 0و  point 1را براي کنترل هايِ  yو  xبه جايِ این می توانید ارزش هايِ 

 ماسک کردن بخش هایی از نمایشگر

 چسبانده شده است : maskاست که به درون رفتRoto  به کار گرفتن یک تکمه يِ  اگر می خواهید نوشته را ماسک کنید ، آسان ترین راه

به طور پیش  Roto، ماسک را در نمایشگر بکشید. می توانید هر کانالی را به کار ببرید ، ولی تکمه يِ  Rotoپس از چسباندن تکمه يِ  .1

 را به کار می برد. Alphaفرض کانالِ 

 .rgba.alphaرا برگزینید. در این جا  mask، کانالِ  Textتکمه يِ  maskاز فهرست پایین افتادنیِ  .2

 را نشان بزنید (مانند زیر). invertبراي وارونه کردن ماسک ، گزینه يِ  .3

   
Standard masking    Inverted masking 

 افزودن سایه ها

 Shadows، و در برگه يِ  Textتکمه يِ  propertiesدر قابِ 

 ، می توانید سایه ها را به نوشته تان بیافزایید.

بروید و گزینه يِ  Shadowsبراي این کار ، به آسانی به برگه يِ 

enable drop shadows .را نشان بزنید 

 آن درست مانند رنگ اگر می خواهید سایه اي که می افتد ، رنگ

 inherit inputسایه در نگاره يِ درون رفت باشد ، گزینه يِ 

color  را نشان بزنید. وگرنه ، براي برگزیدن رنگی براي سایه ، کنترل

 را به کار بگیرید. colorهايِ 

 را به دست بگیرید. opacityبراي میزان کردن کدريِ سایه نسبت به کانالِ آلفايِ درون رفت ، گزینه يِ 
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Opacity = 0.4     Opacity = 0.8 

 درجه ، سایه جهت برابري را به خود می گیرد. 360و  0بازي کنید. در ارزشِ  angleبراي میزان کردن جهت سایه ، با لغزنده يِ 

  
Angle = 0 ( or 360)    Angle = 225 

 می توانید دوري و نزدیکی سایه از نوشته را پیکربندي کنید. distanceبه کمک کنترلِ 

  
Distance = 15     Distance = 45 

 را زیاد کنید. softnessاگر می خواهید سایه را محو کنید ، ارزشِ گزینه يِ 
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Softness = 0     Softness = 20 

را به یک ارزشِ منفی پیکربندي کنید. اگر می خواهید در سایه  Shrink/Expandاگر نیاز باشد ، براي جلوه يِ ساییدگیِ در سایه ، لغزنده يِ 

 گشادگی ایجاد کنید ، براي این کنترل ارزشِ مثبتی را به کار ببرید.

  
Shrink/Expand = -5       Shrink/Expand = 5 

 )Drop Shadowافزودن یک سایه يِ پشت (

 به کمکDropShadow gizmo  براي هر نگاره يِ درون رفت بسازید که کانالِ آلفایی با ارزشِ بزرگ تر از می توانید یک سایه يِ پشتی

 دارد. 0

1. Filter > DropShadow  را برگزینید تا یکDropShadow gizmo  ِپس از تکمه يRead .بنشیند 

2.  نگاره يِ پس زمینه تان را به درون رفتbg  ازDropShadow gizmo  بچسبانید. نگاره تان و سایه يِ پشتی بر رويِ نگاره يِ پس

 می شوند. mergeزمینه 

را نشان بزنید تا سایه يِ پشتی به کار  enable drop shadow، گزینه يِ  DropShadow gizmoاز  Propertiesدر قابِ  .3

 .(نگاره يِ سمت چپ ، پایین) بیافتد
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را به کار بیاندازید  inherit input colorنگ نگاره يِ درون رفت را به خود بگیرد ، گزینه يِ اگر می خواهید سایه يِ پشتی همان ر .4

 ، رنگی را براي سایه يِ پشتی برگزینید. color(نگاره يِ سمت چپ ، پایین). وگرنه ، به کمک کنترل هايِ 

  
 را دستکاري کنید. opacityت ، کنترلِ براي میزان کردن کدريِ سایه يِ پشتی نسبت به کانالِ آلفايِ درون رف .5

  
  Opacity = 0.4     opacity = 0.8 

، سایه  سمت راست ، پایین) درجه (نگاره يِ 360و  0را به دست بگیرید. در ارزشِ  angleبراي میزان کردن جهت سایه ، لغزنده يِ  .6

 جهت برابري را به خود می گیرد.

  
 را به کار بگیرید. distanceبراي دور و نزدیک شدن سایه به نگاره يِ درون رفت ، کنترلِ  .7

  
 را زیاد کنید (نگاره يِ سمت چپ ، پایین). Softnessاگر می خواهید سایه را محو کنید ، ارزشِ گزینه يِ  .8

  
را به یک ارزشِ منفی پیکربندي کنید. اگر می خواهید  Shrink/Expandاگر نیاز باشد ، براي جلوه يِ ساییدگیِ در سایه ، لغزنده يِ  .9

در نگاره يِ پایین سمت راست  shrink/expandدر سایه گشادگی ایجاد کنید ، براي این کنترل ارزشِ مثبتی را به کار ببرید. گزینه يِ 

 گذاشته شده است. 3.5، و سمت چپ بر رويِ  0بر رويِ 
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با هم ترکیب  bgو  inputمعلوم کنید که چگونه می خواهید درون رفت هايِ  input [operation] bgدنیِ به کمک فهرست پایین افتا .10

 شوند.
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 آنالیز و با هم جور کردن کلیپ ها __________________________

سر و کار داریم. این تکمه نمودي از یک سکانس را آنالیز کرده و بر اساسِ تجزیه و تحلیلی که انجام  CurveToolدر این بخش با تکمه يِ 

می سازد. سپس می توانید داده هايِ این خمیدگی را براي راهبرد جلوه هايِ دیگر به کار ببرید. براي  animation curveداده است یک 

 بیافزایید که با آن هماهنگ باشد. CGرا به پردازشِ  )Flickerپرِپرِ زدنی (نمونه ، می توانید 

 پیشگفتار

می توانید چهار جنبه از سکانس هاي فریم تان را بسته به الگويِ خمیدگی که در بخشِ کنترل هايِ تکمه بر  CurveToolبه کمک تکمه يِ 

 می گزینید ، آنالیز کنید :

• AutoCrop (یا هر رنگی که بردارید) آن ها را با  : بخش هايِ سیاه را در پیرامونِ لبه هايِ سکانسِ فریم پیدا می کند و اندازه و جایگاه

بسیار به کار می آید که با آن می توانید پیکسل  Crop) می کند. این الگو براي به راه انداختن یک تکمه يِ trackگذشت زمان ردیابی (

 زیابی را سرعت ببخشید.هايِ بیرونی غیر لازم را پاك کرده و بدین سان روند ار

• Avg Intensities  : تبراي به دست آوردن ارزش هايِ پیکسلی میانگین در یک سکانس فریم ، و سپس جفت و جور کردن آن شد

ه بدر هر جايِ دیگر به کار می آید. این الگو نخستین ارزش در دامنه يِ فریم و ارزشِ فریمِ برگزیده شده يِ بعدي را می گیرد ، آن ها را 

هم افزوده و مجموع را بر دو بخش می کند. آن چه به دست می آید میانگینی از دو ارزشِ گفته شده است. براي نمونه ، شاید بخواهید این 

ارزش را براي جفت و جور کردن سوسو زدن آتشی که در گستره يِ پس زمینه دارید با دودي که در گستره يِ پیش زمینه هست ، به کار 

 ببرید.

• Exposure Difference  :) نوردهی تغییراتExposure ِرا در سکانس فریم آنالیز می کند. این الگو ، نخستین ارزش در دامنه ي (

 رفریم و ارزشِ فریمِ برگزیده شده يِ بعدي را می گیرد و تفاوت میانِ آن دو را به کار می بندد. برآیند به دست آمده را می توانید در ه

 بخواهید همان نوردهی را داشته باشد ، جفت و جور کنید.جايِ دیگر که 

• Max Luma Pixel : .نه می تواند در ماین الگو براي نمو روشن ترین و تاریک ترین پیکسل ها را در سکانس فریم ردیابی می کند ورد

یکی راه می رود و چراغ قوه اي را به باشد. گمان کنید سکانسی از یک شب دارید که در آن یک نفر در خانه يِ تار زیر کاربرد داشته

بدهید. تنها اگر بدانید که روشن ترین پیکسل کجا است می  lens flareدست دارد. می خواهید به چراغ قوه اي که حرکت دارد یک 

را  lens flare) ؛ و بدون این که نیاز باشد Match-Moveرا با حرکت چراغ قوه جفت و جور کنید (به اصطلاح  lens flareتوانید 

 دستی پویانمایی کنید ، آن را در جايِ درست بنشانید.
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 CurveToolتکمه يِ  propertiesقابِ 

 CurveToolکار کرده باشید. تکمه يِ  PixelAnalyzerآشنا باشید ، ممکن است با تکمه يِ  Shakeاگر با برنامه يِ  نکته :

 است. PixelAnalyzerهمانند تکمه يِ  Nukeبرنامه يِ در 

 برش زدن لبه هايِ سیاه

 زیابی هايِ غیر ضروري را بگیرید ، می توانید لبه هايِ سیاه (یا هر رنگی که بر می گزینید) را از فیلم تان برش بزنید :ار جلويِبراي این که 

1. Image > CurveTool  ِرا برگزینید تا یک تکمه يCurveTool .پس از سکانسِ تصویري که می خواهید آنالیز شود ، بنشیند 

 بچسبانید. CurveToolرا به تکمه يِ  Viewerتکمه يِ  .2

 را برگزینید. AutoCropگزینه يِ  curve Type، از فهرست پایین افتادنیِ  CurveTool در قابِ کنترل هايِ تکمه يِ  .3

 بی شود را برگزینید.رنگی که می خواهید ردیا colorبه کمک نمادهايِ  .4

را دستکاري  Intensity Rangeبراي این که معلوم کنید تا چه درجه از رنگی که برگزیده شده است می باید برش بخورد ، لغزنده يِ  .5

 کنید.

 ، کانال هایی را برگزینید که می خواهید آنالیز شوند. channelsاز چهارگوش هايِ نشان خور و فهرست پایین افتادنیِ  .6

ر گاگر می خواهید به جايِ همه يِ فریم ها تنها بخشی از آن ها آنالیز شود ، با کشیدن لبه هايِ فریم ها به جايِ جدید در پنجره يِ نمایش .7

دارند ، بخشِ دلخواه  ROI) را معلوم کنید. یا می توانید به کمک نمادهایی که برچسبِ Region of Interest، بخشی که می خواهید (

 عریف کنید.تان را ت

8.  براي آنالیز شدن فریم ها ، کلیدGo!  ِرا بزنید. پنجره يِ گفت و گويFrames to Execute .باز می شود 

بنویسید. ا رمی باید آنالیز شوند را معلوم کنید. نخستین فریم را بنویسید. ویرگول بگذارید و آخرین فریم در این پنجره ، فریم هایی که  .9

 کلیدOK نامه يِ را بزنید. برNuke .آنالیز کردن سکانسِ فریم را آغاز می کند 

می توانید برآیندهايِ به دست آمده از آنالیز را ببینید. در این جا ارزش هايِ نماد که به رنگ آبی در می  AutoCropDataدر برگه يِ  .10

را ببینید ، بر رويِ میدانِ نماد راست  animation curveدر گذري از زمان پویانمایی شده اند. براي این که  نشانگرِ آن است کهآیند 

 را برگزینید. curve editorکلیک کرده و 

 
خمیدگیِ پویانمایی را می سازد ، می توانید براي نمونه ، از پویانمایی و یا هر یک از ارزش هايِ آن رونوشت گرفته  Nuke برنامه يِ زمانی که

 animationبر رويِ دکمه يِ  .را پایین نگه دارید Ctrlببرید تا با بخشِ آنالیز شده يِ برش جفت و جور شود. کلیدCrop  و به یک تکمه يِ 

میانِ دو نماد  expressionببرید و سپس کلید ماوس را رها کنید. با این کار یک پیوند ماوس را بکشید و بر رويِ نماد دیگري  نید.کلیک ک

 ساخته می شود.

 یز کردن شدت یک سکانس فریمآنال
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 می توانید فیلم تان را براي یافتن میانگین ارزش هايِ شدت که در آن است آنالیز کنید :

1. Image > CurveTool  ِرا برگزینید تا یک تکمه يCurveTool  در جایی مناسب ، پس از سکانسِ تصویري که می خواهید آنالیز

 شود.تان افزوده  Scriptشود ، به  Matchو 

 بچسبانید. CurveToolرا به تکمه يِ  Viewerیک تکمه يِ  .2

 را برگزینید. Avg Intensities، گزینه يِ  Curve Typeدر قابِ کنترل هايِ تکمه ، از فهرست پایین افتادنی  .3

 رگزینید.، کانال هایی که می خواهید آنالیز شوند را ب channelsاز چهارگوش هايِ نشان خور و فهرست پایین افتادنی  .4

همه يِ فریم را در بر داشته و آنالیز می شود. اگر می خواهید بخشِ کوچک تري آنالیز  Region of Interestبه طورِ پیش فرض ،  .5

را تغییر اندازه داده و جايِ آن را به دلخواه عوض کنید. براي این کار می توانید در نمایشگر لبه هايِ آن  Region of Interestشود ، 

، اندازه يِ این بخش را  propertiesدر قابِ  ROIرا به جايِ جدیدي که می خواهید بکشید. هم چنین می توانید به کمک نمادهايِ 

 تغییر بدهید.

، دامنه اي از فریم ها را بنویسید که در آن هر فریم که آنالیز می شود با فریم دیگر سنجیده می  frames base average #در میدانِ  .6

هر فریم با یک فریم بعدي سنجیده می  1شود. فریم ها پس از این که هر فریم آنالیز شد با هم سنجیده می شوند. بنا بر این ، در ارزشِ 

 فریمِ بعدي سنجیده می شود. 5، هر فریم با  5شود. در ارزشِ 

یشه نیاز ، هم هر چه دامنه فریمِ بزرگ تري را به کار بگیرید ، دقتّ ارزیابی بیش تر شده و زمان بیش تري براي آن نیاز است. به هر روي

د فریم به فریم ) ، شاید بخواهیFire Flickerسوسو زدن آتش (نیست که دامنه فریمِ بزرگی را بگیرید. براي آنالیز و جفت و جور کردن 

 زدن ها ، براي این که به میانگین خوبی دست بیابید ، نیاز به دامنه فریمِ بزرگ تري دارد. برداشتن پرِپرِجلو بروید ، ولی براي 

 .باز می شود Frames to executeرا فشار بدهید. پنجره يِ گفت و گويِ  !Goبراي آنالیز شدن سکانس ، دکمه يِ  .7

در این پنجره يِ گفت و گو دامنه فریمی که می خواهید آنالیز و جفت و جور شود را مشخص کنید. فریمِ نخستین را بنویسید ، ویرگول  .8

 سکانسِ فریم را آنالیز می کند. Nukeرا فشار بدهید. برنامه يِ  OKبگذارید و فریم آخر را بنویسید. دکمه يِ 

. در این جا می توانید برآیند هايِ به دست آمده از آنالیز را ببینید. توجه داشته باشید که میدان هايِ بروید IntensityDataبه برگه يِ  .9

را ببینید ،  animation curveدرون رفت به رنگ آبی در می آیند. این نشانگرِ آن است که این نمادها پویانمایی شده اند. براي این که 

 را برگزینید. curve editorگزینه يِ  بر رويِ ارزش ها راست کلیک کرده و

به یک تکمه يِ خمیدگیِ پویانمایی را می سازد ، می توانید براي نمونه ، از پویانمایی و یا هر یک از ارزش هايِ آن  Nukeزمانی که برنامه يِ 

Color Correction  تا با  بگیریدرونوشتتشد  آنالیز شده جفت و جور شود. کلیدCtrl نگه دارید. بر رويِ دکمه يِ  را پایینanimation 

 ماوس را رها کنید. با این کار یک پیوند دیگري ببرید و سپس کلید کلیک کنید. ماوس را بکشید و بر رويِ نمادexpression  میانِ دو نماد

 ساخته می شود.

 )Flickerبرداشتن پِرپِر زدن ها (

 را به کار بگیرید. براي این کار : CurveToolبراي ثابت کردن پرِپرِ زدن هایی که در فیلم دارید ، می توانید تکمه يِ 

 را به فیلم تان بچسبانید. CurveToolیک تکمه يِ  .1

 را برگزینید. Avg Intensitiesگزینه يِ  Curve Typeدر فهرست پایین افتادنیِ  .2
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 Region of Interest، کانال هایی را برگزینید که می خواهید آنالیز شوند. چهارچوبِ  channelsترل هايِ اگر نیاز باشد ، در بخشِ کن .3

(ROI) تان را پوشش بدهد.ایشگر میزان کنید تا بخشِ آنالیزرا در نم 

4.  هر گاه آماده بودید کلیدGo!  ِرا فشار بدهید. پنجره يِ گفت و گويFrames to Execute این جا دامنه يِ فریمی  باز می شود. در

پدیدار می  IntensityDataفیلم تان را آنالیز کرده ، و ارزش هايِ به دست آمده در برگه يِ  CurveToolرا معلوم کنید. تکمه يِ 

 شوند.

 ) بسازید و آن را به فیلم تان بچسبانید.Grade )Color > Gradeیک تکمه يِ  .5

6.  کلیدCtrl يِ  را پایین نگه داشته و از برگهIntensityData  ِتکمه يCurveTool  ِآنالیز به دست آمده را به میدان ،multiply  در

 بکشید. Gradeقابِ کنترل هايِ تکمه يِ 

را فشار  =را برگزینید. می توانید میدان که برگزیده شده است ، کلیدEdit expression  و  ت کلیک کنیدراس multiplyبر رويِ میدانِ  .7

 بدهید.

را بنویسید. با این کار ، ارزش هايِ روشنایی که تکمه  /Expression  ،1در پنجره يِ گفت و گویی که باز می شود ، در جلويِ میدانِ  .8

می تواند تغییرات روشنایی که سبب پرِپرِ زدن در فیلم تان می  Gradeشناسایی کرده است وارونه می شوند ؛ و ابزارِ  CurveToolيِ 

 ند.شود را ثابت ک

 آنالیز کردن اختلاف هايِ نوردهی

 تفاوت هایی که در نوردهی سکانس فریم تان است را می توانید آنالیز کنید :

1. Image > CurveTool  ِرا برگزینید تا یک تکمه يCurveTool .پس از سکانسِ تصویري که می خواهید آنالیز کنید افزوده شود 

 بچسبانید. CurveToolرا به تکمه يِ  Viewerیک تکمه يِ  .2

 را برگزینید. Exposure Difference، گزینه يِ  Curve Typeدر قابِ کنترل هايِ تکمه ، از فهرست پایین افتادنی  .3

 ، کانال هایی که می خواهید آنالیز شوند را برگزینید. channelsاز چهارگوش هايِ نشان خور و فهرست پایین افتادنی  .4

ه يِ فریم تنها بخشی از آن آنالیز شود ، با کشیدن لبه هايِ فریم ها به جايِ جدید در پنجره يِ نمایشگر ، بخشی اگر می خواهید به جايِ هم .5

دارند ، بخشِ دلخواه تان را  ROI) را معلوم کنید. یا می توانید به کمک نمادهایی که برچسبِ Region of Interestکه می خواهید (

 تعریف کنید.

 باز می شود. Frames to Executeرا بزنید. پنجره يِ گفت و گويِ  !Goم ها ، کلید براي آنالیز شدن فری .6

 .در این پنجره ، فریم هایی که می باید آنالیز شوند را معلوم کنید. نخستین فریم را بنویسید. ویرگول بگذارید و آخرین فریم را بنویسید .7

 کلیدOK  ِرا بزنید. برنامه يNuke  سکانسِ فریم را آغاز می کند.آنالیز کردن 

می توانید برآیندهايِ به دست آمده از آنالیز را ببینید. در این جا ارزش هايِ نماد که به رنگ آبی در می  AutoCropDataدر برگه يِ  .8

میدانِ نماد راست  را ببینید ، بر رويِ animation curveآیند نشانگرِ آن است که در گذري از زمان پویانمایی شده اند. براي این که 

 را برگزینید. curve editorکلیک کرده و 

به یک تکمه يِ از پویانمایی و یا هر یک از ارزش هايِ آن براي نمونه ، خمیدگیِ پویانمایی را می سازد ، می توانید  Nukeزمانی که برنامه يِ 

Color Correction  جفت و جور ش نوردهیِ آنالیز شدهتا با بگیرید رونوشت ود. کلیدCtrl  ِرا پایین نگه دارید. بر رويِ دکمه يanimation 
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 ماوس را رها کنید. با این کار یک پیوند دیگري ببرید و سپس کلید کلیک کنید. ماوس را بکشید و بر رويِ نمادexpression  میانِ دو نماد

 ساخته می شود.

 ردیابی کردن روشن ترین و تاریک ترین پیکسل ها

 د روشن ترین و تاریک ترین پیکسل هایی که در سکانس فریم تان دارید را ردیابی کنید :می توانی

1. Image > CurveTool  ِرا برگزینید تا یک تکمه يCurveTool .پس از سکانسِ تصویري که می خواهید آنالیز کنید افزوده شود 

 بچسبانید. CurveToolرا به تکمه يِ  Viewerیک تکمه يِ  .2

 را برگزینید. Max Luma Pixel، گزینه يِ  Curve Typeین افتادنی از فهرست پای .3

4.  براي آنالیز شدن سکانس فریم ، کلیدGo!  ِرا بزنید. پنجره يِ گفت و گويFrames to Execute .باز می شود 

فریمی که می خواهید آنالیز شود را تعریف کنید. فریم نخستین را بنویسید. ویرگول بگذارید و سپس آخرین فریم را بنویسید. بر  دامنه يِ .5

سکانس فریم را آنالیز می کند ؛ هم جایگاه و هم ارزش هايِ روشن ترین و تاریک ترین  Nukeکلیک کنید. برنامه يِ  OKرويِ دکمه يِ 

 می کند.پیکسل ها را ردیابی 

پیدا کنید. اگر توجه کنید می بینید که میدان هايِ درون رفت  MaxLumaDataنالیز را می توانید در برگه يِ برآیند به دست آمده از آ .6

 را ببینید ، بر رويِ animation curveبراي این که  به رنگ آبی در آمده اند که نشان می دهند که در گذري از زمان پویانمایی شده اند.

 را برگزینید. curve editorمیدانِ نماد راست کلیک کرده و 

خمیدگیِ پویانمایی را می سازد ، می توانید براي نمونه ، از پویانمایی و یا هر یک از ارزش هايِ آن به تکمه يِ  Nukeزمانی که برنامه يِ 

دیگري رونوشت بگیرید تا جلوه اي که در آن تکمه هست با روشن ترین و تاریک ترین پیکسل هایی که در سکانس فریم دارید جفت و جور 

 شود. کلیدCtrl رید. بر رويِ دکمه يِ را پایین نگه داanimation  دیگري ببرید و سپس کلید کلیک کنید. ماوس را بکشید و بر رويِ نماد

 ماوس را رها کنید. با این کار یک پیوندexpression .میانِ دو نماد ساخته می شود 
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 3Dترکیب بندي  ___________________________________

راه اندازي کنید ؛ چیزهایی  3Dاین امکان را به شما می دهد که براي جا به جایی هايِ دوربین یک ترکیبِ  Nukeبرنامه يِ  3Dفضايِ کاريِ 

 را در صحنه جایگزین کنید ؛ و براي همانند سازي یک محیط بعد دار واقعی هر کاري که می باید را انجام بدهید.

 کوتاه یک مرور

می پردازیم.  3D، و افزودنِ اشیاء و دوربین ها به فضايِ کاري  Nukeدر برنامه يِ  3Dاندازي یک صحنه يِ در این بخش به چگونگی راه 

ار ک هم چنین در این بخش می توانید ببینید که چگونه اشیاء بافت دهی می شوند ؛ چگونه اشیاء و دوربین ها را تغییر داده و صحنه ها را براي

 تان پردازش کنید. scriptدر بخش هايِ دیگري از 

-pan-andکاربري هايِ بالقوه يِ زیادي دارد ، ولی شما حداقل در ابتدايِ کار بیش تر دوست دارید که صحنه هايِ  3Dاگر چه فضايِ کاري 

tile  ِرا درست کنید. صحنه هايpan-and-tile  2صحنه هایی هستند که در آن پلان هايِ تصویريD ) در یک قوسcurved shape (

 .یک محیط بی درز را تداعی می کنندتوهم  ه حرکت دارد پردازش می شوند ومان شده اند ؛ و سپس با دوربینی کچید

 

 3اشیاءD  ِدر برنامه يNuke  با شکل هايِ گرد نشان داده می شوند

دارند متمایز  2Dتا بتوانید آن ها را از اشیاء دیگري که کاربردهايِ 

لا نشان داده شده است ، می توانید اشیاء کنید. همان گونه که در با

2D  3وD  تکمه اي با هم یکی کنید. براي نمونه ، می را در درخت

 3توانید یک شیءD  2را با یک کلیپD  بافت دهی کنید ، یا یک

را پردازش کرده و آن را به عنوان یک پس زمینه يِ  3Dصحنه يِ 

2D .به کار بگیرید 

 راه اندازي یک صحنه
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 Sceneاشیایی که در زیر می آیند را در خود دارد : یک تکمه يِ  3Dهر صحنه يِ 

،  card(مانند  Geometry، یک یا چند تکمه يِ  Camera، یک تکمه يِ 

sphere  ،obj ِو یک تکمه ي ، (ScanlineRender در نمونه يِ بالا ، تکمه .

) را می Card 2و  Geometry )Card 1بیرون رفت دو تکمه يِ  Sceneيِ 

می فرستد. در این  ScanlineRenderگیرد و ترکیبِ آن دو شیء را به تکمه يِ 

 برگردانده می شود. 2Dتکمه بیرون رفت به 

Script  ِشما ممکن است دارايِ چندین تکمه يScene  ،Camera  و تکمه ،

بارگذاري  properties Binکه در  3Dباشد. همه يِ اشیاء3D Render  هايِ 

 Sceneپدیدار می شوند و به این که به همان تکمه يِ  3Dده اند در نمایشگرِ ش

 کاري ندارد.چسبانده شده باشند یا نه 

 Sceneتکمه يِ 

تان است ، تکمه اي است که بالاترین تراز را در رده يِ زنجیره اي صحنه دارد ؛ چون  Script، صرف نظر از این که کجايِ  Sceneتکمه يِ 

 بازي می کند. دارید (همه يِ اشیاء هندسی ، دوربین ها و مایه ها) نقش خاستگاه را 3Dاین تکمه براي همه يِ عناصري که در فضايِ کاريِ 

 Sceneافزودن یک تکمه يِ 

3D > Scene ار برگزینید.را از نوار ابز 

 ScanlineRenderتکمه يِ 

می گوید که برآیند به دست  Nukeچسبانده شود. این تکمه به  ScanlineRenderمی باید به یک تکمه يِ  Scriptدر  Sceneهر تکمه يِ 

 3Dو  2Dمیان دو نمايِ این اجازه را به شما می دهد که  ScanlineRenderرا پردازش کند. هم چنین تکمه يِ  Sceneآمده از تکمه يِ 

 صحنه تغییر وضعیت بدهید.

 ScanlineRenderافزودن یک تکمه يِ 

 را برگزینید. Sceneتکمه يِ  .1

2. 3D > ScanlineRender .را از نوارِ ابزار برگزینید 

3.  درون رفت درگاهobj/scn  ِرا به یک تکمه يScene  یاgeometry .بچسبانید 

4.  درون رفت درگاهcam ین اصلی بچسبانید.را به دورب 

5.  اگر بخواهید ، براي ترکیب بنديِ یک نگاره يِ پس زمینه با صحنه ، آن نگاره را به درگاه يِ درون رفتbg .بچسبانید 

 در آن به نمایش در آید. ScanlineRenderرا فشار بدهید تا یک نمایشگرِ جدید باز شود و بیرون رفت تکمه يِ  Ctrl + Iکلید هايِ  .6

 هنگامی که نگاره اي را به درون رفتbg  ِمی چسبانید ، وضوحِ آن نگاره ، وضوحِ بیرون رفت براي تکمه يScanlineRender .می شود 
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 Cameraتکمه يِ 

 ScanlineRenderبچسبانید. دوربینی که به تکمه يِ  ScanlineRenderو یا به تکمه يِ  Sceneدوربین ها را می توانید یا به تکمه يِ 

 چسبانده می شود دوربینی است که براي پردازش به کار می رود.

1. 3D > Camera  ِرا برگزینید تا یک تکمه يCamera درScript .بنشیند 

را به درون رفتCamera  بچسبانید. می توانید بیرون رفت تکمه يِ  Sceneرا بکشید و به تکمه يِ  Cameraبیرون رفت تکمه يِ  .2

cam  ِتکمه يScanlineRender .بچسبانید 

می چسبانید ، 3Dهنگامی که دوربین ها را براي صحنه يِ 

دوربینی که می خواهید براي پردازش به کار بگیرید را باید به 

  بچسبانید. ScanlineRenderتکمه يِ 

هر دوربینِ دیگري که در صحنه دارید را می باید به تکمه يِ 

Scene ن دوربین به همراه یک بچسبانید. هنگامی که چندی

دارید ، با برگزیدنِ نمايِ هر یک از دوربین ها  3Dصحنه يِ 

از فهرست پایین افتادنی که در بالايِ نمایشگر است ، می توانید 

 میانِ نمايِ دوربین ها سوئیچ کنید.

 3Dبه کار بردن نمایشگرِ 

 3Dو  2D، هر پنجره يِ نمایشگر را می توانید میان دو الگويِ نمایشی  را راه اندازي کرده اید 3Dتان یک صحنه يِ  Scriptهنگامی که در 

نیز پرسپکتیوي از یک دوربین  3Dبرآیند پردازش شده يِ صحنه تان را نشان می دهد. الگويِ نمایشیِ  2Dتغییر وضعیت بدهید. الگويِ نمایشیِ 

 در صحنه را به نمایش می گذارد (نگاره يِ زیر).
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نماهايِ پیش فرض را به کار می گیرد. این نماها همانند دوربین هايِ  3Dتان ندارید ، نمایشگرِ  scriptدر  Cameraزمانی که تکمه يِ 

به  هگوناگونی عمل می کنند که از میان آن ها می توانید صحنه را به نمایش بگذارید ؛ ولی مانند یک شیء نیستند که بتوانید آن ها را در صحن

 ي بگیرید.باز

 با سانتی متر اندازه گیري ها را انجام می دهد (نه با اینچ یا پیکسل). Nukeدر برنامه يِ  3Dدنیاي  نکته :

 3Dروشِ سوئیچ کردن به نمایشگرِ 

 یک نمایشگر را باز کنید و با زدن کلیدTab  یاV  ِ3میان دو الگويD  2وD  سوئیچ

نی که در گوشه يِ بالا و راست پنجره يِ نمایشگر کنید. می توانید از فهرست پایین افتاد

 است نیز نمایی که می خواهید را برگزینید.

تان ارائه می کند. با  3D، پرسپکتیوهايِ گوناگونی را در صحنه يِ  built-inنماهايِ 

 Shift+Xبراي نمايِ راست ،  Xا عبارتند از : فشار دادن میان بر هايِ صفحه کلید به سرعت می توانید میانِ نماها سوئیچ کنید. این میان بر ه

براي پرسپکتیو سه  Vبراي نمايِ پشت ، و  Shift+Zبراي نمايِ جلو ،  Zبراي نمايِ پایین ،  Shift+Cبراي نمايِ بالا ،  Cبراي نمايِ چپ ، 

 چهارم.

 3Dناوبري در نمایشگرِ 

• Dolly  کلید :Alt ) و دکمه يِ میانی ماوسMMB داده و ماوس را بکشید.) را فشار 

• Pan  کلید :Alt  ِماوس ( چپو دکمه يLMB.را فشار داده و ماوس را بکشید ( 

• Tilt  کلید :Ctrl  ِماوس ( چپو دکمه يLMB.را فشار داده و ماوس را بکشید ( 

• Spin  کلید :Ctrl  ِماوس ( چپو دکمه يLMB.را فشار داده و ماوس را بکشید ( 

• Roll  کلید :Ctrl+Shift  ِماوس ( چپو دکمه يLMB.را فشار داده و ماوس را بکشید ( 

• Look through camera  : دوربین را برگزیده و کلید شیءH .را فشار بدهید 

• Fit the Scene  کلید :F 3تا همه يِ صحنه يِ  را فشار بدهیدD .در نمایشگر جاي بگیرد 

  3Dتغییر دادن ویژه گی هايِ نمایشیِ نمایشگرِ 

 بروید. Viewers) و به برگه يِ Shift+Sرا باز کنید ( Preferencesپنجره يِ گفت و گويِ  .1
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 بدهید. 3Dگزینه يِ  fgو  bgتغییرات دلخواه را به رنگ هايِ  .2

،  Nuke  ،Mayaمی خواهید به کار بگیرید را برگزینید ( ، شمايِ کنترلِ ناوبري ، که 3D control typeاز فهرست پایین افتادنیِ  .3

Houdini  یا ،Lightwave.( 

 کلیک کنید. Save prefesبر رويِ  .4

 zoomو  panکارهايِ  node graphو  2D، زمانی که می خواهید در پنجره هايِ نمایشگرِ  3D control typeیادداشت : 

 را انجام بدهید ، بر رويِ دکمه يِ ماوس نیز تاثیر می گذارد.

 )Look throughنگاه کردن از میانِ یک دوربین (

1.  کلیدV  3را فشار بدهید تا صحنه را از نمايِ پرسپکتیوD .(و نه از نماهايِ ارُتوگرافیک) داشته باشید 

 ، دوربینی را از فهرست پایین افتادنی که در گوشه يِ بالا و راست نمایشگر است ، برگزینید. 3Dاز پنجره يِ نمایشگرِ  .2

 

دوربینی که در این جا بر می گزینید ، دوربین به کار رفته براي پردازش را تغییر نمی دهد. این کار تنها دوربینی را  یادداشت :

 جاري ببینید. 3Dر نمایشگرِ صحنه را د می توانید تغییر می دهد که از درون آن

که  دوربینی را برگزینید دجاري هستند ، خود به خود در این فهرست پایین افتادنی پدیدار می شوند. اگر می خواهی scriptدوربین هایی که در 

 فهرست افزوده شده است.دو بار کلیک کنید تا قابِ آن باز شود. اکنون دوربین به  cameraدر این فهرست نیست ، بر رويِ تکمه يِ 

 3Dقفل کردن نمايِ دوربینِ 

، یا فشار  3D view lockرا می توانید براي دوربین و یا نوري که برگزیده شده است قفل کنید. می توانید با کلیک کردن دکمه يِ  3Dنمايِ 

 ، میانِ دو نمايِ قفل شده و بدونِ قفل تغییر وضعیت بدهید. Ctrl+Lدادن 

• Unlocked  : ِ3در این حالت می توانید آزادانه بدون هیچ محدودیتی در نمايD  ِجا به جا شوید. دکمه يlock  در این جا به رنگ

 خاکستري است.

• Locked  براي آن که نشود دوربین یا نور را جا به جا کرد ، می باید آن را قفل کنید. براي این کار : می باید دوربین یا نور را از فهرست

 است برگزیده و سپس دکمه يِ قفل را بزنید. دکمه به رنگ قرمز در می آید. 3D View lockتادنی که در سمت راست دکمه يِ پایین اف

 Interactive 3D Camera Viewالگويِ روشِ کار با 
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لید ییر بدهید. با پایین نگه داشتن کدوربین یا نور را بر حسب جا به جایی که در نمایشگر دارید ، تغ به کمک این الگو می توانید ارزش هايِ

Ctrl  ِ3و کلیک کردن بر رويِ دکمه يD View lock  ِمی توانید الگوي ،Interactive  ِرا به کار بیاندازید. زمانی که الگويInteractive 

یا  Cameraی باید یک تکمه يِ ، م Interactiveبه رنگ سبز در می آید. براي فعال کردن الگويِ  3D View lockروشن است ، دکمه يِ 

Light  ِدکمه ي راست پایین افتادنی که در سمت 3داشته باشید و آن را از فهرستD View lock .است ، برگزیده باشید 

دوربین  translate ) را فشار بدهید تا ارزش هايِ-) و منها (+روشن است ، می توانید کلید هايِ بعلاوه ( Interactiveهنگامی که الگويِ 

 می کنند. zoom outو  zoom inیا نورِ برگزیده شده تغییر بکند. زمانی که این الگو خاموش است ، این کلید ها نمايِ شما را 

 3Dاشیاء هندسیِ صحنه يِ 

 وجود دارد :به درونِ صحنه تان چندین گزینه  3Dبراي قرار دادن اشیاء هندسیِ 

 ها. Cylinderها و  Sphereها ،  Cubeها ،  Card) را بسازید : Primitiveمی توانید اشیاء نخستین ( •

 OBJدیگر ساخته اید را به درون برنامه بیاورید. این مدل ها با فرُمت3D  هایی که در برنامه هايِ  Point Cloudمدل ها و  •

)WaveFront ، (FBX  ِیا پرونده هاي ،Alembic  ِ3از برنامه هايD  مدل سازيexport .می شوند 

 بسازید. Scratchهايِ خودتان را از  Point Cloudاشیاء هندسی و  •

 را در صحنه تان قرار دادید : 3Dزمانی که یک شیء هندسیِ 

 می توانید معلوم کنید که شیء در نمایشگر چگونه نشان داده شود. •

 ) رويِ اشیاء را برگزینید.Face) و وجوهVertex) می توانید همه يِ اشیاء ، و نیز همه يِ نقطه ها ( •

 کنید. mergeمی توانید اشیاء را با هم  •

 می توانید شکلِ اشیاء را تغییر بدهید. •

 جاسازي شده اند Nukeبرنامه يِ  ربه کار بردن اشیاء نخستینی که د

Card  ، هاCube  ، هاCylinder  ها ، وSphere  ِها از شکل هايِ نخستینی هستند که به همراه برنامه يNuke .این اشیاء  ارائه می شوند

تان ، جایی که  3Dرا می توانید به عنوان قالب هايِ سازنده براي ساختنِ اشیاء پیچیده تر به کار برده ، و یا آن ها را در پس زمینه يِ صحنه يِ 

ش زمینه به جايِ اشیاء پیها تغییر شکل بدهید ، می توانید  Transformاگر بتوانید این اشیاء را با ید. گیرجزئیات به چشم نمی آیند به کار ب

 آن ها را به کار ببرید.نیز 

 ها Cardروش کار با 

ء (و شاید شی اي است که می توانید به صحنه بیاورید ءشی ، ساده ترین Cardیک 

صرفاً یک صفحه اي است که می  این شیء .اي است که بیش ترین کاربرد را دارد)

اي راه اندازيِ برتوانید آن را با یک بافت نگاشت کنید. این بافت معمولاً کلیپی است که 

 به کار می گیرید. pan-and-tile یک
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تغییر شکل بدهید. هم چنین  bicubicیا  bilinearرا به یک شیءCard  می توانید شیء  است Cardدر بخشِ نمادهايِ با کنترل هایی که 

 را به کار بگیرید. RadialDistortیا  ProceduralNoiseمانند  يدیگر 3D، تکمه هايِ  Cardمی توانید براي تغییر دادن شیء هندسی 

این اجازه را به  هایی با نقطه هايِ کنترلی بیش تر) گسترش داده می شوند. آن ها bicubicها ( bicubicبا تغییر شکل به  Cardتکمه هايِ 

کنترل بیش  Cardکه این کار براي پیچاندن یک بخش از  ؛ )subdivideکنید ( به تکه هایی کوچک تر بخش را Cardشما می دهند که یک 

، یا کرده و یا به جایی از آن یک ردیف  subdivideرا به شبکه اي با فضابندي یکنواخت  Cardمی توانید  تر و دقیق تري به شما می دهد.

 یک ستون و یا هر دو را بیافزایید. 

 : Cardافزودن یک شیء  روشِ

1. 3D > Geometry > Card  ِرا کلیک کنید تا یک تکمه يCard  درscript 

 قرار بگیرد.

2.  درگاهimg  ِتکمه يCard  ِرا به تکمه يRead  ِبچسبانید. تکمه يRead 

 بدهید. Cardنگاره اي را دارد که می خواهید آن نگاره را به تکمه يِ 

 بیاورد. 3Dبچسبانید تا آن را به صحنه يِ  Sceneرا به تکمه يِ  Cardتکمه يِ  .3

، کنترل  3Dدر فضايِ  Cardبراي دستکاري کردن جایگاه ، اندازه و چرخشِ  .4

 را به کار بگیرید. Cardشیءtransform  هايِ 

 Cardشکل دادن اشیاء تغییر 

 برگردانید و شکلِ آن را تغییر بدهید. meshرا به یک رویه يِ  Cardمی توانید  Cardاز چهارچوبِ  Deformدر برگه يِ 

) را دارد. هر شمار نقطه يِ کنترلی که خواسته باشید را می surface elasticityبیش ترین انعطاف پذیري ( bicubic deformationیک 

افزوده ، و این نقطه ها ، و تانژانت هايِ آن ها را در هر راستایی جا به جا کنید. تانژانت هايِ نقطه يِ کنترلی تاثیرِ آهن ربایی  Cardبه  توانید

 مانندي را بر رويِ رویه يِ اشیاء اجرا می کنند.

 براي تغییر شکل دادن یک شیءCard : 

 قابِ کنترل هايِ آن باز شود.دو بار کلیک کنید تا  Cardبر رويِ تکمه يِ  .1

 bicubicیا  bilinearرا براي تغییر شکل برگزینید :  meshبروید. الگويِ  Deformبه برگه يِ  .2

 
است. براي افزودن نقطه هايِ کنترلی  y، و سه تا بر رويِ آسه يِ  xدارايِ سه نقطه يِ کنترلی بر رويِ آسه يِ  Cardبه طور پیش فرض ،  .3

 ، هر یک از کارهايِ زیر را انجام بدهید : بیش تر
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کلیک کنید. براي نمونه ، اگر می  new shapeارزش هايِ جدید را بنویسید و بر رويِ دکمه يِ  x/y pointsدر میدان هايِ  •

رلی داشته باشد شش نقطه يِ کنت yچهار نقطه يِ کنترلی ، و در راستايِ آسه يِ  xخواهید شکلی داشته باشید که در راستايِ آسه يِ 

 new shapeرا بنویسید ، و سپس بر رويِ دکمه يِ  6ارزشِ  y points، و براي گزینه يِ  4ارزشِ  x points، براي گزینه يِ 

 کلیک کنید.

را  y subdivideیا  x subdivideبه طورِ یکسان بخش بخش شود ، دکمه هايِ  yو  xبراي این که شکل تان در راستاهايِ  •

در این جا یک نقطه يِ کنترلی میانِ هر نقطه يِ کنترلیِ موجود ، در راستایی که برگزیده اید افزوده می شود. میدان هايِ  کلیک کنید.

x/y points .نیز به روز می شوند و شماره يِ جاريِ نقطه هايِ کنترلی را نشان می دهند 

جايِ ستون هايِ جدید ، و لغزنده  uرا میزان کنید. لغزنده يِ  vیا  uبراي افزودن یک ردیف یا ستونی از نقطه هايِ کنترلی ، لغزنده يِ  •

جايِ ردیف هايِ جدید را مشخص می کند. در پنجره يِ نمایشگر ، یک نشانگرِ بعلاوه يِ زرد رنگ جايِ ستون یا ردیف جدید  vيِ 

جايِ آن را تغییر بدهید. با تغییر دادن جايِ این  را نشان می دهد. می توانید این نشانگرِ بعلاوه را در پنجره يِ نمایشگر بکشید و

 uvنیز به روز می شود. هنگامی که نشانگر همان جایی بود که می خواستید ، دکمه يِ  vو  uلغزنده هايِ  نشانگر ، ارزش هايِ

subdivide ره فشار بدهید ، هیچ را بزنید. یک ردیف یا ستون در جایی که مشخص کرده اید افزوده می شود. اگر دکمه را دوبا

 وجود دارد. subdivisionچیزي رخ نمی دهد ، چون در آن جا یک 

برگزیده باشید ، می توانید رفتارِ تانژانت هايِ نقطه هايِ کنترلی را میزان کنید. یعنی با تغییر  Typeرا از فهرستbicubic  اگر گزینه يِ  .4

 ییري را نشان بدهد. کارهايِ زیر را دنبال کنید :چه تغCardدادن تانژانت هایی نقطه هايِ کنترلی ، 

اصلی  کار می کنید ، تانژانت هايِ uv subdivide، یا  x subdivide  ،y subdivideاگر می خواهید زمانی که دارید با  •

بزنید. را نشان  uniform subdivisionیکنواخت تري درست کنید ، گزینه يِ  subdivisionجوري میزان شده باشند که یک 

 تانژانت هايِ اصلی را نگه می دارد. Nukeاگر این گزینه را نشان نزده باشید ، 

با کلیک کردن و کشیدن می توانید تانژانت هاي را جا به جا کنید. اگر می خواهید تانژانتی را با تانژانت روبرو با هم جا به جا کنید  •

را نشان بزنید. براي این که تانژانت را از  smooth tangentگزینه يِ  (یعنی دو تا تانژانت یک خطِّ پیوسته را شکل بدهند) ،

 تانژانت روبرو بشکنید و هر تانژانت را به تنهایی جا به جا کنید ، نشانِ این گزینه را بردارید.

زینه يِ یکسان باشد ، گبراي تغییر دادن درازايِ تانژانت روبرو ، به گونه اي که همیشه با درازايِ تانژانتی که دارید جا به جا می کنید  •

mirror tangent .روبرو تغییر نمی کند را نشان بزنید. اگر این گزینه نشان نخورده باشد ، درازايِ تانژانت 

 نمایان هستند را بکشید. mesh، نقطه هایی که در  Cardبراي تغییر شکل دادن  .5

 براي جا به جا کردن نقطه هايِ کنترلی و تانژانت ها :

 بروید. Deformدو بار کلیک کنید تا قابِ کنترل هايِ به نمایش در آیند. به برگه يِ  Cardبر رويِ تکمه يِ  .1

نشان داده می شوند. براي جا به جا کردن  Cardتکمه يِ  propertiesتنها کنترل هايِ نقطه هایی که برگزیده شده اند در پایینِ قابِ  .2

 یک نقطه يِ کنترلی دیگر ، می توانید نقطه يِ جدیدي را در پنجره يِ نمایشگر برگزیده و به کمک دکمه هايِ پیکان دار که در پایین بخشِ

 هستند ، به نقطه يِ کنترلی بعدي بروید. Cardهايِ تکمه يِ کنترل 
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 براي جا به جا کردن نقطه هايِ کنترلی و تانژانت هايِ آن ها : .3

، کنترل هایی که براي جا به جا کردن خود آن نقطه به  را زیاد و کم کنید. براي هر نقطه يِ کنترلی z، و  x  ،y هايِ شماره دارِمیدان  •

 در بالايِ کنترل هایی جاسازي شده اند که براي جا به جا کردن تانژانت هايِ نقطه به کار می روند. کار می روند 

 براي جا به جا کردن هر یک از نقطه هايِ کنترلی و تانژانت هايِ آن می توانید آن ها را نسبت به زاویه يِ دید جاري ، بکشید. •

 ها Cubeروشِ کار با 

 six-sided( پهلویک چندگوشه اي است که دارايِ شش  Cubeیک 

polyhedron است. هر یک از (هايِ این پهلوCube  و البته ، بافت )ها که می  پهلو

 کلیپ باشد) را می توانید تغییر شکل بدهید.یک تواند 

 : Cubeبراي افزودن یک 

1. 3D > Geometry > Cube  ِرا کلیک کنید تا یک تکمه يCube  درscript 

 قرار بگیرد.

2.  درگاهimg  ِتکمه يCube  ِرا به تکمه يRead  ِبچسبانید. تکمه يRead ن بافت به واکلیپی را می خواند که می خواهید آن را به عن

 کار بگیرید.

 اشته باشید.را در صحنه د Cubeبچسبانید تا بتوانید  Cubeرا بکشید و به تکمه يِ  Sceneیکی از درگاه هايِ شماره دارِ تکمه يِ  .3

 دستکاري کنید. 3Dرا در فضايِ  Cube، جا ، اندازه و چرخشِ  Cubeشیءtransform  به کمک کنترل هايِ  .4

 می توانید هر یک از پهلوهايِ آن را جا به جا کنید. Cubeبراي تغییر دادن شکلِ  .5

 Cubeجا به جا کردن پهلوهايِ  روشِ

 دو بار کلیک کنید تا قابِ کنترل ها و نمادهايِ آن به نمایش در آیند. Cubeبر رويِ تکمه يِ  .1

، به پهلويِ  n، به پهلويِ پایینی ؛  yبه پهلويِ چپ ؛  xنگاه کنیم :  Cubeبه شیءZ  +را زیاد و کم کنید. (اگر از نمايِ  cubeمیدان هايِ  .2

 به پهلويِ جلویی اشاره دارند).،  f، به پهلويِ بالایی ؛ و  t، به پهلويِ راست ؛  rپشتی ؛ 

 نسبت به زاویه يِ دیدي که در آن هستید بکشید. ، می توانید آن پهلو را Cubeبراي جا به جا کردن هر یک از پهلوهايِ 

 ها Cylinderروشِ کار با 
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 یک شیءCylinder  و یا بیضويِ شکل بوده برابر است که گرد دارايِ دو انتهايِ تخت

) ، یا Geometric resolutionو یک پهلويِ قوس دار دارد. وضوحِ هندسی (، 

 شیء شمارِ وجوهCylinder  را تغییر (این وجوه که می تواند نگاره باشد و البته بافت)

 بدهید.

 : Cylinderافزودن یک شیء  روشِ

1. 3D > Geometry > Cylinder  ِرا کلیک کنید تا یک تکمه يCylinder 

 قرار بگیرد. scriptدر 

2.  درگاهimg  ِتکمه يCylinder  ِرا به تکمه يRead  ِبچسبانید. تکمه يRead  نگاره اي را می خواند که می خواهید آن را به عنوان

 بافت به کار بگیرید.

را در صحنه داشته  Cylinderبچسبانید تا بتوانید  Cylinderرا بکشید و به تکمه يِ  Scene یکی از درگاه هايِ شماره دارِ تکمه يِ .3

 باشید.

 دستکاري کنید. 3Dرا در فضايِ  Cylinder، جا ، اندازه و چرخشِ  Cylinderشیءtransform  به کمک کنترل هايِ  .4

 میزان کردن  وضوحِ هندسی

ستون است. به هر روي  30ردیف و  30 دارايِ Cylinderبه طورِ پیش فرض ، یک 

، می توانید شمارِ ردیف ها و ستون ها را زیاد و کم کنید. براي نمونه ، در این نگاره 

ستون کاهش  3ردیف و  10استوانه اي نشان داده شده است که وضوحِ هندسیِ آن به 

 داده شده است.

 : Cylinderبراي میزان کردن وضوحِ هندسیِ 

ن به نمایش در آیند. آ دو بار کلیک کنید تا نمادهايِ Cylinderبر رويِ تکمه يِ  .1

 شیء نیز در صحنه برگزیده خواهد شد.

 را زیاد و کم کنید. rowsبراي میزان کردن شمارِ بخش هايِ استوانه در پهنا ، میدانِ  .2

 را زیاد و کم کنید. columnsبراي میزان کردن شمارِ بخش هايِ استوانه در درازا ، میدانِ  .3

 ها Sphereروشِ کار با 

شکل است. می توانید وضوحِ هندسی و یا شمارِ  گويیک چندگوشه ايِ  Sphereیک 

 وجوه آن را کنترل کنید (و البته آن را با نگاره ها بافت دهی کنید).

 : Sphereافزودن یک  روشِ

1. 3D > Geometry > Sphere  ِرا کلیک کنید تا یک تکمه يSphere  در

script .قرار بگیرد 
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2.  درگاهimg  ِتکمه يSphere  ِرا به تکمه يRead  ِبچسبانید. تکمه يRead  نگاره اي را می خواند که می خواهید آن را به عنوان

 بافت به کار بگیرید.

 را در صحنه داشته باشید. Sphere بچسبانید تا بتوانید Sphereرا بکشید و به تکمه يِ  Sceneیکی از درگاه هايِ شماره دارِ تکمه يِ  .3

 دستکاري کنید. 3Dرا در فضايِ  Sphere، جا ، اندازه و چرخشِ  Sphereشیءtransform  به کمک کنترل هايِ  .4

 میزان کردن وضوحِ هندسی

ستون است. به هر روي ،  30ردیف و  30دارايِ  Sphereبه طورِ پیش فرض ، یک 

می توانید شمارِ ردیف ها و ستون ها را زیاد و کم کنید. براي نمونه ، در این نگاره گویی 

ستون کاهش داده شده است  4ردیف و  2نشان داده شده است که وضوحِ هندسیِ آن به 

  ساختید). Octahedron(با این کار در واقع یک 

  : Sphereکردن وضوحِ هندسیِ میزان  روشِ

آن به نمایش در آیند.  دو بار کلیک کنید تا نمادهايِ Sphereبر رويِ تکمه يِ  .1

 شیء نیز در صحنه برگزیده خواهد شد.

 را زیاد و کم کنید. rowsدر پهنا ، میدانِ  گويبراي میزان کردن شمارِ بخش هايِ  .2

 را زیاد و کم کنید. columnsدر درازا ، میدانِ  گويبراي میزان کردن شمارِ بخش هايِ  .3

 Nukeها از برنامه هايِ دیگر به درون  Point Cloudآوردنِ اشیاء هندسی و 

بیاورید. بسته  Nukeساخته اید را به درون برنامه يِ  Boujouیا  Mayaگاهی می باید پرونده ها یا اشیایی که در برنامه هايِ دیگر ، مانند 

 به آن چه که می خواهید ، و از جایی که می خواهید به درون برنامه بیاورید ، راه هايِ گوناگونی وجود دارد :

 )OBJ ).objآوردنِ اشیاء هندسی از پرونده هايِ  •

که برنامه هايِ بسیاري می یک فرُمت استانداردي است  FBX ).fbx .(FBXها از پرونده هايِ  Point Cloudآوردن اشیاء هندسی یا  •

هستند که می توانید به کمک آن ها دوربین ها ،  3Dشاملِ صحنه هايِ  fbx.کنند. پرونده هايِ  exportتوانند این گونه پرونده ها را 

 بیاورید. Nukeها را به درونِ برنامه يِ  Point Cloudها و  meshها ،  transformنورها ، 

رایج می توانید این پرونده  3D). از بسیاري از برنامه هايِ Alembic ).abcها از پرونده هايِ  Point Cloudآوردن اشیاء هندسی و  •

 کنید. exportها را 

 OBJآوردن اشیاء هندسی از پرونده هايِ 

 پرونده هایی که با فرُمتOBJ )Wavefront از برنامه هايِ نرم افزاريِ دیگر ذخیره (

بیاورید. در برنامه  Nukeدر  3Dوانید به درونِ یک صحنه يِ سازي شده اند را می ت

را دستکاري کنید ؛ ولی می توانید به  OBJهايِ اشیاءvertex  نمی توانید  Nukeيِ 

 ) بدهید.transform( و یا آن ها را تغییر شکل دادهآن ها بافت 
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 Nukeبه درون برنامه يِ  OBJآوردن یک شیء  روشِ

 بنشیند. scriptدر  ReadGeoکلیک کنید تا یک تکمه يِ  3D > Geometry > ReadGeoبر رويِ  .1

پدیدار  file navigationکلیک کنید. پنجره يِ گفت و گويِ  fileبر رويِ شمایلِ پوشه در جلويِ میدانِ  ReadGeoدر بخشِ نمادهايِ  .2

 می شود.

 را می خواند. OBJپرونده يِ  Nukeکلیک کنید. برنامه يِ  Openاست بروید و بر رويِ دکمه يِ  OBJبه جایی که پرونده يِ  .3

4.  درگاهimg  ِاز تکمه يReadGeo  ِرا بکشید و آن را به تکمه يRead  ِبچسبانید. تکمه يRead  کلیپی را دارد که می خواهید آن را

 به کار ببرید. ReadGeoبه عنوان بافت براي تکمه يِ 

را در صحنه داشته  OBJبچسبانید تا بتوانید شیءReadGeo  را بکشید و به تکمه يِ  Sceneه يِ یکی از درگاه هايِ شماره دارِ تکم .5

 باشید.

 FBXها از پرونده هايِ  Point Cloudآوردن اشیاء هندسی و 

FBX  ِاستاندارد براي پرونده هاي 3یک فرُمتD  ِآن می توانید به صحنه هاي 3است که به کمکD ِ3 که در برنامه هايD  دیگر ساخته اید و

است که دارايِ دوربین  3Dدارید یک صحنه يِ  fbx.این فرُمت را پشتیبانی می کنند ، دسترسی داشته باشید. آن چه که معمولاً در پرونده يِ 

، مایه ها و ... است. از  NURBS )non-uniform rational B-spline ، (transformationها ، خمیدگی هايِ  meshها ، نورها ، 

بیاورید. بدین سان می توانید ، براي  Nukeها را به درون برنامه يِ  meshها ، و  transformاین صحنه می توانید دوربین ها ، نورها ، 

باره در برنامه يِ را دو meshبه بیرون بفرستید ؛ و سپس همان  fbx.ساخته و آن را با فرُمتMaya  را در برنامه يِ  meshنمونه ، یک 

Nuke .به کار بگیرید 

نوشته شده اند.  FBXمشکل دارید ، شاید به سبب آن باشد که آن ها با نسخه يِ قدیمی ترِ  FBXاگر با پرونده هايِ  نکته :

هستند.  binary  ،ASCIIاگر آن ها خیلی آهسته بارگذاري می شوند ، ممکن است به سبب آن باشد که آن ها به جايِ 

 Autodeskي این که بتوانید این مشکل ها را دور بزنید ، می توانید از وب سایت برا

)http://usa.autodesk.com/fbx/download/( FBX Converter  ِرا به کار ببرید. با این برنامه می توانید فرُمت هاي

 ) را به هم برگردانید.binary، و  FBX  ،ASCIIگوناگون (یعنی نسخه هايِ قدیمی 

 fbx.ها از پرونده هايِ  meshآوردن 

ها برگردانده شده اند) را  meshکه به  Patchو رویه هايِ  NURBSها (یا خمیدگی هايِ  meshمی توانید  ReadGeoبه کمک تکمه يِ 

 meshتک ، و یا همه يِ  meshمی توانید یک  ReadGeoبیاورید. به کمک یک تکمه يِ  Nukeبه درون برنامه يِ  FBXاز پرونده هايِ 

 هستند را بخوانید. fbx.هایی که در یک پرونده يِ 

 clusterیا  shape deformerخوانده می شوند. اگر هر گونه  0در فریمِ  meshهايِ  vertex colorها ، و  UVورتکس ها ، نرمال ها ، 

deformer ا خوانده نمی شوند.داشته باشید ، به ورتکس ها داده می شوند. مایه ها یا بافت ه 

 : fbx.از یک پرونده يِ  meshبراي آوردن یک 

1. 3d > Geometry > ReadGeo  ِرا برگزینید تا یک تکمه يReadGeo  درscript .تان قرار بگیرد 
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(که دارايِ  fbx.کلیک کرده و به جایی که پرونده يِ  file، بر رويِ شمایلِ پوشه در کنارِ میدانِ  ReadGeoدر بخشِ کنترل هايِ تکمه يِ  .2

mesh  ِاست) ذخیره شده است بروید. آن را برگزیده و دکمه يOpen .را بزنید 

به کار ببرید را برگزینید. پرونده هايِ  fbx.، گرایشی که می خواهید از یک پرونده يِ  Animation Stackاز فهرست پایین افتادنیِ  .3

FBX  این توانایی را دارند که تنها در یک پرونده ، چندین گرایش را پشتیبانی کنند. معمولاً یکی از این گرایش ها ، هیچ گونه پویانمایی

 ندارد و گرایشِ پیش فرض است.

 بیاورید را برگزینید. Nukeبه درون  FBXکه می خواهید از پرونده يِ  node name  ،mesh از فهرست پایین افتادنی .4

بنویسید (بر حسب فریم  frame rateها ، ارزشِ جدیدي را در میدانِ  animation curveبراي میزان کردن نرخِ فریم به کار رفته در  .5

را نشان زده باشید ، به کار می آید ؛ وگرنه ، نرخِ فریم از  use frame rateدر ثانیه). نرخِ فریمی که می نویسید ، تنها اگر گزینه يِ 

 به کار گرفته می شود. fbx.ه يِ خود پروند

بیاورید ، همه يِ  Nukeاست را به درون برنامه يِ  fbx.هایی که در پرونده يِ  mesh، همه يِ  meshاگر می خواهید به جايِ یک  .6

پویانمایی شده می شود. اگر اشیاء  نادیده گرفتهبرگزیده شده است ،  node nameاشیاء را نشان بزنید. با این کار آن چه که در زیرِ 

می گردد و  بر meshهر شیء به نقطه هايِ  transformرا نشان بزنید. با این کار ،  read on each frameباشند ، گزینه يِ 

 پویانمایی نگه داشته می شود.

 readآورده اید را تغییر بدهید ، نشانِ گزینه يِ  Nukeبه  fbx.که از پرونده يِ  transformاگر می خواهید ویژه گی هايِ  .7

transform from file  به جا می مانندرا بردارید. تا زمانی که این گزینه نشان نداشته باشد ، تغییراتی که می دهید. 

 د.کلیک کنی Reload، بر رويِ دکمه يِ  fbx.از پرونده يِ  transformبراي بارگذاريِ دوباره يِ ویژه گی هايِ  .8

 Nukeبه درون  fbx.ها از پرونده هايِ  Point Cloudآوردن 

بیاورید. براي آوردن یک  Nukeنیز به درون برنامه يِ  FBXها را از پرونده هايِ  Point Cloudمی توانید  ReadGeoبه کمک تکمه يِ 

Point Cloud  ِاز یک پرونده ي.fbx : 

1. 3D > Geometry > ReadGeo کمه يِ را برگزینید تا یک تReadGeo  به درونscript .قرار بگیرد 

را ذخیره کرده اید  fbx.را کلیک کنید و به جایی که پرونده يِ  file، شمایلِ پوشه در کنارِ میدانِ  ReadGeoدر بخشِ کنترل هايِ  .2

 را کلیک کنید. Openاست که می خواهید آن را به درون برنامه بیاورید. دکمه يِ  Point Cloudدارايِ  fbx.بروید. این پرونده يِ 

به کار ببرید را برگزینید. پرونده هايِ  fbx.، گرایشی که می خواهید از یک پرونده يِ  Animation Stackاز فهرست پایین افتادنیِ  .3

FBX را پشتیبانی کنند. معمولاً یکی از این گرایش ها ، هیچ گونه پویانمایی  این توانایی را دارند که تنها در یک پرونده ، چندین گرایش

 ندارد و گرایشِ پیش فرض است.

 را برگزینید. Point Cloud، گزینه يِ  object typeدر فهرست پایین افتادنیِ  .4

بنویسید (بر حسب فریم  frame rateها ، ارزشِ جدیدي را در میدانِ  animation curveبراي میزان کردن نرخِ فریم به کار رفته در  .5

را نشان زده باشید ، به کار می آید ؛ وگرنه ، نرخِ فریم از  use frame rateدر ثانیه). نرخِ فریمی که می نویسید ، تنها اگر گزینه يِ 

 به کار گرفته می شود. fbx.خود پرونده يِ 
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 readآورده اید را تغییر بدهید ، نشانِ گزینه يِ  Nukeبه  fbx.که از پرونده يِ  transformاگر می خواهید ویژه گی هايِ  .6

transform from file  به جا می مانندرا بردارید. تا زمانی که این گزینه نشان نداشته باشد ، تغییراتی که می دهید. 

 کلیک کنید. Reload، بر رويِ دکمه يِ  fbx.از پرونده يِ  transformبراي بارگذاريِ دوباره يِ ویژه گی هايِ  .7

 Alembicها از پرونده هايِ  Point Cloudآوردن اشیاء هندسی و 

Mesh  ِها (یا خمیدگی هايNURBS  ِو یا رویه هايPatch  که بهmesh  ها برگردانده شده اند) وPoint Cloud  ها را می توانید از

در  بیاورید. Nuke) به درون صحنه هايِ abc.(فرُمتAlembic  پرونده هايِ 

با یک پنجره يِ گفت و گويِ  Nukeهنگامی که پرونده را به درون برنامه می آورید ، 

Import  ِاین اجازه را به شما می دهد که بتوانید بر رويِ تکمه هایی که در صحنه ي

Alembic  که دارند بارگذاري می شوند کنترل داشته باشید. اگر تنها یک آیتم در

در نگاره يِ روبرو یک  خود به خود بارگذاري می شود.باشد ،  Alembicپرونده يِ 

 Sonyآورده شده است (از شرکتNuke  که به درون برنامه يِ  Alembicپرونده يِ 

Pictures Imageworks.( 

به  Alembicها را نیز از پرونده يِ transformها ، می توانید دوربین ها و  Point Cloudها و  meshبه جز  نکته :

 بیاورید. Nukeرنامه يِ درون ب

 Alembicها از یک پرونده يِ  Point Cloudها و  meshآوردن  روشِ

پدیدار  Read file(s)را فشار بدهید. پنجره يِ گفت و گويِ  Rرا کلیک کنید یا کلیدNode Graph  ،Image > Read  در پنجره يِ  .1

 می شود.

 Open، بروید. آن را برگزینید و دکمه يِ بیاورید  Nukeاست و می خواهید آن را به درون برنامه يِ  Alembicبه جایی که پرونده يِ  .2

 را بزنید.

نمایان می شود. به طور پیش فرض ، زمانی که این پنجره باز می شود ، همه يِ آیتم هایی  Alembic importپنجره يِ گفت و گويِ 

 اند (مانند نگاره يِ زیر).دارید برگزیده شده  Scene Graphکه در 

 
آیتم هايِ پدري که برگزیده اند با یک گردي زرد رنگ نشانه گذاري شده اند. آیتم هايِ فرزند که برگزیده شده اند با یک نوارِ زرد رنگ 

ند ، برگزیده نشده باشمشخص شده اند (زمانی که این آیتم ها را در فهرست بر می گزینید ، به رنگ نارنجی در می آیند). آیتم هایی که 

 هیچ گونه نشانه اي در کنارشان دیده نمی شود.

آیتمِ ریشه را از حالت گزینش در آورید. براي  می باید بیاورید ، نخست Nukeاگر می خواهید آیتم هايِ خاصی را به درون برنامه يِ  .3

-deاین کار بر رويِ گرديِ زرد رنگ کلیک کنید. با این کار آیتمِ ریشه و آیتم هايِ فرزند آن همگی از حالت گزینش در می آیند (
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select در ). سپس آیتم هایی که می خواهید راScene Graph  فضايِ خالی ، جایی که نشانه هايِ برگزینید. براي این کار ، در همان

 گردي بودند کلیک کنید.

 
 یک آیتم راست کلیک کنید : بر رويِبه جايِ این کار ، می توانید 

• Select as parent  : اگر این گزینه را برگزینید ، آیتم را براي آیتم هايِ دیگر پدر می کنید. بدین سان می توانید براي این آیتم

 جداگانه اي بسازید. Nukeفرزندي که در زیرِ آن هستند) در گامِ بعدي یک تکمه يِ  (و همه يِ آیتم هايِ

• Select as child : .نزدیک ترین آیتمِ پدري می کنید که در بالايِ رده است اگر این گزینه را برگزینید ، آیتم را فرزند 

• Deselect : گزینش در می آید و دیگر از صحنه به درون ب رنامه يِ آیتم از حالتNuke .آورده نمی شود 

 با نگه داشتن کلیدCtrl  و یاShift .و کلیک کردن آیتم ها ، می توانید چندین آیتم را با هم برگزینید ، 

 یکی از کارهايِ زیر را انجام بدهید : .4

ساخته شود. در  Nukeکلیک کنید تا براي آن چه که برگزیده اید یک تکمه در  Create all-in-one nodeبر رويِ دکمه يِ  •

 این جا فرقی نمی کند آیتم هایی که برگزیده اید پدري هستند یا آیتم هايِ فرزند.

کلیک کنید تا براي هر آیتمِ پدري که برگزیده اید (گرديِ زرد رنگ)  Create parents as separate nodesبر رويِ دکمه يِ  •

يِ آیتم هايِ فرزندي (نوارِ زرد رنگ) که در زیرِ آیتمِ پدري باشند را در ساخته شود. این تکمه همه  Nukeیک تکمه در برنامه يِ 

 بر می گیرد.

بیاورید ، تکمه  Nukeبه درون برنامه يِ  Alembicبسته به آیتمی که برگزیده اید و می خواهید از صحنه يِ پرونده يِ  Nukeبرنامه يِ 

 را می سازد. Axis، و  ReadGeo  ،Cameraهايِ 

 می توانید چیزهايِ زیر را میزان کنید : ReadGeoهايِ  در تکمه .5

را نشان زده باشید. بدین  read on each frameاگر اشیایی که به درون برنامه می آورید پویانمایی شده اند ، می باید گزینه يِ  •

ز کار انداخته باشید ، براي را ا read on each frameسان پویانمایی آن جور که هست نگه داري می شود. زمانی که گزینه يِ 

 را به کار بگیرید. lock frameبرگزیدن فریمی که شیء در آن فریم بارگذاري شود ، گزینه يِ 

 را از کار بیاندازید. sub frame، گزینه يِ  پردازش شود ، براي سرعت بخشی به کار motion blurاگر نمی خواهید  •

 ، نرخِ فریم را معلوم کنید (بر حسب فریم در ثانیه). frame rateدر میدانِ  •

ها)  Particleمی شوند یا  Nukeها در برنامه يِ  Point Cloudها (که یا شاملِ  Point Primitiveبراي این که مشخص شود  •

 را به کار بگیرید. render point asچگونه پردازش شوند ، گزینه يِ 

خوانده  abc.را به کار بیاندازید. بدین سان ، ویژه گی هايِ رنگ اشیاء هندسی از پرونده هايِ  use geometry colorsگزینه يِ  •

 داده می شود. Nukeشده و به اشیاء هندسی در 

 ، در پرونده Nukeاگر این گزینه را از کار بیاندازید ، این کنترل می تواند در مقایسه با نسخه هايِ پیشینِ برنامه يِ  یادداشت :

را در  use geometry colorsاي که پردازش می کنید گوناگونی هایی را سبب شود. اگر چنین چیزي رخ بدهد ، گزینه يِ 

 به کار بیاندازید. ReadGeoتکمه يِ  properties قابِ
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می شود.  فهرست ReadGeoاز تکمه يِ  Scenegraphآمده باشد ، در برگه يِ  Nukeکه به درون برنامه يِ  meshهر آیتمِ  •

 view entireدر این برگه فهرست شوند ، گزینه يِ  هستند ، Alembicبراي این که همه يِ آیتم هایی که در پرونده يِ 

scenegraph  راست را نشان بزنید. بدین سان می توانید با کلیک کردن بر رويِ نشانه هايِ زرد رنگ و یا فضايِ خالی در سمت

 کرده و یا به آن بیافزاید.، آیتم ها را از فهرست پاك 

نیز  Axis، یا  ReadGeo  ،Camera، می توانید یک تکمه يِ  Alembicبراي بارگذاريِ آیتم هايِ خاص از پرونده يِ  نکته :

کلیک کرده و به جایی که پرونده  fileرا نشان بزنید ، و بر رويِ شمایلِ پوشه در برگه يِ  read from fileبسازید. گزینه يِ 

 است بروید. abc.يِ 

 Scratchها و اشیاء هندسی از  Point Cloudساختنِ 

و اشیایی که به درون برنامه می آورید ، این امکان براي شما فراهم شده ، جاسازي شده اند  Nukeبه جز اشیاء نخستینی که در خود برنامه يِ 

 سازید.ب Scratchها را نیز از  Dense Point Cloud اشیاء هندسی و است تا

 در این جا به ساختPoint Cloud  ِتکمه هاي ها به کمکDepthToPosition  ،PositionToPoints  و ،DepthToPoints  می

را براي ساختنِ  PointCloudGeneratorو  CameraTrackerرا داشته باشید می توانید تکمه هايِ  NukeXپردازیم. به هر روي ، اگر 

Point Cloud  ِها ، یا تکمه يModeBuilder  ِمدل هاي 3را براي ساختD  ِ2براي فیلم هايD .نیز به کار ببرید 

 DepthToPositionبه کمک تکمه يِ  Position Passساختنِ یک 

را می گیرد و از  ، و داده هايِ دوربین ک پرونده يِ تصویري ذخیره شده اند) که در یDepthداده هايِ ژرفا ( DepthToPositionتکمه يِ 

، و  تابانده شده ژرفا از میانِ دوربین بدین گونه ساخته می شود که Pass) می سازد. این xyz(در راستايِ  2D Position Passیک  ها آن

ه يِ را می توانید همراه با تکم DepthToPositionهر یک از نقطه هايِ تابانده شده ذخیره سازي می شود. تکمه يِ  xyzجایگاه هايِ 

PositionToPoints  به کار برده وPoint Cloud  ِها را بسازید. درست مانند کاري که می شود با تکمه يDepthToPoints .انجام داد 

یک  روشِ ساختPosition Pass  ِتکمه ي به کمکDepthToPosition 

1.  3از فهرستD > Geometry  ،DepthToPosition  را برگزینید تا تکمه اي

 تان افزوده شود. scriptبه همین نام به 

است را بخوانید و آن را به درگاه درون رفتDepth Pass  نگاره اي که دارايِ  .2

image .تکمه بچسبانید 

3.  3از فهرستD  دوربینی را برگزیده و آن را به درگاهی درون رفت ،camera  از

 .(نگاره يِ سمت راست ، پایین) بچسبانید DepthToPositionتکمه يِ 

را از فهرستdepth  از همین تکمه ، کانالِ  DepthToPositionدر برگه يِ  .4

را در  position passبرگزینید. اکنون باید بتوانید یک  depthپایین افتادنیِ 

 پنجره يِ نمایشگر ببینید (نگاره يِ سمت چپ ، پایین).
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، کانالی که دوست دارید را برگزیده ، یا خودتان  outputبیرون رفت را تغییر بدهید ، از فهرست پایین افتادنیِ اگر می خواهید کانالِ  .5

 کانال را بسازید.

با این کار ، را پیکربندي کنید.  farبگیرد ، ارزشِ کنترلِ  هرا نادید depthبراي این که معلوم کنید دوربین از چه فاصله اي ارزش هايِ  .6

 ناخواسته (که به ارزیابی هايِ ریاضیاتی دقیقی نیاز دارند) جلوگیري می شود. bandingبراي ساختنِ  depth بزرگ هايِ ارزشاز 

بسازید و سپس  position passدر یک نگاره یک  depth passاین اجازه را به شما می دهد که از یک  DepthToPositionتکمه يِ 

 DepthToPositionبسازید. در واقع سه تکمه يِ  Point Cloudببرید و از آن یک  PositionToPointsآن چه ساخته اید را به تکمه يِ 

 ،PositionToPoints  و ،DepthToPoints  ِرا می توانید با هم به کار ببرید. تکمه يDepthToPoints  یکgizmo  است که تکمه

 را در خود دارد. PositionToPointsو  DepthToPositionهايِ 

 PositionToPointsبه کمک تکمه يِ  Dense Point Cloudساختنِ یک 

که در یک نگاره يِ تصویري ذخیره سازي شده است (نگاره يِ پردازش شده از یک  positionداده هايِ  PositionToPointsتکمه يِ 

، و  x  ،yبازسازي می کند. ورتکس هايِ  Nukeدر برنامه يِ  dense 3D Point Cloud) را می گیرد و آن را به عنوان یک 3Dبرنامه يِ 

z  ِدر کانالposition  ِ3براي تعریفی جایگاه هايِ نقطه در فضايD  به کار گرفته می شوند. اندازه و شمار يِ هر یک از این نقطه ها را می

 میزان کرد. point detailو  point sizeتوان به کمک کنترل هايِ 

یک  روشِ ساختPoint Cloud  ِتکمه ي به کمکPositionToPoints 

1.  3از فهرستD > Geometry  ِتکمه ي ،PositionToPoints  را برگزینید تا تکمه اي به همین نام بهscript .تان افزوده شود 

 را بخوانید و آن را به تکمه بچسبانید. position passیک  .2

جداگانه اي  normalو  positionاگر چندین نگاره دارید که دارايِ داده هايِ 

 هستند ، آن ها را به درگاه هايِ درون رفتpos  وnorm .بچسبانید 

 به یاد داشته باشید که درگاه هاي درون رفتpos  وnorm  تنها زمانی نمایان می

 بچسبانید.) را unnamed inputشوند که درون رفت بدون نامی (

در نگاره يِ روبرو ، نرمال ها در نگاره يِ منبع موجود هستند ، و این نگاره يِ دوم 

 است. position passاست که دارايِ 
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 را برگزینید. اگر نگاره تان کانالِ نرمال هم دارد ، آن کانال را نیز از فهرستposition ، کانالِ  surface pointاز فهرست پایین افتادنیِ  .3

 را در پنجره يِ نمایشگر ببینید. Point Cloudبرگزینید. اکنون می باید  surface normalپایین افتادنیِ 

 اگر از درگاه هايِ درون رفتpos  وnorm  ِداده هاي ،position  وnormal پایین  به تکمه بدهید ، فهرست هايِ جدا از هم را

 ز کار می افتند.ا surface normalو  surface pointافتادنیِ 

به این معناست که هیچ نقطه اي نمایش  0را میزان کنید. یک ارزشِ برابر با  point detailبراي تغییر دادن شمارِ نقطه ها ، لغزنده يِ  .4

 بدین معناست که همه يِ نقطه ها به نمایش در آیند. 1داده نشود. ارزشی برابر با 

 را به دست بگیرید. point sizeبراي تغییر دادن اندازه يِ نقطه ها ، لغزنده يِ  .5

 Point Cloud  ِکه با تکمه يPositionToPoints .ساخته شده است 

 DepthToPointsبه کمک تکمه يِ  Point Cloudساختنِ یک 

را در خود دارد. این تکمه را  PositionToPointsو  DepthToPositionاست که تکمه هايِ  gizmoیک  DepthToPointتکمه يِ 

داده  DepthToPointsبه کار ببرید. تکمه يِ  3D Cameraو  depth passاز یک  3D Point Cloudمی توانید براي ساخت یک 

 کند.بازسازي می  3D Point Cloudهايِ ژرفا و رنگ که در یک پرونده يِ تصویري است را می گیرد و نگاره را به شکلِ یک 

 DepthToPointsبه کمک تکمه يِ  Point Cloudروشِ ساخت یک 

1.  3از فهرستD > Geometry  ِتکمه ي ،DepthToPoints  را برگزینید تا یکgizmo  بهscript .تان افزوده شود 

 بچسبانید. gizmoاز  imageدارد را بخوانید و آن را به درگاه درون رفتdepth pass  نگاره اي که یک  .2

3.  3از فهرستD  ِتکمه ي درون رفت یک دوربین برگزیده و آن را به درگاه ،DepthToPoints .بچسبانید 

را از فهرست پایین  depth، کانالِ  DepthToPointsاز تکمه يِ  Userدر برگه يِ  .4

نیز باشد ، این  normalبرگزینید. اگر کانالِ شما دارايِ یک کانالِ  depthافتادنیِ 

برگزینید. البته می توانید نگاره  surface normalاز فهرست پایین افتادنیِ کانال را 

 درون رفت اي که دارايِ داده هايِ نرمال است را به درگاهnorm  .از تکمه نیز بچسبانید

 را در پنجره يِ نمایشگر ببینید. Point Cloudاکنون می باید 

را میزان کنید. یک ارزشِ  point detailبراي تغییر دادن شمارِ نقطه ها ، لغزنده يِ  .5

بدین  1به این معناست که هیچ نقطه اي نمایش داده نشود. ارزشی برابر با  0برابر با 

 معناست که همه يِ نقطه ها به نمایش در آیند.
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 را به دست بگیرید. point sizeبراي تغییر دادن اندازه يِ نقطه ها ، لغزنده يِ  .6

 

 مشکل دارید ، ببینید که کانالِ آلفايِ نگاره بر رويِ سیاه پیکربندي نشده باشد. Point Cloudاگر براي دیدن نگاره و  نکته :

 ویژه گی هايِ نمایشیِ شیء

حنه که صاین پیکربندي ها بر رويِ پردازشی از  می توانید ویژه گی هايِ نمایشی همه يِ اشیاء هندسی که در یک صحنه هستند را میزان کنید.

 به کار می آیند. 3Dبیرون می فرستید تاثیري ندارند. این پیکربندي ها تنها براي اهداف نمایشی در نمایشگرِ 

 روشِ ویرایش کردن یکی از ویژه گی هايِ نمایشیِ شیء

 دو بار کلیک کنید تا نمادهايِ آن به نمایش در آیند. Objectبر رويِ یک تکمه يِ  .1

 ، الگويِ نمایشی که می خواهید شیء با آن الگو به نمایش در آید را برگزینید. displayنیِ از فهرست پایین افتاد .2

 

 در این فهرست گزینه هایی چیدمان شده اند که معلوم می کنند شیء چگونه به نمایش در آید :

• Wireframe : ِپیرامون هندسی به نمایش در می آید در این الگو تنها خطوط است ، پایین)(نگاره يِ ر شیء. 

• Solid ر به نمایش گذاشته می شودتو پ هندسی با یک رنگ (نگاره يِ میانی ، پایین) : همه يِ شیء. 

• Solid+wireframe  پیرامونی از هندسه يِ خود شیء پوشانده ري به نمایش می گذارد که با خطوطتو پ هندسی را به رنگ شیء :

 می شود (نگاره يِ چپ ، پایین).
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• Textured : .(نگاره يِ راست ، پایین) رویه را نمایش می دهد تنها بافت 

• Textured+wireframe :  رویه ، با هم نمایش می دهد پایین) چپ(نگاره يِ شیء را با شبکه يِ سیمی و بافت ،. 

  

 Selection 3Dابزارهايِ 

 3Dنمایشگر می توانید تکمه ها ، ورتکس ها و وجوه رويِ یک شیء  يِه در گوشه يِ بالا و راست پنجر 3D Selectionبه کمک ابزارهايِ 

 3را برگزینید. به جايِ این ، می توانید زمانی که بیش از یک شیءD  ِرا دستی در نماي 3در یک تکمه دارید ، هر یک از اشیاءD  به شکلِ تک

 تک برگزینید.

 برگزیدنِ تکمه ها

پیش فرض است ، و درست مانند همان روشی  Selectionمی توانید تکمه ها را برگزینید. این ابزار ، ابزارِ   Node Selectionبا ابزارِ 

 3که اشیاءD .را در پنجره يِ نمایشگر بر می گزینید ، کار می کند 

 3برگزیدن ورتکس هايِ رويِ یک شیءD 

 scriptرا برگزینید. براي ذخیره سازي آن چه برگزیده اید در  3Dشیء  می توانید ورتکس هايِ رويِ یک Vertex Selectionبه کمک ابزارِ 

ره يِ نمایشگر ید در گوشه يِ بالا و راست از پنجرا می توان 3D Selectionرا به کار ببرید. ابزارهايِ  GeoSelectتان ، می باید تکمه يِ 

 پیدا کنید.

، آن  Geometryبا تغییر دادن تکمه هايِ  ، یکربندي می شودبه وسیله يِ نمایشگر پکه  Selectionالگويِ  یادداشت :

 چه برگزیده اید را به شیء جدید منتقل می کند.

 را نیز به کار ببرید. Vertex Selection، می توانید ابزارِ  EditGeoبراي ویرایش کردن شیء هندسی به کمک تکمه يِ 

 روشِ برگزیدنِ ورتکس ها در پنچره يِ نمایشگر
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 نمایشگر را فعال کنید. 3Dبچسبانید و الگويِ  Viewerرا به تکمه يِ  3Dیء یک ش .1

 کلیک کنید تا به کار بیافتد. این ابزار به طور پیش فرض غیر فعال است.  Vertex Selectionبر رويِ ابزارِ  .2

 بر رويِ ورتکس هایی از شیء که می خواهید برگزیده شوند ، با ماوس یک چهارچوب بکشید. .3

به طور پیش فرض ، هر چیزي که به تازگی بر گزینید جایگزین آن چیزي می شود که پیش تر برگزیده بودید ؛ ولی می توانید به آن چیزي  .4

 که برگزیده اید چیزي را افزوده و یا از آن پاك کنید :

•  اگر می خواهید چیزي را به آن چه که برگزیده اید بیافزایید ، کلیدShift که می خواهید را  ییدارید و ورتکس ها  را پایین نگه

 برگزینید.

 را پایین نگه داشته و Alt+Shift، کلیدهايِ  ورتکس (هایی) را از حالت گزینش در آوریداگر می خواهید از آن چه برگزیده اید  •

 یی که می خواهید را برگزینید.ورتکس ها

ان شده را نیز در آن چه بر می گزینید بیاورید. اگر نمی خواهید ورتکس می توانید آیتم هايِ پنه  Occlusion testبا زدن دکمه يِ  .5

برگزیده شوند ، این دکمه را از کار بیاندازید. اگر می خواهید هم  (ورتکس هايِ پنهان از دید در سمت دیگر) هستند Occludeهایی که 

 رگزیده شوند ، این دکمه را به کار بیاندازید.هستند ، هر دو ب Occludeورتکس هایی که دیده می شوند و هم آن هایی که 

 GeoSelectذخیره و بازیابی کردن ورتکس هايِ برگزیده شده به کمک تکمه يِ 

نمایشگر تنها می توانید آن چه بر می گزینید را گذرا داشته باشید. براي این که بتوانید آن چه برگزیده  3D Selectionبا ابزارهايِ پیش فرضِ 

 به کار بگیرید : GeoSelectنمایشگر را با تکمه يِ  3D Selectionره کرده و آن را بازیابی کنید ، می توانید همان ابزارهايِ اید را ذخی

را به درگاه درون رفت آن بچسبانید. براي این  3D) و یک شیء3D > Modify > GeoSelect بسازید ( GeoSelectیک تکمه يِ  .1

 آن باز باشد. propertiesرا به کار بگیرید ، می باید قابِ  GeoSelectبراي کارِ با ورتکس هايِ برگزیده شده تکمه يِ که بتوانید 

 کلیک کنید. 3D Selectionاز قابِ   Vertex Selectionبر رويِ ابزارِ  .2

 بر رويِ ورتکس هایی از شیء که می خواهید برگزیده شوند ، با ماوس یک چهارچوب بکشید. .3

به طور پیش فرض ، هر چیزي که به تازگی بر گزینید جایگزین آن چیزي می شود که پیش تر برگزیده بودید ؛ ولی می توانید به آن چیزي  .4

 که برگزیده اید چیزي را افزوده و یا از آن پاك کنید :

•  اگر می خواهید چیزي را به آن چه که برگزیده اید بیافزایید ، کلیدShift  یی که می خواهید را دارید و ورتکس هارا پایین نگه

 برگزینید.

 را پایین نگه داشته و Alt+Shiftاگر می خواهید از آن چه برگزیده اید ورتکس (هایی) را از حالت گزینش در آورید ، کلیدهايِ  •

 ورتکس هایی که می خواهید را برگزینید.

شده و  freezeرا بردارید تا آن چه برگزیده اید  Selectableه يِ می توانید نشانِ گزین GeoSelectتکمه يِ  propertiesدر قابِ  .5

 دیگر تغییري داده نشود. اگر این گزینه را دوباره نشان بزنید ، دوباره می توانید ورتکس هایی را به روشِ معمول برگزینید.

 هید داشته باشید را برگزینید.می توانید گزینه يِ نمایشی که براي شیء می خوا renderو  displayبه کمک کنترل هايِ  .6

کلیک کنید تا ورتکس هايِ برگزیده شده در تکمه يِ  Save Selectionاگر آن چه برگزیده اید درست بود ، می باید بر رويِ دکمه يِ  .7

GeoSelect .ذخیره شوند 
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 Restore Selectionذخیره شده اند را می توانید بازیابی کنید. براي این کار باید دکمه يِ  GeoSelectورتکس هایی که در تکمه يِ  .8

 را بزنید.

 3برگزیدنِ وجه هایی که بر رويِ یک شیءD است 

جوه با خطوط قابِ سیمی به و 3Dرا برگزینید. هر شیء3D  می توانید وجه هايِ رويِ یک شیءFace Selection   به کمک ابزارِ 

 می توانید یک یا چند تا از این وجه ها را برگزینید. Face Selectionچندگوشه اي بخش می شود. با ابزارِ 

 نیز می توانید شیء هندسی را ویرایش کنید. EditGeoو به کمک تکمه يِ  Face Selectionبا به کارگیريِ ابزارِ 

 کار بیافتد. این ابزارِ به طورِ پیش فرض غیر فعال است.کلیک کنید تا به  Face Selectionبر رويِ ابزارِ  .1

 بر رويِ وجه هایی از شیء که می خواهید برگزیده شوند ، با ماوس یک چهارچوب بکشید. .2

به طور پیش فرض ، هر چیزي که به تازگی بر گزینید جایگزین آن چیزي می شود که پیش تر برگزیده بودید ؛ ولی می توانید به آن چیزي  .3

 برگزیده اید چیزي را افزوده و یا از آن پاك کنید :که 

•  اگر می خواهید چیزي را به آن چه که برگزیده اید بیافزایید ، کلیدShift .را پایین نگه دارید و وجه هایی که می خواهید را برگزینید 

وجه  را پایین نگه داشته و Alt+Shiftيِ اگر می خواهید از آن چه برگزیده اید وجه (هایی) را از حالت گزینش در آورید ، کلیدها •

 هایی که می خواهید را برگزینید.

 

 3برگزیدنِ اشیاءD 

 3زمانی که بیش از یک شیءD  ِدر یک تکمه دارید (مانند هنگامی که یک پرونده ي.fbx را می خوانید که چندین شیء را در خود دارد) ، می

ابزار را به کار بیاندازید و سپس  اینرا به کار ببرید. براي برگزیدنِ اشیاء ، نخست   Object Selectionتوانید براي برگزیدن اشیاء ابزارِ 

 ، بر رويِ شیءاي که می خواهید آن را برگزینید ، کلیک کنید. 3Dدر نمايِ 

 3جفت و جور کردن جایگاه ، جهت گیري ، و اندازه يِ یک شیءD  3باD Selection 

) را می توانید با ورتکس Card(مانند یک تکمه يِ  3D) یک شیءsize ) و اندازه يِ (orientationجهت گیري () ، positionجایگاه (

 هايِ برگزیده شده در یک شیء دیگر جفت و جور کنید.
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کلیک کنید و گزینه   snapکه می خواهید آن را جا به جا کنید ، بر رويِ فهرست پایین افتادنیِ  3Dاز شیءproperties  در قابِ  .1

 را برگزینید. Match Selection Positionيِ 

 3Dتان بر حسبِ  3Dرا برگزینید ، جایگاه و جهت شیءsnap > Match Selection Position, Orientation  اگر گزینه يِ  .2

Vertex Selection .انجام می گیرد ، 

 3Dرا برگزینید ، جایگاه ، جهت و اندازه يِ شیءsnap > Match Selection Position, Orientation, Size  اگر گزینه يِ  .3

 تان بر حسبِ ورتکس هايِ برگزیده شده ، انجام می گیرد.

 ) اشیاءMergeبا هم یکی کردن (

نمونه ، پس  تان را با هم یکی کنید تا همه يِ آن ها در یک زمان آماده سازي شوند. براي 3Dمی توانید اشیاءMergeGeo  به کمک تکمه يِ 

را به کار ببرید. یا می  Transformاز این که اشیاء را با هم یکی کردید ، می توانید براي جا به جا کردن همه يِ آن ها با هم یک تکمه يِ 

باشید که این کار افزوده و یک مایه يِ همگانی را براي آن ها به کار بگیرید (به یاد داشته  scriptرا به  ApplyMaterialتوانید یک تکمه يِ 

 مایه هایی که پیش از یکی کردن اشیاء براي تک تک آن ها به کار گرفته بودید را لغو می کند).

 3روشِ یکی کردن اشیاءD 

1. 3D > Modify > MergeGeo  ِرا برگزینید تا یک تکمه يMergeGeo  3درست پس از اشیاءD  تان درscript .قرار بگیرد 

 بچسبانید. MergeGeoها را با هم یکی کنید را به درگاه درون رفت اشیایی که می خواهید آن  .2

 چسبانده شده اند را با هم آماده سازي کنید. MergeGeoاکنون می توانید همه يِ اشیایی که به تکمه يِ 

 ) شکلِ اشیاءModifyپیراستن (

 بسیاري از تکمه هایی که در زیرِ فهرست به کمکModify  چیدمان شده اند می توانید شکلِ یک شیء را پیرایش کنید. پیرایش کردن تنها

 امکان پذیر است. EditGeoبخش هایی از یک شیء که برگزیده شده اند نیز با تکمه يِ 

 3با برگزیدن ورتکس ها یا وجه هايِ اشیاءD  ِتکمه ي در پنجره يِ نمایشگر ، به کمکEditGeo  ِتبدیلِ ارزش هايِ ودارنمیا با به کارگیري 

)Lookup curve(  ِکارکردهاي ،) توانPower function(  نگاره ها ، کارکرد ،Perlin noise  کارکرد ،Distortion  یا ،trilinear 

interpolation  3، می توانید اشیاءD .را پیرایش کنید 

 EditGeoاشیاء به کمک تکمه يِ  پیرایش کردن

که در پنجره يِ نمایشگر  Selectionرا ، بسته به الگويِ  3Dمی توانید یکراست ورتکس ها یا وجوه یک شیءEditGeo  به کمک تکمه يِ 

، به گونه اي  گذاشته باشید Mergeرا در پایین دست یک تکمه يِ  EditGeoبه کار انداخته شده است ، پیرایش کنید. هم چنین اگر تکمه يِ 

 شیء را هم زمان با هم پیرایش کنید. آن چندمی توانید  شیء هندسی را با هم یکی کرده باشد ، چندین Mergeکه تکمه يِ 

 EditGeoروشِ پیرایش کردن اشیاء به کمک تکمه يِ 
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1.  3شیءD  یاMergeGeo  ِکه می خواهید پیرایش کنید را در پنجره يNode Graph .برگزینید 

2. 3D > Modify > EditGeo مه اي به همین نام در را کلیک کنید تا تکscript .قرار بگیرد 

معلوم کنید که هم چنان که دارید شیء را تغییر می دهید چگونه می  displayدر بخشِ کنترل هايِ تکمه ، از فهرست پایین افتادنیِ  .3

 خواهید در پنجره يِ نمایشگر نشان داده شود.

می  Viewerتکمه يِ  propertiesدر قابِ  headlampانداختنِ کنترلِ اگر شیء نگاره یا بافتی نداشته باشد ، با به کار نکته : 

 توانید ویژه گیِ دیده شدن شیء را بهبود ببخشید.

 در پنجره يِ نمایشگر که هستید کلیدS  ِرا فشار بدهید تا قابproperties  ِتکمه يViewer  به نمایش در آید. سپس گزینه

 د.را به کار بیاندازی 3D > headlampيِ 

را  Viewer Selectionکه در گوشه يِ بالا و راست پنجره يِ نمایشگر چیدمان شده اند ، الگويِ  3D Selectionبه کمک ابزارهايِ  .4

 پیکربندي کنید :

• Vertex Selection  ِهندسی را تک تک برگزینید. در این جا می توانید کنترل در این الگو می توانید ورتکس هايِ رويِ شیء :

 دقیقی در ویرایشِ شیء داشته باشید. هم چنین می توانید یا کشیدن یک چهارچوب ، و یا با پایین نگه داشتن کلیدShift  چندین

 ورتکس را با هم برگزینید.

• Face Selection  : هندسی را تک تک برگزینید. هم چنین می توانید یا کشیدن یک در این الگو می توانید وجه هايِ رويِ شیء

 چهارچوب ، و یا با پایین نگه داشتن کلیدShift .چندین وجه را با هم برگزینید 

د این گزینه را خاموش کنید. در پنجره يِ نمایشگر می توانی occlusion testingبا کلیک کردن بر رويِ دکمه يِ  یادداشت :

 شما پنهان هستند را برگزینید. انید ورتکس ها و وجوه که از دیدبدین سان این امکان براي شما فراهم می شود که بتو

خاموش باشد ، وجوه پشت  occlusion testingهستند ، اگر گزینه يِ  Cubeبراي نمونه ، با برگزیدنِ وجوهی که در جلويِ یک 

 که به آن دید ندارید) نیز برگزیده می شوند. Cubeاز (سمتی 

  

 جهت بگیرند :چگونه با آن چه برگزیده اید  م کنید که دستگیره هايِ آسه ايمعلو axis alignmentاز فهرست پایین افتادنیِ  .5

• Object  : ِآسه ي در این الگو جایگاهxyz  همه يِ ورتکس هایی که برگزیده شده اند مشخص می شود. جهت با میانگینِ جایگاه

 گیريِ آسه نیز همان جهت گیريِ شیء خواهد بود.

• Average normal  ِآسه ي در این الگو جایگاه :xyz  همه يِ ورتکس هایی که برگزیده شده اند مشخص می با میانگینِ جایگاه

 ) تراز می شود.current selectionا میانگینِ نرُمال هايِ آن چه که برگزیده شده اند (شود. جهت گیريِ آسه نیز ب

 دور است. current selectionیکراست به نقطه اي اشاره دارد که از  zدر این الگو ، همیشه آسه يِ 
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Object alignment  Average normal alignment 

، که جهت می توانید مرکزِ آسه را در سرتاسرِ رویه يِ شیء هندسی بکشید  Ctrl+Altبا پایین نگه داشتن کلیدهايِ  نکته :

 ) به نزدیک ترین نُرمالِ وجه پیکربندي شده است.orientationگیري (

که نیاز دارید را انجام بدهید. اگر می خواهید ورتکس یا وجهی را به  face selectionیا  vertex selectionدر پنجره يِ نمایشگر  .6

 آن چه برگزیده شده است بیافزایید ، کلیدShift  ِرا پایین نگه دارید و بر روي

ورتکس یا وجه کلیک کنید. اگر می خواهید ورتکس یا وجهی را از آن چه 

یین نگه دارید و بر رويِ را پا Shift+Altبرگزیده شده است بردارید ، کلیدهايِ 

 ورتکس یا وجه کلیک کنید.

زمانی که ورتکس ها و وجوهی که می خواهید را به درستی برگزیدید ، براي  .7

است را به جايِ  selectionویرایش کردن شیء هندسی ، آسه اي که با بخشِ 

 جدید بکشید.

 پویانمایی کردن ویرایش ها

را  Viewer Selectionنمایشگر چیدمان شده اند ، الگويِ  گوشه يِ بالا و راست پنجره يِ که در 3D Selectionبه کمک ابزارهايِ  .1

 پیکربندي کنید.

• Vertex Selection :  ِهندسی را تک تک برگزینید. در این جا می توانید کنترل در این الگو می توانید ورتکس هايِ رويِ شیء

 دقیقی در ویرایشِ شیء داشته باشید. هم چنین می توانید یا کشیدن یک چهارچوب ، و یا با پایین نگه داشتن کلیدShift  چندین

 ورتکس را با هم برگزینید.

• Face Selection  هندسی را تک تک برگزینید. هم چنین می توانید یا کشیدن یک : در این الگو می توانید وجه هايِ رويِ شیء

 چهارچوب ، و یا با پایین نگه داشتن کلیدShift .چندین وجه را با هم برگزینید 

 را کلیک کنید. دکمه يِ  propertiesآن چه می خواهید را در نمایشگر برگزینید و سپس در قابِ  .2

 نشانگرِ بازپخش را به فریمِ دلخواه ببرید و به کمک دستگیره هایی که در نمایشگر می بینید شیء هندسی را تغییر بدهید. .3

 یک فریمِ کلیدي خود به خود در آن فریم افزوده می شود.

 براي آماده سازيِ پویانماییِ دلخواه ، روند کار را ادامه بدهید. .4

 کلیک کنید. کلید در فریمِ جاري ، بر رويِ دکمه يِ  براي پاك کردن یک فریم نکته :
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اگر می خواهید ورتکس ها به همان جايِ نخستین که بودند  .5

 را فشار بدهید. reset geometryبرگردند ، دکمه يِ 

 تبدیلِ ارزشپیرایش کردن اشیاء به کمک نمودارهايِ 

ا این امکان را به شم LookupGeoو  CrosstalkGeoتکمه هايِ 

ورتکس ها  z، و  x  ،yمی دهند که بر روي هر کدام از ارزش هايِ 

یکراست کنترل داشته باشید. براي نمونه ، می توانید تنها همه يِ ارزش 

 دست بخورد. zو  xپیرایش کنید بدون این که به ارزش هايِ را  yهايِ 

-Lookup Table(تبدیلِ ارزش  در جدول هايِ 2D) را با پیرایش کردن نمودارهايِ z، یا  x  ،yمی توانید ارزش هاي گوناگون ورتکس (

LUT ( ، ِکه همراه با ارزش ها ارائه شده اند ، تغییر بدهید. آسه يx  درLUT  ِارزشِ جاريِ ورتکس ، و آسه يy  ورتکس را نشان ارزشِ جدید

 می دهد.

(ارزشِ جدید) همان ارزشی را  yآسه يِ در نمودار هستند  نقطه هایی که بر رويِه يِ به طورِ پیش فرض ، نمودار یک خط قطري است که هم

 با هم یکی هستند ، هیچ گونه تغییري در شکلِ شیء وجود ندارد. yو  x(ارزشِ جاري) دارند. چون هر دو ارزش هايِ  xآسه يِ  دردارند که 

 0ورتکسِ یک گوي را به  yمی توانید بسیاري از ارزش هايِ ، براي نمونه ،  CrosstalkGeoاز تکمه يِ  yآسه يِ  LUTبا پیرایش کردن 

 پیکربندي کنید تا نیمه يِ پایینیِ گوي فشرده شود (مانند نگاره يِ روبرو).

به کار  ارزشتبدیلِ ورتکس را نیز براي ارزیابی کردن نمودارِ  z، و  x  ،yاز ارزش هايِ می توانید یکی  CrosstalkGeoبه کمک تکمه يِ 

را پیرایش کنید. براي این کار  x->yنید نمودارِ نمونه ، می تواگرفته ، و سپس برآیند به دست آمده را به ارزشِ ورتکسِ دیگري بیافزایید. براي 

ورتکس می افزایید. بدین  yورتکس را به کار می برید تا ارزشِ جدیدي را بر رويِ نمودار بیابید. سپس آن ارزشِ جدید را به ارزشِ  x، ارزشِ 

 را با کانالِ دیگري میزان کنید. yسان ، می توانید ارزش هايِ 

هستند. آن ها هیچ گونه تغییري را ایجاد نمی کنند ، چون ارزشی که به ورتکس  y=0به طورِ پیش فرض ، این نمودارها خط هایی افقی در 

 است. 0) برابر با yافزوده شده (ارزشِ جدید بر رويِ آسه يِ 

 تبدیلِ ارزشروشِ پیراستنِ اشیاء به کمک نمودارهايِ 

1. 3D > Modify > CrosstalkGeo  3یاD > Modify > LookupGeo  ِرا انجام بدهید تا یک تکمه يCrosstalkGeo  یا

LookupGeo  3درست پس از شیءD  که می خواهید آن را پیرایش کنید درscript .تان قرار بگیرد 

 را به تکمه بچسبانید تا بتوانید تغییراتی که می دهید را ببینید. Viewerیک تکمه يِ  .2

تان در پنجره يِ نمایشگر ،  3Dمعلوم کنید که چگونه می خواهید شیءdisplay  در بخشِ کنترل هايِ تکمه ، از فهرست پایین افتادنیِ  .3

 هم چنان که آن را تغییر می دهید به نمایش گذاشته شود.

4. سمت چپ ، نموداري را برگزینید که می خواهید پیرایش کنید. براي نمونه ، اگر می خواهید تنها ارزش هايِ  از فهرستz  ورتکس را

 را برگزینید. zپیرایش کنید ، گزینه يِ 
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ورتکس براي ارزیابی کردن نمودار و افزودنِ  yتا ارزشِ را برگزینید  y->x تنها ، می توانید براي نمونه ، CrosstalkGeoدر تکمه يِ 

 ورتکس به کار برود. xبرآیند به دست آمده به ارزشِ 

را پایین نگه داشته ، و سپس رويِ نمودار کلیک  Ctrl+Altاگر نیاز باشد نمودار را میزان کنید. براي افزودن نقطه ها به نمودار ، کلیدهايِ  .5

 کنید.

 )Power Functionتوان (ارکرد پیرایش کردن اشیاء به کمک ک

تان را پیرایش کنید. به کمک این تکمه ، می توانید هر یک از  3D، شکلِ اشیاءPower  می توانید به کمک یک کارکردLogGeo   با تکمه يِ

ارزش با رزش هايِ مثبت کار می کنید یا ). بسته به این که آیا دارید با اxX  ،yY  ،zZاز یک ورتکس را به توان برسانید ( z، و  x  ،yارزش هايِ 

 می توانید جلوه هايِ گوناگونی را داشته باشید.هايِ منفی ، 

 روشِ پیرایش کردن اشیاء به کمک یک کارکرد توان

1. 3D > Modify > LogGeo  ِرا برگزینید تا یک تکمه يLogGeo  3پس از شیءD  که می خواهید آن را پیرایش کنید بهscript 

 تان افزوده شود.

 را به تکمه بچسبانید تا بتوانید تغییراتی که می دهید را ببینید. Viewerیک تکمه يِ  .2

تان در پنجره يِ نمایشگر ،  3Dمعلوم کنید که چگونه می خواهید شیءdisplay  در بخشِ کنترل هايِ تکمه ، از فهرست پایین افتادنیِ  .3

 هم چنان که آن را تغییر می دهید به نمایش گذاشته شود.

 تغییر می کند). 57به  75را نشان بزنید. با این کار جايِ ارزش و توانی که به آن داده اید عوض می شود (براي نمونه  swapگزینه يِ  .4

آن توان زیاد کنید. براي  ِ ورتکس را به اندازه يِد که می خواهید ارزش هايتوانی را بنویسی log z، و  log x  ،log yدر میدان هايِ  .5

 را بنویسید. 20ارزشِ  zبرسانید ، می باید در میدانِ  20از یک ورتکس را به توان  zنمونه ، اگر می خواهید ارزش هايِ 

تان را در پنجره يِ نمایشگر میزان کنید.  3Dجدید ، شیء  به یک جايِ نقطه يِ کنترلی سفید رنگ ِ این کار ، می توانید با کشیدنبه جاي

 این نقطه يِ کنترلی را می توانید درست در بیرونِ شیء پیدا کنید.

را نشان بزنید. این گزینه ، تنها اگر گزینه يِ  clamp black، گزینه يِ  0.0منفی به ارزشِ  z، و  x  ،yبراي سوق دادن ارزش هايِ  .6

swap باشد ، کار می کند. نشان خورده 

 LogGeoرا نیز نشان بزنید ، تکمه يِ  swapگرفته و گزینه يِ  1را برابر با  log z، و  log x  ،log yاگر ارزش هايِ  نکته :

شیء ایجاد نمی کند. اگر می خواهید ببینید که تکمه چگونه کار می کند ، به تر است از جایی که  هیچ گونه تغییري در هندسه يِ

 می توانید آغاز به کار کرده و سپس کم کم ارزش ها را میزان کنید.

را در زمانی ببینید که گزینه يِ  Nukeبر رويِ یک استوانه و گويِ پیش فرض برنامه يِ  LogGeoدر نگاره هايِ زیر می توانید تاثیر تکمه يِ 

swap  ِدر بخشِ کنترل هايِ تکمه يLogGeo ید که اگر این اشیاء در جايِ پیش فرض قرار نگرفته باشند (مرکزِ نشان خورده است. باید بدان

، و در  0.5برابر با يِ سمت راست  در نگاره log z، و  log x  ،log yارزش ِ  ) ، برآیند به دست آمده از کار می تواند گوناگون باشد.0,0,0

 (بدون تغییر) گرفته شده است. 1نگاره يِ سمت چپ برابر با 
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 پیکربندي شده است. 2هايِ سمت راست و چپ برابر با  در نگاره log z، و  log x  ،log yدر زیر ، ارزش ِ 

  

 1روشِ  –پیرایش کردن اشیاء به کمک یک نگاره 

ر کار می کنید ، همی توانید هندسه يِ شیء را بر پایه يِ یک نگاره پیرایش کنید. هنگامی که دارید با این تکمه  DisplaceGeoبا تکمه يِ 

دارد. هر چه ارزشِ ورتکس)  uvویژه گیِ ( در آن نقطهکه پیکسلِ نگاره  جا به جا می شود ارزشی ل اش به اندازه يِورتکس در راستايِ نرُما

 پیکسل بیش تر باشد ، جا به جاییِ ورتکس بزرگ تر خواهد بود.

 

 اشیاء به کمک یک نگاره پیراستنِروشِ 

1. 3D > Modify > DisplaceGeo  ِرا برگزینید تا یک تکمه يDisplaceGeo  3در جایی پس از شیءD  که می خواهید آن را

 تان قرار بگیرد. scriptپیرایش کنید در 

 را به تکمه بچسبانید تا بتوانید تغییراتی که می دهید را ببینید. Viewerیک تکمه يِ  .2
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تان در پنجره يِ نمایشگر ،  3Dمعلوم کنید که چگونه می خواهید شیءdisplay  نیِ در بخشِ کنترل هايِ تکمه ، از فهرست پایین افتاد .3

 هم چنان که آن را تغییر می دهید به نمایش گذاشته شود.

4.  درون رفت نگاشت نگاره را بخوانید و آن را به درگاهdisplace تکمه يِ  ازDisplaceGeo .بچسبانید 

 کنترل هايِ زیر را میزان کنید : .5

، کانال هایی را برگزینید که براي ارزشِ جا به جایی به کار می  channelsنشان خور و فهرست پایین افتادنیِ  هارگوش هايِاز چ •

 آیند.

را از فهرست پایین  rgbaیا  rgbبرگزینید. براي نمونه ، اگر  displaceمنبعی را براي ارزشِ  sourceاز فهرست پایین افتادنیِ  •

 Pixel، یا روشناییِ پیکسل ( alpha، یا  red  ،green  ،blueبرگزیده باشید ، می توانید کانالِ  channelsافتادنیِ 

Luminance را به عنوان منبع به کار ببرید. هم چنین می توانید (rgb relative  به وسیله يِ مقادیري را برگزینید تا ورتکس ها

 rgbجا به جا کنید. یا اگر می خواهید ورتکس ها به اندازه يِ ارزش هایی که در   z، و  x ،yهست بر رويِ آسه هايِ  rgbکه در 

 را برگزینید. rgb absoluteاست جا به جا شوند ، می توانید 

را میزان کنید. هر چه ارزشی این لغزنده را بزرگ تر بگیرید ، جا به جایی  scaleبراي معلوم کردن بزرگیِ جا به جایی ، لغزنده يِ  •

 زرگ تر خواهد بود.ب

بنویسید. به طور پیش فرض ،  weightداشته باشید ، وزن جدید را در میدان هايِ  z، و  x  ،yاگر می خواهید وزنِ گوناگونی در  •

آن را بر رويِ  weightپیکربندي شده است. اگر نمی خواهید به یک ارزش تغییري داده شود ، گزینه يِ  1بر رويِ ارزشی وزنِ هر 

 رید.بگذا 0

ارزشی را بنویسید که می  offsetداشته باشید ، در میدان هايِ  یک اندازه يِ جبرانی z، و  x  ،yاگر می خواهید براي ارزش هايِ  •

 yبه ارزشی که  0.5بنویسید ، ارزشِ  y offsetرا در میدانِ  0.5اندازه جبران داشته باشند. براي نمونه ، اگر ارزشِ آن خواهید به 

 دارد افزوده می شود.

که پیش از جا به جایی به نگاره داده شده است ، الگوریتمی را از فهرست پایین افتادنیِ ، براي تغییر دادن اندازه يِ فیلتر شدنِ نگاره  •

filter .برگزینید 

•  براي تغییر دادن نامِ ویژه گی که به عنوانِ مختصاتUV گرفته می شود ، نامی را در میدانِ  ورتکس براي یافتن پیکسلِ نگاره به کار

attrib name .بنویسید 

، درست نیستند. براي این که آن ها پس از جا به جایی دوباره ارزیابی شوند ،  ها معمولاً ، نرُمال ها پس از جا به جا شدن ورتکس •

 را نشان بزنید. recalculate normalگزینه يِ 

 2روشِ  –اشیاء به کمک یک نگاره  یش کردنِپیرا

را به کار می گیرد ؛  Displacement، همان نگاشت پردازيِ  DisplaceGeoنیز ، به مانند تکمه يِ  Displacement shaderتکمه يِ 

و در نخستین نگاه ، تکمه ها خیلی همانند هم به چشم می آیند. به هر روي ، رویکردي که این دو تکمه بر رويِ نگاشت پردازيِ 

Displacement .اجرا می کنند با هم گوناگون است 
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روشی است که براي افزودنِ جزئیات هندسی به رویه هايِ شیء و پردازش آن ها به کار می رود. تکمه يِ  Displacementنگاشت پردازيِ 

Displacement  ِتکمه ي بر خلاف ،DisplaceGeo هندسی که دیده می شوند ، انجام می  ، این کار را با جا به جاییِ بخش هایی از شیء

می  را برآوردو بر مبنايِ آن بخش هایی از جا به جایی که می باید پردازش شوند  به نقطه يِ دید دوربین نگاه می کندجا به جایی ،  این دهد.

ترازي بهبود بخشیده  (موزائیک کاري) به tessellationکند. بنا بر این ، در زمانِ پردازش صرفه جویی می شود. هم چنین ممکن است ترازِ 

 شود که براي یک شیء در یک فاصله يِ خاص نیاز دارید.

 Displacementچسباندن تکمه يِ 

 بسازید. Displacement، یک تکمه يِ  3D > Shader > Displacementبا کلیک کردن بر رويِ  .1

بچسبانید. اگر بخواهید ، می توانید بافتی را به درگاه درون رفت تکمه يِ  Displacementشیء هندسی تان را به بیرون رفت تکمه يِ  .2

Displacement .بچسبانید 

3.  درون رفت نگاره اي که می خواهید براي جا به جایی به کار بیاید را از درگاهdisplacement .به تکمه بچسبانید 

اي ارزیابی کردن نرُمال ها به کار بگیرید. این نگاشت را به درگاه درون رفت اگر دوست داشته باشید می توانید نگاشت جداگانه اي را بر .4

normals .بچسبانید 

 دنبال کنید. "Displacementمیزان کردن کنترل هايِ "ادامه يِ کار را در بخشِ  .5

 Displacementمیزان کردن کنترل هايِ 

تان برگزینید که می خواهید آن را  displacementرا از درون رفت  ، کانالی displacement channelاز فهرست پایین افتادنیِ  .1

 به عنوان نگاشتdisplacement .به کار بگیرید 

2.  اگر درون رفتnormals  ِرا نیز به کار گرفته اید ، نشانِ گزینه يbuild normals  ِرا بردارید و گزینه يnormal expansion 

 پیکربندي کنید : را بر رويِ یکی از گزینه هايِ زیر

• None .نرُمال ها را همان گونه که هستند به کار می گیرد : 

• XY  نرُمال ها را در ابعاد :x  وy .ضرب می کند 

• XYZ  نرُمال ها را در ابعاد :x  ،y  و ،z .ضرب می کند 

 را دستکاري کنید. scale، گزینه يِ  displacementبراي پیکربندي کردن بزرگیِ  .3

 را بر رويِ اندازه يِ فیلتري بگذارید که می خواهید به هنگامِ نمونه گیري از نگاره يِ درون رفت به کار ببرید. filter sizeگزینه يِ  .4

 ، الگوریتمی را براي فیلتر گذاري برگزینید. filterاز فهرست پایین افتادنیِ  .5

را نشان بزنید. اگر می خواهید  build normals، گزینه يِ  اگر می خواهید نرُمال ها پس از جا به جایی خود به خود ارزیابی شوند .6

 نرُمال ها از درون رفتnormals .ارزیابی شوند ، نشانِ این گزینه را بردارید 

 دنبال کنید. "براي پردازش Displacementمیزان کردن کنترل هايِ "ادامه يِ کار را در بخشِ  .7

 براي پردازش Displacementمیزان کردن کنترل هايِ 
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میزان کنید تا  Tessellationبه کار برده اید ، می باید کنترل هايِ آن را در برگه يِ  Displacementپیش از پردازشِ صحنه اي که در آن 

 سرعت و کیفیت روند پردازش بهبود یابد :

را به  max subdivisionمی گیرد ، گزینه يِ انجام  tessellationبراي پیکربنديِ بیش ترین شمارِ تقسیمات چندگوشه ها که در  .1

 کار ببرید.

 Displacementدر برنامه هايِ دیگر کار کرده باشید ، به تر است بدانید که با تکمه يِ  displacementو  DisplaceGeoاگر با 

 می توانید به همان میزان جزئیات با تقسیمات هندسیِ کم تر دست بیابید.

) ساخته می شود ، ولی می توانید به کمک 2*30*30سه گوش ( 1800از موزائیک کاريِ  30*30به ابعادCard  براي نمونه ، یک 

 با تقسیمات کم تر دست بیابید : tessellationبه همین تراز  Displacementتکمه يِ 

Tessellation triangles Max Subdivisions Card subdivisions 
2048 5 1*1 (2 triangles) 
2048 4 2*2 (8 triangles) 
2048 3 4*4 (32 triangles) 

را زیاد بگیرید ، سرعت پردازش کنُد می شود. یک  Displacement واگر شمارِ تقسیمات شیء هندسی  یادداشت :

Card  که گزینه يِ  10*10با ابعادmax subdivisions  ِسه گوش است. 51200گذاشته شده است ، دارايِ  4آن روي 

 پیکربندي کنید : modeالگویی که براي تقسیمات چندگوشه به کار می برید را از فهرست پایین افتادنیِ  .2

• Uniform   .این الگو گزینه يِ خوبی براي آزمایش کردن برآیند کارتان است ؛ و تنها گاهی : موزائیک کاري یکنواخت چندگوشه

 به کار بیاید.به عنوان به ترین گزینه  Displacementبه ندرت پیش می آید که براي پردازشِ 

• Screen :  موزائیک کاري به وسیله يِ اندازه يِ صفحه نمایش انجام می گیرد. این گزینه پیش فرض برنامه است و اغلب به ترین

ی شود. در ی بر رويِ صفحه نمایش معلوم مبه وسیله يِ اندازه يِ چندگوشه هايِ موزائیک Tessellationالگو به شمار می رود. 

یچ هوقتی لبه يِ یک چند گوشه يِ خاص به لبه يِ طولی صفحه نمایش رسیده است ، دیگر توانید مطمئن باشید که  این الگو می

 .چندگوشه يِ جدیدي ساخته نمی شود

• Adaptive  ِدر این الگو موزائیک کاري با پیچیدگی :displacement ش هايِ تعیین می شود. در این گزینه تلاش می شود بخ

انجام می گیرد. تنها  thresholdتخت در نگاره ، جایی که نیاز به جا به جایی نیست ، برآورد شود. ارزیابی بر اساسِ کنترل هايِ 

 را برگزیده باشید این کنترل ها فعال خواهند بود. adaptiveاگر گزینه يِ 

بر رويِ بزرگ ترین را  pixel edge lengthپیکربندي می کنید ، گزینه يِ  adaptiveیا   screenرا بر رويِ  modeاگر گزینه يِ  .3

 چندگوشه اي بگذارید که براي موزائیک کاري به کار می برید.

 بگذارید ، می توانید گزینه هايِ زیر را نیز پیکربندي کنید : adaptiveرا بر رويِ  modeاگر گزینه يِ  .4

• Edge threshold ر از ارزشِ این گزینه باشند بخش می شوند. لبه هایی که کوچک تر از ارزشی این گزینه : لبه هایی که بزرگ ت

 ) می شوند.subdivideبخش بخش ( displace thresholdو  normal thresholdباشند بر مبنايِ ارزشِ دو گزینه يِ 

• Normal threshold هايِ  : جهت گیريnormal کند که رویه تخت است یا نه. اگر . بدین سان معلوم می  را مشخص می کند

 زاویه يِ میانِ دو نرُمالِ کنارِ هم بزرگ تر از ارزشِ این آستانه باشد ، موزائیک کاري انجام می شود.
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• Displace threshold  درجه يِ دو نقطه اي که بر رويِ یک رویه جا به جا شده اند را با هم می سنجد ؛ و اگر برآیندهايِ به :

 دست آمده با هم هماهنگ نباشند ، موزائیک کاري انجام می گیرد.

یک شیء هندسی که وضوحِ خیلی بزرگ و  در Displacement shaderکه به کار بردن به یاد داشته باشید  یادداشت :

 پیچیده اي دارد ، می تواند سرعت کار را خیلی پایین بیاورد.

 یک کارکرد پیراستنِ اشیاء به کمکPerlin Noise 

رد یک پیرایش کنید. این کارک Perlin Noiseتان را با یک کارکرد3D  می توانید اشیاءProceduralNoise  ، یا  ProcGeoيِ  تکمهبا 

Noise اتفاقی را می سازد. براي نمونه ، می توانید تکمه يِ  به ظاهرProcGeo  را به کار بگیرید و یکNoise  پویانمایی شده اي را براي

،  تخت ، مانند نگاره يِ زیر Card) از یک terrain) امواج یا ابر ها بسازید ؛ و یا آن را براي ساخت یک زمین (ripplingموج دار نمودن (

 به کار بگیرید :

 

 را برگزیده و نمايِ آن را کنترل کنید. Noiseمی توانید الگويِ  ProcGeoدر بخشِ نمادهايِ تکمه يِ 

 کارکرد روشِ پیراستن اشیاء به کمکPerlin Noise 

1. 3D > Modify > ProceduralNoise  ِرا برگزینید تا یک تکمه يProcGeo  3پس از شیءD  تان که می خواهید آن را پیرایش

 تان قرار بگیرد. script کنید در 

 بچسبانید تا بتوانید تغییرات را ببینید. ProcGeoرا به تکمه يِ  Viewerیک تکمه يِ  .2

یشگر ، هنگامی نمایی را برگزینید که می خواهید شیء تان در پنجره يِ نما displayدر بخشِ کنترل هايِ تکمه ، از فهرست پایین افتادنیِ  .3

 که دارید آن را تغییر می دهید ، با آن نما نشان داده شود.
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 Turbulenceرا برگزینید که می خواهید به کار بگیرید :  Noiseالگویی از  ProceduralNoise Methodاز فهرست پایین افتادنی  .4

 .FBM (Fractal Brownian Motion)یا 

، و یا همه يِ آن ها را می خواهید پیرایش کنید ، فهرست پایین افتادنیِ  z، و  x  ،yش هايِ براي این که معلوم کنید کدام یک از ارز .5

Orientation .را به کار بگیرید 

را به دست بگیرید ،  Noise، نمادهايِ دیگر را میزان کنید. براي نمونه ، اگر می خواهید میزانِ جزئیاتNoise  براي تغییر دادن نمايِ  .6

 نمادOctaves .را میزان کنید 

 یک کارکرد پیراستنِ اشیاء به کمکDistortion 

به کناره  تا) از ورتکس ها است که از مرکزِ شیء Non-linear transformationیک تغییر شکلِ غیر خطی ( RadialDistortتکمه يِ 

درست می کند. در نگاره يِ را در شیء ) pin-cushion() یا بالشتکی barrelها انجام می گیرد ؛ و یک کج و معوج شدگیِ خمره اي شکل (

 دو استوانه به کمک این تکمه کج و معوج شده اند : چگونه زیر می توانید ببینید که

 

 

 یک کارکرد روشِ پیرایش کردن اشیاء به کمکDistortion 

1. 3D > Modify > Radial Distort  ِرا برگزینید تا یک تکمه يRadialDistort  3پس از شیءD  تان که می خواهید آن را پیرایش

 تان قرار بگیرد. script کنید در 

 بچسبانید تا بتوانید تغییرات را ببینید. RadialDistortرا به تکمه يِ  Viewerیک تکمه يِ  .2

ان در پنجره يِ نمایشگر ، هنگامی نمایی را برگزینید که می خواهید شیء ت displayدر بخشِ کنترل هايِ تکمه ، از فهرست پایین افتادنیِ  .3

 که دارید آن را تغییر می دهید ، با آن نما نشان داده شود.
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را میزان کنید. اگر  distortionبراي این که مشخص کنید کج و معوج شدگی از نوعِ خمُره اي شکل باشد یا از نوع بالشتکی ، لغزنده يِ  .4

خمُره اي شکلی خواهید داشت. اگر ارزشِ این گزینه را بالايِ صفر بگیرید کج و معوج  باشد ، کج و معوج شدگیِ 0ارزشِ این گزینه زیرِ 

 را بدهید ، هیچ گونه کج و معوج شدگی رخ نمی دهد. 0شدگی به سمت بالشتکی پیش می رود. اگر براي این گزینه ارزشی برابر با 

میزان کنید. هر چه ارزشِ این کنترل را بزرگ تر بگیرید ، شیء بیش را  power biasبراي کنترلِ بزرگیِ کج و معوج شدگی ، لغزنده يِ  .5

 تر کج و معوج می شود.

 مختصات جدید را بنویسید. rotation centerبراي جا به جا کردن نقطه يِ مرکزيِ کج و معوج شدگی ، در میدان هايِ  .6

 را دستکاري کنید. scale، ارزش هایی میدان هايِ  zو  ، x  ،yبراي کنترل کردن میزانِ کج و معوج شدگی در هر یک از راستاهايِ  .7

 را نشان بزنید. preserve centerبماند ، گزینه يِ  3Dبراي این که مرکزِ شیء در جايِ اصلی اش در فضايِ  .8

 Trilinearپیراستنِ اشیاء به کمک یک درون یابیِ 

شیء  Trilinear ،Bounding Box با یک درون یابیِ  می توانید همه يِ شیء را به طور کامل بپیچانید. در این جا Trilinearبا تکمه يِ 

پی که ودر هم پیچانده می شود. براي نمونه ، می توانید تکمه را براي ساخت تغییر شکل هايِ پویانمایی شده از یک شیء به کار بگیرید. مانند ت

 ) می شود.Squash) و کشیده (Squishن و یا بلند شدن از زمین ، فشرده (در هنگام به زمین خورد

 Trilinear Interpolationروشِ پیرایش کردن اشیاء به کمک یک 

1. 3D > Modify > Trilinear   ِرا برگزینید تا یک تکمه يTrilinear  3پس از شیءD  تان که می خواهید آن را پیرایش کنید در 

script یرد.تان قرار بگ 

 بچسبانید تا بتوانید تغییرات را ببینید. Trilinearرا به تکمه يِ  Viewerیک تکمه يِ  .2

نمایی را برگزینید که می خواهید شیء تان در پنجره يِ نمایشگر ، هنگامی  displayدر بخشِ کنترل هايِ تکمه ، از فهرست پایین افتادنیِ  .3

 ان داده شود.که دارید آن را تغییر می دهید ، با آن نما نش

 مختصات جدید را بنویسید. p0  ،p1  ،p2  ، ... ،p7، در میدان هايِ  Bounding Boxبراي جا به جا کردن هر یک از گوشه هايِ  .4

 را بزنید. reset shape to inputبه حالت نخستین ، گزینه يِ  boxبراي لغو کردن تغییرات و برگرداندن 

بروید  Source boxتعریف کنید ، به برگه يِ  boxشیء را به کار نبرده و به جايِ آن خودتان یک  bounding boxاگر می خواهید  .5

میزان کنید. براي را  scr1و  scr0، مختصاتbox  را بردارید. براي تعریفuse incoming bounding box  و نشانِ گزینه يِ 

 تغییر دادن رنگbox  ِدکمه ي ،box .را کلیک کنید 

 ها و بافت ها مایه

 3براي کنترلِ این که مایه هایی که رويِ اشیاء تان را می سازند چگونه به چشم بیایند ، تکمه هایی که در فهرستD > Shader  هستند را به

 کار بگیرید.

 ویژه گی هايِ مایه يِ رويِ اشیاء
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 با تکمه هایی که در زیر فهرستShader  هستند می توانید ویژه گی هايِ مایه يِ اشیاء

هندسی ، شاملِ کیفیت نورِ بازتاب شده به دوربین از رویه يِ یک شیء را در صحنه تعریف 

 کنید. به کمک این تکمه ها می توانید معلوم کنید مایه يِ اشیاء تان چگونه به چشم بیایند.

یکی پس از دیگري افزوده و جلوه هايِ را  Shaderهم چنین می توانید چندین تکمه يِ 

پیچیده اي را بسازید. براي این کار ، می باید درگاه هايِ درون رفت بدون برچسب بر رويِ 

 را به کار بگیرید. Shaderتکمه هايِ 

پیکربندي هایی که براي ویژه گیِ مایه به کار می گیرید ، بر رويِ پردازشِ بیرون رفتی که 

 یر می گذارند.از صحنه دارید تاث

 تان قرار بدهید : scriptرا می توانید در جاهايِ زیر در  Shaderتکمه هايِ 

 که رویه را می سازد. 3D objectکه براي بافت رویه به کار می رود ، و تکمه يِ  2Dمیانِ نگاره يِ  •

روش خوبی براي به کار بردنِ یک  به آن ها داده شده است. این ApplyMaterialکه تکمه يِ  3D objectپس از تکمه هايِ  •

 مایه يِ همگانی به همه يِ اشیاء است.

 را براي درون رفت یک نگاره يِ ماسک به کار بگیرید تا تاثیرِ تغییرات مایه را محدود کنید. Mapمی توانید اتصال دهنده هايِ 

ی م می توانید تاثیرِ تغییراتی که به ویژه گی هايِ مایه يِ یک شیء یادداشت :

 ببینید. 2Dدهید را نیز در نمايِ 

 ApplyMaterialدادن یک مایه به شیء به کمک تکمه يِ 

 این تکمه مایه اي را از درون رفتmat  (اشیاء) 3به یک شیءD .می دهد 

 ApplyMaterialروشِ به کار بردن تکمه يِ 

1. 3D > Shader > ApplyMaterial  را برگزینید تا تکمه اي به همین نام درscript .تان بنشیند 

 ReadGeo، تکمه يِ  Sphereرا به شیء هندسی تان بچسبانید (براي نمونه ، یک  ApplyMaterialدرون رفت بدونِ نام از تکمه يِ  .2

 ).ModeBuilder، یا تکمه يِ 
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یء بدهید ، می توانید درون رفت بدون نام را نیز به تکمه يِ اگر می خواهید یک مایه يِ همگانی را به چندین ش نکته :

MergeGeo  بچسبانید. بدین سان ، هر مایه اي که پیش ازMerge  هندسی داده اید کردن به هر یک از تکمه هايِ اشیاء

 ، نادیده گرفته می شوند.

 mat) را به درون رفتWireframe ، یا یک تکمه يِ  BasicMaterial، یک تکمه يِ  2Dمایه هایتان (مانند یک نگاره يِ بافتی  .3

 بچسبانید. ApplyMaterialاز تکمه يِ 

 

 پس از خودش می دهد.به همه يِ اشیاء هندسی  matمایه را از درون رفتApplyMaterial  به طور پیش فرض ، 

 Alembicیک پرونده يِ  از ReadGeoبه کمک تکمه يِ ساخته ، و یا آن را  ModelBuilder اگر شیء هندسی تان را با یک تکمه يِ .4

تکمه  propertiesشیء خاصی بدهید. براي این کار ، قابِ  یک بهتنها مایه را  نیز می توانیدآورده باشید ،  Nukeبه درون برنامه يِ 

ین امکان براي شما فراهم می شود تا به بگذارید. بدین سان ، ا nameرا بر رويِ  filterرا باز کنید و گزینه يِ  ApplyMaterialيِ 

 nameگزینه يِ فیلتر در سمت راست  نوشته يِ درون میدانِ بگویید که از هر یک از اشیاء هندسی که با ApplyMaterialتکمه يِ 

 چشم بپوشد.، هماهنگ نباشند 

به گونه  به درون برنامه آورده باشید ، third-party، و یا آن را با یک پلاگینِ  را ساخته ایداگر شیء هندسی تان  یادداشت :

مایه اي را به یک شیء خاص محدود  می توانیددر این جا نیز اشیاء هندسی می افزاید ،  به nameیک ویژه گیِ شیء که  اي

 کنید.

 را پیکربندي کنید : nameدر کنارِ  ادنیلتر شوند ، فهرست پایین افتبراي این که معلوم کنید اشیاء هندسی که به تکمه می آیند چگونه فی .5

• Equals  رشته ايکه نامِ آن درست با  می دهدهر شیء اي  به: مایه را )*String(  ِکه در میدانfilter name  ، نوشته شده است

 هماهنگ باشد.

• Doesn’t equal  که در میدانِ رشته ايکه نامِ آن درست با  می دهدهر شیء اي  به: مایه را filter name  ، نوشته شده است

 هماهنگ نباشد.

• Contains که در میدانِ  به کار رفته باشد رشته اينامِ آن در که  می دهد اشیایی ه: مایه را بfilter name .نوشته شده است 

اشیاء تان را با ساختارهایی نامگذاري کرده اید ، این گزینه می تواند خیلی به کارتان بیاید. براي نمونه ، اگر اشیایی دارید زمانی که 

را برگزینید و در  contains، می توانید گزینه يِ  Root/Table/، و  Root/Chair/Seat  ،/Root/Chair/Back/مانند 
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چشم  tableداده شده و از شیءchair  در این جا ، مایه به همه يِ بخش هایی از . بنویسیدرا  Chairنامِ  filter nameمیدانِ 

 پوشی می شود.

 

• Doesn’t contains  ِمایه را به اشیایی می دهد که در نامِ آن ها رشته اي به کار نرفته باشد که در میدان :filter name  نوشته

 شده است.

را بزنید  chooseو یا دکمه يِ  ؛ بنویسید ی که براي همین کار استنامی را یکراست در میدان می توانید براي پیکربندي کردن نامِ فیلتر ، .6

ی براي باز شود. در این پنجره از فهرستی که اشیاء هندسی را نشان می دهد نام Object Name Chooserتا پنجره يِ گفت و گويِ 

 برگزینید.فیلتر 

  

چندین شیء را با هم برگزینید ، می  Object Name Chooserبراي این که بتوانید در پنجره يِ گفت و گويِ  نکته :

 را پایین نگه داشته و بر رويِ نامِ اشیاء کلیک کنید. Shiftو یا  Ctrlتوانید کلید هايِ 

 میزان کردن رنگDiffuse 

ه نوردهی می شود را میزان کنید. مایه در جایی که نقطه هايِ رویه يِ شیء از نور دورتر می توانید رنگ مایه ، در زمانی ک Diffuseبا تکمه يِ 

 می شوند ، تاریک تر می شود (تابشِ نور بر رويِ نقطه ها کم تر و کم تر می شود).

 Diffuseروشِ به کار بردن تکمه يِ 

1. 3D > Shader > Diffuse  را برگزینید تا تکمه اي به همین نام درscript .تان بنشیند 

از یک تکمه يِ  matقرار بدهید ، یا آن را به درون رفت3D Object  و تکمه يِ  2Dرا میان نگاره يِ بافتDiffuse  تکمه يِ  .2

ApplyMaterial .بچسبانید 

 کانالی را بردارید که می خواهید با آن کار کنید. channels، از فهرست پایین افتادنیِ  Diffuseاز تکمه يِ  propertiesدر قابِ  .3

4.  براي کنترل رنگdiffuse  ِلغزنده ي ،White ) را میزان کنید. به طورِ پیش فرض ، این لغزنده در محدوده يِ خاکستريgrayscale (

 تر بگیرید ، مایه روشن تر می شود.آن را جدا از هم میزان کنید. هر چه ارزش را بالا b، و  r  ،gاست ، ولی می توانید ارزش هايِ 
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Diffuse: Low White value  Diffuse: High White value 

 Specularهايِ  Highlightمیزان کردن 

هايِ رويِ یک مایه تا چه اندازه روشن به چشم بیایند و پهنايِ آن ها چقدر باشد.  Highlightمی توانید معلوم کنید که  Specularبا تکمه يِ 

در زاویه اي از بازتابشِ نور که با نقطه يِ دید در یک راستا باشد (در راستايِ  Specularهايِ  Highlight جايِ نقطه يِ دید بسیار مهم است :

 ترین است.که به چشم می رسد) ، روشن  highlightخطی راست از 

 Specularروشِ به کار بردن تکمه يِ 

1. 3D > Shader > Specular  را برگزینید تا تکمه اي به همین نام درscript .تان بنشیند 

از یک تکمه يِ  matقرار بدهید ، یا آن را به درون رفت3D Object  و تکمه يِ  2Dرا میان نگاره يِ بافتSpecular  تکمه يِ  .2

ApplyMaterial سبانید.بچ 

 کانالی را بردارید که می خواهید با آن کار کنید. channels، از فهرست پایین افتادنیِ  Specularاز تکمه يِ  propertiesدر قابِ  .3

را میزان کنید. هر چه ارزشِ این گزینه را بالاتر بگیرید ، مایه  White، لغزنده يِ  Specularهايِ  highlightبراي کنترل روشناییِ  .4

 درخشان تر به چشم می آید.

    
Specular: Low White value            Specular: High White value 

 را میزان کنید. max shininessو  min shininessها ، لغزنده هايِ  highlightبراي کنترل کردن پهنايِ  .5
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 Specular: Low Shininess value       Specular: High Shininess value 

 minاگر نیاز باشد ، براي کنترلِ این که چگونه کانال هايِ درون رفت براي نگاشت کردن ارزش هايِ سیاه و سفید در نمادهايِ  .6

shininess  وmax shininess  هنگامی که یک درون رفت)mapSh (لغزنده يِ  شوندببه کار گرفته  چسبانده می شود ،shininess 

channel  .گزینه يِرا میزان کنید Red به همین منوال ، تا براي نگاشت کردن ، کانالِ قرمز به کار گرفته شود را برگزینید .Green  را

 averageیا  و کار گرفتن روشنایی ، براي بهرا  Luminanceبراي به کار گرفتن کانالِ آبی ، را  Blueبراي به کار گرفتن کانالِ سبز ، 

rgb  برگزینید.براي به کار گرفتن میانگینِ کانال هايِ قرمز ، سبز و آبی را 

 همانند سازيِ مایه هایی که نور می پراکنند

 .را به کار بگیرید Emissionبراي همانند سازيِ لامپ ها و دیگر سرچشمه هایی که نور می پراکنند ، می توانید تکمه يِ 

 Emissionروش به کار بردن تکمه يِ 

1. 3D > Shader > Emission يِ  را برگزینید تا یک تکمهEmission  بهscript .تان افزوده شود 

 کانال هایی که می خواهید به کار بگیرید را برگزینید. channelsاز فهرست پایین افتادنیِ  ، Emissionتکمه يِ  propertiesدر قابِ  .2

را میزان کنید. هر چه ارزشِ این گزینه را زیادتر  emissionدادن روشناییِ بخش هایی از رویه که روشن نشده اند ، لغزنده يِ براي تغییر  .3

 کنید ، نورِ بیش تري از مایه پراکنده شده و مایه روشن تر به چشم می آید.

 به کمک تنها یک تکمه Emission، و  Diffuse  ،Specularمیزان کردن 

است ، که با آن می توانید هر سه جنبه يِ مایه را  Emission، و  Diffuse  ،Specularترکیبی از تکمه هايِ  BasicMaterialتکمه يِ 

 میزان کنید. propertiesیک قابِ درون تنها از 

 BasicMaterialروشِ به کار بردن تکمه يِ 

1. 3D > Shader > BasicMaterial به همین نام در  را برگزینید تا تکمه ايscript .تان جا بگیرد 

از یک  matتان قرار بدهید ؛ یا آن را به درون رفت3D Object  و تکمه يِ  2Dرا میانِ نگاره يِ بافتBasicMaterial  تکمه يِ  .2

 بچسبانید. ApplyMaterialتکمه يِ 

 ی توانید براي ماسک کردن به کار بگیرید :است که م mapدارايِ چندین درگاه درون رفتBasicMaterial  تکمه يِ  .3
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• mapD  براي میزان کردن جزء :Diffuse .به کار می آید 

• mapS :  براي میزان کردن جزءSpecular .به کار می آید 

• mapE :  براي میزان کردن جزءEmission .به کار می آید 

• mapSh  : براي میزان کردن جزءShininess .به کار می آید 

کانال هایی را برگزینید که می خواهید به کار  channels، از فهرست پایین افتادنیِ  BasicMaterialتکمه يِ  properties در قابِ .4

 بگیرید.

را میزان کنید. به یاد داشته باشید زمانی که نگاره اي دارید که به درون رفتemission  براي تغییر دادن رنگ نوري که مایه می پراکند ،  .5

پردازش شده نگاه کنید تا  2Dمی کنید ، می باید به نگاره يِ چسبانده و ارزشِ آن را میزان  BasicMaterialبرچسبی از تکمه يِ بدون 

 نخواهید داشت. 3Dهیچ گونه تاثیري در پنجره يِ نمایشگرِ  emissionنید. با تغییر دادن ارزشِ یاثرِ تغییراتی که می دهید را بب

 را میزان کنید. Diffuseنگ مایه ، هنگامی که روشن سازي شده است ، گزینه يِ براي کنترل کردن ر .6

 را به کار بگیرید. Specularهايِ رويِ مایه چه اندازه روشن به چشم بیایند ، گزینه يِ  highlightبراي کنترل این که معلوم کنید  .7

را میزان کنید. اگر نگاره  max shininessو  min shininess،  درخشندگیبراي پیکربندي کردن بیش ترین و کم ترین ارزش هايِ  .8

 اي را به درون رفتmapSh  ِبراي مایه به کار می آید. درخشندگیتکمه نچسبانده باشید ، میانگین این ارزش ها به عنوانِ ارزش 

 maxو  min shininessدر نمادهايِ براي کنترلِ این که چگونه کانال هايِ درون رفت براي نگاشت کردن ارزش هايِ سیاه و سفید  .9

shininess  هنگامی که یک درون رفت)mapSh (لغزنده يِ  شوندببه کار گرفته  چسبانده می شود ،shininess channel  را میزان

ي به کار گرفتن را برا Greenرا برگزینید تا براي نگاشت کردن ، کانالِ قرمز به کار گرفته شود. به همین منوال ،  Redکنید. گزینه يِ 

را براي به  average rgbرا براي به کار گرفتن روشنایی ، و یا  Luminanceرا براي به کار گرفتن کانالِ آبی ،  Blueکانالِ سبز ، 

 کار گرفتن میانگینِ کانال هايِ قرمز ، سبز و آبی برگزینید.

 همانند سازيِ رویه هايِ هموار و یکدست

را به کار می برد. این تکمه براي مایه هايِ نرم و هموار  Phongبراي هموار کردن لبه هایی که میان وجوه هستند ، الگوریتمِ  Phongتکمه يِ  

 واقع گرایانه اي را فراهم می کند. shadingها و  highlight، مانند پوست و دیگر رویه هايِ اُرگانیک ، 

 Phongروشِ به کار بردن تکمه يِ 

1. 3D > Shader > Phong  را برگزینید تا تکمه اي به همین نام درscript .تان جا بگیرد 

از یک تکمه يِ  matتان قرار بدهید ؛ یا آن را به درون رفت3D Object  و تکمه يِ  2Dرا میانِ نگاره يِ بافتPhong  تکمه يِ  .2

ApplyMaterial .بچسبانید 

 است که می توانید براي ماسک کردن به کار بگیرید : map دارايِ چندین درگاه درون رفتPhong تکمه يِ  .3

• mapD  براي میزان کردن جزء :Diffuse .به کار می آید 

• mapS :  براي میزان کردن جزءSpecular .به کار می آید 

• mapE :  براي میزان کردن جزءEmission .به کار می آید 
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• mapSh  : براي میزان کردن جزءShininess .به کار می آید 

 کانال هایی را برگزینید که می خواهید به کار بگیرید. channels، از فهرست پایین افتادنیِ  Phongتکمه يِ  propertiesدر قابِ  .4

 را میزان کنید. colorبراي تغییر دادن رنگ مایه ،  .5

 را میزان کنید. emissionبراي تغییر دادن رنگ نوري که مایه می پراکند ، گزینه يِ  .6

 را میزان کنید. diffuseبراي کنترل کردن رنگ مایه در هنگامی که روشن دهی می شود ، گزینه يِ  .7

 را دستکاري کنید. Specularهايِ رويِ مایه چه اندازه روشن به چشم بیایند ، گزینه يِ  highlightبراي این که معلوم کنید  .8

 را میزان کنید. Shininessدرخشنده به چشم بیاید ، گزینه يِ  براي کنترل کردن این که مایه چه اندازه .9

را میزان کنید. اگر نگاره  max shininessو  min shininessبراي پیکربندي کردن بیش ترین و کم ترین ارزش هايِ درخشندگی ،  .10

 اي را به درون رفتmapSh  ِدرخشندگی براي مایه به کار می آید.تکمه نچسبانده باشید ، میانگین این ارزش ها به عنوانِ ارزش 

 maxو  min shininessبراي کنترلِ این که چگونه کانال هايِ درون رفت براي نگاشت کردن ارزش هايِ سیاه و سفید در نمادهايِ  .11

shininess  هنگامی که یک درون رفت)mapSh (یک  شوندببه کار گرفته  چسبانده می شود ،shininess channel  .را برگزینید

را براي به کار گرفتن کانالِ  Greenرا برگزینید تا براي نگاشت کردن ، کانالِ قرمز به کار گرفته شود. به همین منوال ،  Redگزینه يِ 

ر را براي به کا average rgbرا براي به کار گرفتن روشنایی ، و یا  Luminanceرا براي به کار گرفتن کانالِ آبی ،  Blueسبز ، 

 گرفتن میانگینِ کانال هايِ قرمز ، سبز و آبی برگزینید.

 شیء هندسی تان ) بر رويWireframe overlayِیک پوشاننده يِ قاب سیمی ( پردازشِ

 Particleمی توانید یک پوشاننده يِ قاب سیمی را بر رويِ رویه يِ شیء هندسی تان یا همانند سازيِ ذره اي ( Wireframeبا تکمه يِ 

simulation: پردازش کنید. این کار در جاهایی سودمند است که بخواهید براي نمونه ( 

 .یا نه ببینید بافتی که بر رويِ شیء گذاشته اید با هندسه يِ شیء به درستی تراز است •

 پردازشی سریعی از صحنه تان داشته باشید تا جاهايِ اشیاء تان را بررسی کنید. •

 ) درست کنید.motion graphicگرافیک هايِ حرکتی ( •

 ساختارِ ویدئوها را درست کنید. •

پردازش  ScanlineRenderتان را دارید با  3Dتنها زمانی کار می کند که صحنه يِ  Wireframeتکمه يِ  یادداشت :

 می کنید.

 Wireframeروشِ به کار بردن تکمه يِ 

1. 3D > Shader > Wireframe  را برگزینید تا تکمه اي به همین نام درscript .تان جا بگیرد 

از یک تکمه  matتان قرار بدهید ؛ یا آن را به درون رفت3D Object  و تکمه يِ  2Dرا میانِ نگاره يِ بافتWireframe  تکمه يِ  .2

 بچسبانید. ApplyMaterialيِ 
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یی را برگزینید که می خواهید به کار کانال ها channels، از فهرست پایین افتادنیِ  Wireframeتکمه يِ  propertiesدر قابِ  .3

 بگیرید.

 ، مشخص کنید که پوشاننده يِ قاب سیمی چگونه به شیء هندسی تان داده شود : operationاز فهرست پایین افتادنیِ  .4

• Opaque  پایین،  که کاملاً سیاه و مات است (نگاره يِ سمت راست به نمایش در می آید: قاب سیمی بر رويِ هندسه اي از شیء(. 

• See through پایین : قاب سیمی بر رويِ هندسه اي از شیء می نشیند که کاملاً شفاف است (نگاره يِ سمت چپ ،.( 
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• Over  ِقاب سیمی بر روي :shader .(نگاره يِ سمت راست ، پایین) شیء به نمایش در می آید یا بافت 

• Multiply  قاب سیمی با :shader  شیء ضرب می شود و سپس بر رويِ هندسه يِ کاملاً شفافی از شیء به نمایش یا بافت

 گذاشته می شود (نگاره يِ سمت چپ ، پایین).

  

• Modulate  :diffuse shading  ِاستانداردي به قاب سیمی داده شده و سپس بر رويshader  شیء به نمایش گذاشته یا بافت

 ، مربوط می شود. نورهایی که در صحنه است می شود. این الگو به شمارِ

 

 را میزان کنید. Line widthبراي پیکربندي کردن پهنايِ خطوط قاب سیمی (بر حسب پیکسل) ، کنترلِ  .5
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Line width = 0.5    Line width = 3 

 را میزان کنید. Line colorبراي پیکربندي کردن رنگ و شفافیت خطوط قاب سیمی ، گزینه يِ  .6

  
Line color .بر رويِ سفید گذاشته شده است        Line color .بر رويِ فیروزه اي پیکربندي شده است 

 با هم Shaderیکی کردن دو تکمه يِ 

گوریتم هايِ را با هم یکی کنید. براي این کار ، ال shader، می توانید دو تکمه يِ  Shaderاز فهرستMergeMat  به کمک تکمه يِ 

به ویژه براي ترکیب کردن  MergeMatرا می توانید به کار بگیرید. تکمه يِ  stencil، و  none  ،replace  ،overترکیب بندي مانند 

که یکی در بالايِ دیگري بر رويِ  2Dمی توانید نگاره هايِ  Project3Dبسیار به کار می آید. با تکمه هايِ  Project3Dچندین تکمه يِ 

 نشانده شده اند را ترکیب کنید. 3Dشیء هندسیِ 

 با هم shaderروشِ یکی کردن دو 

1. 3D > Shader > MergeMat  ِرا برگزینید تا تکمه اي به همین نام پس از دو تکمه يShader  که می خواهید آن ها را با هم یکی

 تان قرار بگیرد. scriptکنید ، در 

 آن بیاندازید.تان بچسبانید که می خواهید نگاره ها را بر رويِ 3Dاز شیءimg  را به درون رفتMergeMat  تکمه يِ  .2

به عنصرِ پس زمینه  Bبه عنصرِ پیش زمینه ، و  Aبچسبانید.  MergeMatتکمه يِ  Bو  Aرا به درون رفت هايِ  Shaderتکمه هايِ  .3

 بر می گردد.
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را با هم یکی کرده و  Project3Dبراي نمونه ، اگر خواسته باشید دو تکمه يِ 

 سپس برآیند به دست آمده را بر رويِ یک شیءSphere  تکمه بیاندازید ، درخت

 باشد : زیراي تان باید چیزي مانند نگاره يِ 

، با برگزیدن یکی از گزینه هايِ زیر مشخص  Operationاز فهرست پایین افتادنیِ  .4

را با هم دیگر ترکیب  Shaderکنید که چگونه می خواهید برآیندهايِ دو تکمه يِ 

 کنید :

•  اگر می خواهید تنها درون رفتB  ِرا به کار بگیرید ، گزینه يnone  را

 برگزینید.

•  اگر می خواهید تنها درون رفتA ِرا به کار بگیرید ، گزینه ي Replace .را برگزینید 

•  براي ترکیب شدن درون رفتA  بر رويِ درون رفتB  ِیک ماسک ، گزینه ي به کمکOver .را برگزینید 

 را برگزینید. Stencilبیرون از منطقه يِ ماسک ، گزینه يِ  Bدرون رفت  بردنبراي به کار  •

 را برگزینید. Maskيِ  درونِ منطقه يِ ماسک ، گزینه Bدرون رفت  بردنبراي به کار  •

•  براي افزودن درون رفتB  بهA  ِگزینه ي ،Plus .را برگزینید 

•  براي به کار گیريِ درون رفتA  اگر بزرگ تر از درون رفتB  باشد ، وگرنه درون رفتB  ِبه کار برود ، گزینه يMax .را برگزینید 

•  براي به کار گیريِ درون رفتA  اگر کوچک تر از درون رفتB  باشد ، وگرنه درون رفتB  ِبه کار برود ، گزینه يMin .را برگزینید 

کانالی را برگزینید که براي آلفا  Alayer) نیاز دارند ، از فهرست پایین افتادنیِ Mask) که به کانالِ آلفا (Overبراي کارکردهایی (مانند  .5

 به کار بیاید.

 ا اشیاء پشتیآمیختنِ یک مایه ب

می توانید معلوم کنید که پیکسل هايِ رنگ آمیزي شده با مایه اي که به آن ها داده شده  Shaderاز فهرستBlendMat  به کمک تکمه يِ 

یگري است ؛ ولی به جايِ این که با مایه يِ د MergeMatاست ، چگونه با پیکسل هايِ اشیاء پشت ترکیب شوند. این تکمه مانند تکمه يِ 

 در بخشِ پشتی پردازش می شود. 3Dبا آن چیزي آمیخته می شود که در یک صحنه يِ ،  در هم بیامیزد

  
به گویی داده  BlendMatبه کار نرفته است. در نگاره يِ سمت چپ ، یک تکمه يِ  BlendMatدر نگاره يِ بالا سمت راست ، تکمه يِ 

نیز  BlendMatتکمه يِ  Operationاست و دارايِ یک کانالِ آلفايِ شطرنجی است. گزینه يِ شده است که با بافت شطرنجی پوشانده شده 

 گذاشته شده است. Stencilبر رويِ 
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 روشِ آمیختنِ یک مایه با اشیاء پشتی

1. 3D > Shader > BlendMat  ِرا برگزینید تا یک تکمه ي

BlendMat  با پیکسلپس از مایه اي قرار بگیرد که می خواهید آن را 

 هايِ پس زمینه در هم بیامیزید.

 3D Objectاز تکمه يِ  imgرا به درون رفتBlendMat  تکمه يِ  .2

 بچسبانید که می خواهید مایه را بر رويِ آن بیاندازید.

کانال هایی را برگزینید که می  channelsاز فهرست پایین افتادنیِ  .3

 خواهید تاثیر بگیرند.

، گزینه اي را برگزینید که می  Operationیِ از فهرست پایین افتادن .4

 BlendMatمایه اي که به درون رفت تکمه يِ خواهید با آن معلوم کنید 

 می آید چگونه با پیکسل هايِ پس زمینه آمیخته و ترکیب شود :

 ، پایین). را برگزینید (نگاره يِ سمت راست Noneاگر می خواهید مایه به رنگ سیاه پیکربندي شود ، گزینه يِ  •

را برگزینید تا در جایی که مایه و پس زمینه بر رويِ هم می افتند ، مایه نشان داده شود (نگاره يِ میانی ،  Replaceگزینه يِ  •

 پایین).

نگاره را برگزینید ( Overمبنايِ آلفايِ خود مایه ، بر رويِ پیکسل هايِ پس زمینه ترکیب کنید ، گزینه يِ  اگر می خواهید مایه را بر •

 يِ سمت چپ ، پایین).

   

را  Stencilاگر می خواهید در جایی که آلفايِ خود مایه سیاه رنگ است پیکسل هايِ پس زمینه نشان داده شوند ، گزینه يِ  •

 جایی که آلفايِ مایه سفید رنگ باشد ، مایه با رنگ سیاه به نمایش در می آید.. برگزینید

بگذارید.  rgbaرا بر رويِ  channelsمی باید کانالِ آلفا را آماده سازي کند. بنا بر این ،  BlendMatبراي این کار ، تکمه يِ 

 درست وارونه يِ کارکرد این کارکردMask .(راست ، پایین نگاره يِ سمت) است 

 را برگزینید. Maskند ، گزینه يِ اگر می خواهید در جایی که آلفايِ خود مایه سفید رنگ است پیکسل هايِ پس زمینه نشان داده شو •

 جایی که آلفايِ مایه سیاه رنگ باشد ، مایه نیز به رنگ سیاه پیکربندي می شود.

 بگذارید. rgbaرا بر رويِ  channelsمی باید کانالِ آلفا را آماده سازي کند. بنا بر این ،  BlendMatبراي این کار ، تکمه يِ 

 است (نگاره يِ میانی ، پایین). Stencilکرد این کارکرد درست وارونه يِ کار

 را برگزینید (نگاره يِ سمت چپ ، پایین).  Plusبراي این که پیکسل هايِ پس زمینه به مایه افزوده شوند ، گزینه يِ  •
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هايِ مایه بزرگ تر از پیکسل هايِ پس زمینه باشد ، خود مایه ، وگرنه پیکسل هايِ پس زمینه  لاگر بخواهید زمانی که ارزشِ پیکس •

 را برگزینید (نگاره يِ سمت راست ، پایین). Maxبه کار برود ، گزینه يِ 

ینه یکسل هايِ پس زمتر از پیکسل هايِ پس زمینه باشد ، خود مایه ، وگرنه پ کوچکهايِ مایه  لاگر بخواهید زمانی که ارزشِ پیکس •

 ، پایین). چپرا برگزینید (نگاره يِ سمتMin  به کار برود ، گزینه يِ 

  

 جایگزین کردن کانال هايِ مایه با یک رنگ پایدار

جایگزین کنید. این امکان را براي شما فراهم می کند که کانال هايِ مایه اي که برگزیده اید را با یک رنگ پایدار و ثابت  FillMatتکمه يِ 

بگذارید ، تکمه  0را بر رويِ  FillMatهنگامی که رنگ  معمولاً ، این تکمه را براي این به کار می برید تا یک شیء را از اشیاء دیگر جدا کنید.

 ی درست می کند.) کار می کند و درست در جایی که مایه است ، یک سوراخِ سیاه رنگ3D )3D cookie cutterبه مانند یک برش دهنده يِ 

   
 FillMatکانالِ آلفا ، پس از این که تکمه يِ   FillMatهمان صحنه : به کمک تکمه يِ  Cubeدر جلويِ یک  Sphereیک 

 به کار گرفته شده است. بر رويِ  Sphereمایه يِ  rgbaکانال هايِ     

 سیاه پیکربندي شده اند.    

با رنگ سیاه را به عنوان بافت به درون رفت مایه بدهیم. به هر روي ، کاربرد تکمه يِ  Constantاین درست مانند این است که یک تکمه يِ 

FillMat ت را دارد که می توانید به آسانیآن را به کانالِ آلفا و نیز کانال هايِ  این مزیrgb ست که بدهید. از دیگر مزایايِ این تکمه این ا

shading sequence  ِتکمه اي تان پس از تکمه هاي را نمی شکند ، و بنا بر این می توانید آن را در درختmaterial .دیگر به کار ببرید 

 روشِ جایگزین کردن کانال هايِ یک مایه يِ برگزیده شده با یک رنگ پایدار
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1. 3D > Shader > FillMat  ِرا برگزینید تا یک تکمه يFillMat  ِمیان

 3Dکه براي بافت دهی رویه به کار می برید ، و تکمه يِ  2Dنگاره يِ 

Object .که رویه را می سازد ، قرار بگیرد 

کانال هایی را  channelsاز کنترل هايِ ،  FillMatدر بخشِ کنترل هايِ  .2

 برگزینید که می خواهید آن ها را با یک رنگ پایدار جایگزین کنید.

را به کار بگیرید. به طور پیش  colorگزیدن یک رنگ پایدار ، کنترلِ براي بر .3

 ) پیکربندي شده است.0فرض ، این کنترل بر رويِ رنگ سیاه (

 انداختن بافت ها بر رويِ اشیاء

بافتی را  می توانید نگاره هايِ Project3Dو  UVProjectبه کمک تکمه هايِ 

 3بر رويِ اشیاءD ر این روش می توانید جزئیات ، بافت ، یا رنگ تان بیاندازید. د

را به رویه يِ شیء هندسی بیافزایید. بدین سان ، شیء هندسی تان واقع گرایانه تر 

 و جالب تر به چشم می آید.

 است. material shaderیک  Project3Dورتکس ها را تغییر می دهد ، ولی تکمه يِ  UVارزش هايِ  UVProjectتکمه يِ 

 UVProjectبه کمک تکمه يِ بر رويِ اشیاء  انداختنِ بافت ها

را براي شیء پیکربندي می کند ؛ و اجازه می دهد که یک نگاره يِ بافتی را بر رويِ شیء بیاندازید. اگر  UVمختصاتUVProject  تکمه يِ 

 شیء خودش مختصاتUV  داشته باشد ، این تکمه مختصاتUV خودش را جایگزینِ م ختصاتUV .شیء می کند 

 UVProjectروشِ به کار بردن تکمه يِ 

1. 3D > Shader > UVProject .را برگزینید تا تکمه اي به همین نام پس از شیء اي که می خواهید آن را پیرایش کنید قرار بگیرد 

 را ببینید.بچسبانید تا بتوانید تغییراتی که می دهید  UVProjectرا به تکمه يِ  Viewerیک تکمه يِ  .2

گزینه اي را برگزینید که می خواهید شیء تان در پنجره يِ نمایشگر با آن  displayدر قابِ کنترل هايِ تکمه ، از فهرست پایین افتادنیِ  .3

 نما به نمایش گذاشته شود.

را به  Axisیک تکمه يِ بچسبانید. اگر  UVProjectاز تکمه يِ  axis/camرا به درگاه درون رفتCamera  یا  Axisیک تکمه يِ  .4

 این درگاه بچسبانید ، مختصاتUV  ِارزش هاي بافت به کمکAxis transform  ، یعنی)Translation  ،Rotation  ،Scale  و

 را خواهید داشت ، ولیAxisهمانند تکمه يِ  projectionرا به این درگاه بچسبانید ،  Camera...) بر رويِ شیء می افتد. اگر تکمه يِ 

 ) نیز به کار می آیند.Apertureدر این جا داده هايِ لنزِ دوربین (مانند 

 نمادهايِ زیر را میزان کنید : .5
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، الگویی را برگزینید که می خواهید بافت بر رويِ شیء بیافتد. معمولاً ، به ترین کار این  projectionاز فهرست پایین افتادنیِ  •

(مانند یک توپِ  Sphereاست که الگویی را برگزینید که به شکلِ رویه یی شیء نزدیک باشد. براي نمونه ، اگر شیء شما یک 

 را برگزینید. Sphericalفوتبال یا یک سیاره) است ، الگويِ 

 zتا نگاره يِ بافتی در راستايِ آسه هايِ  ZX، یا  XY  ،YZرا برگزینید :  projection، راستايِ  Planeفهرست پایین افتادنیِ از  •

 ،x  یا ،y  بر رويِ شیء بیافتد. این فهرست تنها زمانی در دسترس شما قرار می گیرد که از فهرستprojection type  ِالگوي ،

Planar ید.را برگزیده باش 

آن  ، بسته به این که آیا می خواهید بافت را به وجه جلویی شیء بیاندازید یا به وجه پشتیِ project onاز فهرست پایین افتادنیِ  •

را برگزینید. وجه جلویی شیء وجهی است  both، یا  front  ،back، و یا به هر دو وجه جلویی و پشتی ، یکی از گزینه هايِ 

 قرار می گیرد و به همین منوال ، وجه پشتیِ شیء وجهی است که در دورترین فاصله از دوربین قرار دارد. که رو به دوربین

دوربین هستند ، گزینه  view frustumتنها بر رويِ ورتکس هایی تاثیر بگذارد که درونِ  UVProjectاگر می خواهید تکمه يِ  •

باشد از تکمه تاثیر نگرفته  view frustumکار ، هر ورتکسی که بیرون از را نشان بزنید. با این  view frustum cullingيِ 

 و مختصاتUV  اصلی خودش نگه داشته می شود. اگر می خواهید تکمه بر رويِ همه يِ ورتکس ها تاثیر بگذارد ، نشانِ این گزینه

 را بردارید.

•  براي آینه اي کردن مختصاتUV  ِبافت در راستايِ افق ، گزینه يInvert u  را نشان بزنید. براي آینه اي کردن همین مختصات در

 را نشان بزنید. Invert vراستايِ عمودي ، گزینه يِ 

•  براي تغییر دادن اندازه يِ مختصاتUV  ِبافت (فشرده کردن و یا کشیدن بافت) در راستايِ افق ، لغزنده يu scale .را میزان کنید 

را میزان کنید. هر چه ارزشِ این لغزنده ها را  v scaleبراي تغییر دادن اندازه يِ همین مختصات در راستايِ عمودي ، لغزنده يِ 

 بالاتر بگیرید ، بافت بیش تر کشیده می شود.

•  براي تغییر دادن نامِ ویژه گی که به عنوان مختصاتUV ِرا  تصویري را بیابید ، نامی ورتکس به کار گرفته می شود تا بتوانید پیکسل

 بنویسید. attrib nameدر میدانِ 

 Project3Dانداختنِ بافت ها بر رويِ اشیاء به کمک تکمه يِ 

 می اندازد. 3D، نگاره اي که از درونِ یک دوربین می آید را بر رویی یک شیءProject3D  تکمه يِ 

 Project 3Dروشِ به کار بردنِ تکمه يِ 

1. 3D > Shader > Project3D  ِرا برگزینید تا یک تکمه يProject3D ِپس از شیء اي قرار بگیرد که می خواهید بافتی را بر روي 

 بچسبانید. Project3Dاز تکمه يِ  camرا به درگاه درون رفتCamera  آن بیاندازید. یک تکمه يِ 

 قرار بدهید. Project3D) را پس از تکمه يِ Sphere(مانند یک  3D Geometryیک تکمه يِ  .2

 بچسبانید تا بتوانید تغییراتی که می دهید را ببینید. 3D Geometryرا به تکمه يِ  Viewerیک تکمه يِ  .3

گزینه اي را برگزینید که می خواهید شیء تان در پنجره يِ نمایشگر با آن  displayدر قابِ کنترل هايِ تکمه ، از فهرست پایین افتادنیِ  .4

 نما به نمایش گذاشته شود.
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، گزینه اي را برگزینید که نشان بدهد می خواهید نگاره را بر رويِ وجوه جلویی ، وجوه پشتی ،  project onاز فهرست پایین افتادنیِ  .5

 یاندازید.یا چندگوشه هايِ جلویی و پشتی هر دو ب

را نشان بزنید. اگر می خواهید نگاره با  cropبراي این که نگاره يِ درون رفت از لبه هایش به بعد با رنگ سیاه گسترده شوند ، گزینه يِ  .6

 را بردارید. cropلبه هایی گسترده شود که رنگی باشند ، نشانِ گزینه يِ 

 ray، روشِ  )occlusionهستند (کردن بخش هایی از آن که از دید پنهان و پیدا  projectionاگر می خواهید براي آزمایش کردن  .7

casting  ِپایین افتادنی را به کار بگیرید ، می توانید از فهرستocclusion mode : گزینه يِ دلخواه تان را برگزینید 

• None  ِروش :occlusion testing .را از کار می اندازد 

• Self  ِبه تکمه ي :Project3D هنم دسی که به آن چسبانده شده است ، می تواند سبب ی گوید که تنها شیءocclusion .شود 

• World تکمه يِ  : بهProject3D  می گوید که همه يِ اشیایی که در صحنه هستند می توانند سببocclusion .بشوند 

 ها به درون برنامه UDIM Patchآوردن 
هستند  (1,1) – (0,0)که بیرون از دامنه يِ استاندارد را به کار می گیرند  UVبخش هایی از فضايِ  که، هر گاه بافت ها را به مدل ها می دهید 

 UDIMبه کار می رود. این بافت ها را می توان به راه هايِ گوناگون شماره زد.  1*1چهارگوشی به اندازه يِ هر ، معمولاً یک بافت براي 

شناسایی  1001داده شده است را با شماره يِ  (1,1) – (0,0)ا ؛ که نخستین بافتی که به ناحیه يِ ي است براي شماره دار کردن بافت هتمهید

 د.نده تا ده تا زیاد می شو Vیکی یکی ، و در راستايِ  U، و شماره هايِ پس از آن براي هر بافت ، در راستايِ  می کند

 UDIMاست با شماره يِ  (1,2) – (0,1)، و بافتی که در ناحیه يِ  1003اره يِ است ، شم (2,1) – (1,0)براي نمونه ، بافتی که در ناحیه يِ 

 باشند : که به دنبالِ آن ها می آید ممکن است مانند زیر UDIMها با شماره هايِ  patchشماره گذاري می شود. مجموعه اي از  1011

• color.1001.tif 
• color.1002.tif 
• color.1003.tif 
• color.1004.tif 
• color.1005.tif 

اختصاص داده  UDIMدر فضايِ  patchهستند که براي هر  UDIMارزشِ   ، ... 1002،  1001نامِ کانال ، و شماره هايِ  colorدر این جا 

همراه هستند. می توانید  UDIMها را به درون برنامه بیاورید که با نقشه يِ  patch، می توانید مجموعه اي از  Nukeشده اند. در برنامه يِ 

 3آن ها را به سرعت به رویه هايِ یک شیءD : بدهید. براي این کار 

1. Image > UDIM Import .را از نوارِ ابزار اجرا کنید 

 را کلیک کنید. Openرا برگزینید تا به درون برنامه آورده شود. دکمه يِ  UDIMنگاره یا سکانسِ  .2

 ) که در کنارِ آن است را از کار بیاندازید.Checkboxنادیده گرفته شود ، چهارچوبِ نشان خوري (تکی  patchاگر می خواهید یک  .3

 کلیک کنید. Add Filesهايِ دیگري را بیافزایید ، بر رويِ دکمه يِ  patchاگر می خواهید  .4

در زیرِ دکمه  یک پنجره يِ هشداروجود داشته باشد ، ) conflict(هایی که می افزایید ناسازگاري  patchاگر میان  یادداشت :

 باز می شود و ناسازگاري را بیان می کند.  Add Filesيِ 

که ارزشِ بیاورید  Nukeرا به درون برنامه يِ یکی از همین ناسازگاري هايِ معمول این است که تلاش کنید چندین پرونده اي 

UDIM .یکسانی دارند 
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 نمایان شود. Readبر رویی تکمه يِ  patchتا یک نمايِ بند انگشتی از  را نشان بزنید postage stampگزینه يِ  .5

جاي بگیرد. نامِ تکمه يِ  Groupتکی ، در یک تکمه يِ  patchبراي هر  Readرا نشان بزنید تا تکمه يِ  group nodesگزینه يِ  .6

Group .بر مبنايِ نامِ نگاره یا سکانس مشخص می شود 

 را بزنید تا پرونده ها به درون برنامه آورده شوند. OKدکمه يِ  .7

به هر یک از آن ها پیوست می شود (  UVTileدرست می شود و یک تکمه يِ  Readدر سکانس یک تکمه يِ  patchبدین سان ، براي هر 

 پیرایش کنید). 3Dرا در فضايِ  patchکه این تکمه به شما اجازه می دهد مختصات یک 

 

را  Groupزده باشید ، تکمه يِ نشان  UDIM Importرا در پنجره يِ  group nodesاگر گزینه يِ  یادداشت :

highlight  کرده و کلیدCtrl+Return .آن به نمایش در آیند را فشار بدهید تا محتویات 

جاگذاري می شود. این ارزش بسیار مهم است چرا که هر تکمه يِ  UVTileاز تکمه يِ  udimدر میدانِ  patchبراي هر  UDIMارزشِ 

Read  و بنا بر این ، هر)patch ِرا به فضاي (UDIM  درستoffset  ِمی کند. براي یکی کردن تکمه هايRead/UVTile  با هم می توانید

 کمک بگیرید. MergeMatاز شماري از تکمه هايِ 

به هم دیگر  MergeMatنتهايِ درخت تکمه اي ، زمانی که چندین تکمه يِ در ا MultiTextureتکمه يِ  یادداشت :

پیش فرض را به کار می گیرد و تنها  lop vertex shaderزنجیر شده باشند ، کارِ پردازش را بهبود می بخشد. این تکمه 
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 UDIMتنها براي کار با کارکرد  ندارد و )knob( سر و کار دارد. این تکمه هیچ گونه میدان یا گره اي multi-texturingبا 

Import .درخواست می شود 

بدهید ، به آسانی درگاه بیرون رفت آخرین تکمه اي که در درخت تکمه  3Dها را در صحنه اي که دارید به یک شیءpatch  براي این که این 

 درون رفت اي است را به درگاهimg  ِاز یک تکمه يReadGeo .بچسبانید 

گوناگونی را بنویسید ، یا میدانِ  UDIMارزشِ  UVTile، در قابِ کنترلِ  UVبه نقطه يِ دیگري در فضايِ  patchبراي جا به جا کردن یک 

udim  ِرا از کار بیاندازید و در میدان هايu  وv .ارزش هایی را بنویسید 

تعیین می کند. به هر  UDIMر مبنايِ شماره يِ به طور پیش فرض ، نامِ پرونده را ب UDIM Importکارکرد  یادداشت :

ه کار را بپیمان نامه هايِ نامگذاري خودتان ،  براي تعیینِ نامگذاري سفارشیمکن است ، براي ساخت یک کارکرد روي م

 بخوانید.را  python developers. براي این که بدانید چگونه باید این کار را انجام بدهید ، خواهشمندیم راهنمايِ بگیرید

 نورپردازي
 تکمه هایی که در زیرِ فهرستLights  چیدمان شده اند این امکان را براي شما فراهم می کنند که بتوانید نورپردازيِ صحنه تان را به دست

ده و آن ز ژرفا را درست کربگیرید. به کمک این تکمه ها می توانید اشیاء را به جلو کشیده و یا آن ها به عقب برگردانید ، و با این کار توهمی ا

 .دچه در دنیايِ راستین می بینید را همانند سازي کنید ؛ یا می توانید با این تکمه ها به آسانی حسی که از صحنه می گیرید را تغییر بدهی

 Directبگیرید : نورِ مستقیم (تان به کار  3Dچهار الگو را براي نورپردازي ارائه می کند که می توانید آن ها در صحنه هايِ  Nukeبرنامه يِ 

light) نورِ نقطه اي ، (Point light ِنور ، (Spot ) و نورِ محیطی ،Environment light ِبا به کار بردن تکمه هاي .(DirectLight  ،

Point  ،SpotLight  و ،Environment  ِمی توانید این نورها را به صحنه بیافزایید. به جز این ها ، یک تکمه يLight  هم هست که با

 نیز نورها را بخوانید. fbx.بسازید. هم چنین می توانید از یک پرونده يِ را  spotو  direct  ،pointآن می توانید نورهايِ 

ا نورههمگی کنترل هایی دارند که می توانید به کمک آن کنترل ها معلوم کنید که  SpotLight، و  Light  ،DirectLight  ،Pointتکمه هايِ 

 .)casting shadow( تان سایه بیاندازند 3Dچگونه در صحنه هايِ 

 3هم چنین نورپردازي از نرُمال هايِ شیءD  نیز تاثیر می گیرند. این نُرمال ها براي این به کار می روند که مشخص می کنند نوري که به یک

این اجازه را به شما می دهد که  Normals، تکمه يِ  Nukeيِ نقطه يِ خاص از یک رویه برخورد می کند چگونه پس بجهد. در برنامه 

 را کنترل کنید. specularو  diffuseبتوانید نرُمال هايِ شیء را دستکاري نموده و بنا بر این ، ویژه گی هايِ نورِ 

است  pointو  normalهايِ  passرا می گیرد که این نگاره دارايِ  2Dنیز در این فهرست هست که یک نگاره يِ  Relightیک تکمه يِ 

 ) کنید.Relightآن نگاره را دوباره نورپردازي ( 3D؛ و این امکان را براي شما فراهم می کند که به کمک نورهايِ 

 نورها جاي گذاريِ

 می توانید بیافزایید این ها هستند : 3Dنورهایی که به یک صحنه يِ 

به درون برنامه يِ  FBX، و نورهایی که از یک پرونده يِ  Environment، نورهايِ  Spot، نورهايِ  Point، نورهايِ  Directنورهايِ 

Nuke .می آورید 
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 Directجاي گذاريِ نورهايِ 

ده ش یک نورِ مستقیم نوري است که پرتوهايِ آن در یک راستا و موازي با هم تابیده می شوند. پرتوهايِ این نور از یک سرچشمه يِ دور تابانده

دارد  تانگار همه يِ اشیایی که در صحنه دارید را با شدتی یکسان نورپردازي می کنند. نورِ مستقیم در فاصله يِ بی نهایت از اشیاء بوده و جهو 

)orientation) ولی جایگاهی ندارد ، (positionد). یک نمونه از نورِ مستقیم در دنیايِ راستین ، خورشید است. نورِ مستقیم را می توانی 

 براي نمونه ، براي همانند سازيِ نورِ خورشید و نورِ ماه به کار بگیرید.

 افزودنِ یک نورِ مستقیم

1. 3D > Lights > Direct  ِرا برگزینید تا یک تکمه يDirectLight  درscript .تان بنشیند 

 بچسبانید. Sceneرا به تکمه يِ  DirectLightتکمه يِ  .2

 ، گزینه هايِ زیر را میزان کنید : DirectLightدر قابِ کنترل هايِ تکمه يِ  .3

 .کندتغییر تا رنگ نور را به چپ و راست بکشید  colorلغزنده يِ  •

 را بکشید. intensityبراي تغییر دادن روشناییِ نور ، لغزنده يِ  •

 بنویسید. rotateبراي کنترل نمودنِ راستايِ نور ، ارزشِ دلخواه را در میدانِ  •

 
 بروید و کنترل هايِ آن را میزان کنید. Shadowsبه برگه يِ یکربندي هايِ سایه ، براي میزان کردن پ •

 جاي گذاريِ نورهايِ نقطه اي

است که در هر راستا نور می پراکند. نمونه اي از نورِ نقطه اي در دنیاي راستین ، حبابِ نور است.  3Dیک نورِ نقطه اي ، نقطه اي در فضايِ 

 براي همانند سازي حباب هايِ نور ، لامپ ها ، و شمع ها ، می توانید نورِ نقطه اي را به کار بگیرید.

 افزودنِ یک نورِ نقطه اي

1. 3D > Lights > Point ِرا برگزینید تا یک تکمه ي PointLight  درscript .تان بنشیند 

 بچسبانید. Sceneرا به تکمه يِ  PointLightتکمه يِ  .2
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 ، گزینه هايِ زیر را میزان کنید : PointLightدر قابِ کنترل هايِ تکمه يِ  .3

 .کندتغییر تا رنگ نور را به چپ و راست بکشید  colorلغزنده يِ  •

 را بکشید. intensity براي تغییر دادن روشناییِ نور ، لغزنده يِ •

اگر می خواهید معلوم کنید که شیء چه اندازه نور از سرچشمه يِ نور بگیرد (بر مبنايِ فاصله اي که میانِ شیء و سرچشمه يِ نور  •

 ، شدت نور هم چنان که مسیر را تا شیء طی Linearرا به کار بگیرید. در الگويِ  falloff typeاست) ، فهرست پایین افتادنیِ 

شدت نور با نرخِ تصاعدي کاهش می یابد.  Cubicو  Quadraticمی کند ، با یک نرخِ پایدار کاهش می یابد ؛ ولی در الگوهايِ 

را از فهرست برگزینید ، فاصله اي که میانِ سرچشمه يِ نور و اشیاء هست هیچ گونه تاثیري در شدتNo Falloff  اگر گزینه يِ 

 نور نخواهد داشت.

 ارزش هايِ دلخواه تان را بنویسید. translateکنترل کنید ، در میدان هايِ  3Dخواهید جايِ نور را در فضايِ اگر می  •

بروید و کنترل هايِ آن را میزان کنید. به هر روي ، به یاد داشته  Shadowsبراي میزان کردن پیکربندي هايِ سایه ، به برگه يِ  •

 را به کار می برید ، نورِ نقطه اي از اشیاء سایه اي نمی اندازد. ScanlineRenderباشید که اگر دارید تکمه يِ 

 Spotجاي گذاريِ نورهايِ 

در دنیايِ  Spotاست که یک نورِ مخروطی شکل را در یک راستايِ معین می تاباند. نمونه اي از نورِ  3Dنقطه اي در فضايِ  Spotیک نورِ 

 .راستین ، یک چراغِ مطالعه است

 Spotافزودنِ یک نورِ 

1. 3D > Lights > Spot  ِرا برگزینید تا یک تکمه يSpotLight  درscript .تان بنشیند 

 ، گزینه هايِ زیر را میزان کنید : SpotLightدر قابِ کنترل هايِ تکمه يِ  .2

 را به چپ و راست بکشید تا رنگ نور تغییر کند. colorلغزنده يِ  •

 را بکشید. intensityبراي تغییر دادن روشناییِ نور ، لغزنده يِ  •

را به چپ و  cone angle، لغزنده يِ (باریک و یا پهن شدن دهانه اي که پرتوهايِ نور را می پراکند) براي میزان کردن پخشِ نور  •

 ر بدهید.درجه می توانید تغیی 180تا  0میزانِ پخشِ نور را بر مبنايِ درجه از  راست بکشید.

بازي کنید. اگر به این  cone penumbra angleبخشِ روشن را بتوانید کنترل کنید ، با لغزنده يِ براي این که نرمیِ لبه هايِ  •

گزینه ارزشِ منفی بدهید ، بخشِ روشن از لبه يِ گردي به سمت درون نرم می شود. اگر به این گزینه ارزشِ مثبتی بدهید ، بخشِ 

گردي به سمت بیرون نرم می شود. براي این که بتوانید نرمی را در لبه يِ بخشِ روشن ببینید ، می باید گزینه يِ  روشن از لبه يِ

cone falloff  ِو یا یک ارزشِ پایین پیکربندي کنید. این جنبه تنها در اشیایی که پردازش شده باشند دیده می  0را بر رويِ ارزش

 دیده نمی شود. 3D OpenGLشود و در نمایشگرِ 

 ، چه اندازه کاهشمی رسد  مرکزِ بخشِ گرد تا لبه يِ آن از ي کهبراي کنترل نمودن این که نور چگونه متمرکز شود (یعنی ، از نور •

 falloffرا میزان کنید. هر چه ارزشِ این گزینه را بالاتر بگیرید ، نور بیش تر فوکوس می شود. این  cone falloffبیابد) ، لغزنده يِ 

 جدا بوده و به آن وابسته نیست. falloff typeاز 
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اگر می خواهید معلوم کنید که شیء چه اندازه نور از سرچشمه يِ نور بگیرد (بر مبنايِ فاصله اي که میانِ شیء و سرچشمه يِ نور  •

هم چنان که مسیر را تا شیء طی  ، شدت نور Linearرا به کار بگیرید. در الگويِ  falloff typeاست) ، فهرست پایین افتادنیِ 

شدت نور با نرخِ تصاعدي کاهش می یابد.  Cubicو  Quadraticمی کند ، با یک نرخِ پایدار کاهش می یابد ؛ ولی در الگوهايِ 

ت درا از فهرست برگزینید ، فاصله اي که میانِ سرچشمه يِ نور و اشیاء هست هیچ گونه تاثیري در ش No Falloffاگر گزینه يِ 

 نور نخواهد داشت.

 بنویسید. rotateبراي کنترل کردن جهت نورپردازي ، ارزشِ دلخواه تان را در میدان هايِ  •

 ارزش هايِ دلخواه تان را بنویسید. translateکنترل کنید ، در میدان هايِ  3Dاگر می خواهید جايِ نور را در فضايِ  •

 بروید و کنترل هايِ آن را میزان کنید. Shadowsه يِ براي میزان کردن پیکربندي هايِ سایه ، به برگ •

 جاي گذاريِ نورهايِ محیطی

ازي که این نورپرد نگاره اي که از محیط دنیايِ راستین به دست آمده است ، اشیاء را روشن می کند. ا روشناییِیک نورِ محیطی نوري است که ب

ساخته می شوند  HDRIبه دست می آید. هنگامی که نگاره هايِ  HDRI (high dynamic range image)بر مبنايِ یک نگاره است ، با 

نگاره  ،، چندین نگاره که هر کدام نوردهی گوناگونی دارند با هم یکی می شوند و نگاره يِ تکی را از محیط پیرامون درست می کنند. بنا بر این 

دامنه يِ گسترده اي از ارزش ها ، میانِ بخش هايِ سیاه و سفید را دارند ، و شرایط نورپردازيِ دنیايِ راستین را خیلی دقیق تر به  HDRIهايِ 

 نمایش می گذارند.

ه کمک ب سپس باید بگیرید. HDRIبراي به کار بردن یک نورِ محیطی ، نخست می باید از محیطی که در آن زندگی می کنید ، یک نگاره يِ 

که  3D، این نگاره را به گویی که با همین نگاره نگاشت شده است بر گردانید. این گوي پیرامونِ اشیايِ  SphericalTransformتکمه يِ 

 را روشن می کند. 3Dدر صحنه دارید را در بر می گیرد. بدین سان ، نگاره اي که براي نگاشت گوي به کار رفته است ، اشیاء 

که می توانند نگاره يِ نگاشت شده را بازتاب بدهند ، کار می کند. بنا بر این ، در یک نورپردازيِ  درخشندهشیء تنها با مایه هايِ  ، نورِ محیطی

 از صحنه که خیلی واقع گرایانه است ، چیدمانِ اشیاء در محیط آسان تر می شود.

 افزودن یک نورِ محیطی

 بخوانید. scriptاز محیط را در  HDRIیک نگاره يِ  .1

2. Transform > SphericalTransform  را اجرا کنید تا تکمه اي به همین نام پس از نگاره

نگاشت  HDRIقرار بگیرد. می توانید به کمک این تکمه، یک گوي را با این نگاره يِ  HDRIيِ 

 را برگزینید (که در این جا Output Typeو  Input Typeکنید. در بخشِ کنترل هايِ تکمه ، 

 است). Sphereهمان 

3. 3D > Lights > Environment  ِرا برگزینید تا یک تکمه يEnvironment  درscript 

از تکمه يِ  mapرا به درگاه درون رفتSphericalTransform  تکمه يِ  تان جاي بگیرد.

Environment  ِو سپس این تکمه را به تکمه ي ،Scene بچسبانید 

 ، گزینه هايِ زیر را میزان کنید : Environmentدر قابِ کنترل هايِ تکمه يِ  .4
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 را به چپ و راست بکشید تا رنگ نور تغییر کند. colorلغزنده يِ  •

 را بکشید. intensityبراي تغییر دادن روشناییِ نور ، لغزنده يِ  •

 برگزینید. mapنگاره يِ ، الگوریتمِ فیلتر را براي  filterاز فهرست پایین افتادنیِ  •

 را میزان کنید. blur size، لغزنده يِ  mapبراي تغییر دادن اندازه يِ محو شدگیِ نگاره يِ  •

 

 Spot، یا نورهايِ  Point، نورهايِ  Directجاي گذاريِ نورهايِ 

ین ، می توانید آن را به هر کدام از این سه را در خود دارد ؛ بنا بر ا SpotLight، و  DirectLight  ،Point، تکمه هايِ  Lightتکمه يِ 

در این است که اگر بخواهید الگويِ نورپردازي تان را بعد تغییر بدهید  Lightتکمه که خواسته باشید پیکربندي کنید. مزیت به کار بردن تکمه يِ 

جدیدي راه اندازي کنید. براي نمونه ، ممکن است یک تکمه  تکمه يِ دوباره ، به آسانی می توانید این کار را انجام بدهید بدون این که نیاز باشد

 DirectLightنیاز دارید. اگر با تکمه يِ  Spot، ولی بعد می بینید که براي نورپردازيِ صحنه به یک نورِ داده باشید  را در صحنه جاي Directيِ 

را به صحنه بیاورید.  SpotLightنورِ مستقیمی را در صحنه پیاده کرده باشید ، در این جا می باید این نور را از صحنه پاك کنید و یک تکمه يِ 

 ر ،نورِ مستقیمی را در صحنه بازسازي کرده باشید ، به آسانی می توانید در بخشِ کنترل هايِ نو،  Lightبه هر روي ، اگر با یک تکمه يِ 

Light Type  ِآن را از الگويdirectional  بهspot .تغییر بدهید 

 نیز به کار بگیرید. Nukeبه درون برنامه يِ  fbx.این تکمه را می توانید براي آوردنِ نورها از پرونده هايِ  نکته :

 Spot، و  Direct  ،Pointافزودنِ یک نورِ 

1. 3D > Lights > Light  يِ را برگزینید تا یک تکمهLight  درscript .تان جاي بگیرد 

،  point  ،directionalبرگزینید :  light type، الگویی که براي نورپردازي می خواهید را از  Lightدر قابِ کنترل هايِ تکمه يِ  .2

 directionalبر پایه يِ الگویی که بر می گزینید یکسري از کنترل ها به کار ، و یکسري نیز از کار می افتند. براي نمونه ، اگر نورِ  .spotیا 

 دارید. DirectLightرا برگزینید ، با همان کنترل هایی سر و کار پیدا می کنید که در تکمه يِ 
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 نید.کنترل ها را بنا به نیازي که دارید میزان ک .3

 به کارگیريِ درون رفتLook 

 اگر خواسته باشید می توانید درون رفتlook  ِتکمه يLight  جهتی رو را به کار بگیرید. با این کار ، نور خود به خود می چرخد و به سمت

ن درگاه بچسبانید. براي نمونه ، می را به ای Axis، یا  Camera  ،Lightمی کند که به درگاه درون رفت چسبانده اید. می توانید یک تکمه يِ 

بچسبانید تا به هر جایی که آن تکمه را جا به جا می کنید نور نیز بچرخد و همواره به سمتLook  را به درون رفتAxis  توانید یک تکمه يِ 

 آن اشاره داشته باشد.

را به درون  Lightو  Cameraمی توانید یک تکمه يِ  جا به جا شود ، xرا پویانمایی کنید به گونه اي که در راستايِ آسه يِ  Cardاگر یک 

 رفتLook  بچسبانید تا دوربین و نور ، با جا به جا شدنCard  آن اشاره کنند. براي این کار ، گام خود به خود بچرخند و همواره به سمت ،

 هايِ زیر را انجام بدهید :

 قرار بدهید. scriptدر  Axisرا پویانمایی کردید ، یک تکمه يِ  Cardپس از این که  .1

2.  کلیدCtrl  ِرا پایین نگه داشته و در قابproperties  ِتکمه يCard  ِبر رويِ تکمه ي ،animation  ِگزینه يtranslate  کلیک

، بر رويِ  Axisتکمه يِ  propertiesکنید. ماوس را بکشید و در قابِ 

بروید و سپس دکمه يِ ماوس  translateگزینه يِ  animationدکمه يِ 

 را رها کنید. یک پیوندexpression  ِمیان تکمه يAxis  وCard  درست

با یک خط سبز رنگی به نمایش در می آید  scriptمی شود. این پیوند در 

 که پیکان دار است و جهتexpression .را نشان می دهد 

بیافزایید. دوربین را یا به جایی که در  scriptبه  Cameraیک تکمه يِ  .3

پنجره يِ نمایشگر نیاز است بکشید ، و یا براي میزان کردن جايِ دوربین ، 

هستند را به کار  Cameraتکمه يِ  propertiesکنترل هایی که در قابِ 

 بگیرید.

4.  درون رفت درگاهLook  ِتکمه يCamera  ِرا به تکمه يAxis .بچسبانید 
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افزوده و آن را در پنجره يِ نمایشگر به جايِ دلخواه بکشید. می توانید براي میزان کردن جايِ نور ، کنترل  scriptبه  Lightیک تکمه يِ  .5

 هستند را نیز به کار بگیرید. Lightتکمه يِ  propertiesهایی که در قابِ 

6.  درون رفت درگاهLook  ِتکمه يLight  ِرا به تکمه يAxis انید.بچسب 

  

7. Card .که پویانمایی شده است را بازپخش کنید. می بینید که دوربین و نور هر دو آن را دنبال می کنند 

  

 Nukeبه درون برنامه يِ  FBXآوردن نورها از پرونده هايِ 

FBX اس 3اندارد براي پرونده هايِ تیک فرُمتD  ِ3است که این امکان را براي شما فراهم می کند که بتوانید به صحنه هايD  ِکه در برنامه هاي

دارید ،  fbx.نرم افزاريِ دیگر ساخته اید و این فرُمت را پشتیبانی می کنند ، دسترسی داشته باشید. آن چه که روي هم رفته در یک پرونده يِ 

، مایه ها و ... هستند. از این صحنه ،  transformationها ،  NURBSها ،  meshها ، نورها ،  ، شاملِ دوربین 3Dهمه يِ یک صحنه يِ 
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بیاورید. بدین سان می توانید ، براي نمونه ، نوري  Nukeها را به درون برنامه يِ  meshها ، و  transformمی توانید دوربین ها ، نورها ، 

به  Nukeبه بیرون فرستاده ، و سپس همان نور را دوباره در برنامه يِ  fbx.یک پرونده با فرُمت بسازید ، آن را در  Mayaرا در برنامه يِ 

 کار بگیرید.

 Nukeبه درون برنامه يِ  fbx.روشِ آوردن نورها از یک پرونده يِ 

را به  Lightوانید یک تکمه يِ می گیرید ، می ت FBX Sceneکه از پرونده هايِ  spot، و  directional  ،pointبراي خواندن نورهايِ 

تان سه نور داشته باشید و می خواهید  fbx.تنها می توانید یک نور را بخوانید. بنا بر این ، اگر در پرونده يِ  Lightکار ببرید. با هر تکمه يِ 

 به کار ببرید. را Lightبیاورید ، می باید براي این کار سه تکمه يِ  Nukeهمه يِ آن ها را به درون برنامه يِ 

 : fbx.براي آوردن یک نور از یک پرونده يِ 

1. 3D > Lights > Light  ِرا برگزینید تا یک تکمه يLight  در جایی ازscript .بنشیند که می خواهید در آن جا نور داشته باشید 

هستند به کار می  Fileرا نشان بزنید. با این کار کنترل هایی که در برگه يِ  read from file، گزینه يِ  Lightدر قابِ کنترل هايِ  .2

نورهایی که می خواهید را بخوانید. هم چنین همه يِ کنترل هایی که ارزش هایشان  fbx.افتند ؛ و بدین سان می توانید از یک پرونده يِ 

ها به کار  expressionمی توانید این ارزش ها را ببینید و آن ها را در  پر می شود ، از کار می افتند. البته هنوز fbx.از پرونده يِ 

خوانده می شوند. هر گونه تغییري که به پرونده يِ  fbx.بگیرید ، ولی نمی توانید آن ها را تغییر بدهید ؛ چون این ارزش ها از پرونده يِ 

.fbx ِآن در بخشِ کنترل هايِ تکمه يِ  بدهید ، ارزش هايLight .بازتاب می شوند 

را نگهداري می کنید بروید. دکمه يِ  fbx.بروید. بر رويِ شمایلِ پوشه کلیک کنید و به جایی در رایانه تان که پرونده يِ  Fileبه برگه يِ  .3

Open .را بزنید 

 
ببرید را برگزینید. پرونده هايِ به کار  fbx.، گرایشی که می خواهید از یک پرونده يِ  Animation Stackاز فهرست پایین افتادنیِ  .4

FBX  این توانایی را دارند که تنها در یک پرونده ، چندین گرایش را پشتیبانی کنند. معمولاً یکی از این گرایش ها ، هیچ گونه پویانمایی

 ندارد و گرایشِ پیش فرض است.

 به برنامه بیاورید. fbx.از یک پرونده يِ را برگزینید که می خواهید  Light، تکمه يِ  node nameاز فهرست پایین افتادنیِ  .5

به کار گرفته شده است ، نادیده گرفته شود ، نرخِ فریم جدیدي را (بر حسب فریم در  fbx.اگر می خواهید نرخِ فریمی که در پرونده يِ  .6

دارید  fbx.ان بزنید تا به جايِ نرخِ فریمی که در پرونده يِ را نش use frame rateبنویسید. گزینه يِ  frame rateثانیه) در میدانِ 

 ، نرخِ فریمی که نوشته اید به کار برود.

را میزان کنید.  intensity scaleخوانده شده است ، لغزنده يِ  fbx.که از پرونده يِ  intensityبراي تغییر دادن ارزش هايِ کانالی  .7

 ن گزینه را زیاد کنید.اگر نور هم چنان تاریک است ، ارزشِ ای
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 readبروید و نشانِ گزینه يِ  Lightمیزان کنید ، به برگه يِ  آورده شده اند را fbx.اگر می خواهید ویژه گی هایی که از پرونده يِ  .8

from file  ِرا بردارید. سپس هر تغییري که می خواهید را انجام بدهید. تا هنگامی که گزینه يread from file د ، تغییراتی نشان ندار

 که داده اید ، به جا می مانند.

نشان خورده باشد.  read from file، نخست ببینید که گزینه يِ  fbx.براي بارگذاريِ دوباره يِ ویژه گی هايِ نور از یک پرونده يِ  .9

 را فشار بدهید. Fileدر برگه يِ  reloadسپس دکمه يِ 

 سایه اندازي

کنترل هایی دارند که به کمک آن ها می توانید معلوم کنید که پرتوهايِ نور در  SpotLight، و  Light  ،Point  ،DirectLightتکمه هايِ 

تان چگونه سایه بیاندازند. تکمه هايِ هندسی که در زیر آمده اند نیز دارايِ کنترل هایی هستند که به کمک آن ها می توانید  3Dصحنه يِ 

یاء دیگر سایه اشرويِ  بریه اي که به سبب نور از اشیاء دیگر می افتد را به خود بگیرند ، و یا این که خودشان مشخص کنید که آیا این اشیاء سا

 بیاندازند :

• Card     • ModelBuilder 
• Cube     • PointCloudGenerator 
• Cylinder    • PositionToPoints 
• Sphere    • ReadGeo 
• MergeGeo    • Scene 

 ، متفاوت است : renderبه یاد داشته باشید ، روشی که براي ساخت سایه ها به کار می رود ، میانِ تکمه هايِ گوناگونِ 

ScanlineRender  سایه ها براي ساختdepth mapping را به کار می گیرد این تکمه نخست یک نگاشت .depth  را براي هر نوري

فاصله اي  شان دهنده يِاز دید نور پردازش می شود ، و هر پیکسل در این نگاشت ن depthکند. نگاشت  که سایه اي می اندازد ، پردازش می

با پردازشی که از  depthاي است که نور در یک راستايِ بخصوص آن پیکسل را روشن می کند. سپس نگاشت  از نور تا نزدیک ترین رویه

باشد ، آن  depthاگر نقطه اي در نگاره که دوربین می بیند دورتر از همان نقطه در نگاشت دید دوربین گرفته شده است ، سنجیده می شود. 

 نقطه سایه به شمار آورده می شود.

 است ، ولی کم تر به واقعیت نزدیک اند. raytracedاغلب سریع تر از سایه هايِ  depth mapپردازشِ سایه هايِ 
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PrmanRender  سایه ها را ازraytracing تکمه پرتوهايِ نوري را از دوربین یکی یکی براي هر پیکسل به درونِ صحنه . این می سازد

میانِ نقطه يِ  ، پرتوهايِ به اصطلاح سایه PrmanRenderشلیک می کند. هر گاه پرتوِ نور به رویه اي در صحنه برخورد کند ، تکمه يِ 

می کند. اگر میانِ این نقطه يِ برخورد و سرچشمه هايِ نور موانعی وجود داشته برخورد و هر سرچشمه يِ نوري که در صحنه هست را ردیابی 

 باشند ، نقطه يِ برخورد به عنوان سایه به شمار آورده می شود.

آن چه این است که می توان آن را براي ساختنِ سایه هايِ دقیق تر و سایه هایی که لبه هايِ نرم دارند (درست مانند  Raytracingاز مزایايِ 

ساخته می شوند  depth mapکه در دنیايِ راستین می بینید) به کار گرفت. به هر روي ، اگر بخواهیم این سایه ها را با سایه هایی که از روشِ 

 پردازشی به مراتب طولانی تر خواهند داشت. Raytracingبا هم بسنجیم ، باید بگوییم که سایه هايِ 

 
 براي سایه انداختنِ اشیاء :

 که در صحنه دارید را باز کنید. 3Dاشیاءproperties  قابِ  .1

 ، و یا هر دو گزینه را نشان بزنید. receive shadowیا  cast shadowگزینه يِ  .2

Cast shadow .دیگري که در صحنه هستند سایه بیاندازند به اشیاء می گوید که در راستایی که نور به آن ها می تابد بر رويِ اشیاء 

Receive shadow دیگر در صحنه بر روي آن ها می افتد را به نمایش بگذارند. این براي به اشیاء می گوید سایه هایی که از اشیاء ِ

 در یک صحنه به کار می آید. occlusionنشان دادن 

که به آن چسبانده شده اند تعریف  3Dرا به کار بگیرید و این پیکربندي ها را براي همه يِ اشیاءScene  یک تکمه يِ هم چنین می توانید 

 castبگذارید و کنترل هايِ  override inputsرا بر رويِ  shadow، گزینه يِ  Sceneتکمه يِ  propertiesکنید. در قابِ 

shadow  وreceive shadow  اشیاء 3را دستکاري کنید. بدین سان ، آن چه که براي همین کنترل ها در تک تکD  به کار گرفته

 اید ، نادیده گرفته می شود.

 که می خواهید سایه ها را بگیرند ، چسبانده شده باشد. 3Dبه هر یک از اشیاءShader  می باید یک تکمه يِ  .3

 را نشان بزنید. cast shadow، گزینه يِ  Shadowsیک تکمه يِ نور را به صحنه تان بچسبانید و در برگه يِ  .4

را در درخت تکمه اي به کار گرفته ایم ، ولی شما می توانید یک  ScanlineRenderپایین آورده ایم ، یک تکمه يِ در نمونه اي که در 

 را جایگزینِ آن بکنید. PrmanRenderتکمه يِ 
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 ScanlineRenderن در تکمه يِ به کار می گیرید ، سایه اندازيِ آرا  Pointاگر دارید در صحنه تان یک تکمه يِ  یادداشت :

 پشتیبانی نمی شود.

 ) سایه ها را میزان کنید.PrmanRenderیا  ScanlineRenderبسته به تکمه اي که براي پردازش به کار می گیرید ( .5

 ریدرا به کار می ب ScanlineRenderمیزان کردن سایه ها هنگامی که براي پردازشِ صحنه تکمه يِ 

یکی از گزینه هايِ زیر را بر رويِ  Shadow modeبروید و  Shadows، به برگه يِ  Lightتکمه يِ  propertiesدر قابِ  .1

 پیکربندي کنید :

• Solid .ر به شمار آورده می شوندنوري که سایه می اندازند تمام توپ در این الگو اشیاء ، از دید : 

• Clipped alpha کنترلِ براي ارزشی باشد که  : اگر آلفايِ شیء پایین تر ازclipping threshold  اشیایی که  گذاشته ایدنور ،

يِ جلو (آن هایی که بالاتر از ارزشِ این آستانه باشند) سایه می اندازند شفاّف به شمار آورده می شوند. همه يِ ارزش هايِ دیگر آلفا

 نور را می گیرند.

• Full alpha و کدر یانِ چیزهایی که مات: سایه بر مبنايِ این ارزیابی می شود که نور ، زمانی که از م )non-opaque نبوده و (

 ) بگذرد ، چگونه کاهش می یابد.occludeآن را گرفته اند ( جلويِ

 ) تاثیر می گیرند.opacityدر این جا سایه هایی که از اشیاء می افتند بر مبنايِ کدريِ شیء (

   
Clipped Alpha       Solid سایه چهارگوش افتاده است چون)         Full Alpha  

 داده شده است). Cardبرگ به یک  نگاره يِ        
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را بر رويِ کانالی بگذارید که می خواهید آن را  output maskنگاشت سایه را بیرون بدهد ، گزینه يِ  Lightاگر می خواهید تکمه يِ  .2

 نید این گزینه را به کار بیاندازید.غیر فعال باشد ، می توا cast shadowsذخیره کنید. حتا اگر گزینه يِ 

 گذاشته باشید ، می توانید گزینه هايِ زیر را میزان کنید : clipped alphaیا  solidرا بر رويِ  shadow modeاگر گزینه يِ  .3

• Depthmap resolution  در این جا می توانید وضوحِ نگاشت :depth  را میزان کنید. هر چه ارزشِ این گزینه را بالاتر

 وضوحِ کم تري دارد ؛ ولی نیاز به زمانِ پردازش بیش تر می شود.بگیرید ، سایه هایی به دست می آیند که لبه هایشان 

  
Depthmap Resolution = 7400   Depthmap Resolution = 800 

، وضوحِ لبه ها را  samples، می توانید با زیاد کردن شمارِ  depthmap resolutionبه جايِ افزایش  به یاد داشته باشید که

 درست کنید.

• Samples بسازدا رنرم و همواري  به کار می گیرد تا سایه هايِنور  می توانید شمارِ نمونه هایی را پیکربندي کنید که : با این گزینه .

) یا نقطه نقطه به چشم می آیند ، ارزشِ این گزینه را زیاد کنید. هر چه noisyم (اگر سایه هايِ نرمی که در صحنه دارید درهم و بره

 ارزشِ این گزینه بیش تر باشد ، نرمیِ سایه ها بیش تر می شود.

  
Samples = 50    Samples = 1 

• Jitter scale  هنگامی که براي سایه هايِ نرم :percentage-closer filtering (PCF)  ، ارزشِ این گزینه انجام می گیرد

بزرگ تر باشد ، سایه هایی که به دست می آیند ، نرم تر و  jitter scaleبه کار رفته را معلوم می کند. هر چه ارزشِ  jitterمیزانِ 

 از دقتّ گیرایی بیش تري برخوردار هستند.

PCF  با نمونه گیريِ نگاشتdepth رِ یک نقطه ، کار خود را انجام می دهد. ارزشِ نهایی در چندین جايِ گوناگون ، دور تا دو

 هستند. )visible( ) یا نمایانoccludeسایه براي آن نقطه ، میانگینی است از نمونه هایی که از دید نور پنهان (

• Bias  : این جنبه یکoffset نوري که سایه می اندازد رویه به سم همان پایداري است که نقطه يِ نمونه گیري شده يِ رویه را از ت

در نگاره پدیدار شوند ، شاید می باید ارزشِ این گزینه را زیاد کنید. به هر  self-shadowing. اگر آرتیفکت هايِ پیش می برد

ا را انداخته هروي ، به یاد داشته باشید که اگر ارزشِ این گزینه را خیلی زیاد بگیرید ، برخی از سایه ها از پايِ اشیایی که همان سایه 

 اند جدا می شوند.
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 ها Shadow Artifact           می تواند به کاهشِ آرتیفکت Biasزیاد کردن ارزشِ  

 ها کمک کند. 

• Slope bias  درست مانند :bias  است ، ولی در این جاoffset  ِنسبت به شیبdepth map  این گزینه به شما گیردانجام می .

 اجازه می دهد که براي هر ارزشی که در نگاشتdepth سنجیده می شودنسبت به نور  که هست ، بسته به شیبِ رویه ، offset 

درست شده و نیاز به  depth. براي نمونه ، اگر شیبِ رویه نسبت به نور کم باشد ، ارزش در نگاشت را به کار ببریدگوناگونی 

offset  خیلی کوچک داشته و یا ممکن است اصلاً نیاز بهoffset  نداشته باشند. اگر شیبِ رویه نسبت به نور تُند باشد ، ارزش ها

 در نگاشتdepth  به احتمالِ کم تري درست می شوند و نیاز بهoffset  ِآرتیفکت هاي بزرگ تري است. اگر به سبب وجودself-

shadowing  ِاندازه يbias ده شآرتیفکت هايِ بیش تري ساخته  می بینید که نگاره از یش می دهید ولی در جاهايِ دیگرفزارا ا

را زیاد کنید. سپس می  slope biasرا پایین بیاورید و به جايِ آن ارزشِ گزینه يِ  bias، شاید به تر باشد که ارزشِ گزینه يِ  اند

 .برسیدچه که می خواهید باید با ارزش هايِ هر دو گزینه بازي کنید تا به آن 

 زیر را می توانید میزان کنید :گزینه هايِ  Clipped Alphaدر الگويِ 

• Filter  :گفتیم). ینگالگويِ فیلتر را به کار می برد (بخشی را بخوانید که در باره يِ الگوریتم هايِ فیلتر 

• Clipping threshold  .هر نمونه اي از رویه با ارزش هايِ آلفایی که پایینِ این آستانه باشند ، شفاّف به شمار آورده می شوند :

 ، شفاّف می شوند. -که سایه می اندازند-هر چه ارزش این گزینه را بالاتر بگیرید ، بخش هايِ بیش تري بر رويِ اشیاء 

  
Clipping threshold = 0.9  Clipping threshold = 0.1 

 گذاشته باشید ، می توانید گزینه هايِ زیر را میزان کنید : full alphaرا بر رويِ  shadow modeاگر گزینه يِ  .4

• Filter : گفتیم). ینگالگويِ فیلتر را به کار می برد (بخشی را بخوانید که در باره يِ الگوریتم هايِ فیلتر 

• Scene epsilon  یک :offset نوري که سبب سایه اندازي  ست که نقطه يِ نمونه گیري شده را از رویه يِا هندسی به سمت شیء

 را کم کنید. self-shadowingشده است ، پیش می برد. با زیاد کردن ارزشِ این گزینه می توانید آرتیفکت هايِ 

د ، صحنه را از دید نور ببینید (به کمک فهرست دست بیایدقیقی به سایه هايِ  DirectLightبراي این که از یک تکمه يِ  نکته :

از را به گونه اي میزان کنید که بخشی  DirectLightتکمه يِ  scaleدر پنجره يِ نمایشگر) و کنترلِ  cameraپایین افتادنیِ 
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اندازند  ید هیچ یک از اشیایی که سایه مینما را پر کند. با این کار می توانید مطمئن باش د ، همه يِصحنه که می باید سایه بیانداز

 نگاشت از زیرِ دست ،depth .از دست نمی روند 

 ریدرا به کار می ب PrmanRenderمیزان کردن سایه ها هنگامی که براي پردازشِ صحنه تکمه يِ 

 ه باشد.نشان خورد Shadowsکنید و ببینید که گزینه يِ  را باز PrmanRenderتکمه يِ  propertiesقابِ  .1

 بروید. Shadowsرا باز کنید و به برگه يِ  Lightتکمه يِ  propertiesقابِ  .2

کار می کنید ، دو گزینه  PrmanRenderگذاشته شده باشد. هنگامی که دارید با  solidمی باید بر رويِ  shadow modeگزینه يِ  .3

 يِ دیگر به کار نمی آیند.

را زیاد کنید. ارزشی که براي این گزینه بنویسید در  sample widthنرمی را داشته باشید ، ارزشِ گزینه يِ  اگر می خواهید سایه هايِ .4

پهنايِ بخشِ نرمی که پیرامونِ لبه يِ یک سایه است ضرب می شود. هر چه ارزشِ این گزینه را بالاتر بگیرید ، بخشِ نرمِ سایه بزرگ تر 

 می شود.

  
Sample width = 15   Sample width = 1 

را در گام پیشین افزایش داده باشید و ببینید که سایه هايِ نرمی که در صحنه دارید درهم و برهم  sample widthاگر ارزشِ گزینه يِ  .5

)noisy) یا نقطه نقطه (dotty ِهستند ، ارزشِ گزینه ي (Samples مونه هایی را پیکربندي می کنید که را زیاد کنید. بدین سان ، شمارِ ن

 نور براي ساختنِ سایه هايِ نرم به کار می گیرد. هر چه ارزشِ این گزینه را بیش تر بگیرید ، سایه هايِ نرم هموارتر می شوند.

  
Samples = 80    Samples = 10 

با این کار نقطه يِ نمونه گیري شده جا به جا  را زیاد کنید. biasدر نگاره پدیدار شوند ، ارزشِ  self-shadowingاگر آرتیفکت هايِ  .6

 شده و از رویه دور می شود. به هر روي ، به یاد داشته باشید که اگر ارزشِ این گزینه را خیلی زیاد بگیرید ، برخی از سایه ها از پايِ

 اشیایی که همان سایه ها را انداخته اند جدا می شوند.

 شیء کار با نُرمال هايِ یک
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ند علوم کننرُمال هايِ یک شیء بردارهایی هستند که بر رویه يِ شیء عمود اند. این نرُمال ها براي ارزیابی هايِ نورپردازي به کار می روند تا م

و  diffuseکه نور چگونه می باید در یک نقطه يِ بخصوص از رویه پس بجهد. با دست بردن در این نُرمال ها می توانید ویژه گی هايِ 

specular .نور را کنترل کنید 

 دستکاري کردن نرُمال هايِ یک شیء

1. 3D > Modify > Normals  ِرا برگزینید تا یک تکمه يNormals  3پس از شیءD  که می خواهید ویژه گیِ نورپردازيِ آن را

 تان بنشیند. scriptدر  میزان کنید ،

 بچسبانید. Normalsاز تکمه يِ  Look atرفت  را به درون Light، یا  Camera  ،Axisیک تکمه يِ  .2

 : هر یک از گزینه هايِ زیر را به کار بگیرید را باز کنید و action، فهرست پایین افتادنیِ  Normalsدر قابِ کنترل هايِ تکمه يِ  .3

• Unchanged .تغییري داده نمی شود : 

• Set  ِمی توان براي تعریف کردن ارزشِ نرُمال ها ، میدان هاي :normal x  ،normal y  و ،normal z .را به کار گرفت 

• Build ر آن را در برگر تا دوفته اند ، بازسازي می کند. براي معلوم کردن ر: هر یک از نرُمال ها را بر مبنايِ ورتکس هایی که دو

بگیرید به این معناست که همه  0را میزان کنید. اگر ارزشِ این گزینه را برابر با  threshold angleزاویه يِ شکست ، لغزنده يِ 

را به این گزینه بدهید ، همه يِ وجوه نرم و هموار می شوند. یک ارزشِ میانگینِ  180يِ وجوه تخت هستند. اگر ارزشی برابر با 

 است. 60خوب براي این گزینه 

• Look at : همه يِ نرُمال ها به درون رفت look at  ِتکمه يNormals .نگاه می کنند 

• Delete :  ِآن ویژه گی که نام دارد را از شیء پاك می کند. براي نمونه ، اگر ویژه گیN .را بردارید ، شیء هیچ نرُمالی ندارد 

 3Dبا نورهايِ  2Dنورپردازيِ دوباره يِ یک نگاره يِ 

است ، می توانید  point position passو  normal passکه دارايِ  2Dبه یک نگاره يِ  3Dبراي نوردهیِ دوباره با سرچشمه هايِ نورِ 

برگردید و صحنه را با نورپردازي دوباره اي که انجام می دهید  3Dرا به کار ببرید. به جايِ این که دوباره به برنامه يِ  Relightتکمه يِ 

را در یک محیط3D  ) یک صحنه يِ interactiveمی توانید به تُندي و با یک روند تعاملی ( Relightزش کنید ، به کمک یک تکمه يِ پردا

2D .دوباره نورپردازي کنید 

را به  point position passو  normal passکار می کند. این نگاره  2Dبه یک نگاره يِ  3D Shaderبا دادنِ یک  Relightتکمه يِ 

را (و یا چندین نور را از  3Dکار می گیرد که در کانال هايِ جداگانه اي از نگاره ذخیره شده اند ؛ و این امکان را به شما می دهد که یک نورِ 

 ) چسبانده و آن را به دست بگیرید.Sceneراه یک تکمه يِ 

 Relightبه کمک تکمه يِ  2Dروشِ نورپردازي دوباره يِ یک نگاره يِ 

1.  3از فهرستD > Lights  ِگزینه ي ،Relight  را برگزینید تا تکمه اي به همین نام درscript .تان بنشیند 

تکمه  colorاست. نگاره را به درگاه درون رفتpoint position  و  normalهايِ  passرا بخوانید که دارايِ  2Dیک نگاره يِ  .2

 بچسبانید.
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جداگانه اي باشند ، می توانید آن ها را با یک تکمه يِ  ها در نگاره هايِ normal vectorو  position passاگر  نکته :

ShuffleCopy  با هم یکی کنید. سپس این تکمه را به درون رفتcolor  ِاز تکمه يRelight .بچسبانید 

 را بسازید. point positionو  normalهايِ  passنیز می توانید  NukeXدر برنامه يِ  DepthGeneratorبه کمک یک تکمه يِ 

 normal، کانالی را برگزینید که داده هايِ  normal vectors، از فهرست پایین افتادنیِ  Relightتکمه يِ  propertiesدر قابِ  .3

 را دارد.

 ارد.را د point position، کانالی را برگزینید که داده هايِ  point positionsاز فهرست پایین افتادنیِ  .4

 

5.  درون رفت به درگاهlights  ِیک تکمه ي یک نور را بچسبانید. می توانید از راه ،Scene .چندین نور را به همین درگاه بچسبانید ، 

6.  درون رفت دوربینی که می خواهید براي پردازش صحنه يِ اصلی به کار بیاید را به درگاهcam .بچسبانید 

که می چسبانید ، ویژه گی  shaderبچسبانید. بسته به الگويِ  material) را به درون رفتPhong (مانند یک تکمه يِ  shaderیک  .7

 هايِ آن را بسته به نیازتان تعریف و میزان کنید.

 cameraنچسبانده باشید ، درون رفتlight  را به درگاهی درون رفتScene  یا  lightتا زمانی که یک تکمه يِ  یادداشت :

 پدیدار نمی شوند. materialدوربینی را نچسبانید ، درگاه هايِ درون رفتcamera  ی شود. تا زمانی که به درون رفت نمایان نم

 بروید و نورهایتان را در جایی که می خواهید بچینید. 3D viewerبه نمايِ  .8

9.  اگر نگاره اي که به درون رفتcolor ا به عنوان ماسک ، براي محدود کردن تاثیرِ تکمه يِ می رود کانالِ آلفا داشته باشد و بخواهید آن ر

Relight  ِبه کار ببرید ، گزینه يuse alpha .را نشان بزنید 

 را براي صحنه میزان کنید. ambientرا به دست بگیرید. با این کار می توانید ترازِ جهانیِ نورِ  ambientاگر نیاز باشد ، لغزنده يِ   .10

را به کار ببرید. گزینه يِ  Mergeاصلی ، یک تکمه يِ  2Dبا نگاره يِ  Relightبراي یکی کردن داده هايِ نورپردازيِ تکمه يِ  .11

operation  ِدر تکمه يMerge  ِرا بر رويmultiply  ِبگذارید. سپس تکمه يRelight  را به درون رفتA  ِ2، و نگاره يD  را

 به درون رفتB  ِاز تکمه يMerge .بچسبانید 

 دوربین ها

 .به نمایش بگذارندمی تواند چندین دوربین را در صحنه پشتیبانی کند که هر کدام از آن ها پرسپکتیو بی همتایی را  Nukeبرنامه يِ 

به کار می روند ، می توانید آن ها را به گونه اي راه اندازي کنید که نگاره  3Dدوربین ها ، به جز این که براي نمایش و پردازشِ صحنه هايِ 

 ).projectionرا بر رويِ اشیاء هندسی که در صحنه دارید بیاندازید ( 2Dهايِ 
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ر بگیرید ، می به کا Nuke) دوربینی را ساخته اید ، و بخواهید آن را در برنامه يِ Maya(مانند  third-party 3Dاگر در یک برنامه يِ 

) ، و سپس آن پرونده را به درون exportبه بیرون بفرستید ( Alembicیا  FBXتان دارید را با فرُمت3D  توانید صحنه اي که در برنامه يِ 

 بیاورید. Nukeبرنامه يِ 

ا به کار گرفته و آن را به درون ر import_boujou.tcl scriptساخته اید ، می توانید  Boujouهم چنین اگر دوربینی را در برنامه يِ 

 بیاورید. Nukeبرنامه يِ 

 

 روشِ کار با دوربین ها

، این که چگونه نما را از میان آن به نمایش بگذارید ، روشِ قفل کردن دوربین ، و  scriptدر این جا می خواهیم روشِ افزودن یک دوربین به 

 نیز چگونگی ویرایشِ  ویژه گی هايِ لنزِ دوربین را آموزش بدهید.

 روشِ افزودن یک دوربین

1. 3D > Camera  ِرا اجرا کنید تا یک تکمه يCamera  بهscript  تان افزوده

 شود.

را برگزینید تا دوربینِ جدیدي  create cameraيِ  گزینه،  3Dدر نمایشگرِ 

 که هستید قرار بگیرد. 3Dدر راستا و جایی از فضايِ 

2.  براي این که دوربینی را براي پردازشِ صحنه راه اندازي کنید ، از تکمه يِ جدیدCamera  ِاتصال دهنده اي را به تکمه ي

ScanlineRender  .یابکشید ... 

 بکشید. Sceneاتصال دهنده اي را به تکمه يِ  Cameraدوربینِ دیگر براي نمایشِ صحنه ، از تکمه يِ جدید براي راه اندازي یک 

 روشِ دیدن صحنه از درون یک دوربین

1.  کلیدV  ِ3را فشار بدهید تا مطمئن شوید که هم اکنون دارید از نمايِ پرسپکتیوD .صحنه را می بینید و نه از یکی از نماهايِ اُرتوگرافیک 

 ، دوربینی که می خواهید را برگزینید. 3Dدر گوشه يِ بالا و راست پنجره يِ نمایشگرِ  cameraاز فهرست پایین افتادنیِ  .2
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دوربینی که از این جا بر می گزینید ، دوربینی که براي پردازشِ  یادداشت :

. با این کار تنها دوربینی تغییر می دهدتغییر نمی  را صحنه به کار می رود

 جاري را از میانِ آن به نمایش بگذارید. 3Dد که می خواهید صحنه يِ کن

داشته باشید خود به خود در این فهرست جاسازي می شود  scriptهر دوربینی که در 

دارید ولی در این فهرست نمی بینید ، و می خواهید آن را  scriptینی را در ؛ و از این جا می توانید هر کدام را که خواستید برگزینید. اگر دورب

 ن باز شده و دوربین به این فهرست افزوده شود.يِ آن دو بار کلیک کنید تا قابِ آبرگزینید ، بر رويِ تکمه 

 3Dروشِ قفل کردن دوربین در یک نمايِ 

یا با فشار  3D view lockبرگزیده اید قفل کنید. می توانید با کلیک کردن دکمه يِ  را بر رويِ دوربین یا نوري که 3Dمی توانید یک نمايِ 

 ، میان دو الگويِ قفل شده و بدون قفل سوئیچ کنید. Ctrl+Lدادن کلیدهايِ 

• Unlocked  ِتی آزادانه در فضاي3: در این جا می توانید بدون هیچ محدودیD  ِ3بچرخید. دکمه يD view lock  به رنگ

 خاکستري نشان داده می شود.

• Locked  ِدکمه ي راست پایین افتادنی در سمت 3: در این الگو جا به جا شدن تان با دوربین یا نوري که از فهرستD view 

lock  ِ3برگزیده اید قفل می شود. دکمه يD view lock قرمز در می آید. به رنگ 

 Interactive 3D Cameraکار با الگويِ نمایشیِ روشِ 

می توانید ارزش هايِ دوربین یا نور را بر مبنايِ جا به جا شدن تان در نمایشگر تغییر بدهید.  Interactive 3D Cameraبا الگويِ نمایشیِ 

 با پایین نگه داشته کلیدCtrl  ِ3و کلیک کردن دکمه يD view lock امی که این الگو روشن ، می توانید الگويِ تعاملی را به کار بیاندازید. هنگ

به رنگ سبز در می آید. براي این که بتوانید الگويِ تعاملی را به کار بیاندازید ، می باید یک تکمه يِ  3D view lockاست ، دکمه يِ 

Camera  یاLight راست دکمه يِ  داشته باشید و آن را از فهرست 3پایین افتادنی در سمتD view lock .برگزیده باشید 

–دوربین یا نور  translate) را براي تغییر دادن ارزش هايِ -) و منها (+نگامی که الگويِ تعاملی روشن است ، می توانید کلیدهايِ بعلاوه (ه

 کنید.  Zoom outو  Zoom inبه کار ببرید. زمانی که این الگو خاموش است ، با این کلیدها می توانید نما را  -که برگزیده اید

 ویرایش کردن ویژه گی هايِ لنزِ یک دوربینروشِ 

 دو بار کلیک کنید تا پنجره يِ نمادهايِ آن باز شود. Cameraتکمه يِ اگر نیاز باشد ، بر رويِ  .1

 بروید. Projectionبه برگه يِ  .2

 را به چپ و راست بکشید. focal lengthبزرگ نمایی دوربین ، لغزنده يِ  براي میزان کردن ترازِ .3

را به چپ و راست بکشید. اشیایی که در جلويِ این  nearدوربین ، لغزنده يِ  forward clipping planeبراي ویرایش کردن جايِ  .4

 گسُتره باشند ، پردازش نشده و هم چنین نشان داده نمی شوند.

بکشید. اشیایی که در پشت این  را به چپ و راست farدوربین ، لغزنده يِ  rearward clipping planeبراي ویرایش کردن جايِ  .5

 گسُتره باشند ، پردازش نشده و هم چنین نشان داده نمی شوند.
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(آسه يِ عمودي) ، می توانید  window translate v(آسه يِ افقی) و  window translate uبا زیاد کردن ارزشِ لغزنده هايِ  .6

 کنید.بیرون رفت دوربین را در راستايِ هر یک از آسه ها جا به جا 

(آسه يِ عمودي) ، می توانید بیرون رفتwindow scale v  (آسه يِ افقی) و  window scale uبا زیاد کردن ارزشِ لغزنده هايِ  .7

 دوربین را در راستايِ هر یک از آسه ها بزرگ و کوچک کنید.

 چپ و راست بکشید.را به  window roll، لغزنده يِ  zبراي چرخاندنِ بیرون رفت دوربین به دورِ آسه يِ  .8

 درون رفت کار با درگاهLook 

 درون رفت اگر بخواهید می توانید درگاهLook  ِاز تکمه يCamera  چیزي که را به کار بگیرید ؛ تا دوربین خود به خود بچرخد و به سمت

را بچسبانید. براي نمونه ، می  Axis، یا  Camera  ،Lightبه این درگاه چسبانده شده است رو کند. به این درگاه می توانید یک تکمه يِ 

جا به جا می شود ، دوربین بچرخد و همواره رو به آن  Axisبچسبانید تا به هر جایی که  lookرا به درون رفتAxis  توانید یک تکمه يِ 

 داشته باشد.

را از این درگاهLight  یا  Cameraمی توانید یک تکمه يِ جا به جا کرده و پویانمایی داده باشید ،  xرا در راستايِ آسه يِ  Cardاگر یک 

 درون رفتlook  به شیءCard  بچسبانید. بدین سان ، شیءCard  .به هر جایی که جا به جا بشود ، دوربین یا نور نیز هم زمان می چرخند

 براي این کار ، گام هايِ زیر را انجام بدهید :

1.  پس از این که شیءCard پویانمایی کردید ، یک تکمه يِ  تان راAxis  را درscript .قرار بدهید 

2.  کلیدCtrl  ِرا پایین نگه دارید و سپس در قابproperties  از تکمه

 translateدر کنارِ نمادanimation  ،  بر رويِ دکمه يِ  Cardيِ 

 Axisتکمه يِ  propertiesکلیک کنید و ماوس را بکشید. به قابِ 

 translateنمادanimation  ید ماوس را بر رويِ دکمه يِ بروید و کل

 رها کنید. یک پیوندExpression  ساخته می شود. این پیوند

expression  ِدر پنجره يnode graph  سبز رنگ نشان با یک خط

را مشخص می  expressionداده می شود که پیکانِ رويِ آن راستايِ 

 کند.

تان قرار بدهید. سپس دوربین را در پنجره يِ نمایشگر بگیرید و به جایی که می خواهید بکشید ؛  scriptرا در  Cameraیک تکمه يِ  .3

 بروید و نمادهايِ آن را دستکاري کنید. Cameraتکمه يِ  propertiesو یا براي میزان کردن جايِ دوربین ، به قابِ 

4.  درون رفت درگاهLook  ِدوربین را به تکمه يAxis .بچسبانید 

تان قرار بدهید. سپس نور را در پنجره يِ نمایشگر بگیرید و به جایی که می خواهید بکشید ؛ و یا  scriptرا در  Lightیک تکمه يِ  .5

 بروید و نمادهايِ آن را دستکاري کنید. Lightتکمه يِ  propertiesبراي میزان کردن جايِ نور ، به قابِ 
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6.  درون رفت درگاهLook  ِنور را به تکمه يAxis .بچسبانید 

  

7.  پویا نماییِ شیءCard  را بازپخش کنید. می بینید که دوربین و نور شیءCard .پویانمایی شده را دنبال می کنند 

  

 Projection دوربین هايِ

را بر رويِ یک شیء2D  یا سکانسی از نگاره ها يِ  2D، می توانند یک نگاره يِ  3Dدوربین ها ، به جز نشان دادن و پردازشِ صحنه هايِ 

است که در عکاسی به کار گرفته می شود. در این  front-projectionهندسی که در صحنه دارید بیاندازند. این درست مانند سیستم هايِ 

اصرِ دیگري که در همان صحنه هستند ) انداخته می شود و با عنstageروش ، یک نگاره يِ پس زمینه یا یک عنصرِ دیگر بر رويِ صحنه (

 عکس برداري می شود.
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را  پروجکشنبگیرد و یک  -یا هر فیلمِ دیگر)(می تواند داده هايِ دوربین را از فیلمِ اصلی  projection، یک دوربینِ  Nukeدر برنامه يِ 

 ).Match-Moveراه اندازي کند که جا به جایی دوربین در آن با منبعِ دیگر جفت و جور است (

 Project3D، یک تکمه يِ  Scene، یک تکمه يِ  Projection Cameraبراي این راه اندازي باید تکمه هايِ زیر را به کار بگیرید : یک 

به همراه نگاره اي که می خواهید  2Dبر رويِ آن انداخته می شود) ، و یک تکمه يِ  2D(که نگاره يِ  Geometry Object، یک تکمه يِ 

 ا بر رويِ شیء هندسی تان بیاندازید.آن ر

 نخست کمی به ریاضی بپردازیم

کار می کند ، می باید یکسري از داده ها را  پروجکشنرا می سازید ، براي آن که مطمئن شوید   projection Cameraهنگامی که یک 

 عبارتند از : آوري کرده و ارزیابی هایی را انجام بدهید. داده هایی که به آن نیاز داریدگرد

• Focal Length .لنزِ دوربینی که نگاره با آن گرفته شده است 

 وضوحِ نگاره يِ اسکن شده. •

 دستگاهی که فیلم را اسکن کرده است. Scanner Pitchویژه گیِ  •

، می باید ارزیابی هایی را انجام بدهید تا پیکربندي هايِ افقی و  پروجکشنپس از این که این داده ها را گردآوري کردید ، براي به راه انداختنِ 

 را به دست بیاورید : Apertureعموديِ 

horiz. res. / scanner pitch = horizontal aperture 
vertical res. / scanner pitch = vertical aperture 

 باشد ، آن چه به دست می آورید این است : 20برابر با  Scanner Pitch، و  720x486اگر وضوحِ نگاره تان  براي نمونه ،
720 / 20 = horizontal aperture = 36 
486 / 20 = vertical aperture = 24.3 

دوربین را از گزارشی که خود دوربین همراه با هر عکسی ارائه می  focal lengthهايِ حرفه اي ، می توانید  پروجکتمعمولاً براي بیش ترِ 

،  Boujou(مانند  3D tracking، به دست بیاورید. اگر چنین گزارشی موجود نباشد ، می توانید با اجرا کردن نگاره در یک برنامه يِ  کند

Syntheyes  یاRealVIz.به داده هايِ لنزِ دوربین دست بیابید ( 

 Projection Camera Scriptراه اندازي کردن 

لنز را براي نگاره اي داشتید که می خواهید آن را پروجکت کنید ، می توانید راه اندازي  focal lengthو افقی و عمودي ،  apertureهر گاه 

 کردن دوربینِ پروجکشن را کامل کنید.

 Projection Cameraافزودن یک 

1. 3D > Camera  را برگزینید تا دوربینی بهscript  تان افزوده شود. براي این که بتوانید درscript تان این دوربین که براي پروجکشن

 را تغییر بدهید. Cameraاست را به آسانی شناسایی کنید ، نامِ تکمه يِ 

2. 3D > Shader > Project3D تا یک تکمه يِ  درا برگزینیProject3D  بهscript .افزوده شود 

 بچسبانید. Project3D) را به تکمه يِ Read(یعنی همان تکمه يِ  2Dنگاره يِ  .3



115 | N u k / U s e r  G u i d e  
 
 

Vahid Velayati 
 

 بچسبانید. Project3Dبینِ پروجکشن را به تکمه يِ دور .4

 را دریافت کند ، بچسبانید. 3D Projectionکه می باید  Geometryرا به تکمه يِ  Project3Dتکمه يِ  .5

 دو بار کلیک کنید تا قابِ نمادهايِ آن باز شود. Projection Cameraبر رويِ تکمه يِ  .6

 focal length  ،horizبروید. داده هایی که گردآوري کرده بودید را براي  Projection ، به برگه يِ Cameraدر قابِ تکمه يِ  .7

aperture  وvert aperture  .بنویسید 

  

 نگاهی بیاندازید و جايِ نگاره يِ پروجکشن را بررسی کنید. 3Dهنگامی که کارتان تمام شد ، به صحنه يِ 

 2D یک نگاره يِ پس زمینه يِ بر رويِ 3Dبه نمایش گذاشتن یک صحنه يِ 

 را فشار بدهید تا بیرون رفت تکمه در نمایشگر به نمایش در آید. 1را برگزیده و کلیدScene  تکمه يِ  .1

2.  اگر نیاز باشد ، کلیدTab  3را فشار بدهید تا نمایشگر به الگويِ نمایشیD .برود 

 را فشار بدهید تا نما از دید آن دوربین به نمایش گذاشته شود. Hبرگزینید. کلید تکمه یا شیء دوربین که کارِ پردازش را انجام می دهد را  .3

 را فشار بدهید. Shift+2که می خواهید در نمایشگر ببینید را برگزینید. سپس کلیدهايِ  2Dتکمه و نگاره يِ  .4

براي معلوم کردن اتصالِ موجود بعدي است) ؛ و هم  2، نگاره به نمایشگر چسبانده می شود (شماره يِ  Shift+2با زدن کلیدهايِ میان برِ 

 راه اندازي می شود. compare wipeچنین یک 

 ).none ، (over  ،under  ،minus  ،wipe( -برگزینید (یعنی ،  Viewer compositeگزینه يِ دلخواه را از فهرست پایین افتادنی  .5

 

بر رويِ یک نگاره  3Dسنجیدن یک صحنه يِ  -است. بعلاوه يِ مویی شکل (نگاره يِ زیرآخرین گام ، روي هم انداختنِ دو عنصر در نمایشگر 

 براي هم سنجی میزان کنید.را  wipe) کنترلی است که با آن می توانید جا و زاویه يِ 2Dيِ 
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 FBXآوردن دوربین ها از پرونده هايِ 

 بیاورید. Nukeيِ به درون برنامه  FBXمی توانید دوربین ها را از پرونده هايِ 

 FBXدر باره يِ پرونده هايِ 

FBX  ِاستاندارد براي پرونده هاي 3یک فرُمتD  ِآن می توانید به صحنه هاي 3است که به کمکD  ِ3که در برنامه هايD  دیگر ساخته اید و

است که دارايِ دوربین  3Dدارید یک صحنه يِ  fbx.این فرُمت را پشتیبانی می کنند ، دسترسی داشته باشید. آن چه که معمولاً در پرونده يِ 

، مایه ها و ... است. از  NURBS )non-uniform rational B-spline ، (transformationها ، خمیدگی هايِ  meshها ، نورها ، 

د. بدین سان می توانید ، براي بیاوری Nukeها را به درون برنامه يِ  meshها ، و  transformاین صحنه می توانید دوربین ها ، نورها ، 

را دوباره در برنامه يِ  meshبه بیرون بفرستید ؛ و سپس همان  fbx.ساخته و آن را با فرُمتMaya  را در برنامه يِ  meshنمونه ، یک 

Nuke .به کار بگیرید 

نوشته شده اند.  FBXقدیمی ترِ مشکل دارید ، شاید به سبب آن باشد که آن ها با نسخه يِ  FBXاگر با پرونده هايِ  نکته :

هستند.  binary  ،ASCIIاگر آن ها خیلی آهسته بارگذاري می شوند ، ممکن است به سبب آن باشد که آن ها به جايِ 

 ر بزنید ، می توانید از وب سایتبراي این که بتوانید این مشکل ها را دوAutodesk 

)http://usa.autodesk.com/fbx/download/ (FBX Converter  ِرا به کار ببرید. با این برنامه می توانید فرُمت هاي

 ) را به هم برگردانید.binary، و  FBX  ،ASCIIگوناگون (یعنی نسخه هايِ قدیمی 

 Nukeبه درون برنامه يِ  fbx.آوردن دوربین ها از یک پرونده يِ 

 FBX )Producer Perspective  ،Producer Top ، Producer Bottomمی توانید دوربین هايِ استانداردCamera  با تکمه يِ 

، Producer Right ، Producer Left ، Producer Front ، Producer Back.و دوربین هايِ دیگر را بخوانید ( 
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نیاز داشتید که چندین دوربین بیاورید. اگر  Nukeبه درون برنامه يِ  fbx.تنها می توانید یک دوربین را از پرونده يِ  Cameraبا هر تکمه يِ 

 به کار ببرید. Cameraباید براي هر دوربین یک تکمه يِ  را به برنامه بیاورید ، می

 fbx.روشِ آوردن یک دوربین از یک پرونده يِ 

1. 3D > Camera  را برگزینید تا یک تکمه يِ دوربین در جایی ازscript .که می خواهید بنشیند 

را نشان بزنید. هر گاه این گزینه نشان خورده باشد ، کنترل هایی که در برگه  read from fileبین ، گزینه يِ در قابِ کنترل هايِ دور .2

به کار بگیرید. هر  fbx.می توانید آن ها را براي خواندن دوربینی از یک پرونده يِ  هستند به کار می افتند ؛ و شما می توانید Fileيِ 

این کنترل ها را خوانده می شود ، غیر فعال می شود. البته هنوز می توانید ارزش هايِ  fbx.آن از خود پرونده يِ  کنترلی که ارزش هايِ

نشان خورده است ، نمی توانید آن  read from fileها به کار بگیرید ، ولی تا زمانی که گزینه يِ  expressionببینید و آن ها را در 

است ، ارزش هایی که در بخشِ کنترل هايِ دوربین  fbx.وي ، با تغییر دادن ارزش هایی که در یک پرونده يِ ها را تغییر بدهید. به هر ر

دوباره بارگذاري  fbx.غیر فعال هستند نیز تاثیر می گیرند ؛ چون در هر بار که با تکمه سر و کار پیدا می کنید ، این ارزش ها از پرونده يِ 

 می شوند.

را  fbx.کلیک کنید. به جایی که پرونده يِ  File، بر رويِ شمایلِ پوشه در برگه يِ  fbx.وربین از یک پرونده يِ براي خواندنِ یک د .3

 را بزنید. Openدارید بروید. آن را برگزیده و دکمه يِ 

 

ا برگزینید. پرونده هايِ به کار ببرید ر fbx.گرایشی که می خواهید از یک پرونده يِ  ، animation stackاز فهرست پایین افتادنی  .4

FBX  این توانایی را دارند که تنها در یک پرونده ، چندین گرایش را پشتیبانی کنند. معمولاً یکی از این گرایش ها ، هیچ گونه پویانمایی

 ندارد و گرایشِ پیش فرض است.

 بیاورید را برگزینید. Nukeبه درون  FBXکه می خواهید از پرونده يِ  Camera، تکمه يِ  node nameاز فهرست پایین افتادنی  .5

بنویسید (بر حسب فریم  frame rateها ، ارزشِ جدیدي را در میدانِ  animation curveبراي میزان کردن نرخِ فریم به کار رفته در  .6

را نشان زده باشید ، به کار می آید ؛ وگرنه ، نرخِ فریم از  use frame rateدر ثانیه). نرخِ فریمی که می نویسید ، تنها اگر گزینه يِ 

 به کار گرفته می شود. fbx.خود پرونده يِ 

 computeارزیابی شوند ، گزینه يِ  look at positionو  look up vectorاگر می خواهید ارزش هايِ چرخیدن دوربین با  .7

rotation  باشد ، برنامه يِ را نشان بزنید. اگر این گزینه نشان نخوردهNuke  ِبه جايِ این که کانال ،rotation  جدیدي را ارزیابی

براي دوربین داشته باشید ، ارزش هايِ چرخیدن دوربین  look atبه کار می گیرد. زمانی که یک هدفfbx  .کند ، آن را از پرونده يِ 

 همواره بر مبنايِ ان ارزیابی می شود.
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آورده اید را تغییر بدهید ، نشانِ گزینه يِ  Nukeبه درون برنامه يِ  fbx.دوربینی که از یک پرونده يِ اگر می خواهید ویژه گی هايِ  .8

read from file  ِرا در برگه يCamera  بردارید و تغییراتی که می خواهید را انجام بدهید. تا زمانی که این گزینه نشان نداشته باشد

 د.، تغییراتی که می دهید به جا می مانن

نشان خورده  read from fileمطمئن شوید که گزینه يِ ،  fbx.براي بارگذاري کردن دوباره يِ ویژه گی هايِ دوربین از یک پرونده يِ  .9

 را کلیک کنید. reloadبروید و دکمه يِ  Fileاست. به برگه يِ 

 Nukeبه درون برنامه يِ  Alembicآوردن دوربین ها از پرونده هايِ 

بیاورید. در هنگامی که پرونده به درون برنامه  Nuke) به درون صحنه يِ abc.(با فرُمتAlembic  می توانید دوربین ها را از پرونده هايِ 

این اجازه به شما داده می شود که معلوم کنید کدام تکمه ها در صحنه يِ  importآورده می شود ، به کمک پنجره يِ گفت و گويِ  Nukeيِ 

Alembic  ِبارگذاري شوند. اگر تنها یک آیتم در پرونده يAlembic .باشد ، خود به خود بارگذاري می شود 

ها برگردانده  Meshکه به  Patchرویه هايِ و  NURBS(یا خمیدگی هايِ ها  mesh دوربین ها می توانید به جز نکته :

 بیاورید. Nukeبه درون برنامه يِ  Alembicونده يِ ها را نیز از پر transformها و  Point Cloud شده اند) ،

 Alembicروشِ آوردنِ دوربین ها از یک پرونده يِ 

 را فشار بدهید. Rکه هستید کلیدNode Graph  کلیک کنید و یا در پنجره يِ  Image > Readبر رويِ  .1

 باز می شود. Read File(s)پنجره يِ گفت و گويِ 

را کلیک  Openمی خواهید آن را به درون برنامه بیاورید بروید. آن را برگزیده و دکمه يِ  واست   Alembicبه جایی که پرونده يِ  .2

 کنید.

باز شود ،  importباز می شود. به طورِ پیش فرض ، هنگامی که پنجره يِ گفت و گويِ  Alembic importپنجره يِ گفت و گويِ 

 ند برگزیده می شوند (نگاره يِ زیر را ببینید).هست Scene Graphیی که در آیتم ها همه يِ

 

آیتم هايِ پدري برگزیده شده با یک گرديِ زرد رنگ مشخص می شوند. آیتم هايِ فرزند که برگزیده شده اند نیز با یک خط نواريِ زرد 

جی در می آیند). آیتم هایی که برگزیده رنگ نشان داده می شوند (این آیتم ها زمانی که آن ها را از فهرست بر می گزینید به رنگ نارن

 نشده باشند هیچ نشانگري در کنارِ آن ها وجود ندارد.

بیاورید ، نخست می باید آیتمِ ریشه را از حالت گزینش در آورید. براي  Nukeاگر می خواهید آیتم هايِ خاصی را به درون برنامه يِ  .3

-deن کار آیتمِ ریشه و آیتم هايِ فرزند آن همگی از حالت گزینش در می آیند (این کار بر رويِ گرديِ زرد رنگ کلیک کنید. با ای

select سپس آیتم هایی که می خواهید را در .(Scene Graph  ِبرگزینید. براي این کار ، در همان فضايِ خالی ، جایی که نشانه هاي

 گردي بودند کلیک کنید.
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 آیتم راست کلیک کنید :به جايِ این کار ، می توانید بر رويِ یک 

• Select as parent  اگر این گزینه را برگزینید ، آیتم را براي آیتم هايِ دیگر پدر می کنید. بدین سان می توانید براي این آیتم :

 جداگانه اي بسازید. Nuke(و همه يِ آیتم هايِ فرزندي که در زیرِ آن هستند) در گامِ بعدي یک تکمه يِ 

• Select as child : .نزدیک ترین آیتمِ پدري می کنید که در بالايِ رده است اگر این گزینه را برگزینید ، آیتم را فرزند 

• Deselect :  ِگزینش در می آید و دیگر از صحنه به درون برنامه ي آیتم از حالتNuke .آورده نمی شود 

 با نگه داشتن کلیدCtrl  و یاShift نید چندین آیتم را با هم برگزینید.، و کلیک کردن آیتم ها ، می توا 

 یکی از کارهايِ زیر را انجام بدهید : .4

ساخته شود. در  Nukeکلیک کنید تا براي آن چه که برگزیده اید یک تکمه در  Create all-in-one nodeبر رويِ دکمه يِ  •

 این جا فرقی نمی کند آیتم هایی که برگزیده اید پدري هستند یا آیتم هايِ فرزند.

کلیک کنید تا براي هر آیتمِ پدري که برگزیده اید (گرديِ زرد رنگ)  Create parents as separate nodesرويِ دکمه يِ  بر •

ساخته شود. این تکمه همه يِ آیتم هايِ فرزندي (نوارِ زرد رنگ) که در زیرِ آیتمِ پدري باشند را در  Nukeیک تکمه در برنامه يِ 

 بر می گیرد.

بیاورید ، تکمه  Nukeبه درون برنامه يِ  Alembicبسته به آیتمی که برگزیده اید و می خواهید از صحنه يِ پرونده يِ  Nukeبرنامه يِ 

 را می سازد. Axis، و  ReadGeo  ،Cameraهايِ 

 ، می توانید گزینه هايِ زیر را میزان کنید : Cameraدر تکمه هايِ  .5

به کار بگیرید را برگزینید. پرونده هايِ  abc.گرایشی که می خواهید از پرونده يِ  animation stackاز فهرست پایین افتادنیِ  •

Alembic .چندین گرایش را در یک پرونده پشتیبانی می کنند 

 بیاورید. Nukeبه درون برنامه يِ  abc.، دوربینی را برگزینید که می خواهید از پرونده يِ  node nameاز فهرست پایین افتادنیِ  •

بنویسید (بر حسب  frame rateها ، ارزشِ جدیدي را در میدانِ  animation curveبراي میزان کردن نرخِ فریم به کار رفته در  •

را نشان زده باشید ، به کار می آید ؛ وگرنه ، نرخِ  use frame rateفریم در ثانیه). نرخِ فریمی که می نویسید ، تنها اگر گزینه يِ 

 به کار گرفته می شود. abc.يِ  فریم از خود پرونده

 Cameraمی آورید را تغییر بدهید ، به برگه يِ  Nukeبه برنامه يِ  abc.اگر می خواهید ویژه گی هايِ دوربینی که از پرونده يِ  •

گزینه نشان  را بردارید. سپس تغییراتی که می خواهید را انجام بدهید. تا زمانی که این read from fileبروید و نشانِ گزینه يِ 

 نداشته باشد ، تغییراتی که می دهید به جا می مانند.

نشان خورده  read from file، مطمئن شوید که گزینه يِ  abc.براي بارگذاريِ دوباره يِ ویژه گی هايِ دوربین از پرونده يِ  •

 را کلیک کنید. Reloadبروید و دکمه يِ  Fileباشد. سپس به برگه يِ 

 computeارزیابی شوند ، گزینه يِ  look at positionو  look up vectorش هايِ چرخیدن دوربین با اگر می خواهید ارز •

rotation  ِرا نشان بزنید. اگر این گزینه نشان نخورده باشد ، برنامه يNuke  ِبه جايِ این که کانال ،rotation  جدیدي را
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براي دوربین داشته باشید ، ارزش هايِ  look atبه کار می گیرد. زمانی که یک هدفabc  .ارزیابی کند ، آن را از پرونده يِ 

 چرخیدن دوربین همواره بر مبنايِ ان ارزیابی می شود.

بیاورید ، می توانید یک تکمه  Nukeبه درون برنامه يِ  Alembicاگر می خواهید آیتم هايِ بخصوصی را از پرونده هايِ  نکته :

پوشه در برگه  را نشان بزنید. بر رويِ شمایلِ read from fileبسازید ؛ و سپس گزینه يِ  Axis، یا  ReadGeo  ،Cameraيِ 

 است بروید. abc.به جایی که پرونده يِ  کلیک کنید و Fileيِ 

 Boujouآوردن دوربین ها از برنامه يِ 

شود ، که این امکان را به شما می دهد که دوربین هایی که در برنامه يِ  ارائه می import_boujou.tclبا اسکریپتی به نامِ  Nukeبرنامه يِ 

Boujou  ِساخته شده اند را به درون برنامه يNuke .بارگذاري کنید 

 Boujouروشِ آوردن یک دوربین از برنامه يِ 

1. Camera solve  ِرا در برنامه يBoujou  ِبا یک پرونده ي.txt .ذخیره کنید 

کلیک کرده و گزینه يِ  content menu، بر رويِ یک دکمه يِ  Nukeدر برنامه يِ  .2

Script Editor  ِرا برگزینید. پنجره يِ ویراستارscript  ِدر چهارچوبی که دکمه ي

content menu .را برگزیدید ، باز می شود 

3. ) در چهارچوبِ درون رفتinput pane ِویراستار (Script  (یعنی ، چهارچوبِ پایینی)

 ،nuke.tcl(“import_boujou”)  ِدکمه يِ را بنویسید. بر رويRun the 

current script   ِدر بالايِ ویراستار کلیک کنید ؛ یا کلیدهايCtrl+Return 

 را فشار بدهید.

 را در گام نخست در آن جا ذخیره کردید. txt.در مرورگرِ پرونده اي که باز می شود ، به جایی بروید که پرونده يِ  .4

بارگذاري می شود. تکمه يِ  Nukeبه درون  Group، و یک تکمه يِ  ScanlineRender، یک تکمه يِ  Cameraتکمه يِ  یک

Group نقطه ها در برنامه يِ  نشان دهنده يِ دارايِ استوانه هایی است کهBoujou .هستند 

 را باز کنید : Nukeدر برنامه يِ  Boujouبا انجام دادن کارهايِ زیر نیز می توانید مرورگرِ پرونده يِ نوشتاريِ  نکته :

برنامه يِ  Script commandرا فشار بدهید تا پنجره يِ گفت و گويِ  xکه هستید ، کلیدNode Graph  در پنجره يِ  .1

Nuke .باز شود 

 نید (اگر خودش نشان نخورده باشد)را نشان بز TCLدر این پنجره ،  .2

 را بنویسید. command  ،import_boujouدر میدانِ  .3

 را بزنید. OKدکمه يِ  .4

 این گام ها را می توانید به جايِ سه گامِ نخستین که در بالا گفتیم به کار ببرید.

 تغییر شکل دادن هندسه يِ اشیاء ، دوربین ها ، و نورها
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فعال است  Objectتکمه يِ  یکاست. هنگامی که  3Dکارکردهايِ تغییر شکل شاملِ جا به جایی ، تغییر اندازه ، و چرخاندن اشیاء در فضايِ 

 ، می توانید پیکربندي هايِ خاصی را براي تغییر شکلِ شیء در بخشِ نمادهايِ آن تکمه بنویسید ؛ یا یکراست شیء را به کمک دستگیره هايِ

 لولانمایان می شوند ، دستکاري کنید. تغییر شکل هایی که به شیء داده می شود از جايِ نقطه يِ  3Dیر شکل که در پنجره يِ نمایشگري تغی

 ) انجام می گیرد.Pivot Pointيِ شیء (

 ء اي داشته باشید که همیشه الگويِاین امکان براي شما فراهم شده است که بتوانید چندین شیء را هم زمان با هم تغییر داده ، یا شی Nukeدر 

 دیگري است.

آورده شده به برنامه پیوند بدهید ، یا با نمودارهايِ پویانمایی تغییر  Trackرا به داده هايِ دوربین یا  transformهم چنین می توانید نمادهايِ 

 شکل ها را کنترل کنید.

 ) به درون برنامه بیاورید.Mayaدیگر (مانند  3Dها را از برنامه هايِ  transform، می توانید  Alembicو  FBXبه کمک پرونده هايِ 

 Transformکار با دستگیره هايِ 

 3زمانی که یک شیءD  ِکه بشود آن را تغییر شکل داد ، به درونProperties Bin  ، دستگیره هايِ بارگذاري می شودTransform  نمایان

، و رنگ آبی آسه يِ  y، رنگ سبز آسه يِ  xهستند : رنگ قرمز آسه يِ  3Dره ها بر مبنايِ آسه هايِ فضايِ می شوند. رنگ هايِ این دستگی

z .را تغییر شکل می دهد 

 Transformروشِ جا به جا کردن یک شیء با دستگیره هايِ 

 هر یک از آسه ها ، آن را بکشید.  در راستايِبراي جا به جا کردن شیء 

 کلیدShift  .تنها در راستايِ یکی از آسه ها شیء جا به جاییِ را پایین نگه داشته و شیء را بکشید

 انجام می گیرد.

 Transformروشِ چرخاندن یک شیء با دستگیره هايِ 

 کلیدCtrl .ر هر یک از آسه ها بچرخدرا پایین نگه دارید و میانِ حلقه هايِ چرخش کلیک کرده و بکشید تا شیء به دو 

 و ماوس را بکشید. بر رويِ یکی از حلقه ها کلیک کردهاگر می خواهید شیء را تنها به دورِ یکی از آسه هایش بچرخانید ، 

  

 Transformروشِ تغییر اندازه دادن یک شیء با دستگیره هايِ 

دستگیره ها است کلیک کرده و ماوس را بکشید. اندازه رنگی که در مرکزِ  را پایین نگه دارید و بر رويِ چهارگوشِ زرد Shiftو  Ctrlکلیدهايِ 

 يِ شیء در هر سه آسه به طور یکسان بزرگ و کوچک می شود.
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را پایین نگه دارید و بر رويِ  Shiftو  Ctrlاگر می خواهید اندازه يِ شیء را تنها در راستايِ یکی از آسه هايِ آن تغییر بدهید ، کلیدهايِ 

 کلیک کرده و ماوس را بکشید. آسه يِ دلخواهچهارگوشِ 

  

 تکمه propertiesتغییر شکل دادن اشیاء از قابِ 

خیلی آسان و راه دست است ، ولی هنگامی که به دقّتی خیلی  3Dبراي جا به جا کردن اشیاء پیرامونِ فضايِ کاريِ  transformدستگیره هايِ 

 transformبنویسید. در این قاب گزینه هايِ دیگري نیز براي  nodeتکمه يِ  بیش تري نیاز دارید ، می باید ارزش ها را یکراست در قابِ

 وجود دارد که در پنجره يِ نمایشگر نیست. rotationو 

 Transformationپیکربندي کردن گزینه هايِ 

گزینه اي را برگزینید که می خواهید آرایشی را تعریف کنید که به وسیله يِ تغییر شکل  transform orderاز فهرست پایین افتادنیِ  •

 ).translationبراي  t، و  rotationبراي  scale  ،rبراي  sها انجام می شوند (

 ها تعریف کنید.گزینه اي را برگزینید که می خواهید آرایشِ آسه اي را براي چرخش  rotation orderاز فهرست پایین افتادنیِ  •

 تغییر شکل دادن یک شیء از قابِ آن

، و  translate x  ،translate yبراي جا به جا کردن یک شیء در راستايِ یک یا چند تا از آسه هایش ، ارزشِ میدان هايِ  •

translate z .را زیاد و کم کنید 

 را زیاد و کم کنید. rotate z، و  rotate x  ،rotate yبراي چرخاندن یک شیء ، ارزشِ میدان هايِ  •

 را زیاد و کم کنید. uniform scaleبراي بزرگ و یا کوچک کردن یک شیء در همه يِ آسه هایش به طورِ هم زمان ، ارزشِ میدانِ  •

، و  scale x  ،scale y) ، ارزشِ میدان هايِ  z، یا  x  ،yبراي بزرگ و کوچک کردن یک شیء به طورِ ناهماهنگ (بر رويِ آسه يِ  •

scale z .را زیاد و کم کنید 

را زیاد و  skew z، و  skew x  ،skew yآن) ، ارزشِ میدان هايِ  بومیِبراي اُریب کردن شیء (پیچاندن شیء با چرخاندن آسه هايِ  •

 بچرخد. کم کنید تا آسه يِ مربوطه (و به همراه آن ورتکس هايِ شیء)

 )Pivot Pointلولا (تغییر شکل ها و نقطه يِ 

این تغییرات از جایی انجام می شوند که نقطه يِ لولایی شیء قرار دارد. هنگامی که تغییراتی را به جا ، اندازه و چرخشِ یک شیء می دهید ، 

 پیش فرض ، نقطه يِ لولا در جایی قرار دارد که آسه هايِ شیء هم دیگر را قطع می کنند. به طورِ
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جایی که بخواهید جا به جا کنید. حتا می توانید آن را در بیرون از شیء بکشید. سپس هر تغییر شکلی که  این نقطه يِ لولا را می توانید به هر

 به شیء می دهید بر مبنايِ جایی که نقطه يِ لولا قرار دارد انجام می گیرد.

 روشِ جا به جا کردن نقطه يِ لولا

 به نمایش در آیند.دو بار کلیک کنید تا نمادهايِ آن  Objectتکمه يِ  بر رويِ .1

) در هر یک از local Axisبومیِ شیء (را به دلخواه تغییر بدهید تا آسه يِ  pivot z، و  pivot x  ،pivot yارزش هايِ میدان هايِ  .2

 راستاهایی که ارزشِ آن را تغییر داده اید جا به جا شود.

 
لولا را با یک خطّ نشان می دهند. همه يِ تغییر شکل هایی که پس از این انجام شیء می افتند ، جايِ نقطه يِ نقطه هايِ گرافیکی که بر رويِ 

 بدهید بر مبنايِ این نقطه يِ لولا انجام می گیرد.

 يِ هزمانی که جايِ نقطه يِ لولایی یک شیء را تعریف کردید ، می توانید نمادهايِ تغییر شکلِ شیء را به کار بگیرید تا شیء را نسبت به نقط

 جا به جا کرده ، چرخانده ، بزرگ و کوچک نموده ، و اُریب کنید. لولا

 ایجاد ساختارِ پدري به اشیاءAxis 

کار می  null، با افزودن یک آسه يِ جدید براي تغییر شکل به اشیاء دیگري که به آن زنجیر شده اند ، به مانند یک شیءAxis  یک تکمه يِ 

 توکارِ خودشان را دارند ، گاهی فرزند کردن آن ها به یک آسه يِ جداگانه می تواند سودمند باشد.کند. حتا زمانی که اشیاء آسه هايِ 

را در نظر بگیرید که براي اشیاء دیگري که در صحنه دارید (دو گسُتره يِ نگاره و دوربین) پدر شده است (نگاره  Axisبراي نمونه ، یک تکمه يِ 

 يِ زیر). اکنون یک شیءAxis  دارید که کنترلِ همه يِ صحنه را به دست دارد. براي نمونه اگر آن را بچرخانید ، همه يِ اشیایی که در صحنه را

 هستند می چرخند.
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همه يِ آن ها را با هم  MergeGeoاگر می خواهید چندین شیء را با هم جا به جا کنید ، می توانید با یک تکمه يِ  نکته :

 کنترلِ آن ها را به دست بگیرید. TransformGeoیکی کرده ، و سپس به کمک یک تکمه يِ 

 افزودنِ یک شیءAxis 

1. 3D > Axis  ِرا برگزینید تا یک تکمه يAxis  بهscript .افزوده شود 

آن  Axisتکمه يِ  transformationکه می خواهید با کنترل هايِ  Objectبراي این که ساختارِ پدري را بسازید ، همه يِ تکمه هايِ  .2

 بچسبانید.  Axis، را به تکمه يِ  ها را کنترل کنید

 

زنجیر  Axisدیگري را به نخستین تکمه يِ  Axisاگر می خواهید یک رده يِ زنجیره اي تو در تو براي تغییر شکل ها بسازید ، تکمه هايِ 

 را براي کنترل کردن چرخش ، اندازه و جا به جایی بسازید. Axisوانید یک رده يِ زنجیره اي از سه تکمه يِ کنید. براي نمونه ، می ت
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نیز به  Axis1چسبانده شده است.  Axis1 (transform)به  Axis2 ، و Axis2 (scale)به  Axis3 (rotation)در نمونه يِ بالا ، 

که بدین روش چسبانده  Axisمی خواهید رويِ آن ها تاثیر بگذارید. با تکمه هايِ چسبانده شده که  TransformGeoتکمه (ها) يِ 

 افزوده می شود. TransformGeoشده اند ، داده هايِ تغییر شکلِ آن ها به پایینِ زنجیره کشیده شده و به پیکربندي هايِ تکمه يِ 

 درون رفت کار با درگاهLook 

  درون رفت درگاهlook  ِاز تکمه يAxis  را می توانید به اختیار به کار بگیرید. با این کارAxis  چیزي رو خود به خود می چرخد و به سمت

 می کند که به این درگاه چسبانده شده است. به این درگاهlook  ِمی توانید یک تکمه يCamera  ،Light  یا ،Axis  ، بچسبانید. براي نمونه

بچرخد و به سمت دوربین رو کرده و هر جا دوربین برود  Axisبچسبانید تا  lookه درگاه درون رفت را ب Cameraمی توانید یک تکمه يِ 

 آن را دنبال کند.

 TransformGeoروشِ کار با تکمه يِ 

با هم یکی شده اند را  MergeGeoاین اجازه را به شما می دهد که چندین شیء را که به کمک یک تکمه يِ  TransformGeoتکمه يِ 

ه مجا به جا کرده ، چرخانده ، بزرگ و کوچک کنید ، و تغییر شکل هايِ دیگر را انجام بدهید. هم چنین می توانید اشیاء هندسی را به یک تک

 Axis Transformation بچسبانید. با این کار ، می توانید همه يِ اشیایی که به هم دیگر چسبانده شده اند را به کمک کنترل هايِ Axisيِ 

را درست پس از هر شیء هندسی بنشانید ، تکمه  TransformGeoجا به جا کنید. همه يِ آن چه باید انجام بدهید این است که یک تکمه يِ 

 نید.را میزان ک Axisاز تکمه يِ  transformچسبانده ، و کنترل هايِ  TransformGeoاز تکمه يِ  axisرا به درون رفتAxis  يِ 

چرخاندن یک شیء است که به  TransformGeoکاربرد دیگرِ تکمه يِ 

) جایگاهposition دوم دیگر وابسته شده است. به این گونه که شیء شیء (

را که جا به جا کنید ، شیء نخست می چرخد تا همواره رو به آن داشته باشد. 

 براي نمونه ، می توانید یک شیءSphere  داشته باشید که همیشه رو به یک

 شیءCylinder  داشته باشد. هر گاه شیءCylinder  را به جايِ جدید جا

 به جا کنید ، شیءSphere  نیز خود به خود می چرخد تا همیشه رو به آن

 داشته باشد.

 3یک شیءD دیگر داشته باشد که همیشه رو به شیء 

  

 ) که می خواهید رو به شیء دیگر قرار بگیرد را برگزینید.Sphere(براي نمونه ، یک  3D Objectتکمه يِ  .1
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2. 3D > Modify > TransformGeo  ِرا برگزینید تا یک تکمه يTransformGeo  درscript .بنشیند 

 TransformGeoتکمه يِ ) را برگزیده و یک Cylinderشیء نخست رو به آن قرار بگیرد (براي نمونه ، یک شیء اي که می خواهید  .3

 را پس از آن بنشانید.

 دوم بچسبانید. TransformGeoتکمه يِ  lookنخست را به درگاه درون رفتTransformGeo  تکمه يِ  .4

 بروید. Lookرا باز کنید و به برگه يِ  TransformGeoکنترل هايِ نخستین تکمه يِ  .5

  

 اي را برگزینید که شیء به دورِ آن بچرخد و رو به شیء دیگر قرار بگیرد. ، آسه look axisاز فهرست پایین افتادنیِ  .6

  
+Y     +Z 

  
+X     -Z 

  
-Y     -X 
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را به کار ببرید. براي این که  rotate Z، و  rotate X  ،rotate Yبراي برگزیدن آسه اي از شیء که به دورِ آن بچرخد ، گزینه هايِ  .7

 شیء نخست به درستی رو به شیء دوم قرار بگیرد ، می باید هر سه گزینه را نشان بزنید.

را میزان کنید. هر چه ارزشِ این گزینه کم تر باشد ، شیء کم تر می  look strengthبراي تعریف کردن گستردگیِ چرخش ، لغزنده يِ  .8

 را پیکربندي کنید ، شیء هیچ چرخی نمی خورد. 0ارزشی برابر با  چرخد. اگر براي این گزینه

را نشان بزنید. این گزینه می  use quaternionsاگر می خواهید براي ارزیابی کردن چرخش تدبیرِ دیگري را به کار بگیرید ، گزینه يِ  .9

 شده به کارتان بیاید.برگزیده  look axisتواند براي نرم و هموار شدن چرخش هايِ نامنظمّ در راستايِ 

دوم را میزان کنید می بینید که شیء نخست خود به خود می چرخد تا همواره رو به شیءTransformGeo  اکنون اگر کنترل هايِ تکمه يِ 

 دوم داشته باشد.

 ها به یک شیءTrackبه کار بردنِ 

) را به نمادهايِ Motion dataدرون برنامه آورده و داده هايِ حرکتی ( را به channelاین توانایی را دارد که پرونده هايِ  Nukeبرنامه يِ 

transformation  یک دوربین یا شیء بدهید. بیش ترین هدفی که براي این کار است ، همانند سازيِ جا به جایی یک دوربین ویژه یا جا

 به جا کردن اشیاء در یک مسیرِ تعریف شده است.

تعریف می شود. این داده ها با یک  Cartesianبراي هر فریم از پویانمایی در یک فیلم ، مجموعه اي از مختصاتchannel  در پرونده هايِ 

بیرون فرستاده  channel) ارزیابی شده و به شکلِ یک پرونده يِ Boujou، یا  3D-Equalizer  ،Maya(مانند  3D Trackingنرم افزارِ 

 می شود.

 به یک شیء channelدادن یک پرونده يِ 

 دو بار کلیک کنید تا نمادهايِ آن به نمایش در آیند. Cameraیا  Objectبر رويِ یک تکمه يِ  .1

 کلیک کنید. پنجره يِ مرورگرِ پرونده باز می شود. import chan fileبر رويِ  .2

 کلیک کنید. OK دکمه يِ را ذخیره کرده اید. آن را برگزیده و بر رويِ channelبه جایی بروید که پرونده يِ  .3

4. Nuke  ِداده هايchannel  را می خواند و یک پیام در باره يِ شمارِ فریم هايِ داده اي که به درون برنامه آورده شده اند ، به نمایش

ون با داده شیء به رنگ سبز در آمده اند که نشان می دهد این نمادها اکن translationمی گذارد. هم چنینی می توانید ببینید که نمادهايِ 

هايِ پویانمایی کنترل می شوند. نشانگرِ بازپخشِ نمایشگر را به چپ و راست بکشید. می بینید که اکنون شیء یا دوربین بر مبنايِ داده 

 آورده شده ، جا به جا می شوند. Nukeبه درون برنامه يِ  channelکه از پرونده يِ  transformationهايِ 

 translationاز همه يِ نمادهايِ  channelنیز می توانید یک پرونده يِ  export chan file به کمک دکمه يِ یادداشت :

به بیرون بفرستید. این کار میان هنرمندان این رشته براي  Nukeپویانمایی شده که به یک شیء داده شده است را از برنامه يِ 

 به اشتراك گذاشتن آن چه که انجام داده اند بسیار سودمند است.

را می توانید براي آوردن دوربین هایی که در برنامه هايِ دیگر ساخته اید نیز به کار ببرید. به هر  channelپرونده هايِ  نکته :

 دیگر از برنامه هايِ chanیک فُرمت استاندارد نیست و شاید براي بیرون فرستادن پرونده هايِ  chanروي ، فُرمت پرونده يِ 

 ) نیاز داشته باشید.file format converterبرگردانِ فُرمت (به یک برنامه يِ  ،
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 FBXها از پرونده هايِ  transformآوردن 

 پیش از این گفتیم. FBXدر باره يِ پرونده هايِ 

بخوانید.  fbx.ها) را از پرونده هايِ Locatorها ( Nullها و  Markerها ،  Transformتکمه اي است که با آن می توانید  Axisتکمه يِ 

 بیاورید. Nukeرا به درون برنامه يِ Null، یا  transform  ،Markerمی توانید یک  Axisيِ  به ازايِ هر تکمه

 fbx.از یک پرونده يِ  Transformروشِ آوردن یک 

1. 3D > Axis  را برگزینید تا تکمه اي به همین نام درscript  ِتان جاي بگیرد. تکمه يAxis  ِرا به یک تکمه يScene .بچسبانید 

هستند به  Fileرا نشان بزنید. با این کار کنترل هایی که در برگه يِ  read from file، گزینه يِ  Axisدر بخشِ کنترل هايِ تکمه يِ  .2

هر  بیاورید. Nukeبه درون برنامه يِ  fbx.ها را از یک پرونده يِ  transformکار می افتند ؛ و این اجازه را به شما می دهند که 

نشان  read from fileتا زمانی که گزینه يِ  خوانده می شود ، غیر فعال می شود. fbx.آن از خود پرونده يِ  زش هايِکنترلی که ار

ها به کار بگیرید.  expressionخورده است ، نمی توانید این ارزش ها را تغییر بدهید. به هر روي ، هنوز می توانید آن ها را ببینید و در 

دوباره بارگذاري می شوند. بنا بر این ، هر گونه تغییري که در  fbx.ر و کار پیدا می کنید ، ارزش ها از پرونده يِ هر بار که با تکمه س

 نیز بازتاب می شوند. Axisانجام بدهید در بخشِ کنترل هايِ  fbx.ارزش هايِ پرونده يِ 

 

است (که دارايِ  fbx.بروید و بر رويِ شمایلِ پوشه کلیک کنید تا مرورگرِ پرونده باز شود. به جایی که پرونده يِ  Fileبه برگه يِ  .3

transform  ِاست و می خواهید آن را به کار ببرید) بروید. آن را برگزیده و دکمه يOpen .را بزنید 

به کار ببرید را برگزینید. پرونده هايِ  fbx.اهید از یک پرونده يِ ، گرایشی که می خو animation stackاز فهرست پایین افتادنی  .4

FBX  این توانایی را دارند که تنها در یک پرونده ، چندین گرایش را پشتیبانی کنند. معمولاً یکی از این گرایش ها ، هیچ گونه پویانمایی

 ندارد و گرایشِ پیش فرض است.

به درون  FBXکه می خواهید از پرونده يِ را برگزینید  Null، یا  node name  ،Transform  ،Markerاز فهرست پایین افتادنی  .5

Nuke .بیاورید 

 frame rate، ارزشِ جدیدي را در میدانِ به کار بیاید fbx.از پرونده يِ ها  animation curve براي اگر نمی خواهید نرخِ فریم .6

را نشان زده باشید ، به کار می آید  use frame rateی نویسید ، تنها اگر گزینه يِ بنویسید (بر حسب فریم در ثانیه). نرخِ فریمی که م

 به کار گرفته می شود. fbx.؛ وگرنه ، نرخِ فریم از خود پرونده يِ 

آورده اید را تغییر بدهید ، نشانِ گزینه  Nukeبه درون برنامه يِ  fbx.که از یک پرونده يِ  transformاگر می خواهید ویژه گی هايِ  .7

و تغییراتی که می خواهید را انجام بدهید. تا زمانی که این گزینه نشان نداشته باشد  ، بردارید Axisرا در برگه يِ  read from fileيِ 

 ، تغییراتی که می دهید به جا می مانند.
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نشان  read from file، مطمئن شوید که گزینه يِ  fbx.از یک پرونده يِ  transformبراي بارگذاري کردن دوباره يِ ویژه گی هايِ  .8

 را کلیک کنید. reloadبروید و دکمه يِ  Fileخورده است. به برگه يِ 

 Alembicها از پرونده هايِ  Transformآوردن 

بیاورید. در هنگامی که پرونده به درون  Nuke) به درون صحنه يِ abc.(با فرُمتAlembic  ها را از پرونده هايِ  transformمی توانید 

این اجازه به شما داده می شود که معلوم کنید کدام تکمه ها در  importآورده می شود ، به کمک پنجره يِ گفت و گويِ  Nukeبرنامه يِ 

 بارگذاري می شود.باشد ، خود به خود  Alembicبارگذاري شوند. اگر تنها یک آیتم در پرونده يِ  Alembicصحنه يِ 

ها  Meshکه به  Patchرویه هايِ و  NURBS(یا خمیدگی هايِ ها  mesh ها می توانید transform به جز نکته :

 بیاورید. Nukeبه درون برنامه يِ  Alembicرا نیز از پرونده يِ  دوربین هاها و  Point Cloud برگردانده شده اند) ،

 Alembicده يِ روشِ آوردنِ دوربین ها از یک پرون

 را فشار بدهید. Rکه هستید کلیدNode Graph  کلیک کنید و یا در پنجره يِ  Image > Readبر رويِ  .1

 باز می شود. Read File(s)پنجره يِ گفت و گويِ 

را کلیک  Openمی خواهید آن را به درون برنامه بیاورید بروید. آن را برگزیده و دکمه يِ  واست   Alembicبه جایی که پرونده يِ  .2

 کنید.

باز شود ،  importباز می شود. به طورِ پیش فرض ، هنگامی که پنجره يِ گفت و گويِ  Alembic importپنجره يِ گفت و گويِ 

 هستند برگزیده می شوند (نگاره يِ زیر را ببینید). Scene Graphآیتم هایی که در  همه يِ

 

زرد رنگ مشخص می شوند. آیتم هايِ فرزند که برگزیده شده اند نیز با یک خط نواريِ زرد  آیتم هايِ پدري برگزیده شده با یک گرديِ

رنگ نشان داده می شوند (این آیتم ها زمانی که آن ها را از فهرست بر می گزینید به رنگ نارنجی در می آیند). آیتم هایی که برگزیده 

 .نشده باشند هیچ نشانگري در کنارِ آن ها وجود ندارد

بیاورید ، نخست می باید آیتمِ ریشه را از حالت گزینش در آورید. براي  Nukeرا به درون برنامه يِ  ویژه اياگر می خواهید آیتم هايِ  .3

-deاین کار بر رويِ گرديِ زرد رنگ کلیک کنید. با این کار آیتمِ ریشه و آیتم هايِ فرزند آن همگی از حالت گزینش در می آیند (

select.(  سپس آیتم هایی که می خواهید را درScene Graph  ِبرگزینید. براي این کار ، در همان فضايِ خالی ، جایی که نشانه هاي

  گردي بودند کلیک کنید.

 

 به جايِ این کار ، می توانید بر رويِ یک آیتم راست کلیک کنید :
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• Select as parent  اگر این گزینه را برگزینید ، آیتم را براي آیتم هايِ دیگر پدر می کنید. بدین سان می توانید براي این آیتم :

 جداگانه اي بسازید. Nuke(و همه يِ آیتم هايِ فرزندي که در زیرِ آن هستند) در گامِ بعدي یک تکمه يِ 

• Select as child : .نزدیک ترین آیتمِ پدري می کنید که در بالايِ رده است اگر این گزینه را برگزینید ، آیتم را فرزند 

• Deselect :  ِگزینش در می آید و دیگر از صحنه به درون برنامه ي آیتم از حالتNuke .آورده نمی شود 

 با نگه داشتن کلیدCtrl  و یاShift نید چندین آیتم را با هم برگزینید.، و کلیک کردن آیتم ها ، می توا 

 یکی از کارهايِ زیر را انجام بدهید : .4

ساخته شود. در  Nukeکلیک کنید تا براي آن چه که برگزیده اید یک تکمه در  Create all-in-one nodeبر رويِ دکمه يِ  •

 این جا فرقی نمی کند آیتم هایی که برگزیده اید پدري هستند یا آیتم هايِ فرزند.

کلیک کنید تا براي هر آیتمِ پدري که برگزیده اید (گرديِ زرد رنگ)  Create parents as separate nodesرويِ دکمه يِ  بر •

ساخته شود. این تکمه همه يِ آیتم هايِ فرزندي (نوارِ زرد رنگ) که در زیرِ آیتمِ پدري باشند را در  Nukeیک تکمه در برنامه يِ 

 بر می گیرد.

بیاورید ، تکمه  Nukeبه درون برنامه يِ  Alembicبسته به آیتمی که برگزیده اید و می خواهید از صحنه يِ پرونده يِ  Nukeبرنامه يِ 

 را می سازد. Axis، و  ReadGeo  ،Cameraهايِ 

 ، می توانید گزینه هايِ زیر را میزان کنید : Axisدر تکمه هايِ  .6

به کار بگیرید را برگزینید. پرونده هايِ  abc.گرایشی که می خواهید از پرونده يِ  animation stackاز فهرست پایین افتادنیِ  •

Alembic .چندین گرایش را در یک پرونده پشتیبانی می کنند 

به  abc.را برگزینید که می خواهید از پرونده يِ  Null، یا  node name  ،transform  ،Markerاز فهرست پایین افتادنیِ  •

 بیاورید. Nukeدرون برنامه يِ 

، نرخِ فریمی را (بر حسب فریم در ثانیه) براي پویانمایی بنویسید. نرخِ فریمی که می نویسید ، تنها اگر  frame rateدر میدانِ  •

 ار گرفته می شود.به ک abc.را نشان زده باشید ، به کار می آید ؛ وگرنه ، نرخِ فریم از خود پرونده يِ  use frame rateگزینه يِ 

 Axisمی آورید را تغییر بدهید ، به برگه يِ  Nukeبه برنامه يِ  abc.که از پرونده يِ  transformاگر می خواهید ویژه گی هايِ  •

را بردارید. سپس تغییراتی که می خواهید را انجام بدهید. تا زمانی که این گزینه نشان  read from fileبروید و نشانِ گزینه يِ 

 داشته باشد ، تغییراتی که می دهید به جا می مانند.ن

نشان  read from file، مطمئن شوید که گزینه يِ  abc.از پرونده يِ transform براي بارگذاريِ دوباره يِ ویژه گی هايِ  •

 را کلیک کنید. Reloadبروید و دکمه يِ  Fileخورده باشد. سپس به برگه يِ 

بیاورید ، می توانید یک تکمه  Nukeبه درون برنامه يِ  Alembicايِ بخصوصی را از پرونده هايِ اگر می خواهید آیتم ه نکته :

پوشه در برگه  را نشان بزنید. بر رويِ شمایلِ read from fileبسازید ؛ و سپس گزینه يِ  Axis، یا  ReadGeo  ،Cameraيِ 

 است بروید. abc.به جایی که پرونده يِ  کلیک کنید و Fileيِ 

 3Dبه یک صحنه يِ  Motion Blurافزودنِ 
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 Motion Blurتان ، جلوه يِ  3Dواقع گرایی بیش تري ببخشید ، می باید بر پایه يِ جا به جا شدنِ دوربینِ  3Dبراي آن که به یک صحنه يِ 

 بدهید.

را میزان کنید. با این گزینه مشخص می کنید با هر بار که شاترِ دوربین  samples، ارزشِ  ScanlineRenderدر نمادهايِ تکمه يِ  •

ه ب باز و بسته شود ، نگاره چند بار نمونه گیري شود. این دقیق ترین ، و البته کنُد ترین راه است ؛ چون ارزیابیِ پردازشی براي هر پیکسل

 طورِ کامل براي چندین بار انجام می گیرد.

را به کار ببرید. پردازش در این جا سریع تر انجام می  VectorBlurبر مبنايِ بردارهايِ حرکتی ، تکمه يِ  Motion Blurبراي ساختنِ  •

 تاثیر گرفته می شود.وضوحِ پیکسلی نگاره يِ نهایی با تان ، تنها  3Dگیرد ؛ چرا که به جايِ پیچیدگیِ صحنه يِ 

 ScanlineRenderبه کمک یک تکمه يِ  Motion Blurافزودن 

 بروید. MultiSample، به برگه يِ  ScanlineRenderدر قابِ کنترل هايِ تکمه يِ  .1

را زیاد کنید. با این کار نگاره در زمانی که شاتر باز است چندین بار نمونه گیري می شود. هر چه ارزشِ این گزینه را  samplesارزشِ  .2

 بیش تر بگیرید ، نگاره يِ نرم تري به دست می آید ، ولی زمانِ پردازشِ بیش تر می شود.

  
Samples = 5   Samples = 15 

کردن نگاره باز می ماند. براي نمونه ، اگر ارزشی  Motion Blurایی را بنویسید که شاتر به هنگامِ ، شمارِ فریم ه Shutterدر میدانِ  .3

را به این گزینه بدهید ، شاتر به اندازه يِ نیم فریم باز می ماند. با زیاد کردن ارزشِ این گزینه میزان محو شدگی نگاره بیش  0.5برابر با 

 میزان محو شدگی نیز کم تر می شود. تر ، و با کم کردن ارزشِ این گزینه

  
Shutter = 20   Shutter = 40 

، دامنه يِ جبرانیِ شاتر را میزان کنید. با گزینه هايِ گوناگونی که در زیر می آیند می توانید  shutter offsetاز فهرست پایین افتادنیِ  .4

 بسته شود.که چه زمانی شاتر نسبت به ارزشِ فریمِ جاري باز و  معلوم کنید

• Centered  شاتر در محدوده اي از زمان باز می شود که فریم جاري درست در میانِ این محدوده قرار دارد. براي نمونه ، اگر :

 باز می ماند. 30.5تا  29.5باشد ، شاتر از فریمِ  30پیکربندي کنید و فریم جاري تان شماره يِ  1ارزشِ شاتر را رويِ 
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• Start :  ِپیکربندي کنید و فریم جاري تان شماره يِ  1شاتر را در فریم جاري باز می کند. براي نمونه ، اگر ارزشِ شاتر را روي

 باز می ماند. 31تا  30باشد ، شاتر از فریمِ  30

• End  ِ30تان شماره يِ  پیکربندي کنید و فریم جاري 1: شاتر را در فریم جاري می بندد. براي نمونه ، اگر ارزشِ شاتر را روي 

 باز می ماند. 30تا  29باشد ، شاتر از فریمِ 

• Custom  پایین افتادنی است ، ارزشی (بر حسب ن کرده اید. در میدانی که در کنار فهرستشاتر در زمانی باز می شود که معی :

یم جاري باز شود ، یک ارزشِ منفی را در فریم) را بنویسید که می خواهید به فریم جاري افزوده شود. براي این که شاتر پیش از فر

 را بنویسید ، شاتر نیم فریم پیش از فریم جاري باز می شود. 0.5-این میدان بنویسید. براي نمونه ، اگر ارزشی برابر با 

ا این کار ، بر رويِ را میزان کنید. ب randomize timeبراي آن که پراکندگیِ نمونه ها در زمان به شکلی اتّفاقی انجام شود ، گزینه يِ  .5

ه ها انِ نمونبیش تر باشد ، اختلاف زمانی می همه يِ نمونه ها ، به جر نمونه يِ نخست و پایانی تاثیر می گذارید. هر چه ارزشِ این گزینه

 بزرگ تر خواهد بود.

کسلی که در آن دایره می نشیند ، براي ، قطرِ دایره اي را پیکربندي می کنید که براي هر پی sample diameterبا میزان کردن گزینه يِ  .6

antialiasing .هر چه ارزشِ بزرگ تري را به این گزینه بدهید ، پیکسل هايِ بیش تري  نمونه گرفته می شودjitter .می شوند 

را  multi-sampleپردازشِ ،  stochastic samplesاگر می بینید پردازش خیلی کُند پیش می رود ، می توانید با به کارگیريِ  .7

د نتقریب زده و زمانِ پردازش را کاهش بدهید. این گزینه با به کارگیريِ برآورد اتّفاقی ، شمارِ نمونه ها (هر پیکسل) را پیکربندي می ک

چه ارزشِ  غیر فعال است). هر چه ارزش ها پایین تر باشند پردازش سریع تر انجام می شود ؛ ولی هر 0(این گزینه در ارزشی برابر با 

 بالاتري به گزینه بدهید ، کیفیت نگاره يِ نهایی بهبود بخشیده می شود.

ارزشِ خیلی بزرگی بدهید ، می توانید آن را با ارزشِ کوچکی  stochastic samplesبه یاد داشته باشید ، به جايِ این که به گزینه يِ 

 کنید. را زیاد Samplesبه جايِ آن ارزشِ گزینه يِ میزان کرده و 

  
        Stochastic samples = 0 (الغیر فع) Stochastic samples = 5 

را به کار بیاندازید. بدین سان ، به همه يِ  uniform distributionبراي پخش شدن یکنواخت نمونه ها در زمانِ شاتر ، گزینه يِ  .8

 برآیندهايِ دقیق تري به دست می آید. stochastic multi- samplingنمونه ها در زمانِ شاتر اهمیت یکسانی داده می شود ؛ و براي 

 VectorBlurبه کمک تکمه يِ  Motion Blurافزودن 

) می گیرد ، راستايِ محو شدن را مشخص uو  v(کانال هايِ  motion vectorبه کمک ارزش هایی که از کانال هايِ  VectorBlurتکمه يِ 

را درست می کند. اگر بخواهیم محو شدگی که با این تکمه به دست می  Motion Blurدر یک خط راست ،  کرده و با محو کردن هر پیکسل
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به دست می آورید را با هم بسنجیم ، باید  ScanlineRenderاز تکمه يِ  MultiSampleآید را با محو شدگی که به کمک کنترل هايِ 

 ه جايِ آن پردازش سریع تر انجام می شود.بگوییم که در این جا دقتّ محو شدگی کم تر ، و ب

 به چندین راه می توانید درست کنید :را  VectorBlurبردارهايِ حرکتی لازم براي کار با تکمه يِ 

است ؛ و با هر دو دوربین  MotionBlur3D. این معمولاً دقیق تر از کاربرد یک تکمه يِ ScanlineRenderبه کار گیريِ تکمه يِ  •

 ) دوربین به خوبی کار می کند.Non-Linear) و غیر خطیِ (Linearایستا و در حالِ حرکت ، و نیز با هر دو جا به جا شدن هايِ خطی (

 است ، میشما ایستا یا کم و بیش ایستا است ، و جا به جا شدن دوربین در زمانِ شاتر کم و بیش خطی  3Dبه جايِ آن ، اگر صحنه يِ  •

را نیز به کار ببرید. به هر روي ، به یاد داشته باشید که این تکمه تنها داده هايِ دوربین را  Filter > MotionBlur3Dتوانید تکمه يِ 

ه مبراي ساخت بردارهايِ حرکتی به کار می گیرد. اگر اشیایی در صحنه دارید که جا به جا می شوند ، ولی خود دوربین ایستا است ، تک

 نمی تواند هیچ بیرون رفتی را بسازد. MotionBlur3Dيِ 

می سازند  Two-Channel floating point نگاره هايِ به شکلِرا دیگر هستند که داده هايِ بردارهايِ حرکتی  3Dچندین برنامه يِ  •

 بشوند. unpremultiplyبه کار بگیرید. البته اگر ممکن باشد ، می باید این نگاره ها  VectorBlur؛ که این نگاره ها را می توانید با 

 ScanlineRender ه کمک تکمه يِب VectorBlurروشِ به کارگیريِ تکمه يِ 

 بروید. Shaderرا باز کنید و به برگه يِ  ScanlineRenderتکمه يِ  propertiesتان ، قابِ  3Dدر صحنه يِ  .1

 ) پیکربندي شده باشد :offبر رويِ یکی از گزینه هايِ زیر (و نه گزینه يِ  motion vectorsزینه يِ ببینید که گ .2

• Classic  ِردارهايِ حرکتی را به روشِ قدیمی (پیش از نسخه يب :Nuke 6.1 پردازش می کند. این گزینه تنها براي سازگاري با (

 دقیق نیست. نسخه هايِ پیشین برنامه گذاشته شده است ، و همیشه

• Velocity  ِچگالیِ هر پیکسل را تک به تک در کانال هاي :motion blur  ِذخیره می کند (روش به کار رفته در نسخه هاي

براي این که برنامه در این جا رفتاري ). این گزینه نیز تنها براي سازگاري با نسخه هايِ پیشین آورده شده است. Nuke 7.0پیش از 

 بگذارید. 1را بر رويِ  samplesداشته باشد ، گزینه يِ  Nuke 6.3درست به مانند 

• Distance :  ِبراي هر پیکسل ، فاصله يِ میان نمونه ها را در کانال هايmotion blur  (بر حسب پیکسل) ذخیره می کند. این

گزینه اي است که معمولاً براي داشتن به ترین برآیند کار پیشنهاد می شود تا به کار بگیرید. هم چنین این امکان در این گزینه هست 

  VectorBlurه يِ ) انجام می شود ، تکمcurve) به شکلِ خمیدگی (linear، در جایی میان دو فریمی که درون یابی به جايِ خطی (

 بتواند بردارِ محو شده يِ خمیده اي را درست کند.

 را به کار بگیرید. motion vector channelsکجا ذخیره شوند ، گزینه يِ در براي این که معلوم کنید بردارهايِ حرکتی ساخته شده  .3

 داراي بردارهايِ حرکتی هستند.اگر کانال هایی که برگزیدید را به نمایش بگذارید می بینید که اکنون آن ها 

بماند. بعدها ، اگر نتوانید به خوبی جا به جایی غیر خطیِ  1همان را بگذارید روي  samples، گزینه يِ  MultiSampleدر برگه يِ  .4

 تقریب بزنید ، می توانید ارزشِ این گزینه را زیاد کنید. VectorBlurرا به کمک روند خطیِ تکمه يِ 
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 3Dپردازشی از یک صحنه يِ       حرکتی که به کمک تکمه يِ ايِبرداره

ScanlineRender .ساخته شده اند 

5. Filter > VectorBlur  ِرا برگزینید تا تکمه اي به همین نام پس از تکمه يScanlineRender .جاي بگیرد 

 

 کانال هایی که می خواهید محو شوند را برگزینید. channels، از فهرست پایین افتادنیِ  VectorBlurتکمه يِ  propertiesدر قابِ  .6

کانال هايِ بردارهايِ حرکتی را برگزینید. این کانال ها باید همان کانال هایی باشند که در گام  uv channelsاز فهرست پایین افتادنیِ  .7

 ساختید. 3

است ،  backwardدقیق تر از الگوریتمِ یک  forwardارید. بگذ forwardرا بر رويِ  methodبراي بهبود برآیند کار ، گزینه يِ  .8

 ولی به زمان بیش تري براي پردازش نیاز می شود.

تنها زمانی درست از کار در می آید که بردارهايِ حرکتی پیوسته باشند ، و هیچ تغییري از نظر پارگی در لبه يِ  backwardالگوریتمِ 

را می بینید که با تکمه يِ  motion blurاشیاء وجود نداشته باشد. در نگاره يِ پایین سمت راست ، نگاره يِ اصلی ، و در سمت چپ ، 

VectorBlur .درست شده است 
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 بگذارید. این بدین معناست که شاتر در فریم جاري باز می شود. 0را بر رويِ  offsetگزینه يِ  .9

بروید ScanlineRender تکمه يِ  propertiesاز قابِ  MultiSampleدرازايِ محو شدگی را میزان کنید. براي این کار ، به برگه يِ  .10

 را به دست بگیرید. shutterو کنترلِ 

 MotionBlur3Dبه کمک تکمه يِ  VectorBlurتکمه يِ  روشِ به کارگیريِ

را باز کنید. با برگه  ScanlineRenderتکمه يِ  propertiesتان (که باید ایستا و یا کم و بیش ایستا باشد) ، قابِ  3Dدر صحنه يِ  .1

 بگذارید. offرا بر رويِ  motion vectorsبروید ، و گزینه يِ  Shaderيِ 

 MotionBlur3D. در واقع می خواهید تکمه يِ می گویید که بردارهايِ حرکتی را نسازد ScanlineRenderبا این کار ، به تکمه يِ 

 بردارها را بسازد.این 

2. Filter > MotionBlur3D  را برگزینید تا تکمه اي به همین نام درscript  ِتکمه ي جاي بگیرد. این تکمه را به بیرون رفت

ScanlineRender .بچسبانید 

3.  دوربینی که کارِ پردازش را انجام می دهد را به درون رفتcam  ِاز تکمه يMotionBlur3D  بچسبانید. به یاد داشته باشید که این

 .دوربین باید دوربینی باشد که جا به جا می شود. جا به جایی دوربین در زمانِ شاتر می باید خطّی ، و یا کم و بیش خطّی باشد

را به کار بگیرید و جایی را برگزینید که بردارهايِ حرکتیِ  Output UV، گزینه يِ  MotionBlur 3Dتکمه يِ  propertiesدر قابِ  .4

 ساخته شده ذخیره شوند. اگر کانال هایی که برگزیدید را به نمایش بگذارید می بینید که اکنون آن ها داراي بردارهايِ حرکتی هستند.

5. Filter > VectorBlur  را برگزینید تا تکمه اي به همین نام درscript  ِجاي بگیرد. آن را به تکمه يMotionBlur3D .بچسبانید 

از فهرست پایین افتادنیِ ،  VectorBlurتکمه يِ propertiesدر قابِ  .6

uv channels .لایه يِ حرکتی را برگزینید 

 بنویسید. vو  uرا براي هر دو گزینه يِ  Add  ،1براي پیکربندي هايِ  .7

 Addارزشِ گزینه يِ باید براي عکس هايِ آنامورفیک ،  یادداشت :

u و ارزشِ گزینه يِ  2 را برابر با ،Add v  بگیرید 1را. 

 forwardرا بر رويِ  methodبراي بهبود برآیند کار ، گزینه يِ  .8

است ، ولی  backwardدقیق تر از الگوریتمِ یک  forwardبگذارید. 

 به زمان بیش تري براي پردازش نیاز می شود.

تنها زمانی درست از کار در می آید که بردارهايِ حرکتی پیوسته باشند ، و هیچ تغییري از نظر پارگی در لبه يِ  backwardالگوریتمِ 

 اشیاء وجود نداشته باشد.

 را میزان کنید. Shutterبروید و پیکربنديِ  MotionBlur3D تکمه يِ propertiesبراي میزان کردن درازايِ محو شدگی ، به قابِ  .9
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 Shutter بالايِ ارزشِ   Shutter پایین ارزشِ

 دیگر 3Dبا بردارهايِ حرکتی از برنامه هايِ  VectorBlurروشِ به کارگیريِ تکمه يِ 

1. Filter > VectorBlur 2نگاره يِ  یک را اجرا کنید تا تکمه اي به همین نام پس ازD  ردارِ حرکتی است ، جايکه داراي کانال هايِ ب

 بگیرد.

 کانال هایی را براي محو شدن برگزینید. channels، از فهرست پایین افتادنیِ  VectorBlurتکمه يِ  propertiesدر قابِ  .2

 برگزینید. uv channelsکانال هايِ بردار حرکتی را از فهرست پایین افتادنیِ  .3

 را نشان بزنید. alphaشده اند ، گزینه يِ  premultiplyاگر بردارهايِ حرکتی با کانالِ آلفا  .4

است ،  backwardیک الگوریتمِ دقیق تر از  forwardبگذارید.  forwardرا بر رويِ  methodبراي بهبود برآیند کار ، گزینه يِ  .5

 ولی به زمان بیش تري براي پردازش نیاز می شود.

تنها زمانی درست از کار در می آید که بردارهايِ حرکتی پیوسته باشند ، و هیچ تغییري از نظر پارگی در لبه يِ  backwardتمِ الگوری

 اشیاء وجود نداشته باشد.

 ها Point Cloud، یا  Axesبیرون فرستادنِ اشیاء هندسی ، دوربین ها ، نورها ، 

 FBXها را به درون یک پرونده يِ  point cloudو  axesمی توانید اشیاء هندسی ، دوربین ها ، نورها ،  WriteGeoبه کمک تکمه يِ 

).fbx یا (Alembic ).abc.بیرون بفرستید ( 

 بچسبانید. Sceneبسازید و آن را به یک تکمه يِ  WriteGeoیک تکمه يِ  .1

را برگزینید. سپس اشیایی که  abcیا  fbx، یکی از گزینه هايِ  file type، از فهرست پایین افتادنیِ  WriteGeoدر بخشِ کنترل هايِ  .2

 می خواهید به بیرون بفرستید را نشان بزنید :

• Geometries .هندسی صحنه را در یک پرونده می نویسد اشیاء : 

• Cameras .دوربین هايِ صحنه را در یک پرونده می نویسد : 

• Lights هندسی صحنه را در یک پرونده می نویسد (تنها  : اشیاء.fbx.( 

• Axes  :axes .هايِ صحنه را در یک پرونده می نویسد 

• Point cloud  :point cloud .هايِ صحنه را در یک پرونده می نویسد 

 را می نویسید : FBXاگر دارید پرونده هايِ  .3

 را نشان بزنید. ascii file formatبنویسید ، گزینه يِ  binary .fbxاگر نمی خواهید صحنه را به یک پرونده يِ  •



137 | N u k / U s e r  G u i d e  
 
 

Vahid Velayati 
 

 animate meshپویانمایی شده و فریم هايِ کلیدي در هر فریم ساخته شوند ، گزینه يِ  meshاگر می خواهید ورتکس هايِ  •

vertices  .را نشان بزنیدMesh  هايِ پویانمایی شده براي داده هاvertex point cache  ها را به کار می گیرند. پوشه اي

ها را در خود دارد. به طورِ پیش فرض ،  point cacheکه به دنبالِ نامِ پرونده آورده می شود و  fpc_شود با پسوند ساخته می 

animated mesh  ِاست و بنا بر این ، پوشه يpoint cache .ساخته نمی شود 

 : را برگزینید storage formatرا می نویسید ، گزینه يِ  Alembicاگر دارید پرونده هايِ  .4

• HDF  :.نیرومندي است که سازگاري پیشین را نگه می دارد یک فرُمت 

• Ogawa : .نیرومندي است که پردازش پرونده يِ سریع تر و پرونده هايِ کوچک تري را ارائه می کند یک فرُمت 

 را ذخیره کنید ؛ و نامی براي آن بنویسید. abc.یا  fbx.، به جایی بروید که می خواهید پرونده يِ  fileاز میدانِ  .5

را نشان  limit to rangeاگر می خواهید زمانی که دامنه يِ خاصی از فریم ها بیرون فرستاده می شوند تکمه از کار بیفتد ، گزینه يِ  .6

 به اجرا در بیایند. Writeدامنه يِ فریم هایی را بنویسید که می خواهید با این تکمه يِ  frame rangeبزنید. در میدان هايِ 

 نماهایی را برگزینید که می خواهید بیرون فرستاده شوند (مانند نمايِ چپ و راست براي پروژه هايِ استریوسکوپیک). .7

 را نشان بزنید. Executeدکمه يِ  .8

را  OKونده منظور شود. سپس دکمه يِ اگر نیاز باشد ، می توانید از پنجره يِ بازشو ، دامنه يِ فریمی را تغییر بدهید که می خواهید در پر .9

 کلیک کنید.

 یک نوار پیشرفت کار را نشان می دهد ، و پرونده اي که برگزیده اید در پوشه اي که مشخص کرده اید ذخیره می شود.

 3Dپردازشِ یک صحنه يِ 

صحنه يِ را به نمایش می گذارد. هنگامی که صحنه اي را می سازید ، برنامه يِ  OpenGLبه کمک پردازشِ سخت افزاريِ  3Dنمایشگرِ 

Nuke  ِبیرون رفتی از پرسپکتیوِ دوربینی که به تکمه يScanlineRender  بالا پردازش می کند. سپس نگاره تچسبانده شده است را با کیفی

جاي گرفته است فرستاده می شود ، و شما می توانید برآیند به دست آمده را پردازش شده به تکمه يِ بعدي که در درخت ترکیب بندي  2Dيِ 

 گذاشته اید بدهید. scriptبه درون رفت تکمه هايِ دیگري که در 

 را نیز بیرون می فرستد. Deepداده يِ  ScanlineRenderدر مسیر باشد ، تکمه يِ  Deepاگر یک تکمه يِ 

 آنپردازشِ یک صحنه و بیرون فرستادن 

 چسبانده شده باشد. ScanlineRenderببینید که دوربینِ پردازش کننده يِ صحنه به تکمه يِ  .1

2.  ت2نمایشگر را به وضعیD .برگردانید 

 که در صحنه دارید بچسبانید. 2Dرا به تکمه هايِ  ScanlineRenderبیرون رفت تکمه يِ  .3

 میزان کردن نمادهايِ پردازش

 است ، می توانید بر رويِ بیرون رفت پردازش شده تاثیر بگذارید. ScanlineRenderوناگونی که در تکمه يِ با میزان کردن کنترل هايِ گ

 را تغییر بدهید. global ambientرا برگزینید ، یا رنگprojection  براي نمونه ، می توانید براي پردازش هايِ گوناگون از صحنه الگويِ 
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 شرح کنترل
Transparency  ال است ، با بهت به اشیاء داده می شود. زمانی که این گزینه غیر فعکار انداختن این گزینه ، پیکربندي هايِ شفاّفی

 ) می شود.opaqueکانالِ آلفا به طورِ کامل کدر و مات (

Z-buffer ر انجام سریع ت اگر این گزینه را به کار بیاندازید ، لایه هايِ چندگوشه ساده سازي می شود ؛ و بدین سبب پردازش

 بگیرد.

Filter : یکی از گزینه هايِ زیر را برگزینید 

• Impulse  :رابر با ب، درست انجام نمی شود. هر پیکسلی که بیرون فرستاده می شود  یهیچ گونه فیلتر شدن

 همان پیکسلی است که به درون می آید.

• Cubic : .یک درون یابی نرم میانِ پیکسل ها انجام می گیرد. گزینه يِ پیش فرض است 

• Keys :  پیکسل ها کمی نرم شدگی وsharp کوچک دریافت می کنند. یشدن 

• Simon :  پیکسل ها کمی نرم شدگی وsharp میانه دریافت می کنند (*). یشدن 

• Rifman :  پیکسل ها کمی نرم شدگی وsharp ه یشدندریافت می کنند (*). قابل توج 

•  Mitchell :  و محو شدگی می گیرند تا نمايِ پیکسل ها کمی نرمpixelation پنهان شود )+.(* 

• Parzen :  پیکسل ها در این جا بیش ترین نرم شدگی را نسبت به همه يِ فیلترها دریافت می کنند. این گزینه

 .جلوگیري شود (+) sharpبر رويِ لبه هايِ  ringingرا به کار ببرید تا از 

• Notch : ) که تمایل به پنهان کردن الگوهايِ پیکسل ها نرم شدگیِ تختی را می گیرندMoiré .(+) (است 

• Lanczos4 : ِاندازه گزینه يِ خوبی است (*) براي کوچک سازي 

• Lanczos6 :  براي کوچک سازي اندازه همراه با کمیsharp گزینه يِ خوبی است (*). ، شدن 

• Sinc4 :  این گزینه را براي کوچک سازي اندازه کهsharp د ، برگزینید (*).شدن بیش تري داشته باش 

• Nearest :  سریع ترین و در عین حال ناپخته ترین فیلتر را به همراه دارد. از نزدیک ترینtexel ازmip 

map (%) مناسب نمونه می گیرد 

• Bilinear : ترازِ از و  انسداد را بر می دارد ؛mip map  ، چهار مناسبtexel  تر از همه هستند نزدیککه 

 نمونه گرفته و درون یابی می کند (%). را

• Trilinear :  ِبر حسب فاصله ، درون یابیِ نرمی از بافت انجام می دهد. به طورbilinear  ِمیانِ دو تراز

mipmap .(%) که نزدیک ترین هستند درون یابی می کند 

• Anisotropic : ت را به همراه دارد. هنگامی که رویه هايِ دارايِ بالاترین کیفیShading  زاویه يِ تُندي با

 نسبت به دوربین هستند ، برآیند به تري را به ارمغان می آورد (%).

(*) لُوب هايِ منفی دارد ؛ که می تواند ارزش هایی را بسازد که بیرون از دامنه يِ پیکسل  یادداشت :
 رفت هستند.هايِ درون 

 زمانی که جا به جا نمی شوند ، تغییر می دهد.پیکسل ها را (+) بدون درون یابی ، حتا 
، جدا از بخشِ نمونه گیري که درخواست شده است. این در  )constant time( (%) فیلترِ زمانی پایدار

زمان تغییر می کند  با گذشترا می سازد و هنگامی که بافت  mip map ، ترازهایی از زمانِ پردازش
  .به جا بگذاردکاربردي  يتاثیرمی تواند ، 
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Antialiasing  پایین افتادنیِ از فهرستantialiasing قطع شدگی ( ترازچند  یکسلهر پکه  می توانید معلوم کنیدintersection (

 داشته باشند.شده  antialiase داشته باشد تا چند گوشه هایی به دست بیاید که لبه ها و تقاطع هايِ Z Testو 

Z-blend mode  دو رویه اي که در دامنه يِ به هم آمیختنِ براي  مشخص کنیدمی توانید  فهرست پایین افتادنیاز اینZ-blend  هم

سازگاري با نسخه  linearبه تر به چشم می آید ، ولی  smoothبه کار برود ( rampچه الگويِ دیگر هستند ، 

 هايِ پیشین را ممکن می سازد).

Z-blend range  لغزنده يِ با به کار بردنZ-blend range در هم  از یک سويِوانید میان دو اشیایی که با هم برخورد دارند ، می ت

 پیکربندي کنید.یک نرم شدگی را  )blending transition( تا سويِ دیگرِ  آن آمیختگی

Projection 
mode 

 یکی از گزینه هايِ زیر را می توانید برگزینید :

• Render camera این گزینه را برگزینید. : براي معلوم کردن الگويِ پروجکشنِ دوربینِ پردازش کننده ، 

• Perspective  براي این که :focal length  وaperture  دوربین را داشته باشید تا بشود براي اشیایی

 که در جلويِ دوربین هستند توهمی از ژرفا را تعریف کنید ، این گزینه را به کار بگیرید.

• Orthographic  ِبراي پروجکشنِ اُرتوگرافیک (پروجکشن بر روي :projection plane  به کمک

 پرتوهايِ موازي) این گزینه را برگزینید.

• uv ر این گزینه را برگزینید ، براي هر شیء فضايِ : اگUV  بیرون رفت پردازش می شود. می آن در فُرمت

 توانید این گزینه را براي پخت نگاشت هايِ بافتی به کار ببرید.

• Spherical  ِگوي کاملی درجه اي  360: با برگزیدن این گزینه یک دنیاي دارید که به شکلِ یک نگاشت

 می شود.مانند پردازش 

Tessellation 
max 

 است. spaceو  screenتقسیمات محدود به فاصله اي می شود که میان 

Overscan  چپ و راست ، و بالا و پایین می باید بیش ترین پیکسل هایی که در ورايِ لبه هايِ فریم از دو سمت براي تعریف

 هتکم اگر تکمه هایی که پس از اینبه دست بگیرید.  توانیدرا می  overscanپردازش شوند ، میدان یا لغزنده يِ 

ورايِ لبه هايِ  پیکسل هایی که درمی آیند نیاز داشته باشند که به بخشِ بیرونیِ فریم نیز دست بیابند ، پردازش کردن 

رخت را در نظر بگیرید که در پایین دست د Blurهستند خیلی به کارتان می آید. براي نمونه ، یک تکمه يِ فریم 

 تکمه اي جاسازي می کنید تا به کمکoverscan  .رِ لبه هايِ فریم به دست بیاوریدر تا دوبتوانید برآیند به تري دو

را ممکن  overscanنیز که از پیِ تکمه می آید نیاز به گزینه يِ  LensDistortionدرست مانند همین ، تکمه يِ 

 می سازد. 

Ambient  ِجهانی رنگambient  .کلی بیافزاید می تواند به بخش هایی که با چشمه هايِ نور روشن سازي نشده اند یک رنگ

 1(سیاه) و  0را بکشید ، و یا ارزشی میان  ambientبدون این رنگ ، این بخش ها تاریک خواهند بود. لغزنده يِ 

 (سفید) را در میدانِ درون رفت بنویسید.

 3D به یک صحنه يِ Motion Blurافزودنِ 

 بروید و گزینه هایی که در آن جا هست را میزان کنید. MultiSample، به برگه يِ  3Dبه یک صحنه يِ  Motion Blurبراي افزودن 
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 Stereoscopicپروژه هايِ  ____________________________

تا هر چند نمایی  در واقع محدود به نماهايِ استریوسکوپیک نیست ، ولی Nukeراه کننده است ؛ چون برنامه يِ مسرنامه يِ این بخش کمی گ

 ) را پشتیبانی می کند.multi-viewکه نیاز داشته باشید (

 یک آغازِ تنُد و سریع

چندین راه به شما این امکان را می دهد که بر رويِ مایه يِ استریوسکوپیک ، درست به مانند هر نگاره يِ دیگري کار کنید.  از Nukeبرنامه يِ 

که مخصوصِ کارهايِ استریو بوده و زمانی که با کارهايِ ترکیب بنديِ  هستندهايِ خیلی کمی هم ها و تکمه یکربندي هر روي ، پبه 

دا می کنید ، می باید این چیزها را بدانید. در زیر به شما آموزش می دهیم که چگونه پروژه يِ استریو را راه اندازي استریوسکوپیک سر و کار پی

 .کنید ، نگاره هایتان را خوانده و به نمایش بگذارید ، تکمه هايِ استریوسکوپیک را به کار گرفته ، و بیرون رفت نهایی را پردازش کنید

 ه و سریع خواهیم داشت بر گردشِ کاري :در این جا مروري کوتا

 نخستین کاري که باید انجام بدهید این است کهمی کنید ، پیدا کار سر و  Nukeکوپیک در وسزمانی که با عکس ها و فیلم هايِ استری .1

را فشار  Sه هستید ، کلید ک Node Graphراه اندازي کنید (می توانید در پنجره يِ نماهایی را آن ها در پیکربندي هايِ پروژه تان براي 

 را فشار بدهید. Set up views for stereoبروید و دکمه يِ  Viewsبدهید تا پنجره يِ پیکربندي هايِ پروژه باز شود). به برگه يِ 

یلم تان ، عکس یا ف JoinViews، و یا با به کارگیري تکمه يِ  file nameپس از این می توانید یا با نوشتن یک متغیر در میدانِ  .2

)footage ( ِرا به درون برنامه يNuke .بارگذاري کنید 

. هم چنین می توانید نماها را کنار نشان داده شودنمایی مشخص کنید چه  viewsدر پنجره يِ نمایشگر ، می توانید به کمک دکمه هايِ  .3

 با هم یکی کنید. MixViewsو  SideBySideیا آن ها را به کمک تکمه هايِ  چیده و به نمایش بگذاریدبه کنار هم 

4.  گاهی نیاز می شود که یک نما را تغییر داده و نمايِ دیگر به همان شکلی که هست بماند. در این گونه جاها می باید یا به کمکView 

menu ) یک نما را جدا کنیدsplit و یا در مورد ، (RotoPaint  گزینه هايِ راست کلیک را در فهرست ،stroke/shape  به کار

 بگیرید و نماها را از هم جدا کنید.

 یک نما را جدا کنید. OneViewاگر نیاز باشد که در دو نما کارکردهايِ کاملاً گوناگونی را به انجام برسانید ، می توانید به کمک تکمه يِ 

نیز به  View menuو  RotoPaintه يِ در تکمبه آن را وجود داشته باشد ، می توانید گزینه هايِ وابسته  disparityیک میدان اگر  .5

 کار ببرید تا تغییراتی که در یک نما می دهید خود به خود در نمايِ دیگر بازسازي شود.

می توانید عکس یا فیلم تان  Anaglyphمی توانید نماهایتان را دوباره بازچینی کنید ؛ و با تکمه يِ  ShuffleCopyبا تکمه يِ  .6

)footage (را به یک عکس یا ) قرمز و فیروزه اي فیلمِ آناگلیفCyan.برگردانید ( 

. با بچرخانیدراست و چپ را به سمت داخل  ) را دوباره میزان کرده ، یا دوربین هايِ نمایشconvergenceِگاهی نیاز دارید همگرایی ( .7

 نگاره را نگاه می کنید ، نقطه اي در نگاره که در ته صفحه نمایش پدیدار می شود تغییر می کند. 3Dبا یک عینک این کار ، زمانی که 

 و پردازش آن به بیرون ، پیش نمایش بدهید. flipbookدر پایان ، می توانید یک نما از پروژه يِ استریو تان را با انجام  .8

 scriptراه اندازي کردن نماها براي 
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گاره هايِ استریوسکوپیک را آغاز کنید ، می باید در بخشِ پیکربندي هايِ پروژه براي چشمِ چپ و راست نماهايِ گوناگونی پیش از این کار با ن

ما در هر ن را پیکربندي کنید. بدین سان می توانید هر یک از نماها را جدا از هم یا هر دو را با هم آماده سازي کرده ، و تغییراتی که می دهید را

 ببینید.

 اه اندازي کردن نماها براي پروژه تانر

1. Edit > Project Settings .را برگزینید 

 فهرست می شوند. viewsبروید. نماهایی که موجود باشند در میدان  Viewsبه برگه يِ  .2

 

 

 Set up viewsرا بیافزایید ، بر رويِ دکمه يِ  rightو  leftرا پاك کرده و نماهایی به نام هايِ  mainاگر می خواهید نمایی به نامِ  .3

for stereo .گوناگون تعریف می شوند. براي تغییر دادن رنگ ها ، بر رويِ میدانِ  کلیک کنید دو نما با رنگcolor  دو بار کلیک کنید

 که باز می شود رنگ دیگري را برگزینید. color pickerو از پنجره يِ 

، نشانگرهايِ نماهايِ جدا شده  Node Graphرا نشان بزنید ، این رنگ ها در اتصالات پنجره يِ  ?Use colors in UIاگر گزینه يِ 

نیز به کار گرفته می شوند که تمایزِ میان نماها را آسان   ShuffleCopyبر رويِ تکمه ها ، و کنترل هايِ پنجره يِ نمایشگر و تکمه يِ 

 تر می کنند.

  

 را فشار بدهید. +جدید دیگري بیافزایید ، دکمه يِ  اگر می خواهید نمايِ .4
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 را بزنید. OK). کلید mainگفت و گویی که باز می شود ، نامی براي نما بنویسید (براي نمونه ،  در پنجره يِ .5

ید مِ نما است ، می توانتکرار کنید. با دو بار کلیک کردن در بخشی که در سمت راست ناتا هر چند نمایی که بخواهید را ،  5و  4گام هايِ  .6

 به هر یک از نماها رنگی را تعریف کنید.

  

کلیک کنید. به  deleteاگر نمایی را نمی خواهید می توانید آن را پاك کنید. براي این کار ، نما را از فهرست برگزیده و بر رويِ دکمه يِ  .7

پاك نمی شوند ؛ و هر تکمه اي که به نمايِ پاك شده  scriptاز  یاد داشته باشید با پاك کردن یک نما مرجع هایی که به آن نما دارید

 فرستاده شده است پیامِ خطایی را نشان می دهد.

را بر  heroاگر می خواهید هر بار که پروژه را بارگذاري می کنید بر رويِ نمایی که می خواهید نشان داده شود ، فهرست پایین افتادنیِ  .8

 رويِ آن نما بگذارید.

از کنترل هايِ تکمه ، می توانید به نماهایی که در پروژه دارید دست بیابید. هم چنین توجه داشته باشید که هر  viewاز فهرست پایین افتادنیِ 

 نما در بخشِ کنترل هايِ نمایشگر ، دکمه يِ خودش را دارد.

به شکلِ دکمه هايِ جداگانه در بخشِ کنترل هايِ هر تکمه و نمایشگر اگر چندین نما ساخته باشید ، شاید بخواهید آن نماها ، به جايِ این که 

در قابِ  ،پدیدار شوند ، در یک فهرست پایین افتادنی به نمایش گذاشته بشوند. براي این کار (به کارگیريِ نماها از فهرست هايِ پایین افتادنی) 

Project Settings  ِبه برگه يViews  ِبروید و نشانِ گزینه يView selection uses buttons? .را بردارید 

 

اگر نیاز دارید که در پروژه هايِ گوناگون ، درست همین نماها را به کار بگیرید ، می باید نماهایی که ساخته اید را در یک پرونده يِ 

template.nk script .ذخیره کنید 

 )Multi-Viewبارگذاريِ نگاره هايِ چند نمایی (

خوانده می شوند. براي آسان تر کردن کار ، به تر است نگاره هایی که می  Nukeبا راه اندازي کردن نماها ، نگاره هایتان به درون برنامه يِ 

، یا  filename.left.0001.exr  ،filename.l.exrخوانید نامِ نما و یا نخستین نویسه از نامِ نما را در نامِ خود داشته باشند ؛ براي نمونه : 

lefteyefilename.0001.cin. 
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کار می کنید ، پرونده هایتان می توانند هم درون رفتی براي چشمِ چپ و هم درون رفتی براي چشمِ راست داشته  exr.اگر دارید با پرونده هايِ 

دیگري که کار می کنید ، می باید پرونده  چندین نما را در یک پرونده پشتیبانی می کنند. با هر نوع پرونده يِ exr.باشند ؛ یعنی پرونده هايِ 

 چپ و راست داشته باشید.هايِ جداگانه اي را براي درون رفت هايِ 

 خواندنِ نگاره ها

1. Image > Read .را اجرا کنید 

به جایی بروید که پرونده اي دارید که دارايِ نگاره هایی است که یا براي چشمِ چپ و یا براي چشمِ راست درخواست می شود (یا در  .2

 را فشار بدهید. Open، هر دو چشم).  exr.مورد نگاره هايِ 

 یکی از کارهايِ زیر را انجام بدهید : .3

در نام هايِ پرونده  )r، یا  left  ،right  ،lو یا نخستین نویسه از آن را (براي نمونه ، اگر نگاره هایی که می خواهید بخوانید نامِ نما  •

را براي جایگزین کردن  V%جایگزین کنید.  v%، یا  V%، آن را با متغیر  Readاز کنترل هايِ تکمه يِ  fileشان دارند ، در میدانِ 

) به کار ببرید. rیا  lنخستین (براي نمونه ،  را براي جایگزین کردن نویسه يِ v%) ، و rightیا  leftنامِ کاملِ یک نما (براي نمونه ، 

درون رفت را در تنها یک  گم شده را می خواند و همه يِ درون رفت هايِ Nukeهنگامی که متغیر را به کار می گیرید ، برنامه يِ 

 بیرون رفت با هم ترکیب می کند.

هر دو نگاره يِ  Nukeتغییر بدهید ، برنامه يِ  image.%V.cinرا بخوانید و نام را به  image.left.cinبراي نمونه ، اگر 

image.left.cin  وimage.right.cin  ِرا با همان تکمه يRead  ِمی خواند ؛ و نماهایی به نامleft  وright ِرا در پنجره ي 

project settings ِدر یک بیرون رفت با هم ترکیب می شوند. درون رفت تان فراهم می کند. هر دو نگاره ي 

نویسه  در نام گذاريِ نماهايِ چپ و راست ، کار می کنید ، می باید Linuxیا  Macاگر دارید با سیستمِ عاملِ  یادداشت :

یستمِ را نمی شناسد. در س Rو  Lبزرگ نویسه هايِ  v%رِ ) بنویسید. متغیlower caseکوچک ( را با نویسه يِ rو  lهايِ 

Windows .می توانید با هر کدام از نویسه هايِ بزرگ و کوچک بنویسید 

رهايِ متغی%V  و%v ) را می توانید در یک ترازِ پوشه ايdirectory ِنیز به کار بگیرید. براي نمونه ، گمان کنید نماهایی به نام (

testleft  ،testmiddle  و ،testright زیر را دنبال دارید :نده ها و پوشه هايِ را راه اندازي کرده اید و پرو 

mydirectory/testleft/image.testleft.cin 
mydirectory/testmiddle/image.testmiddle.cin 
mydirectory/testright/image.testright.cin. 

تغییر بدهید ، هر سه  mydirectory/%V/image.%V.cinرا بخوانید و مسیرِ آن را به  image.testleft.cinاگر نگاره يِ 

 خوانده می شوند. Readدرون رفت در همان تکمه يِ 

در نامِ  )r، یا  left  ،right  ،l(براي نمونه ، اگر نگاره هایی که می خواهید بخوانید ، نامِ یک نما یا نخستین نویسه از نامِ آن را  •

سپس به به کار ببرید و  Read اید براي هر درون رفت یک تکمه يِنیستند ، ب ییاستریو exr. و پرونده هايِ ندارندپرونده اي شان 

 آن را در یک بیرون رفت با هم ترکیب کنید. JoinViewsکمک تکمه يِ 
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•  اگر نگاره هایی که می خواهید بخوانید با فرُمت.exr  استریویی هستند ، نیاز نیست کاري انجام بدهید. به هر روي ، به یاد داشته

کار می کنید که استریویی نیست ،  exr.استریویی نیستند. اگر با پرونده يِ exr.، پرونده هايِ  exr.باشید که همه يِ پرونده هايِ 

 آموزش هایی که در دو گامِ نخست گفته شد را دنبال کنید.

 کردن نماهايِ گوناگون در یک بیرون رفت ، هنگامی که نماها در نام هاي پرونده نشانده نشده اندترکیب 

1. Image > Read  را برگزینید. سکانس هايِ نگاره هایی که نماهايِ گوناگون

 دارند را به درون برنامه بخوانید.

 Viewsبیاورید. براي این کار دستورِ  scriptرا در  JoinViewsیک تکمه يِ  .2

> JoinViews .را اجرا کنید 

بچسبانید. براي  Readرا به تکمه هايِ  JoinViewsهايِ تکمه يِ درون رفت  .3

ساخته اید ، درون رفتی خواهید  Project Settingsهر نمایی که در پنجره يِ 

 داشت. درون رفت ها با نامِ نما برچسب خورده اند.

 Project Settingsاز پنجره يِ  Viewsرا در برگه يِ  ?Use colors in UIو گزینه يِ اگر رنگ ها را براي نماها تعریف کرده باشید 

می چسبانند ، رنگ نماها را بازتاب می دهند.  JoinViewsرا به درون رفت تکمه يِ  Readنشان زده باشید ، پیکان هایی که تکمه هايِ 

می شوند ؛ و ممکن است درون رفت ها را به جايِ اشتباهی بچسبانید. براي این اگر این کار را نکنید ، پیکان ها به رنگ سیاه نشان داده 

 بچسبانید ، این گزینه را نشان بزنید. JoinViewsرا به درون رفت درست از تکمه يِ  Readکه هر تکمه يِ 

 درون رفت ها را در یک بیرون رفت با هم ترکیب می کند.همه يِ  Nukeبرنامه يِ 

 ن نماها در پنجره يِ نمایشگربه نمایش گذاشت

هستند را به نمایش بگذارید. براي این که فهرستی از این نماها را ببینید ، یا نماها  Project Settingsمی توانید تنها نماهایی که در پنجره يِ 

 بروید. Viewsرا اجرا کنید و به برگه يِ  Edit > Project Settingsرا افزوده و یا پاك کنید ، دستورِ 

 به نمایش گذاشتن یک نمايِ بخصوص

 تان بیافزایید. scriptیک نمایشگر (اگر نیست) به  .1

 در کنترل هايِ بالايِ نمایشگر ، کارهايِ زیر را انجام بدهید : .2

نشان زده اید ، دکمه يِ نمایی که می  Project Settingsرا در پنجره يِ  ?View selection uses buttonsاگر گزینه يِ  •

را  rightرا فشار بدهید (البته اگر نمایی به نامِ  Rightواهید در نمایشگر به نمایش در آید را کلیک کنید. براي نمونه ، دکمه يِ خ

 پایین ، سمت راست). (نگاره يِ تان تعریف کرده باشید) scriptدر 

نشان نزده باشید ، نمایی که می خواهید  Project Settingsرا در پنجره يِ  ?View selection uses buttonsاگر گزینه يِ  •

 پایین ، سمت چپ). به نمایش در آید را از فهرست پایین افتادنی برگزینید (نگاره يِ
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 forward( ‘) و semicolon( ;نمایشگر ، می توانید کلیدهايِ گوناگون در پنجره يِ  براي جا به جا شدن میان نماهايِ نکته :

single quote (.را نیز فشار بدهید 

 به نمایش گذاشتن دو نما در کنار هم دیگر

 تان بیافزایید. scriptیک نمایشگر (اگر نیست) به  .1

 ، نماهایتان را در یک بیرون رفت با هم ترکیب کنید. JoinViewاگر لازم باشد ، به کمک یک تکمه يِ  .2

3. Views > Stereo > SideBySide ن نام در جایی مناسب از را اجرا کنید تا تکمه اي به همیscript .بنشیند 

، دو نمایی را برگزینید که می خواهید در  view2و  view1 ، از فهرست پایین افتادنیِ SideBySideتکمه يِ در بخشِ کنترل هايِ  .4

 در سمت راست چیدمان می شود. view2در سمت چپ ، و  View1کنار هم به نمایش در آیند. 

را نشان بزنید.  verticalدیگر چیدمان شود ، گزینه يِ  نمايِجاي این که نماها در کنار هم بنشینند ، یک نما در بالايِ اگر می خواهید به  .5

view1  ِدر بالايview2 .می نشیند 

 را فشار بدهید. swapنمایشگر با هم عوض کنید ، دکمه يِ اگر می خواهید جايِ نماها را در پنجره يِ  .6

 نمایشگر دو نما را هم زمان با هم به نمایش می گذارد و می توانید به آسانی آن ها را با هم بسنجید. پنجره يِ

 

 ) میان دو نماblendبه نمایش گذاشتن یک در هم آمیختگی (

 تان بیافزایید. scriptیک نمایشگر (اگر نیست) به  .1

 ر یک بیرون رفت با هم ترکیب کنید.، نماهایتان را د JoinViewاگر لازم باشد ، به کمک یک تکمه يِ  .2

3. Views > Stereo > MixViews  را اجرا کنید تا تکمه اي به همین نام در جایی مناسب ازscript  بنشیند. این تکمه یک در هم

 اها چیدمان کنید.نمایشگر به نمایش می گذارد ؛ و به شما اجازه می دهد که چگونه عناصر را در این نمآمیختگی از دو نما را در پنجره يِ 
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، براي برگزیدنِ دو نمایی که می خواهید با هم آمیخته شوند ، دکمه ها یا فهرست هایی پایین  MixViewsتکمه يِ در بخشِ کنترل هايِ  .4

 را به کار بگیرید. viewsافتادنیِ 

بگذارید ، تنها یکی از نماها  1یا  0ده را بر رويِ را میزان کنید. اگر لغزن Mixبراي کنترل کردن این در هم آمیختگی میان نماها ، لغزنده يِ  .5

 باشند ، آمیختگیِ گوناگونی از دو نما را نشان می دهند. 1و  0به نمایش در می آیند. ارزش هایی که میان دو ارزشِ 

 

 برگزیدن نماهایی که می خواهید به آن ها تغییرات بدهید

هر تغییري که به همه يِ نماهايِ تکمه می دهید را انجام می دهد. اگر می خواهید این تغییرات تنها به  Nukeبه طورِ پیش فرض ، برنامه يِ 

 :یک نما داده شود (براي نمونه ، نمايِ چپ تغییر کند ولی نمايِ راست تغییر نکند) ، می باید نخست یکی از کارهايِ زیر را انجام بدهید 

 ) کنید.splitبخشِ کنترل هايِ تکمه نماي را جدا (در بیش تر تکمه ها ، می توانید در  •

در بخشِ کنترل هايِ تکمه ، نمایی را برگزینید که می خواهید رويِ  view، از فهرست پایین افتادنیِ  RotoPaintدر تکمه هايِ  •

 آن کار بشود.

نجام بدهید ولی ارزش هايِ گوناگونی را براي آن به کار این روش ها ، براي نمونه ، زمانی که می خواهید کارکرد یکسانی را بر رويِ دو نما ا

 بگیرید ، به کارتان می آید.

 جدا کردن نماها

 این امکان براي شما فراهم شده است که براي انجام تغییرات به نماها به شکلی جدا از هم ، آن ها را از یک دیگر جدا کنید. Nukeدر برنامه يِ 

 روشِ جداسازيِ یک نما

تان جاي  scriptاز  ) در جایی مناسبColorCorrectبراي آماده سازي (براي نمونه ، یک تکمه يِ یک تکمه  .1

 بدهید.

بچسبانید. از بخشِ کنترل هايِ نمایشگر ، نمایی را برگزینید که می خواهید تغییرات در آن  1را به تکمه يِ گامِ  Viewerیک تکمه يِ  .2

 انجام بگیرد.

 د.کنترل هايِ تکمه را باز کنی .3

 Split offدر کنارِ کنترلی که می خواهید آن را میزان کنید ، کلیک کنید. از فهرستی که باز می شود ،   viewبر رويِ دکمه يِ  .4

[view name]  ِرا برگزینید. براي نمونه ، اگر می خواهید تغییراتی به نمایی به نامleft  ِبدهید ، گزینه يSplit off left  .را برگزینید

 از فهرست راست کلیک ، همه يِ کنترل هايِ تکمه را جداسازي کنید. Split all knobsمی توانید با برگزیدنِ  هم چنین
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یک نقطه يِ سبز رنگ افزوده می  Node Graphپدیدار می شود و به خود تکمه در پنجره يِ   viewیک نشانِ چشم بر رويِ دکمه يِ 

 شود که نشان می دهد این نما جداسازي شده است.

را در پنجره يِ  ?Use colors in UIاگر رنگ هایی را براي نماهایتان تعریف کرده باشید و گزینه يِ 

Project Settings  نشان زده باشید ، نقطه هایی بر رويِ تکمه نمایان می شوند که نشان می دهند نماها

اگر قرمز را براي نمايِ چپ به کار برده و آن را جداسازي کرده باید ، نقطه از هم جداسازي شده اند. براي نمونه ، 

 يِ قرمز بر رويِ تکمه پدیدار می شود.

انجام بدهید تنها به نمایی که جداسازي شده داده می شود. به نماهايِ  هر تغییري که اکنون به کمک کنترل ها

 دیگري که هنوز جداسازي نشده باشند ، تغییرات داده نمی شود.

 روشِ نشان دادن ارزش هايِ جداگانه براي هر نما

ید. به آسانی بر رويِ پیکانِ کوچک در سمت هنگامی که یک نمايِ جداسازي شده دارید ، می توانید تغییرات را جداگانه به نماهايِ موجود بده

 ببینید. هر نما را براي ارزش ها این کار کنترل را تقسیم می کند که می توانیدچپِ کنترلی که جداسازي شده است کلیک کنید. 

 

 ) نماهاunsplitبه هم چسباندن (روشِ 

 کلیک کنید.  viewدر بخشِ کنترل هايِ تکمه ، بر رويِ دکمه يِ  .1

را دوباره بچسبانید ، گزینه  leftرا برگزینید. براي نمونه ، اگر می خواهید نمايِ  Unsplit [view]از فهرستی که باز می شود ، گزینه يِ  .2

 را برگزینید. Unsplit leftيِ 

 را دوباره انجام بدهید. 2اگر می خواهید همه يِ نماها را دوباره بچسبانید ، گامِ  .3

 شود و هر تغییري که پس از جداسازي نما انجام داده باشید از دست می رود. نما دوباره چسبانده می

 کار می کنید RotoPaintبرگزیدن یک نما براي آماده سازي ، زمانی که دارید با تکمه يِ 

 براي برگزیدن یک نما براي آماده سازي :

 را باز کنید. RotoPaintکنترل هايِ تکمه يِ  .1
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ماها ن آن کار کنید. براي این که در یک زمان تغییرات را به همه يِ، نمایی را برگزینید که می خواهید رويِ  viewاز فهرست پایین افتادنیِ  .2

 بدهید ، همه يِ آن ها را جدا جدا برگزینید.

ذاشته نمایشگر به نمایش گاگر تنها یک نما را برگزیده باشید ، مطمئن شوید هنگامی که تغییرات را به نما می دهید ، همان نما در پنجره يِ  .3

 شده باشد.

 انجام دادن کارکردهايِ گوناگون بر رويِ نماهايِ گوناگون

 OneViewبراي جدا کردن یک نما از یک تکمه يِ در جایی که نیاز دارید کارهايِ کاملاً گوناگونی را بر رويِ دو نما انجام بدهید ، می توانید 

 کمک بگیرید.

 ارپردازيبیرون کشیدن یک نما براي ک

1. Views > OneView  را برگزینید تا تکمه اي به همین نام در جايِ مناسب درscript .تان جاي بگیرد 

 ، نمایی را برگزینید که می خواهید به آن تغییرات بدهید. viewدر بخشِ کنترل هايِ همین تکمه ، از فهرست پایین افتادنیِ  .2

تغییري که بدهید تنها به نمایی که برگزیده بودید داده می شود (جدا از این که این نما در پنجره يِ همه يِ نماها بیرون کشیده می شوند ، و هر 

 نمایشگر نشان داده می شود یا نه).

 برگزینید. OneViewتکمه يِ  viewبراي آن که تغییرات را به نمايِ دیگري بدهید ، آن نما را از فهرست پایین افتادنیِ 

را برگزینید تا نماها با هم ترکیب شوند (یا می توانید  Views > JoinViewsاز مسیرِ جدا از هم را با هم دیگر یکی کنید ،  براي این که دو نما

 تان پاك کنید). scriptرا از  OneViewتکمه يِ 

 وار آیتمِ فهرستا هم یکی بکنید ، اگر نیاز باشد که همه يِ نماها را بیرون بکشید ، و سپس آن ها را یکی یکی آماده سازي کرده و دوباره ب

Split and Join  در واقع ترکیبی از دو تکمه يِ  آیتمرا به دست بگیرید. اینOneView  وJoinViews  .نخست همه يِ  این آیتماست

گر یکی می کند. کاري بیرون کشیده و سپس دوباره آن ها را با هم دیکرده اید  راه اندازيتان  Project Settingsنماهایی که در پنجره يِ 

را به کار ببرید ، ولی در این جا سرعت  JoinViewsو  OneViewکه با این آیتم انجام می دهید هیچ تفاوتی با این ندارد که چندین تکمه يِ 

 Viewsدستورِ کار بیش تر است ؛ چون نمی خواهد براي جدا کردن هر نما یک تکمه به کار بگیرید. براي دسترسی به این آیتم فهرست وار 

> Split and Join .را اجرا کنید 

ساخته باشید  rightو  leftنماهایی به نام هايِ  Project Settingsبراي نمونه ، اگر در پنجره يِ 

را به کار ببرید ، درخت تکمه اي روبرو را  Split and Joinآیتمِ  Read، و پس از تکمه يِ 

  خواهید داشت :

را میان تکمه هايِ  ها) color correctionپس از این می توانید هر تکمه اي که بخواهید (مانند ، 

OneView  وJoinViews .بیافزایید 

 داده ایدتکثیر دادن تغییراتی که به یک نما 
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اه نگاره وابسته هستند ، می توانید ، ساخت جلوه هايِ رنگ آمیزي ، یا انجام دادن دیگر کارکردهایی که به جایگ Rotoscopingبه هنگامِ 

و هر تکمه  Roto، تکمه يِ  RotoPaintتغییراتی که در یک نما ایجاد می کنید را خود به خود در نماهايِ دیگر تکثیر کنید. این به تکمه يِ 

 دارايِ کنترل هستند. yو  xیی داده می شود که براي مختصات ها gizmoيِ دیگر ، گروه ها ، یا 

نیاز دارید که جايِ یک  disparityها ساخته شده اند ، به یک دامنه يِ  gizmoبراي تکثیر کردن تغییراتی که با تکمه هاي بالا ، گروه ها ، یا 

 Foundary’s O_DisparityGeneratorپیکسل را در یک نما به جایگاه پیکسل متناظرش در نمايِ دیگر نگاشت کند. به کمک پلاگینِ 

 disparityرا بسازید. هر گاه میدانِ  disparityمی توانید یک میدانِ  3Dآورده شده است) ، یا یک برنامه يِ  Oculaجموعه پلاگین (که در م

در مسیر داده اي (جایی که  disparityبراي افزودن کانال هايِ یا  ،ذخیره کرده  exr.را دارید ، می توانید آن را در کانال هايِ یک پرونده يِ 

 را به کار بگیرید. ShuffleCopyآن نیاز دارید) ، یک تکمه يِ  به

 Yو  Xتکثیر کردن ارزش هايِ 

و برابر داشته باشید ، می توانید خود به خود ارزش هايِ  yو  xبراي یک نما ، ارزش هایی را براي هر کنترلِ  Nukeهر زمان که در برنامه يِ 

ها صدق می کند. براي نمونه ، می توانید به کمکgizmo  هم براي تکمه ها و هم براي  که گفتیمکنید. این درست براي نماهايِ دیگر  همسان را

ردیابی شده اي را داشته باشید که خود به خود براي نمايِ  yو  xچیزهایی را در یک نما ردیابی کنید ؛ و سپس جایگاهTracker  یک تکمه يِ 

 دیگر ساخته می شود.

 براي یک نما و خود به خود ساخته شدن ارزش هایی همسان براي نماهايِ دیگر yو  xرزش هايِ روشِ ساخت ا

باشد. اگر سکانسِ تصویري تان یک  disparityیک میدانِ  ، با آن سر و کار نخست باید ببینید که در بالادست سکانسِ تصویري که .1

ل هايِ آن آورده شده باشد. وگرنه ، می توانید به کمک یک تکمه يِ می تواند در کانا disparityاست ، میدانِ  exr.پرونده يِ 

ShuffleCopy  یا پلاگینO_DisparityGenerator  ِاز مجموعه يOcula  ِیک میدانdisparity .به مسیرِ داده اي بیافزایید 

 ، جاي بدهید.باشد را پس از سکانس تصویري که با آن سر و کار دارید  yو  xتکمه اي که دارايِ کنترلِ  .2

 .انجام بدهیدافزوده اید بچسبانید ، و تغییرات تان را در یک نما  scriptرا به تکمه اي که در گامِ پیشین به  Viewerیک تکمه يِ  .3

4.  از فهرستView ِکه در کنارِ کنترل هاي x  وy  ِاست ، گزینه يCorrelate [view] from [view] using disparity  براي)

برابر و همسان در نمايِ دیگر  yو  x) را برگزینید. با این کار ، ارزش هايِ Correlate right from left using disparityنمونه ، 

 ساخته می شود.

 

 Correlate [view] fromرا در برنامه داشته باشید ، می توانید گزینه يِ  The FoundaryشرکتOcula  اگر پلاگین هايِ 

[view] with ocula  ِرا نیز برگزینید. بدین سان ، هنگامی که ارزش هايx  وy  همسان ساخته می شوند ، پالایش هايِ دیگري نیز

 برآیند کار دقیق تر باشد. می رسند ، که همین سبب می شود به انجام

د. میزان کردن هایی که در یک نما را میزان کنید ، می باید هر نما را جداگانه به دست بگیری yو  xاگر می خواهید پس از این ارزش هايِ  .5

 انجام می دهید خود به خود براي نمايِ دیگر ساخته نمی شوند.
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 عوض کردن جايِ نماها

تان را بازچینی کنید. براي نمونه ، می توانید جايِ نماهايِ چپ و راست را با  scriptمی توانید نماها را در  SuffleViewsبه کمک تکمه يِ 

 را براي چشمِ چپ به کار می برد. rightرا براي چشمِ راست ، و درون رفتleft  درون رفتNuke  هم عوض کنید ؛ بدین سان ، برنامه يِ 

 بازچینیِ نماها

1. Views > ShuffleViews يِ را برگزینید تا یک تکمه SuffleViews  در جايِ مناسب درscript .تان بنشیند 

 کلیک کنید. addدکمه يِ  ، اگر نیاز باشد بر رويِ SuffleViewsتکمه يِ  در بخشِ کنترل هايِ .2

 ضدکمه ها و فهرست هايِ پایین افتادنی را به کار ببرید و نمایی را برگزینید تا آن را جایگزین نمايِ دیگر کنید. براي نمونه ، براي عو .3

 زیر را انجام بدهید : هايِکارکردن جايِ نماهايِ چپ و راست ، می باید 

) برگزینید. اکنون نمايِ راست ”from )“get left from right را از زیرِ right، و  getرا از زیرِ  leftدر یک ردیف ، گزینه يِ  •

 جایگزینِ نمايِ چپ می شود.

) برگزینید. نمايِ چپ ”from )“get right from leftرا از زیرِ  left، و  getرا از زیرِ  rightدر ردیف دیگر ، گزینه يِ  •

 جایگزینِ نمايِ راست می شود.

 
 add يِدکمه  کافی ردیفی از دکمه ها یا فهرست هايِ پایین افتادنی نباشد ، بر رويِ به اندازه يِ ShuffleViewsاگر در قابِ تکمه يِ 

 کلیک کنید تا یک ردیف افزوده شود.

در کنارِ ردیفی که می خواهید آن را و  ShuffleViewsکنترل هايِ تکمه يِ  ، در بخشِ ی که نیاز نمی شوندردیف هایبراي پاك کردن 

 .را کلیک کنید deleteدکمه يِ ،  کنیدپاك 
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 برگرداندن نگاره ها به آناگلیف

را به کار ببرید. با این کار ، زمانی که نگاره ها با  Anaglyphبراي برگرداندن درون رفت هایتان به نگاره هايِ آناگلیف ، می توانید تکمه يِ 

 خواهید داشت. 3Dدیده شوند ، یک جلوه يِ  color anaglyph-2عینک هايِ 

 روشِ برگرداندن نگاره هایتان به نگاره هايِ آناگلیف

1. Views > Stereo > Anaglyph  ِرا برگزینید تا یک تکمه يAnaglyph  در جايِ مناسب درscript .تان بنشیند 

زینید کنترل هايِ ، براي برگزیدن نماهایی که می خواهید براي چشمِ چپ و راست برگ Anaglyphتکمه يِ  propertiesاز قابِ  .2

views .را به کار بگیرید 

پالایش می شود تا رنگleft  درون رفت را به نگاره هايِ آناگلیف سیاه و سفید بر می گرداند. درون رفت  نگاره هايِ Nukeبرنامه يِ 

 از آن پاك شود. نماي راست رنگ قرمز را پاك می کندآبی و سبز 

.  

(سیاه و  0ارزشی میانِ  amtcolorرا به سمت راست بکشید ؛ یا براي میدانِ  amtcolorبراي افزودن رنگ به نگاره ها ، لغزنده يِ  .3

 (رنگی) بنویسید. 1سفید) و 

نبال ن را به داگر نگاره ها بخش هایی دارند که خیلی قرمز ، سبز ، یا آبی هستند ، افزودن رنگ بیش تر به آن ها به ترین برآیند ممک

 نخواهد داشت.

  

، گزینه يِ  leftاز درون رفتgreen  و  blue، و کانال هايِ  rightاز درون رفتred  براي وارونه کردن رنگ ها و به کار بردن کانالِ  .4

(right=left) .را نشان بزنید 
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انی که با عینک هايِ آناگلیف دیده می شوند) ، ارزشی را نسبت به صفحه نمایش نمایان می شوند (زمبراي کنترل کردن جایی که نگاره ها  .5

 در میدانِ درون رفتhorizontal offset  بنویسید. براي آن که نگاره ها در جلويِ صفحه نمایش پدیدار شوند ، معمولاً باید یک ارزش

ا بنویسید. (اگر جايِ نمايِ چپ و راست را با هم منفی را به کار ببرید. براي آن که نگاره ها دور نمایان شوند ، می باید ارزشِ مثبتی ر

 عوض کرده باشید ، این درست در نمی آید).

ثبت کنید. با این کار ،  viewer processرا به عنوان یک  Anaglyphاگر دوست داشته باشید ، می توانید تکمه يِ  نکته :

از نمایشگر به این تکمه به عنوان یک گزینه يِ نمایشی  Viewer processهمیشه می توانید در یک فهرست پایین افتادنیِ 

باشد ، آن را به نمایشگرِ جاري  Node Graphدسترسی داشته باشید و بدون این که نیازي به جاگذاري تکمه در پنجره يِ 

 بدهید. کارهايِ زیر را انجام بدهید :

 زید (البته اگر چنین پرونده اي وجود ندارد).بسا menu.pyدر پوشه يِ مسیرِ پلاگین تان ، پرونده اي به نامِ  .1

 menu.py، جمله يِ زیر را در پرونده يِ  Viewer Processبه عنوان یک  Anaglyphبراي به ثبت رساندن یک تکمه يِ  .2

 nuke.ViewerProcess.register("Anaglyph", nuke.createNode, ("Anaglyph", ""))ذخیره کنید : 

 دید و دوباره آن را باز کنید.را ببن Nukeبرنامه يِ  .3

در  Viewer Processرا به کار بگیرید ، آن را از فهرست پایین افتادنیِ  Anaglyph Viewer Processبراي این که  .4

 برگزینید. Viewerبخشِ کنترل هايِ تکمه يِ 

را از فهرست پایین افتادنیِ  show panel، گزینه يِ  Anaglyph Viewer Processبراي میزان کردن کنترل هايِ  .5

Viewer Process .برگزینید 

 تغییر دادنِ همگرایی

این امکان براي شما فراهم می شود که همگرایی را جا به جا کنید (چرخشی چشم ها یا دوربین ها به سمت داخل).  ReConvergeبا تکمه يِ 

نگاه می کنید ، در ژرفايِ صفحه نمایش پدیدار می  3Dزمانی که با عینک هاي نگاره که برگزیده شده است ، بدین سان ، هر نقطه اي بر رويِ 

) خوانده می شود. جایی که خطِّ دید دو دوربین به هم دیگر می رسند ، نقطه convergence point( همگرایی نقطه يِشود. این نقطه به نامِ 

 همگرایی است. يِ

 
د ، نماهايِ گوناگون در ژرفايِ صفحه نمایش چیدمان شده و نمایان می کنینگاه می  3Dِ همگرایی ، زمانی که به نگاره با عینک هايِ در نقطه يِ

همگرایی باشد در پشت صفحه نمایش پدیدار می شود ؛ و هر چیزي که در جلويِ آن باشد انگار از صفحه  شوند. هر چیزي که پشت نقطه يِ

 پایین به نمایش گذاشته شده است :مایش بیرون زده است. این که گفتیم در نگاره يِ ن
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ک نگاره با عناصر در ید نیز تغییر می کند. با این کار ، همه يِ ز نگاره ها به تصویر کشیده می شو، ژرفایی که ابا تغییر دادن نقطه يِ همگرایی 

 میان آن ها تغییر نمی کند. نگاره يِ زیر را ببینید. در این جا چهارگوش شوند ؛ و البته فاصله يِیک فاصله يِ مشخص به جلو یا پشت کشیده می 

 به تصویر کشیده شده اند. ییهايِ خاکستري رنگ عناصري را نشان می دهند که در یک نگاره يِ استریو

 
همگرایی به کار گرفته می شود. به هر روي ، براي این ن نقطه يِ اغلب ، عنصري از یک نگاره که نزدیک ترین فاصله تا بیننده را دارد به عنوا

 همگرایی را به پشت این عنصر بکشید. که عنصري در نگاره تان به بیرون بپرد ، می باید نقطه يِ

تا جایگاه یک پیکسل  نیاز دارد disparityبه یک میدانِ  ReConvergeبراي ارزیابی کردن میزانِ جا به جایی نقطه يِ همگرایی ، تکمه يِ 

می توانید پلاگینِ  disparityرا در یک نما به جایگاه پیکسلِ متناظرش در نمايِ دیگر نگاشت کند. براي ساختنِ میدانِ 

O_DisparityGenerator  از شرکتFoundary  ِرا به کار بگیرید. این پلاگین بخشی از مجموعه پلاگین هايOcula  است. به جايِ این

یک پرونده می توانید آن را در کانال هايِ  disparityبا داشتن میدانِ  بسازید. 3Dرا در یک برنامه يِ  disparity، می توانید میدانِ  پلاگین

را به  ShuffleCopy، تکمه يِ  -جایی که به آن نیاز دارید-به مسیرِ داده اي  disparityذخیره کرده ، یا براي افزودن کانال هايِ  exr.يِ 

 کار بگیرید.

 نماها را تنها در راستايِ افقی جا به جا می کند ؛ نه عمودي. ReConvergeبه یاد داشته باشید که تکمه يِ 
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 همگراییِ یک نگاره يِ استریویی روشِ تغییر دادن نقطه يِ

تغییر بدهید باشد. اگر سکانسِ تصویري  در بالادست سکانسِ تصویري که می خواهید همگرایی آن را disparityمطمئن شوید یک میدانِ  .1

می تواند در کانال هايِ آن آورده شده باشد. وگرنه ، می توانید براي افزودن یک میدانِ  disparityاست ، میدانِ  exr.تان یک پرونده يِ 

disparity  ِبه مسیرِ داده اي ، یک تکمه يShuffleCopy  ِیا پلاگینO_DisparityGenerator ه يِ از مجموعOcula  را به کار

 بگیرید.

را برگزینید تا تکمه اي به همین نام پس از سکانسِ تصویري که می خواهید  Views > Stereo > ReConvergeاز نوارِ ابزار ،  .2

 همگرایی آن را میزان کنید ، قرار بگیرد.

 بچسبانید. ReConvergeرا به تکمه يِ  Viewerیک تکمه يِ  .3

) میانِ دو تکمه Anaglyph )Views > Stereo > Anaglyph، یک تکمه يِ  ReConvergeاثیرِ تکمه يِ براي به تر نشان دادن ت .4

 جاي بدهید. Viewerو  ReConvergeيِ 

باز باشد. می باید در نمایشگر  ReConvergeتکمه يِ  propertiesببینید که قابِ  .5

 يِ نقطه اي بکشید که میپوشاننده يِ نقطه يِ همگرایی را ببینید. این نقطه را به بالا

صفحه نمایش پدیدار شود. ترازِ  نگاه می کنید در 3Dزمانی که با عینک هايِ  خواهید

 همگرایی به این جا کشیده می شود.

 هم چنین می توانید با نوشتن ارزش هایی براي مختصاتx  وy  ِخود نقطه در میدان هاي

Convergence upon .نقطه يِ همگرایی را جا به جا کنید ، 

نمايِ راست را جا به جا می کند تا جا  ReConvergeبه طورِ پیش فرض ، تکمه يِ  .6

،  ReConvergeبه جا شدگی همگرایی به دست بیاید. به هر روي ، اگر دوست داشته باشید ، می توانید در بخشِ کنترل هايِ تکمه يِ 

را برگزینید) ، و یا هر دو نما  Shift leftا به کار بگیرید و به جايِ نمايِ راست ، نمايِ چپ (گزینه يِ ر Modeفهرست پایین افتادنیِ 

 را برگزینید) جا به جا کنید. Shift bothرا به یک اندازه (گزینه يِ 

همگرایی (بر حسب پیکسل)  ) را برايoffset، یک اندازه يِ جبرانی ( ReConvergeاگر نیاز باشد ، در بخشِ کنترل هايِ تکمه يِ  .7

 Convergenceمیزان کنید. براي آن که همه يِ عناصرِ نگاره تان را به جلويِ ترازِ صفحه نمایش بیاورید ، ارزشِ مثبتی را در میدانِ 

offset .تعریف کنید. اگر می خواهید همه يِ عناصر را دور ببرید ، در این میدان یک ارزشِ منفی بنویسید 

وانید در سرتاسرِ سکانسِ تصویري ، عنصري را به عنوان نقطه يِ همگرایی به کار بگیرید. براي نمونه ، می توانید کاري کنید که هم چنین می ت

سرتاسرِ سکانسِ تصویري ، تکمه يِ  یک هنرپیشه همواره در ژرفايِ صفحه نمایش نمایان شود. براي همگرایی بر رويِ یک عنصر در

ReConverge ه يِ را به یک تکمTracker ) پیوندLink.بزنید ( 

 روشِ به کار گرفتن یک عنصر به عنوان نقطه يِ همگرایی در سرتاسرِ سکانسِ تصویري

 .(نگاره يِ پایین ، سمت راست) آن را میزان کنید را پس از سکانسِ تصویري بگذارید که می خواهید همگراییِ Trackerیک تکمه يِ  .1

 سرِ سکانسِ تصویري تان در ترازِ صفحه نمایش قرار بگیرد ، را ردیابی کنید.نقطه اي که می خواهید در سرتا .2
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از تکمه  Converge upon، به کنترلِ  Expressionزمانی که داده هاي پویانمایی شده يِ ردیابی را داشتید ، آن را با پیوند زدن یک  .3

 animationرا پایین نگه دارید و دکمه يِ  Ctrlبدهید. آسان ترین راه براي انجام دادن این کار این است که کلیدReConverge  يِ 

 در کنارِ فهرستtracks  ِرا بکشید و آن را بر رويِ دکمه يanimation  ِدر کنارِ کنترلConverge upon .ببرید و رها کنید 

   

 وپیکپیش نمایشِ نگاره هايِ استریوسک

کردن نگاره هايِ استریویی  Flipbookبا  ) یا بالاتر می توانیدMac OSX 10.5 )Leopard، و  Windows  ،Linuxدر سیستم هايِ عامل 

 ، آن ها را پیش نمایش بدهید.

Flipbook کردن نگاره هايِ استریویی 

 کنید. flipbookتکمه اي را برگزینید که می خواهید آن را  .1

 را فشار بدهید). Alt+Fرا اجرا کنید (یا کلید هايِ  Render > Flipbook selectedاز نوارِ فهرست اصلی برنامه دستورِ  .2

را در گوشه يِ پایین و راست نمایشگر فشار بدهید. با این کار ، تکمه هایی که  Flipbook this Viewerهم چنین می توانید دکمه يِ 

 می شوند. flipbookند ، به نمایشگر چسبانده شده ا

 یک پنجره يِ گفت و گوي باز می شود.

پیکربندي هایی که درست هستند را در پنجره نشان بزنید. پیکربندي هایی  .3

که در پنجره هستند معمولاً با پیکربندي هایی که سکانس هايِ غیر 

 می کنید یکسان هستند. flipbookاستریویی را 

فریمی را بنویسید که می خواهید پیش  دامنه يِ frame rangدر میدانِ  .4

 )15-12 10 8-1یا  35-1نمایش داده شود (براي نمونه ، 

، نمایی را برگزینید که می خواهید آن را  Viewبه کمک کنترلِ  .5

flipbook  ِکنید (یا نمايleft  یاright.( 

6. OK .را فشار بدهید 
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تعریف   scriptبرگزیده شده را به عنوان یک سکانسِ موقتی با دامنه يِ فریم و وضوحی که در پیکربندي هايِنمايِ  Nukeبرنامه يِ 

 شده است ، پردازش می کند. چند لحظه اي زمان می برد.

می کند. به کمک کنترل را اجرا کرده و سکانسِ موقتی را در آن بارگذاري  flipbookنمایشگرِ  Nukeپس از این که پردازش تمام شد ،  .7

 هستند می توانید سکانس را بازپخش کرده و جلو و عقب بکشید. flipbookهایی که در نمایشگرِ 

 پردازش کردن نگاره هايِ استریوسکوپیک

) extensionايِ (گسترش ه exr.می توانید چندین نما را پردازش کنید. هنگامی که براي پرونده اي با فرُمتWrite  به کمک تنها یک تکمه يِ 

بیرون رفت هر دو نما را در یک پرونده يِ تک می نویسد. در پرونده هایی با فرُمت هايِ دیگر ، نماها در  Nukeاستریویی را به کار می برید ، 

 پرونده هايِ مربوط به خودشان نوشته می شوند.

 exr.پردازش کردن پرونده هايِ

1. Image > Write يِ  را برگزینید تا یک تکمهWrite  در جايِ مناسبی درscript .تان بنشیند 

 را برگزینید. exr، گزینه يِ  file type، از فهرست پایین افتادنیِ  Writeدر بخشِ کنترل هايِ تکمه يِ  .2

 .left  ،right، نما یا نماهایی را برگزینید که می خواهید پردازش شوند ؛ براي نمونه ،  viewsاز فهرست پایین افتادنیِ  .3

نماهايِ برگزیده شده را تنها در یک پرونده  Nukeرا بزنید.  Renderاگر نیاز باشد ، کنترل هايِ دیگر را نیز میزان کرده و سپس دکمه يِ  .4

 می نویسد.

 پردازش کردن پرونده اي با فرُمت هايِ دیگر

 براي پردازشِ پرونده اي با فرُمتی به جز فرُمت.exr : کارهايِ زیر را انجام بدهید 

1. Image > Write  ِرا برگزینید تا یک تکمه يWrite  در جايِ مناسبی درscript .تان بنشیند 

 ، الگويِ پرونده يِ نگاره هایتان را برگزینید. file type، از فهرست پایین افتادنیِ  Writeدر بخشِ کنترل هايِ تکمه يِ  .2

(یا  rightو  leftهنگامی که براي سکانس هايِ تصویري پردازش شده نام گذاري انجام می دهید ، می توانید براي نشان دادن واژه هايِ  .3

. filename.%V.####.exrبزرگ) را به کار ببرید ؛ براي نمونه ، (با نویسه يِ  V%نام هايِ هر نمايِ دیگر) در نام هايِ پرونده ، متغیرِ 

(با نویسه يِ کوچک) را به کار ببرید.  v%(یا نخستین نویسه از هر نمایی که هست) می توانید متغیرِ  rو  lنشان دادن نویسه هايِ براي 

نماهایی که در گامِ بعدي معین  پر می کند و همه يِ l  ،r، و  left  ،rightاین متغیرها را با  Nukeسپس به هنگامِ پردازش ، برنامه يِ 

 کنید را پردازش می کند.می 

 نماهايِ برگزیده شده را پردازش می کند. Nukeرا بزنید.  Renderاگر نیاز باشد ، کنترل هايِ دیگر را نیز میزان کرده و سپس دکمه يِ  .4

Nuke .ن نکرده اید (یا اگر در نام هايِ پرونده نمای چندین نما را پردازش می کند ، ولی آن ها را در پرونده هايِ جدا از هم می نویسدی را معی

 با نوشتن نامِ نما ، یا با نوشتنِ نخستین نویسه از نامِ آن ، و یا با یک متغیر) ، تنها می توانید یک نما را پردازش کنید.
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آن  را با فهرستی از نامِ نماها بیاورید تا همه يِ view–براي پردازش کردن از خطِّ فرمان ، می توانید نشانوند  یادداشت :

 ها پردازش شوند. براي این کار باید نماها با یک ویرگول از هم جدا شده باشند. اگر یک نشانوند–view  را مشخص نکنید

 نماها را پردازش می کند. همه يِ Nuke، برنامه يِ 
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 عمقیترکیب بنديِ  __________________________________

داده هایی با یک فرُمت گوناگون  است کهروشی براي ترکیب بندي کردن نگاره هايِ دیجیتالی  )Deep compositing( عمقی ترکیب بنديِ

 رفاپیداست ، داده هايِ ژ آنهمان گونه که از نامِ این ترکیب بندي ، . به دست بیاید ياستاندارد" تخت"ترکیب بنديِ  را به کار می گیرد تا

)depth(  می به کار را) گیرد. بدین سان ، نیاز براي پردازشِ دوبارهre-render بالا به دست آمده ، و تکم می شود ؛ نگاره هایی با کیفی (

 کمکی است براي شما تا مشکلِ آرتیفکت هایی که پیرامونِ لبه هايِ اشیاء درست می شوند را برطرف کنید.

 عمقیدر باره يِ ترکیب بنديِ 

دارايِ چندین نمونه  عمق داردیگر ، نگاره هايِ تک است. از سويِ براي هر کانالِ هر پیکسل دارايِ یک ارزشِ  رداستاندا 2D یک نگاره يِ

، و ژرفایی هستند که نسبت به دوربین  color  ،opacityبراي هر پیکسل در ژرفاهايِ گوناگون هستند ، و هر نمونه نیز دارايِ داده هایی مانند 

 ).camera-relative depthبرآورد می شود (

را نیز به کار برده  antialiasedدر صحنه اي که اشیاء در آن جا به جا می شوند (به ویژه اشیایی که پیکسل هايِ شفاّف داشته و براي نمونه ، 

ردازش کرده و پس ، نخست پس زمینه را تنها یک بار پ Nukeاز برنامه يِ  Deep Compositingيِ هامجموعه تکمه اید) ، می توانید با 

ره و از آن ، اشیاء تان را به جاها و ژرفاهايِ گوناگون جا به جا کرده و پردازش را انجام بدهید. در این جا دیگر نیاز نیست پس زمینه دوبا

ه می شوند. بنا هم دارند ، بدون هیچ عیب و ایرادي نشان داد Motion Blurدوباره پردازش شود. همه يِ پیکسل هايِ شفاّف که براي نمونه 

 نه تنها سریع تر است ، بل که با آن می توانید نگاره اي با کیفیت بالاتر را به دست بیاورید. عمقیبر این ، کار با ترکیب بنديِ 

 

 یک آغازِ تنُد و سریع

 می توانید : Nukeاز برنامه يِ  Deep Compositingيِ هابا مجموعه تکمه 

 تان را بخوانید.عمق دارمی توانید نگاره يِ  DeepReadبا تکمه يِ  •

 می توانید داده هايِ ژرفا را با هم یکی کنید. DeepMergeبا تکمه يِ  •
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 بسازید. holdoutهايِ  matte، عمق دار می توانید از یک جفت نگاره يِ  DeepHoldoutبه کمک تکمه يِ  •

 ها. point cloudمعمولی ، یا ساختنِ  2Dيِ و ساختن یک نگاره  عمق داربراي تخت کردن نگاره هايِ  •

 .DeepSampleنمونه گیري داده اي در یک پیکسلِ مشخص به کمک تکمه يِ  •

درست با همان روشی که براي یک نگاره يِ معمولی انجام می ، عمق دار برش زدن ، تغییر دادن فرُمت ، و تغییر شکل دادن نگاره هايِ  •

 .DeepTransform، و  DeepCrop  ،DeepReformatگیرد ، به کمک تکمه هايِ 

و  ، DeepFromFrames  ،DeepFromImage  ،DeepRecolorبه کمک تکمه هايِ نگاره هايِ عمق دار ساختنِ  •

ScanlineRender. 

 )Deep footageخواندنِ فیلم و ویدئويِ عمق دار (

بخوانید ؛ درست مانند نگاره هايِ دیگر که با تکمه يِ  Nukeمی توانید نگاره هايِ عمق دار را در برنامه يِ  DeepReadبه کمک تکمه يِ 

Read  .می خوانیدNuke : مق دار را در دو فرُمت به درون برنامه بیاوریداجازه می دهد که نگاره هايِ ع 

• DTEX  ِساخته شده از برنامه ي)PhotoRealistic RenderMan® Pro Server  از شرکتPixar( 

• Scanline OpenEXR 2.0  ِپرونده هاي)tiled OpenEXR 2.0 (پشتیبانی نمی شوند 

 Nukeبه درون برنامه يِ  DTEXآوردن پرونده هايِ 

،  16.4،  15.2نسخه يِ  RenderMan Pro Server بیاورید ، می باید Nukeرا به درون برنامه يِ  DTEXپیش از این که پرونده هايِ 

 را بر رويِ رایانه تان داشته باشید. 17.0یا 

 کارهايِ زیر را انجام بدهید :

1. RenderMan Pro Server  ِرهايِ محیطی لازم ، که برنامه يرا بر رويِ رایانه راه اندازي کنید. متغیNuke  الرا براي کار با آن فع

 .Setting Up RenderMan Pro Server and PrmanRenderنگاهی داشته باشید به  می کنند را پیکربندي کنید. براي جزئیات ،

نیازي ندارید ؛ تنها  RenderMan Pro Server، به جوازِ  Nukeکه براي کار کردن با نگاره يِ عمق دار در برنامه يِ  باید بدانید

 نصب برنامه يِ نرم افزاري براي کار کفایت می کند.

 تکمه اي به همین نام بسازید. Deep > DeepReadبا کلیک کردن  .2

 کلیک کنید. Openبر رويِ دکمه يِ  است. dtex.به جایی بروید که پرونده يِ  .3

را  dtex.) تلاش می کند خود به خود نوعِ پرونده يِ subimage nameبا نگاه کردن به نامِ زیر نگاره ( Nukeبه طورِ پیش فرض ،  .4

 Nukeختم شده باشد ،  deepopacity.باشد یا به نامِ  Deep Opacityبا  Deep Shadowره یا شناسایی کند. اگر نام زیر نگا

رفتار می کند. به هر روي ، اگر در هنگامِ پردازشِ پرونده نامِ زیر نگاره را دستی تغییر  deep opacityبا آن به مانند یک پرونده يِ 

را بر  typeی شناسایی کند. اگر با این مورد برخورد کردید ، فهرست پایین افتادنیِ شاید نتواند نوعِ پرونده را به درست Nukeبدهید ، 

 رويِ یکی از گزینه هايِ زیر بگذارید :

• Deepopacity  ِاین گزینه به برنامه ي :Nuke  ِفشار می آورد تا با پرونده به مانند یک پرونده يaccumulated deep 

opacity يِ درایورِ رفتار کند ؛ که به پیکربندRenderMan Display : مربوط می شود 



160 | N u k / U s e r  G u i d e  
 
 

Vahid Velayati 
 

Display “Filename.dtex””deepshad””deepopacity” 
 

• Alpha  ِاین گزینه به برنامه ي :Nuke  ِفشار می آورد تا با پرونده به مانند یک پرونده يpoint-sampled alpha  یاpoint-

sampled color  ِجدیدتر رفتار کند ؛ که به پیکربنديِ درایورRenderMan Display : مربوط می شود 

Display “Filename.dtex””deepshad””a” 
 یا

Display “Filename.dtex””deepshad””rgba” 

 Nukeبه درون برنامه يِ  Scanline OpenEXRآوردن پرونده هايِ 

 مین نام بسازید.تکمه اي به ه Deep > DeepReadبا کلیک کردن  .1

 کلیک کنید. Openاست. بر رويِ دکمه يِ  exr.به جایی بروید که پرونده يِ  .2

3.  به طورِ پیش فرض ، پسوندexr  ِبه کلیدهايmetadata از  بشود آن ها چسبیده شده اند تاmetadata  تکمه دیگري که در درخت

 do، بدون چسبیدن یک پسوند بخوانید ، گزینه يِ  ”گونه که هستهمان “را  metadataشناسایی کرد. اگر ترجیح می دهید  اي است

not attach prefix .را به کار بیاندازید 

 ساختنِ داده هايِ عمقی

 بسازید :از راه هايِ زیر می توانید داده هايِ عمقی را  Nukeدر برنامه يِ 

در یک فریمِ ساخت چندین نمونه براي هر پیکسل تنها  ومعمولی در چندین فریم  2Dنمونه گیري کردن از یک سکانسِ تصویري  •

 .)Deep Frame( تک عمق دارِ

معمولی به یک نگاره يِ عمق دار ، به کمک تنها یک نمونه يِ تکی براي هر پیکسل در ژرفایی که با  2Dبرگرداندن یک نگاره يِ •

 تعریف شده است. depth.Zکانالِ 

 معمولی. 2Dهايِ ژرفا به کمک یک نگاره يِ  ) نمونهrecolorدوباره رنگ کردن ( •

 در پایین دست آن. Deepو چسباندن یک تکمه يِ  3Dبه یک صحنه يِ  ScanlineRenderیک تکمه يِ  افزودنِ •

 به یک فریمِ عمق دار ، به کمک فریم هايِ درون رفت 2Dبرگرداندنِ یک سکانسِ تصویريِ 

را به  DeepFromFrames، می توانید تکمه يِ باشند  هايِ گوناگونژرفا مونه هایی بسازید که دراگر می خواهید از فریم هايِ درون رفت ن

 کار ببرید.

جاي داده می شود ؛ و بدین هر فریم در ژرفاهايِ چندگانه را به فیلم یا ویدئویی که دارید بچسبانید.  DeepFromFramesتکمه يِ  .1

 عمق دار ساخته می شود. سان نگاره يِ

 : را میزان کنیدبرآیند به دست آمده  به کمک کنترل هايِ زیر ، propertiesدر قابِ  .2

• Samples  مق داري که بیرون فرستاده می شود  در معلوم کنید: با این گزینه می توانیدبراي هر پیکسل چه شماري از، نگاره يِ ع 

 .باشدنمونه ها 
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• Frame range  ِمق دار به کار می برد. براي نمونه ، اگر ارزشِ گزینه يدامنه يِ فریم را براي یک نگاره يِ ع :samples  برابر

،  1در بارهايِ  DeepFromFramesبگذارید ، تکمه يِ  9-1دامنه يِ فریم را بر رويِ  و ارزشِ (ارزشِ پیش فرض) باشد 5با 

 نمونه می گیرد. 9، و  7،  5،  3

• Premult  ِجنبه ي :premultiply .را براي نمونه ها ممکن می سازد 

• Split alpha mode  : گزینه يِ درadditive در گزینه يِ بر شمارِ نمونه ها انجام می گیرد.  تقسیمی multiplicative  آلفا

این ) flattenتخت شود ( ) نگارهDeepToImageشکافته و جدا می شود ؛ که البته اگر بعدها (براي نمونه ، به کمک تکمه يِ 

را برگزینید ، آلفا را دیگر نمی توان به ارزشِ اصلی  additiveمی تواند به ارزشِ اصلی خودش برگردانده شود. اگر گزینه يِ آلفا 

 اش برگرداند.

• Zmin :  مق داري که بیرون فرستاده می شود (مربوط به نخستینتعریف  فریم در دامنه)ژرفایی را به نخستین نمونه از هر پیکسلِ ع ،

 می کند.

• Zmax :  مق داري که بیرون فرستاده می شود (مر بوط به آخرین فریم در دامنه) ، تعریفژرفایی را به آخرین نمونه از هر پیکسلِ ع

 می کند.

 
 deep fogیک راه اندازيِ ساده براي ساخت یک عنصرِ 

 اربه یک نگاره يِ عمق د 2Dبرگرداندنِ یک نگاره يِ 

معمولی را به یک نگاره يِ عمق دار برگردانید. در این جا به کمک کانالِ  2Dمی توانید یک نگاره يِ  DeepFromImage با تکمه يِ

depth.Z .براي هر پیکسل تنها یک نمونه يِ تک در ژرفا تعریف می شود ، 

 آن را به یک نگاره يِ عمق دار برگردانید. را به فیلم یا ویدئویی بچسبانید که می خواهید DeepFromImageتکمه يِ  .1

بشوند یا نه ، با گزینه يِ  premultiplyتکمه ، براي این که معلوم کنید آیا می خواهید کانال هايِ درون رفت  propertiesدر قابِ  .2

premult input .کار کنید 
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 keep zeroآلفایی برابر با صفر دارند ، از نگاره يِ عمق دارِ به دست آمده بیافتند ، نشانِ گزینه يِ  اگر می خواهید نمونه هایی که ارزشِ .3

alpha ِمق داري که به دست می آید نمونه هايرا بردارید. به طورِ پیش فرض ، این گزینه نشان خورده است ؛ و بنا بر این ، نگاره يِ ع 

 آلفا با ارزشِ صفر را هم شامل می شود.

را نشان  specify zتکمه ، ژرفا را مشخص کنید. در این جا ، گزینه يِ  propertiesدر قابِ  zهم چنین می توانید به کمک کنترلِ  .4

 .را از درون رفتی که به تکمه می آید ، به کار بگیرید depthبزنید. این نشان می دهد که نمی خواهید کانالِ 

 Depthدوباره رنگ زدن داده يِ 

استاندارد که دارايِ  2Dهستند ، با یک نگاره يِ  opacity) پرونده هايِ بافر ، که براي هر نمونه تنها دارايِ mergeبراي با هم یکی کردن (

ه يِ درون رفت است را رنگی که در هر پیکسل از نگار DeepRecolorرا به کار بگیرید. تکمه يِ  DeepRecolorرنگ است ، تکمه يِ 

 در سرتاسرِ همه يِ نمونه هايِ پیکسلِ متناظر از نگاره يِ عمق دار گسترش می دهد.

1.  مق دارید را به درون رفتمنبعی که براي عdepth  ِاز تکمه يDeepRecolor  ِ2بچسبانید. نگاره يD  تان را نیز به درون رفتcolor 

 colorرا میانِ درون رفتunpremultiply  شده باشد ، شاید بخواهید یک تکمه يِ  premultiplyتان  2Dبچسبانید. اگر نگاره يِ 

 جاي بدهید. DeepRecolorو تکمه يِ 

 به کار ببرید را برگزینید. color، می توانید کانال هایی که می خواهید از نگاره يِ درون رفتproperties  در قابِ  .2

را می گیرد و آن را با رنگ نمونه  exr.شده با فرُمتunpremultiply  یک نگاره يِ  DeepRecolorدر نمونه يِ زیر ، تکمه يِ 

 به کار می برد. dtex.عمقی از پرونده يِ هايِ 

 

3.  بالایی دارد ، با آلفایی اگر در این مرحله آلفایی که از نگاره يِ تخت تمقکه در نمونه هايِ پردازش شده يِ نهایی که کیفیان داده نش ع

نباشد (براي نمونه ، به مانند برآیندي که از فشرده سازي به دست می آید که معمولاً در پرونده هايِ عمق دار بر رويِ  یکیمی شود ، 

 را نشان بزنید. این بدان معناست که آلفايِ target input alphaرخ می دهد) ، می توانید گزینه يِ  shaderدیسک یا تغییري به 

 درون رفتcolor مقمق به  در میانِ نمونه هايِ عپخش و گسترده می شود ؛ و بنا بر این ، آلفايِ نهایی که پس از تخت شدن داده هايِ ع

 دست می آید با آلفايِ درون رفتcolor یکی خواهد بود. 

، و  colorن آلفايِ نگاره يِ درون رفت کرد unpremultiplyبا  Nukeنشان نخورده باشد ،  target input alphaاگر گزینه يِ 

 DeepRecolorهر نمونه ، رنگ را به هر نمونه می گستراند. در این جا ، آلفا از تکمه يِ  کردن دوباره يِ آلفايِ multiplyپس از آن 

 ممکن است با آلفايِ درون رفتcolor .فت و جور نباشدج 
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 )Deep Dataرست کردن داده يِ عمق (براي د ScanlineRenderبه کارگیريِ تکمه يِ 

 باشد ، این تکمه می تواند داده يِ عمق را بیرون بفرستد. ScanlineRenderدر پایین دست تکمه يِ  Deepاگر یک تکمه يِ

 پردازش کند. 2Dرا به آن بچسبانید تا صحنه را به مانند یک نگاره يِ  ScanlineRenderبسازید و یک تکمه يِ  3Dیک صحنه يِ  .1

در  BlendMatرا پشتیبانی می کند. بنا بر این ، اگر یک تکمه يِ  over blendترکیب بندي عمقی تنها الگويِ  یادداشت :

 پیکربندي شده است. overآن همواره بر رويِ  operationبرگردانده می شود ،  Deepباشد ، هنگامی که به  3Dصحنه يِ 

 بیافزایید. ScanlineRenderیک تکمه به پایین دست تکمه يِ  Deepاز فهرست پایین افتادنیِ  .2

 

تکمه يِ  propertiesاگر نمی خواهید نمونه هايِ عمق دار با آلفایی که ارزشِ برابر با صفر دارد ، بیرون رفت را شکل بدهند ، قابِ  .3

ScanlineRender  ِرا باز کنید و ببینید که گزینه يdrop zero alpha samples .ال باشدفع 

 را میزان کنید. براي نمونه : ScanlineRenderویژه گی هايِ دیگرِ تکمه يِ  .4

بروید و ارزشِ  MultiSampleآرتیفکت هایی در پردازش وجود دارند ، به برگه يِ  antialiasingبه سبب  اگر می بینید •

Samples مقی براي هر پیکسل افزایش می یابد.را زیاد کنید. با این کار ، شمارِ نمونه هايِ ع 

(نگاره يِ پایین ،  lowرا بر رويِ  antialiasingگزینه يِ  بروید و ScanlineRenderبه برگه يِ  این کار می توانید به جايِ

 بگذارید. (نگاره يِ پایین ، سمت چپ) high، یا  medium، سمت راست) 

  
را زیاد کنید تا در زمانِ شاتر از نگاره  samplesباشید ، ارزشِ  داشته Motion Blurتان  3Dاگر می خواهید در صحنه يِ  •

 چندین بار نمونه گرفته شود.
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شاتر باز بماند. اگر روند پردازش به کُندي انجام  Motion Blur، شماره فریم هایی را بنویسید که به هنگامِ  shutterدر میدانِ 

شمارِ بارهایی که پردازش  stochastic samplesرا تقریب بزنید و با افزایشِ  multi-sampleبگیرد ، می توانید پردازشِ 

 انجام می شود را کم کنید.

  
 Motion Blurبا     Motion Blurبدونِ 

(که نشان دهنده يِ جا  3D Point Cloudبراي ساختنِ یک  نکته :

به جا شدن در صحنه است) می توانید پس از تکمه يِ 

ScanlineRender  ِیک تکمه ي ،DeepToPoints  را به کار

 .روبرو) (نگاره يِ ببرید

 

 Deepبه نمایش گذاشتنِ داده يِ ژرفا در نمودارِ 

را در پنجره يِ  Deep Graphزمانی که نگاره يِ عمق دارتان را می خوانید ، براي نمونه گرفتن داده هايِ ژرفا در نگاره ، می توانید نوارِ 

 ایشگر به کار بگیرید.نم

 

 باز ، و اگر باز است بسته شود. Deepکلیک کنید تا نمودارِ  timeline) در بالايِ forward slash( /بر رويِ دکمه يِ  .1
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 Deepهايِ عمق جا به جا کنید. نمودارِ  لکه باز است می توانید ماوس تان را در پنجره يِ نمایشگر بر رويِ پیکس Deepدر نمودارِ  .2

 شِ ژرفايِ پیکسل ها را با یک نشانگرِ سفید رنگ بر رويِ نمودار به نمایش می گذارد.ارز

) تا از نمونه هایتان Panکرده و آن را به چپ و راست ، و پایین و بالا بکشید ( Zoom Outو  Zoom Inمی توانید  Deepدر نمودارِ  .3

 .را به دست بیاوریدنمايِ نزدیک تري 

انجام  DeepSampleاگر می خواهید نمونه هايِ نگاره يِ عمق دارتان را با آمار و ارقامِ درست داشته باشید ، این کار را با تکمه يِ  .4

 بدهید.

 با هم یکی کردن نگاره هايِ عمق دار

بدین سان ، هر پیکسلی که بیرون فرستاده يِ چندین نگاره يِ عمق دار را با هم یکی کنید. می توانید نمونه ها DeepMergeبه کمک تکمه يِ 

 می شود دارايِ همه يِ نمونه هایی است که از همان پیکسل از هر یک از درون رفت ها می گیرد.

 بچسبانید. DeepMergeداده اي که می خواهید یکی کنید را به درون رفت هايِ شماره دار از تکمه يِ  .1

 گذاشته شده باشد. combineبر رويِ  operationيِ  تکمه ، ببینید که گزینه propertiesدر قابِ  .2

را نشان بزنید. با این کار ، نمونه هایی که با نمونه هايِ نزدیک  drop hidden samplesمی توانید گزینه يِ  propertiesدر قابِ  .3

 تري مسدود می شوند که ارزشِ آلفايِ یکسان دارند ، در نمونه گیري شامل نمی شوند.

 

 ها Holdoutساختنِ 

. این که کدام یک از این DeepMerge، یا تکمه يِ  DeepHoldoutها وجود دارد : به کار بردن تکمه يِ  holdoutدو راه براي ساختنِ 

نگاره تخت شده را بیرون بفرستد یا یک یک نگاره يِ  holdoutدو راه را برگزینید به این بر می گردد که آیا می خواهید تکمه پس از انجامِ 

 يِ عمق دار.

 DeepHoldoutتخت شده با تکمه يِ  holdoutساختنِ یک 

مسدود می شوند را پاك کرده و یا  holdoutرفت  درونکه با نمونه هایی از  mainنمونه هایی از درون رفتDeepHoldout  تکمه يِ 

که در به همراه سوراخ هایی است  mainتخت شده اي از نگاره يِ درون رفت ). آن چه به دست می آید نگاره يِ fade outمحو می کند (
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را گرفته اند. اگر می  mainدرون رفت جلويِ بخش هایی از نگاره يِ  holdoutدرون رفت  که اشیاء در نگاره يِ پدیدار می شوند جاهایی

 گزینه اي است که باید به کار بگیرید. DeepMergeدر تکمه يِ  holdoutاده شود عمق دار باشد ، کارکرد خواهید نگاره اي که بیرون فرست

 : DeepHoldout به کمک تکمه يِ holdoutبراي ساختنِ یک 

 .بچسبانید mainعمق داري که می خواهید بخش هایی از آن را پاك کرده و یا محو کنید ، را به درون رفت نگاره يِ  .1

2.  به درون رفتholdout  ِمق داري را بچسبانید که بخش هایی دارد که جلويِ نگاره ينیز نگاره يِ ع درون رفتmain .را می گیرد 

با کانال هايِ قرمز ، سبز ، آبی ، و آلفا به دست آمده است. باید بدانید که نگاره يِ  holdoutاکنون می توانید برآیند کار را ببینید. یک  .3

 ون رفت تخت شده است.بیر

 
 از ساختمان هايِ آبی با شکل هايِ گوي که برش ایجاد کرده اند. holdoutیک 

 DeepMergeبا تکمه يِ  Deep Holdoutساختنِ یک 

، که با نمونه هایی از  Bنمونه هایی از درون رفتDeepMerge  در تکمه يِ  holdout، کارکردDeepHoldout  درست مانند تکمه يِ 

 درون رفتA  ِمسدود شده باشند را پاك کرده و یا محو می کند. به هر روي ، تکمه يDeepMerge ِتکمه ي برخلاف ، DeepHoldout 

 ، داده ها را تخت نمی کند و یک نگاره يِ عمق دار را بیرون می فرستد.

 : DeepMerge به کمک تکمه يِ holdoutبراي ساختنِ یک 

 بچسبانید. Bعمق داري که می خواهید بخش هایی از آن را پاك کرده و یا محو کنید ، را به درون رفت نگاره يِ  .1

2.  به درون رفتA  ِمق داري را بچسبانید که بخش هایی دارد که جلويِ نگاره ينیز نگاره يِ ع درون رفتB .را می گیرد 

 بگذارید. holdoutرا بر رويِ  operation، گزینه يِ  DeepMergeتکمه يِ  propertiesدر قابِ  .3

) ، برخی از نمونه ها که ارزشِ آلفايِ خیلی پایینی دارند ممکن است به اشتباه floating pointشناور (به سبب نادرست بودنِ نقطه يِ  .4

را زیاد کنید. به طورِ پیش  drop zero threshold ، ارزشِ گزینه يِ holdoutنگه داشته شوند. براي پاك کردن این نمونه ها از 

 پیکربندي شده است. 0.0000001فرض ، این گزینه بر رويِ 

با کانال هايِ قرمز ، سبز ، آبی ، و آلفا به دست آمده است. باید بدانید که نگاره يِ  holdoutاکنون می توانید برآیند کار را ببینید. یک 

 ار است.بیرون رفت هنوز هم یک نگاره يِ عمق د
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 از نگاره هايِ عمق دار 3Dو  2Dساختنِ عناصرِ 

 از یک نگاره يِ عمق دار 2Dساختنِ یک نگاره يِ 

را به کار ببرید. این تکمه همه يِ نمونه هایی که در یک نگاره يِ عمق دار  DeepToImageبراي تخت کردن یک نگاره می توانید تکمه يِ 

 لی با هم یکی می کند.معمو 2Dهستند را در یک نگاره يِ 

که داده هايِ عمقی را دارد که با هم یکی شده اند) بچسبانید که می  DeepMergeِ تکمه را به نگاره يِ عمق داري (یا یک تکمه ي .1

 خواهید آن را تخت کنید.

ینه را بردارید ، برنامه از پیش نشان خورده است. اگر نشان این گز volumetric composition، گزینه يِ  propertiesدر قابِ  .2

. اگر این گزینه )overlap( هم نمی افتند جلویی هر نمونه را ارزیابی می کند و گمان می شود نمونه ها بر رويِ تنها ژرفايِ Nukeيِ 

افتاده بودند ، نگاره اي هم  نشان نداشته باشد ، ارزیابی زمانِ کمی را می برد ، ولی اگر در نگاره يِ عمق دار نمونه هایی داشتید که رويِ

 نباشد که انتظار می رفت. آن چیزيبراي هر پیکسل ، که به دست می آید ممکن است 

 از یک نگاره يِ عمق دار Point Cloudساختنِ یک 

دید (چیزي بسیار  Nukeبرنامه يِ  3D که بتوان آن ها را در نمايِ 3Dبراي تغییر شکل دادن نمونه هايِ پیکسلی عمقی به نقطه هایی در فضايِ 

 همانندPoint Cloud ِمی توانید تکمه ي ، (DeepToPoints ) را به کار ببرید. این تکمه براي خاستگاه کردن جایگاهposition 

reference.بسیار کارآمد است ( 

1.  درون رفت درگاهdeep  ِاز تکمه يDeepToPoints ِمق داري بچسبانید که می خواهید در فضايِ  را به نگاره ي3عD  به نمایش در

 بچسبانید. cameraنگاه داشته باشد ، آن را به درگاه درون رفتPoint Cloud  به آید. اگر دوربینی دارید که می خواهید 

2.  کار را ببینید  ، نما را (با فشار دادن کلید براي این که برآیندTab3ه نمايِ ) بD .تغییر بدهید 

 ، چگالیِ توده يِ ابر مانند نقطه ها را میزان کنید. Point detailمی توانید با دستکاري کردن لغزنده يِ  propertiesدر قابِ  .3

  
Point detail = 0.005    Point detail = 0.05 

را بر رويِ  3D Object selectionنید. هم چنین می توانید ابزارِ را میزان ک Point sizeگزینه يِ ، براي تغییر دادن اندازه يِ نقطه ها  .4

Point Cloud  ِبه دست آمده از تکمه يِ ببرید ، و براي نمونه بر رويِ برآیندهايDeepToPoints .بکشید 
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Point size = 2    Point detail = 6 

 پیرایش کردن داده يِ عمق

) ، و نیز آن ها را به color correctرنگ نگاره هايِ عمق دار را درست کرده ( شما فراهم شده است کهاین امکان براي  Nukeدر برنامه يِ 

 کمکexpression ) ها پیرایشmodify.کنید ( 

 درست کردن رنگ نگاره هايِ عمق دار

 می توانید رنگ هر نمونه در هر پیکسل را درست کنید. DeepColorCorrectبا تکمه يِ 

نیز  masterها یکسري کنترل ها جاسازي شده اند. البته یک کنترلِ  highlightها و  midtoneتکمه براي میزان کردن سایه ها ، در این 

 midtoneهست که به کمک آن می توانید همه يِ این کارها را به یکباره انجام بدهید. براي کنترل کردن دامنه اي از نگاره که جزوِ سایه ها ، 

 کار کنید. )lookup curves(تبدیلِ ارزش  با نمودارهايِ Rangesها به شمار آورده می شود ، می توانید در برگه يِ  highlightها ، و 

صفر بگذارید ، براي کانالِ آلفا را بر رويِ  gainداشته باشید ، ارزشِ  matteاگر در دامنه اي که می خواهید یک  نکته :

 ها را به دست می آورید. Matteپیکربندي کنید ،  1را براي همین کانال بر رويِ  offsetو ارزشِ 

 در عمق Color Correctionمیزان کردن جلوه يِ 

تان آغاز و پایان می یابد را پیکر  Color Correctionمی توانید نقطه يِ میانِ نمونه هايِ عمقی ، جایی که جلوه يِ  Maskingدر برگه يِ 

 د.بندي کنی

 را نشان بزنید. limit_z، گزینه يِ  zmapبراي به کار افتادنِ ابزارِ  .1

2.  ذوزنقه را به گونه اي میزان کنید که مرزبندA  ِژرفا را نشان بدهد ؛ جایی که می خواهید جلوه يColor Correction آغاز شود. مرز بند

B  وC  نشانگرِ درازايِ جلوه يِ کامل هستند ؛ و مرزبندD  ِجایی را نشان می دهد که جلوه به پایان می رسد. بنا بر این ، آسه يy  ِاز ابزار

Zmap  ِاندازه يِ جلوه ، و آسه يx .دامنه يِ نمونه هايِ ژرفا را نشان می دهند 

رابر اگر ارزشِ این گزینه ب .ن درست شده است را میزان کنیداصلی با نگاره اي که رنگ آ می توانید آمیختگیِ میانِ نگاره يِ mixبا کنترلِ  .3

 بگذارید ، نگاره اي را خواهید داشت که همه يِ رنگ آن تمام درست شده است. 1با صفر باشد ، نگاره يِ اصلی ، و اگر ارزش را بر رويِ 
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 ها Expressionپیرایش کردن نگاره هايِ عمق دار با 

را بر رويِ داده يِ عمقی اجرا کنید. براي این کار ، کنترل  Nukeبرنامه يِ  هايِ expressionمی توانید  DeepExpressionبا تکمه يِ 

 هستند را به کار بگیرید : propertiesهایی که در قابِ 

نیز درست همین گونه است. اگر می باید که یک  Expressionهاي موقتی چهار میدان وجود دارد. در تکمه يِ  expressionبراي  .1

expression ا در چندین میدان بنویسید و می خواهید آن درازي رexpression  ر تعریف کنید ، اینیک متغی را به طورِ گذرا به مانند

را در سمت راست آن بنویسید.  expression(برابري) ، و  =میدان ها می توانند به کارتان بیایند. نامِ متغیر را در سمت چپِ نشانه يِ 

ر را به نماینده گیِ همه يِ سپس می توانید نامِ متغیexpression  ِدر میدان هايExpression .براي کانال ها بنویسید 

ها را  expressionکانال هایی را مشخص کنید که می خواهید  chans3تا  chans0در فهرست هايِ پایین افتادنیِ سپس می توانید  .2

 ه زیر آن هایی که هستند افزوده و یا پاك می کند.را ب expressionبراي آن ها بسازید. این کار ، میدان هايِ 

 هایتان را بنویسید. expression، براي کانال هايِ گوناگون  channel expressionپس از این می توانید در میدان هايِ  .3

 برش زدن ، تغییر دادن فُرمت ، و تغییر شکل دادن نگاره هايِ عمق دار

عمق دار را به مانند نگاره هايِ معمولی برش بزنید ، فرُمت آن ها را تغییر بدهید می توانید نگاره هايِ  Deepبه کمک چند تایی از تکمه هايِ 

 ، و نیز آن ها را تغییر شکل بدهید.

به یاد داشته باشید که چون نمونه ها در هر پیکسل می توانند در ژرفاهايِ دلخواه جاي بگیرند ، نمونه گیريِ  یادداشت :

دوباره اي که به هنگامِ کارکرد تغییر شکل انجام می گیرد ممکن است به برآیندهايِ پیش بینی نشده اي بیانجامد ؛ چون 

 نمونه هایی نباشند.ناري ک در پیکسل هايِممکن است در یک ژرفايِ یکسان 

 برش زدن نگاره هايِ عمق دار

 ، نگاره يِ عمق دارتان را برش بزنید : Cropمی توانید درست مانند تکمه يِ  DeepCropبه کمک تکمه يِ 

 عمق داري بچسبانید که می خواهید آن را برش بزنید.را به نگاره يِ  DeepCropتکمه يِ  .1

 Xرا در پنجره يِ نمایشگر در راستاهايِ  crop) ، گزینه يِ crop areaز نگاره که می خواهید برش بخورد (براي معلوم کردن بخشی ا .2

را به کار  bboxمیدان هايِ  propertiesمیزان کنید. به جايِ این ، می توانید براي تعریف بخشی که برش می خورد ، در قابِ  Yو 

 را نشان بزنید. keep outside bboxنگه دارید ، می توانید گزینه يِ  crop boxفا را بیرون از بگیرید. اگر می خواهید نمونه هايِ ژر

می توانید نمونه ها را در ژرفا برش بزنید. اگر نمی خواهید این کنترل ها را به کار  propertiesدر قابِ  zfarو  znearبا کنترل هايِ  .3

ژرفایی که که در کنارِ آن هاست ، آن ها را از کار بیاندازید. اگر می خواهید نمونه هايِ  useببرید ، می توانید با برداشتنِ نشانِ گزینه يِ 

 keep outside zrangeنترل ها معلوم شده است) هستند را نگه دارید ، می باید گزینه يِ (دامنه اي که با این ک zبیرون از دامنه يِ 

 را نشان بزنید.

 عمق دار تغییر دادن فُرمت نگاره هايِ
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ازه و ن اندتکمه اي است که با آن می توان فرُمت داده يِ عمقی را تغییر داد. این تکمه را می توانید براي تغییر داد DeepReformatتکمه يِ

 ابعاد نگاره يِ عمق دار به کار ببرید.

 را به نگاره يِ عمق داري بچسبانید که می خواهید فرُمت آن را تغییر بدهید. DeepReformatتکمه يِ  .1

 : typeدر فهرست پایین افتادنیِ  .2

• To format پایین افتادنیِ  .: پهنا و درازايِ بیرون رفت را به فرُمتی که برگزیده اید پیکربندي می کند در فهرستoutput 

format  ِفرُمت را برگزینید. اگر هنوز فرُمتی وجود ندارد ، می توانید گزینه ي ،new  ِجدیدي را بسازید. پیکربندي را بزنید و فرُمت

نشان داده  Project Settings) نگاره را به فرُمتی تغییر اندازه می دهد که در پنجره يِ گفت و گويِ root.formatپیش فرض (

 شده است.

• To box :  ِن کرده اید پیکربندي می کند. در میدان هايپهنا و درازايِ بیرون رفت را به ابعادي که بر حسب پیکسل معیwidth  ،

height  و ،pixel aspect .را مشخص می کنند ارزش هایی را بنویسید که ابعاد 

• Scale :  ِپهنا و درازايِ بیرون رفت به چندین اندازه از درون رفت پیکربندي می کند. با لغزنده يsacle  می توانید فاکتور را معلوم

در  ) کمی گرد شده است ؛ به گونه اي که نگاره يِ بیرون رفت شمارِ صحیحی از پیکسل هاscale factorکنید. فاکتورِ بزرگی (

 برگزیده اید. resize typeراستایی است که در زیرِ 

 می توانید معلوم کنید چه الگویی براي تغییر اندازه اي می خواهید : resize typeدر فهرست پایین افتادنیِ  .3

• None .اندازه يِ اصلی هیچ تغییري نمی کند : 

• Width زرگ و بکند که با پهنايِ بیرون رفت یکی بشود. سپس به همان گونه درازا  : اندازه يِ پهنا را تا جایی بزرگ و کوچک می

 اصلی تغییر نکند. aspect ratioکوچک می شود تا 

• Height :  ر کند. سپس به همان گونه پهنا بزرگ واندازه يِ درازا را تا جایی بزرگ و کوچک می کند که درازايِ بیرون رفت را پ

 اصلی تغییر نکند. aspect ratioکوچک می شود تا 

• Fit :  ر کند. سپس بلندترینآن پهنا یا درازايِ بیرون رفت را پ اندازه يِ نگاره يِ اصلی را جوري تغییر می دهد که کوچک ترین سمت

 اصلی پیش نیاید. aspect ratioسمت به همان گونه تغییر می کند تا تغییري در 

• Fill : ر کند. سپس کوچک اندازه يِ نگاره يِ اصلی را جوري تغییآن پهنا یا درازايِ بیرون رفت را پ ر می دهد که بلند ترین سمت

 اصلی پیش نیاید. aspect ratioسمت به همان گونه تغییر می کند تا تغییري در 

• Distort : ر کنناندازه يِ هر دو سمت از نگاره يِ اصلی را تغییر می دهد تا هم پهنا و هم داین گزینه  رد. درازايِ بیرون رفت را پ

aspect ratio  تغییر می کند ، و بنا بر این ممکن است در نگارهdistortion .ایجاد بشود 

را نشان بزنید تا معلوم کنید که آیا پیکسل هايِ درون رفت باید به اندازه يِ جدید دوباره نمونه گیري شوند یا با مرکزِ  centerگزینه يِ  .4

 بیرون رفت تراز شوند. اگر مرکز را نداشته باشید ، گوشه يِ چپ و پایین از نگاره هايِ درون رفت و بیرون رفت با هم تراز می شوند.

 ان نگاره می توانید گزینه هايِ دیگر را نشان بزنید :براي میزان کردن چیدم .5

• Flip .جايِ بالا و پایین نگاره را با هم عوض می کند : 

• Flop .جايِ چپ و راست نگاره را با هم عوض می کند : 

• Turn  درجه می چرخاند. 90: نگاره را 
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• Black outside شان می دهد.: پیکسل هایی که بیرون از چهارچوبِ فرُمت هستند را سیاه ن 

• Preserve bounding box .رش بزند ، نگه می داردبیرون رفت هستند را به جايِ این که ب پیکسل هایی که بیرون از فرُمت : 

 تغییر شکل دادن نمونه هايِ عمقی

 نمونه هايِ عمقی را تغییر بدهید. می توانید جايِ DeepTransformبا تکمه يِ 

 ویدئويِ عمق داري بچسبانید که می خواهید آن را تغییر شکل بدهید.تکمه را به فیلم یا  .1

 را به کار بگیرید. translate z، و  translate x  ،translate yبراي جا به جا کردن نمونه هایتان ، کنترل هايِ  .2

باشند ژرفا را زیاد ، و ارزش هایی که  1نمونه را بزرگ و کوچک کنید. ارزش هایی که بزرگ تر از  z، ژرفايِ  zscaleبه کمک کنترلِ  .3

 باشند ژرفا را کاهش می دهند. 1کوچک تر از 

4.  درون رفت اگر ماسکی را به درگاهmask  آن مشخص کنید که چه بخش هایی از فریم و به چه اندازه تکمه بچسبانید ، می توانید به کمک

 انجام می گیرد تاثیر بگیرند.ژرفا ی که براي تغییر شکل از

 نمونه گیري نگاره هايِ عمق دار

می توانید از هر پیکسلِ مشخص در یک نگاره يِ عمق دار نمونه بگیرید. این تکمه داده هايِ ژرفا را با آمار و  DeepSampleبا تکمه يِ 

 ید.به شکلی گرافیکی ببین Deep Graphارقام به شما ارائه می کند ، ولی می توانید همان داده ها را در نمودارِ 

 بچسبانید. Deepيِ تکمه هارا به تکمه يِ دیگري از مجموعه  DeepSampleتکمه يِ  .1

 را بر رويِ پیکسل هایی در نمایشگر ببرید که می خواهید نمونه بگیرید. posنشانگرِ  .2

 sampleو در جدولِ  DeepSampleتکمه يِ  propertiesاطلاعاتی که در باره يِ نمونه يِ عمقی ارائه می شود را می توانید در قابِ  .3

 ببینید.

مشخص کنید که آیا می خواهید ارزش هايِ نمونه گیري شده از  accumulateهم چنین می توانید با تغییر وضعیت دادن گزینه يِ  .4

 ان بزنید).شپیکسل را تک به تک ببینید (نشان گزینه را بردارید) ، و یا ارزشِ ترکیب شده يِ نهایی را به شما نشان بدهد (گزینه را ن

 نوشتنِ داده يِ عمقی

بنویسید. در این جا با کنترل هایی  scanline OpenEXR 2.0می توانید نگاره هايِ عمق دار را با فرُمتDeepWrite  به کمک تکمه يِ 

 :هستند. کارهايِ زیر را انجام بدهید  Writeسر و کار پیدا می کنید که مانند کنترل هايِ تکمه يِ استاندارد 

1. Deep > DeepWrite  را برگزینید تا تکمه اي به همین نام درscript .تان جاي بگیرد 

کلیک کنید و به جایی بروید که می خواهید نگاره يِ عمق دار را  proxyیا  fileشمایلِ پوشه ِ میدانِ  ، بر روي propertiesدر قابِ  .2

 در آن پوشه ذخیره کنید.

کلیک کنید. اگر  OKداشته باشد. سپس بر رويِ دکمه يِ  exr.عمق دار بنویسید که گسترشِ پس از تعیین مسیر ، نامی براي نگاره يِ  .3

 ) نیز در نامِ آن می آید.####دارید سکانسی از یک نگاره را پردازش می کنید ، متغیرِ شماره يِ فریم (براي نمونه ، 
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 .bit float 32، یا  bit half 16را براي پرونده يِ پردازش شده برگزینید :  datatype  ،bit depthاز فهرست پایین افتادنیِ  .4

 را به الگویی پیکربندي کنید که می خواهید پرونده يِ پردازش را فشرده سازي کنید. compressionگزینه يِ  .5

) metadataاي را بردارید که معلوم می کند پرونده يِ پردازش شده چه فراداده اي ( ، گزینه metadataاز فهرست پایین افتادنیِ  .6

 داشته باشد :

• No metadata هیچ گونه ویژه گی سفارشی ساخته نمی شود ؛ و تنها فراداده اي که میدان هايِ سربرگ : )header مورد نیاز (

 را پر می کند نوشته می شوند.

• Default metadata ارزش هايِ فراداده اي ، : به کم کtime code  ، اختیاريedge code  ،frame rate  و میدان ،

 پر می شوند.  exposure headerهايِ 

• Default metadata and exr/* 
• All metadata except input/* 
• All metadata 

7.  به طورِ پیش فرض ، کلیدهايِ فراداده اي ناشناخته دارايِ پیشوندnuke  هستند که هنگامی که در یک پرونده نوشته می شوند به آن ها

 do not attach، بدون پیشوند نوشته شوند ، گزینه يِ  "همان گونه که هستند"چسبیده شده است. اگر می خواهید آن ها در پرونده 

prefix .را نشان بزنید 

 اگر نیاز باشد ، کنترل هايِ دیگر را میزان کنید. .8

 را فشار بدهید. Renderدکمه يِ  .9

 نوشته شده است. frame rateاست که در میدان هايِ اي برنامه از شما دامنه يِ فریمی را درخواست می کند. پیش فرض برنامه دامنه 

 را بزنید. OKدر صورت لزوم ، فریم هايِ آغازین و پایانی را تغییر بدهید ؛ و سپس دکمه يِ  .10

Nuke مقی را در یک پروندهيِ  داده يِ عscanline OpenEXR 2.0  ِمی نویسد (پرونده هايtiled OpenEXR 2.0  پشتیبانی نمی

 شوند).
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 روشِ کار با فراداده هايِ پرونده ___________________________

در نوار ابزار چیدمان شده اند می توانید با دانسته  Metadata، و همه يِ تکمه هایی که در فهرستRead  تکمه يِ  Metadataاز برگه يِ 

 هایی که در نگاره هایتان جاسازي شده اند کار کنید.

 Nukeفراداده ها در برنامه يِ 

 نگاره است که در پرونده يِ تصویري جاسازي شده اند. این دانسته ها می تواند براي نمونه یک فراداده مجموعه اي از دانسته ها در باره يِ

، پهنا ، و درازايِ اصلیِ نگاره باشند. این دانسته ها می توانند با دوربینی که براي گرفتن آن نگاره به کار رفته است ، و/یا  bit depthشاملِ 

 د.نبعدها ویرایش شده است ، به نگاره چسبانده شده باش

اسازي شده اند را نیز می خواند. سپس این فراداده ها در درخت نگاره اي را بارگذاري می کند ، فراداده هایی که در آن ج Nukeهنگامی که 

تان آن فراداده ها را ببینید و به کار بگیرید. براي نمونه ، می  scriptتکمه اي به پایین رد داده می شوند و بدین سان می توانید در هر جایی در 

 توانید فراداده اي را از راهexpression ) ها خاستگاهreference کنید. هم چنین می توانید فراداده اي که هست را ویرایش و یا پاك کنید (

 فراداده يِ به دست آمده را در پرونده هایی که بیرون می فرستید بنویسید.؛ فراداده يِ جدیدي را به یک پرونده بیافزایید ، و 

 ان نمی دهد.را نش bit depth، گاما و  QuickTimeبراي پرونده هايِ  Metadata یادداشت :

برداشته شده  propertiesاز قابِ  Writeو  Readاز تکمه هايِ  edge codeو  time codeمیدان هايِ  یادداشت :

 ، فراداده هنوز هست. input/edgecodeو  input/timecodeاند ؛ ولی به کمک کلیدهايِ 

سر و کار دارید ، می توانید مشخص کنید کدام فراداده يِ درون رفت به پایین  Mergeهنگامی که با یک تکمه يِ  نکته :

 بگذارید. Bو یا  Aرا یا بر رويِ  metadata from، گزینه يِ  Mergeدست رد داده شود. در بخشِ کنترل هايِ تکمه يِ 

 فهرستMetadata  ِدر نوارِ ابزارِ برنامه يNuke برگه يِ  داراي پنج تکمه است که ، همانندMetadata  ِاز تکمه يRead  براي کار ،

 با فراداده يِ یک پرونده شما را یاري می کنند :

درون رفت به پایین دست رد داده می شود را  این امکان را به شما می دهد که فراداده اي که با تکمه يِ ViewMetaDataتکمه يِ  •

 بررسی کنید.

 می توانید فراداده هايِ دو درگاه درون رفت را با هم سنجیده و تفاوت هايِ آن ها را ببینید. CompareMetaDataبا تکمه يِ  •

ه اي که در مسیرِ درون رفت هست را ویرایش کنید ، فراداده اي را به مسیر دبه شما اجازه می دهد فرادا ModifyMetaDataتکمه يِ  •

 بیافزایید ، و یا فراداده اي را از آن پاك کنید.

ه اي را از یک درون رفت به درون رفت دیگر رونوشت بگیرید و فراداده اي را دمی توانید فرادا CopyMetaDataکمک تکمه يِ  به •

 پالایش کنید تا از برخی از داده هايِ آن چشم پوشی شود.

زوده و با تکمه يِ درون رفت را به فراداده اف timecodeنیز این امکان را براي شما فراهم می کند که یک  AddMetaDataتکمه يِ  •

 آن را به پایین رد بدهید.
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 دیدن یک فراداده

بروید.  Metadataبه برگه يِ  Readاستاندارد تکمه يِ  propertiesآسان ترین راه براي دیدن فراداده يِ یک پرونده این است که در قابِ 

 با یک جست و جويِ ساده ، همه يِ فراداده هايِ موجود پرونده نمایش داده می شوند.

 

 براي پالایش کردن فهرستmetadata  ِمیدان ،search metadata for  ِرا به کار بگیرید. براي نمونه ، اگر نویسه يf  را در این میدان

را دارند. به طور پیش فرض ، جست و جو هم براي کلیدها و هم براي  fمی شوند که نویسه يِ بنویسید ، تنها کلیدها و ارزش هایی نشان داده 

یا  keys onlyرا به  withinارزش ها انجام می گیرد. اگر می خواهید جست و جو تنها در کلیدها و یا ارزش ها انجام شود ، گزینه يِ 

values only ُپرونده (براي نمونه ، پیکربندي کنید. براي نمونه ، با نوشتن فر متdpx/ ِدر میدان (search metadata for  ِو پیکربندي ،

 ، می توانید فراداده اي را ببینید که فرُمت پرونده را مشخص می کند. Keys onlyبر رويِ  within گزینه يِ

با سیستم  Windowsمعمولاً در سیستمِ نگاه می کنید ،  )input/ctimeزمانِ ساخت یک نگاره (به هنگامی که  یادداشت :

فرق می بینید. این به سبب آن است که سیستم هايِ عامل به راه هايِ گوناگون با زمان هايِ  Mac OSXو  Linuxهايِ 

 ) سر و کار دارند.creation timeساخت پرونده (

 ها خاستگاه کنید. expressionاگر بدانید چه کلیدهایی در درون رفت دارید ، می توانید آن ها را با 

 نیز می توانید فراداده هايِ یک پرونده را ببینید : ViewMetaDataبا تکمه يِ 

1. MetaData > ViewMetaData  را برگزینید تا تکمه

اي به همین نام پس از تکمه اي جاي بگیرد که می خواهید 

 آن را بررسی کنید. فراداده هايِ

، می  ViewMetaDataتکمه يِ  propertiesدر قابِ  .2

توانید فهرستی از فراداده هايِ جاسازي شده در پرونده را 

بخش شده  valueو  keyببینید. این فهرست به دو نیمه يِ 

  است.
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 سنجشِ فراداده هايِ میانِ درون رفت ها

را برگزینید تا تکمه اي به همین نام پس از دو تکمه اي جاي بگیرد که می  MetaData > CompareMetaDataاز نوارِ ابزار ،  .1

 خواهید فراداده هايِ آن ها را با هم بسنجید.

 بچسبانید. CompareMetaDataتکمه يِ  Bو  Aدو تکمه را به درون رفت هايِ  .2

نشان داده  CompareMetaDataتکمه يِ  propertiesیک فهرست از کلیدهایی که میان دو درون رفت با هم تفاوت دارند در قابِ

 می شود.

 پیرایش کردن فراداده ها

 چندین راه وجود دارد. Nukeبراي پیراستن یک فراداده در برنامه يِ 

 روشِ افزودن یک فراداده

1. MetaData > ModifyMetaData  ِرا برگزینید تا یک تکمه يModifyMetaData هید پس از تکمه اي جاي بگیرد که می خوا

 به فراداده يِ آن یک کلید جدید بیافزایید.

) در چهارچوبِ placeholderکلیک کنید. یک جانگهدار ( +، بر رويِ نشانه يِ  ModifyMetaDataدر بخشِ کنترل هايِ تکمه يِ  .2

metadata .پدیدار می شود 

 ، سمت راست). دو بار کلیک کنید (نگاره يِ پایین keyاین جانگهدار در زیرِ فهرست  بر رويِ .3

 باز می شود. Pick metadata keyپنجره يِ گفت وگويِ 

کلیک  OKدر میدانی که در پایینِ پنجره است ، نامی براي کلید جدید (که می خواهید آن کلید را به فراداده بیافزایید) بنویسید. بر رويِ  .4

 کنید (نگاره يِ پایین ، سمت چپ).

  

 دو بار کلیک کنید و براي کلید جدید ارزشی را بنویسید. dataبر رويِ جانگهدار در زیرِ  .5

 آن به فراداده افزوده می شود. کلید جدید و ارزشِ

 روشِ ویرایش کردن یک فراداده
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1. MetaData > ModifyMetaData  ِرا برگزینید تا یک تکمه يModifyMetaData  پس از تکمه اي جاي بگیرد که می خواهید

 فراداده يِ آن را ویرایش کنید.

) در چهارچوبِ placeholderکلیک کنید. یک جانگهدار ( +، بر رويِ نشانه يِ  ModifyMetaDataدر بخشِ کنترل هايِ تکمه يِ  .2

metadata .پدیدار می شود 

 باز می شود. Pick metadata keyک کنید. پنجره يِ گفت وگويِ دو بار کلی keyاین جانگهدار در زیرِ فهرست  بر رويِ .3

 را بزنید. OKکلیدي را برگزینید که می خواهید نام و ارزشِ آن را ویرایش کنید. دکمه يِ  .4

 افزوده می شود. ModifyMetaDataتکمه يِ  propertiesکلید به 

شِ آن دو بار کلیک کنید و دانسته ها را آن گونه که نیاز است ، بر رويِ کلید یا ارز ModifyMetaDataتکمه يِ  propertiesدر  .5

 ویرایش کنید.

 روشِ پاك کردن یک فراداده

1. MetaData > ModifyMetaData  ِرا برگزینید تا یک تکمه يModifyMetaData  پس از تکمه اي جاي بگیرد که می خواهید

 فراداده يِ آن را ویرایش کنید.

) در فهرستplaceholder کلیک کنید. یک جانگهدار ( +، بر رويِ نشانه يِ  ModifyMetaData تکمه يِ propertiesدر بخشِ  .2

metadata .پدیدار می شود 

را برگزینید (نگاره يِ پایین ،  Removeدو بار کلیک کنید و از فهرستی که باز می شود گزینه يِ  actionبر رويِ جانگهدار در زیرِ  .3

 سمت راست).

 دو بار کلیک کنید (نگاره يِ پایین ، سمت چپ). keyبر رويِ جانگهدار در زیرِ  .4

  

 باز می شود. Pick metadata keyپنجره يِ گفت و گويِ 

از فهرست کلیدهایی که هست ، کلیدي را برگزینید که می خواهید آن را پاك کنید ؛ سپس  .5

 را فشار بدهید. OKدکمه يِ 

را از فراداده پاك می کند. اگر به فراداده در بیرون رفت نگاهی  تکمه کلید برگزیده شده

 بیاندازید می توانید این را ببینید.

تکمه يِ  properties) در قابِ action( کُنش هاویرایش کردن فهرستی از 

ModifyMetaData 

 کلیک کنید. +براي اجرايِ یک کُنشِ جدید ، بر رويِ دکمه يِ  •
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(منها) را فشار بدهید. باید بدانید که این تنها بر رويِ کُنش هايِ  –براي لغو کردن یک کُنش ، آن را از فهرست برگزیده و سپس دکمه يِ  •

ModifyMetaData .تاثیر دارد ، و کلیدها را از فراداده اي که در نگاره يِ درون رفت جاسازي شده است پاك نمی کند 

 فهرست ، آن را برگزیده و سپس دکمه يِ پیکانِ رو به بالا را فشار بدهید. یتم به بالايِبراي جا به جا کردن یک آ •

 براي جا به جا کردن یک آیتم به پایینِ فهرست ، آن را برگزیده و سپس دکمه يِ پیکانِ رو به پایین را فشار بدهید. •

ن پالایش کردرونوشت برداري کردن فراداده اي از یک درون رفت به درون رفت دیگر و 

)filterفراداده ( 

1. MetaData > CopyMetaData  را برگزینید تا تکمه اي به همین نام درscript .تان جاي بگیرد 

2.  درون رفتimage .تکمه را به نگاره اي بچسبانید که می خواهید آن را به پایین دست رد بدهید 

 درون رفتMeta .را به تکمه اي بچسبانید که فراداده يِ آن را می خواهید براي بیرون رفت رونوشت بگیرید 

 کنید : زیر پیکربنديرا بر رويِ یکی از گزینه هايِ  Metadata Fromگزینه يِ  .3

• Image+Meta  فراداده را از درون رفت :Meta  به فراداده يِ نگاره اي می چسباند که به درون رفتImage سبانده چ

 شده است. اگر درون رفت ها کلیدهايِ فراداده ايِ همسانی داشته باشند ، ارزش ها از درون رفتMeta  ِبر رويِ ارزش هاي

 درون رفتImage .سوار می شوند 

• Meta only :  تنها فراداده يِ درون رفتMeta .را به کار می گیرد 

• Meta+Image  فراداده را از درون رفت :Image ب ه فراداده يِ درون رفتMeta .اگر درون رفت ها کلیدهايِ  می افزاید

 فراداده ايِ همسانی داشته باشند ، ارزش ها از درون رفتImage  بر رويِ ارزش هايِ درون رفتMeta .سوار می شوند 

• Image only  تنها فراداده يِ درون رفت :Image ار به دست می آورید مانند آن را به کار می گیرد. برآیندي که از این ک

گرفته می شوند. به  Imageرا به کار نبرده اید : هم نگاره و هم فراداده از درون رفتCopyMetaData  است که تکمه يِ 

 هر روي ، اگر بخواهید فراداده را پالایش کنید تا برخی چیزها را از آن کنار بزنید ، انجامِ این کار می تواند سودمند باشد.

 Imageو/ یا  Meta filteringدر زیرِ  Copy onlyبراي پالایش کردن فراداده هایی که از درون رفت ها گرفته شده اند ، میدان هايِ  .4

filtering  ِرا به کار ببرید. براي نمونه ، اگر نویسه يf  ِرا در میدانcopy only  ِبنویسید که در زیرMeta filtering  است ، تنها

را دارند. به طور پیش فرض ، جست و جو هم در  fرونوشت برداري می شوند که نویسه يِ  Metaزش هایی از درون رفت کلیدها و ار

کلیدها و هم در ارزش ها انجام می شود. اگر بخواهید کاري کنید که جست و جو تنها در کلیدها یا در ارزش ها انجام بگیرد ، گزینه يِ 

within  ِرا بر رويkeys only ا یvalues only  ، پرونده (براي نمونه بگذارید. براي نمونه ، با نوشتن فُرمتdpx/ ِدر میدان (

copy only ِو پیکربنديِ گزینه ي ، within  ِبر رويKeys only  پرونده يِ درون می توانید فراداده اي را رونوشت بگیرید که فرُمت ،

 رفت را مشخص می کند.

 فراداده  به Time Codeافزودنِ یک 

1. MetaData > AddTimeCode  ِرا برگزینید تا یک تکمه يAddTimeCode .تکمه اي تان جا بگیرد درون درخت 
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 نخستین فریم بر رويِ time codeکه به فراداده اي افزوده می شود از آن رد داده می شود. به طورِ پیش فرض ،  time codeیک 

سرعت بازپخشِ کلیپِ درون رفت به روز می شود ؛ که به نوبه  است. این نرخِ زمان در سرتاسرِ دامنه يِ فریم ، بر مبنايِ 01:00:00:00

 يِ خود با نمادfps (frames per second)  ِدر پنجره يProject Settings  ِکنترل می شود. اگر ارزشfps  را در این پنجره تغییر

 اداده به روز شده و تغییر را بازتاب می دهد.بدهید ، نرخِ زمان در فر

 

است. به جايِ  59.94یا  29.97با فریم هایی که می افتند نیز سر و کار دارد ؛ مانند زمانی که نرخِ فریمِ یک کلیپ  Nukeبرنامه يِ 

جدا می شوند) را  semicolon(با  HH;MM;SS;FFکه براي نرخِ زمان است ، می توانید فرُمتHH:MM:SS:FF  فرُمت پیش فرضِ 

 نیز به کار ببرید.

نمایشگر ، یک پیامِ خطا در پنجره يِ  به کار می برید non-drop frameرا با نرخ هايِ زمانِ  ;هنگامی که نشانه يِ  یادداشت :

 نشان داده می شود.

 بنویسید. startcodeباشد ، نرخِ زمانِ جدید را در میدانِ  01:00:00:00آغازین  اگر نمی خواهید نرخِ زمان در فریمِ .2

گرفته شود ، دستی مشخص کنید ، نشانِ  Project Settingsِ این که از فراداده و پنجره يِ اگر می خواهید سرعت بازپخش را ، به جاي .3

 سید.ارزشِ جدیدي را بنوی fpsرا بردارید و در میدانِ  get FPS from metadataگزینه يِ 

را نشان بزنید و در میدانِ  ?use start frameدیگري را مشخص کنید ، گزینه يِ  آغازینِ اگر می خواهید به جايِ نخستین فریم ،  فریمِ .4

start frame .ارزشِ جدیدي را بنویسید 

بگذارید و در میدانِ  AddTimeCode پس از تکمه يِ Textاگر می خواهید نرخِ زمان را بر رويِ نگاره به نمایش بگذارید ، یک تکمه يِ 

message  ِارزش[timecode] .را بنویسید 

 پردازش کردن یک فراداده

به شما اجازه می دهد که فراداده يِ پرونده ها را در فرُمت هايِ زیر بنویسید :  Nukeپردازش می کنید ،  Writeهنگامی که دارید با تکمه يِ 

.exr  ،.cin  ،.dpx  و ،.jpg ..فراداده ها را نمی توانید در فرُمت هايِ دیگر بنویسید 

، فهرست پایین افتادنیِ  Writeپردازش می کنید ، می توانید در بخشِ کنترل هايِ تکمه يِ  exr.هنگامی که فراداده را در یک پرونده يِ 

metadata : را به کار بگیرید و از آن جا معلوم کنید که فراداده چگونه نوشته شود 

• No metadata مورد نیاز را : هیچ فراداده اي در پرونده يِ بیرون رفت نوشته نمی شود ، به جز فراداده هایی که م یدان هايِ سربرگ

ر می کنند (مانند ، نامِ پرونده ، و پbbox.( 

• Default metadata  :time code  ،edge code  ،frame rate  وexposure .را در پرونده يِ بیرون رفت می نویسد 
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• Default metadata and exr/*  :time code  ،edge code  ،frame rate  ،exposure  و هر چیزي درexr/ در  را

 پرونده يِ بیرون رفت می نویسد.

• All metadata except input/*  همه يِ فراداده ، به جز هر چیزي که در :input/ يِ بیرون رفت می نویسد. است را در پرونده 

• All metadata : .همه يِ فراداده را می نویسد 

هر آن چه از فراداده که از آن فرُمت پشتیبانی می  Nukeرا پردازش می کنید ، برنامه يِ  exr.فرُمت دیگر به جر  هرپرونده اي با هنگامی که 

 نوشته می شود بر مبنايِ فرُمت پرونده گوناگون خواهد بود. کند را می نویسد. بنا بر این ، آن چه در پرونده يِ بیرون رفت

 دسترسی به فراداده يِ پرونده به کمکExpression  ِهايTCL 

 به راه هايِ زیر می توانید به فراداده ها از راهexpression  ِهايTCL : دست بیابید 

را به کار ببرید. براي  [metadata] عبارت درون تکمه می آید ،براي به دست آوردن فهرستی از همه يِ کلیدها در فراداده اي که به  •

را بنویسید ، فهرستی از همه  [metadata] عبارتmessage ، را پس از نگاره بیاورید و در میدانِ  Textنمونه ، اگر یک تکمه يِ 

 ارزش هايِ این کلیدها نشان داده نمی شوند. يِ کلیدهایی که در فراداده هستند بر رويِ نگاره پدیدار می شوند.

 را به کار ببرید. [metadata values]اگر می خواهید فهرستی از همه يِ کلیدها و ارزش ها را با هم داشته باشید ، 

•  بخصوص را در فراداده اي به کار بگیرید که به درون تکمه می آید ، عبارت براي این که ارزشی از یک کلید[metadata key]  را به

را با نامِ کلیدي جایگزین کنید که می خواهید ارزشِ آن را به کار بگیرید. براي نمونه ، اگر می خواهید نام و جايِ  keyکار ببرید. واژه يِ 

 ، عبارتmessage بیاورید و در میدانِ  Textپرونده يِ تصویري بر رويِ نگاره به نمایش در آید ، پس از نگاره یک تکمه يِ 

[metadata input/filename] .را بنویسید 

•  پالایش شده اي از کلیدها را در فراداده داشته باشید ، عبارت اگر می خواهید فهرست[metadata keys filter]  ِرا بیاورید. واژه ي

filter می ،  اشدب در نامِ کلید که ه ايرا با چیزي جایگزین کنید که می خواهید فهرست را با آن پالایش کنید. به جايِ صفر یا هر نویس

در نامِ آن ها به کار  fجایگزین کنید. براي نمونه ، اگر بخواهید فهرستی از همه يِ کلیدها داشته باشید که نویسه يِ  )asterisks( *توانید 

 رفته باشد ، عبارت[metadata keys *f*]  را بنویسید. اگر بخواهید فهرستی از همه يِ کلیدهایی داشته باشید که باinput/  آغاز

 می شوند ، عبارت[metadata input/*] .را بنویسید 

 ”s “separator-یدمان ، می توانید عبارت ت می شوند. براي تغییر دادن این چبه طورِ پیش فرض ، کلیدها در خطّ هايِ جدا از هم فهرس

می توانید  separatorه کار ببرید. با این کار کلید ها با یک خطِّ جدا کننده از چیزي که برگزیده اید جدا می شوند. به جايِ واژه يِ را ب

هر چیزي را بگذارید که می خواهید میانِ کلیدهايِ گوناگون نمایان شود. براي نمونه ، اگر بخواهید فهرستی از همه يِ کلیدهایی داشته 

 metadata –s “ “ keys]آغاز می شوند و با فضاهاي خالی از هم جدا شده باشند ، می توانید عبارتinput/  ه با باشید ک

input/*]  را بنویسید. اگر بخواهید همین فهرست با ویرگول از هم جدا شده باشد ، عبارت[metadata –s “ , “ keys input/*] 

 را بنویسید.

) را stringیک رشته يِ خالی ( Nukeمی کنید به فراداده اي دست بیابید که در مسیرِ داده اي وجود ندارد ،  به طورِ پیش فرض ، اگر تلاش

 را به کار ببرید. e flag-برگشت می زند. به جايِ این خطا ، پیش از نمادهايِ دیگر 
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 Pythonدست یافتن به فراداده ها با زبان برنامه نویسیِ 

 < Helpنیز می توانید به فراداده ها دست بیابید. براي دانستن بیش تر در این باره ، راهنمايِ برنامه ( Pythonبه کمک زبان برنامه نویسیِ 

Documentation.را بخوانید ( 
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 Nukeروشِ کار با پرونده هايِ شنیداري در برنامه يِ  ______________

تغییرات کلیدي در تصویر را با ضرب آهنگ صدا هماهنگ که  بسیار حیاتی این است بسیاري از پروژه هايِ ترکیب بندي ، یکی از کارهايِدر 

را به کار ببرید. براي هم تراز کردن فریم  AudioReadشنیداري می توانید تکمه يِ  براي خواندن یک پرونده يِ ، Nukeدر برنامه يِ  .کنید

 به نمایش بگذارید. Dope Sheetو  Curve Editorلیديِ ترکیب بندي تان با شکلِ موج دارِ صدا ، می توانید آن را در هايِ ک

 یک آغازِ تنُد و سریع

درست به مانند روشی که براي خواندنِ نگاره  بارگذاري کنید ؛ Nukeمی توانید یک پرونده يِ شنیداري را در  AudioReadبه کمک تکمه يِ 

بخوانید و  Nukeرا می توانید در برنامه يِ  aiff.و  wav.انجام می دهید. پرونده هايِ شنیداريِ فشرده نشده با فرُمتRead  با تکمه يِها 

 کنید. flipbookآن ها را براي بازپخش با فیلم یا ویدئویی که دارید 

 در این جا مروري خواهیم داشت به روشِ کار :

 بخوانید. یک پرونده يِ شنیداري را .1

 animationمی توانید به  Dope Sheetو  Curve Editor شکلِ موج دارِ صدايِ کلیپِ صوتی را به نمایش بگذارید. در پنجره هايِ .2

curve .دسترسی داشته باشید 

 و بشنوید.کنید تا برآیند به دست آمده را ببینید  flipbookتان را  scriptهر گاه این کارها را انجام دادید ، می توانید  .3

 Node Graphشنیداري به درونِ خواندنِ پرونده هايِ 

 بکشید. Node Graph به پنجره يِ Projectآورده اید ، می توانید پرونده يِ شنیداري را از برگه يِ  Nukeاگر کلیپ را به برنامه يِ 
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 ، پرونده يِ شنیداري تان را بخوانید : AudioReadوگرنه می باید با یک تکمه يِ 

 < Other، در نوار ابزارِ برنامه بر رويِ  AudioReadبراي ساختن یک تکمه يِ  .1

AudioRead .کلیک کنید 

 نباید به هیچ تکمه يِ دیگري چسبانده شود. AudioReadتکمه يِ

 رگذارينیز می توانید یک پرونده يِ شنیداري را با Readبا یک تکمه يِ  نکته :

یبانی رایانه بروید که پرونده يِ شنیداري (که برنامه آن را پشتکنید. براي این کار نخست تکمه را بسازید و سپس به جایی بر رويِ 

 بکند) را نگه داشته اید.

رایانه تان بروید که پرونده يِ شنیداري را نگه به جایی بر رويِ  file، به کمک کنترلِ  AudioReadتکمه يِ propertiesدر قابِ  .2

را  aiff.و  wav.می تواند پرونده هايِ شنیداري فشرده سازي نشده با فرُمتNuke  داشته اید و می خواهید آن را در برنامه بخوانید. 

 پشتیبانی کند.

 کار کنید. time rangeبر حسب ثانیه ، با میدان هايِ  Nukeبراي نوشتنِ زمان هايِ آغاز و پایانِ صدا در برنامه يِ  .3

هید بخوانید را بر حسب ثانیه بنویسید. این یانِ پرونده يِ شنیداري که می خواآغاز و پا ، زمان هايِ file time rangeدر میدان هايِ  .4

ریدن داده ها در ارزش ها خود به خود به ارزش هایی در پرونده پیکربندي می شوند ؛ ولی می توانید با بNuke .آن ها را تغییر بدهید 

 را فشار بدهید. Reload اگر می خواهید تغییراتی که داده اید را کنار بگذارید و پرونده يِ شنیداري را دوباره بارگذاري کنید ، دکمه يِ .5

6.  از فهرستratesource : منبعی براي نرخِ فریم برگزینید ، 

• File رونده يِ شنیداري می خواند.: نرخِ فریم را از رويِ پ 

• Custom  ِمیدان در ایم جا می توانید به کمک :rate .نرخِ فریمی را بنویسید که خودتان می خواهید ، 

 شنیداريساختن و ویرایش کردن نمودارهايِ 

و  Curve Editorدر پنجره هايِ  شنیداري را می خوانید ، می توانید شکلِ موج دارِ آن را به نمایش بگذارید و هنگامی که یک پرونده يِ

Dope Sheet  بهanimation curve .آن دست بیابید 

 ساخت یک نمودارِ فریمِ کلیدي

 ، می توانید نمودارهایی از داده هايِ صوتی درست کنید : AudioReadتکمه يِ  propertiesاز قابِ  curvesدر بخشِ 

براي نمونه ، اگر ارزشِ  پیکربندي کنید. key intervalفاصله اي که می خواهید فریم هاي کلیدي در نمودار داشته باشند را در میدانِ  .1

 بگیرید ، فریم هايِ کلیدي به فاصله يِ هر سه فریم از فیلم یا ویدئويِ درون رفت ساخته می شود. 3این میدان را برابر با 

کلیک کنید ؛ بدین سان می توانید آن را در  generateبراي این که داده يِ صوتی به شکلِ یک نمودار ساخته شود ، بر رويِ دکمه يِ  .2

 به کار ببرید. Dope Sheetو  Curve Editorپنجره هايِ 

ببینید و اگر نیاز باشد آن را میزان کنید.  می توانید ترازهايِ استریویی چپ و راست بر رويِ فریم جاري را rightو  leftدر میدان هايِ  .3

 هر تغییري که بدهید خود به خود بر رويِ نمودار بازتاب می دهد.
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 Dope Sheetو  Curve Editorپیرایش کردن یک نمودارِ صوتی در پنجره هاي

گزینه هایی کردن به راست کلیک  با، کار می کنید  Dope Sheetو  Curve Editorهنگامی که دارید با نمودارهايِ صوتی در پنجره هايِ

 به نمایش در آمدن شکلِ موج دارِ کلیپ تان را میزان کنید : چگونگیِ یابید که با آن ها می توانیددست می 

 را برگزینید. View > Audioراست کلیک کنید و گزینه يِ  Dope Sheetیا  Curve Editorپنجره يِبر رويِ  .1

 AudioRead nodeیا  ProjectDefaultزینید و بسته به آن چه که می خواهید ببینید ، گزینه يِ را برگ Sourceسپس گزینه يِ  .2

 را نشان بزنید.

،  channelگزینه يِ مناسب در زیرِ اگر دارید با یک کلیپِ استریو با بیش از یک کانالِ صوتی کار می کنید ، می توانید با تیک زدن  .3

 کانالِ شنیداري تان را برگزینید.

 ، الگويِ نمایش براي شکلِ موج دار صدا را برگزینید : DrawStyleبا برگزیدن یکی از گزینه هايِ  .4

• Off .شکلِ موج داري براي صدا کشیده نمی شود : 

• Behind ) نمودارهايِ پویانمایی یک شکل موجی در پشت :animation curve.کشیده می شود ( 

• Below پویانمایی کشیده می شود.دارهايِ و: یک شکلِ موجی در زیرِ نم 

 

Flipbook ) کردن شیارِ صوتیAudio Track( 

 کنید : flipbookهر گاه کارتان را انجام دادید ، می توانید برآیند هايِ به دست آمده را 

 کلیک کنید.  flipbook this Viewer، بر رويِ دکمه يِ  Comp Viewerدر پنجره يِ نمایشگرِ  .1

به کار  Audioرا برگزینید ، که می خواهید در فهرست پایین افتادنیِ اي ، پرونده يِ شنیداري خوانده شده  Flipbookدر پنجره يِ  .2

 بگیرید.

 ببینید و به آن گوش فرا دهید. Flipbookدر تان را را بزنید. کلیپ  OKدکمه يِ  .3
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 پیش نمایش و پردازش کردن ____________________________

) برتر را پشتیبانی می Dynamic rangeیک پردازش گرِ توکارِ سریع و با کیفیت بالا ، با وضوحِ رنگ و دامنه يِ پویاییِ ( Nukeبرنامه يِ 

 کند که هیچ گونه کُندي در روند کار ندارد.

 پردازش در برنامه يِ در باره يِ روندNuke 

 : Nukeکلیدي در باره يِ موتورِ پردازش گرِ  برخی از جنبه هايِ

) processorدر ارزیابی خودش چندین پردازش کننده يِ سیستم ( است. موتورِ پردازش گر )multi-threadedچند تکه اي ( پردازش •

 را به کار می گیرد ؛ که این یک مزیت به شمار می رود.

از  تا بتوانید بی درنگ بخش هایی کندم می براي شما فراهرا این امکان  پردازشی که مبتنی بر بافر است) ، (در برابرِ Scanlineپردازشِ  •

 پردازش که بیرون فرستاده می شود را ببینید.

 انجام می گیرد. bit-32) با دقتlinear light level ّارزیابی ها ، به کمک ترازهايِ خطّیِ نور ( •

 یک آغازِ تنُد و سریع

 در این جا مروري کوتاه خواهیم داشت به روند کار :

تنها به پیش نمایشِ بخشِ خاصی   ROIدر پنجره يِ نمایشگر می توانید فیلم یا ویدئوتان را پیش نمایش بدهید و به کمک دکمه يِ  .1

 از پنجره بپردازید.

ه در پنجر  Flipbookکنید. یک راه سریع براي این کار این است که بر رويِ دکمه يِ  flipbookپس از این می توانید کلیپ تان را  .2

که باز می شود دامنه يِ فریم و پیکربندي هايِ دیگر را انجام داده و سپس  Flipbookنمایشگر کلیک کنید. در پنجره يِ گفت و گويِ يِ 

 اجرا می شود. flipbookکلیک کنید. کلیپ خود به خود در نمایشگرِ  OKبر رويِ دکمه يِ 

،  Capture با به کارگیريِ، می توانید  (براي نمونه ، هنگامی که می خواهید دو نمونه را با هم بسنجید) براي به اشتراك گذاري کارتان .3

در پنجره يِ نمایشگر کلیک کنید. در پنجره   Capture بر رويِ دکمه يِ با وضوح پایین ذخیره کنید. jpg.کلیپ را با سکانس هايِ 

 را فشار بدهید. OKدامنه يِ فریم و پیکربندي هايِ دیگر را انجام داده ، و دکمه يِ که باز می شود ،  Captureيِ گفت و گويِ 

از  AudioRead، یک کلیپِ صوتی را نیز خوانده باشید ، تنها با برگزیدن همان تکمه يِ  AudioReadاگر به کمک یک تکمه يِ  .4

 کنید. flipbookدئوتان ، می توانید صدا را نیز با فیلم یا وی Audioفهرست پایین افتادنیِ 

درست باشد ، فیلم یا ویدئوتان را در یک دستگاهpixel aspect ratio  براي بازبینیِ برآیند نهایی از این نظر که فضايِ رنگ ویدئو و  .5

 نمایشگرِ ویدئویی بیرونی پیش نمایش بدهید.

به کلیپ تان  Writeبراي این کار ، می باید دست کم یک تکمه يِ اگر از برآیند کار راضی بودید ، می توانید کلیپ تان را پردازش کنید.  .6

می توانید فرُمتfilename  پیکربندي کنید. هم چنین در میدانِ  propertiesبچسبانید ؛ و سپس ویژه گی هايِ پردازش را در قابِ 

 م ها را براي جبران به کار بگیرید.شماره هایی از فری frameپردازش را مشخص کرده ، و اگر نیاز باشد ، به کمک کنترلِ 
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داشته باشید که به درخت تکمه اي چسبانده شده اند ، می توانید همه يِ آن ها را پردازش  Writeبیش تر از یک تکمه يِ  scriptاگر در  .7

ردازش ، از نوارِ فهرست کرده ، و یا تنها تکمه اي را برگزینید که می خواهید پردازش شود. سپس می توانید براي آغاز شدن روند پ

Render > Render All  یاRender > Render Selected .را برگزینید 

 پیش نمایشِ پرونده يِ بیرون رفت

را براي  flipbookپیش نمایش بدهیم ؛ چگونه یک  Nukeدر این بخش یاد می گیریم که چگونه فریم هايِ تک را در یک پنجره يِ نمایشگرِ 

 سکانسی از فریم ها پردازش کنیم ؛ و چگونه پرونده يِ بیرون رفت را در یک دستگاه نمایشگرِ ویدئویی بیرونی به نمایش بگذاریم.

 Nukeپیش نمایش در یک نمایشگرِ 

امه ماره دار را فشار بدهید) ، برنرا به بیرون رفت تکمه يِ معینی بچسبانید (تکمه را برگزیده و یک کلید ش Viewerهنگامی که یک تکمه يِ 

 به کمک همه يِ پردازش کننده هايِ بومیِ موجود در سیستمِ رایانه ، بی درنگ پردازشِ بیرون رفت را در نمایشگر آغاز می کند. Nukeيِ 

 د :به یاد داشته باشید نکته هایی که در زیر می آیند براي سرعت بخشیدن به این نوع پردازشِ پیش نمایش هستن

) کنید. پس از این zoom inنگاره ارزیابی شود ، به بخشی که می خواهید پرداش شود بزرگ نمایی (نخست ، اگر نیاز ندارید که همه يِ  •

 ) که در نمایشگر دیده می شوند را پردازش می کند.scan lineتنها بخشی از خطّ هايِ پویشی ( Nuke، برنامه يِ 

نمایشگر را به کار بگیرید. در این  ROI (region of interest)ِ این ، می توانید براي پردازش کردن بخشی از نگاره ، جنبه يِ به جاي •

 پردازش می شود. ROIجا همه يِ نگاره را در نمایشگر دارید و تنها بخشِ 

 ROIبه کار انداختنِ جنبه يِ پردازشیِ روشِ 

، که نشان  نمایشگر به رنگ قرمز در می آید  ROIرا فشار بدهید. دکمه يِ  Alt+Wهستید ، کلیدهايِ  نمایشگر که در پنجره يِ .1

 آن است که این جنبه به کار افتاده است. دهنده يِ

ین ا نمایشگر بکشید تا بخشِ دلخواه تان مشخص شود. اکنون نمایشگر تنها پیکسل هایی را پردازش می کند که درون ماوس را بر رويِ .2

 بخش هستند.

 جاري ROIروشِ ویرایش کردن جا و یا اندازه يِ 

 در نمایشگر پدیدار می شود. ROI. پوشاننده يِ کلیک کنید تا به رنگ قرمز در آید  ROIبر روي دکمه يِ  .1

 : ROIبراي جا به جا کردن  .2

 است را بگیرید و آن را به جايِ دلخواه تان جا به جا کنید. ROIمویی شکلی که در میانه يِ بعلاوه يِ 

 : RoIبراي بزرگ و کوچک کردن  .3

 را بگیرید و ماوس را بکشید. ROIیکی از گوشه ها یا کناره هايِ 

 ROIروشِ از کار انداختنِ جنبه يِ پردازشیِ 
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خاموش است. اکنون نمایشگر همه  ROIان می دهد جنبه يِ که نش کلیک کنید. دکمه به رنگ خاکستري در می آید  ROIبر رويِ دکمه يِ 

 يِ نگاره اي که در آن دیده می شود را پردازش می کند.

Flipbook کردن سکانس ها 

Flipbook دامنه اي از نگاره ها (معمولاً با وضوحِ  روندي گفته می شود که در آن کردن یک سکانس بهproxy پردازش و سپس باز پخش (

 بتوانید به درستی ویژه گی هايِ حرکتی جلوه هایی که به سکانس داده اید را بررسی کنید.می شوند تا 

 چندین گزینه را دارید : Nukeکردن در برنامه يِ  flipbookبراي 

رنامه فریم هايِ پردازش شده را به کار بیاندازید ؛ سپس این فریم ها را در نمایشگرِ خود ب automation disk cachingمی توانید  •

 بازپخش کنید. این گزینه به شما اجازه نمی دهد که براي بازپخش فریم ها ، نرخِ مشخصی را تعریف کنید.

می توانید سکانس هايِ تصویري گذرایی را به بیرون پردازش کنید. این ابزار یک ابزارِ بازپخشِ مبتنی بر  flipbookingبه کمک ابزارِ  •

RAM )RAM-buffering playback ( ِاست. سکانس هايِ پردازش شده را می توانید در خود نمایشگر به نمایش بگذارید و در نرخ

 فریم تعریف شده اي آن ها را بازپخش کنید.

راه اندازي کنید.  Nukeکننده يِ بیرونی را در برنامه يِ  flipbook، یک نرم افزارِ  Pythonبا به کارگیريِ زبانِ می توانید  هم چنین •

 ) را بخوانید.Python )Help > Documentationتن بیش تر در این باره ، راهنمايِ برنامه در باره يِ براي دانس

خود به خود نسخه اي از هر فریم که نمایش داده می شود را بر رويِ دیسک ذخیره می کند. هنگامی که سکانس هایی از فریم  Nukeنمایشگرِ 

شده و براي بار دیگر که آن را بازپخش کنید ، بی درنگ یا  cacheگاره هايِ از پیش پردازش شده ها را در نمایشگر بازپخش کرده باشید ، ن

Real-time  نمایش داده می شوند. این که چه شمار از فریم هاcache  .شوند ، به وضوحِ تصویري و پیکربنديِ سیستمِ رایانه تان بستگی دارد

 را تعریف کنید. Viewer cacheخیره شدن  و اندازه يِ می توانید جايِ ذ Preferencesدر پنجره يِ 

 cacheچه چیزي پیکربندي کرده باشید ،  viewer settingsدر پنجره يِ  viewer buffer bit depthبسته به این که براي گزینه يِ 

اشد. این که کدام گزینه را به کار بگیرید ب bit (float)-32، یا  bit (byte)  ،16 bit (half-float)-8داده هايِ تصویريِ شاملِ می تواند 

دقتّ بالاتري را فراهم می آورند ، ولی  byteنسبت به الگويِ  floatو  Half-floatبه سرعت و کیفیتی که می خواهید بر می گردد. الگوهايِ 

 روند کار را کُندتر می کنند.

 Viewer cacheروشِ پیکربنديِ جا و اندازه يِ 

1. Edit > Preferences  ِرا کلیک کنید تا پنجره يِ گفت و گويPreferences .به نمایش در آید 

جایی که  می بینید. در این میدان ، در Disk Caching-temp directory، میدانی به نامِ  Performance > Cachingدر بخشِ  .2

 ).c:/tempیسید (براي نمونه ، پوشه را بنوذخیره شوند ، نام و مسیرِ  flipbookمی خواهید نگاره هايِ 

 برسد. image cache، شمارِ گیگابایت هایی را مشخص کنید که می خواهید به مصرفcomp disk cache size  به کمک کنترلِ  .3

به روز  preferencesکلیک کنید. براي این که  OK ، بر رويِ Preferencesدر گوشه يِ پایین و راست پنجره يِ گفت و گويِ  .4

 را ببندید و دوباره آن را باز کنید. Nuke نی شود ، برنامه يِرسا
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هنگامی که بر رويِ دکمه هايِ بازپخش در نمایشگر  می کند. cacheاکنون نمایشگر هر فریمی که به نمایش در آید را در پوشه يِ مشخص شده 

 می خواند. cacheنگاره ها را از این  Nukeکلیک کنید ، یا نوارِ نشانگرِ بازپخش را به چپ و راست بکشید ، برنامه يِ 

را بازتاب می دهند. این بدان  scriptشده نام هايِ مخصوص به خود دارند که جايِ بیرون رفت آن ها در  cacheباید بدانید نگاره هايِ 

شده  cacheکنید بدون این که بر رويِ نگاره هايِ از پیش  cache است scriptکه در تکمه چندین معناست که می توانید نگاره ها را از 

 نوشته شوند.

 کنیم Flipbookچگونه یک سکانس را 

 کنید. flipbookتکمه اي را برگزینید که می خواهید بیرون رفت آن را  .1

آن را کلیک کنید تا بیرون رفت تکمه را دستی در  Renderرا برگزینید ، نخست باید دکمه يِ  Writeیادداشت : اگر در گامِ بالا تکمه يِ 

 لازم به اجراست. Writeتعریف کرده اید. این گام تنها در مورد تکمه يِ  fileمسیري پردازش کنید که در میدانِ 

2. Render > Flipbook selected  را برگزینید (یاAlt+F .(را فشار بدهید 

پایین و راست نمایشگر کلیک کنید. بدین سان  در گوشه يِ  Flipbook this Viewerاین می توانید بر رويِ دکمه يِ به جايِ 

 می شوند. flipbookچسبیده هستند  Viewer ، تکمه هایی که به تکمه يِ

 باز می شود. Flipbookیک پنجره يِ گفت و گويِ 

که به تازگی فعال کرده اید  Viewerش فرض از تکمه يِ پی ببینید که پیکربندي هایتان در پنجره يِ گفت و گو درست باشند. ارزش هايِ .3

 رونوشت برداري می شوند. اگر نیاز باشد می توانید آن ها را تغییر بدهید :

• Flipbook  : نرم افزاري که می خواهید برايFlipbook  د.یپیکربندي کناز این جا کردن به کار ببرید را 

• Take settings from پیش فرض از آن به کار  لوم کنید کدام نمایشگر باید براي کشیدن ارزش هاي: از این جا می شود مع

 برود.

• Enable ROI  ِبراي تعریف کردن بخش :ROI .تان این گزینه را نشان بزنید 

• Channels  این که کدام لایه در برآیند :flipbook .شده نمایش داده شود ، از این جا مشخص کنید 

• Frame range  دامنه يِ فریمی که براي :flipbook .می خواهید را پیکربندي کنید 

• Use proxy  این گزینه را نشان بزنید تا الگوي :Proxy .را به کار بگیرید 

• Render in background  : این گزینه را نشان بزنید تا پردازش در پس زمینه انجام بگیرد. اگر این گزینه را نشان بزنید ، می

را نیز پیکربندي کنید. با نخستین گزینه می توانید شمارِ تکه ها و بندهایی  Memory limitو  Thread limitتوانید کنترل هايِ 

به کار می برد را  Nukeکه  cacheيِ دوم می توانید اندازه يِ حافظه يِ  در پس زمینه به کار می گیرد ، و با گزینه Nukeکه 

 مرزبندي کنید.

که بر  RAMبیش تري از  این کار می تواند اندازه يِاگر دارید چندین سکانس را در پس زمینه پردازش می کنید ،  یادداشت :

هايِ پس زمینه اي از هر نوعی به اجرا گذاشته می شود ، می رويِ سیستم رایانه تان هست را به کار بگیرد. هنگامی که پردازش 
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بیش تري از آن چه بر رويِ سیستمِ رایانه تان هست نیاز ندارند ؛ وگرنه ،  Ramباید مطمئن شوید که همه يِ آن ها با هم به 

 ممکن است مشکلاتی مانند هنگ کردن سیستم گریبان گیرتان شود.

• Delete existing temporary files  این گزینه را نشان بزنید تا پیش از :flipbook  کردن ، همه يِ پرونده هايِ موقتی

 موجود که هم نام با پرونده هایی هستند که تازه می خواهند پردازش شوند ، پاك شوند.

• LUT  :LUT  ، مناسب براي دیدن را برگزینید. به طورِ پیش فرضflipbook خطّی پردازش  پرونده هایتان را با یک فضايِ رنگ

 رد کند. flipbookرا به  LUTکرده و تلاش می کند یک پرونده يِ 

• Burn in the LUT  : ِاگر این گزینه را نشان بزنید پرونده هايflipbook  باLUT  به کار گرفته شده پردازش می شوند. اگر نشان

) به نمایش گذاشته می شود. اگر در برنامه يِ LUTهمسانِ خودش (بر مبنايِ نامِ  LUTبا  flipbookاین گزینه را بردارید ، 

flipbook  یکLUT  همسان داشته باشید ، به تر است این گزینه را نشان نزنید. بدین سان ، هنگامی که ارزش هايِ پیکسلی در نرم

 به دست می آورید جفت و جور هستند. Nukeگر اندازه گیري می شوند ، با آن چه که در نمایش flipbookافزارِ 

• Audio :  اگر می خواهید درflipbook  ِصدا را نیز با کلیپ تان داشته باشید ، تکمه يAudioRead  مورد نیازتان را از این

 فهرست پایین افتادنی برگزینید.

• Continue on error : پردازش حتا اگر در ه نگامِ آماده سازي به خطایی برخورد کرد ، باز هم این گزینه را نشان بزنید تا روند

 به کار خود ادامه بدهد.

• Buffer : .از این جا می توانید بافري را پیکربندي کنید 

 را فشار بدهید. OKدکمه يِ  .4

 scriptکه در پنجره يِ  بیرون رفت تکمه هايِ برگزیده شده را به مانند یک سکانسِ گذرا ، با دامنه يِ فریم و وضوحی Nukeبرنامه يِ 

settings این کار کمی زمان می برد.پردازش می کند.  تعریف شده است 

را اجرا کرده و سکانسِ گذرا را در آن بارگذاري می کند. به کمک کنترل  flipbookنمایشگرِ  Nukeپس از این که پردازش تمام شد ، 

 ه جلو و عقب بکشید.می توانید بازپخش سکانس را ب flipbookهايِ نمایشگرِ 

 نمایشگر گرفتن داده هايِ

بی درنگ و  flipbookبراي یک 

سریع ، می توانید آن چه در نمایشگر 

است را بگیرید. این کار به نامِ 

Playblast  نیز خوانده می شود. در

این جا آن چیزي که از نمایشگر گرفته 

 می شود با فرُمت.jpg  ذخیره می شود

ا مرور کنید. این کار که می توانید آن ر

براي بررسی کردن بی درنگ پویانمایی 

تان بسیار کارآمد است.  3Dدر فضايِ 
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،  3Dو  2Dن گونه که هست (شامل صحنه هايِ انمایشگر را هم Playblastندارید. روشِ  full scanlineدر این جا نیازي به پردازشِ 

 می کند. flipbookها و ...) Roto  ،wipeايِ پیرامون یک شکلِ مانند خط ه transformدستگیره ها و پوشاننده هايِ 

 براي گرفتنِ آن چه در نمایشگر است :

در زیرِ نمایشگر و در سمت راست دکمه ِ  Captureدکمه يِ بر رويِ  .1

flipbook .کلیک کنید 

 باز می شود. Captureپنجره يِ 

 مورد نیاز را بردارید. Flipbookاز فهرست پایین افتادنی ابزارِ  .2

تان بیش از یک نمایشگر دارید ، نمایشگرِ مورد نیاز را  scriptاگر در  .3

 برگزینید.

ببینید پیکربندي هايِ دیگري که در پنجره يِ گفت و گو هستند درست باشند.  .4

پیش فرض از نمایشگري که هم اکنون به کار است رونوشت می ارزش هايِ 

 می توانید به دلخواه تغییر بدهید :زیر را  شود. گزینه هايِ

• Frame range  ِاز این جا می توانید مشخص کنید ارزش هايِ پیش فرض از کدام نمایشگر کشیده شوند ؛ و نیز دامنه يِ فریم :

flipbook .را پیکربندي کنید 

• Use proxy  ِبا نشان زدن این گزینه الگوي :proxy .به کار گرفته می شود 

• Render in background  : این گزینه را نشان بزنید تا پردازش در پس زمینه انجام بگیرد. اگر این گزینه را نشان بزنید ، می

را نیز پیکربندي کنید. با نخستین گزینه می توانید شمارِ تکه ها و بندهایی  Memory limitو  Thread limitتوانید کنترل هايِ 

به کار می برد را  Nukeکه  cacheبا گزینه يِ دوم می توانید اندازه يِ حافظه يِ در پس زمینه به کار می گیرد ، و  Nukeکه 

 مرزبندي کنید.

• Delete existing temporary files  اگر می خواهید پرونده هایی که از پیش :cache  شده اند به جا بمانند ، نشانِ این

 گزینه را بردارید.

• Continue on error :  پردازش حتا اگر در هنگامِ آماده سازي به خطایی برخورد کرد ، باز هم این گزینه را نشان بزنید تا روند

 به کار خود ادامه بدهد.

• Buffer : .از این جا می توانید بافري را پیکربندي کنید 

• Customize write path : ه هايِ این گزینه را نشان بزنید تا بتوانید دستی جایی که باید پروند.jpg  ذخیره بشوند را پیکربندي

 ).Write pathکنید (در زیرِ میدانِ 

• No flipbook :  ِاگر نیازي نمی بینید که ابزارflipbook ده شده دامنه يِ فریم را نشان بدهد ، این گزینه را به کار بیاندازید.یبرگز 

 hash frame paddingیا  printfمی گیرد. فراموش نکنید که  jpg.تنها سکانس ها را با فُرمتNuke  برنامه يِ  یادداشت :

 ) را بیاورید.####یا  4d%(مانند 

 کلیک کنید تا آن چه در نمایشگر دارید گرفته شود. OKبر رويِ دکمه يِ  .5
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پیکربندي کرده اید ، و یا در  Preferencesدر پنجره يِ جايِ پیش فرض که  در گرفته می شود یا jpg. با فرُمت ی کهدامنه يِ فریم

 (اگر این گزینه را به کار انداخته باشید) مشخص کرده اید. Write pathپوشه اي ذخیره می شوند که با کنترلِ 

 پیش نمایش دادن بر رويِ یک دستگاه نمایشگرِ ویدئویی بیرونی

فیلمِ ویدئویی تان درست است یا نه ، می  pixel aspect rationبراي آن که بتوانید برآیند نهایی را بررسی کنید تا ببنید که فضايِ رنگ و 

) external broadcast video monitor(توانید نگاره يِ نمایشگري که در آن هستید را بر رويِ یک دستگاه نمایشگرِ ویدئویی بیرونی 

 FireWire) یا یک درگاهmonitor output نمایشگر (پیش نمایش بدهید. براي این کار به سخت افزارِ دیگري ، مانند یک کارت بیرون برِ 

 پیشنهاد می شوند : براي این کار نیاز دارید. دستگاه هايِ سخت افزاري زیر آزمایش شده و

• BlackMagic  ِسخت افزار :BlackMagic Decklink PCI  ِشاملِ دستگاه هاي ،Decklink SDK  ،Decklink 4K 

Extreme  و ،Ultrastudio SDI Thunderbolt  ِتنها براي سیستم)Mac.( 

• AJA  ِخانواده ي :AJA Kona PCI  ِشامل ،Kona 3G  ،LHi  و ،LHe Plus. 

• AJA  ِتنها براي سیستمِ عاملMac OSX  :IoXT  برايThunderbolt  و ،Io4K  برايThunderbolt 2 

کار می کنید ، باید به نکته هاي زیر را توجه  Nukeيِ  برنامهبیرون برِ نمایشگر در  هنگامی که دارید با کارکردهايِ یادداشت :

 داشته باشید :

یا درایورهايِ  SDK 10.4.4 11.3کارکرد درستی داشته باشد ، به درایورهايِ  Mac OSXبراي  AJA Io4Kبراي آن که  •

 بالاتر نیاز دارد.

 وند.نمی ش پشتیبانی Linuxهم اکنون در سیستمِ  AJAکارت هايِ نمایشگرِ بیرون برِ  •

 یا بالاتر پشتیبانی می شود. OSX 10.7 (lion)تنها بر رويِ سیستم عاملِ  Mac  ،AJA Kona 3Dدر رایانه هايِ  •

 دارند پشتیبانی نمی شود. AMDکارت هايِ نمایشگرِ بیرونی هم اکنون بر رويِ سیستم هايِ عاملِ ویندوز که کارت گرافیک  •

به دستگاه هايِ نمایشگر ویدئویی بیرونی بیرون بفرستد.  bit RGB-10یا  bit RGB-8می تواند نگاره ها را با الگوهايِ رنگNuke  برنامه يِ 

خود به خود برگزیده  bit-10پیکربندي شده باشد ، رنگfloat  یا  half-floatبر رويِ نمایشگر  gl buffer depthزمانی که گزینه يِ 

 به کار گرفته می شود. bit-8موارد دیگر ، رنگ در همه يِ  می شود.

 gl buffer depth، تنها اگر براي گزینه يِ  bit-10با برگزیدنِ الگويِ بیرون رفت دستگاه نمایشگر با عبارت  یادداشت :

و  Half-floatواقعی بیرون فرستاده می شود. الگوهايِ  bit-10برگزیده شده باشد ، رنگfloat  یا  half-floatیا الگويِ 

float  ا الگويِ ب که براي بیرون برِ نمایشگربه مراتب پردازش هايِ کنُدتري را به همراه دارند ؛ بنا بر این ، پیشنهاد می شود

byte  10کار شود ، مگر این که دستگاه نمایشگر براي کار خود تنها به رنگ-bit اشد.نیاز داشته ب 

 روشِ پیش نمایشِ بیرون رفت بر رويِ یک دستگاه نمایشگرِ ویدئوییِ بیرونی

1.  بر رويِ پنجره يِ نمایشگر که هستید کلیدS  ِرا فشار بدهید. پنجره يViewer Settings .باز می شود 
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کار بگیرید را برگزینید. گزینه يِ  ، دستگاه نمایشگرِ بیرونی که می خواهید به monitor output deviceاز فهرست پایین افتادنیِ  .2

enable monitor output  را نشان بزنید. همه يِ دستگاه هایی که هستند خود به خود شناسایی شده و در این فهرست جاي می

 گیرند.

زینه برگزینید. گ ، الگويِ نمایشی براي دستگاهی که در گامِ پیشین برگزیده اید را monitor output modeاز فهرست پایین افتادنیِ  .3

هايِ موجود به دستگاهی که به کار می برید بستگی دارند. به طورِ پیش فرض ، الگويِ نمایشی که به تازگی به کار برده اید برگزیده شده 

 است.

در  monitor outputبروید ، یا بر رويِ دکمه يِ  Viewer > Toggle Monitor Outرا فشار بدهید. به  Ctrl+Uکلیدهايِ  .4

 کلیک کنید.  Viewer overflowرست پایین افتادنیِ فه

 

 .بیرون فرستاده می شودچسبانده شده است بر رويِ دستگاه نمایشگرِ بیرونی که برگزیده اید  viewerاز همین اکنون ، هر بیرون رفتی که به 

ره انگاره اي که به دستگاه نمایشگرِ بیرونی می رود ، صرف نظر از این که چه نمایشگري و با چه پیکربندي هایی به آن پیوند شده است ، همو

full frame ) 1:1، بدون بزرگ نمایی ratio) و بدون جا به جایی ، (unpanned است. این بدان معناست که اندازه يِ فرُمت هایی که (

در آیند و با آن جفت  نمایشگر این که به اندازه يِ) براي PAL/NTSCبراي  640x512/640x448ماهنگ شده هستند (براي نمونه ، کمی ناه

 تغییر نمی کنند. و جور شوند

بعدي که همین  ذخیره می شود. بارِ scriptرا ذخیره کنید ، این پیکربندي نیز به همراهscript  فعال است  monitor outputاگر هنگامی که 

script  ِرا باز کنید ، گزینه يmonitor output .ال استفع 

 روشِ از کار انداختن نمایش بر رويِ یک دستگاه نمایشگرِ ویدئویی بیرونی

 یکی از کارهايِ زیر را انجام بدهید :

 کلیک کنید. Viewerدر بخشِ کنترل هايِ  monitor outputدکمه يِ بر رويِ  •

 را برگزینید. Viewer > Toggle Monitor Outputزار از نوارِ اب •

با دستگاه نمایشگري کار می کنید که می توانید چیزهایی را بر رويِ صفحه نمایشِ آن بکشید را فشار بدهید. اگر دارید  Ctrl+Uکلیدهايِ  •

 مانند دستگاه)Digital Cinema Desktop Preview  که باApple Final Cut Pro  است) این کارکرد می تواند بسیار نصب شده

 کارآمد باشد.

•  بر رويِ نمایشگر که هستید کلیدS  ِرا فشار بدهید. پنجره يViewer Settings  ِباز می شود. نشانِ گزینه يenable monitor 

output .را بردارید 
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 پردازش کردن پرونده يِ بیرون رفت

شبکه پردازش کنید. پیش از پردازش ، ببینید  Render farmنگاره هایتان را می توانید بر رويِ همان سیستم رایانه خودتان ، یا بر رويِ یک 

) output format، فرُمت بیرون رفت ( Project Settingsمناسبی را به کار می برید. هم چنین ببینید که در  Syntaxکه براي نامِ پرونده 

 درستی را به کار گرفته باشید. proxy formatو 

را برگزینید ، پرونده يِ به دست آمده بر همان پایه شماره می خورد ؛ براي نمونه ،  Render farm 15به طورِ پیش فرض ، اگر 

image.0015.rgbبه هر روي ، می توانید .  از راهexpression  ها ، با مشخص کردن فریمِ آغازین ، وoffset  هايِ پایدار این رفتار را

 تغییر بدهید.

 گاهی شاید بخواهید یک نگاره را پردازش کرده و همین نگاره يِ پردازش شده را در برنامه بخوانید. چون خواندن بیرون رفتی از یک پرونده

در پروژه هايِ بزرگ به کار شما سرعت از راه درخت تکمه اي بالادست است ، این کار می تواند  سریع تر از ارزیابی کردن بیرون رفت آن

 بدهد.

هم زمان می باید شمارِ بزرگی از پرونده ها را بارگذاري کند (براي نمونه ، با صدها  Nukeهایی که  scriptدر  یادداشت :

رونده آورده شده است) ، ممکن است شمارِ دستگیره هايِ موجود پ TimeBlurکه به دنبالِ ان ها تکمه هايِ  Readتکمه يِ 

 ها با مشکل روبرو شود. scriptبراي هر آماده سازي از اندازه يِ لازم تجاوز کند و همین سبب شود که پردازشِ 

ونده را بر رويِ همه يِ سیستم ها پشتیبانی می کند ؛ به هر روي ، اگر نیاز بود رپ 2048خودش تا بیش از  Nukeبرنامه يِ 

 به دست بگیرد ممکن است سیستم تان به مشکل بخورد.ي را بیش تر پرونده يِ که از این شمار

را (بسته به نسخه يِ سیستم) افزایش بدهید.  256پیش فرضِ  ، می توانید محدوده يِ Mac OSXبر رويِ سیستمِ عاملِ 

 Terminalرا از همان  Nukeبنویسید و سپس برنامه يِ  Terminalرا از  ulimit –Sn 2048براي این کار فرمانِ 

session .اجرا کنید 

 وضوح و فُرمت پردازش

، بسیار مهم است که الگويِ فعالِ جاري را  scriptپیش از پردازشِ یک 

همه يِ پردازش  Nuke. برنامه يِ proxyیا  full-sizeبررسی کنید : الگويِ 

یک  ها را در اندازه يِ الگويِ جاري اجرا می کند. بنا بر این ، زمانی که

script ِدر الگوي proxy  ِآماده سازي در اندازه ي پردازش می شود ، روند

proxy  ِانجام می گیرد و نامی که در میدانproxy  ِاز تکمه يWrite  است

را معلوم  proxyبه نگاره يِ بیرون رفت داده می شود. اگر نامِ پرونده يِ 

را  proxyنکنید ، پردازش با یک خطا از کار می ایستد. اندازه يِ نگاره يِ 

 نوشت. full-sizeرا نمی شود بر رويِ نگاره يِ  proxyهرگز نمی شود تغییر داد و نگاره يِ 

را از نوارِ فهرست برگزینید ، یا نشانگرِ  Edit > Project Settingsجاري ،  scriptبراي پرونده يِ  proxyبراي دیدن و تغییر دادن وضوحِ 

 را فشار بدهید. Sاست کلیدproperties Bin   یا Node Graphماوس که بر رويِ پنجره يِ 
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 predefined resolutions، می توانید یک فرُمت پردازشی جدید را از فهرست پایین افتادنیِ  Project Settingsاز قابِ ویژه گی هايِ 

-fullرا از زیرِ  newتوانید گزینه يِ را تغییر وضعیت بدهید. هم چنین می  proxy(وضوح هايِ از پیش تعریف شده) برگزینید ، و پردازشِ 

size format  یاproxy format  ، برگزینید ؛ یا اگر می خواهید براي ترکیب بندي وضوح هايِ سفارشی را براي پردازش تعریف کنید

وح هایی که از پیش در زیرِ پردازش می کنید ، براي به کار بردن وض proxyرا به کار ببرید. هنگامی که در الگويِ  proxy scaleمیدان هايِ 

proxy format  وproxy scale .راست را به کار بگیرید پایین افتادنیِ در سمت هم چنین ببینید  تعریف شده است ، فهرستread 

proxy file  ِبه آن چه که می خواهید پیکربندي شده باشد. این پیکربندي کنترل می کند که تکمه هايRead  ِچگونه پرونده را در الگوي

proxy ) براي خواندن به کار بگیرندfull res  یاproxy.( 

 )Writeتکمه هايِ بیرون بر (

را در  Writeوضوح و فرُمت درستی را برگزینید ؛ سپس تکمه هايِ 

بگذارید که می خواهید نگاره ها را از آن جا  scriptجایی از 

 پردازش کنید.

معمولاً در زیرِ درخت ترکیب بندي جاي می  Writeیک تکمه يِ 

گیرد تا بیرون رفت نهایی را پردازش کند. به هر روي ، تکمه هايِ 

Write  هم درگاه هاي درون رفت و هم بیرون رفت دارند ؛ بنا بر

 قرار داد. scriptاین می شود آن ها را در هر جایی از 

دازش را تنها براي ترکیب بندي تان می توانید روند پر scriptدر 

به اجرا  Writeو یا براي همه يِ تکمه هايِ  Writeیک تکمه يِ 

 در آورید.

 تک Writeروشِ پردازش کردن یک تکمه يِ 

 برگزینید که می خواهید نگاره اي را از آن جا پردازش کنید. scriptتکمه اي را در  .1

2. Image > Write  ِرا برگزینید (یا می توانید در پنجره يNode Graph  که هستید کلیدW  .(را فشار بدهیدNuke  ِیک تکمه ي

Write برگزیده بودید می چسباند و قابِ  را به تکمه اي که در گامِ پیشینproperties .آن را باز می کند 

شان ن وضوحِ درستید که براي بیرون رفت که می خواهید پردازش کند ، بچسبانید ؛ و ببین Writeرا به تکمه يِ  Viewerیک تکمه يِ  .3

جا به جا شوید. وضوحِ بیرون رفتی  proxyو  full-resرا فشار بدهید تا میانِ دو وضوحِ  Ctrl+Pداده شود. اگر نیاز باشد ، کلیدهايِ 

 که به نمایش در می آید براي پردازش به کار گرفته می شود.

(بسته به این که آیا می خواهید نگاره ها با وضوحِ بالا   proxyیا  file، بر رويِ شمایلِ پوشه يِ میدانِ  propertiesدر قابِ  .4

high res  پردازش شوند یا در وضوحِ پایینlow res کلیک کنید ، و به پوشه اي بروید که می خواهید سکانسِ پردازش شده تان در (

 آن جا ذخیره شود.
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پردازش شده پس از مسیر ، نامی براي نگاره يِ  .5

را فشار بدهید. اگر دارید  OKبنویسید و دکمه يِ 

سکانسی از یک نگاره را پردازش می کنید ، متغیرِ 

) را در نام گذاري ####شماره يِ فریم (براي نمونه ، 

 بیاورید.

 اگر نیاز باشد ، کنترل هايِ زیر را میزان کنید : .6

نشان خور و فهرست پایین  به کمک گزینه هايِ •

ا برگزینید ، کانال هایی ر channelsافتادنیِ 

 که می خواهید پردازش شوند.

به کمک فهرست پایین افتادنی و میدانِ درون  •

 رفتframe  ِآماده سازي شده يِ جاري و شماره اي که فریمِ نوشته شده به خود می گیرد را پیکربندي کنید.، رابطه يِ میانِ فریم 

به جايِ این که از پردازشِ درخت تکمه اي بالادست  Writeرا نشان بزنید ؛ با این کار ، بیرون رفت تکمه يِ  read fileگزینه يِ  •

 ساخته شود ، پرونده يِ پردازش شده را می خواند.

یین افتادنیِ را به هم برگردانید ، از فهرست پا Nukeهنگامی که قرار است فضايِ رنگ نگاره و فضايِ رنگ توکار خود برنامه يِ •

colorspace  ، ِتبدیلِ ارزشجدول )LUT.که می خواهید به کار بگیرید را برگزینید ( 

پردازش می شوند برگزینید. اگر فرُمتی را از این جا معلوم نکنید ، فرُمتی را براي نگاره هایی که  file typeفهرست پایین افتادنیِ  از •

 ،Nuke ) گسترشیextension پرونده است را به کار می برد.) که در نام 

را نشان  limit to rangeاگر می خواهید زمانی که بیرون از دامنه يِ فریم مشخص شده می شوید ، تکمه از کار بیافتد ، گزینه يِ  •

 جرا شود.در همین دامنه ا Writeفریم هایی را بنویسید که می خواهید تکمه يِ ، دامنه يِ  frame rangeبزنید. در میدان هايِ 

 را کلیک کنید. Render، دکمه يِ  Writeتکمه يِ  propertiesدر قابِ  .7

8. Nuke  ِدامنه فریم را می پرسد و آن چه در میدان هايframe range  نوشته اید را پیش فرض دارد. اگر خواستید ، فریم هايِ آغاز و

 کلیک کنید. OKيِ ) ، و سپس بر رويِ دکمه 100-1پایانی را تغییر بدهید (براي نمونه ، 

هنگامی که می خواهید دامنه يِ فریمی را براي پردازش مشخص کنید ، می توانید دامنه فریم هايِ پیچیده اي را در پنجره  نکته :

را بنویسید ، تنها همین  ”25-22 15 10 8 5-1“بنویسید. براي نمونه ، اگر فریم هايِ  frame range promptيِ گفت و گويِ 

 ها پردازش می شوند. به همین گونه می توانید چندین دامنه فریمِ مشخص را در خطِّ فرمان بنویسید ؛ براي نمونه : 
Nuke –F 1-5 –F8 –F10 –F15 –F22-25 –x myscript.nk 

دازش پر نی که پردازش تمام شد ، نگاره هايِمی توانید پیش رفتنِ روند پردازش را ببینید. زما statusدر پنجره يِ باز شده يِ 

 مشخص کرده بودید ، افزوده می شوند. 4شده به پوشه اي که در گامِ 

) و یک data typeبا افزودنِ الگويِ داده اي (کار پردازشی را انجام می دهید ، می توانید  Writeزمانی که با تکمه يِ  نکته :

ویژه نیرو بیاورید. براي نمونه ، می توانید  رونده ، به یک الگويِ داده ايِ) پیش از مسیرِ پcolon( :نشانه يِ 

ftiff:c:/Temp/test.tif  را به عنوان مسیرِ پرونده بنویسید تا پرونده اي پردازش شود که الگويِ داده ايِ آنftiff  ِو گسترش ،

 باشد. tifآن 
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 scriptدر  Writeبرگزیده شده یا همه يِ تکمه هايِ  Writeروشِ پردازش کردن تکمه هايِ 

که می خواهید پردازش شود ، بچسبانید ؛ و ببینید که براي بیرون رفت وضوحِ درست  Writeرا به یک تکمه يِ  Viewerیک تکمه يِ  .1

 نشان داده شده باشد.

جا به جا شوید. وضوحِ بیرون رفتی که به نمایش  proxyو  full-resرا فشار بدهید تا میانِ دو وضوحِ  Ctrl+Pاگر نیاز باشد ، کلیدهايِ  .2

 در می آید براي پردازش به کار گرفته می شود.

که قرار است یکی یکی پردازش را شوند را تغییر بدهید. براي این کار ، در میدانِ  Writeاگر بخواهید می توانید چیدمانِ تکمه هايِ  .3

render order ردازش بدهید.به آن ها شماره اي براي پ 

 یکی از کارهايِ زیر را انجام بدهید : .4

•  تکمه يِ دلخواهWrite  ، که برگزیده شده استRender > Render selected  را برگزینید (یا کلیدF7 (را فشار بدهید 

 را فشار بدهید). F5را برگزینید (یا کلیدRender > Render all  گزینه يِ  •

پیش فرض از نمایشگري که فعال  ، اگر نیاز باشد ، ویژه گی هايِ پردازش را میزان کنید. ارزش هايِ Renderدر پنجره يِ گفت و گويِ  .5

 دارید گرفته می شوند.

• Frame range .دامنه يِ فریمی که براي پردازش می خواهید را پیکربندي کنید : 

• Use proxy  بزنید تا الگويِ  نشان: این گزینه راproxy .را به کار بگیرید 

• Render in background  ِاگر این گزینه را نشان بزنید پردازش در پس زمینه انجام می گیرد ؛ و نیز می توانید کنترل هاي :

#CPU limit  وMemory limit  ِرا پیکربندي کنید. گزینه يِ نخست شمارِ تکه ها و بندهایی را مرزبندي می کند که برنامه ي

Nuke با گزینه يِ دیگر می توانید اندازه يِ در پس زمینه به کار می برد .memory cache  کهNuke  به کار می گیرد را

 مرزبندي کنید.

را محدود می کنید که تنها شمارِ  Nukeها براي این می تواند سودمند باشد که با این کار برنامه يِ  CPUپیکربندي کردن شمارِ 

را محدود به  Nukeرا اشغال کند). یا می توانید  CPU 4می تواند  threads 4ها را به کار بگیرد (براي نمونه ،  CPUخاصی از 

 بتوانید در خود برنامه کار کنید.ها کنید تا هم چنان که پردازش در پس زمینه انجام می شود  CPUشماري از 

• Continue on error  خ بدهدکارِ پردازش ر باز هم پردازش به کار خود ادامه : با نشان زدن این گزینه ، اگر خطایی در روند ،

 می دهد.

• Views .نماهايِ استریویی که می خواهید پردازش شوند را از این جا پیکربندي کنید : 

 را فشار بدهید. OKدکمه يِ  .6

 QuickTimeیادداشتی براي پردازش کردن پرونده هايِ 

 را پردازش می کنید ، می توانید : mov.اگر دارید پرونده هايِ 

• کدُك QuickTime  ِپایین افتادنی را از فهرستcodec .برگزینید 
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بر  pixel format) کار می کنید ، از پیکربندي کردن کنترلِ Avid DNxHD )Avid AVDnاگر دارید با کُدك  یادداشت :

پرهیز کنید ؛ چرا که موضوعِ شناخته شده اي در این کدُك است که سبب می شود با پیش رفتنِ هر فریمی در  r408رويِ 

 سکانس ، فریم ها تاریک تر شوند.

 را پیکربندي کنید : encoderبراي نوشتنِ پرونده کتابخانه يِ  •

 Apple ProRes 4444باشد. براي نمونه ،  read onlyبسته به کُدکی که به کار می برید ، این کنترل می تواند  یادداشت :

 mov64یا  mov32این امکان را به شما می دهد که یکی از گزینه هايِ  Animationرا به کار می برد ، ولی  mov64همیشه 

 را برگزینید.

o Move32  ِهمه يِ دامنه فریمِ کدُك هاي :QuickTime  ِرا به کار می گیرد ، ولی به سبب پیچیدگیِ اضافی در هنگام

decode .آماده سازي را کُند کند کردن می تواند روند 

o Move64 :  ، آماده سازي براي سرعت بخشیدن به روندdecode/encode  بسته بندي و از بسته در آمده يِ خودتان را

 را پشتیبانی می کند. QuickTimeبه کار می برد ، ولی تنها زیر مجموعه اي از کدُك هايِ 

پیش فرض می زند. اگر دارید  decoderبراي کُدك به کار رفته در پرونده ، به سریع ترین  Nukeبرنامه يِ  یادداشت :

پیش فرض می زند. وگرنه ،  readerبه آن  Nukeپشتیبانی شده است ،  mov64زیر مجموعه يِ  الگویی را می خوانید که با

move32 Reader .پیشین به کار می رود 

• Fps  ِبازپخش در هر ثانیه را از این جا می توانید براي پرونده يِ بیرون رفت پیکربندي کنید.: فریم هاي 

• Audio file  تا پرونده يِ شنیداريِ جداگانه اي را در بیرون رفت منظور کنید. یا دستی مسیرِ پرونده را : این امکان را به شما می دهد

 کلیک کنید و به جایی بروید که پرونده يِ شنیداري آن جاست. browseدکمه يِ بنویسید ، و یا بر رويِ 

• Audio offset  ِزمانِ آغاز شدن هر پرونده يِ شنیداري که در کنترل :audio file عریف شده است را پیکربندي می کند. یگانِ اندازه ت

منفی سبب می شوند که صدا پیش از پرونده يِ ویدئویی آغاز شود. ارزش مشخص می شود. ارزش هايِ  unitsگیري به کمک کنترلِ 

 شود. آغازهايِ مثبت نیز سبب می شوند که پرونده يِ شنیداري پس از پرونده يِ ویدئویی 

• Write timecode  ِال شده باشد ، برنامه يهنگامی که این گزینه فع :Nuke  ِنرخِ زمان را درون فراداده ي.mov .می نویسد 

خوانده می شود. اگر این میدان خالی باشد ، نرخِ زمان در  input/timecodeيِ کلیديِ نرخِ زمان از فراداده  یادداشت :

 پرونده نوشته نمی شود.

 QuickTimeپرونده هايِ پیشرفته يِ گزینه هايِ 

می توانید گزینه هايِ پیشرفته يِ کدُك را میزان کنید. گزینه هایی که می بینید ، بسته به این که  Advancedبا باز کردن فهرست پایین افتادنیِ 

 را به کار می برید ، گوناگون هستند. mov64 encoderیا  mov32 encoderآیا 
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 شرح کنترل
Move32 encoder 

Codec options ) کلیک کنید تا یک پنجره يِ گفت و گو با ویژه گی هايِ فشرده سازيcompression settings پیشرفته (

 نمایش داده شود.

Fast start  ، ال استهنگامی که این گزینه فعMOV .ها می توانند بازپخش بشوند ولی هنوز بارگذاري کُند است 

Use format 
aspect 

پردازش شده با آن چه که به درون رفت  mov.در پرونده يِ  pixel ratio هنگامی که این گزینه فعال است ، 

 می رود یکی است.

 را براي کار شناسایی می کند. pixel ratioهنگامی که این گزینه غیر فعال است ، این کدُك است که 

د مجاز باشند که در هنگامِ را می نویسند بای NTSCو  PALکُدك هایی که یادداشت : 
دارند را  1:1هایی به جز  pixel ratioرا تعیین کنند ؛ ولی فُرمت هایی که  ratioپردازش 

 باید دستکاري کرد.
Ycbcr matrix  روندي را پیکربندي می کند کهRGB  بهYCbCr  .برگردانده شودRec 601  وRec 709  ِویژه گی هاي

ITU.BC  را دنبال می کنند ؛ ولیNuke Legacy  ،Nuke Legacy Mpeg  و ،Nuke Legacy YUVS 

 Recماتریس رنگی را به  Format-basedبراي سازگاري با نسخه هايِ پیشینِ برنامه نگه داشته شده اند. 

پیکسل و یا  840براي فرُمت هایی با پهنايِ  Rec 709پیکسل ، و  840براي فرُمت هایی با پهنايِ زیر  601

 بالاتر پیکربندي می کند.

 کار می کنید. YCbCrاین پیکربندي تنها زمانی موجود است که دارید با یک الگويِ پیکسلی مبتنی بر 

Pixel format  پیکسلی الگو را تعریف می جاري پشتیبانی می شوند را فهرست می کند. فرُمت فرُمت هايِ پیکسلی که با کدُك

 درخواست می شود : QuickTimeاز  Nukeبرنامه يِ  layoutکند و 

 QuickTime. این گزینه معلوم می کند که آیا YCbCr (A)یا  RGB (A)فضايِ رنگ پیکسلی : یا  •

از خودQuickTime Reader  برگردانِ فضايِ رنگ را به عهده بگیرد یا مسئولیت این کار به گردنِ 

به این  RGB (A)، برگزیدنِ یک فضايِ رنگYCbCr  پیکسلی  باشد. براي یک الگويِ Nukeبرنامه يِ 

برگردانده شود. برگزیدن فضايِ  YCbCrبه  RGBتکیه کند تا رنگQuickTime  به  Nukeمعناست که 

 رنگYCbCr (A)  نیز به این معناست کهNuke  برگردانِ فضايِ رنگ را به عهده بگیرد خودش مسئولیت

 بخصوص به کار گرفته شود (این گزینه پیشنهاد می شود). ycbcr matrix، و بنا بر این می تواند یک 

• Pixel bit depth  :8-bit  ،16-bit  و .... این گزینه ،encoding depth  را پیکربندي می کند که

 bit depth) به کار رفته است. هر چه decompressingدر آوردن فریم ها (به هنگامِ از فشرده سازيِ 

 سرعت کار پایین آمده و حافظه يِ بیش تري مصرف می شود.بزرگ تر باشد دقتّ بالاتر می رود ، ولی 

• Pixel layout  :422  ،444  ،4444  ِو .... این گزینه معلوم می کند کانال هاي ،chroma  در بافر

 442پایین تري نسبت به بافرِ  spatial Chromaنمونه گیريِ  444مان شوند. بافرهايِ چگونه چید

ر آن را برگزید. براي موارد دیگ است دارد ؛ بنا بر این ، معمولاً زمانی که این بافر در دسترس باشد ، به تر

 ،Nuke  ِبسته يِ بافرsub-sampled  ِرا به وضوحfull res .باز می کند 
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• Range ا : یBiased  ِاست و یا خالی. براي الگوهايRGB (A) 1تا  0(از  ی، ارزش ها دامنه يِ کامل (

، ارزش ها به طورِ پیش فرض در دامنه يِ ویدئویی هستند ، که در هر  YCbCr (A)دارند. براي الگوهايِ 

همین گذاشته شود ،  Biasedسقفی را ارائه می کنند. اگر این گزینه بر رويِ  يِ بالا و پایینِ دامنهدو انتها

 سقف تنها در انتهايِ بالایی موجود خواهد بود.

• (4cc)  ِ4: این گزینه الگويِ پیکسلیcc  است که به توسطQuickTime API .تعریف شده است 

 این پیکربندي به به ترین فرُمت مورد قبولِ کدُك پیش فرض می زند.

Write nclc  ِال باشد ، داده ياین گزینه زمانی که فعnclc  را درcolr atom .نمونه يِ ویدئویی می نویسد 

Write gamma  ِال باشد ، داده ياین گزینه زمانی که فعgama  را درgama atom .نمونه يِ ویدئویی می نویسد 

Write prores  ِال باشد ، داده ياین گزینه زمانی که فعprores  را درprores header  .نمونه يِ ویدئویی می نویسد 

Mov64 encoder 
bitrate Bitrate  ِهدف را پیکربندي می کند که کدُك تلاش می کند در محدوده اي که با کنترل هايbitrate 

tolerance  وquality min/max .مشخص می شود به آن برسد 

 فعال است. MPEG-4-Videoتنها براي کُدك هاي خاص مانند  bitrateکنترلِ یادداشت : 
Bitrate tolerance  اندازه اي را پیکربندي می کند کهbitrate  ِمی تواند از کنترلbitrate  ، کمی گوناگونی نشان بدهد. با

 پیکربندي کردن این آستانه شکست هايِ پردازشی خیلی پایین می آیند.

-MPEG-4تنها براي کُدك هاي خاص مانند  bitratetoleranceکنترلِ یادداشت : 

Video .ال استفع 
Quality min  ت را پیکربندي می کنند که کدُك در آن دامنه می تواند براي رسیدنبیش ترین و کم ترین ارزشِ دامنه يِ کیفی

 دامنه هايِ بالاتر می تواند تخریبِ تصویري را به همراه داشته باشد. معین مانور بدهد. bitrateبه یک 

-MPEG-4تنها براي کُدك هاي خاص مانند  Quality min/maxکنترلِ یادداشت : 

Video .ال استفع 

Quality max 

Gop size  معلوم می کند که چه شمار از فریم ها می توانند با هم دیگر باشند و یکGOP )group of pictures (

 فشرده سازي را شکل بدهند.

با این کنترل خیلی با احتیاط کار کنید. اگر تغییرات بزرگی به این کنترل بدهید یادداشت : 
 می تواند نرم افزارهايِ دیگري را متوقفّ کند که پرونده يِ پردازش شده را می خوانند.

فعال  MPEG-4-Videoتنها براي کُدك هاي خاص مانند   gop sizeکنترلِ یادداشت : 
 است.

B frames  ِبیش ترین شمارِ فریم هايB .را پیکربندي می کند که می توانند در پرونده يِ پردازش شده پشت سر هم بیایند 

 .منتفی می کندرا در پرونده يِ بیرون رفت  Bبیش ترین شمارِ فریمی هايِ نقشِ ) ، 0ارزشِ پیش فرض (

فعال  MPEG-4-Videoتنها براي کُدك هاي خاص مانند   b framesکنترلِ یادداشت : 
 است.

Write nclc  ِال باشد داده ياین گزینه زمانی که فعnclc  را درcolr atom .نمونه يِ ویدئویی می نویسد 
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Nuke  ِپیکسلی برگزیده شده را ، به همراه برخی دانسته هايِ دیگر ، در فراداده يِ پرونده می نویسد. سپس اگر پرونده ي فضايِ رنگ و فرُمت

آن فراداده را می خواند و توانایی این را دارد که براي پرونده پیش فرض هايِ درست را دستچین  Nukeپردازش شده را بخوانید ، برنامه يِ 

 را به کار بگیرید. ViewMetaDataبراي این که بتوانید خودتان فراداده را ببینید ، یک تکمه يِ  .کند

براي بارگذاريِ پرونده هايِ  پشتیبانی می شود. Mac OSXو  Windowsتنها بر رويِ سیستم عاملِ  QuickTimeبه طورِ پیش فرض ، 

QuickTime  ِدر سیستمِ عاملLinux  می باید پیشوندmov64: : را پیش از مسیر پرونده و نامِ پرونده به کار بگیرید. براي نمونه 

mov64:/users/john/job/FILM/MG/final_comp-V01.####.mov 

تا پرونده است ؛  FFmpeg Open Source، که بر مبنايِ کتابخانه يِ  به کار می گیرد  خودش را Readerبرنامه يِ   Nukeبدین سان ، 

کردن نگاره هايِ بیرون رفت  encodeرا براي  Open Sourceکند. به یاد داشته باشید که این کتابخانه يِ  decodeرا  QuickTimeهايِ 

 به کار می گیریم.

 ، برخی از کاربران پیامِ خطايِ زیر را در پایانِ روند پردازش گزارش می کنند : QuickTimeهنگامِ نوشتنِ پرونده هايِ 

Failed to flatten movie data: the movie is open in another application. 

در سیستم عاملِ  Finderبرنامه يِ باز شده است. این می تواند براي نمونه  يدیگر روندهايِ دراین به سبب آن است که پرونده يِ بیرون رفت 

Mac OSX  هم چنین می تواند یک جست و جوگرِ پرونده يِ سیستمی ، یا باشد که تلاش می کند پیش نمایشی از پرونده را نشان بدهد ؛ یا

را خاموش  Fast Startگزینه يِ  Writeیک ویروس یاب باشد که تلاش می کند پرونده را شناسایی کند. در بخشِ کنترل هايِ تکمه يِ 

 کنید.

 OpenEXRیادداشت هایی براي پرونده هايِ پردازش شده يِ 

را پشتیبانی می کند. با این پرونده ها می توانید کانال ها ، لایه ها ، و نماها را در  OpenEXR 2.0 بخشیِپرونده هايِ چند  Nukeبرنامه يِ 

می تواند سریع تر انجام بگیرد ؛  exr.با ذخیره سازي داده ها بدین گونه ، بارگذاريِ پرونده هايِ  پرونده ذخیره کنید.در بخش هایی جداگانه 

، به جايِ آن که همه يِ پرونده را بخواند ، تنها به بخشی از پرونده که درخواست می شود دسترسی پیدا می کند. به هر روي ،  Nukeچرا که 

را به عنوانِ نگاره هايِ  exr.براي سازگاري با نسخه هايِ پیشینِ برنامه ، گزینه اي در اختیار شما قرار گرفته است که می توانید پرونده هايِ 

 ) پردازش کنید.single-partبخشی (تک 

را باز  Writeتکمه يِ  propertiesپردازش شده تان ذخیره شوند ، قابِ  exr.اگر می خواهید معلوم کنید که داده ها چگونه در پرونده يِ 

 را بر رويِ هر یک از گزینه هايِ زیر بگذارید : interleaveکنید و گزینه يِ 

• Channels , layers and views  در یک بخش از پرونده يِ با هم : کانال ها ، لایه ها و نماها را.exr  .پردازش شده می نویسد

و دیگر برنامه  Nukeپیشینِ برنامه يِ  انید مطمئن باشید که با نسخه هايِبدین سان ، یک پرونده يِ تک بخشی ساخته می شود و می تو

 .سازگاري داردرا به کار می گیرند ،  OpenEXRنرم افزاري که کتابخانه يِ قدیمی ترِ هايِ 

• Channels and layers  ِکانال ها و لایه ها را با هم در یک بخش از پرونده ي :.exr  پردازش شده می نویسد ، ولی نماها جداگانه

آن چه  واند (بر مبنايِ) درست می شود که می تmulti-partدر بخشِ خودشان نوشته می شوند. بدین سان ، یک پرونده يِ چند بخشی (

 که در بالا گفتیم) سرعت خواندن پرونده را بهبود ببخشد.
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• Channels  ِکانال ها ، لایه ها ، و نماها را جداگانه در هر یک از بخش هايِ خودشان در پرونده ي :.exr  پردازش شده می نویسد. در

زمان تنها با یکی دو تا لایه کار داشته باشید ، می تواند سرعت  این جا نیز یک پرونده يِ چند بخشی ساخته می شود که اگر در یک

 خواندنِ پرونده را بهبود ببخشد.

 پیمان نامه هايِ نام گذاري پرونده براي نگاره هايِ پردازش شده

رمت پرونده را می نویسید ، فُ هیچ نمادي نیست که بشود با آن فرُمت بیرون رفت را تعیین کرد. به جايِ آن ، هنگامی که نامِ Writeدر تکمه يِ 

 با یک پیشوند یا یک گسترش مشخص می شود. نگاهی به عبارت زیر بیاندازید :

<prefix>:/<path>/<name>.<frame number variable>.<extension> 

ي می رسد که می خواهید نامِ کاملِ مسیري است که به پوشه ا <path>می توانید هر گسترشِ معتبري را بنویسید.  :<prefix>به جايِ 

نشان دهنده يِ  ####پر می شود که  #### لایی گذاريِ با معمولاً <frame number variable >پردازش ها در آن جا ذخیره شوند. 

نمونه ، شماره براي  را تغییر بدهید و )####گذاري چهار رقمی ( لاییهم چنین می توانید این  شماره فریم هایی هستند که چهار رقمی اند.

 ) داشته باشید.#####) ، و نیز پنج رقمی (###) ، سه رقمی (##گذاري دو رقمی (

ذخیره کنید.  TIFF16را با فرُمتfinal_comp_v01”  “با دانستن این پیمان نامه ها ، گمان کنید می خواهید یک سکانسِ تصویري به نامِ 

 می شود انجام داد را می بینید : Writeدر زیر نمونه هایی از نام گذاري که در تکمه يِ 

tiff16:/<path>/final_comp_v01.####.tiff 
/<path>/final_comp_v01.####.tiff16 
tiff16:/<path>/final_comp_v01.### 

ه کار می ندي را بپشتیبانی می شوند را می توانید براي پیشوند به کار بگیرید. هنگامی که پیشو Nukeهمه يِ گسترش هایی که با برنامه يِ 

راي گسترش را غیر ضروري می کند. بوجود برید ، آن پیشوند پیش از فرُمتی می آید که با گسترشی نشان داده شده است. در واقع ، پیشوند 

 نمونه ، می توانید عبارتexr:/<path>/###  ِرا براي نامِ پرونده بنویسید. بدین سان ، یک سکانسِ تصویريOpenEXR شماره  که تنها

 می شود ؛ که شماره يِ فریم ها با سه رقم لایی گذاري شده اند.ساخته فریم دارد 

 تغییر دادن شماره گذاريِ فریم هايِ پردازش شده

فرض را برآن می گذارد که یک ارتباط تنگاتنگ میان  Nukeبه طورِ پیش فرض ، زمانی که یک سکانسِ تصویري را پردازش می کنید ، 

را براي  15فریمی که هم اکنون آماده سازي می شود با شماره گذاريِ فریمی که به بیرون نوشته می شود وجود دارد. بنا بر این ، اگر فریمِ 

 frame). به هر روي ، نمادimage.0015.rgb مونه ، پردازش برگزینید ، پرونده يِ به دست آمده بر مبنايِ آن شماره گذاري می شود (براي ن

این امکان را به شما می دهد که این رفتار را تغییر بدهید. براي نمونه ، اگر سکانسی دارید که می خواهید از نگاره يِ  Writeدر تکمه يِ 

image.0500.rgb  ِتا نگاره يimage.1000.rgb  اجرا و نوشته شود ، شاید بخواهید این فریم ها در پرونده يِ بیرون رفت با شماره هایی

ها ، فریم هايِ آغازینِ تعریف  expressionشماره گذاري شوند. این کار را می توانید با  image.0501.rgbتا  image.0001.rgbاز 

 ) انجام بدهید.constant offsetهايِ پایدار ( offset) ، و specified start framesشده (

 ها Expressionروش کار با 
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1. Image > Write  ِرا برگزینید تا یک تکمه يWrite  درscript .تان جاي بگیرد 

کلیک کنید. سپس مسیر را به پوشه اي ببرید که   fileيِ گزینه يِ ، بر رويِ شمایلِ پوشه  Writeتکمه يِ  propertiesدر قابِ .2

 جا سکانسِ تصویريِ پردازش شده را ذخیره کنید. نامی براي سکانسِ تصویري بنویسید.می خواهید در آن 

ارتباطexpression  بنویسید. این  expressionبگذارید. در میدانِ سمت راست یک  expressionرا بر رويِ  frameگزینه يِ  .3

م هايِ نوشته شده به کار می رود را تغییر می دهد. نامِ فریمِ به میانِ فریمی که هم اکنون آماده سازي می شود و شماره گذاري که براي فری

 به نمایش در می آید. Node Graphدر پنجره يِ  Writeتکمه يِ  دست آمده براي فریمِ جاري بر روي

 

نوشته شده می گیرد ، به  آغاز شده و می خواهید نامی که این فریم در پرونده يِ بیرون رفت و 500براي نمونه ، اگر کلیپِ شما از فریمِ 

به کار  expressionرا به عنوان یک  frame-499باشد ، می توانید عبارتimage.0001.rgb  ، نامِ  image.0500.rgbجايِ 

با نامِ  500جاري کم می شود و سپس شماره يِ به دست آمده براي فریم نوشته می شود. فریمِ  فریم از فریمِ 499ید. بدین سان ، ببر

image.0001.rgb  ِبا نامِ  501، فریمimage.0002.rgb .دیگر از یک  اينمونه  و ... نوشته می شوندexpression  عبارت

frame*2  ِو به نامِ فریمی که به بیرون نوشته می شود داده می  ضرب می شود 2است. در این جا شماره يِ فریمِ جاري در شماره ي

و ...  image.0006.rgb، نامِ  3، براي فریمِ  image.0004.rgb، نامِ  2، براي فریمِ  image.0002.rgb، نامِ  1شود. براي فریمِ 

 نوشته می شود.

 تخصیص یک شماره فریم براي فریمِ نخستین در کلیپ

1. Image > Write  ِرا برگزینید تا یک تکمه يWrite  درscript .تان جاي بگیرد 

کلیک کنید. سپس مسیر را به پوشه اي ببرید که   fileبر رويِ شمایلِ پوشه يِ گزینه يِ ،  Writeتکمه يِ  propertiesدر قابِ .2

 می خواهید در آن جا سکانسِ تصویريِ پردازش شده را ذخیره کنید. نامی براي سکانسِ تصویري بنویسید.

ن بدی را برگزینید. در میدانِ سمت راست شماره اي را براي فریمِ آغازین بنویسید. start at، گزینه يِ  frameاز فهرست پایین افتادنی  .3

 سان ، شماره يِ فریم به نخستین فریمی که در سکانس است داده می شود. شماره گذاريِ فریم هايِ دیگر نیز به همین گونه انجام می شود.

 

با نامِ  500را بنویسید ، فریمِ  1ارزشِ  start atدر میدانِ  آغاز می شود و 500براي نمونه ، اگر سکانس تان از فریمِ 

image.0001.rgb  ِبا نامِ  501، فریم.image.0002.rgb  ِو ... نوشته می شوند. به همین گونه ، اگر در میدانstart at  ِارزش

 به بیرون نوشته می شود. image.0100.rgbبا نامِ  500را بنویسید ، فریمِ  100
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 شماره يِ همه يِ فریم ها به بالا و پایین به اندازه يِ یک ارزشِ پایدار کشیدن

1. Image > Write  ِرا برگزینید تا یک تکمه يWrite  درscript .تان جاي بگیرد 

کلیک کنید. سپس مسیر را به پوشه اي ببرید که   file، بر رويِ شمایلِ پوشه يِ گزینه يِ  Writeتکمه يِ  propertiesدر قابِ .2

 می خواهید در آن جا سکانسِ تصویريِ پردازش شده را ذخیره کنید. نامی براي سکانسِ تصویري بنویسید.

ایدار پایدار بنویسید. این ارزشِ پ offsetرا برگزینید. در میدانِ سمت راست یک   offset، گزینه يِ  frameاز فهرست پایین افتادنی  .3

 فریمِ جاري افزوده شده و به نامِ فریمی که به بیرون نوشته می شود داده می شود.به شماره يِ 

 

با نامِ  image.0500.rgbآغاز می شود و بخواهید این فریمِ نخستین به جايِ نامِ  500براي نمونه ، اگر کلیپ شما از فریمِ 

image.0001.rgb در پرونده يِ بیرون رفت نوشته ش را به عنوانِ یک  499-ود ، می توانید عبارتoffset  ِپایدار در میدانoffset 

شماره از شماره يِ فریمِ جاري کم می شود و شماره يِ به دست آمده براي نامِ فریم به کار می رود. نامِ  499بنویسید. بدین سان ، 

image.0001.rgb  ِنامِ  500براي فریمِ شماره ي ،image.0002.rgb  ِو ... نوشته می شود. 501براي فریمِ شماره ي ، 

 پردازش شدهنگاره يِ  براي خواندن Writeبه کار بردن تکمه يِ 

می توانید دو کار انجام بدهید : هم نگاره اي را پردازش کنید و هم نگاره يِ پردازش شده را دوباره بخوانید.  Writeبه کمک یک تکمه يِ

به بیرون نوشته شده است به مراتب سریع تر از این است که بیرون رفت پرونده با درخت تکمه  Writeخواندن پرونده اي که از یک تکمه يِ 

هايِ بزرگ خیلی کارآمد خواهد بود. هنگامی که کار بر رويِ شاخه اي  compه همین سبب این روش به ویژه در اي بالادست ارزیابی شود. ب

را پس از آن بنشانید ، بیرون رفت درخت تکمه اي را پردازش کنید ،  Writeاز درخت تکمه اي را به پایان رساندید ، می توانید یک تکمه يِ 

نگاره يِ پردازش شده را بخوانید. اگر بعد نیاز بود که تکمه هايِ درخت بالادست را ویرایش کنید ، می توانید  Writeو دوباره با همان تکمه يِ 

 رسانی کرده و آن را می خواند. دوباره نگاره را به روز Writeبه آسانی تغییرات لازم را انجام بدهید. تکمه يِ 
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 نگاره اي که پردازش کرده است براي خواندن Writeروشِ به کار گرفتن یک تکمه يِ 

پردازش کنید. بدین سان ،  exr.نگاره اي را به روشی که پیش تر گفتیم پردازش کنید. پیشنهاد می کنیم نگاره را به عنوان یک پرونده يِ  .1

Nuke ) شارزشِ هhash value ِتکمه اي که به تکمه ي درخت (Write می آید را در پرونده يِ پردازش شده می نو یسد. اگر درخت

شما را از این مشکل آگاه  Nukeتکمه اي تغییر بکند و پرونده يِ پردازش شده از رده بیرون شود ، هش ها جفت و جور نمی شوند و 

 می کند.

 از درختNuke را نشان بزنید. هنگامی که این گزینه روشن است ،  read file، گزینه يِ  Writeتکمه يِ  propertiesدر قابِ  .2

 به کار می گیرد. Write تکمه اي بالادست چشم پوشی می کند و نگاره يِ پردازش شده را به عنوانِ بیرون رفت تکمه يِ

چسبانده شده است به روز رسانی می شود ، گزینه  Writeبراي این که ببینید آیا پرونده يِ درون رفت با درخت تکمه اي که به تکمه يِ  .3

نوشته شده اند ، هنگامی  Nukeکه با برنامه يِ  exr.را نشان بزنید. این گزینه تنها براي پرونده هايِ  check file matches inputيِ 

نتواند پرونده يِ درون رفت را بررسی کند ، واژه يِ  Nukeغیر فعال است کار می کند. اگر  down-rezو  proxyکه الگويِ 

unchecked  ِبر رويِ تکمه يWrite ِدر پنجره ي Node Graph .نشان داده می شود 

معلوم کنید چه  missing framesاز فهرست پایین افتادنیِ اگر به هنگامِ بارگذاري کردن پرونده يِ پردازش شده خطایی رخ بدهد ،  .4

 کار انجام بگیرد :

• Error ِود.خطا بر رويِ هر فریمی که از دست رفته به نمایش گذاشته می ش : یک پیام 

• Black .فریم هایی که از دست رفته اند با سیاه جایگزین می شوند : 

• Checkerboard .هر یک از فریم هایی که از دست بروند با یک نگاره يِ شطرنجی جایگزین می شوند : 

• Read input ِدرون رفت از دست رفته برآیند به دست آمده اپردازش شده ، در هر یک از فریم هايِ پرونده يِ  : به جاي ز درخت

 جایگزین می شود.

از پیش پردازش شده ، می توانید تکمه يِ  تصویريِ براي کم کردن بخش هایی از درخت تکمه اي به درون رفت هايِ نکته :

Precomp )Other > Precomp.را نیز به کار ببرید ( 

 ) چیست؟Hash Valueارزشِ هش (

) که از یک تکمه و همه يِ تکمه هايِ درختی که به b1c9c0aff2012a8ارزشِ هش یک شماره يِ منحصر به فردي است (براي نمونه ، 

 آن چسبانده شده اند ، ارزیابی می شود. رتبه يِ تکمه (درون رفتclass ِش ) و همه يویژه گی هايِ کنترلی جاري ، در شکل گیريِ ارزشِ ه

 شرکت دارند.

برگزینید  Node Graphارزشِ هش را می توانید در هر جایی بر رويِ درخت تکمه اي نشان بدهید. براي این کار ، تکمه اي را در پنجره يِ 

 و کلیدI .تکمه اي متفاوت است ش در جاهايِ گوناگون بر رويِ درخترا فشار بدهید. ارزشِ ه 

Render Farm ها 

آن هایی را انجام می دهند ، و نیز همه يِ  Render Farmکه به طورِ مجازي کارِ  Third-Partyنرم افزارهايِ با همه يِ  Nukeبرنامه يِ 

با چنین سیستمی ، روند پردازشی را می  Nukeکه اختصاصاً براي این کار ساخته شده اند ، پشتیبانی می شود. با یکپارچه سازيِ برنامه يِ 
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، یا  Windows  ،Macرا دارند (در همه يِ سیستم هايِ عاملِ  Nukeزِ ماشین هایی که شبکه شده اند و مجوتوانید به سرتاسرِ همه يِ 

Linux.بارگذاري کنید ( 

خود برنامه نیز بهره ببرید.  توکارِ Farm Serverرا دارید ، می توانید از  Nuke Studioزِ برنامه يِ اگر مجو یادداشت :

به شما اجازه می دهد که براي سریع تر شدن روند پردازشی ، ماشین هایی را از بیرون به خدمت  Farm Serverاین 

 ).external slave machineبگیرید (

شبکه اي بفرستد. براي این کار می توانید از زیر  Render Farmرا می توانید به گونه اي پیکربندي کنید که کارها را به یک  Nukeبرنامه يِ 

فهرست Render )Render > Render راي بشود ، سفارشی سازي ) کمک بگیرید. به هر روي ، چون این گزینه می باید براي هر استودیو

را براي پردازش شبکه اي به شرکتی که این کار را می کند  Nukeاز برنامه يِ  scriptاین که چگونه یک گرفتن آموزش هایی در باره يِ 

 سیستمِ مدیریتی آن جا این کار را هماهنگ کنید. بفرستیم ، می باید با

فشار بیاورید که به جايِ شکست ، کارکردي را هر جور شده انجام بدهد (مانند  Nukeاگر دارید تلاش می کنید به  نکته :

می بینید) ، زي که در هنگامِ پردازش مسائلِ مجوExit Code  ِهايِ برنامه يNuke : شاید به کارتان بیاید 
0 = success 
1 = render error 
100 = license failure 
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 ها Scriptسازماندهیِ  _______________________________

کنند ، بسیار مهم است که آن ها را با یک روشِ خوانا و می و چندین نفر بر رويِ آن کار  ، ها بزرگ و پیچیده می شوند scriptهم چنان که 

 سازماندهی کنید.معنادار 

 آن چه در این بخش می خوانید :

 .Nukeدر برنامه يِ  Scriptبه نمایش گذاشتن دانسته هایی در باره يِ  •

 .proxyو  fileیا مسیرهايِ پرونده در هر یک از تکمه ها ، به کمک کنترل هايِ  یافتن و جایگزین کردن همه یا بخشی از نام ها •

 .Groupیا تکمه يِ  Backdropبه کمک تکمه يِ  Node Graph گروه کردن تکمه ها در پنجره يِ •

 .Node Graphافزودنِ یادداشت هایی به پنجره يِ  •

جداگانه ، پردازش این  nk script.براي ذخیره کردن زیر مجموعه اي از درخت تکمه اي به عنوانِ یک  Precompکار با تکمه يِ  •

script  پردازش شده در یک ذخیره شده ، و بازخوانیِ پرونده يِ بیرون رفتmain comp .تصویريِ تک به عنوان یک درون رفت 

 Scriptبه نمایش گذاشتنِ دانسته هايِ 

در الگويِ  scriptآیا ، و این که  cache، مانند شمارشِ تکمه ها ، شمارشِ کانال ، میزانِ به کار رفته يِ  scriptبراي نشان دادن دانسته هايِ 

full resolution  است یاproxy ِزیر را انجام بدهید : ، کارهاي 

1. File > comp info  ِرا برگزینید (یا کلیدهايAlt+I .(را فشار بدهید 

 باز می شود. information scriptپنجره يِ 

 

 را فشار بدهید. updateیِ دانسته هايِ پنجره دکمه يِ تان بدهید ، براي به روز رسان scriptباز است تغییراتی به که اگر پنجره  .2

 کلیک کنید. closeبراي بستنِ پنجره يِ دانسته ها ، بر رويِ دکمه يِ  .3

 Scriptبه کارگیريِ نمایه يِ 

داده ، یا آن ) را بر رويِ صفحه نمایش نشان performance timing data( اجراییمی تواند به دقتّ داده يِ زمان بنديِ  Nukeبرنامه يِ 

هايِ کُند و آهسته را عیب یابی کنید. اگر زمان   scriptبه بیرون بفرستد ؛ تا کمکی باشد براي شما که تنگناهايِ  XMLرا در یک پرونده يِ 
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ها خودشان بر به نمایش در می آید ، و تکمه  Node Graphزمان بندي در پنجره يِ بنديِ اجرایی را به کار انداخته باشید ، دانسته هايِ 

سریع) تا قرمز (تکمه هايِ کُند) رنگ بندي مبنايِ این که چه نسبتی از زمان براي هر یک از آن ها صرف می شود ، از رنگ سبز (تکمه هايِ 

 می شوند.

ه گاننیز می توانید به دانسته هايِ زمان بندي هر یک از تکمه ها به شکلی جدا Pythonاز زبان برنامه نویسیِ یادداشت : 

 را بخوانید. Help > Documentation > Python Dev Guideدست بیابید. براي دانستن بیش تر در این باره ، 

 اجراییبه کار انداختنِ زمان بنديِ 

را به کار بیاندازید. هم چنین می توانید  script) می توانید نمایه يِ P–، یا از خطِّ فرمان (با به کار بردن نشانوندScript Editor  از پنجره يِ 

 با افزودنِ نشانوند–pf   ِنامِ پرونده ، داده يِ زمان بندي را در یک پرونده يXML  بیرون بفرستید. البته این پرونده يِ بیرون رفت تنها در زمانی

 که پردازش کنید ساخته می شود.

یا از خطِّ فرمان ، سربارِ دیگري به روند آماده  Script Editorبا به کار انداختنِ زمان بنديِ اجرایی از پنجره يِ  یادداشت :

صرف می  scriptسازي افزوده می شود ؛ ولی به هر روي ، این داده می تواند نمايِ دقیقی از جایی که زمانِ آماده سازي در 

 شود براي شما فراهم کند.

 صفحه نمایش ن زمان بندي هايِ اجرایی بر رويِنشان داد

به کار انداختنِ زمان بنديِ اجرایی بر رويِ صفحه نمایش این امکان براي شما فراهم می شود تا هم چنان که بر رويِ هر تکمه اي کار می با 

 کنید ، داده ها را یک جا ببینید.

 یسید :که هستید عبارت زیر را بنو Script Editorدر پنجره يِ 

nuke.startPerformanceTimers() 
 در خطِّ فرمان عبارت زیر را بنویسید :

./Nuke9.0v1/Nuke9.0.exe -P 

می توانید داده يِ Script Editor در پنجره يِ ()nuke.resetPerformanceTimersبا نوشتنِ عبارت  یادداشت :

 کنید. resetزمان بندي را 

 صفحه نمایش نشان داده می شوند : زیر بر روي فعال است ، دانسته هايِهنگامی که زمان بنديِ اجرایی 

• Cpu  : زمانی را بر حسب میکرو ثانیه نشان می دهد کهCPU  صرف می کند تاprocessing code ِتکه هايِ  ، که از همه يCPU 

) این زمان معمولاً multi-threaded processingگرد آوري شده است را اجرا کند. براي نمونه ، با روند آماده سازي چند تکه اي (

به شماره يِ تکه هايِ به کار رفته بخش بخش می شود) کوتاه  cpuبراي هر تکه ( CPUاست. اگر میانگین زمانِ  wallبزرگ تر از زمانِ 

) صرف executing codeي کدُ اجرا (بسیاري از زمان را نه برا CPUآن است که تکه هايِ باشد ، این بازگو کننده يِ  wallتر از زمانِ 

 ها زمانی را می مانند که نشان دهنده يِ یک مشکلِ اجرایی است. lockمی کنند ، و شاید بر رويِ 

در حالِ حاضر دقیق نیست. بر رويِ سیستمِ  CPU، زمانِ  Windowsو  Mac OSXبر رويِ سیستم هايِ عاملِ  یادداشت :

 یکسان است. wallره با زمانِ هموا cpu، ارزشِ  Mac OSXعاملِ 
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• Wall  اجرایی دیواري اندازه گیري می کند. زمانی را نشان می دهد که می باید براي کامل شدن روند زمان را درست مانند یک ساعت :

 نیز بر حسب میکرو ثانیه اندازه گیري می شود. wallصبر کنید. زمانِ 

• ops  ِسازنده يِ : شمارِ اپُراتورها را در تکمه نشان می دهد. اپُراتورها قالب هايNuke  .خاصی را انجام می دهند هستند که وظایف

خودش  این کهتکمه ها می توانند دارايِ یک یا چندین اپُراتور باشند. براي نمونه ، زمانی که یک تکمه نیاز به تغییر اندازه دارد ، به جايِ 

 Helpرا به کار می گیرد. براي دانستن بیش تر در این باره ،  Transformکه باید انجام بشود را پیاده سازي کند ، یک اپُراتورِ  کاري

> Documentation > C++ Plug-in Development > NDK Developers Guide .را بخوانید 

• Memory  :را نشان می دهد. همه يِ میزان حافظه يِ سیستم که تکمه به کار می گیرد 

روند  هبه جز دانسته هايِ زمان بندي ، تکمه ها بر مبنايِ نمایه هایشان از رنگ سبز تا قرمز ، رنگ بندي می شوند. رنگ قرمز بیانگر آن است ک

 اجراییِ تکمه به کُندي انجام می گیرد (به نگاره يِ زیر نگاهی بیاندازید).

 

 در پنجره يِ ()nuke.stopPerformanceTimersي را می توانید با اجرايِ دستورِ نمایشِ داده يِ زمان بند یادداشت :

Script Editor .متوقفّ کنید 

 بیرون فرستادنِ زمان بنديِ اجرایی در یک پرونده

 نشانوند به کمک–pf  ِو نام گذاريِ پرونده ، می توانید داده يِ زمان بنديِ اجرایی را در یک پرونده يXML ِبیرون  بیرون بفرستید. پرونده ي

 و یا از خطِّ فرمان) ساخته می شود. Writeرفت تنها در زمانِ پردازش (یا از پردازش تکمه يِ 

پردازش را  Node Graphدر پنجره يِ  Write، زمانی که از راه یک تکمه يِ فرمانِ زیر ،  Windowsبر رويِ سیستمِ عاملِ براي نمونه ، 

 : می نویسد د ، داده يِ نمایه را در پروندهانجام می دهی

Nuke9.0v1\Nuke9.0.exe -Pf <file path and name>.xml 

پردازش کرده و داده يِ نمایه را در یک پرونده يِ  profileTest.nkرا به نامِ  scriptدر پردازش از راه خطِّ فرمان ، فرمانِ زیر ده فریم از 

XML .می نویسد 



208 | N u k / U s e r  G u i d e  
 
 

Vahid Velayati 
 

Nuke9.0v1\Nuke9.0.exe -x -Pf C:\temp\profileTest.xml C:\temp\profileTest.nk 1-10 

 نامِ پروندهجست و جو و جایگزین کردن 

 کارکرد به کمکSearch and Replace  ِمی توانید با کنترل هاي ،file  وproxy  به تُندي همه يِ نام ها و مسیرهايِ پرونده یا تنها بخشی ،

 )جایگزین کنید. Writeو  Readا را در هر تکمه (براي نمونه ، تکمه هايِ از آن ه

 روشِ جست و جو براي نام یا مسیرِ یک پرونده و جایگزین کردن آن

 تکمه (ها) اي را برگزینید که می خواهید همه یا بخشی از نام یا مسیر پرونده را جایگزین کنید. .1

2. Edit > Node > Filename > Search and Replace ... را برگزینید. یا 

 را فشار بدهید. /+Ctrl+Shift کلیدهايِ

) را بنویسید که می خواهید جست و جویی را بر مبنايِ آن انجام بدهید ؛ و stringگفت و گویی که باز می شود ، رشته اي (در پنجره يِ  .3

 را فشار بدهید. OK يِبه جايِ رشته يِ پیشین بنشیند. دکمه رشته اي را بنویسید که می خواهید 

 آن می نشاند. جدید را به جايِبرگزیده شده است جست و جو را انجام داده و رشته يِ براي رشته اي که در تکمه هايِ  Nukeبرنامه يِ 

ها را نیز به کار ببرید. تنها باید  Expressionمی توانید  Search and Replaceگفت و گويِ  در پنجره يِ یادداشت :

هايِ با قاعده را می گیرد. هر نویسه در  expressionگفت و گو تنها  در پنجره يِ Searchبه یاد داشته باشید که میدانِ 

expression  هايِ با قاعده ، معنايِ بخصوصی دارد ، مانند[and]  ِبنشیند. براي نمونه  \، که می باید جلويِ نویسه ي ،

[getenv HOME]  ِباید به شکل\[getenv HOME\] .نوشته شود 

 )flag( نشان هایی expressionچه رفتاري را دنبال کند ، می توانید در کنارِ خودexpression  این که یک  کنترلِبراي 

گیرد ، آن را در نظر ب اس باشد ورا به کار بگیرید. براي نمونه ، اگر می خواهید جست و جو به بزرگی و کوچکی نویسه حس

 را بنویسید. (!?)،  "فضايِ خالی"یا پس از یک یا چند نویسه يِ  expressionمی توانید در آغازِ 

 Node Graphگروه بندي کردن تکمه ها در پنجره يِ 

یک  Backdropتکمه ها را گروه بندي کنید. تکمه يِ  Groupیا  Backdropمی توانید به کمک تکمه يِ  Node Graphدر پنجره يِ 

 چهارگوشِ پس زمینه اي در پشت تکمه ها قرار می دهد ؛ که از لحاظ بصري تکمه هایی که در آن هستند را از تکمه هايِ دیگر جدا می کند.

تکمه به مانند یک آشیانه آن تکمه ها را در بر مجموعه اي از تکمه ها را در یک تکمه با هم یکی می کند ؛ که این  Groupولی یک تکمه يِ 

 می گیرد.

 Backdropگروه کردن تکمه ها به کمک تکمه يِ 

یک  Backdropگروه کنید. تکمه يِ  Node Graphمی توانید به شکلِ بصري تکمه ها را در پنجره يِ  Backdropبا یک تکمه يِ 

ارگوش را جا به جا کنید ، همه يِ تکمه هایی که درون این چهارگوش باشند نیز جا چهارگوش در پشت تکمه ها می سازد. زمانی که این چه

، می توانید تکمه هایی که در درخت تکمه اي هستند را درون چهارگوش هایی بگذارید  Backdropبا ساختن چندین تکمه يِ  به جا می شوند.
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ار ک که هر یک رنگ ها و سرنامه هايِ گوناگونی داشته باشند. با این

می توانید به آسانی یک تکمه يِ بخصوص را در یک درخت تکمه اي 

 بزرگ پیدا کنید.

در بالايِ  Backdropهم چنینی می توانید براي لایه بندي تکمه هايِ

را به کار بگیرید.  Z orderکنترلِ  propertiesهم دیگر ، در قابِ 

ر باشد در آن ها پایین ت Z Orderکه ارزشِ  Backdropتکمه هايِ 

 زیرِ تکمه هایی جا می گیرند که ارزشِ بالاتري دارند.

 Backdropروشِ گروه کردن تکمه ها به کمک یک تکمه يِ 

1. Other > Backdrop  ِرا برگزینید. یک تکمه يBackdrop  ِبه شکل یک چهارگوش در پنجره يNode Graph.پدیدار می شود 

 سه گوشی که در گوشه يِ پایین و راست چهارگوش است را بکشید. بزرگ و کوچک کنید ، نشانِاگر می باید که اندازه يِ چهارگوش را  .2

؛ تا آن را پشت تکمه هایی جا به جا کنید که می خواهید آن ها را با هم گروه  بر رويِ سر نامه يِ چهارگوش کلیک کرده و آن را بکشید .3

 کنید. اگر تکمه اي درون چهارگوش باشد ، به همراه چهارگوش جا به جا می شود.

  

آن دو بار  ر سرنامه يِرا باز کنید. براي این کار باید بر رويِ نوا Backdropبراي تغییر دادن رنگ چهارگوش ، قابِ کنترل هايِ تکمه يِ  .4

 که باز می شود رنگ جدیدي را برگزینید. Color Pickerکلیک کنید. سپس دکمه يِ رنگ سمت چپ را فشار بدهید . در پنجره يِ 

 

 بنویسید. Backdropکنترل هايِ تکمه يِ  براي تغییر دادن سرنامه يِ چهارگوش ، نامِ جدیدي را در قابِ .5
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هر یک از آن ها ارزشی را  propertiesهم بگذارید ، در قابِ  را بتوانید مانند لایه ها در بالايِ Backdropهايِ براي این که تکمه  .6

آن ها پایین تر باشد در زیرِ تکمه هایی می نشینند که  Z Orderکه ارزشِ  Backdropبنویسید. تکمه هايِ  Z Orderبراي کنترلِ 

 ارزشِ بالاتري دارند.

 Deleteچهارگوش کلیک کرده و کلید  د هم چهارگوش و هم تکمه هايِ درونِ آن را پاك کنید ، بر رويِ نوارِ سرنامه يِاگر می خواهی .7

 را بزنید. اگر می خواهید تنها چهارگوش پاك شود و تکمه هايِ درونِ آن دست نخورده به جا بمانند ، کلیدCtrl  را پایین نگه دارید ، بر

 لیرا بزنید. اگر می خواهید تکمه هايِ درونِ یک چهارگوش را پاك کنید و Deleteچهارگوش کلیک کرده و کلید رويِ نوارِ سرنامه يِ 

چهارگوش دست نخورده به جا بماند ، بر رويِ نشانِ سه گوش در گوشه يِ پایین و راست چهارگوش خود کلیک کرده و کلید Delete 

 را بزنید.

 

 Groupگروه کردن تکمه ها به کمک تکمه يِ 

 تک بگذارید. می توانید تکمه ها را درونِ یک تکمه يِ Groupبه کمک تکمه يِ 

 Groupروشِ گروه کردن تکمه ها با یک تکمه يِ 

 بگذارید ، برگزینید. Groupهمه يِ تکمه هایی که می خواهید آن ها را در تکمه يِ  .1

 Edit > Node > Group > Collapseجایگزین کنید ، راست کلیک کرده و  Groupمی خواهید تکمه هايِ اصلی را با تکمه يِ  اگر .2

To Group در پنجره يِ  را برگزینید (یاNode Graph  ِکلیدهاي ،Ctrl+G .(فشار بدهید 

 < Editنیز به جا بمانند ، راست کلیک کنید و  layoutهستند در  Groupاگر می خواهید تکمه هايِ اصلی به جز این که در تکمه يِ 

Node > Group > Copy Nodes To Group  ِرا برگزینید (یا در پنجره يNode Graph  ِکلیدهاي ،Ctrl+Alt+Shift+G 

 را فشار بدهید).
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جداگانه که باز  بر رويِ یک برگه يِ Groupجاي می گیرند. ساختارِ درونیِ تکمه يِ  Groupتکمه هايِ برگزیده شده درون یک تکمه يِ 

 است نشان داده می شود.

، می توانید از نوارِ ابزار یا از فهرستEdit > Node> Group > Collapse to Group  به جايِ انجام دادن  نکته :

 را نیز برگزینید. Other > Groupگزینه يِ  Node graphراست کلیک در پنجره يِ 

 جا گرفته اند Groupروشِ دیدن تکمه هایی که درونِ یک تکمه يِ 

 است) در گوشه يِ بالا و راست کلیک کنید. Show(کوتاه شده يِ واژه يِ  S، بر رويِ دکمه يِ  Groupدر بخشِ کنترل هايِ تکمه يِ 

 

 هستند. Groupرد که درون تکمه يِ یک برگه يِ جدید باز می شود که تکمه هایی را در بر دا

 از گروه در آوردنِ تکمه ها

 را برگزینید. Group، تکمه يِ  Node Graphدر پنجره يِ  .1

2. Edit > Node > Group > Expand Group  ِرا برگزینید (یا کلیدهايCtrl+Alt+G .(را فشار بدهید 

 بودند.که درونِ آن  با تکمه هایی جایگزین می شود Groupتکمه يِ 

 یا

تکمه هايِ  در گوشه يِ بالا و راست کلیک کنید. یک برگه يِ جدید شاملِ S، بر رويِ دکمه يِ  Groupدر بخشِ کنترل هايِ تکمه يِ  .1

 باز می شود. Groupدرونِ تکمه يِ 

تان رونوشت بگیرید. اگر بخواهید می توانید اتصّالات میان تکمه هايِ گروه شده را قفل  scriptتکمه ها را از برگه يِ جدید به درونِ  .2

را  lock all connectionsکنید تا در هنگامِ رونوشت برداري و چسباندن به طورِ تصادفی اتصّالی بریده نشود. براي این کار گزینه يِ 

 نشان بزنید. Groupبخشِ کنترل هايِ تکمه يِ 

 تان پاك کنید. scriptکه دیگر به آن نیاز ندارید را از  Group تکمه يِ .3

 Node Graphافزودنِ یادداشت ها به پنجره يِ 
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بیافزایید. یادداشت ها می توانند هر گونه نوشته یا نشانه  Node Graphمی توانید یادداشت هایی را به پنجره يِ  StickyNoteبا تکمه يِ 

 ، این یادداشت ها را براي این می گذارید تا در باره يِ عناصري که در درخت تکمه اي هستند شرحی بنویسید.باشند. معمولاً  HTMLگذاريِ 

 Node Graphروشِ افزودن یادداشت ها در پنجره يِ 

 ، جایی که می خواهید یادداشتی بگذارید ، کلیک کنید. Node Graphبر رويِ بخشی از پنجره يِ  .1

2. Other > StickyNote گزینید. یک چهارگوشِ براي نوشتن یادداشت در پنجره يِ را برNode Graph نگاره يِ پدیدار می شود) 

 .پایین ، سمت راست)

 HTMLبنویسید. اگر بخواهید می توانید نشانه گذاريِ  label، یادداشتی که می خواهید را در میدانِ  StickyNoteدر بخشِ کنترل هايِ  .3

 را به کار ببرید. براي نمونه :

را به کار ببرید. این عبارت به شکلِ  <b>my note </b>نمایان شود ، می توانید عبارتBold  براي این که یادداشتی به شکلِ  •

my note به چشم می آید. 

کار ببرید. این عبارت به شکلِ  را به <i>my note </i>نمایان شود ، می توانید عبارتItalic  براي این که یادداشتی به شکلِ  •

my note به چشم می آید. 

•  براي این که یک شمایل را به یادداشت تان بیافزایید ، می توانید عبارت<img src=”Colorwheel.png”/>  .را به کار ببرید

ایل هايِ خودتان را نیز افزوده می شود. هم چنین می توانید شم Nukeاز خود برنامه يِ  Color Wheelدر این جا یک شمایلِ 

تان ذخیره کرده باشید. با بیش ترِ فرُمت هايِ تصویري می توانید  Plug-inبه کار ببرید. این شمایل ها را می باید در پوشه يِ مسیرِ 

 کار کنید ؛ ولی پیشنهاد می کنیم پرونده اي با فرُمت.png .را به کار بگیرید 

  

 Precompکار با تکمه يِ 

جداگانه ذخیره می شود. این به شما اجازه  nk.است ، ولی محتوايِ آن در یک پرونده يِ  Groupمانند یک تکمه يِ  Precompتکمه يِ 

 تکمه اي را به عنوان یک اسکریپت می دهد که زیر مجموعه اي از درخت.nk  ذخیره شده را این اسکریپت جداگانه ذخیره کنید ، بیرون رفت

 اصلی بخوانید. Compريِ تک درونِ به مانند یک درون رفت تصوی پردازش نموده ، و بیرون رفت پردازش شده را دوباره

نمی توانید یک  Nuke Assistپشتیبانی نمی شوند. در  Nuke Assistدر برنامه يِ  Precompتکمه هايِ  یادداشت :

Precomp  را بسازید ؛ به هر روي ، اگر یکPrecomp  درscript  داشته باشید ، می توانید آن را ببینید ، ولی نمی توانید

را با  Precompبراي آن که این را نشان بدهد ، پیرامونِ تکمه هايِ  Nukeبیرون رفت آن را ویرایش کنید. برنامه يِ 

 ، و کنترل هايِ آن ها با رنگ خاکستري کمرنگ نشان می یابند.رنگ قرمز مشخص می کند 
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می توانند حداقل در دو راه سودمند باشند. نخست این که آن ها را می توانید براي کم کردن بخش هایی از درخت تکمه  Precompتکمه هايِ 

ار سرعت پردازش را بیش تر و زمانِ آن را کم می کند. چون اي ، به مانند درون رفت هايِ تصویريِ از پیش پردازش شده به کار ببرید. این ک

Nuke  به جايِ این که همه يِ تکمه هایی که براي ساختPrecomp  تصویريِ تک را به کار رفته اند را پردازش کند ، تنها یک درون رفت

به آن ها  هم چنان ي ذخیره شده اند ، می توانیدجداگانه ا nk.از آن جایی که تکمه هايِ اصلی در اسکریپت هم چنین ، پردازش می کند. 

 دسترسی داشته باشید و اگر نیازي باشد بعدها آن ها را میزان کنید.

اصلی کار می  Compیک کارنمايِ مشترکی را به کار می اندازند. یک هنرمند هم چنان که دارد بر رويِ  Precompدیگر این که ، تکمه هايِ 

بیرون فرستاده شده است. این بخش ها را می توان جدا  Precompتوانند بر رويِ بخش هایی کار کنند که با تکمه يِ کند ، هنرمندانِ دیگر می 

چند  CGدارید که یک پردازشِ  Compاصلی ویرایش نمود ، نسخه پردازي کرد ، و مدیریت نمود. براي نمونه ، گمان کنید یک  Compاز 

می تواند از این یک اسکریپت جداگانه اي درست کند که هنرمندانِ دیگر براي کارِ ترکیب بندي  3Dهنرمند لایه اي پیچیده اي را می طلبد. یک 

را پیرایش کرده و  Compآن  CG Elementمی تواند بخشِ  3Dبخوانند. بدین سان ، هنرمندPrecomp  آن را به کمک یک تکمه يِ 

 دارد براي کارِ ترکیب بندي به کار می رود) تداخلی داشته باشد.که (اصلی  Compدوباره پردازش بگیرد ، بدون این که در 

 Precompساختنِ تکمه هايِ 

را براي سرعت دادن به روند پردازشی به کار گرفته و یا می خواهید کارنمايِ مشترکی را به کار  Precompاین که آیا می خواهید تکمه هايِ

 ساخت بیاندازید ، روندPrecomp کسان است.ی 

 Precompروشِ ساختنِ یک تکمه يِ 

1.  تکمه هایی را برگزینید که می خواهید در اسکریپتPrecomp  ِجداگانه اي شامل شوند. اگر یک تکمه يGroup د ، تکمه را برگزینی

 هایی که درونِ آن جاسازي شده اند به درونِ اسکریپتPrecomp .رونوشت گرفته می شوند 

2. Other > Precomp برگزینید (یا می توانید در پنجره يِ  راNode Graph  ِکه هستید کلیدهايCtrl+Shift+P .(را فشار بدهید 

 باز می شود. Precomp Nodesپنجره يِ گفت و گويِ 

 

را می سازید هیچ تکمه اي برگزیده نشده باشد ، پنجره يِ گفت و گويِ  Precompاگر زمانی که یک تکمه يِ  یادداشت :

Precomp Nodes  نماد تکمه خالی رها می شود. سپس به کمک به نمایش در نمی آید و خودfile  ِدر بخشِ کنترل هاي

Precomp دارید و آن را به درونِ تکمه يِ  ی را ذخیرهبروید که اسکریپت بر رويِ رایانه تان می توانید به جاییPrecomp 

 بارگذاري کنید.
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وجود داشته باشد و بخواهید معلوم کنید که کدام یک از آن ها براي بیرون  Writeه يِ اگر در اسکریپت موجود چندینِ تکم

درست پس  Outputرا برگزینید تا یک تکمه يِ  Other > Outputبه کار گرفته شود ، می توانید  Precompرفت تکمه يِ 

 که می خواهید به کار بگیرید ، بنشیند. Writeاز تکمه يِ 

می گردد و در  Writeپیدا کند ، به دنبالِ یک تکمه يِ  scriptرا در  Outputتواند یک تکمه يِ ن Precompاگر تکمه يِ 

 Outputرا به نامِ آن تکمه پیکربندي می کند. هم چنین میدانِ  Output nodeگزینه يِ  Precompبخشِ کنترل هايِ 

node  را می توانید بعدها به کار بگیرید. آن چه در این میدان بنویسید بر رويِ آن چیزي که به عنوان تکمه يِ بیرون رفت در

 اسکریپتPrecomp  شده پیکربندي شده سوار می شود. براي این کار می بایدenable  این گزینه می را نشان بزنید. به کمک

 Outputبه طورِ پیش فرض برگزیده شده است و تکمه يِ بیرون رفتی که خودتان در میدانِ  توانید میانِ تکمه يِ بیرون رفتی که

node .ت بدهیدمشخص کرده اید ، تغییر وضعی 

کلیک کنید. بر رويِ رایانه تان به پوشه اي بروید که می خواهید  Precomp script pathدر کنارِ  بر رويِ شمایلِ مرورگرِ پرونده  .3

 اسکریپتPrecomp .nk  را در آن ذخیره کنید. پس از معلوم کردن مسیرِ پوشه ، نامی براي اسکریپتPrecomp  بنویسید ، براي نمونه

 ،Precomp1_v01.nk به طورِ پیش فرض ، اسکریپت .Precomp  اصلی اصلی ذخیره می شود. اگر اسکریپت در کنارِ اسکریپت

 ذخیره نشده باشد ، اسکریپتPrecomp شه يِ جاري ذخیره می شود.در پو 

کلیک کنید. بر رويِ رایانه تان به پوشه اي بروید که می  Precomp render pathدر کنارِ  بر رويِ شمایلِ مرورگرِ پرونده  .4

شده را در آن ذخیره کنید. پس از معلوم کردن مسیرِ پوشه ، نامی براي  Precomp خواهید بیرون رفت پردازش شده اي از تکمه هايِ

. اگر دوست داشته باشید ، می توانید شماره يِ نسخه را نیز در Precomp1_####.exrنگاره يِ پردازش شده بنویسید ، براي نمونه ، 

 .Precomp1_v01_####.exrنامِ پرونده به کار ببرید ، براي نمونه ، 

می تواند از آن چه  که به درخت تکمه اي می  Nukeپردازش کنید ؛ چرا که  exr.پیشنهاد می کنیم نگاره را با فرُمت  هشدار :

به گونه اي تغییر کند که هش ها همخوان  Precompد. اگر اسکریپت رونِ پرونده يِ پردازش شده بنویسآید ارزشِ هش را به د

، و شما می توانید نگاره يِ به دست آمده را به روز رسانی کنید. اگر دارید  آگاهیِ شما برساند می تواند این را به Nukeنباشند ، 

پردازش شده از رده کار می کنید ، دیگر نمی توانید این آگاهی را دریافت کنید و پرونده يِ  exr.با فُرمت پرونده اي به جز 

 بیرون می شود. 

 Precompپردازش شده تاز تکمه هايِ کانال هایی را برگزینید که می خواهید در بیرون رفتChannels  از فهرست پایین افتادنیِ  .5

 شامل شوند.

) در Write1مربوطه (به طورِ پیش فرض ،  Write ، می توانید در تکمه يِ را میزان کنیدبرگزیده اید  کهاگر بعدها نیاز بود آن چه 

 اسکریپتPrecomp .nk ي کنید.کانال ها را پیکربند 

 زیر را برگزینید :یکی از گزینه هايِ  Original nodesاز فهرست پایین افتادنیِ  .6

• Add backdrop  ِتکمه هاي یک پشت پرده اي در پشت :Precomp  ِدر پنجره يNode Graph .می سازد 

• Delete تکمه هاي :Precomp .شده را پاك می کند 

• No change  ِتکمه هايِ : هیچ کاري بر رويPrecomp .شده انجام نمی شود 

 را فشار بدهید. OKدکمه يِ  .7



215 | N u k / U s e r  G u i d e  
 
 

Vahid Velayati 
 

تکمه هايِ درون رفت و بیرون رفت ،  scriptمعین ذخیره می کند. این  nk.برگزیده شده را در یک اسکریپت  تکمه هايِ Nukeبرنامه يِ 

 را نیز در خود دارد.، و پیکربندي هايِ جاريِ پروژه  Writeیک تکمه يِ 

تکمه يِ  propertiesقابِ  Nukeبرگزیده شده می شود. جایگزینِ تکمه هايِ  Precomp ، تکمه يِ Node Graphدر پنجره يِ 

Precomp .را باز می کند 

 و پیکربندي هايِ پروژه Precompتکمه هايِ 

پیکربندي هايِ پروژه اش را از اسکریپت اصلی می گیرد.  Precomp .nkرا می سازید ، اسکریپتPrecomp  هنگامی که یک تکمه يِ 

 اصلی نیز هر زمان که اسکریپت پیکربندي هايِ پروژه يِ اسکریپتPrecomp  .اصلی بارگذاري می شود به کار گرفته می شوند در اسکریپت

 بنا بر این ، اگر اسکریپتPrecomp  را در یک نمونه يِ دیگري ازNuke  پیکربندي هايِ پروژه يِ آن تغییر می کند. یعنی دیگر با باز کنید ،

به درونِ اسکریپت اصلی بارگذاري شود تغییراتی که  Precompاسکریپت اصلی همخوان نخواهند بود ؛ و زمانی که اسکریپت  پیکربندي هايِ

ید ، می باید همیشه این کار را در اسکریپت اصلی انجام بدهید داده اید بدون تاثیر می شوند. اگر می خواهید پیکربندي هايِ پروژه را تغییر بده

 نه در اسکریپتPrecomp. 

 براي سرعت بخشیدن به روند پردازش Precompبه کار گرفتن یک تکمه يِ 

در بیرون رفتPrecomp  را براي سرعت دادن به روند پردازشی به کار ببرید ، می باید تکمه يِ  Precompاگر می خواهید یک تکمه يِ

 اسکریپتPrecomp .خوانده شود 

 Precompروشِ پردازشِ یک تکمه يِ 

 بسازید. Precompیک تکمه يِ  .1

کلیک کنید. در پنجره يِ گفت و گویی که باز می شود دامنه يِ فریمی را  Render، بر رويِ  Precompتکمه يِ در بخشِ کنترل هايِ  .2

 را بزنید. OK) و 100-1بنویسید (براي نمونه ، 

 Precomp renderرا پردازش کرده و نگاره يِ به دست آمده را در پوشه يِ  Precompبیرون رفت اسکریپتNuke  برنامه يِ 

path .تکمه مشخص نموده اید ، ذخیره می کند که در زمانِ ساخت 

را مشخص کرده باشید ، نگاره يِ پردازش شده یک  Proxyبیرون رفت یک نامِ پرونده يِ را فعال کرده و در تکمه يِ  Proxyاگر الگويِ 

 خواهد بود. Proxyنگاره يِ 

خود به  read file for output، گزینه يِ  Precompتکمه يِ  propertiesاگر روند پردازش با موفّقیت به پایان رسید ، در قابِ  .3

به رنگ سبز در آمده و به جايِ ارزیابی کردن بیرون  Precompخود روشن می شود. هنگامی که این گزینه نشان خورده باشد ، تکمه يِ 

 اسکریپت رفتPrecomp  ِهمین نگاره ي ،precomp ) پردازش شده را می خواند. واژهRead و نامِ نگاره اي که خوانده می شود (

 همین است. به نمایش گذاشته می شود و نشانگرِ Node Graphدر پنجره يِ  Precompنیز بر رويِ تکمه يِ 

 missingروبرو بشوند ، می توانید از فهرست پایین افتادنیِ شده با خطا  Precompدر جایی که بیرون رفت پردازش شده يِ تکمه هايِ  .4

frames  ِدر قابproperties  ِتکمه يPrecomp : معلوم کنید که چه روندي انجام بگیرد 
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• Error .یک پیامِ خطا را بر رويِ فریم هايِ از دست رفته نشان می دهد : 

• Black .سیاه به نمایش می گذارد هر فریمی که از دست رفته است را با رنگ : 

• Checkerboard .هر فریمی که از دست رفته باشد را با یک نگاره يِ شطرنجی نشان می دهد : 

• Read input  ِتکمه اي : به جايِ نشان دادن پرونده ي درخت پردازش شده بر رويِ هر فریمی که از دست رفته است ، برآیند

 درون رفت را به نمایش می گذارد.

براي جایگزین کردن بخش هایی در یک درخت تکمه اي بزرگ و پیچیده به کار گرفته شده اند ، زمان  Precompزمانی که چندین تکمه يِ

 هايِ پردازش خیلی سریع تر می شود.

که در نگاهWrite  خود به خود تکمه يِ  Nuke، برنامه يِ  Precompبه هنگامِ پردازشِ بیرون رفت اسکریپت  ادداشت :ی

را پیدا کند ، تلاش می کند یک  Outputبه کار می برد. اگر برنامه نتواند تکمه هايِ  Output nodeنخست می بیند را براي 

 Writeهمین تکمه يِ را با نامِ  Precompدر بخشِ کنترل هايِ تکمه يِ  Output nodeرا بیابد و گزینه يِ  Writeتکمه يِ 

 را پیدا کند ، یک خطا را نشان می دهد. Writeو یا  Outputپیکربندي کند. اگر این تکمه نتواند هیچ تکمه يِ 

را به کار بگیرید و گزینه يِ خودتان را بر رويِ آن  Precompتکمه يِ  propertiesقابِ  در هر زمان ، می توانید گزینه هايِ

تکمه را باز کرده و به  propertiesپیکربندي شده است سوار کنید. براي این کار ، قابِ  Output nodeچه که براي گزینه يِ 

هید بیرون رفت نویسید که می خوارا ب Writeنامِ تکمه يِ  Output nodeبروید. در میدانِ  Advancedبخشِ کنترل هايِ 

نیز نشان خورده باشد. . به کمک این گزینه می توانید میانِ تکمه يِ  enableن به کار گرفته شود. هم چنین باید گزینه يِ آ

مشخص  Output nodeبیرون رفتی که به طورِ پیش فرض برگزیده شده است و تکمه يِ بیرون رفتی که خودتان در میدانِ 

ت بدهید.کرده اید ، تغییر وضعی 

بالادست ، بیرون را به کار بگیرید و به جايِ ارزیابی شدن تکمه هايِ  Writeهم چنین می توانید به همین گونه تکمه هايِ  نکته :

پردازش شده بخوانید. آن ها از پرونده يِ رفت 

 Precompبازبینی هايِ 

 را باز کنید ، ویرایش کرده ، و دوباره بارگذاري نمایید. Precompیک اسکریپت در زیر نشان می دهیم که چگونه 

 روشِ دیدن و ویرایش کردن یک اسکریپتPrecomp 

جدید آغاز شده و  Nuke sessionکلیک کنید. با این کار ، یک  Open، بر رويِ  Precomp تکمه يِ propertiesدر قابِ  .1

 اسکریپتPrecomp .در آن بارگذاري می شود 

2.  اگر نیاز باشد ، اسکریپتPrecomp .را ویرایش کنید 

 Node Graphرا در پنجره يِ  Writeرا به کار می برید ، تکمه يِ versionشماره هايِ  Writeاگر دارید در نامِ پرونده براي تکمه يِ  .3

 versionکنید. این کار ، شماره يِ را اجرا  Edit > Node > Fliename > VersionUpبرگزینید و سپس از نوارِ فهرست دستورِ 

، تغییر  )Precomp1_v02_####.exrبه  Precomp1_v01_####.exrدر پرونده اي که پردازش می شود را (براي نمونه ، از 

 می دهد.
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نوشته  را proxyیک نامِ  Outputروشن باشد و براي تکمه يِ  Proxyرا پردازش کنید. باید بدانی که اگر الگوي  Writeتکمه يِ  .4

 را پردازش می کند. proxyیک نگاره يِ  Nukeباشید ، 

 version) را اجرا کنید تا اسکریپت با یک شماره يِ File > Save Comp As(یا  File > Save New Comp Versionدستورِ  .5

 ) ذخیره شود.Precomp1_v01.nkبه جايِ  Precomp1_v02.nkجدید (براي نمونه ، 

 بازبینی شده Precompیک اسکریپت روشِ بارگذاري کردن 

1. Comp .اصلی را بارگذاري کنید 

همخوان باشد. اگر نامِ اسکریپتPrecomp  با نامِ جاريِ اسکریپتPrecomp  از تکمه يِ  fileببینید که نامِ پرونده در میدانِ  .2

Precomp ) یک نسخه بالاتر شده باشدVersionUpِبه آسانی می توانید تکمه ي ، ( Precomp  ِرا برگزیده و دستورEdit > 

Node > Filename > VersionUp  اصلی اجرا کنید. با این کار نامِ اسکریپت که خوانده می شود (براي نمونه از را از فهرست

Precomp1_v01.nk  بهPrecomp1_v02.nk.تغییر می کند ( 

 اگر اسکریپتPrecomp  با نامِ گوناگونی ذخیره شده باشد ، یا دیگري را در اسکریپت بخواهید یک اسکریپتPrecomp  به کار بگیرید

 ویرایش کنید. file، نامِ پرونده را در میدانِ 

 را فشار بدهید. Reload، دکمه يِ  Precompتکمه يِ  propertiesدر قابِ  .3

 نمونه اي از یک کارنمايِ مشترك

 TDاصلی به عهده دارد که به مشتري تحویل داده می شود. یک  Compدر  کاري را )Compositorکامپوزیت کار (در این نمونه ، یک 

اصلی به عهده دارد. در زیر توضیح می دهیم که چگونه  Compبه کارگیري در  چند لایه اي را براي CGنورپرداز نیز آماده کردن پردازشِ 

 ايِ مشترکی را به کار بیاندازند.، کارنم Precompنورپرداز می توانند به کمک تکمه يِ  TDبا  کامپوزیت کار

 روشِ به کار انداختنِ یک کارنمايِ مشترك

 اصلی را آغاز می کند. Compکامپوزیت کار ساختارِ  .1

2. TD  ِنورپرداز پردازشی از عنصرCG  و یکComp  ِاز لایه ها را می گیرد ، و اسکریپت را به نامcg_vo1.nk .ذخیره می کند 

اصلی ادامه می  Compرا می خواند. سپس به کار در  cg_v01.nkمی سازد که پرونده يِ  Precompکامپوزیت کار یک تکمه يِ  .3

 دهد.

4. TD  ِنورپرداز به بازبینیِ پردازشCG  وComp  ِادامه می دهد ، و نسخه يِ تکمه يWrite  و نامِ اسکریپتPrecomp .nk  را بالا می

آگاه  Precompنورپرداز شخصِ کامپوزیت کار را از کارِ جدید و نسخه يِ اسکریپتTD  هر زمان که برآیند به تري به دست آمد ،  برد.

 می سازد.

را بارگذاري می  Precompرا به نسخه يِ جدید و بهبود یافته بالا می برد و اسکریپتPrecomp  کامپوزیت کار نسخه يِ تکمه يِ  .5

 نماید.
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 Nukeپیکربندي کردن  _______________________________

را براي چندین هنرمند پیکربندي  Nukeچگونه برنامه يِ  در این بخش نشان می دهیم که سرپرستانِ جلوه هايِ ویژه ، پیش از آغازِ یک پروژه ،

 می کنند. پیکربندي هايِ رایج که در این بخش به آن می پردازیم :

 )Command-Lineکارکردهايِ خطِّ فرمان ( •

 )Environment Variableمتغیرهايِ محیطی ( •

• Gizmo  ِپلاگین ،NDK  ِپوشه هاي ،TCL Script 

 Python Scriptپوشه هايِ  •

 OFX Plug-Inپوشه هايِ  •

 Favoriteپوشه هايِ  •

 )Cross-platform( چند زیر بنایی مسیرهايِ پرونده اي •

 گزینه هايِ فهرست و نوارِ ابزار •

 فرُمت هايِ تصویري •

• Gizmo  ِها (برنامه يNuke (تکمه ها را گروه کرده یا زیرنوشت می گذارد که می توان تنها تغییرات را برگزید 

 پلاگین هايِ سفارشی •

 )”TCL )“TiCkLeاسکریپت هايِ عمومیِ  •

 اسکریپت هايِ قالب •

• Preference هايِ مشترك 

 اسکریپت (lookup table- LUT)تبدیلِ ارزش  جدول هايِ •

 آماده سازي هايِ سفارشیِ نمایشگر •

رونوشت بگیرید و به درون  می آید را این راهنمايِ کاربري در  Pythonاسکریپت هايِ نمونه هایی که از اگر داشت : یاد

 ه جا نمی مانند. در این جا باید دستی نشانه گذاري ها درست کنید.ب، نشانه گذاري هايِ خطّ  ویراستارِ نوشتاري بچسبانید

 پایانه را به کار ببریم؟) چیست و چگونه یک Terminalیک پایانه (

فرمان ها را بنویسید. این شما را به پنجره اي ارجاع می  Shellاز یک پایانه یا  چگونه به شما می گوییم روشِ کاريچندین با در این بخش 

 ی را انجام بدهید).گزینش هایدهد که در آن جا می توانید فرمان ها را یکراست بنویسید (به جايِ این که از سرتاسرِ پنجره يِ کاربري 

 چگونه چنین پنجره اي را در سیستمِ عامل رایانه تان باز کنید :

• Linux ماوس را بر رويِ میز کار کلیک کنید و گزینه يِ  : دکمه يِ راستNew Terminal  یا)Open Terminal را از فهرست (

 راست کلیک برگزینید.

• Windows  از فهرست :Start  ِدستور ،All Program > Accessories > Command Prompt .را اجرا کنید 
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• Mac OSX  ِبر رويِ شمایل :Terminal dock .کلیک کنید 

 یا

 دو بار کلیک کنید. Terminalدر درایو سخت سیستم تان بروید ، و بر رويِ شمایلِ  Applications > Utilitiesبه پوشه يِ 

، و سمت چپ در سیستم  Windowsمی بینید (نگاره يِ پایین سمت راست در سیستمِ  Command Promptدرونِ پایانه یا پوسته ، یک 

 ).Mac OSXو  Linuxهايِ 

 7 

هست می توانید فرمان ها را در آن بنویسید و با این روش کارهايِ گوناگونی (مانند فهرست کردن پرونده ها  Command Promptهر جا 

 امه ها) را انجام بدهید. نمونه هایی را در زیر آورده ایم :در یک پوشه ، یا اجرا کردن برن

را بزنید. با این کار می توانید مسیرِ پرونده يِ جاري  Enterرا بنویسید و  pwd، عبارتMac OSX  یا  Linuxبر رويِ سیستمِ عاملِ  •

 را بنویسید. cdبراي انجام گرفتن همین کار می باید فرمانِ  Windowsرا ببینید. در سیستمِ عاملِ 

را بزنید. با این کار می توانید فهرستی از پرونده ها را در  Enterرا بنویسید و  Is، عبارتMac OSX  و  Linuxبر رويِ سیستمِ عاملِ  •

 را بنویسید. dirبراي انجام گرفتن همین کار می باید فرمانِ  Windowsدر سیستمِ عاملِ  پوشه يِ جاري ببینید.

را به دنبالِ نامِ کاملِ مسیر  cd، براي تغییر دادن پوشه ها عبارتWindows  و  Linux  ،Mac OSXسیستمِ عاملِ بر رويِ هر سه  •

 بنویسید.

 کارکردهايِ خطِّ فرمان

، و کارکردهايِ  هايِ خطِّ فرمان گزینه هايِ گوناگونی را فعال کرده flagرا از خطِّ فرمان یا پایانه اجرا می کنید ،  Nukeزمانی که برنامه يِ 

 به اجرا در آوریم.  Shellرا از یک  Nukeفراهم می کنند. اجازه بدهید نخست به این بپردازیم که چگونه برنامه يِ  Nukeدیگري را براي 

 Windowsبر رويِ 

 را باز کرده و پوشه را مانند زیر تغییر بدهید : Command-line promptیک 
cd C:\Program Files\Nuke9.0v4\ 

 ، این فرمان را بنویسید : Nukeبراي اجرا کردن برنامه يِ 
Nuke9.0.exe 

 اشاره کند و سپس برنامه را از هر پوشه اي اجرا کنید : Nukeپیکربندي کنید که به  doskeyبه جاي این ، می توانید یک 
doskey nuke="C:\Program Files\Nuke9.0v4\Nuke9.0.exe" 
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 کنید : doskeyرا  Nuke Studioو  NukeXاگر می خواهید 

doskey nukex="C:\Program Files\Nuke9.0v4\Nuke9.0.exe" –nukex 
doskey nukes="C:\Program Files\Nuke9.0v4\Nuke9.0.exe" --studio 

 Mac OSXبر رويِ سیستمِ 

 را باز کرده و پوشه را مانند زیر تغییر بدهید : Command-line promptیک 
cd /Applications/Nuke9.0v4/Nuke9.0v4.app/Contents/MacOS 

 ، این فرمان را بنویسید : Nukeبراي اجرا کردن برنامه يِ 
./Nuke9.0v4 

اشاره دارد ، و سپس می توانید برنامه را از هر پوشه اي اجرا کنید. روشی که  Nukeپیکربندي کنید که به  aliasبه جاي این ، می توانید یک 

که به کار می برید را به دست بیاورید ، پایانه  Shellپیش فرض تان چیست. براي این که نامِ  Shellاین بستگی دارد که ت به براي این کار اس

 را بنویسید. echo $SHELLرا اجرا کرده و 

 کار می کنید : Bash Shellاگر دارید با یک 
alias nuke='/Applications/Nuke9.0v4/Nuke9.0v4.app/Contents/MacOS/Nuke9.0v4' 

 را به کار می برید : tcsh Shellبه جايِ این ، اگر دارید یک 
alias nuke /Applications/Nuke9.0v4/Nuke9.0v4.app/Contents/MacOS/Nuke9.0v4 

 کنید : aliasرا  Nuke Studioو  Nuke Xاگر می خواهید 

alias nukex /Applications/Nuke9.0v4/Nuke9.0v4.app/Contents/MacOS/Nuke9.0v4 –nukex 
alias nukes /Applications/Nuke9.0v4/Nuke9.0v4.app/Contents/MacOS/Nuke9.0v4 --studio 

در پوشه يِ خانه بیافزایید. بدین سان ، آن ها هر بار که  bashrc.یا  cshrc.ها را به پرونده يِ  aliasمی توانید  نکته :

 مدیر را باز کنید فعال می شوند. براي راهنمایی در باره يِ راه اندازي کردن آن چه در بالا گفتیم ، Shellیک 

)Administrator( .سیستم تان را ببینید 

 دنبال کنند.) 741صفحه يِ می توانند روشِ کار را در خود راهنمايِ کاربري برنامه  Linux(کاربران سیستمِ عاملِ 

 هايِ خطِّ فرمان flagروشِ کار با 

نسخه و تاریخِ ساخت به خطِّ فرمان را آغاز کنید. در نمونه يِ زیر شماره يِ  هايِ flag، کار با  Nukeاکنون می توانید براي اجرايِ برنامه يِ 

 ر می آید.نمایش د
nuke -version 

 اگر یک اسکریپت.nk  ِدارید ، می توانید آن را بر رويِ خطِّ فرمان پردازش بگیرید بدون این که بخواهید نسخه يGUI  را باز کنید. در زیر

 نمونه اي است که یکصد فریم از اسکریپتNuke : را پردازش می گیرد 
nuke -F 1-100 -x myscript.nk 

ه کنید که چگونه می توانید براي نشان دادن دامنه يِ فریم سوئیچِ به این توج-F  را بر رويِ خطِّ فر مان به کار بگیرید. فریم هايِ آغازین و پایانی

 ) از هم جدا می شوند.dashبا یک خطِّ تیره (
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را به  F-، سوئیچِ جدید  فریم بر رويِ خطِّ فرمان پیشنهاد می کنیم که هر زمان براي تعریف کردن دامنه يِ یادداشت :

ین ، به هر روي ، براي سازگاري با نسخه هايِ پیش کار ببرید. این سوئیچِ جدید می باید جلوتر از عبارت نامِ اسکریپت بیاید.

نسخه از برنامه به کار بگیرید. براي این کار ، دامنه يِ فریم را در پایانِ فرمان جاي قدیمی را نیز در این  Syntaxمی توانید 

 آغازین و پایانی یک ویرگول بگذارید. مانند نمونه يِ زیر : بدهید و براي جدا کردن فریم هايِ
nuke -x myscript.nk 1,100 

 فرمان زیر را بنویسید :هايِ خطِّ فرمان (سوئیچ ها) ،  flagبراي نشان دادن فهرستی از 
nuke -help 

 هاي خطِّ فرمان را ببینید : flagدر جدولِ زیر می توانید فهرستی از 

Switch/Flag کارکرد 

-a .پیش فرض را به آنامورفیک بر می گرداند فرُمت 

-b  الگويِ پس زمینه. این فرمانNuke  را اجرا کرده و کنترل را دوباره به پایانه بر می گرداند. بدین گونه دوباره

prompt  تان را خواهید داشت. این فرمان برابر با پیوست کردن فرمانی است باan & to run  در پس

 زمینه.

--crashhandling 1 
--crashhandling 0 

رویدادهایی که به خرابی می خورند را به که  هستاین امکان براي شما  Breakpad crashبا گزارشِ 

 شرکتThe Foundry ) بفرستید. به طورِ پیش فرض ، گزارشِ خرابیcrash reporting را می شود (

 آن را از کار انداخت. Terminal modeبه کار انداخت و در الگويِ  GUI modeدر الگويِ 

--crashhandling 1 ِخرابی هم در الگويِ  را براي به کار انداختنِ گزارشGUI  و همTerminal  به کار

 ببرید.

--crashhandling 0  ِرا براي از کار انداختنِ گزارشِ خرابی در هر دو الگويGUI  وTerminal  به کار

 ببرید.

-c size(K,M,or G)  ِبراي مرزبندي کردن حافظه يcache  .استSize  برابر با شماره اي است که براي تعیین این مرزبندي به

(مگابایت)  M(کیلوبایت) ،  kکار رفته و بر حسب بایت نوشته و خوانده می شود. با نوشتن یکی از نویسه هايِ 

 می توانید یگانِ دیگري را براي این گزینه به کار ببرید. size(گیگا بایت) پس از واژه يِ  G، و 

-d <x server name>  این اجازه می دهد کهNuke  .بر رويِ یک ماشین اجرا شده و بر رويِ یک ماشین دیگر به نمایش در آید 

-f  اسکریپتNuke براي نشان دادن نگاره ها در الگويِ ن باز می کند. اسکریپت هایی که را با وضوحِ کاملِ آ

proxy  این ذخیره شده باشند را نیز می توانید به کمکflag  .با وضوحِ کاملِ تصویري باز کنید-P  را نیز

 ببینید.

-F  ِشماره فریم هایی را مشخص می کند که اسکریپت در آن دامنه اجرا شود. همه يِ عبارت هاي-F  می باید

 زیر نگاه کنید : جلوتر از عبارت نامِ اسکریپت بیایند. به نمونه هايِ

• -F3 ِاست. 3نشانگرِ فریمِ شماره ي 

• -F 1-10 ِرا نشان می دهد. 10، و  9،  8،  7،  6،  5،  4،  3،  2،  1شماره يِ  فریم هاي 

• -F 1-10x2  ِرا نشان می دهد. 9، و  7،  5،  3،  1فریم هاي 

 نین می تواند دامنه هاي فریمِ گوناگون را به کار ببرید :هم چ
nuke -F 1-5 -F 10 -F 30-50x2 -x myscript.nk 
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-h .راهنمايِ خطِّ فرمان را نشان می دهد 

-help .راهنمايِ خطِّ فرمان را نشان می دهد 

-i  یکRLM license key ) تعاملیnuke_i را به کار می برد. این سوئیچ در ارتباط با پردازشِ پس زمینه (

را به  nuke_r license keyیک  x-به کار گرفته می شود. به طورِ پیش فرض ،  x-اي اسکریپت ها با 

 پردازش هايِ پس زمینه اي را انجام می دهد. nuke_i license keyبا یک  ix- کار می برد ، ولی

-I  تکمه هايِ جدیدread  وwrite ) فضايِ رنگ را به جايِ آن چه که پیش فرض باشدdefault ِبه فضاي (

 ) پیکربندي می کنند.linearرنگ خطّی (

-m # ) شماره يِ تکه هاthreadمشخص می شود. #نشانِ  ) را تعریف می کند ؛ که ارزشِ آن با 

--multigpu multi-GPU acceleration  ِرا در الگويTerminal  ِبر رويlate 2013 Mac Pro 6.1  ِکه سیستم)

OSX 10.9.3 ‘mavericks’ .یا پس از آن را اجرا می کند) به کار می اندازد 

 Interactiveدر الگويِ  Preferencesپیکربنديِ پنجره يِ این عبارت بر رويِ  یادداشت :
 معتبر است. Mac OSXسوار است و تنها در سیستمِ عاملِ 

-n تمبر پستی ( نگاره هايِ اسکریپت را بدونpostage stamp.بر رويِ تکمه ها باز می کند ( 

--nocrashprompt  هنگامی کهcrash handling  ِدر الگويGUI  ال باشد ، گزارش هاي خرابی را خود به خود می فرستدفع

 را به نمایش بگذارد. crash reporterبدون این که پنجره يِ گفت و گويِ 

--nukeassist  ِبرنامه يNuke Assist .را اجرا می کند 

-P  اسکریپتNuke  ِرا در وضوحproxy  باز می کند. اگر اسکریپت ها با وضوحِ کاملِ تصویري ذخیره شده

 ببینید.را نیز  f-باز کنید. سوئیچِ  proxyباشند ، با این سوئیچ می توانید آن ها را با وضوحِ 

-p  ِکارآییِ تکمه هایتان را اندازه می گیرد و در پنجره يNode Graph .به نمایش می گذارد 

-Pf <filename>  ِکارآییِ تکمه هایتان را اندازه می گیرد و آن ها را در زمانِ پردازش در یک پرونده يXML .می نویسد 

--Pause  نمایشگر هايِ ابتدایی که در اسکریپت مشخص شده اند بر رويِ خطِّ فرمانpause .می شوند 

--Ple  ِبرنامه يNuke  ِرا در الگويPersonal Learning Edition .اجرا می کند 

--Priority P Nuke : را با پیش گامیِ دیگري اجرا می کند 
• high 
• medium 
• low 

--Python-no-root-
knobdefaults 

 هنگامی که یک اسکریپتPython  ِاجرا می شود ، جلويِ نرم افزار را از پیش فرض هايknob  به تکمه

 يِ ریشه می گیرد.

-q  ِالگويQuiet همه يِ روند هایی چاپ شدن به .Shell .از کار می ایستند 

--remap  اشتراك گذاريِ پروژه هايِاجازه می دهد که براي آسان شدن در بهNuke  ، در سیستم هايِ عاملِ گوناگون

در پنجره يِ گفت  Path Remapsبازنگاشت کنید. این سوئیچ برابر با پیکربنديِ کنترلِ  مسیرهايِ پرونده را 

 است. Preferencesو گويِ 



223 | N u k / U s e r  G u i d e  
 
 

Vahid Velayati 
 

--remap flag ا شده اند می گیرد. فهرستی از مسیرها را به شکلِ یک عبارت ، که با ویرگول از هم جد

مسیرها در جفت هایی چیدمان شده اند که نخستین مسیر از هر جفت به دومین مسیر هر جفت نگاشت می 

 به کار ببرید : را "nuke -t --remap "X:/path,Y:,A:,B:/anotherpathزند. براي نمونه ، اگر 

 برگردانده می شود. :Yآغاز شود به  X:/pathهر مسیري که با  •

 برگردانده می شود. B:/anotherpathآغاز شود ، به  :Aر مسیري که با ه •

--remap flap : خطایی می اندازد اگر 

 .t-یا  x-تعریف شود ؛ یعنی بدون  GUIبه هنگام آغاز شدن الگويِ 

 را به کار می برید :  ":nuke -t --remap "X:/path,Y:,Aمسیرها جفت نباشند. براي نمونه ، اگر 

A:  چیزي نگاشت نمی زند ، و یک خطا ایجاد می شود.به 

--remap flag  ،شدار  ، اگر مسیري به آن ندهید(و نه خطا) نشان می دهد. براي نمونه :یک ه 
Nuke-t—remap”” 
د کنیآغاز می را   Nukeکه نگاشت گذاري ها تنها به جلسه اي که دباید بدانی یادداشت :
که در الگويِ  nk.از پرونده يِ  Preferencesربندي هايِ د. آن ها بر رويِ پیکنداده می شو

GUI .به کار گرفته می شود ، تاثیري به جا نمی گذارند 
-s #  ِکم ترین اندازه يstack  ِیا اندازه ي ،stack cache  تکمه اي براي هر از درختthread  را برحسب

کوچک ترین اندازه اي که اجازه دارید است.  (MB 16) 16777216بایت پیکربندي می کند. پیش فرض ، 

 است. (MB 1) 1048576به کار ببرید 

--safe  ِبا اجرايِ برنامه يNuke  ِزیر در در این الگو ، بارگذاري هايstartup : از کار می ایستند 

 nuke./~همه يِ اسکریپت ها یا پلاگین ها در  •

 %NUKE_PATH% یا   NUKE_PATH$ همه ي اسکریپت ها یا پلاگین ها در •

 )FurnaceCoreها (از جمله  OFX Plug-Inهمه يِ  •

--sro  بهNuke  ِبراي چیدمانِ پردازشی تکمه هايWrite  ِفشار می آورد ؛ به گونه اي که تکمه هايRead  می

 ساخته شده اند. Writeتوانند پرونده هایی را به کار بگیرند که پیش از این با تکمه هايِ 

-t ِالگويTerminal  بدون)GUI ِدر این جا می توانید فرمان هاي .(Python  ِرا بدون اجرايGUI  به کار

به نمایش در می آید. براي بیرون  <<<Aبا  Command promptببرید. در هنگامِ نمایشِ این الگو ، 

فرض ، یک  برگردید. این الگو به طورِ پیش Shell promptرا بنویسید و به  ()quitرفتن از این الگو 

nuke_r license key  را به کار می برد ، ولی می توانید با–ti flag combo  یکnuke_i key  را به

 کار بگیرید.

--tg  ِالگويTerminal این سوئیچ هم چنین یک .QApplication  را باز می کند ؛ به گونه اي که می توانید

Pyside/PyQt  را به کار ببرید. این الگو یکinteractive license ِرا به کار می گیرد ، و بر روي 

 نیاز است. X Windows display session، به یک  Linuxسیستمِ عاملِ 

-V level  ِالگويVerbose ِدر الگوي .Terminal  کار  اجرا شدن یکبراي به صراحت فرمان هایی را می بینید که

را به یکی از ارزش هايِ زیر مشخص کنید که می خواهید در الگويِ  Levelمی آیند.  Nukeدر برنامه يِ 

Terminal : داشته باشید 
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 )verbose(بدون هیچ  0 •

 را بیرون می دهد) Nukeاسکریپت (بارگذاري و ذخیره سازيِ  1 •

پیشرفت کار و بافر  ، گزارش هايِ Nuke، اسکریپت هايِ  Python  ،TCLپلاگین ها ،  (بارگذاريِ 2 •

 ا بیرون می دهد)ر

-v  ِاین فرمان یک پرونده يِ تصویري را درونِ نمایشگرNuke : نشان می دهد. مانند نمونه يِ زیر 
nuke-v image.tif 

--view v بنویسید که با ویرگول را تنها نماهايِ مشخص شده را اجرا می کند. براي نماهايِ چندتایی ، فهرستی از نماها 

 از هم جدا شده اند :

• Left,right 
--version  دانسته هايِ نسخه را درShell .به نمایش می گذارد 

-x  ِالگويeXecute یک اسکریپت .Nuke ِالِ  را می گیرد و همه يتکمه هايِ فعWrite .را پردازش می کند 

از خطِّ فرمان  x-اسکریپتی را با سوئیچِ  زیر Syntaxبا نوشتنِ  نمی توانید PLEدر برنامه يِ  بدانید کهباید 

 پردازش کنید :
nuke –x myscript.nk 

را به کار می گیرد. اگر می خواهید  RLM nuke_r license keyهم چنین باید بدانید که این الگو یک 

 ).nuke –xi myscript.nkرا به کار ببرید ( xi-را به کار بگیرید ،  nuke_i license keyیک 

را فشار بدهید ، اگر پردازشی به کار افتاده باشد  Ctrl+Breakکلیدهايِ  ، اگر Windowsدر سیستمِ عاملِ 

آن پردازش لغو می شود بدون این که بیرون بروید. ؛ ولی اگر پردازشی فعال نباشد ، از برنامه بیرون می روید. 

 بی درنگ از برنامه بیرون می روید. Ctrl+Cبا فشار دادن کلیدهايِ 

 همیشه بیرون می روید. Ctr/Cmd+C، با زدن کلیدهايِ  Mac OSXو  Linux بر رويِ سیستم هايِ عاملِ

-X node  ِتنها تکمه يWrite  که باnode .مشخص شده است را پردازش می کند 

باشد که  -) آغاز شده ، یا تنها dashپایانِ سوئیچ هاست ، و اجازه می دهد که اسکریپت با یک خطِّ تیره ( --

 خوانده شود. stdinاجازه می دهد اسکریپت از 

Syntax عمومی 

 عمومی براي به کارگیريِ این گزینه ها وجود دارد : syntax یک اجرا می کنید ، command promptرا در  Nukeزمانی که برنامه يِ 
nuke <switches> <script> <argv> <ranges> 

<switches>  زمانی که : Nuke  .از خطِّ فرمان اجرا می شود ، رفتارِ آن را پیرایش می کند. فهرستی از سوئیچ ها در جدولِ بالا آمده است

 خوانده می شوند. flagاین ها گاهی به نامِ 

<script>  نامِ اسکریپت :Nuke .است 

<argv>  اختیاري است که می توانید آن را در یک عبارت :Nuke ِزیر را ببینید. به کار بگیرید. نمونه ي 

<ranges> .دامنه يِ فریمی است که می خواهید پردازش کنید : 

 نمونه ها
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 بیایید نگاهی داشته باشیم به برخی از نمونه هايِ کاربردي :

 nuke myscript.nk           : و باز کردن یک اسکریپت Nukeبراي اجرا کردن برنامه يِ 

که در آغاز نامِ پرونده می ) hyphen(نامگذاري می کنم. این خطِّ تیره  myscript.nk-شاید دیوانگی باشد ، ولی من اسکریپتم را به نامِ 

 خطِّ تیره بگذارید : syntaxتغییر نام بدهید دو تا را سردرگم می کند. اگر شما نمی خواهید پرونده تان را  Nukeگذارم برنامه يِ 
nuke -- -myscript.nk 

 دیدنِ نگاره ها

 nuke -v polarbear.tif        براي به نمایش گذاشتن یک نگاره :

 nuke -v polarbear.tif whiteflower.psd mountains.cin       براي به نمایش گذاشتن چندین نگاره :

 ) :taxi.0001.tif  ،taxi.0002.tif  ... ، ،taxi.00003.tifبراي به نمایش گذاشتن یک سکانسِ تصویري (
nuke -v taxi.####.tif 1-50 

 انجامِ روند پردازش بر رويِ خطِّ فرمان

 Nuke  :               nuke -F 5 -x myscript.nkاز یک اسکریپت  5براي پردازش کردن فریم 

 Nuke :    nuke -F 30-50 -x myscript.nkاز یک اسکریپت  50تا  30براي پردازشِ فریم هايِ 

 : Nuke) از یک اسکریپت 60تا  34، و  20تا  10براي پردازش کردن دو دامنه يِ فریم (
nuke -F 10-20 -F 34-60 -x myscript.nk 

 : Nukeفریم از یک اسکریپت  50براي پردازش کردن یک فریم از هر ده فریم در یک سکانسِ تصویري 
nuke -F 1-50x10 -x myscript.nk 

 پردازش می شوند. 41،  31،  21،  11،  1فریم هايِ در فرمانِ بالا 

 WriteBlurرا از تکمه يِ  20تا  1، این فرمان فریم هايِ  WriteInvertو  WriteBlurبه نامِ  Writeدر یک اسکریپت با دو تکمه يِ 

 nuke -X WriteBlur myscript.nk 1-20          پردازش می کند :

 [argv 0]به کار بردن 

را اجرا کنید و یک درخت تکمه اي بسازید  Nukeبرنامه يِ  GUI، به نامِ پرونده يِ بیرون رفت تنوع بدهیم. نسخه يِ  [argv]با عبارت بیایید 

آن را باز کنید. در میدانِ  properties، قابِ  Writeدارد. با دو بار کلیک کردن بر رويِ تکمه يِ  Writeدرونِ تکمه يِ  checkerکه یک 

 این نام را براي پرونده بنویسید : fileاريِ نوشت
[argv 0].####.tif 

 اسکریپت را ذخیره کنید و از برنامه بیرون بروید. بر رويِ خطِّ فرمان دستورِ زیر را بنویسید :
nuke -x myscript.nk mychecker 1-5 

 )، و ... mychecker.0001.tif  ،mychecker.0002.tifفریم را پردازش می کند ( 5این فرمان 

این عبارت را  fileبراي کنترل کردن نوعِ پرونده يِ تصویري که بیرون فرستاده می شود ، می توانید متغیرِ دیگري بیافزایید. در میدانِ نوشتاريِ 

 [argv 1].####.[argv 0]                     بنویسید :

 nuke -x myscript.nk mychecker cin 1-5              د :سپس اسکریپت را با این فرمان پردازش کنی 



226 | N u k / U s e r  G u i d e  
 
 

Vahid Velayati 
 

 ، و ... خواهید داشت. mychecker.0001.cin  ،mychecker.0002.cinفریم به نام هايِ  5

ی باشد. این ها م expression [argv n]می تواند هر  <argv>رشته يِ براي این که عبارت هايِ تغییر پذیري براي اسکریپت فراهم شود ، 

ها چندگانه اي را به کار ببرید ، ولی براي این که  expressionجاي بگیرند. می توانید  <ranges>و  <script>باید در خطِّ فرمان میانِ 

) آغاز non-numeric character، هر یک از آن ها می باید با نویسه اي که شماره نباشد ( نشودبراي کنترلِ دامنه يِ فریم سردرگمی ایجاد 

 ند.شو

 ها JPEGها به  TIFFبراي برگرداندن  Pythonبه کار بردن 

 بر می گرداند : JPEGرا به  TIFFفریم با فرُمت  5این روشِ خطِّ فرمان 
nuke -t 
>>> r = nuke.nodes.Read(file = ”myimage.####.tif”) 
>>> w = nuke.nodes.Write(file = ”myimage.####.jpg”) 
>>> w.setInput( 0, r ) 
>>> nuke.execute(“Write1”, 1,5) 
>>> quit() 

 imageconvert.pyاین که این فرمان ها را خطّ به خطّ بنویسیم کمی خسته کننده است. خوب بیایید آن ها را در یک پرونده يِ نوشتاري به نام 

 را اجرا می کند. PythonاسکریپتNuke  بگذاریم. 
cat imageconvert.py 
r = nuke.nodes.Read(file = ”myimage.####.tif”) 
w = nuke.nodes.Write(file = ”myimage.####.jpg”) 
w.setInput( 0, r ) 
nuke.execute(“Write1”, 1,5) 
nuke -t < imageconvert.py 

 اسکریپتPython  خطِّ فرمان مانندبه را می توانید ار اجازه دارید که نمادهايِ دیگري را پس از نامِ . با انجام این ک به کار بگیرید یک نماد

 argv[1:]اجرا شده است ، و  Pythonنامِ یک اسکریپت  sys argv[0]. زمانی که این کار را انجام می دهید ، باید بدانید که اسکریپت بنویسید

 نمادهايِ دیگري هستند که به کار می گیرید. به نمونه اي که در زیر آمده نگاه کنید.
cat imageconvertwithargs.py 
import sys 
r = nuke.nodes.Read(file = sys.argv[1]) 
w = nuke.nodes.Write(file = sys.argv[2]) 
w.setInput(0, r) 
nuke.execute("Write1", 1, 5) 
nuke -t imageconvertwithargs.py myimage.####.tif myimage.####.jpg 

 متغیرهايِ محیطی

ايِ محیطی متغیرهایی هستند که براي اندوختنِ یک ارزش ، مانند یک مسیرِ پرونده يِ ویژه به کار گرفته می شوند. این متغیرها را می متغیره

را  دانسته هاي اندوخته شده در پرونده ها Nukeبه کار بگیرید و بر رويِ رفتارِ برنامه تاثیر بگذارید. براي نمونه ،  Nukeتوانید در برنامه يِ 

 آن ها تعریف کند. برايبه کار می گیرد تا جایی را 

 پیکربندي کردن متغیرهايِ محیطی
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در این بخش می آموزید که چگونه متغیرهايِ محیطی را پیکربندي کنید ؛ اگر یک متغیري هست چگونه آن را بررسی نمایید ، و یا چگونه 

 فهرستی از متغیرهايِ محیطی را به نمایش بگذارید.

 Windowsروشِ پیکربندي کردن یک متغیرِ محیطی در سیستمِ عاملِ 

 را برگزینید. Propertiesراست کلیک کنید و گزینه يِ  My Computerبر رويِ  .1

 بروید. Advancedبه برگه يِ  .2

 ود.باز می ش Environment Variablesکلیک کنید. پنجره يِ گفت و گويِ  Environment Variablesبر رويِ دکمه يِ  .3

، بسته به این که آیا می خواهید متغیر را براي کاربرِ  System variablesیا  User variables، در زیرِ یا  Newبر روي دکمه يِ  .4

یت رجاري یا همه يِ کاربران پیکربندي نمایید ، کلیک کنید. براي پیکربندي کردن متغیر هايِ محیطی براي همه يِ کاربران ، می باید از مدی

 امتیاز داشته باشید. حقِ

 ، نامِ متغیرِ محیطی را بنویسید که می خواهید پیکربندي کنید. Variable nameدر میدانِ  .5

 ، ارزشی را براي متغیرِ محیطی بنویسید. این ارزش می تواند براي نمونه ، یک مسیرِ پرونده باشد. Variable valueدر میدانِ  .6

7. OK .را بزنید 

متغیرهايِ موجود در سیستم تان را ویرایش می کنید ، یا متغیري به متغیرهاي سیستم یا متغیرهايِ کاربري زمانی که  یادداشت :

 log ، گیرندیر بتاث از تغییراتی که داده اید پیش از این که متغیرهاي محیطی می افزایید یا از آن پاك می کنید ، شاید نیاز باشد

off   و دوبارهlog on .کنید 

 Macیکربندي کردن یک متغیرِ محیطی در سیستمِ عاملِ روشِ پ

است که هر زمان که کاربري  property listیا پرونده يِ  a .plist–، یک پرونده يِ محیطیِ بخصوص به نامِ  Mac OSXبر رويِ سیستمِ 

log in يِ  می شود این پرونده خوانده می شود. اگر پرونده.plist file  مسیرِ پوشه يِ باید آن را در می  نباشددر سیستم تان

~/.MacOSX/environment.plist  نشان دهنده يِ یک پوشه يِ پنهان  ” . “نشان دهنده يِ پوشه يِ خانه يِ کاربر ، و  ” ~ “بسازید (که

 شده است).

 Mac یا نمی خواهید پرونده يِاگر تنها نیاز باشد که یک متغیرِ محیطی را براي یک جلسه پیکربندي کنید ،  یادداشت :

OSX .plist  روشی که در بخشِ مربوط به سیستمِ عاملِ را به کار ببرید ، می توانید به کمکLinux  ِآمده 752(صفحه ي (

 متغیرها را پیکربندي کنید. است

 plist.ود ، متغیرهايِ محیطی که به کمک پرونده يِ از راه شمایلِ آن ، و هم زمانی که برنامه از پایانه اجرا می ش Nukeهم زمانی که برنامه يِ 

 پیکربندي شده اند خوانده می شوند.

). user folderپوشه يِ خودتان در زیر باز کنید. به طورِ پیش فرض ، می باید در پوشه يِ خانه تان باشید ( Terminalیک پنجره يِ  .1

 ) را بنویسید. pwd )present working directoryبراي بازبینیِ این پوشه ، 

 mkdirپوشهدر فهرست نباشد ، براي ساختنِ  MacOSX.را بنویسید. اگر  Is -alبراي دیدن فهرستی از پرونده هایی که در پوشه هستند ،  .2

.MacOSX .را بنویسید 
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 را اجرا کنید. TextEditتان ،  plist.براي ساختن پرونده يِ  .3

 را ویرایش کنید : ”string“و  ”key“آن چه در زیر می آید را در سند رونوشت بگیرید و ورودي هايِ  .4

<?xml version="1.0" encoding="UTF-8"?> 
<!DOCTYPE plist PUBLIC "-//Apple Computer//DTD PLIST 1.0//EN" 
"http://www.apple.com/DTDs/PropertyList-1.0.dtd"> 
<plist version="1.0"> 
<dict> 
<key>NUKE_PATH</key> 
<string>/SharedDisk/Nuke</string> 
<key>OFX_PLUGIN_PATH</key> 
<string>/SharedDisk/OFX</string> 
</dict> 
</plist> 

به  NUKE_PATH. متغیرِ OFX_PLUGIN_PATHو  NUKE_PATHاین نمونه دو متغیرِ محیطی را پیکربندي می کند : 

/SharedDisk/Nuke/  ِرو متغی ،OFX_PLUGIN_PATH  به/SharedDisk/OFX .اشاره دارد 

 را برگزینید. Format > Make Plain Textهر گاه از سند رضایت داشتید ،  .5

 را به آخرِ نامِ پرونده بیافزایید. txt.ذخیره کنید. نباید گسترشِ  environment.plistپرونده را در پوشه يِ خانه تان با نامِ  .6

 را بنویسید. pwdرا اجرا کنید. براي این که در پوشه يِ خانه تان باشید ،  Terminalبیرون بروید ؛ و یک پنجره يِ  TextEditاز  .7

، عبارتMacOSX  .از پوشه يِ خانه تان به درون پوشه يِ  environment.plistبراي جا به جا کردن پرونده يِ  .8

mvenvironment.plist.macOSX .را بنویسید 

 ).Log in( به سیستم بیایید و دوباره )Log outز سیستم بیرون رفته (ا .9

 )را بخوانید 752راهنمايِ کاربري صفحه يِ خودLinux  ، براي دانستن روشِ پیکربندي کردن یک متغیرِ محیطی در سیستمِ عاملِ (

 که وجود دارد یک متغیرِ محیطی روشِ بررسی کردن

 Windowsبر رويِ سیستمِ عاملِ 

1. Start > All Programs > Accessories > Command Prompt .را برگزینید 

را با نامِ متغیرِ محیطی جایگزین  VARIABLEرا بنویسید. واژه يِ  %echo %VARIABLEکه باز می شود ،  Commandدر پنجره يِ  .2

 را بنویسید. %echo %NUKE_DISK_CACHEرا بررسی کنید ،  NUKE_DISK_CACHEکنید. براي نمونه ، اگر می خواهید 

 به نمایش در می آید. Commandاگر متغیر پیکربندي شده باشد ، ارزشِ آن در پنجره يِ 

 Linuxیا  Mac OSXبر رويِ سیستمِ عاملِ 

1. Terminal  یاShell .را اجرا کنید 

2. echo $VARIABLE  ِرا بنویسید. واژه يVARIABLE رِ محیطی جایگزینرا با نامِ متغاگر می خواهید  کنید. براي نمونه ی ،

NUKE_DISK_CACHE  ، را بررسی کنیدecho $NUKE_DISK_CACHE .را بنویسید 

 به نمایش در می آید. Shellیا  Terminalاگر متغیر پیکربندي شده باشد ، ارزشِ آن در پنجره يِ 

 به نمایش گذاشتن فهرستی از متغیرهايِ محیطیِ پیکربندي شده
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 Windowsیستمِ عاملِ بر رويِ س

1. Start > All Programs > Accessories > Command Prompt .را برگزینید 

 را بنویسید. setکه باز می شود ،  Commandدر پنجره يِ  .2

 به نمایش در می آیند. Commandفهرستی از همه يِ متغیرهايِ محیطی که پیکربندي شده اند در پنجره يِ 

 Linuxیا  Mac OSXبر رويِ سیستمِ عاملِ 

1. Terminal  یاShell .را اجرا کنید 

2. printenv .را بنویسید 

 به نمایش در می آیند. Shellیا  Terminalفهرستی از همه يِ متغیرهايِ محیطی که پیکربندي شده اند در پنجره يِ 

 Nukeمتغیرهايِ محیطیِ 

 آمده است. Nukeدر جدولِ زیر فهرستی از همه يِ متغیرهايِ محیطی در برنامه يِ 

 توضیح متغیرِ محیطی
FN_DISABLE_LICENSE_ 
DIALOG 

 یا
FN_NUKE_DISABLE_TMPLIC_ 
NOTIFY_DIALOG 

در آغازِ برنامه  Nukeموقتّ را نصب کرده باشید ،  licenseبه طور پیش فرض ، اگر یک 

گفت و گویی را نشان می دهد و شما را از شمار روزهايِ مانده آگاه می سازد. اگر پنجره يِ 

 1می خواهید این رفتار را از کار بیاندازید ، می توانید یکی از این متغیرهايِ محیطی را به 

 ش در نیاید.پیکربندي کنید تا پیامِ هشدار در باره يِ پایانِ زمان مجوز به نمای

 يپیدا نکند (براي نمونه اگر تنها مجوز licenseاگر برنامه هیچ  یادداشت :
را اجرا کنید)  Nuke Xدارید ولی تلاش می کنید که برنامه يِ  Nukeبراي 

 باز هم شما را در جریان این می گذارد. 
FN_LICENSE_DIALOG_DAYS_ 
LEFT_BEFORE_PROMPT 

در آغازِ برنامه  Nukeموقتّ را نصب کرده باشید ،  licenseبه طورِ پیش فرض ، اگر یک 

گفت و گویی را نشان می دهد و شما را از شمار روزهايِ مانده آگاه می سازد. اگر پنجره يِ 

می خواهید این رفتار را تا چند روزِ مشخص پیش از به پایان رسیدن از کار بیاندازید ، می 

 این متغیرِ محیطی را به شماره روزهایی که نیاز است پیکربندي کنید.توانید 

 يپیدا نکند (براي نمونه اگر تنها مجوز licenseاگر برنامه هیچ  یادداشت :
را اجرا کنید)  Nuke Xدارید ولی تلاش می کنید که برنامه يِ  Nukeبراي 

 باز هم شما را در جریان این می گذارد.
FN_NUKE_DISABLE_GPU_ 
ACCELERATION 

که  را از کار می اندازد. زمانی Nukeبرنامه يِ  OpenCLو  CUDAتوانایی هايِ  این متغیر

هایی که در همان سیستم نصب شده اند از کار می افتند  GPUاین توانایی فعال باشد ، همه يِ 

 Preferences > Performance > Hardwareو نمی توانید از فهرست پایین افتادنی 

> default blink device  گزینه اي را برگزینید. همه يِ تکمه هایی که براي آماده سازي
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 CPU، نیز به  Denoiseو  Kronos) ، مانند GPU acceleratedنیاز دارند ( GUPبه 

 پیش فرض می زنند.

foundry_LICENSE  ِجايِ پرونده يNuke RLM license  ِیک پرونده يِ نوشتاري به نام)nuke.lic اگر ، (

 زیر به کار گرفته نشود :جايِ پیشنهاد شده يِ 

 : Linuxو  Mac OSXدر سیستمِ عاملِ 
/usr/local/foundry/RLM 

 : Windowsدر سیستمِ عاملِ 
drive letter:\Program Files\The Foundry\RLM 

FOUNDRY_LICENSE_DEBUG  ر دانسته هايِ دیگر مربوط بهاین متغیlicense  را در خطِّ فرمان یاTerminal  چاپ می

 کند.

FOUNDRY_LICENSE_FILE  ِجايِ پرونده يNuke FLEXlm license  ِیک پرونده يِ نوشتاري به نام)nuke.lic ، (

 زیر به کار گرفته نشود :اگر جايِ پیشنهاد شده يِ 

 : Linuxو  Mac OSXدر سیستمِ عاملِ 
/usr/local/foundry/FLEXlm 

 : Windowsدر سیستمِ عاملِ 
drive letter:\Program Files\The Foundry\FLEXlm 

FOUNDRY_LOG_FILE  ِر جاياین متغیlogfile ِبرنامه ي Nuke  را مشخص می کند. اگر یکlogfile  ن نشدهمعی

 باشد ، همه بیرون رفت ها بر رويِ صفحه نمایش نشان می یابند. 

FOUNDRY_LOG_LEVEL  ِر ترازاین متغیlog  ِشدن فرآورده هايNuke  ِرا به هنگامِ کار پیکربندي می کند. بر روي

 وجود دارد : verboseتا  minimalیک لغزنده يِ اندازه گیري چهار ترازِ جزئیات ، از 
• Error 
• Warning 
• Message 
• Verbose 

پیکربندي کنید ، زمانی که  verboseشدن را به  logاگر ترازِ  یادداشت :
FOUNDRY_LOG_FILE  ِن شده باشد ، پرونده هايمعیlog  بزرگی ساخته

 می شوند.
FRAMESERVER_LOG_DIR  ِاگر دوست دارید پرونده هايlog  را ازNUKE_TEMP_DIR  پیش فرض جدا داشته باشید

را در جايِ دیگري که  logپرونده هايِ  Frame Server، این متغیر را به کار ببرید تا 

 مشخص شده بنویسد.

NUKE_ALLOW_GIZMO_ 
SAVING 

در  gizmoبه شما اجازه نمی دهد که بدون رونوشت گرفتن از   Nukeبه طورِ پیش فرض ، 

کنید. با پیکربندي کردن این متغیر به  Save asو  Overwriteها را  gizmoیک گروه ، 

را  gizmoمی توانید این رفتار را به کار بیاندازید. بنا بر این ، دیگر نیازي نیست که یک  1

 پیش از ویرایش کردن آن رونوشت بگیرید.
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NUKE_CRASH_HANDLING  با گزارش دادنBreakpad crash  می توانید خرابی هایی که به احتمالِ خیلی دور ممکن

 است پیش بیایند را به شرکتThe Foundry  بفرستید. به طورِ پیش فرض ، گزارشِ خرابی

 غیر فعال است. Terminal modeفعال ، و در  GUI modeدر 

پیکربندي می کنید ، گزارش دادن  1را بر رويِ  NUKE_CRASH_HANDLINGزمانی که 

 ).enableبه کار می افتد ( Terminalو  GUIرابی ها در هر دو الگويِ خ

پیکربندي می کنید ، گزارش دادن  0را بر رويِ  NUKE_CRASH_HANDLINGزمانی که 

 ).disableاز کار می افتد ( Terminalو  GUIخرابی ها در هر دو الگويِ 

NUKE_DEBUG_ 
IMAGECACHE 

به خطِّ فرمان یا  Compاز نمایشگرِ  image cacheهنگامی که فعال باشد ، داده هايِ 

Terminal  ، چاپ می شوند. دانسته هایی در باره يِ فضايِ به کار رفته بر رويِ دیسک

 به نمایش گذاشته می شوند. cacheشده ، و جايِ  cacheشمارِ پرونده هايِ 

NUKE_DEBUG_MEMORY  ِبزرگ کار می کنید ، هنگامی که دارید بر رويِ نگاره هايNuke  ممکن است نیاز پیدا
کند که حافظه را در هنگامِ پردازش خالی کند. زمانی که این رویداد انجام بشود و 

NUKE_DEBUG_MEMORY  ِپیکربندي شده باشد ،  1بر رويNuke  دانسته هايِ زیر

 را به کنسول چاپ می گیرد :

Memory  به کار گیري بیش تر از :Maximum  که تلاش می کند به کارگیري را از ،

1GB  924بهMB .کاهش بدهد 

 را ببینید. debug memoryاگر این متغیر پیکربندي نشده باشد ، نمی توانید پیام هايِ 

هستند. براي نمونه ،  1000یگان هایی از  TB، و  KB  ،MB  ،GBبه یاد داشته باشید که 

1MB  بایت است. 1,000,000برابر با 

NUKE_DISK_CACHE  ِجایی است که برنامه يNuke  همه يِ نگاره هایی که به تازگی در نمایشگر به نمایش در

آمده اند را در آن جا ذخیره می کند. ایده آل این است که این جا باید یک دیسک بومی باشد 

یش اید فضايِ کافی نیز براي بتا بشود در سریع ترین زمان به آن دسترسی داشت. هم چنین ب

 باشد. داشته flipbook cacheاندازه يِ  ترین

در  flipbook cacheاگر این متغیر پیکربندي نشده باشد ، جايِ ذخیره سازي با گزینه يِ 

مشخص می شود. به طورِ پیش فرض ، این پیکربندي به  Preferencesپنجره يِ 

NUKE_TEMP_DIR .اشاره دارد 

NUKE_DISK_CACHE_GB  ِبیش ترین اندازه يflipbook cache  که می شود به آن رسید را برحسب گیگابایت معلوم

 می کند.

 flipbook cacheاگر این متغیر پیکربندي نشده باشد ، جايِ ذخیره سازي با پیکربنديِ 

size  ِدر پنجره يPreferences .مشخص می شود 

NUKE_EXR_TEMP_DIR  ِدر سیستمِ عاملLinux  ر جایی است کهاین متغی ،Nuke  ِموقّتی (که دارد براي پرونده هاي

می خواند) به کار می گیرد. این متغیرِ محیطی تنها  PIZفشرده سازي شده با  exr.پرونده هايِ 

 به کار می آید. Linuxبر رويِ سیستمِ عاملِ 
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مشخص  NUKE_TEMP_DIRاگر این متغیر پیکربندي نشده باشد ، جايِ ذخیره سازي با 

 می شود.

NUKE_FONT_PATH  ِجایی است که برنامه يNuke  ِزمانی که قاب ،properties  ِتکمه يText  باز شده باشد

 ، براي پرونده هايِ فونت موجود به آن جا نگاه می کند.

NUKE_IGNORE_ROTO_ 
INCOMPATIBILITY 

را باز  Nuke 8پیش از نسخه يِ  RotoPaintتکمه هايِ  دارايِزمانی که اسکریپت هايِ 

) به نمایش در می آید. این متغیر warningمی کنید ، یک پنجره يِ گفت و گويِ هشدار (

 نمایشِ این پنجره را از کار می اندازد.

NUKE_INTERACTIVE  به طورِ پیش فرض ، کارکردimport nuke  ِزیک مجوnuke_r_render  را بررسی می

را بدون انجامِ کارهايِ پردازشی به کار ببرید ، و یک مجوزِ  Nukeکند. اگر می خواهید 

interactive license  ِرِ محیطی را بر رويپیکربندي کنید.  1هم دارید ، این متغی 

NUKE_MOV64READER_ 
ENABLE 

از کار  Nukeدر برنامه يِ  bit mov decoding-64بگذارید تا  0این متغیر را بر رويِ 

 برگردد. bit decoding-32بیافتد و به 

NUKE_NO_CRASH_PROMPT  هنگامی کهcrash handling  درGUI mode  ر به شما اجازه میال است ، این متغیفع

 دهد که بتوانید کنترل کنید آیا گزارش ها خود به خود فرستاده بشوند یا نه :

گزارش  پیکربندي شده باشد ، 1بر رويِ  NUKE_NO_CRASH_PROMPTهنگامی که 

گفت و گويِ گزارش دهنده  هايِ خرابی خود به خود فرستاده می شوند ، بدون این که پنجره يِ

 به نمایش در آید. crash reporterيِ 

 Nukeپیکربندي شده باشد ،  0بر رويِ  NUKE_NO_CRASH_PROMPTهنگامی که 

 crashپنجره يِ گفت و گويِ یک پیش از این که گزارشِ خرابی را به شرکت بفرستد ، همیشه 

reporter .را به نمایش می گذارد 

NUKE_NO_VIEWER_GPU Comp Viewer OpenGL hardware acceleration  ِرا در برنامه يNuke  از کار

 می اندازد.

NUKE_PATH  ِجایی را معلوم می کند که پرونده هايِ مربوط به پیکربندي هايNuke  در آن جا ذخیره می

 شوند.

NUKE_TEMP_DIR  جایی را معلوم می کند که همه يِ پرونده هاي موقّتی ، که جايِ خاصی براي آن ها تعریف

 نشده است ، در آن جا ذخیره می شوند.

آن  Preferencesدر پنجره يِ  flipbook cacheاین هم چنین جایی است که پیکربنديِ 

 را پیش فرض قرار می دهد.

NUKE_WINDOWMANAGER_ 
DEBUG 

به خطِّ فرمان  Nukeبرنامه يِ  window managerهنگامی که فعال باشد ، داده ها از 
 چاپ می شوند. Terminalیا 

OCIO  ر را براياین متغیcolor conversion  (برگرداندن رنگ ها به هم دیگر) به جایی که پرونده

 تان است پیکربندي کنید. OCIO configurationيِ 
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که در پنجره يِ  OCIO configاگر قصد دارید پرونده يِ  یادداشت :
Preferences  مشخص شده است را به کار بگیرید ، مطمئن شوید که گزینه

 < Preferences > Project Defaults > Color Managementيِ 

Export > use OCIO nodes when exporting to a comp  نشان
 خورده و فعال باشد.

OFX_PLUGIN_PATH  ِجایی است که برنامه يNuke  ِبراي پلاگین هايOFX .به آن جا نگاه می کند 

 TCLو  Python، و اسکریپت هايِ  NDKها ، پلاگین هايِ  Gizmoبارگذاري کردن 

را پیکربندي می کنند. این نرم افزار  Nukeکه باز می شود ، پوشه هايِ گوناگون را براي پرونده هایی دنبال می کند که رفتارِ  Nukeبرنامه يِ 

، اسکریپت  NDKها ، پلاگین هايِ  gizmo، فرُمت هايِ تصویري ،  Menu، گزینه هايِ  favoriteبراي دانسته هایی در باره يِ پوشه هايِ 

 به گوشه و کنار نگاه می کند. Preferences، و  generic TCL، اسکریپت هايِ  Pythonهايِ 

بزنید ؛ چون یک اشتباه کوچک  Pythonپرونده هايِ خوب است بدانید که باید خیلی با دقتّ دست به ویرایش  هشدار :

 را از اجرا شدن باز می ایستاند. Nukeبرنامه يِ 

 صی از پوشه يِ خانه تان و پوشه يِ خود نرم افزار را می گردد :زیر پوشه هايِ بخصو Nukeبرنامه يِ 

 : Linuxدر  •

• /usr/local/Nuke9.0v4/plugins 
• /usr/local/Nuke9.0v4/plugins/nukescripts 
• /users/login name/.nuke 

 : Mac OSXدر  •

• /Applications/Nuke9.0v4/Nuke9.0v4.app/Contents/MacOS/plugins 
• /Applications/Nuke9.0v4/plugins/nukescripts 
• /Users/login name/.nuke 

 : Windowsدر  •

• drive letter:\Program Files\Nuke9.0v4\plugins\nukescripts or 
• drive letter:\Program Files (x86)\Nuke9.0v4\plugins\nukescripts 
• drive letter:\Program Files\Nuke9.0v4\plugins 
• ~\.nuke 

به آن اشاره شده است. اگر  HOMEرا می توانید در زیرِ پوشه اي پیدا کنید که با متغیرِ محیطیِ  nuke.پوشه يِ  یادداشت :

 USERPROFILEدر زیرِ پوشه اي است که با متغیرِ محیطیِ  nuke.این متغیر پیکربندي نشده باشد (که شایع است) ، پوشه يِ 

است)  \driver letter:\login nameیا  \driver letter:\Documents and Settings\login name(که معمولاً به شکلِ 

 مشخص می شود.

پیکربندي شده باشند و به جایی اشاره داشته باشند ، براي یافتن آن  USERPROFILEو  HOMEاگر متغیرهايِ محیطیِ 

%HOME%  یا%USERPROFILE%  ِرا در نوارaddress  ِدر مرورگرWidows Explorer  رِ محیطیبنویسید. اگر متغی

پیکربندي شده باشد ، پوشه اي که به آن اشاره دارد باز می شود. اگر متغیرِ محیطی پیکربندي نشده باشد ، پیامِ خطایی را دریافت 

 می کنید.
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، این امکان را براي  menu.pyو  init.pyتان به کمک پرونده هايِ  Python/pluginبه جز راه اندازي کردن محیطNuke  ، برنامه يِ 

 : Pythonاجرا کنید. جايِ پیش فرض براي این رمزِ ) startupرا خود به خود هنگامِ آغازِ برنامه ( Pythonشما فراهم می کند که رمزِ 
<STARTUP_PYTHON_PATH>/Python/Startup 

یافت می شوند و به هنگامی  Python/Startup/باشند در پوشه يِ  init__.py__که حاويِ  Python .pyهمه يِ ماژول ها یا بسته هايِ 

 افزوده می شوند.  hiero.plugins namespaceکه نرم افزار آغاز به اجرا می کند ، به درون برنامه آورده شده ، و به 

هر جايِ دیگري نگاه بیاندازد ، می توانید خودتان یک  براي پلاگین ها ، به جز همین جاهايِ پیش فرض ، به Nukeاگر می خواهید برنامه يِ 

امه را نمسیرِ پلاگینی مشترك تعریف کنید. بنا بر این ، با تعریف کردن مسیرِ پلاگینی ، می توانید خودتان یک پوشه يِ مشترك معلوم کنید تا بر

 براي چندین هنرمند به کنترل در آورید.

 Nukeتعریف کردن یک مسیرِ پلاگینی براي 

 بسازید. NUKE_PATHدر هر یک از ماشین ها ، یک متغیرِ محیطی به نامِ  .1

را در خود جاي  Nukeرا به نامِ مسیرِ پوشه اي تعریف کنید که پرونده هايِ مربوط به پیکربندي سازيِ  NUKE_PATHمتغیرِ محیطیِ  .2

 خواهد داد.

 : tcsh Shellا ی csh Shell با به کارگیريِ Mac OSXبراي نمونه ، در سیستمِ 
setenv NUKE_PATH /SharedDisk/Nuke 

 را به کار می گیرید : ksh Shellیا  bash Shellیا اگر دارید یک 
export NUKE_PATH=/SharedDisk/Nuke 

اگر را تا نخستین پلاگینِ جاسازي شده جست و جو می کند. براي نمونه  plugin_find() ، (NUKE_PATHبارگذاري کردن یک پلاگین (

باشد ، مسیري که در زیر می آید تا نخستین پلاگین جاسازي  project_dir:studio_dir:company_dirشاملِ  NUKE_PATHمتغیرِ 

 شده یکی یکی جست و جو می شود :  

• ~/.nuke 
• project_dir 
• studio_dir 
• company_dir 
• nuke_dir 

کشف شده به کار گرفته می شوند ، متغیرِ محیطیِ و همه يِ رونوشت هايِ  menu.pyو  init.pyبه هر روي ، زمانی که بارگذاريِ 

NUKE_PATH  .این امکان فراهم می شود که پیکربندي هايِ بومی بر رويِ ماشین به پیکربندي بدین سان ، در جهتیِ وارونه تجزیه می شود

 به شکلِ زیر اجرا می شوند : init.pyکه در بالاست ، اسکریپت هايِ هايِ همگانی تر سوار شوند. بنا بر این ، با رده يِ زنجیره اي 

• nuke_dir/init.py 
• company_dir/init.py 
• studio_dir/init.py 
• project_dir/init.py 
• ~/.nuke/init.py 

 OFX بارگذاريِ پلاگین هايِ
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می گردد. این پلاگین ها کارکردهايِ  OFXگوناگون را براي پلاگین هايِ  ه اجرا می شود ، برنامه پوشه هايِآغاز ب Nukeزمانی که برنامه يِ 

به ارمغان می آورند. مسیرهايِ این پوشه ها در سیستم هايِ عاملِ گوناگون با هم فرق دارد ، ولی آن چه در زیر می  Nukeبیش تري را براي 

 که می شود آن ها را پیدا کرد :نمونه جاهایی است آوریم 

 : Linuxبر رويِ  •
/usr/OFX/Nuke 
/usr/OFX/Plugins 

 : Windowsبر رويِ  •
C:\Program Files\Common Files\OFX\Nuke (or, when using 64-bit Nuke on 64-bit Windows, \Program 
Files (x86) 
\Common Files\OFX\Nuke) 
C:\Program Files\Common Files\OFX\Plugins (or, when using 64-bit Nuke on 64-bit Windows, 
\Program Files (x86) 
\Common Files\OFX\Plugins) 

 : Mac OSXبر رويِ  •
/Library/OFX/Nuke 
/Library/OFX/Plugins 

بگردد ، تنها باید متغیرِ محیطیِ  OFXهر جایی به جز آن جا که شما می توانید بگردید را براي پلاگین هايِ  Nukeبرنامه يِ اگر می خواهید 

OFX_PLUGIN_PATH .را به پوشه يِ جدیدي اشاره بدهید 

 : tcsh Shellیا  csh Shellبا به کارگیري یک  Mac OSXبراي نمونه ، بر رويِ سیستمِ عاملِ 
setenv OFX_PLUGIN_PATH /SharedDisk/OFX 

 را به کار می گیرید : ksh Shellیا  bash Shellیا اگر دارید یک 
export OFX_PLUGIN_PATH=/SharedDisk/OFX 

 مشترك Favoriteتعریف کردن پوشه هايِ 

ها را براي  Favoriteدست بیابید. معمولاً این  Favoriteمی توانید به پوشه هايِ  Nukeبا یک کلیک در هر مرورگرِ پرونده اي برنامه يِ 

 پوشه هايِ مشترك در یک پروژه می سازید.

 Favoriteروشِ تعریف کردن یک مجموعه يِ مشترك از پوشه هايِ 

 بسازید. menu.pyدر پوشه يِ مسیرِ پلاگین تان ، پرونده اي به نام  .1

 یک ورودي با فرُمت زیر بیافزایید : .2

nuke.addFavoriteDir('DisplayName', 'Pathname') 
• DisplayName پوشه با آن نام به نمایش گذاشته شود ؛ براي نمونه ، را با رشته اي جایگزین کنید که می خواهید ب راي پیوند

‘Home’  یا‘Desktop’. 

• Pathname  را با نامِ مسیر براي پوشه اي جایگزین کنید که می خواهید بهfavorite .اشاره داشته باشد 

 بنویسید : ’pathname‘در وروديِ بالا ، هم چنین می توانید عبارت هايِ زیر را به اختیار پس از  .3
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• Type ) این یک رشته :sting ِو یک اپُراتور (wise-bit  ، ترکیبی از  یااستnuke.IMAGE  ،nuke.SCRIPT  یا

nuke.FONT .است 

o nuke.IMAGE  ِپوشه ي :favorite  ِرا محدود به این می کند که تنها در مرورگرِ تصویري (که برنامه يNuke  براي

 یک پرونده آن را باز می کند) به نمایش در آید. Writeو  Readکارکردهايِ 

o nuke.SCRIPT  ِپوشه ي :favorite ) را محدود به این می کند که تنها در مرورگرِ پرونده هايِ اسکریپتیScript 

file browser ِبه نمایش در آید. زمانی که دستور (File > Open Comp  را اجرا می کنید ، یا براي باز کردن و

رونده هايِ اسکریپتی به درون برنامه گزینه يِ همانندي را بر می گزینید ، مرورگرِ پرونده هايِ اسکریپتی به آوردن پ

 نمایش در می آید.

o nuke.FONT  ِپوشه ي :favorite ) را محدود به این می کند که تنها در مرورگرِ فونتFont browser به نمایش (

 در آید.

• icon=’Name’  :Name ِنگاره و گسترشِ پرونده يِ تصویري  را با نام.png  یا).xpm ( جایگزین کنید که می خواهید آن را

مسیرِ پلاگین تان ذخیره شده باشد. اندازه يِ  به کار بگیرید. نگاره می باید در پوشه يِ favoriteبه عنوان شمایل براي پوشه يِ 

 پیکسل باشد. 24x24نگاره باید 

• Tooltip=’My tooltip’  :My tooltip  را با رشته اي جایگزین کنید که می خواهید به عنوانِ راهنمايِ پایین افتادنی به کار

 بیاید.

 1نمونه يِ 

باز  Readپرونده اي که از راه تکمه يِ می سازد که بر رويِ همه يِ مرورگرهايِ  DisasterFlickStoreبه نامِ  favoriteوروديِ زیر یک 

 اشاره دارد.job/DisasterFlick/img/آمده و به پوشه يِ  می شوند ، به نمایش در
nuke.addFavoriteDir ('DisasterFlickStore', '/job/DisasterFlick/img', nuke.IMAGE) 

 

 2نمونه يِ 

یا با برگزیدن دستورِ  Readمی سازد ؛ که بر رويِ همه يِ مرورگرهايِ پرونده اي که از راه تکمه يِ  Testبه نامِ  favoriteوروديِ زیر یک 

File > Open Comp  ِباز می شوند ، به نمایش در آمده و به پوشه ي/job/Test  اشاره دارد. هم چنین وروديTest Images  و

Scripts  را به عنوانtooltip  ِبراي پوشه يfavorite .تعریف می کند 
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nuke.addFavoriteDir ('Test', '/job/Test', nuke.IMAGE | nuke.SCRIPT, tooltip='Test images and Scripts') 

 

 )Cross Platform( زیر بناییدستکاري کردن مسیرهايِ پرونده چند 

به کار می گیرید ، شاید بخواهید برنامه را به گونه اي پیکربندي کنید که اسکریپت هایی  سیستمِ عاملرا بر رويِ چندین  Nukeاگر برنامه يِ 

 که در یک سکو ساخته اید را در سکويِ نیز دیگر به کار ببرید.

، و بالعکس  Linuxبر رويِ سیستمِ عاملِ  Windowsبراي نمونه ، براي اطمینان از این که مسیرهايِ پرونده اي ساخته شده در سیستمِ عاملِ 

 : دنبال کنیدنیز کار می کنند ، می توانید کارهايِ زیر را 

 (اگر نیست) بسازید. init.pyدر پوشه يِ مسیرِ پلاگین تان پرونده اي به نامِ  .1

 را در یک ویراستارِ نوشتاري باز کنید و یک ورودي با قالبِ زیر را به آن بیافزایید : init.pyپرونده يِ  .2

import platform 
 
def filenameFix(filename): 
if platform.system() in ("Windows", "Microsoft"): 
return filename.replace( "/SharedDisk/", "p:\\" ) 
else: 
return filename 

(که در نمونه يِ بالا با  Windows ايمسیرهايِ پرونده ،  به کار برود Linuxدر سیستمِ  Nukeهر زمان که یک اسکریپت بدین سان ، 

p:\  با مسیرهايِ پرونده اي (آغاز بشوندLinux  که با)/SharedDisk/ وگرنه ، مسیرهايِ پرونده  آغاز می شوند) جایگزین می شود ؛

 به کار می روند. Windowsايِ 

 \:p) تغییر نمی کند. اگر دارید مسیرِ GUI )Graphic User Interfaceکاربري  به یاد داشته باشید که مسیرهايِ پرونده در پنجره يِ

نشان داده می شود. به هر روي ، در سیستمِ عاملِ  \:pبه کار می برید ، این مسیر هنوز به شکلِ  هايِ یک تکمهکنترل  ی ازرا در یک

Linux  ِبرنامه ي ،Nuke  ِمسیرp:\  ِرا به شکل/SharedDisk/ .تفسیر می کند 

 پیش فرض براي کنترل ها راه اندازي کردن ارزش هايِ
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تان می توانید ارزش هايِ پیش فرض را براي کنترل هايِ یک تکمه پیکربندي کنید.  init.pyساده به پرونده يِ  Pythonبا افزودن یک خطِّ 

می شوند. براي هر گاه یک ارزشِ پیش فرض را پیکربندي نمودید ، همه يِ کنترل هایی که نام هايِ همخوان دارند به این ارزش پیش فرض 

یا تکمه هايِ دیگري که با  Read  ،Writeنمونه ، می توانید ارزش هايِ پیش فرض را براي کنترل هايِ ویژه يِ فرُمت پرونده در تکمه يِ 

 فرُمت پرونده ها سر و کار دارند ، پیکربندي کنید. براي پیکربندي کردن یک ارزشِ پیش فرض ، عبارت زیر را به کار ببرید :
nuke.knobDefault() 

که به دنبالِ آن گسترشِ فرُمت پرونده و نامِ کنترل می آید.  را به کار ببرید classبراي معین کردن پیش فرض هايِ ویژه براي فرُمت پرونده ، نامِ 

 ) از هم جدا می شوند. مانند :.همه يِ این ها با نشانه يِ نقطه (
nuke.knobDefault("Read.exr.compression", "2") 

را ارزشِ پیش فرض  200،  فریمِ  Project Settingsشاید بخواهید براي آخرین ارزشِ فریم در کنترل هايِ دامنه يِ فریم ، در پنجره يِ 

 کنید. براي این کار عبارت زیر را بنویسید :
nuke.knobDefault("Root.last_frame", "200") 

 سفارشی تعریف کردن فهرست ها و نوارهايِ ابزارِ

بیافزایید. سپس  Nukeکاربري فهرست ، و هم چنین گزینه هايِ نوارِ ابزارِ سفارشی را به پنجره يِ  آزادانه می توانید فهرست ها و گزینه هايِ

 را هدف بگیرند.یره شده در پوشه يِ مسیرِ پلاگین ها و پلاگین هايِ ذخ gizmoهنرمندان می توانند این گزینه ها را به کار بگیرند تا 

به نامِ  gizmoپیش فرض بیافزایید که در آن گزینه اي باشد براي این که یک براي نمونه ، اگر بخواهید یک فهرست جدید به نوارِ ابزارِ 

MyGizmo : را راه بیاندازد ، می توانید کارهايِ زیر را انجام بدهید 

 بسازید (البته اگر این چنین پوشه اي نباشد). nuke.تان ، پوشه اي به نامِ خانه  در پوشه يِ .1

 بسازید (البته اگر چنین پرونده اي نباشد). menu.py، پرونده اي به نامِ  nuke.در پوشه يِ  .2

 به آن بیافزایید :را پیرایش کنید. خطّ هايِ زیر را  menu.pyدر یک ویراستارِ نوشتاري ، پرونده يِ  .3

toolbar = nuke.toolbar("Nodes") 
toolbar.addCommand( "Test/MyGizmo", "nuke.createNode('MyGizmo')") 

 ”MyGizmo“به نوار ابزارِ تکمه هايِ پیش فرض افزوده می شود که در آن آیتمی است که برچسبِ  ”Test“بدین سان یک فهرست با برچسبِ 

 را می سازد. MyGizmo؛ که نمونه اي از تکمه يِ  دارد

د. این ن) تغییر می کنNuke 8و  Nuke 7تکمه گاهی میانِ نسخه هايِ اصلیِ برنامه (مانند  ()Classنام هايِ  یادداشت :

یک  classپیشین گرفته می شوند تاثیري به جا نمی گذارد ؛ ولی اگر  اسکریپت هایی که از نسخه هايِتغییرات بر رويِ 

، که براي  toolbars.pyتکمه پیرایش شده باشد شاید نشود به برآیندهایی که انتظار آن را دارید دست بیابید. پرونده يِ 

اگر بخواهید  تکمه يِ جاري بوده و classهايِ  نامبه کار گرفته می شود ، دارايِ همه يِ  Nukeساخت نوار ابزارِ تکمه هايِ 

 جاي گرفته است. /instal_directory>/plugins/nukescripts>در  ید ،به آن دست داشته باش

تغییر کرده است. در پرونده يِ  Text2به  Textاز  Textتکمه يِ  ()Nuke 8  ،Classو  Nuke 7براي نمونه ، میانِ 

toolbars.py  ِبراي این دو نسخه از برنامه ، ورودي ها براي تکمه يText : به شکلِ زیر نشان می یابند 
m.addCommand("Text", "nuke.createNode(\"Text\")", icon="Text.png") 
m.addCommand("Text", "nuke.createNode(\"Text2\")", icon="Text.png") 
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 افزود و حتا نوار ابزار هايِ ویژه يِ خودتان را بسازید. Nukeهم چنین می توان آیتم ها را به فهرست هايِ دیگر در 

 روشِ افزودن یک نوارِ ابزار

 در پوشه يِ مسیرِ پلاگین تان بسازید (البته اگر نباشد). menu.pyیک پرونده به نامِ  .1

 :را در یک ویراستارِ نوشتاري باز کنید و یک ورودي با قالبِ زیر به آن بیافزایید  menu.pyپرونده يِ  .2
t=nuke.toolbar("ToolbarName") 
t.addCommand("NewMenu", "PythonCode", "Shortcut", icon="IconName") 

• ToolbarName  ِرا با نامی که می خواهید به پرونده بدهید جایگزین کنید. این نام در فهرست هايcontent  ِدر زیر

Windows > Custom ر رويِ برگه يِ ، و در بالايِ نوارِ ابزار بtitle .پدیدار می شود 

• NewMenu .را با نامِ فهرستی که می خواهید به نوارِ ابزار افزوده شود جایگزین کنید 

• PythonCode  ِرا با رمزPython  ًمربوطه (معمولاnuke.createNode ِجایگزین کنید ؛ و اگر نیاز باشد نام (gizmo  ،

 اسکریپتgeneric Python يِ پلاگین را به کار ببرید که می خواهید در فهرست گزینه کنید. براي آسانیِ کار ، همه  ، یا پرونده

 مسیرِ پلاگین جاي بدهید.چنین پرونده هايِ خاستگاه شده را درونِ پوشه يِ  يِ

 فراخواندنی جایگزین کنید. Pythonرا با یک  PythonCode، هم چنین می توانید  داشته باشیداگر دوست 

• Shortcut  ، رِ صفحه کلید جایگزین کنید ؛ براي نمونهرا با میان بAlt+A  ،Ctrl+A  یا ،Shift+A.  ِنویسه يa  تنها نشان دهنده

 يِ نویسه يِ کوچکa  .استF1  کارکردkey 1  ِرا نشان می دهد. اگر نیاز باشد ، می توانید کلیدهايShift  ،Ctrl  و ،Alt  را با

که نشانگرِ  A+، و  Ctrl+Aکه نشانگرِ  Alt+A  ،^Aکه نشانگرِ  A#اگر دوست داشته باشید ، هم چنین می توانید  هم ترکیب کنید.

Shift+A .است را به کار ببرید 

• IconName  ِرا با نامِ نگاره ي.png  یا).xpm جایگزین کنید که می خواهید آن را به عنوان شمایلِ فهرست به کار ببرید. این (

 پیکسل ذخیره سازي شده باشد. 24x24باید در پوشه يِ مسیرِ پلاگین و با اندازه يِ  نگاره می

 نیز بیافزایید. ”ToolbarName“اختیاريِ زیر را در پرانتز پس از در وروديِ بالا ، هم چنین می توانید عبارت هايِ  .3

• True  پیش فرض است. هنگامی که :True باشد  ،.nuke.toolbar() یا اگر  را با نامِ تعیین شده فرا می خواند ينوارِ ابزار ،

یا یک نوارِ ابزاري  t=nuke.toolbar(“Extras”,True)آن را می سازد. براي نمونه ،  چنین نوار ابزاري وجود نداشته باشد ،

 که هست را فرا می خواند یا اگر نیست ، یک نوار ابزار به همین نام می سازد.  Extrasبه نامِ 

• False  هنگامی که :False  . باشد ، نوار ابزاري اگر نباشد ساخته نمی شودnuke.toolbar()  بهNone  ِبر می گردد. اگر نوار

ابزاري با یک نامِ مشخص وجود داشته باشد ، می توانید این ترفند را براي یافتنِ آن به کار بگیرید. براي نمونه ، 

t=nuke.toolbar(“Extras”,False) وارِ ابزاري به نامِ ، یا یک نExtras  که هست را فرا می خواند یا اگر چنین نوار ابزاري

 بر می گردد. Noneوجود نداشته باشد ، به 

چیدمان شده است. از این جا ، می  Customدر زیرِ  contentجدید به طورِ پیش فرض نمایان نمی شود ، ولی در فهرست هايِ نوار ابزارِ 

را ذخیره  layout) جاسازي کنید. هنگامی که از نوار ابزارِ جدید و جايِ آن رضایت داشتید ، paneدر هر چهارچوبی (و بگیرید توانید آن را 

را در همین فضايِ کاريِ ذخیره شده اجرا کنید ،  Nuke). پس از این ، هر زمان که برنامه يِ Workspace > Save Workspaceکنید (

 نوارِ ابزار پدیدار می شود.
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 ها را ذخیره کنید. layoutگوناگون می توانید چندین نوار ابزار بسازید و  اي کارهايِبر

 1نمونه يِ 

است که یک تکمه يِ  Create VectorBlurمی سازد. نوار ابزار داراي گزینه اي به نامِ  Extrasوروديِ زیر یک نوار ابزارِ جدید به نام 

VectorBlur  می سازد. هم چنین وروديv رِ صفحه کلید براي تکمه يِ را به عنوانِ میان بVectorBlur .تعریف می کند 
t=nuke.toolbar("Extras") 
t.addCommand("Create VectorBlur", "nuke.createNode ('VectorBlur')", "v") 

 2نمونه يِ 

خیلی  افزودیم. این گزینه تکمه هايِ برگزیده شده را  1را به نوارِ ابزارِ ساخته شده در نمونه يِ  Autoplaceدر این نمونه ، گزینه اي به نامِ 

 Autoplaceمی چیند. نگاره هايِ زیر ، سمت راست پیش از به کار بردن گزینه يِ  Node Graphمنظمّ یکی پس از دیگري در پنجره يِ 

 نشان می دهند.، و سمت چپ پس از به کار بردن این گزینه را 

  

 براي این گزینه تعریف شده است. Alt+Aرا می افزاید. هم چنین میان برِ  Autoplaceوروديِ زیر گزینه يِ 
def _autoplace(): 
n = nuke.selectedNodes() 
for i in n: 
nuke.autoplace(i) 
t=nuke.toolbar("Extras") 
t.addCommand("Auto&place", "_autoplace()", "Alt+a") 

 نوار ابزارروشِ تعریف کردن یک فهرست یا گزینه يِ 

 در پوشه يِ مسیرِ پلاگین تان بسازید (البته اگر نباشد). menu.pyیک پرونده به نامِ  .1

 را در یک ویراستارِ نوشتاري باز کنید و یک ورودي با قالبِ زیر به آن بیافزایید : menu.pyپرونده يِ  .2
menubar=nuke.menu("MenuType") 
m=menubar.addMenu("&NewMenu") 
m.addCommand("&NewItem", "PythonCode", "Shortcut", icon="IconName", index=#) 

• MenuType : را با نوعِ فهرست یا نوار ابزاري جایگزین کنید که می خواهید یک آیتم به آن بیافزایید 

Nuke اصلی می افزاید. یک آیتم به نوار فهرست 
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Animation  ِرويِ دکمه ي به فهرستAnimation   ِراست کلیک در پنجره ي در همه يِ قاب ها ، و نیز به فهرست

Curve Editor .یک آیتم می افزاید 

Properties  ِراست کلیک در پنجره ي به فهرستNode Graph .یک آیتم می افزاید 

Nodes ک آیتم می افزاید.ابزار پیش فرض ی به نوار 

Viewer راست کلیک در پنجره يِ نمایشگر یک آیتم می افزاید. به فهرست 

Pane  ِبه فهرست هايcontent  ِدر زیرِ گزینه ي ،Custom .یک آیتم می افزاید 

• NewMenu  موجود ، همه يِ گزینه هايِ جدید را به فهرستی که را با نامِ فهرست جایگزین کنید. با به کارگیريِ نامِ یک فهرست

 و نوارِ ابزار بیافزایید. Menuهست پیوست کنید. هم چنین می توانید گزینه هایی را به نوارِ 

• NewItem  ِپیش ببرید تا  &می توانید هر نویسه را با یک  جایگزین کنید. که می خواهید به فهرست بیافزایید زمینه ايرا با آیتم

 کنید. flagآن را به عنوان یک میان برِ صفحه کلید 

• PythonCode  ِرا با رمزPython ًمربوطه (معمولا nuke.createNodeو اگر نیاز باشد ، نامِ  ) جایگزین نموده ،gizmo  ،

 اسکریپتgeneric Python لاگینی را به کار ببرید که می خواهید به فهرست گزینه کنید. براي آسانیِ کار ، همه ، یا پرونده يِ پ

 خاستگاه شده را درونِ پوشه يِ مسیرِ پلاگین جاي بدهید. يِ چنین پرونده هايِ

فراخواندنی جایگزین کنید. بدین سان ، این  Pythonرا با یک  PythonCodeاگر دوست داشته باشید ، هم چنین می توانید 

 امکان براي شما خواهد بود که در باره يِ خطاهایی که در اسکریپت تان به هنگام آغاز به اجرا شدن پیش می آید آگاهی پیدا کنید.

• Shortcut  ، رِ صفحه کلید جایگزین کنید ؛ براي نمونهرا با میان بAlt+A  ،Ctrl+A  یا ،Shift+A. ه يِ نویسa  تنها نشان دهنده

 يِ نویسه يِ کوچکa  .استF1  کارکردkey 1  ِرا نشان می دهد. اگر نیاز باشد ، می توانید کلیدهايShift  ،Ctrl  و ،Alt  را با

که نشانگرِ  A+، و  Atrl+Aکه نشانگرِ  Alt+A  ،^Aکه نشانگرِ  A#هم ترکیب کنید. اگر دوست داشته باشید ، هم چنین می توانید 

Shift+A .است را به کار ببرید 

با معلوم کردن یک میان برِ صفحه کلید ، می توانید آن را بر رويِ میان برهایی که هست رونویسی کنید. براي نمونه  یادداشت :

(که باز کردن یک را به یک آیتمِ فهرست جدید بدهید ، دیگر این میان بر براي هدف پیش فرض اش  Ctrl+O، اگر میان برِ 

 پرونده است) به کار نمی آید. به هر روي ، میان برها تنها در نوارِ فهرست اصلی ، نوارِ ابزار ، هر یک از نوار ابزارهایی که ساخته

 . این بدان معناست که میجدید را به آن می افزایید ، رونویسی می شوند آیتمِ فهرست يِ کاربر است ، و فهرستی که دارید

بیافزایید بدون این که بخواهید همان میان بر را در پنجره يِ  Node Graphانید یک میان بر را ، براي نمونه درونِ پنجره يِ تو

) کنید. به هر روي ، نمی توانید بدون پیکربندي کردن دوباره يِ یک میان بر در نوارِ فهرستreset نمایشگر دوباره پیکربندي (

 بیافزایید. Node Graphهمان را به پنجره يِ  اصلی یا نوار ابزار ،

• IconName  ِرا با نامِ نگاره ي.png  یا).xpm جایگزین کنید که می خواهید آن را به عنوان شمایلِ فهرست به کار ببرید. این (

 پیکسل ذخیره سازي شده باشد. 24x24نگاره می باید در پوشه يِ مسیرِ پلاگین و با اندازه يِ 

را با شماره اي جایگزین کنید که جایگاه آیتم را در نوار فهرست یا نوار ابزار نشان بدهد. اگر یک واژه يِ کلیدي شاخص را به  # •

 کار نگیرید ، آیتم به پایانِ نوارِ فهرست یا نوار ابزار افزوده می شود.
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 : بگذارید ، مانند این addCommandمی توانید نامِ فهرست را نیز در  نکته :
nuke.menu("MenuType").addCommand("NewMenu/NewItem", "PythonCode("name")") 

 1 نمونه يِ

به نامِ  gizmoدر نوارِ فهرست می سازد. این گزینه یک  Custom > Cue Renderوروديِ زیر یک فهرست و گزینه يِ جدید به نامِ 

“Cue_Render” ِجاسازي می کند. هم چنین ورودي ، کلیدهاي Ctrl+R  رهايِ صفحه کلید برايرا به عنوانِ میان بgizmo .تعریف می کند 
menubar=nuke.menu("Nuke") 
m=menubar.addMenu("&Custom") 
m.addCommand("&Cue Render", "nuke.createNode('cue_render')", "Ctrl+R") 

 

 2 نمونه يِ

را نشان بگیرد ، نمونه  gizmoبراي دانستن این که چگونه یک فهرست جدیدي در نوار ابزارِ پیش فرض بسازید که آیتمی داشته باشد که یک 

 آمده است را بخوانید. "تعریف کردن سفارشیِ فهرست ها و نوارهايِ ابزار"بخشِ اي که در 

 3نمونه يِ 

را که برگزینید ، یک  Blurدر نوار فهرست می سازد. گزینه يِ  Custom > Filters > Blurوروديِ زیر یک فهرست و گزینه اي به نامِ 

 تان جا می گیرد. scriptدر  Blurتکمه يِ 
menubar=nuke.menu("Nuke") 
m=menubar.addMenu("&Custom") 
m.addCommand("Filters/Blur", "nuke.createNode(\"Blur\")" ) 

 

 ) انجام بدهید :lambda functionلامبدا (ین کار را با یک کارکرد هم چنین می توانید هم
menubar=nuke.menu("Nuke") 
m=menubar.addMenu("&Custom") 
m.addCommand("Filters/Blur", lambda: nuke.createNode("Blur") ) 

 ها را به کار ببرید. backslashدر این جا نباید 

 رایجتعریف کردن فُرمت هايِ تصویري 

هايِ مربوط به آن) را براي یک پروژه يِ معین تعریف  pixel aspect ratioشاید بخواهید فرُمت هايِ تصویري (وضوح هايِ تصویري و 

 پدیدار می شوند. Reformatو  Readکنید. این ها به شکلِ فهرست هايِ پایین افتادنی بر رويِ تکمه هايِ 

 تعریف کردن یک فُرمت تصویري

 مسیرِ پلاگین تان بسازید. در پوشه يِ menu.pyپرونده اي به نامِ  .1
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 یک ورودي با قالبِ زیر به آن بیافزایید : .2

nuke.addFormat(" ImageWidth ImageHeight LowerLeftCorner LowerRightCorner 
UpperRightCorner UpperLeftCorner PixelAspectRatio DisplayName ") 

• ImageWidth نگاره (بر حسب پیکسل) جایگزین کنید.را ب ا پهنايِ فرُمت 

• ImageHeight .نگاره (بر حسب پیکسل) جایگزین کنید را با درازايِ فرُمت 

،  LowerLeftCornerتعریف کنید که کوچک تر از وضوحِ فرُمت باشد ،  image areaاگر می خواهید یک  •

LowerRightCorner  ،UpperLeftCorner  ،UpperRightCorner  را با مختصاتx  وy  (بر حسب پیکسل) درست

 جایگزین کنید (اختیاري است). image areaبراي گوشه هايِ پایین چپ ، پایین راست ، بالا چپ  و بالا راست از 

• DisplayName نی ایین افتادرا با نامی براي فرُمت که به نمایش در می آید جایگزین کنید. این نام بر رويِ همه يِ فهرست هايِ پ

 به چشم می آید.

 1نمونه يِ 

برابر  pixel aspect ratio، و  1556در  2048با وضوحِ برابر با  full_aperture-anamorphicوروديِ زیر یک فرُمت جدید به نامِ 

 را می پوشاند).(ارزشی براي گوشه هايِ نگاره تعریف نشده است ؛ بنا بر این ، نگاره همه يِ بخشِ فرُمت  می سازد. 2.0با 
nuke.addFormat (" 2048 1556 2.0 full_aperture_anamorphic ") 

Gizmo ِسفارشی ، و اسکریپت هايِ  ها ، پلاگین هايGeneric TCL 

گروه هايِ ساده اي ها  Gizmoها را بسازند.  gizmoبراي هنرمندان و کارگردانان تکنیکی این امکان را فراهم می کند که  Nukeبرنامه يِ 

همسان با  Nukeها در برنامه يِ  Gizmoآن ها را دوباره به کار  بگیرند.  نیز می توانند هستند که هنرمندان دیگر Nukeاز تکمه هايِ 

macro  ِهايِ برنامه يShake  ًهستند. استودیو ها معمولاgizmo  ایی که همواره جاه درزیر به کار می گیرند :  جاهايِدر براي نمونه ها را

به فیلم و نگاره ها داده می شود ، روند آوردن فیلم و ویدئو با یک الگوي خاص و برگرداندن تکنیک هايِ درجه بندي شده يِ ویژه اي از رنگ 

 ).film printingآن بر مبنايِ یک فرمولِ ویژه ، و روند بیرون فرستادن فیلم و ویدئو براي چاپِ فیلم (

تان  Nukeدر پوشه يِ پلاگینِ  gizmo.است که آن را می سازید و در یک پرونده يِ جداگانه به نامِ  Groupيِ  یک تکمه gizmoیک 

را درست مانند هر نوع تکمه يِ دیگري به کار بگیرند. اسکریپت هايِ ذخیره  gizmoمی توانند این  Nukeذخیره می کنید. اسکریپت هايِ 

است و در زمانی که اسکریپت به درون  gizmoهستند ؛ که در پرونده يِ  gizmoنام و کنترل براي  سازي شده تنها دارايِ پیکربندي هايِ

و همه يِ اسکریپت هایی که آن را به  gizmoبارگذاري می شود ، خوانده می شوند. بنا بر این ، می توانید روند پیاده سازيِ  Nukeبرنامه يِ 

 کار می برند را تغییر بدهید.

 کرد. Cloneها را نمی توان  gizmoبرخلاف تکمه هايِ دیگر ،  یادداشت :

 ثبت کنید. Nukeاز برنامه يِ  Timelineها را می توانید به عنوان جلوه هايِ نرم در محیطgizmo   نکته :

 ها و یافتن منابع براي آن ها Gizmoساختن 
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کنید ؛ و به روشنی معلوم کنید که  Exportاز تکمه ها را به بیرون  می توانید گروهی Nukeدر برنامه يِ  Export gizmoبه کمک فرمانِ 

 هنرمندان چه کنترل هایی را بتوانند ویرایش کنند.

 روشِ ساختGizmo ها 

 شامل شوند. Gizmoتکمه هایی را برگزینید که می خواهید در  .1

2. Other > Group  را از نوارِ ابزار برگزینید (یاCtrl+G کمه ها با هم گروه شوند.را فشار بدهید) تا ت 

این  نام جدیدي را براي تکمه بنویسید. titleدر میدانِ  Groupتکمه يِ  propertiesشاید بخواهید نامِ گروه را تغییر بدهید. در قابِ  .3

ذخیره شده ندارد. به هر روي ، این خیلی خوب است که نامی به گروه بدهید که  gizmoگام اختیاري است و هیچ گونه تاثیري بر رويِ 

 را نشان بدهید. gizmoکاربرد 

 

 "Gizmoمدیریت کردن کنترل هايِ "بخشِ براي معلوم کردن این که هنرمندان چه کنترل هایی را بتوانند میزان کنند ، آموزش هایی که در  .4

 می آید را دنبال کنید.

 کلیک کنید. export as gizmoکمه يِ بر رويِ د .5

را فشار بدهید. پس از مسیري که در پایین مرورگرِ پرونده به نمایش گذاشته می شود  Homeکه پدیدار می شود ، دکمه يِ  در مرورگري .6

.nuke/ .را بنویسید 

اسکریپت ذخیره شده  هر که در استفرمانی  نام، را پیوست کنید. این  gizmo.پس از مسیر نامی را بنویسید ، و پس از نام نیز گسترشِ  .7

این را  Nuke. خیلی خوب است که نام را با نویسه هايِ بزرگ بنویسید ؛ چون برنامه يِ را به کار می گیرد ، نوشته می شود gizmoکه 

 است. gizmoبه نشانه می گیرد که فرمان یک تکمه یا یک 

8. Save .را کلیک کنید 

 gizmoدر یک گروه ، بر رويِ  gizmoبه شما اجازه نمی دهد که بدون رونوشت گرفتن  Nukeبه طور پیش فرض ،  یادداشت :

کنید. اگر می خواهید این رفتار را تغییر بدهید تا هنرمندان پیش از ویرایش  Save asو یا  )Overwrite( نویسی کردهها رو

را بر رويِ  NUKE_ALLOW_GIZMO_SAVINGند ، متغیرِ محیطیِ نیازي به رونوشت گرفتن آن نداشته باش gizmoکردن 

 پیکربندي کنید. 1

 Gizmoمدیریت کردن کنترل هايِ 

 است) بیافزایید : Groupاین جا یک تکمه يِ  رتان (که د gizmoبه دو روشِ گوناگون می توانید کنترل هایی را به 

هستند وجود دارد. براي  Groupکنترل هایی که براي تکمه هایی که درون تکمه يِ و ویرایش کردن یک کنترل از ) Pick( انتخاببا  •

را به قابِ  Gradeباشد ، می توانید هر کدام از کنترل هايِ تکمه يِ  Gradeدارايِ یک تکمه يِ  Groupنمونه ، اگر تکمه يِ 

properties  ازgizmo .تان بیافزایید 

 .gizmoاز  propertiesبا افزودن کنترلی که خودتان آن را ساخته اید به قابِ  •
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 کنترل هایی که هستند انتخابِروشِ 

را  Manage User Knobsراست کلیک کنید و  Groupتکمه يِ  propertiesخاکستري تیره در قابِ بر رويِ پس زمینه يِ  .1

 باز می شود. ایین سمت راستبرگزینید. پنجره يِ گفت و گویی مانند نگاره يِ پ

کلیک کنید. پنجره يِ گفت و گویی باز می شود که همه  Pick براي انتخابِ کنترلی که می خواهید آن را به کار بگیرید ، بر رويِ دکمه يِ .2

 .(نگاره يِ پایین ، سمت چپ) يِ تکمه هایی که گروه شده اند در آن فهرست می شوند

  

را  OKيِ تکمه ها را ببینید می باید آیتم هايِ فهرست شده را بگسترانید. کنترلی را برگزیده و سپس دکمه يِ اگر می خواهید کنترل ها

 بزنید. هم چنین می توانید با پایین نگه داشتن کلیدCtrl  و کلیک کردن بر رويِ هر یک از کنترل ها ، چند تا از آن ها را برگزینید. با پایین

 نگه داشتن کلیدShift .و کلیک کردن نیز می توانید دامنه اي از کنترل هايِ پشت سر هم را برگزینید 

پدیدار می شود. کنترلی که برگزیده بودید به این  Groupتکمه يِ  propertiesدر قابِ  Userدر این جا ، یک برگه يِ جدید به نامِ 

 برگزیده شده است. Textاز تکمه يِ  sizeبرگه افزوده شده است. در نمونه اي که این جا آورده ایم ، کنترلِ 

را باز کرده ، و کنترل را از فهرست برگزینید.  Manage User Knobsگفت و گويِ  براي ویرایش کردن کنترلی که افزوده اید ، پنجره يِ .3

 کلیک کنید. Editبر رويِ 

 در بسیاري از جاها ، می توانید گزینه هايِ زیر را ویرایش کنید :

• Name  : می باید این نام را زمانی به کار ببرید که می خواهید کنترل بدهید.  یگانه ايبه کنترلِ جدید نامِ از این جا می توانید

 را از اسکریپت ها یا از راهExpression ) ها خاستگاه کنید. نام می تواند تنها از نویسه هاletter) و شماره ها (digit (

که فضاهايِ خالی و نقطه گذاري ها را براي نام گذاري به کار ببرید. این میدان را نمی توانید ساخته شده باشد. اجازه ندارید 

 خالی بگذارید.

• Label  ِچپِ کنترل در قاب آن چه در این میدان بنویسید در سمت :properties  ازgizmo  نمایان می شود. (یا ، اگر دکمه

نوشته  Nameود). اگر این میدان را خالی بگذارید ، هر چیزي که در میدانِ اي باشد ، بر رويِ دکمه به نمایش گذاشته می ش

 باشید براي برچسب به کار گرفته می شود.

ها ، دکمه هايِ  check boxمربوط به  Labelدر میدان هايِ 

TCL script  ِو دکمه هاي ،Python script  می توانید

HTML  را نیز به کار ببرید. براي نمونه ، اگر بخواهید نوشته تان
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 را بنویسید. <b>text</b>به نمایش در آید ، می توانید  Boldبه شکلِ 

 اگر بخواهید به کمکHTML  شمایلی را بهcheck box  ِیا دکمه يTCL/Python  تان بیافزایید ، می توانید عبارت<img 

src=”Colorwheel.png”/>  ِرا در میدانLabel  ِبنویسید. بدین سان ، شمایلcolor wheel ِبرنامه ي خود Nuke 

ها  check boxافزوده می شود. هم چنین می توانید شمایل هايِ خودتان را نیز به همان روشی که گفتیم به دکمه ها و 

اشید. براي این کار می توانید رایج ترین فرُمت هايِ بیافزایید. تنها باید آن ها را در پوشه يِ مسیرِ پلاگین تان ذخیره کرده ب

 کار کنید. png.تصویري را به کار بگیرید ، ولی پیشنهاد می کنیم که با پرونده هايِ 

در داده تان داشته باشید ، یک خطِّ جدید در برچسب به نمایش در  newline characterبه یاد داشته باشید که اگر یک 

 می آید.

• Hide کاربران پنهان بماند ، این گزینه را نشان بزنید. اگر بخواهید یک کنترلِ جدید بسازید تا : اگر م ی خواهید کنترل از دید

که به کمک آن می توانید با کنترل هايِ دیگر به تکرار به آن  expressionپیچیده را شامل بشود (یک  expressionیک 

 خواهد بود. کنترل برگردید) ، نشان زدن این گزینه سودمند

• Start new line  ِاگر می خواهید کنترل بر رويِ همان خطی پدیدار شود که کنترلِ پیشین در قاب :properties  از

gizmo نشانِ این گزینه را بردارید. است ، 

• Tooltip نگه می دارد ، : راهنمايِ نوشتاريِ کوتاهی را در این جا بنویسید. زمانی که کاربر نشانگرِ ماوس را بر رويِ کنترل 

 Nameاین نوشته در راستايِ نامِ کنترل پایین می افتد. اگر چیزي را براي این گزینه یادداشت نکنید ، هر چیزي که در میدانِ 

 نیز به کار می رود. Tooltipنوشته باشید براي 

 گامِ پیشین را تکرار کنید. سه آینده) gizmoتان ( Groupبراي افزودن کنترل هايِ دیگر به تکمه يِ  اگر نیاز باشد ، .4

دارند ،  Manage User Knobsگفت و گويِ  ، کنترل ها با همان چیدمانی که در پنجره ي Groupتکمه يِ  propertiesدر قابِ  .5

، آن را در پنجره يِ گفت و گو برگزیده و به کمک دکمه هايِ  propertiesفهرست می شوند. براي بالا و پایین بردن یک کنترل در قابِ 

Up و Down .بالا و پایین بکشید 

 کلیک کنید. export as gizmoبر رويِ دکمه يِ  .6

را  /nuke.را بزنید. پس از مسیري که در پایینِ مرورگرِ پرونده به نمایش در می آید  Homeدر مرورگرِ پرونده اي که باز می شود ،  .7

 یسید.بنو

این ، نام فرمانی است که در هر اسکریپت ذخیره شده که  پیوست کنید. gizmo.نامی پس از مسیر بنویسید. به دنبالِ نام نیز یک گسترشِ  .8

gizmo  ِرا به کار می گیرد ، نوشته می شود. خیلی خوب است که نام را با نویسه هايِ بزرگ بنویسید ؛ چون برنامه يNuke  این را به

 است. gizmoمی گیرد که فرمان یک تکمه یا یک  نشانه

9. Save .را کلیک کنید 

 روشِ ساختن کنترل هايِ جدید

 Mange User Knobsراست کلیک کنید و گزینه يِ  Groupتکمه يِ  propertiesبر رويِ پس زمینه يِ خاکستريِ تیره در قابِ  .1

 را برگزینید. پنجره يِ گفت و گویی باز می شود.



247 | N u k / U s e r  G u i d e  
 
 

Vahid Velayati 
 

) به کنترل هايِ divider lineبخش کننده () ، یا یک خطِّ staticیک کنترلِ جدید ، یک برگه ، یک نوشته يِ ایستا (براي افزودن  .2

Group )gizmo ِبر رويِ دکمه ي ، (Add  ِدر همین پنجره کلیک کنید و گزینه اي که می خواهید را برگزینید. با این کار ، پنجره ي

نید کنترل ، برگه ، یا نوشته يِ ایستایی که افزوده اید را ویرایش کنید. در بسیاري از جاها ، می توانید گفت و گویی باز می شود که می توا

 گزینه هايِ زیر را ویرایش کنید :

• Name از این جا می توانید به کنترلِ جدید نامِ یگانه اي بدهید. می باید این نام را زمانی به کار ببرید که می خواهید کنترل را از : 

 اسکریپت ها یا از راهExpression ) ها خاستگاه کنید. نام می تواند تنها از نویسه هاletter) و شماره ها (digit ساخته شده (

 باشد. اجازه ندارید که فضاهايِ خالی و نقطه گذاري ها را براي نام گذاري به کار ببرید. این میدان را نمی توانید خالی بگذارید.

• Label چپِ کنترل در قابِ  : آن چه در این میدان بنویسید در سمتproperties  ازgizmo  نمایان می شود. (یا ، اگر دکمه اي

نوشته باشید براي  Nameباشد ، بر رويِ دکمه به نمایش گذاشته می شود). اگر این میدان را خالی بگذارید ، هر چیزي که در میدانِ 

 برچسب به کار گرفته می شود.

 HTMLمی توانید  Python script، و دکمه هايِ  TCL scriptها ، دکمه هايِ  check boxمربوط به  Labelيِ در میدان ها

 را بنویسید. <b>text</b>به نمایش در آید ، می توانید  Boldرا نیز به کار ببرید. براي نمونه ، اگر بخواهید نوشته تان به شکلِ 

 اگر بخواهید به کمکHTML  شمایلی را بهcheck box  ِیا دکمه يTCL/Python  تان بیافزایید ، می توانید عبارت<img 

src=”Colorwheel.png”/>  ِرا در میدانLabel  ِبنویسید. بدین سان ، شمایلcolor wheel ِبرنامه ي خود Nuke  افزوده

ها بیافزایید. تنها باید  check boxمی شود. هم چنین می توانید شمایل هايِ خودتان را نیز به همان روشی که گفتیم به دکمه ها و 

آن ها را در پوشه يِ مسیرِ پلاگین تان ذخیره کرده باشید. براي این کار می توانید رایج ترین فرُمت هايِ تصویري را به کار بگیرید ، 

 کار کنید. png.پیشنهاد می کنیم که با پرونده هايِ  ولی

 در داده تان داشته باشید ، یک خطِّ جدید در برچسب به نمایش در می آید. newline characterبه یاد داشته باشید که اگر یک 

• Hide کاربران پنهان بماند ، این گزینه را نشان بزنید. اگر بخواه ک ید یک کنترلِ جدید بسازید تا ی: اگر می خواهید کنترل از دید

expression  پیچیده را شامل بشود (یکexpression  آن می توانید با کنترل هايِ دیگر به تکرار به آن کنترل که به کمک

 برگردید) ، نشان زدن این گزینه سودمند خواهد بود.

• Start new line کنترلِ پیشین در قابِ  : اگر می خواهید کنترل بر رويِ همان خطی پدیدار شود کهproperties  ازgizmo 

 است ، نشانِ این گزینه را بردارید.

• Tooltip  راهنمايِ نوشتاريِ کوتاهی را در این جا بنویسید. زمانی که کاربر نشانگرِ ماوس را بر رويِ کنترل نگه می دارد ، این :

نوشته  Nameاین گزینه یادداشت نکنید ، هر چیزي که در میدانِ نوشته در راستايِ نامِ کنترل پایین می افتد. اگر چیزي را براي 

 نیز به کار می رود. Tooltipباشید براي 

 Expressionپیوند بدهید ، می توانید یک  Groupآن در یک تکمه يِ اگر می خواهید کنترلی که ساخته اید را به یک تکمه و کنترل هايِ .3

 را به کار ببرید.

 آینده) سه گامِ پیشین را تکرار کنید. gizmoتان ( Groupافزودن کنترل هايِ دیگر به تکمه يِ  اگر نیاز باشد ، براي .4
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دارند ،  Manage User Knobsگفت و گويِ  ، کنترل ها با همان چیدمانی که در پنجره ي Groupتکمه يِ  propertiesدر قابِ  .5

، آن را در پنجره يِ گفت و گو برگزیده و به کمک دکمه هايِ  propertiesفهرست می شوند. براي بالا و پایین بردن یک کنترل در قابِ 

Up و Down .بالا و پایین بکشید 

 کلیک کنید. export as gizmoبر رويِ دکمه يِ  .6

را  /nuke.را بزنید. پس از مسیري که در پایینِ مرورگرِ پرونده به نمایش در می آید  Homeدر مرورگرِ پرونده اي که باز می شود ،  .7

 بنویسید.

این ، نام فرمانی است که در هر اسکریپت ذخیره شده که  پیوست کنید. gizmo.نامی پس از مسیر بنویسید. به دنبالِ نام نیز یک گسترشِ  .8

gizmo  ِرا به کار می گیرد ، نوشته می شود. خیلی خوب است که نام را با نویسه هايِ بزرگ بنویسید ؛ چون برنامه يNuke ن را به ای

 است. gizmoنشانه می گیرد که فرمان یک تکمه یا یک 

9. Save .را کلیک کنید 

 روشِ پاك کردن کنترل ها

 Mange User Knobsراست کلیک کنید و گزینه يِ  Groupتکمه يِ  propertiesبر رويِ پس زمینه يِ خاکستريِ تیره در قابِ  .1

 را برگزینید.

را  Deleteدر پنجره يِ گفت و گویی که باز می شود ، کنترل هایی را برگزینید که می خواهید آن ها را از فهرست پاك کنید. دکمه يِ  .2

 فشار بدهید.

 را کلیک کنید. Deleteتند و نیز نامِ برگه را برگزیده و دکمه يِ همه يِ کنترل هایی که در برگه هس براي پاك کردن همه يِ یک برگه ، .3

 نمونه ها

 ها بسازید. gizmoکنترل هايِ جدید را براي می توانید چگونه  بدهیمنشان  تا را آورده ایمدر زیر نمونه هایی 

1. Draw > Text  وDraw > Rectangle راست) (نگاره يِ را برگزینید پایین ، سمت. 

 دو بار کلیک کنید. Rectangle1بر رويِ تکمه يِ  .2

 گاره يِ زیر ، سمت چپ می بینید).ن(مانند آن چه در چهارگوش را تغییر بدهید در پنجره يِ نمایشگر ، اندازه يِ و جايِ  .3

کلیک کنید تا به جايِ لغزنده ، ارزش هايِ  4بروید. بر رويِ دکمه يِ  Color، به برگه يِ  Rectangle1تکمه يِ  propertiesدر قابِ  .4

را بنویسید. بدین سان چهارگوش از رنگ سفید به رنگ قرمز در می  0ارزشِ  a، و  b  ،g، براي  1ارزشِ  rاي آن نشان داده شوند. بر

 آید.
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 را رونوشت بگیرید و در همان اسکریپت بچسبانید (نگاره يِ پایین ، سمت راست). Rectangle1تکمه يِ  .5

 ).r0 , g1 , b0 , a0را از قرمز به سبز تغییر بدهید ( دو بار کلیک کنید و رنگ آن Rectangle2بر رويِ تکمه يِ  .6

7. Merge > Switch  ِرا برگزینید تا یک تکمه يSwitch  بهscript ِچپ) تان افزوده شود (نگاره ي پایین ، سمت. 

  

را فشار بدهید تا با هم گروه شوند.  Ctrl+Gرا برگزینید و کلیدهايِ  Switch1، و  Text1  ،Rectangle1  ،Rectangle2تکمه يِ  .8

 است که در نمونه هايِ زیر کنترل هایی را به آن می افزاییم. gizmoاین گروه یک 

 پاك کنید. Node Graphچهار تکمه يِ اصلی را از برگه يِ  .9

 به آن بچسبانید. Viewerرا برگزیده و یک تکمه يِ  Groupتکمه يِ  .10

 1نمونه يِ 

می افزاییم. این کنترل یک میدانِ درون رفت است. هر چه در این  Groupرا به کنترل هايِ تکمه يِ  Versionدر این نمونه یک کنترلِ  به نامِ 

 خوانده می شود و زمانی که بیرون رفت گروه را ببینید ، در نمایشگر نشان داده می شود. Text1میدان بنویسید با تکمه يِ 

 Mange User Knobsرا باز کنید و بر رويِ پس زمینه يِ خاکستريِ تیره راست کلیک کنید.  Groupتکمه يِ  propertiesقابِ  .1

 را برگزینید.

را برگزینید تا یک کنترلِ میدانِ درون رفت به قابِ  Add > Text input Knobدر پنجره يِ گفت و گویی که باز می شود ،  .2

properties .افزوده شود 

3. version  را به عنوانName  براي کنترل بنویسید. برايLabel  نیزversion  .را بنویسیدversion number here  را براي

Tooltip  بنویسید. کلیدOK  وDone .را بزنید تا پنجره هايِ گفت و گو بسته شوند 

و یا انتخاب  د. همه يِ کنترل هایی که افزودهساخته می شو Groupدر بخشِ کنترل هايِ تکمه يِ  Userدر این گام یک برگه به نامِ 

 یش فرض بر روي این برگه جاي می گیرند.کرده بودید به طور پ

 نیز اکنون این جاست.  Versionهمان گونه که می توانید ببینید ، کنترلِ 
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،  messageدر میدانِ را دو بار کلیک کنید تا کنترل هايِ آن باز شود.  Text1، تکمه يِ  Group1 Node Graphبرگه يِ بر رويِ  .4

expression  : زیر را بنویسید[value version] این .expression  ِکنترلی به نامversion  که در گامِ پیشین ساخته بودید را فرا

 Text) ، به عنوانِ برآیند تکمه يِ v03یسید (براي نمونه ، بنو Groupتکمه يِ  Versionمی خواند . بنا بر این ، هر چیزي که در میدانِ 

 پدیدار می شود.

 

 2نمونه يِ 

بسازید تا کاربران بتوانند با برداشتن نشانِ آن و یا نشان زدنِ آن معلوم کنند که آیا  checkboxچگونه یک کنترلِ در این نمونه می آموزید که 

  را که در نمونه يِ پیشین افزوده بودید را پنهان کرده و یا به نمایش بگذارند. version numberمی خواهند 

 Mange User Knobsرا باز کنید و بر رويِ پس زمینه يِ خاکستريِ تیره راست کلیک کنید.  Groupتکمه يِ  propertiesقابِ  .1

 را برگزینید.

تکمه  propertiesبه قابِ  checkboxرا برگزینید تا یک کنترلِ   Add > Check Boxدر پنجره يِ گفت و گویی که باز می شود ،  .2

 افزوده شود. Groupيِ 

3. hideversion  را برايName  ، براي کنترلhide version number  را برايLabel  و ،Check this to hide the version 

number  را برايTooltip .به کار ببرید 

داشته باشید (به جايِ این که در زیرِ آن بر رويِ خطِّ ، که در نمونه يِ پیشین ساختید ، Versionرا در کنارِ کنترلِ  براي این کنترلِ جدید .4

را فشار بدهید تا پنجره هايِ گفت و گو بسته  Doneو  OKرا بردارید. دکمه يِ  Start new lineخودش باشد) ، نشانِ گزینه يِ 

 شوند.

 ببینید. Groupتکمه يِ  propertiesوانید در قابِ کنترلی که ساختید را می ت

 

 را برگزینید. Add expressionراست کلیک کنید و  disableبروید. بر رويِ کنترلِ  Node، به برگه يِ  Text1در بخشِ کنترل هايِ  .5
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را  parent.hideversionینه يِ ، می توانید گز پاکسازي کنید(یا اگر می خواهید آن را  Expression  ،hideversionدر میدانِ  .6

 را بزنید. OKساخته اید را فرا می خواند .  3و  2نیز به کار بگیرید) را بنویسید. این کار ، کنترلی که در گام هايِ 

از کار می  Text1نشان بخورد ، تکمه يِ  Groupدر بخشِ کنترل هايِ  Hide version numberاز اکنون ، هر زمان که گزینه يِ 

 را ببینید.افتد و نمی توانید شماره يِ نسخه 

 

 

 

 3نمونه يِ 

می افزاییم. این کنترل یک فهرست پایین افتادنی است با دو گزینه :  Groupبه کنترل هايِ تکمه يِ  Statusدر این نمونه ، کنترلی با برچسبِ 

Finished  وUnfinished ِهر گاه گزینه ي .Finished ه شده باشد ، چهارگوشِ سبز رنگی به نمایش در می آید. هنگامی که گزینه برگزید

  را برگزینید ، به جايِ آن یک چهارگوشِ قرمز رنگ را خواهید دید. Unfinishedيِ 

را  Mange User Knobs، بر رويِ پس زمینه يِ خاکستريِ تیره راست کلیک کرده و  Groupتکمه يِ  propertiesدر قابِ  .1

 د.برگزینی

را برگزینید تا یک کنترلِ فهرست پایین افتادنی به قابِ   Add > Pulldown Choiceدر پنجره يِ گفت و گویی که باز می شود ،  .2

properties  ِتکمه يGroup .افزوده شود 

، آیتم هایی که می خواهید  Menu Itemsبرگزینید. در میدانِ  Labelرا به عنوان  Statusو  Nameرا به عنوانِ  statusبراي کنترلِ  .3

 را فهرست کنید.) Unfinishedو  Finishedدر فهرست پایین افتادنی پدیدار شوند (در این نمونه ، 
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را فشار بدهید تا پنجره هايِ گفت  Doneو  OKبنویسید.  Tooltipرا براي  Select the production status hereدر پایان ، 

 ببینید. Groupرا در بخشِ کنترل هايِ  Statusتوانید کنترلِ و گو بسته شوند. اکنون می 

را دو بار کلیک کنید تا کنترل هايِ آن باز شود. بر رويِ میدانِ  Switch1، تکمه يِ  Group1 Node Graphبر رويِ برگه يِ  .4

Which  راست کلیک کنید وAdd expression .را برگزینید 

). این parent.status==0(یا  status==0زیر را بنویسید :  expressionدر پنجره يِ گفت و گویی که باز می شود ،  .5

expression  ِکنترلی به نامstatus ساخته بودید را فرا می خواند. براي فهرست هايِ پایین افتادنی ،  در همین نمونه که پیش از این

 و ... هستند. 2بعدي  ، 1، آیتمِ بعدي  0نخستین آیتم 

برگزینید ، چهارگوشِ سبز رنگ نشان داده می شود. هنگامی که گزینه يِ  Statusرا در زیرِ  Finishedاز اکنون ، هر زمان که 

Unfinished .برگزیده شود ، چهارگوشِ قرمز رنگ به نمایش گذاشته می شود 

 4نمونه يِ 

ساخته اید را همان جور که می بینید گروه بندي  Groupتکمه يِ  propertiesکه براي قابِ در این نمونه می آموزید که چگونه کنترل هایی 

کنترل هایی که در برگه هستند  را تغییر بدهید ، و براي گروه بندي کردن Userکرده و بازچینی کنید. براي انجامِ این کار می توانید نامِ برگه يِ 

 بخش کننده را به کار ببرید. می توانید یک نوشته يِ ایستا و خطّ هايِ

 تغییر می دهیم : Groupتکمه يِ  propertiesرا در قابِ  Userنخست ، نامِ برگه يِ 

را  Mange User Knobs، بر رويِ پس زمینه يِ خاکستريِ تیره راست کلیک کرده و  Groupتکمه يِ  propertiesدر قابِ  .1

 برگزینید.

 را کلیک کنید. Editرا برگزیده و  Userدر پنجره يِ گفت و گویی که باز می شود ،  .2

را فشار بدهید تا  Doneو  OK. دکمه هايِ version and status، نامِ جدیدي براي برگه بنویسید ؛ براي نمونه ،  Labelدر میدانِ  .3

 پنجره هايِ گفت و گو بسته شوند.

تغییر کرده  Version and statusبه  Userداشته باشید ، می بینید که نامِ برگه يِ  Groupتکمه يِ اگر اکنون نگاهی به کنترل هايِ 

 است.

 

 با هم گروه بندي کنیم. version controlsرا در زیرِ نامِ  Groupاز تکمه يِ  versionمی خواهید دو کنترلِ  اکنون

را  Mange User Knobs، بر رويِ پس زمینه يِ خاکستريِ تیره راست کلیک کرده و  Groupتکمه يِ  propertiesدر قابِ  .1

 برگزینید.

تان افزوده  Groupتکمه يِ  propertiesرا برگزینید تا یک نوشته به قابِ  Add > Textدر پنجره يِ گفت و گویی که باز می شود ،  .2

 شود.
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بنویسید. به هر روي ، نوشته در جایی که ما  Labelرا براي  Version controls، و  Nameرا براي  versioncontبراي کنترل ،  .3

 ) پدیدار نمی شود. باید آن را بالا بکشیم.Hide version numberو  Versionمی خواهیم (در بالايِ کنترل هايِ 

 

 ینید.را برگز Manage User Knobsراست کلیک کنید و  Groupتکمه يِ  propertiesدوباره بر رويِ قابِ  .4

 را بزنید. Doneکلیک کنید. دکمه يِ  Upرا برگزینید . سه بار بر رويِ  [Version controls]از فهرست ، گزینه يِ  .5

 به نمایش در آمده باشد. version، در بالايِ کنترل هايِ  Groupتکمه يِ  propertiesاکنون نوشته می باید در بالايِ قابِ 

 

 : جا بدهیم Statusو کنترلِ  version) را میانِ کنترل هايِ divider lineبخش کننده (در پایان می خواهیم یک خطِّ 

را  Mange User Knobs، بر رويِ پس زمینه يِ خاکستريِ تیره راست کلیک کرده و  Groupتکمه يِ  propertiesدر قابِ  .1

 برگزینید.

برگزینید تا یک خطّ براي بخش کردن کنترل ها از هم به قابِ  را Add > Divider Lineدر پنجره يِ گفت و گویی که باز می شود ،  .2

properties  ِتکمه يGroup .تان افزوده شود 

 نشان داده شده است ، خطّ را برگزینید. unnamed، جایی که به نامِ  Manage User Knobsاز پنجره يِ گفت و گويِ  .3

را  Doneجاي بگیرد. دکمه يِ  Statusو  Hide version number را فشار بدهید تا خطّ میانِ کنترل هايِ Upیک بار دکمه يِ  .4

 بیاندازید ، می توانید ببینید که خطیّ میان این کنترل ها جاسازي شده است. Group. اکنون اگر نگاهی به کنترل هايِ تکمه يِ بزنید

 

هایتان بسازید. هر  gizmoامیدواریم با نمونه هايِ بالا توانسته باشیم ایده اي به شما داده باشیم که بدانید چگونه کنترل هايِ کاربري را براي 

 تان را ذخیره کنید. gizmoگاه همه يِ کنترل هایی که نیاز داشتید را ساختید ، می باید 

 Gizmoمنبع کردن یک 

تعریف کردن فهرست ها و نوارهايِ "را خاستگاه کند (بخشِ  gizmoرا منبع کنید ، یک گزینه يِ فهرست بسازید که  gizmoبراي این که یک 

 را بخوانید) "ابزارِ سفارشی

 یا
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•  کلیدX  ِرا در پنجره يNode Graph  ِیا در قابproperties  ِفشار داده و در پنجره يِ گفت و گویی که باز می شود ، نامgizmo 

 بنویسید. TCLونِ گسترشِ آن به عنوان یک فرمانِ را بد

می باید نامِ  gizmo nameرا بنویسید. به جايِ عبارتnuke.load(“gizmo name”)  را باز کنید و  Script Editorپنجره يِ  •

gizmo .را بدون گسترشِ آن بنویسید 

• Other > All plugins > Update  را برگزینید. یک بار که این کار را انجام دادید ، کلیدTab  ِرا در پنجره يNode Graph 

 تان را بنویسید. gizmoفشار بدهید و نامِ 

 )Template( قالب بندي شده اسکریپت هايِ

 Fileیا  File > New Compید ، یا را اجرا می کن Nukeهر زمان که برنامه يِ می توانید یک اسکریپت قالب بندي شده اي را بسازید که 

> Close Comp  ، خالیرا بر می گزینید بارگذاري شود. با این کار می توانید ، براي نمونه ، راه اندازهايِ  به جايِ یک اسکریپتLUT 

(lookup table) ) و چیدمان هايِ دلخواهیFavorite arrangement.از تکمه ها را ذخیره کنید ( 

 گرفتنِ یک اسکریپت قالب بندي شده ساختن و به کار

 اسکریپتی را بسازید که می خواهید به عنوان یک قالب آن را به کار بگیرید. .1

2. File > Save Comp As  را برگزینید. به~/.nuke ید. نشانه يِ برو~ )tilde نشان دهنده يِ پوشه يِ خانه است ، و نشانه يِ نقطه (

 پنهان است. )folderزیر پوشه () براي یک .(

 را بزنید. Saveنام گذاري کنید و دکمه يِ  template.nkاسکیپت تان را به  .3

را برگزینید ، برنامه قالب را  File > Close Compیا  File > New Compرا اجرا کنید ، یا  Nukeپس از این ، هر زمان که برنامه يِ 

 بارگذاري می کند. nuke/template.nk./~از 

می توانید یک  Mac OSXو  Linuxپوشه يِ خانه تان را نمی دانید ، بر رويِ سیستم هايِ عاملِ ه درستی جايِ اگر ب نکته :

را بنویسید. پایانه نامِ مسیر را به پوشه يِ خانه تان  echo $HOME) را باز کنید و در آن Terminalپنجره يِ پایانه (

 برگشت می زند.

به  HOMEرا در زیرِ پوشه اي بیابید که با متغیرِ محیطیِ  nuke.، می توانید پوشه يِ  Windowsعاملِ  بر رويِ سیستمِ

زیر پوشه اي در زیرِ  nuke.آن اشاره شده است. اگر این متغیر پیکربندي نشده باشد (که البته شایع هم هست) ، پوشه يِ 

)folder(  ِرِ محیطیخواهد بود که با متغیUSERPROFILE ن شده ارهايِ محیطیِ  یست. اگر ممعیخواهید ببینید که متغی

HOME  وUSERPROFILE  ِپیکربندي شده و به کجا اشاره دارند ، در نوارAddress  ِدر پنجره يِ مرورگرWindows 

Explorer  ِعبارت هاي ،%HOME%  و%USERPROFILE%  ، رِ محیطی پیکربندي شده باشدیر زرا بنویسید. اگر متغی

 اگر متغیرِ محیطی پیکربندي نشده باشد ، خطایی را دریافت می کنید. می شود که متغیر به آن اشاره دارد. پوشه اي باز

 در این جا نمونه هایی از نامِ مسیر را در زیر بناهايِ گوناگون آورده ایم :
Linux: /users/login name 
Mac: /Users/login name 
Windows: drive letter:\Documents and Settings\login name or drive letter:\Users\login name 
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 مشترك Preferencesتعریف کردن 

 تغییرات) این امکان را ایجاد می کند که هر کاربر رفتار و Nuke )Edit > Preferencesبرنامه يِ  Preferences گفت و گويِ پنجره يِ

هايِ پیش فرضِ ویژه اي  Preferencesکاربري درست کند. به هر روي ، شاید بخواهید براي هنرمندان نمایشیِ بی شماري را در پنجره يِ 

 را تعریف کنید.

 هايِ پیش فرض Preferencesروشِ تعریف کردن 

1. Edit > Preferences  ِرا برگزینید تا پنجره يِ گفت و گويPreferences ر آید.به نمایش د 

 کنترل هایی که می خواهید را میزان کنید. .2

می نویسید  Preferences9.0.nkهايِ پیرایش شده را در یک پرونده به نامِ  Nuke  ،Preferencesرا فشار بدهید.  OKدکمه يِ  .3

 ذخیره می کند. nuke./[home directory]، و آن را در پوشه يِ 

 جا به جا کنید. Nukeپلاگینِ  ه را در پوشه يِ مسیرِبه دست آمد Preferences9.0.nkپرونده يِ  .4

 بسازید (البته اگر این پرونده نباشد). menu.pyدر پوشه يِ مسیرِ پلاگین تان پرونده اي به نامِ  .5

 بنویسید : menu.pyوروديِ زیر را در پرونده يِ  .6

nuke.load ("preferences9.0.nk") 

 Preferencesگفت و گويِ  به مانند پیش فرض براي هنرمندان کار می کند. به هر روي ، هر تغییري که در پنجره يِ Preferencesاکنون 

 ض هایی که هستند سوار می شوند.رانجام بدهید ، این تغییرات به پیش ف

 Preferencesکردن)  Resetپاك کردن (و 

 باز کنید. Shellیا  Terminalیک  .1

2.  به کمکPrompt  ِبه پوشه ي ،.nuke .در زیرِ پوشه يِ خانه تان بروید ، 

 را بنویسید. چیزي مانند زیر را باید ببینید : pwdبراي به نمایش در آمدن و بررسی کردن مسیر ،  .3

• /users/login name/.nuke (on Linux), 
• /Users/login name/.nuke (on Mac) or 
• drive letter:\Documents and Settings\login name\.nuke or drive letter:\Users\login name\.nuke 

را می توانید در زیرِ پوشه اي بیابید  nuke. زیر پوشه يِ Windowsهمیشه این جور نیست ؛ چرا که بر رويِ سیستمِ به هر روي ، 

ت. اگر به آن اشاره شده اس USERPROFILEیطیِ پیکربندي نشده باشد) متغیرِ مح HOME، یا (اگر  HOMEکه با متغیرِ محیطیِ 

در  Addressپیکربندي شده و به کجا اشاره دارند ، در نوارِ  USERPROFILEو  HOMEمی خواهید ببینید که متغیرهايِ محیطیِ 

را بنویسید. اگر متغیرِ محیطی  %USERPROFILE%و  %HOME%، عبارت هايِ  Windows Explorerپنجره يِ مرورگرِ 

پیکربندي شده باشد ، زیر پوشه اي باز می شود که متغیر به آن اشاره دارد. اگر متغیرِ محیطی پیکربندي نشده باشد ، خطایی را 

 دریافت می کنید.

 را بنویسید. Preferences  ،rm preferences9.0.nkپرونده يِ براي پاك شدن  .4
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5. Terminal  یاShell ببندید. را 

 پیش فرض بازسازي می کند. Preferencesرا اجرا کنید ، خود برنامه پرونده اي را با  Nukeزمانِ بعد که برنامه يِ 

 یک اسکریپت (LUT) تبدیلِ ارزشِجدول هايِ  تغییر دادن

برنامه  ه و دستگاه ، و فضايِ رنگ توکارِیک اسکریپت ، نمودارهایی هستند که برگرداندنِ فضاهايِ رنگ میان پروند تبدیلِ ارزشِجدول هايِ 

ارزش  yنشان دهنده يِ ارزش هايِ پیکسلی درون رفت ، و آسه يِ  x، آسه يِ  Curve Editorرا کنترل می کنند. در پنجره يِ  Nukeيِ 

ارزشِ  Nukeها ، برنامه يِ  LUTهنگام به کار گرفتن  .هنجار سازي شده اند) 1-0(در دامنه يِ  هايِ پیکسلی بیرون رفت را نشان می دهد

 بیرون بفرستد. yجست و جو می کند تا ارزشی را ارزیابی کند که با ارزشِ  xدرون رفت را در راستايِ آسه يِ 

 هايِ زیر را فراهم می کند : LUTمجموعه اي از  Nukeبرنامه يِ 

linear, sRGB, rec709, Cineon1, Gamma1.8, Gamma2.2, Panalog2, REDLog3, ViperLog4, AlexaV3LogC5, 

PLogLin6, Slog7, REDSpace8 

 هستند را پاك کنید.  scriptهایی که در پیکربندي هايِ  LUTهايِ دیگر را نیز می توانید بسازید و ویرایش کنید ، یا  LUTبی شمار 

هايِ بخصوصی را به کار می گیرد. در بسیاري از  LUTبراي انواعِ پرونده ها و دستگاه ها يِ بخصوص ،  Nukeبه طورِ پیش فرض ، برنامه يِ 

مانی زجاها ، نیاز نیست دست به این پیش فرض ها بزنید. به هر روي ، گاهی پیش می آید که می باید پیش فرض را تغییر بدهید ؛ براي نمونه ، 

ضبط و نگاشته شده باشد. در جاهایی ، که به تغییرِ  Panalog، مانند مایه تان با دوربینی گرفته شده باشد که در یک فضايِ رنگ سفارشی  که

 پیکربندي هايِ اسکریپت تغییر بدهید. نیاز ندارید ، می توانید پیش فرض ها را در پنجره يِ Writeیا  Readفضايِ رنگ بر رويِ هر تکمه يِ 

ر را برگزینید که د یتبدیلِ ارزش پیش فرض را به کار بگیرید ، می توانید جدولِ LUT یتک اگر نمی خواهید براي خواندن یا نوشتن نگاره هايِ

 مربوط می شوند ، به کار بیاید. LUTکه به  Writeیا  Readبخشِ کنترل هايِ تکمه يِ 

 ها LUTبه نمایش گذاشتن ، افزودن ، ویرایش کردن و پاك کردن 

مکان را براي شما فراهم می کنند که بتوانید جدول هایی جست و جو را ببینید ، جدولی این ا Project Settingsدر پنجره يِ  LUTبرگه يِ 

 را به فهرست بیافزایید ، هر یک از جدول ها را ویرایش ، و یا پاك کنید.

 LUTروشِ به نمایش گذاشتنِ نمودارهايِ 

1. Edit > Project Settings ت باز شود.را اجرا کنید تا پنجره يِ پیکربندي ها براي اسکریپ 

__________________________________________________________________________________ 
۱   The Cineon conversion is implemented as defined in Kodak’s Cineon documentation. 
۲   The Panalog LUT is based on a log2lin conversion with a blackpoint of 64, whitepoint of 681, and a gamma of 0.89. 
۳   The REDLog LUT is based on a log2lin conversion with a blackpoint of 0, whitepoint of 1023, and a gamma of 1.022. 
٤   The ViperLog LUT is based on a log2lin conversion with a blackpoint of 0, whitepoint of 1023, and a gamma of 1.0. 
٥   The Alexa LogC LUT uses the formula provided by ARRI. 
٦   The PLogLin LUT uses the default values for the formula, mapping log 0.43457 (code value 445 on a 1024 scale) to linear 
0.18 (mid-gray) 
assuming a negative gamma of 0.6 and a density per code value of 0.002. (This does factor in the fact that value ranges for a 
log image in Nuke are still scaled to 0-1 range.) 
۷ The Sony S-Log LUT comes from the Sony S-Log Whitepaper Version 1.110. 
http://www.sony.co.uk/res/attachment/file/66/1237476953066.pdf. 
۸ The REDSpace LUT is implemented as defined in a curve provided by RED. 
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 بروید. LUTبه برگه يِ  .2

به نمایش در آید را برگزینید. اگر می خواهید  Curve Editorکه می خواهید در پنجره يِ  LUTاز فهرستی که در سمت چپ است ،  .3

هایی که  LUTها را یکی یکی کلیک کنید. همه يِ  LUTرا پایین نگه دارید و  Ctrlرا با هم برگزینید ، کلید  تبدیلِ ارزشچندین جدول 

 به نمایش در می آیند. Curve Editorدر پنجره يِ  برگزیدید در یک زمان

 

 جدید LUTروشِ ساختنِ یک 

1. Edit > Project Settings اي اسکریپت باز شود.را اجرا کنید تا پنجره يِ پیکربندي ها بر 

 بروید. LUTبه برگه يِ  .2

 ) کلیک کنید. یک پنجره يِ گفت و گو باز می شود.+بر رويِ دکمه يِ بعلاوه ( .3

 را فشار بدهید. OKجدید بنویسید و  LUTنامی براي  .4

اگر می خواهید نموداري را برگزینید بر رويِ آن کلیک کنید. اگر می خواهید را آن گونه که می خواهید میزان کنید.  تبدیلِ ارزشنمودارِ  .5

را با هم پایین نگه دارید و بر رويِ نمودار کلیک کنید. می توانید نقطه ها را بگیرید  Altو  Ctrlنقطه هایی را به نمودار بیافزایید ، کلیدهايِ 

 تانژانت را میزان کنید.د شکلِ نمودار را تغییر بدهید ، دستگیره هايِ و به جايِ دیگري بر رويِ نمودار بکشید. اگر می خواهی

تکمه هايِ  propertiesدر قابِ  colorspace، و فهرست پایین افتادنیِ  LUTدر پیکربندي هايِ همگانیِ را جدید  LUT می توانید اکنون

Read  وWrite  ِو کنترل هاي ،Viewer .ببینید 

 ها LUTروشِ ویرایش کردن 

1. Edit > Project Settings .را اجرا کنید تا پنجره يِ پیکربندي ها براي اسکریپت باز شود 

 بروید. LUTبه برگه يِ  .2

 که می خواهید ویرایش کنید را برگزینید. LUTاز فهرستی که در سمت چپ است ،  .3
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اري را برگزینید بر رويِ آن کلیک کنید. اگر می خواهید نمودارِ تبدیلِ ارزش را به آن چه که نیاز دارید میزان کنید. اگر می خواهید نمود .4

را با هم پایین نگه دارید و بر رويِ نمودار کلیک کنید. می توانید نقطه ها را بگیرید  Altو  Ctrlنقطه هایی را به نمودار بیافزایید ، کلیدهايِ 

 تانژانت را میزان کنید.غییر بدهید ، دستگیره هايِ و به جايِ دیگري بر رويِ نمودار بکشید. اگر می خواهید شکلِ نمودار را ت

را برگزینید.  Editراست کلیک کنید و  Curve Editor، بر رويِ  Pasteو  copyبراي به کار بردن فرمان هايِ ویرایشیِ مرسوم ، مانند 

 سپس ، فرمانِ ویرایشی که می خواهید به کار بگیرید را برگزینید.

را تغییر نام بدهید ، می  LUTاگر بخواهید یک  هایی که هستند را نمی توانید تغییر بدهید. LUTدر حال حاضر ، نامِ  یادداشت :

 LUTقدیمی را در آن رونوشت بگیرید. پس از این  LUTجدید را افزوده و نام گذاري کنید. سپس دانسته هايِ  LUTیک باید 

 قدیمی را پاك کنید.

 به شکلِ پیش فرضِ نخستین شان LUTروشِ بازگرداندنِ نمودارهايِ 

1. Edit > Project Settings .را اجرا کنید تا پنجره يِ پیکربندي ها براي اسکریپت باز شود 

 بروید. LUTبه برگه يِ  .2

کنید ،  Resetرا با هم  LUTکنید را برگزینید. اگر می خواهید چندین  Resetکه می خواهید  LUTاز فهرستی که در سمت چپ است ،  .3

 کلیدCtrl .را پایین نگه دارید و آن ها را یکی یکی برگزینید 

 را بزنید. Resetدکمه يِ  .4

 LUTروشِ پاك کردن یک 

1. Edit > Project Settings .را اجرا کنید تا پنجره يِ پیکربندي ها براي اسکریپت باز شود 

 بروید. LUTبه برگه يِ  .2

هایی که براي نمونه ، تصادفی ساخته شده و  LUTکه می خواهید پاك کنید را برگزینید. تنها  LUTاز فهرستی که در سمت چپ است ،  .3

 ) کلیک کنید.-در اسکریپت تان کاربردي ندارند را پاك کنید. بر رويِ دکمه يِ منها (

LUT  ِاز پیکربندي هايLUT  ِپایین افتادنی و فهرست ،colorspace  ِدر قابproperties  ِتکمه يRead  وWrite .برداشته می شود 

 LUTنامِ همان به جست و جويِ را پاك کنید که در تکمه اي به کار گرفته شده است ، تکمه  LUTاگر یک  یادداشت :

 ادامه می دهد و به یک خطا می رسد.

 براي کار با آن LUTبرگزیدن یک 

 را به کار بگیرید. براي این کار : LUTاره ، می باید یک به هنگامِ خواندن و نوشتن یک نگ

 آن باز شود. propertiesدو بار کلیک کنید تا قابِ  Writeیا  Readبر رويِ تکمه يِ  .1

پیش  LUT، نمودارِ تبدیلِ ارزشی که می خواهید به کار بگیرید را برگزینید. اگر می خواهید  colorspaceاز فهرست پایین افتادنیِ  .2

 را برگزینید. defaultبراي نوعِ نگاره تعریف شده است را به کار ببرید ، گزینه يِ  Nukeفرضی که در پنجره يِ پیکربندي هايِ 
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 پیش فرض LUT پیکربندي هايِ

 هايِ زیر را در جاهایی که آمده به کار می گیرد : Nuke  ،LUTبه طورِ پیش فرض ، برنامه يِ 

LUT ده/دستگاهنوعِ پرون پیش فرض 
sRGB نمایشگر دستگاه )monitor ِبراي نگاره هايِ تمبر پستی ، بافت هاي : (OpenGL  ِنمایش دهنده ي ،color 

chooser ) و همه يِ نمایش دهنده هايِ تصویري دیگر که نمایشگر ،viewer .نباشند ، به کار برده می شوند (

ر برده می شود که برگرداندن فضايِ رنگ به دستگاه نمایش به هنگامی به کا Truelightهم چنین با تکمه هايِ 

 یا برگرداندن فضايِ رنگ از دستگاه نمایش نیاز باشد.

sRGB  ِ8پرونده هاي-bit  :8پرونده هايِ تصویري که شاملِ داده يِ  به هنگامِ خواندن یا نوشتن-bit به کار گرفته  باشند

، و براي برگرداندن درون رفت هايِ تکمه هايِ  Mergeتکمه يِ  sRGB switch چنین با. هم می شود

Primatte  وTruelight  بهsRGB  و بیرون رفت هايِ آن ها از ،sRGB  .به کار برده می شودCineon 

LUT  ِنیز براي کنترل کردن درون رفتی که به تکمه يTruelight .می آید به کار می رود 

sRGB  ِ16پرونده هاي-bit  ِ16داده يِ  خواندن یا نوشتن پرونده هايِ تصویري که شاملِ: به هنگام-bit integer  و)

 .به کار برده می شود) هستند ، half floatنه 

Cineon  ِپرونده هايlog پرونده هايِ  : به هنگامِ خواندن یا نوشتن.cin  یا.dpx نیاز  . هم چنین زمانی کهبه کار می رود

 باشد یک فضايِ رنگ از فضايِ رنگlog  یا به ، فضايِ رنگlog  ِبرگردانده شود ، به وسیله يِ تکمه هاي

Truelight .به کار می رود 

Linear  ِپرونده هايfloat  ِبه هنگامِ خواندن و یا نوشتن پرونده هايِ تصویري که شاملِ داده ي :floating-point 

 باشند ،  به کار گرفته می شود .

 پیش فرض LUTروشِ تغییر دادن پیکربندي هايِ 

1. Edit > Project Settings .را اجرا کنید تا پنجره يِ پیکربندي ها براي اسکریپت باز شود 

 بروید. LUTبه برگه يِ  .2

براي هر نوع به عنوانِ پیش فرض هایی را برگزینید که می خواهید  Default LUT settings  ،LUTاز فهرست پایین افتادنی در زیرِ  .3

 .برودپرونده یا به طورِ پیش فرض به کار 

بخصوص را گزینش نکرده بودید ، به کار می رود. همه يِ کنترل  LUT، که براي آن یک  LUTاکنون پیش فرض هايِ جدید براي هر پیکربنديِ 

برگزیده شده را  LUTپیکربندي نشده باشد) به کار گرفتن  defaultشده باشد (یعنی ، به گزینه يِ بخصوص پیکربندي  LUTهایی که به یک 

 پیکربندي شده اند ، تاثیر می گیرند. defaultادامه می دهند ، و تنها آن هایی که به 

 نمونه ها

 غییر بدهید.را ت هايِ پیش فرض LUTرا می آوریم که ممکن است نیاز باشد  شرایطیدر زیر نمونه هایی از 

 روشِ کار در فضايِ رنگ ویدئو
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با فضايِ رنگ ویدئویی کار می کند پیشنهاد نمی شود. به هر روي ، اگر نیاز بود که ي که کارِ ترکیب بندي را تقلیدي انجام می دهد و نرم افزار

 این کار را انجام بدهید ، کارهايِ زیر را دنبال کنید :

1. Edit > Project Settings  ِرا برگزینید و به برگه يLUT .بروید 

 تغییر بدهید. linearرا به  monitor  ،8-bit files  ،16-bit files، ارزش هايِ  Default LUT settingsدر زیرِ  .2

ده يِ هنوز دا Nukeبرگرداند. تکمه هايِ  linearبه  sRGBرا از را می گیرد و نمی گذارد فضايِ رنگ  Nukeاین کار جلويِ برنامه يِ 

linear  ویدئویی دارند که نگاره هایی می انجامد که فضايِ رنگ آماده سازي نگاره به ساخت را به خود می گیرند ، ولی روندlinear  نشده

 است.

 bit-16در پرونده هايِ  Linearداده يِ 

به کار گرفته می برند. اگر شما  bit-16در پرونده هايِ را  linear، داده يِ  انجام می دهند يِ آن  که کارها را به شکلِ ساده کسانیبرخی از 

 هم جزوِ این افراد هستید ، کارهايِ زیر را انجام بدهید :

1. Edit > Project Settings  ِرا برگزینید و به برگه يLUT .بروید 

 تغییر بدهید. linearرا به  bit files-16، ارزشِ  Default LUT settingsدر زیرِ  .2

 Cineonنمایش دهنده هايِ 

داده يِ  هبرخی از کسانی که کارها را به شکلِ ساده يِ آن انجام می دهند ، الکترونیک هايِ دستگاه نمایشگرشان را به گونه اي میزان کرده اند ک

Cineon کنید : را به درستی نمایش می دهد. اگر این کاري است که شما هم انجام داده اید ، کارهايِ زیر را دنبال 

1. Edit > Project Settings  ِرا برگزینید و به برگه يLUT .بروید 

 تغییر بدهید. Cineonرا به  monitor، ارزشِ  Default LUT settingsدر زیرِ  .2

 مدیریت رنگ

که براي پیکربنديِ  LUTک و تکمه هايِ دیگر را به کار بگیرید ، ولی شاید با ی Truelightاگر چه براي مدیریت واقعیِ رنگ باید تکمه يِ 

monitor  ا ببه کار برده می شود نیز بتوانید به چیزي که می خواهید نزدیک شوید. با این کار ، نگاشت هايِ بافتی و نگاره هايِ تمبر پستی

 دقتّ بیش تري به نمایشِ نهایی شبیه خواهند بود.

 monitor-correctedتان بر پایه يِ دستگاه نمایشگر تصحیحِ رنگ شده باشد (اگر در مدیریت رنگی که انجام می دهید نگاره يِ ساخته شده 

image براي آن که بیرون رفت ، (monitor-correct  ِقابل قبولی بر رويِ نگاره هايnon-Viewer  ِبه دست بیاورید ، پیکربندي

monitor  ِرا بر رويsRGB .بگذارید 

 OCIO Configبه کار گرفتن پرونده هايِ 

ارائه می  Nukeاین امکان را فراهم می آورد که به جايِ یک پرونده يِ پیکربندي که با برنامه يِ  Project Settings > OCIOبرگه يِ 

 Nukeداده می شود ، ولی در  Nukeرا مشخص کنید. این پرونده يِ پیکربندي به سرتاسرِ برنامه يِ  OCIOشود ، یک پرونده يِ پیکربنديِ 

 را پیکربندي کنید. project-wide OCIO configپرونده يِ  Timelineدر محیطProject Settings  به کمک پنجره يِ می توانید 
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• Ocio config  : پرونده يِ پیکربنديِ یکOpenColorIO  کرده و به کار می گیردرا مشخص همه يِ پرونده  پایین افتادنی ،. فهرست

را برگزینید تا  Customذخیره شده باشند را فهرست می کند. از این فهرست  Nukeپلاگینِ  که در هر مسیرِ OCIOهايِ پیکربنديِ 

 در زیر فعال شود. path to custom OCIO configگزینه يِ 

دارد. یکی را که برگزینید ، فضايِ رنگ تعریف کرده باشید را در خود  همه يِ آن چه که براي OpenColorIOپرونده يِ پیکربنديِ 

 موجود هستند را تعیین می کند. OCIOهايِ رنگی که در تکمه هايِ فضا

• path to custom OCIO config  : ِیک پرونده يِ پیکربنديOpenColorIO .سفارشی را بر می گزیند و آن را به کار می گیرد 

برنامه  )"OCIO="/myOCIOConfigLocation/config.ocioه ، را مشخص کرده باشید (براي نمون OCIOاگر یک متغیرِ محیطیِ 

و  OCIO configهمیشه پرونده يِ پیکربندي که این جا مشخص شده است را به کار می گیرد. در این جا ، کنترل هايِ  Nukeيِ 

path to custom OCIO config .ال می شوندغیر فع 

 هايِ سفارشی Viewer Processساختن 

، می توانید روند نمایشِ یک نمایشگرِ تک را به گونه اي میزان  ها Viewer processها) در  LUTتبدیلِ ارزش ( دول هايِج با به کار بردن

 Viewerهايِ  gizmoیک چند  Nukeبر رويِ فیلم یا برخی از دستگاه هاي نمایشِ ویدئویی یکسان به چشم بیاید. برنامه يِ کنید که نگاره 

process شده را در خود دارد ؛ ولی خود شما نیز می توانید فرآیندهایی را به آن بیافزایید. براي این کار می باید یک تکمه یا  از پیش تعریف

gizmo  را به عنوان یکViewer process  ثبت کنید. هر چند تاViewer process  که خواسته باشید را می توانید به ثبت برسانید. اگر

تان فهرست شده است را به کار ببرید ، می  Viewer processدر  Project Settingsهایی که در پنجره يِ  1D LUTمی خواهید یکی از 

 را به کار بگیرید. ViewerProcess_1DLUTساخته شده اي به نامِ  gizmoتوانید 

 3Dد چگونه یک نهکه توضیح می د ندهست init.py نصب شده يِ در پرونده يِ تفسیر شده یک چند تا نمونه هايِنکته : 

LUT  و یکTruelight  را براي یکViewer Process يِ زیر پیدا کنید :هابه کار بگیرید. این پرونده را می توانید در جا 

 : Windowsدر سیستمِ عاملِ 

drive letter:\Program Files\Nuke9.0v4\plugins or 
drive letter:\Program Files (x86)\Nuke9.0v4\plugins 

 : Mac OSXدر سیستمِ عاملِ 

/Applications/Nuke9.0v4/Nuke9.0v4.app/Contents/MacOS/plugins 
 : Linuxدر سیستمِ عاملِ 

/usr/local/Nuke9.0v4/plugins 

هايِ موجود (هم آن هایی که از پیش تعریف شده باشند و هم آن هایی که سفارشی ساخته شده باشند) را می  Viewer Processهمه يِ 

به کار  Viewerدر بخشِ کنترل هايِ تکمه يِ  Viewer processتوانید از فهرست پایین افتادنیِ 

 بگیرید.
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يِ توکار و ثابت تکمه ها هستند که پیش از این که نگاره ها در ها بخشی از خطِّ لوله يِ ساخته شده  Viewer Processباید بدانید که 

 ین دو تاست :ایکی از  )pipeline( نمایشگر نشان داده شوند به آن ها داده می شود. این خطِّ لوله

• gain > Input Process > Viewer Process > gamma > dither > channels > clipset  اگر)viewer input 

order  ِدر پنجره يViewer Settings  بهbefore viewer process .(پیکربندي شده باشد 

 یا

• gain > Viewer Process > Input Process > gamma > dither > channels > clipset  اگر)viewer input 

order  ِدر پنجره يViewer Settings  بهafter viewer process .(پیکربندي شده باشد 

شما  Viewer Processانجام می دهد ، ممکن است ترتیب درست نباشد. بنا بر این ، اگر  Viewer Processوي ، بسته به آن چه به هر ر

) ، clipset، یا  gain  ،gamma) کنترل هایی دارد که براي نمایشگر هم موجود باشند (مانند کنترل هایی به نامِ Input Process(یا یک 

Viewer آماده سازيِ نگاره را انجام نمی دهد. این به شما اجازه آن ها را از ک نترل هايِ نمایشگرِ مربوطه بیرون می کشد و دیگر خودش روند

 Viewerتان پیاده سازي کنید. اگر  Viewer Processمی دهد که این کنترل ها را به کمک هر تکمه اي و با هر ترتیبی که بخواهید در 

Process  تان این کنترل ها را نداشته باشد (و یا آن ها بر رويِ هیچInput Process (که به کار می رود پیدا نشوند  ،Viewer  جلوه ها را

 بر مبنايِ خطِّ لوله يِ ساخته شده يِ توکار در روند هنجارشان انجام می دهد.

 سفارشی Viewer Processبه عنوان یک  Gizmoبه کار گرفتن یک 

بسازید که شاملِ تصحیح رنگ باشد (مانند یک جدولِ تبدیلِ ارزش  gizmoسفارشی ، معمولاً باید یک  Viewer Processاخت یک براي س

 به ثبت برسانید. Viewer Processآن را به عنوان یک  Python) و به کمکLUT یا 

تان به کار بگیرید ، نیازي  Viewer Processرا در  Project Settingsهايِ فهرست شده در پنجره يِ  1D LUTاگر می خواهید یکی از 

را  ViewerProcess_1DLUTساخته شده يِ توکار به نامِ  gizmoسفارشی بسازید. به جايِ آن ، می توانید یک  gizmoنیست که یک 

 ن را ویرایش کنید.ه آگذارد ککه به کار می رود نمادي را می گیرد ، ولی نمی  LUTبراي آن  gizmoثبت کنید. این به آسانی 

یافت شود ،  Project Settingsدر پنجره يِ  LUTرا داشته باشید که بر رويِ برگه يِ  1D LUTاگر می خواهید هر چیزِ پیچیده تر از یک 

 خودتان را بسازید و آن را به ثبت برسانید. gizmoمی باید 

 Viewer Processه عنوان یک ب Project Settingsدر پنجره يِ  LUTروشِ به ثبت رساندن یک 

 در پوشه يِ مسیرِ پلاگین تان بسازید (البته اگر نیست). init.pyیک پرونده به نام  .1

، کارکرد زیر را  Viewer Processاست به عنوان یک  Project Settingsهایی که در پنجره يِ  LUTبراي به ثبت رساندن یکی از  .2

 تان به کار ببرید : init.py، براي نمونه ، در 

nuke.ViewerProcess.register("Cineon", nuke.createNode, ("ViewerProcess_1DLUT",  

"current Cineon")) 
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ثبت کرده و آن را  Viewer Processرا به عنوان یک  ViewerProcess_1DLUTساخته شده يِ توکار به نامِ  gizmoاین کارکرد یک 

با  Viewer Processبه ثبت رسیده در فهرست پایین افتادنیِ  Viewer Processرا به کار بگیرید.  Cineon LUTپیکربندي می کند که 

 به نمایش در می آید. Cineonنامِ 

را به  Project Settingsدر پنجره يِ  1D LUTساخته شده يِ توکار را به گونه اي پیکربندي کنید که هر  gizmoباید بدانید  که می توانید 

 را به کار بگیرد : Panolog LUTرا به گونه اي پیکربندي کنید که  gizmoکار ببرد. براي نمونه ، با به کار بردن کارکرد زیر می توانید 
nuke.ViewerProcess.register("Panalog", nuke.createNode, ("ViewerProcess_1DLUT", 
"current Panalog")) 

 Viewer Process Gizmoروشِ ساختن یک 

به کار ببرید. براي نمونه ، می توانید یک تکمه يِ  Viewer Processتکمه (ها) اي را بسازید که می خواهید به عنوان یک  .1

ColorLookup  ،Vectorfield (3D LUT)  ،Truelight  یا ،Colorspace .را به کار ببرید 

 را اجرا کنید. Other > Groupرگزنید ، و شامل شود را ب  Viewer Processتکمه (ها) اي که می خواهید در  .2

تان را کاربران بتوانند میزان کنند ، بر رويِ پس زمینه يِ خاکستريِ  Viewer Processبراي این که معلوم کنید کدام یک از کنترل هايِ  .3

 را برگزینید. Manage User Knobsراست کلیک کرده و  Groupتکمه يِ  propertiesتیره در قابِ 

) به نمایش بگذارید ، کنترل هایی که در پنجره يِ gammaو  gainاگر کنترل ها را با همان نامی که در پنجره يِ نمایشگر دارند (مانند 

را با همان کنترل ها به کار بگیرید ،  Input Processنمایشگر هستند براي راندن این کنترل ها به کار می روند. به هر روي ، اگر یک 

Input Process  ِم شمرده می شود و کنترل هايمقدViewer  ِآن را می رانند و از کنترل یا کنترل هايViewer Process  هم نام

 چشم پوشی می کنند.

4.  هر زمان که از گروهViewer Process  ِپیرایش شده راضی بودید ، در برگه يNode  ِاز بخشِ کنترل هايِ گروه دکمه يexport 

as gizmo  تا را بزنیدViewer Process   را در یکgizmo  به بیرونExport .کنید 

را  /nuke.را فشار بدهید. پس از مسیري که در پایینِ مرورگرِ پرونده پدیدار می شود ،  Homeدر مرورگرِ پرونده که باز می شود ،  .5

بزرگ آغاز شده باشد. در  باید با نویسه يِ پس از نام پیوست بزنید. نام gizmo.بنویسید. نامی پس از مسیر بنویسید ، و یک گسترشِ 

 را فشار بدهید. Saveپایان دکمه يِ 

 سفارشی را ادامه بدهید. Viewer Processبه عنوان یک  gizmoدر زیر ، به ثبت رساندن یک  .6

 Inputتان را پیش از به ثبت رساندن ، به عنوان یک  Viewer Process gizmoاگر دوست داشته باشید ، می توانید  نکته :

Process : آزمایش کنید. کارهايِ زیر را دنبال کنید 

 بگذارید. Noneرا رويِ  Viewer Processدر گوشه يِ بالا و راست از پنجره يِ نمایشگر ، فهرست پایین افتادنیِ  .1

 را برگزینید. Node Graph  ،gizmoدر پنجره يِ  .2

در بخشِ کنترل هايِ نمایشگر کلیک کنید. اگر از  IP، بر رويِ دکمه يِ  Input Processو خاموش کردن براي روشن  .3

است را دنبال  Viewer Processبه عنوان یک   gizmoبرآیند کار راضی بودید ، ادامه يِ کار که همان به ثبت رساندن 

 کنید.
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موجود را ببینید و ویرایش کنید ، می توانید کارهايِ زیر را انجام  Viewer Processاگر می خواهید اینترنال هايِ یک  نکته :

 بدهید :

 که می خواهید پیرایش کنید را برگزینید. Viewer Process، آن  Viewer Processاز فهرست پایین افتادنیِ  .1

2. Edit > Node > Copy Viewer Process to Node Graph  را برگزینید. با این کارViewer Process gizmo  که

 برگزیده بودید ، جاگذاري می شود. Node Graphدر پنجره يِ 

کلیک  copy to groupبروید و بر رويِ  Nodeدو بار کلیک کنید تا کنترل هايِ آن باز شود. به برگه يِ  gizmoبر رويِ  .3

 دست بیابید. gizmoکنید. با این کار می توانید به یک نسخه يِ ویرایش پذیر از 

کلیک کنید تا اینترنال هايِ گروه به نمایش در آیند. آن ها بر رويِ یک  S، بر رويِ دکمه يِ  Groupدر بخشِ کنترل هايِ  .4

 نشان داده می شوند. Node Graphبرگه يِ جدید در پنجره يِ 

هايِ گروه ، گروه را از بخشِ کنترل  Nodeبر رويِ برگه يِ  export as gizmoتغییرات تان را بدهید و با زدن دکمه يِ  .5

 کنید Exportبه بیرون  gizmoدر یک 

 در rbg_only به کمک به کار ببرید ، می توانید Viewer Process gizmoرا در یک  ViewerLUTاگر تکمه يِ  نکته :

داده  blue، و  red  ،greenبه همه يِ کانال ها ، یا تنها به کانال هايِ  LUTمعلوم کنید که آیا  ViewerLUT بخشِ کنترل هايِ

در معرضِ دید بگذارید تا کاربران  Viewer Process gizmoشود. هم چنین می توانید این کنترل را در بخشِ کنترل هايِ 

 بتوانند آن را خودشان پیکربندي کنند.

 سفارشی Viewer Processروشِ به ثبت رساندن یک 

 در پوشه يِ مسیرِ پلاگین تان بسازید (البته اگر نیست). init.pyیک پرونده به نامِ  .1

 به کار ببرید : init.py، کارکرد زیر را در پرونده يِ  Viewer Processیا تکمه به عنوان یک  gizmoبراي ثبت کردن یک  .2

nuke.ViewerProcess.register() 

 Myثبت کرده و آن را با نامِ  Viewer Processرا به عنوان یک  MyProcess.gizmoبه نامِ  gizmoبراي نمونه ، اگر بخواهید یک 

Custom Process  ِپایین افتادنی در فهرستViewer Process : زیر را بنویسید داشته باشید ، می باید کارکرد 
nuke.ViewerProcess.register("My Custom Process", nuke.Node, ("MyProcess", "")) 

 شما در بخشِ کنترل هايِ نمایشگر پدیدار شده باشد. Viewer Processاکنون می باید 

را از ثبت در آورید ، می توانید  Viewer Processاگر نیاز باشد که یک 

nuke.ViewerProcess.unregister() .براي نمونه : را به کار ببرید 

nuke.ViewerProcess.unregister("My Custom Process") 
به کار گرفتن این عبارت ها ، می توانید در پنجره يِ براي به دست آوردن راهنمایی در باره يِ 

 را بنویسید. help (nuke.ViewerProcess)عبارتScript Editor  ، ویراستارِ 

بخواهید  رد بدهید. براي نمونه ، اگر ()nuke.ViewerProcess.registerهم چنین می توانید عبارت ها را به  نکته :

پیکربندي شده است را به ثبت برسانید ، می باید کارکرد زیر را  10آن را رويِ  sizeرا که دستگیره يِ  Blurیک تکمه يِ 

 بنویسید :
nuke.ViewerProcess.register("Blur", nuke.createNode, ("Blur", "size 10")) 
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 هايِ سفارشی به نگاره ها Viewer Processدادن 

سفارشی را به  Viewer Processپنجره يِ نمایشگر ، می توانید یک  در بخشِ کنترل هايِ

است. نیز می توانید براي نگاره اي بدهید که در پنجره يِ نمایشگر به نمایش گذاشته شده 

Viewer Process .ال است ، کنترل ها را باز کنیدکه هم اکنون فع 

سفارشی تان به نگاره هایی که در پنجره يِ نمایشگر  Viewer Processروشِ دادن 

 نشان داده شده اند

 در بخشِ کنترل هايِ پنجره يِ نمایشگر ، فرآیندي را برگزینید. Viewer Processاز فهرست پایین افتادنیِ 

 که هم اکنون فعال است Viewer Processروشِ دیدن کنترل هايِ یک 

 را برگزینید. show panel، گزینه يِ  Viewer Processدر بخشِ کنترل هايِ پنجره يِ نمایشگر ، از فهرست پایین افتادنیِ 

و  gainباز می شود. هر کنترلی که هم نام با یکی از کنترل هايِ پنجره يِ نمایشگر باشد (مانند  Viewer Processاز  propertiesقابِ 

gamma با همان کنترل هايِ خود پنجره يِ نمایشگر میزان کنید. اگر این کنترل ها بر رويِ یک ) را می توانیدInput Process  نیز به کار

را به دست می  Input Processبه کار انداخته شده باشد ، کنترل هايِ پنجره يِ نمایشگر کنترل هايِ  Input Processگرفته شده باشند و 

 از کار می افتند. Viewer Processگیرند و کنترل هايِ 
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__________________________________ Expression ها 

ها (فرمان هايِ برنامه ریزي شده) و روشِ به کارگیريِ آن ها  Expressionدر این بخش گریزي خواهیم داشت به مبانی نخستین در باره يِ 

ها انجام بدهیم (براي نمونه ، چگونه  expression. در این جا می آموزیم که چگونه برخی از کارکردها را با Nukeدر نمادهايِ برنامه يِ 

 ارزش هايِ یک نماد را به نماد دیگر پیوند بزنیم).

 یک آغازِ تنُد و سریع

1. Expression  ِهايِ برنامه يNuke  ِرا در پنجره يِ گفت و گويExpression ره را می توانید یا با فشار دادن می نویسید. این پنج

 باز کنید. Add expression) در رويِ یک نماد ، و یا با راست کلیک کردن بر رويِ آن و برگزیدن =نشانه يِ برابري (

، نوشته اي را بنویسید که یا ارزشی را از نمادهايِ دیگر خاستگاه می کند (با ساختن یک  Expressionدر پنجره يِ گفت و گويِ  .2

expression یا کارکردهايِ ریاضیاتی را به ارزش هايِ جاري بدهد. دار پیوند ، (parent.Transform1.rotate  می تواند نمونه

از تکمه  rotateبیان کننده يِ آن است که این کنترل ارزش هایش را از کنترلِ پدري (کنترلِ  expressionاي از مورد آخر باشد. این 

 .) می گیردTransformيِ 

هايِ برنامه يِ  Expressionها را در میانِ زبان هايِ برنامه نویسی (یعنی ، میانِ  expressionاگر نیاز باشد ، هم چنین می توانید  .3

Nuke  ،TCL  و ،Python.رد و بدل کرده و به هم برگردانید ( 

Expression هايِ پیوند دار 

 از راهExpression  ها ، می توانید نمادهايِ یک تکمه را به نمادهايِ تکمه يِ دیگر پیوند بزنید و ارزش هايِ آن را کنترل کنید. هنگامی که

پیوند دار را می سازید ، عناصري که در جدولِ زیر فهرست شده اند را بنویسید. به یاد داشته باشید که براي جدا کردن هر  expressionیک 

 بگذارید.) .عنصر یک نقطه (

 توضیح عنصر
 )Transform1تکمه به همراه نماد منبع (مانند ،  نامِ تکمه

نام از درون تعریف می شود ، و ممکن است با برچسبِ نماد ). translateنامِ نماد به همراه ارزشِ منبع (براي نمونه ،  نامِ نماد

نمایان می شود یکسان نباشد. اگر نیاز باشد ، نشانگرِ ماوس را بر رويِ میدانِ نماد ببرید  Nukeکه در پنجره يِ کاربريِ 

 که پایین می افتد به نمایش در می آید. tooltipو نگه دارید. نامِ آن در 

 نامِ نماد فرزند

 (اختیاري)

،  red، و یا کانال هايِ رنگy  و  xبرخی از نمادها دارايِ نمادهايِ فرزند هستند ، مانند میدان هایی که براي آسه هايِ 

green  و ،blue  فرزند با برچسبی که پیش از میدانِ نماد پدیدار می شود یکسان است (براي نمونه است. نام هايِ نماد

 ،x.( 
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 زمان

 (اختیاري)

هايِ پیوند دار ارزش ها را از شماره يِ فریم جاري می گیرند ، ولی می توانید آن  expressionبه طورِ پیش فرض ، 

 temporal) بخوانید (یعنی با یک Dynamic) و یا پویا (Staticارزش ها را از فریم هايِ دیگر ، یا به شکلِ ایستا (

offset.( 

یک فریمِ مشخص بخوانید ، تنها باید شماره يِ آن فریم را درون یک پرانتز اگر می خواهید ارزشِ ایستایی را براي 

 ).(10)بنویسید (براي نمونه ، 

را بنویسید (متغیري براي زمان  tدر زمان ،  offsetاگر می خواهید ارزش ها به شکلی پویا خوانده شوند ولی با یک 

رو به پشت) بگذارید ، و  offset(براي یک  -جلو) و یا رو به  offset(براي یک  +است) ، پس از آن یک نشانه يِ 

را  (t-2)براي نمونه ، اگر  می شوند. offsetشماره اي را بنویسید که شماره فریم هایی را نشان می دهند که سپس 

 بنویسید ، ارزش ها از دو فریمِ پشتیِ فریمی که در آن هستید گرفته می شوند.

در فریمِ دهم بگیرد ، می  Transformتکمه يِ  translationپیوند دار که ارزشی را از میدانِ  expressionبنا بر این ، براي ساختن یک 

را در  Transform1.translate.x(10)باز شود ؛ سپس  Expressionرا بنویسید تا پنجره يِ گفت و گويِ  =باید بر رويِ یک نماد ، 

 بنویسید. Expressionمیدانِ 

 

 ارزش ها از نماد دیگرخاستگاه کردن 

 1روشِ 

 بر رويِ نماد مقصد (نمادي که ارزش ها را از نماد دیگر دریافت می کند) کلیک کنید. .1

 را برگزینید. Add expressionبه نمایش در آید ، بر رويِ نماد راست کلیک کنید و  Expressionگفت و گويِ براي آن که پنجره يِ  .2

 

 بنویسید. parameterرا در میدانِ  =،  یا
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گفت و گویی که باز می شود ، نامِ تکمه (که شاملِ نماد منبع و یک نقطه است) را بنویسید. (نامِ هر تکمه بر رويِ خود آن  در پنجره يِ .3

 نشان داده می شود).

 را کلیک کنید.  multi-line edit filedچند تایی را بنویسید ، می توانید دکمه يِ  expressionیک  بخواهیداگر  .4

و نگه  آن ببریدبه دنبالِ نامِ نماد و یک نقطه ، نامِ تکمه را بیاورید. (اگر نامِ نماد را نمی دانید ، می توانید نشانگرِ ماوس را بر رويِ میدانِ  .5

 نشان داده شود). tooltipدارید تا نامِ نماد در یک 

 یز بنویسید.به اختیار می توانید نامِ نماد فرزند و یک نقطه را ن .6

را بنویسید تا  (t-2)، یا  (2)را در براکت ها بنویسید (براي نمونه ، می توانید  offsetبه اختیار می توانید یک شماره فریم یا یک متغیرِ  .7

 می گیرید). از آن ارزش ها راکه فریم یا دامنه اي از فریم ها را مشخص کنید 

 Pythonتان یک  expressionکلیک کنید تا خود به خود  Pyانید بر رويِ دکمه يِ ، می تو expressionدر کنارِ میدانِ وروديِ  .8

callback  ِبسازد. هم چنین می توانید دکمه يR  تا  خاموش و روشن کنیدراexpression  تان به عنوان یکexpression  و یا به

که روشن هستند ، می توانید  Pythonو الگويِ  multi-lineعنوان یک سري از عبارت ها تفسیر شود. براي نمونه ، الگويِ ویرایشی 

expression  ، کار را به دست بیاورید : 15زیر را بنویسید ، و از برآیند 

-execlocal 
 
def example(): 
a = 5 
return a 
 
def example2(): 
b = 10 
return b 
 
ret = example()+example2() 

9. OK آدها را بزنید. بدین سان ، نما بی در می آیند. در پنجره يِ پیوند می خورند ، و به رنگNode Graph  ِیک پیکان سبز رنگ میان ،

 به هم پیوند دارند. expressionتکمه ها پدیدار می شود که نشان دهنده يِ آن است که این تکمه ها از راه یک 
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را برگزینید (یا بر رويِ  Edit expressionراست کلیک کنید و  را ویرایش کنید ، بر رويِ نماد expressionاگر می خواهید بعدها  .10

 را فشار بدهید). هم چنینی می توانید دکمه يِ  =نماد که هستید کلیدanimation   را فشار بدهید و براي ویرایش کردن

expression  ِها براي همه يِ نمادهایی که در کنارِ دکمه هستند ، گزینه يEdit expression .را برگزینید 

 

 2روشِ 

1.  کلیدCtrl  آن را به کار بگیرید. سپس ماوس را به بالايِ  ارزش هايِ که می خواهید ببریدرا پایین نگه دارید و ماوس را بر رويِ نمادي

 ی در می آیند. درنمادي بکشید که می خواهید این ارزش ها را دریافت کند. با این کار پیوندي میان نمادها ساخته می شود و به رنگ آب

یک پیکان سبز رنگ میانِ تکمه ها پدیدار می شود که نشان دهنده يِ آن است که این تکمه ها از راه یک  نیز Node Graphپنجره يِ 

expression .به هم پیوند دارند 

 زینید.را برگ Edit expression، بر رويِ نماد راست کلیک کنید و  expressionبراي دیدن و ویرایش کردن 

2.  اگر می خواهید چندین نماد را هم زمان پیوند بزنید ، کلیدCtrl  ِرا پایین نگه دارید و دکمه يanimation  که در کنار نمادهايِ منبع

 است را به بالايِ همین دکمه ها در کنارِ نمادهايِ مقصد بکشید.

کلیک کنید و  animation، بر رويِ دکمه يِ  ا به کار رفته انددان نماده هایی که براي پیوند expressionبراي دیدن یا ویرایش کردن 

 را برگزینید. Edit expressionگزینه يِ 

 پیوند دادن کانال ها و فُرمت ها به کمکExpression ها 

نترل چون این ک دیگر پیوند بدهید. در تکمه هايِهایی بسازید و کنترل هايِ کانال ، لایه ، و فرُمت را به کنترل دیگري  expressionمی توانید 

 TCLو  Python، و نیز زبان هايِ برنامه نویسیِ  Nukeهايِ برنامه يِ  expressionها پویانمایی نمی شوند ، نمی توانید دامنه يِ کاملی از 

 را به کار ببرید. به کمکLink menu  در قابِ  کهproperties رل ها را پیوند بزنید :در کنارِ یک کنترل است می توانید کنت 

 باز می شود. Expressionرا برگزینید. یک پنجره يِ گفت و گويِ  Set linkکلیک کنید و گزینه يِ  Link menuبر رويِ  .1

2. Expression  ِتان را در میدانExpression  بنویسید وOK .را بزنید 

 را برگزینید. Editlinkکلیک کرده و  Link menuیک پیوندي که هست را می توانید ویرایش کنید. براي این کار بر رويِ  .3

4.  هم چنین می توانید کلیدCtrl  را پایین نگه داشته وLink menu  را بگیرید و بر رويِ کنترلِ دیگر بکشید. میان آن دو کنترل یک پیوند

 ساخته می شود.
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 را برگزینید. Removelinkکلیک کرده و گزینه يِ  Link menuبراي پاك کردن یک پیوند ، بر رويِ  .5

 ها Expressionافزودن کارکردهايِ ریاضیاتی به 

را وارونه کنید که می خواهید آن را  Trackingمی توانید کارکردهايِ ریاضیاتی را در نمادها جا بدهید. براي نمونه ، اگر بخواهید یک نمودارِ 

 ).(Transform1.translate.x)-(منفی) کنید (مانند :  negateرا  expressionبراي ثابت کردن یک عنصر به کار بگیرید ، می توانید یک 

 هایتان بیافزایید (جدولِ زیر). expressionهم چنین می توانید کارکردهايِ ریاضیاتی پیچیده تري را به 

DeepExpression 
Compatible 

Related 
Functions 

Operator usage Purpose Function 

 See also: fabs. x Returns the absolute value of the 
floating-point number x. 

abs (x) 

 See also: cos, 
cosh, 
asin, atan. 

If x is less than -1 or 
greater than 1, acos 
returns nan (not a 
number). 

Calculates the arc cosine of x; that 
is the value whose cosine is x. 

acos (x) 

 See also: sin, sinh, 
acos, atan. 

If x is less than -1 or 
greater than1, asin 
returns nan (not a 
number). 

Calculates the arc sine of x; that is 
the value whose sine is x. 

asin (x) 

 See also: tan, 
tanh, acos, asin, 
atan2. 

x Calculates the arc tangent of x; 
that is the value whose tangent is 
x. The return value is between - 
PI/2 and PI/2. 

atan (x) 

 See also: sin, cos, 
tan, asin, acos, 
atan, hypot. 

x , y Calculates the arc tangent of the 
two variables x and y. This 
function is useful to calculate the 
angle between two vectors. 

atan2 (x, y) 

 See also: floor, 
trunc, rint. 

x Round x up to the nearest integer. ceil (x) 

 See also: min, 
max. 

x , min , max Return x clamped to [min ... max]. clamp (x, 
min, max) 

 See also: min, 
max. 

x Return x clamped to [0.0 ... 1.0]. clamp (x) 

 See also: acos, 
sin, 
tan, cosh. 

x in radians Returns the cosine of x. cos (x) 

 See also: cos, 
acos, sinh, tanh. 

x Returns the hyperbolic cosine of x, 
which is defined mathematically as 
(exp(x) + exp(-x)) / 2. 

cosh (x) 

 See also: radians. optional: frame, defaults 
to current frame. 

Returns the y value of the 
animation curve at the given 
frame. 

curve (frame) 

 See also: radians. x Convert the angle x from radians 
into degrees. 

degrees (x) 

 See also: log, 
log10. 

x Returns the value of e (the base 
of natural logarithms) raised to 
the power of x. 

exp (x) 

 See also: 
mantissa, ldexp. 

x Exponent of x. exponent (x) 

 See also: noise, 
random, 
turbulence. 

x, y, z, octaves, 
lacunarity, gain 

Fractional Brownian Motion. This 
is the sum of octaves calls to 
noise(). For each of them the 
input point is multiplied by pow 
(lacunarity,i) and the result is 

fBm (x, y, z, 
octaves, 
lacunarity, 
gain) 
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multiplied by pow(gain,i). For 
normal use, lacunarity should be 
greater than 1 and gain should be 
less than 1. 

 See also: abs. x Returns the absolute value of the 
floating-point number x. 

fabs (x) 

 See also: true.  Always returns 0 false () 

 See also: ceil, 
trunc, rint. 

x Round x down to the nearest 
integer. 

floor (x) 

 See also: ceil, 
floor. 

x, y Computes the remainder of 
dividing x by y. The return value is 
x - n y, where n is the quotient of x 
/ y, rounded towards zero to an 
integer. 

fmod (x, y) 

 See also: x.  Return the current frame 
number. 

frame () 

 See also: 
to_sRGB, 
to_rec709f, 
from_ 
rec709f. 

color_ 
component 

Converts an sRGB pixel value to a 
linear value. 

from_byte 
(color 
component) 

 See also: form_ 
sRGB, 
to_rec709f. 

color_ 
component 

Converts a rec709 byte value to a 
linear brightness 

from_rec709f 
(color 
component) 

 See also: 
to_sRGB, 
to_rec709f, 
from_ 
rec709f. 

color_ 
component 

Converts an sRGB pixel value to a 
linear value. 

from_sRGB 
(color 
component) 

 See also: atan2. x, y Returns the sqrt(x*x + y*y). This is 
the length of the hypotenuse of a 
right-angle triangle with sides of 
length x and y. 

hypot (x, y) 

 See also: ceil, 
floor, trunc, rint. 

x Round x to the nearest integer 
not larger in absolute value. 

int (x) 

 See also: 
exponent. 

x, exp Returns the result of multiplying 
the floating-point number x by 2 
raised to the power exp. 

ldexp (x) 

 See also: step, 
smoothstep. 

a, b, x Returns a point on the line f(x) 
where f(0)==a and f(1)==b. 
Matches the lerp function in other 
shading languages. 

lerp (a, b, x) 

 See also: log10, 
exp. 

x Returns the natural logarithm of x. log (x) 

 See also: log, exp. x Returns the base-10 logarithm of 
x. 

log10 (x) 

 See also: 
mantissa, 
exponent. 

x Same as exponent(). logb (x) 

 See also: 
exponent. 

 Returns the normalized fraction. If 
the argument x is not zero, the 
normalized fraction is x times a 
power of two, and is always in the 
range 1/2 (inclusive) to 1 
(exclusive). If x is zero, then the 
normalized fraction is zero and 
exponent() Returns zero. 

mantissa (x) 

 See also: min, 
clamp. 

x, y, (...) Return the greatest of all values. max (x, y, ... ) 
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 See also: max, 
clamp. 

x, y, (...) Return the smallest of all values. min (x, y, ... ) 

 See also: step, 
smoothstep, lerp. 

a, b, x Same as lerp(). mix (a, b, x) 

 See also: random, 
fBm, turbulence. 

x, optional y, 
optional z 

Creates a 3D Perlin noise value. 
This produces a signed range 
centerd on zero. The absolute 
maximum range is from -1.0 to 
1.0. This produces zero at all 
integers, so you should rotate the 
coordinates somewhat (add a 
fraction of y and z to x, etc.) if you 
want to use this for random 
number generation. 

noise (x, y, z) 

   Returns the value for pi 
(3.141592654...). 

pi () 

 See also: log, exp, 
pow. 

x, y Returns the value for pi 
(3.141592654...). 

pow (x, y) 

 See also: pow. x, y Returns the value of x raised to 
the power of 2. 

pow2 (x) 

 See also: degrees. x Convert the angle x from degrees 
into radians. 

radians (x) 

 See also: noise, 
fBm, turbulence. 

optional x, 
optional y, 
optional z 

Creates a pseudo random value 
between 0 and 1. It always 
generates the same value for the 
same x, y and z. Calling random 
with no arguments creates a 
different value on every 
invocation. 

random (x, y, 
z) 

 See also: ceil, 
floor, int, trunc. 

x Round x to the nearest integer. rint (x) 

 See also: asin, 
cos, 
tan, sinh. 

x in radians Returns the sine of x. sin (x) 

 See also: sin, asin, 
cosh, tanh. 

x Returns the hyperbolic sine of x, 
which is defined mathematically as 
(exp(x) - exp(-x)) / 2. 

sinh (x) 

 See also: step, 
lerp. 

a, b, x Returns 0 if x is less than a, 
returns 1 if x is greater or equal to 
b, returns a smooth cubic 
interpolation otherwise. Matches 
the smoothstep function in other 
shading languages. 

smoothstep 
(a, 
b, x) 

 See also: pow, 
pow2. 

x Returns the non-negative square 
root of x. 

sqrt (x) 

 See also: 
smoothstep, lerp. 

a, x Returns 0 if x is less than a, 
returns 1 otherwise. Matches the 
step function other shading 
languages. 

step (a, x) 

 See also: atan, 
cos, sin, tanh, 
atan2. 

x in radians Returns the tangent of x. tan (x) 

 See also: tan, 
atan, 
sinh, cosh. 

x Returns the hyperbolic tangent of 
x, which is defined mathematically 
as sinh(x) / cosh(x). 

tanh (x) 

 See also: form_ 
sRGB, 
to_rec709f, 
from_rec709f. 

color_ 
component 

Converts a floating point pixel 
value to an 8-bit value that 
represents that number in sRGB 
space. 

to_byte 
(color 
component) 
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 See also: form_ 
sRGB, from_ 
rec709f. 

color_ 
component 

Converts a floating point pixel 
value to an 8-bit value that 
represents that brightness in the 
rec709 standard when that 
standard is mapped to the 0-255 
range. 

to_rec709f 
(color 
component) 

 See also: form_ 
sRGB, 
to_rec709f, 
from_rec709f. 

color_ 
component 

Converts a floating point pixel 
value to an 8-bit value that 
represents that number in sRGB 
space. 

to_sRGB 
(color 
component) 

  See also: false Always Returns 1. true () 

 See also: ceil, 
floor, int, rint. 

x Round x to the nearest integer 
not larger in absolute value. 

trunc (x) 

 See also: fBm, 
noise, random. 

x, y, z, octaves, 
lucanarity, gain 

This is the same as fBm() except 
the absolute value of the noise() 
function is used. 

turbulence 
(x, y, 
z, octaves, 
lucanarity, 
gain) 

 See also: y, curve. optional: frame, 
defaults to 
current frame. 

Evaluates the y value for an 
animation at the given frame. 

value (frame) 

 See also: frame.  Return the current frame 
number. 

x () 

 See also: value, 
curve. 

optional: frame, 
defaults to current 
frame. 

Evaluates the y value for an 
animation at the given frame. 

y (frame) 

 

 برنامه نویسیها میانِ زبان هايِ  Expressionبرگرداندن 

را به  Nukeهايِ  expressionرا به کار ببرید ، شاید ببینید که می خواهید ، براي نمونه ،  Expressionبسته به جایی که باید یک 

expression  ِهايTCL  ِیا کارکردهايِ جاسازي شده يPython  در یکexpression  ِبرنامه يNuke ِگوناگونِ برگردانید. در بخش هاي

Nuke  ِگوناگون به کار گرفته می شوند :، زبان هاي 

) و در اسکریپت Script )File > Comp Script Command، در فرمانِ  Script Editorرا در پنجره يِ  Pythonمی توانید  •

 ) به کار ببرید.menu.pyو  init.pyاجرا می شوند (مانند  Nukeهایی که در زمانِ آغازِ برنامه يِ 

• TCL  ِرا می توانید در بیش ترsting knob  ِها (جایی که تنها به جايِ شماره ها می توان نوشته را هم نوشت) ، در پنجره يِ گفت و گوي

Script Command )File > Comp Script Command براي باز کردن اسکریپت هايِ سازگار که در آغاز برنامه اجرا می ، (

 ) به کار بگیرید.format.tclو  init.pyشوند (مانند 

• Expression  ِهايNuke  ِرا می توانید در پنجره يِ گفت و گويAdd Expression  ِبا بیش ترknob  هایی که درNuke  هستند

 به کار ببرید. Expressionدر تکمه يِ  expressionو میدانِ وروديِ 

 با هم به کار بگیرید :ها  expressionکارکردهايِ زیر را می توانید براي انواعِ گوناگونِ 

• Nuke.expression()  براي به کار بردن یکexpression  درPython code. 

• Expression  براي به کار بردن یکexpression  ِاز برنامه يNuke  درTCL. 

• Nuke.tcl()  ِبراي اجرايTCL code  درPython. 
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• Python  ِبراي اجرايPython code  درTCL. 

 ).sting knob(یا یک  Nukeاز برنامه يِ  expressionجاسازي شده در یک  TCLبراي  [] •

• [python{…}]  برايPython  جاسازي شده در یکexpression  ِاز برنامه يNuke. 

جاسازي می کنید ،  TCL، در زمانی که آن را در  Python code) به دورِ {}به یاد داشته باشید که گذاشتنِ پرانتزها ( نکته :

 Pythonرا می گیرد و نمی گذارد پیش از رد کردن  TCLکن است روند کار را کمی آسان تر کند ؛ چون این کار جلويِ مم

code  به یکPython interpreter  ارزیابی هایی که از ،Python code  : انجام می دهد را اجرا کند. براي نمونه
[python{“hello”+”world”}] 

پیش فرض تنها یک خطّ از رمز را ارزیابی نموده و برآیند را برگشت  به طورِ TCLدر  ”python“رمانِ باید بدانید که ف نکته :

) را به کار ببرید. براي دانستن ”python-exec“(مانند :  ”exec-“می زند. اگر می خواهید چندین خطّ را اجرا کنید ، گزینه يِ 

 ) را بخوانید.Nuke )Help > Documentation > TCL Scriptingدر  TCLبیش تر در این باره ، راهنمايِ برنامه نویسیِ 
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 Pythonو  Script Editorپنجره يِ  ______________________

) ارائه می Python )Application Programming Interface – APIبا یک پنجره يِ برنامه نویسی فراگیر براي  Nukeبرنامه يِ 

 اجرا کنید. Pythonشود. به کمک این پنجره يِ کاربردي می توانید کارهایی که در پنجره يِ کاربري انجام می دهید را با زبانِ برنامه نویسی 

 یک آغازِ تنُد و سریع

 را شوند.بنویسید تا کارهایی که می خواهید انجام بدهید اج Script Editorرا در پنجره يِ  Pythonعبارت هايِ  .1

 در آن باشد. sys.pathدر پوشه اي ذخیره کنید که متغیرِ  py.اسکریپت تان را با گسترشِ  .2

 Nukeبرنامه يِ  Script Editorرا به درون پنجره يِ  py.پس از این ، زمانی که بخواهید همان سکانس را اجرا کنید ، پرونده يِ  .3

 ه اجرا در می آورد.عبارت ها را در چیدمان مشخص شده ب Nukeبیاورید. 

  اگر نیاز باشد که هر زمان در باره يِ کاربردPython  ِدر برنامه يNuke  ِبیش تر بدانید ، می توانید همیشه راهنمايNuke Python 

Developer )Help > Documentation.را بخوانید ( 

 بیاورید. third-party Python 2.7.3 interpreterرا می توانید به عنوان یک ماژول به درون یک  Nuke نکته :

 بر رويِ خطِّ فرمان اجرا کنید. nuke –tرا با دستورِ  interactive Pythonهم چنین می توانید یک جلسه يِ  نکته :

 Script Editorروشِ کار با پنجره يِ 

 Script Editorرا در پنجره يِ  Pythonکار نمی کنید ، می توانید اسکریپت هايِ  third-party Python interpreterاگر با یک 

 بنویسید.

 Script Editorپنجره يِ باز کردن 

کلیک  content، بر رويِ یکی از فهرست هايِ  Script Editorبراي باز کردن پنجره يِ 

 را برگزینید. Script Editorکنید و از فهرستی که باز می شود گزینه يِ 

 چهارچوب هايِ درون رفت و بیرون رفت

به دو بخش جدا شده است (نگاره يِ زیر را ببینید). در بخشِ پایینی  Script Editorپنجره يِ 

تان را می نویسید و اجرا می کنید ؛  Python) عبارتInput pane (چهارچوبِ درون رفت 

و هنگامی که کارتان را انجام دادید ، عبارت ها و بیرون رفت هايِ آن ها در بخشِ بالایی 

) نمایان می شوند. عبارت هایی که با Output pane(چهارچوبِ بیرون رفت  ویراستار

 دنبال می شوند.  )#( hashموفّقیت اجرا شوند با یک نشانه يِ 
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در بالايِ   Show output onlyیا  Show input onlyبراي پنهان کردن چهارچوبِ بیرون رفت یا درون رفت ، دکمه يِ 

 را کلیک کنید. Script Editorپنجره يِ 

 را کلیک کنید.  Show both input and outputاگر می خواهید دوباره هر دو چهارچوب به نمایش در آیند ، دکمه يِ 

 نوشتن یک عبارت

 بر رويِ چهارچوبِ درون رفت در پنجره يِ ویراستار کلیک کنید تا نشانگرِ ماوس در آن جا بنشیند. .1

) بر رويِ ویراستار راست pasteو  copyعبارت تان را بنویسید. اگر می خواهید کارکردهايِ ویرایشی معمول را به کار ببرید (مانند  .2

 کلیک کنید و کارکرد دلخواه تان را برگزینید.

) به importو  Print(مانند  باشد Pythonواژه هايِ  هر واژه اي که از کلید می نویسید ، توجه داشته باشیدرا  یزمانی که دارید عبارت

 رنگ  د) به) جا می گیرquotation mark( نشانِ نقلِ قول ها (معمولاً هر چیزي که در stringد ؛ ولی رنگ سبز نشان داده می شو

 .به نمایش گذاشته می شوندها با رنگ زرد  Comment ، وقرمز یا فیروزه اي 

 

تغییر  Preferencesاز پنجره يِ گفت و گويِ  Script Editorو فونت را در برگه يِ اگر دوست داشته باشید ، می توانید این رنگ ها 

 را فشار بدهید. Shift+Sکلید هايِ  Preferences. براي باز کردن پنجره يِ گفت و گويِ بدهید

را براي کمک به کار بگیرید. نوشتن یک  auto-completeگزینه يِ  Pythonعبارت هايِ می توانید در نوشتنِ  نکته :

 فرمان را آغاز کنید و کلیدTab  ، را فشار بدهید. اگر تنها یک راه براي تمام کردن فرمان تان باشدNuke  آن را یکراست

یک فهرست  Nuke می کند. ولی اگر چندین راه ممکن براي تکمیل وجود داشته باشد ، auto-completeو بی درنگ 

پایین افتادنی را به شما نشان می دهد که همه يِ آن راه ها را در آن فهرست کرده است. اگر هیچ راه شناخته شده اي براي 

کامل کردن فرمان تان نباشد ، هیچ چیزي رخ نمی دهد. حتا اگر فرمان تان خود به خود هم تکمیل شود ، خود به خود به 

 اجرا در نمی آید.

را  Returnعبارت تان چندین خطّ داشته باشد ، یا بخواهید چندین عبارت را به یک بار بنویسید ، براي رفتن به خطِّ بعدي کلید  اگر .3

 بزنید.
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را  Ctrl+Returnدر بالايِ ویراستار کلیک کنید ، یا  Run the current scriptبراي اجرا شدن یک عبارت ، بر رويِ دکمه يِ  .4

 فشار بدهید.

 بر رويِ صفحه کلید شماره دار ، عبارت ها را اجرا کنید. Ctrl+Enterهم چنین می توانید با فشار دادن : نکته 

به طورِ پیش فرض ، عبارت هايِ موفقّ از چهارچوبِ درون رفت ناپدید شده ، و در چهارچوبِ بیرون رفت نمایان می شوند. به هر روي ، اگر 

 از این که اجرا شدند در چهارچوبِ درون رفت بمانند ، می توانید کارهايِ زیر را انجام بدهید : پسمی خواهید همه يِ عبارت ها 

 باز شود. Preferencesتا پنجره يِ گفت و گويِ را فشار بدهید  Shift+Sکلیدهايِ  .1

 بروید. Script Editorبه برگه يِ  .2

 را بردارید. clear input window on successful script executionنشانِ گزینه يِ  .3

 Preferenceرا بزنید تا  Save prefsتنها براي پروژه يِ جاري ذخیره شود ؛ یا دکمه يِ  preferenceکلیک کنید تا  Closeبر رويِ  .4

 براي پروژه يِ جاري و پروژه هايِ بعدي در آینده ذخیره شود.

ایجاد می کند ، و عبارتScript Editor  یرون رفت در پنجره يِ یک خطا را در چهارچوبِ ب Nukeاگر یک عبارت نادرستی را بنویسید ، 

 نادرست در همان چهارچوبِ درون رفت می ماند. عبارت را درست کنید و آن را دوباره اجرا کنید تا به برآیندي درستی برسید.

بچسبانید (مانند  Script Editorدیگري رونوشت گرفته و به درونِ پنجره يِ  از منبعِ گاهی اگر عبارت ها را یادداشت :

رت را از آن جا منبعی است که عبا encodingیا  mark-upبه سببِ ) ، ممکن است به یک خطا برسید. این E-Mailیک 

 براي درست کردن این مشکل ، عبارت را دوباره دستی بنویسید. رونوشت گرفته اید.

داشته باشید ، پنجره يِ گفت  Script Editorبیرون رفت پنجره يِ در چهارچوبِ  شده را ااجر Pythonاگر می خواهید همه يِ فرمان هايِ 

 echo all commandsبروید ، و گزینه يِ  Script Editorرا فشار بدهید) ؛ به برگه يِ  Shift+Sرا باز کنید ( Preferencesو گويِ 

to output window  .برنامه يِآن هایی که با  هم و م فرمان هایی که خودتان اجرا بکنید، ه این گزینه را که نشان بزنیدرا نشان بزنید 

Nuke براي نمونه ، اگر تکمه اي از نوار ابزار را برگزینید ، فرمانِ  .اجرا می شوند ، تاثیر می گیرندPython  در که مربوط به آن است

لی وچهارچوبِ بیرون رفت نشان داده می شود. این کار به همه يِ کارکردهایی که در پنجره يِ کاربري گرافیکی انجام می دهید داده نمی شود ، 

 انجام می گیرند. Pythonتنها به آن هایی داده می شود که با اجرايِ فرمان هايِ برنامه نویسیِ 

ا شود ، اسکریپت را در چهارچوبِ درون رفت بنویسید و بخشی که می خواهید اجرا شود را برگزینید. براي آن که تنها بخشی از اسکریپت اجر

بخشی از اسکریپت که برگزیده شده است را اجرا می کند و اسکریپت دیگر در  Nukeرا فشار بدهید. برنامه يِ  Ctrl+Returnکلیدهايِ 

 چهارچوبِ درون رفت به جا می ماند.

در بالايِ ویراستار کلیک کنید تا به عبارت پیشین برگردد.   Previous Scriptیک عبارت تکرار شود ، بر رويِ دکمه يِ  اگر می خواهید

 این کار را هم چنان ادامه بدهید تا به عبارتی برسید که می خواهید تکرار شود. براي این که عبارت دوباره اجرا گردد ، کلیدCtrl+Return 

 را فشار بدهید.

 را فشار بدهید. Shift+Tab، و براي کاهشِ آن کلیدهايِ  Tab) در پنجره يِ درون رفت ، کلیدIndentation براي افزایشِ دندانه گذاري (

 گشت و گذاري در تاریخچه يِ اسکریپت و پاك کردنِ آن
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 Nextین می توانید به جلو هم بروید. دکمه يِ در تاریخچه يِ اسکریپت تان گام به گام به عقب برگردید ، هم چنبه جز این که می توانید 

script  .را فشار بدهید تا در میانِ عبارت هایتان به جلو بروید 

 کلیک کنید.  Clear Historyبراي پاك کردن تاریخچه ، بر رويِ دکمه يِ 

 پاك کردن چهارچوبِ بیرون رفت

 را فشار بدهید. Ctrl+Backspaceرا کلیک کنید. به جايِ این کار می توانید کلیدهايِ   Clear output windowدکمه يِ 

 )Automateروش هايِ خودکارسازي (

را در آن بنویسید. ولی تا  Pythonرا به کار بگیرید و سکانسی از عبارت هايِ  Script Editorخوب ، اکنون می دانید که چگونه پنجره يِ 

با رایانه تان می نوشتید. اکنون زمان است که روش را خودکار کنید. همه يِ آن چه که باید انجام بدهید این است که  این جا ، عبارت ها را

بیاورید  Script Editorعبارت ها را ذخیره کنید ؛ و هر زمان که خواستید آن ها را دوباره به کار بگیرید ، آن ها را به درونِ پنجره يِ 

)import.( 

 Pythonعبارت ها در یک ماژولِ ذخیره کردن 

 کلیک کنید.  Save a script، بر رويِ دکمه يِ  Script Editorدر بالايِ پنجره يِ  .1

را دارید. (اگر می  sys.pathره کنید که در آن متغیرِ ی) در پوشه اي ذخfirstmodule.py(براي نمونه ،  py.اسکریپت را با گسترشِ  .2

بنویسید. اگر می خواهید پوشه اي را به متغیرِ  Script Editorرا در پنجره يِ  print sys.pathخواهید این پوشه ها را ببینید ، 

sys.path  ، بیافزاییدsys.path.append (“directory”)  .را بنویسیدdirectory  نشان دهنده يِ پوشه اي است که می خواهید

 ایید).بیافز

 تان را ساختید. Pythonاکنون نخستین ماژولِ 

 باز کردن یک اسکریپتPython  ِدر پنجره يScript Editor 

باز  Script to openکلیک کنید. پنجره يِ گفت و گويِ  Script Editorدر بالايِ پنجره يِ   Load a scriptبر رويِ دکمه يِ  .1

 می شود.

 را بزنید. Openروید. این ماژول دارايِ اسکریپتی است که می خواهید آن را باز کنید. دکمه يِ است ب Pythonبه جایی که ماژولِ  .2

Nuke  ِاسکریپت را در چهارچوبِ پنجره يScript Editor .باز می کند ، ولی آن را اجرا نمی کند 

 آوردن یک اسکریپتPython به درون برنامه و اجرا کردن آن 

باز  Script to openرا کلیک کنید. پنجره يِ گفت و گويِ   Source a script، دکمه يِ  Script Editorدر بالايِ پنجره يِ  .1

 می شود.
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 را بزنید. Openاست بروید. این ماژول دارايِ اسکریپتی است که می خواهید آن را باز کنید. دکمه يِ  Pythonبه جایی که ماژولِ  .2

 یا

 Import moduleدر چهارچوبِ درون رفت این عبارت را بنویسید : 

module  ِنشان دهنده يِ نامِ ماژولPython  : تان ، بدون گسترشِ پرونده است. براي نمونهImport firstmodule 

Nuke  ِماژولPython .را به درون برنامه آورده و روشی که در ماژول تعریف شده است را انجام می دهد 

انجام می شود. به هنگام  Pythonبر مبنايِ قوانینِ پیش فرضِ  Nukeآورده شدن ماژول ها به درون برنامه يِ  دداشت :یا

 آوردن یک ماژول ، آن ماژول به ترتیب در جاهايِ زیر جست و جو می شود :

 در پوشه يِ جاري. .1

شده باشد ، در پوشه هایی که شاملِ این متغیرِ محیطی هستند (اگر می خواهید  تعریفPYTHONPATH اگر متغیرِ محیطیِ  .2

 را بنویسید). echo $PYTHONPATHعبارتCommand Shell  این پوشه ها را ببینید ، در یک 

 در یک پوشه يِ پیش فرض که وابسته به نصبِ برنامه است. .3

 sys.pathها راه اندازي می شود. سپس ماژول ها در پوشه هایی که با متغیرِ از این پوشه  sys.pathبه هنگامِ جست و جو ، متغیرِ 

 فهرست شده اند جست و جو می شود. اگر می خواهید این پوشه ها را ببینید ، عبارتprint sys.path  ِرا در پنجره يScript 

Editor .بنویسید 

Nuke  ِبه عنوان یک ماژولPython 

بیاورید. در این نرم افزار می توانید به  third-party Python 2.7.3 interpreterرا به مانند یک ماژول به درون یک  Nukeمی توانید 

 دسترسیِ کامل داشته باشید. Nukeبرنامه يِ  Python-APIهمه يِ 

 ها پشتیبانی فراهم کند. third-party Python interpreterنمی تواند براي  The Foundaryشرکت  یادداشت :

 : Pythonبه مانند یک ماژولِ  Nukeبراي به اجرا در آوردن 

 Pythonدر نرم افزارِ نصب شده يِ  usrlocal.pthبه پرونده يِ  Nukeبرنامه يِ  site-packagesمسیرِ پرونده اي را براي پوشه يِ  .1

 C:\Program Files\Nukeاجرا می کنید ، مسیرِ  Windowsسیستمِ عاملِ بیافزایید. براي نمونه ، اگر دارید برنامه را بر رويِ  2.7.3

9.0v4\lib\site-packages  ِرا به پرونده يusrlocal.pth .بیافزایید 

 است. usrlocal.pthهم چنین می توانید مسیرهايِ نسبی را براي پوشه اي به کار بگیرید که شاملِ پرونده يِ  نکته :

(مانند  Nukeبرنامه يِ  Script Editorرا به کار ببرید. فرمان ها و کارکردهايِ  import nukeرت ، عبا Python Promptدر  .2

nuke.nodes.Blur()  ِکه براي افزودن یک تکمه يBlur  است) درPython interpreter .نصب شده تان موجود می شوند 

 کارکردimport nuke  ِزبه طورِ پیش فرض به مجوnuke_r render  نگاه می کند. اگر بخواهیدNuke  را به شکلِ محاوره ايِ آن

 بگذارید. 1را بر رويِ  NUKE_INTERACTIVEهم داشته باشید ، متغیرِ محیطیِ   nuke_iبه کار ببرید ، و یک مجوزِ 

 Help > Documentationامه ، از نوارِ فهرست برن Pythonبه مانند یک ماژولِ  Nukeبراي دانستن بیش تر در باره يِ به کار بردن 

 بروید. Python Developers Guide > Nuke as a Python Moduleرا برگزینید و به 
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 Pythonراهنمايِ 

 در این راهنمايِ کاربري مجالِ آن نیست که به همه يِ جزئیاتPython  رِ اسکریپت هايِ آن بپردازیم. براي همین در زیر راه هایی برايو متغی

 به تر و بیش تر دست بیابید.می خواهید بدانید  Pythonبه آن چه که در باره يبتوانید ا آورده ایم که دسترسی شم

 خواندنِ نوشته هايِ بیش تر

و نمونه هايِ آن ، و راه هايِ به کار بردن آن براي هدف هايِ  Pythonمی توانید به هر چه در باره يِ  Python Developerدر راهنمايِ 

 Help > Documentation > Python Developers Guideدست بیابید.   Nukeر برنامه يِ گوناگون د

 بروید. Help > Documentation > PythonScriptingReferenceرا بخوانید ، به  Python APIاگر می خواهید راهنمايِ 

 دیدن نمونه هايِ بیش تر

 : Windowsدر سیستمِ عاملِ  •

drive letter:\Program Files\Nuke9.0v4\plugins\nukescripts or 
drive letter:\Program Files (x86)\Nuke9.0v4\plugins\nukescripts 

 : Mac OSXدر سیستمِ عاملِ  •

/Applications/Nuke9.0v4/Nuke9.0v4.app/Contents/MacOS/plugins/nukescripts 
 : Linuxدر سیستمِ عاملِ  •

/usr/local/Nuke9.0v4/plugins/nukescripts 

 به کار بردن عبارتHelp 

 باشد : Script Editorشاید سریع ترین راه براي دسترسی به راهنمایی از فرمان هايِ موجود ، نوشتن عبارت زیر در پنجره يِ 

Help (nuke) 

 را با چیدمانِ الفبایی ، و شرحی در باره يِ آن ها فهرست می کند. Pythonاین عبارت همه يِ فرمان هايِ 

 :نشان می دهد را به شما  ()setValue. براي نمونه ، عبارت زیر شرحی از روشِ بگیریددر چیزهايِ ویژه تر نیز می توانید راهنما 

Help (nuke.Knob.setValue) 

Python بر رويِ شبکه 

 ./Python  :http://www.python.orgنویسیِ وب سایت رسمیِ زبانِ برنامه 


	Spatial  فیلترگذاري و جلوه هاي
	Convolve به کار بردن تکمه هاي
	Depth-of-Field همانند سازي محوشدگیِ
	یک آغاز تنُد و سریع
	ZDefocus چسباندن تکمه ي
	Blur میزان کردن پیکربندي هاي
	Highlight میزان کردن شکل هایی که بیرون از فوکوس هستند
	Disc روش به کار بردن یک نگاره ي از پیش تعریف شده
	روشِ به کار بردن یک نگاره يِ تیغه اي از پیش تعریف شده
	روشِ به کار بردن یک نگاره يِ فیلتر سفارشی

	highlight  بالا بردن شدت هایی که بیرون از فوکوس هستند
	blur ماسک کردن جلوه ي

	ساختنِ افکت ها
	یک آغاز تنُد و سریع
	بازتاب هايِ پس زمینه بر رويِ عناصرِ پس زمینه
	LightWrap روشِ به کار بردنِ تکمه يِ

	Highlight ساختنِ جلوه هايِ ستاره اي شکل بر روي هاي نگاره
	Glint روشِ به کار بردنِ تکمه يِ

	ساخت نوشته بر روي فیلم و نگاره
	نمونه اي از متغیرها و نهادها

	فونت ها و ویژه گی هايِ آن ها
	برگزیدنِ یک فونت
	میزان کردن اندازه و فضابنديِ فونت
	تراز کردن فونت ها

	Font Cache به روز رسانی
	تغییر شکل دادن نوشته
	تغییر شکل دادن نوشته هایی که برگزیده اید
	تغییر شکل دادن گروه ها
	پویانمایی کردن تغییر شکل ها
	تغییر دادن رنگ نوشته
	ماسک کردن بخش هایی از نمایشگر
	افزودن سایه ها

	افزودن یک سایه يِ پشت

	آنالیز و با هم جور کردن کلیپ ها
	پیشگفتار
	برش زدن لبه هايِ سیاه
	آنالیز کردن شدت یک سکانس فریم
	برداشتن پِرپِر زدن ها
	آنالیز کردن اختلاف هايِ نوردهی
	ردیابی کردن روشن ترین و تاریک ترین پیکسل ها

	3D  ترکیب بندي
	یک مرور کوتاه
	راه اندازي یک صحنه
	Scene تکمه يِ
	ScanlineRender تکمه يِ
	Camera تکمه يِ

	3D به کار بردن نمایشگر
	3D اشیاء هندسی صحنه ي
	Nuke به کار بردن اشیاء نخستینی که در برنامه ي جاسازي شده اند
	Nuke ها از برنامه هايِ دیگر به درون Point Cloud آوردنِ اشیاء هندسی و
	Scratch ها و اشیاء هندسی از Point Cloud ساختن
	DepthToPosition به کمک تکمه ي Position Pass ساختن یک
	PositionToPoints به کمک تکمه ي Dense Point Cloud ساختن یک
	DepthToPoints به کمک تکمه ي Point Cloud ساختن یک
	ویژه گی هاي نمایشی شیء
	3D Selection ابزارهاي
	3D Selection 3 با D  جفت و جور کردن جایگاه ، جهت گیري ، و اندازه يِ یک
	Merge) با هم یکی کردن ) اشیاء
	Modify) پیراستن ) شکلِ اشیاء
	EditGeo پیرایش کردن اشیاء به کمک تکمه يِ
	پیرایش کردن اشیاء به کمک نمودارهايِ تبدیل ارزش
	پیرایش کردن اشیاء به کمک کارکرد توان
	پیرایش کردن اشیاء به کمک یک نگاره – روش
	پیرایش کردن اشیاء به کمک یک نگاره – روش
	Perlin Noise  پیراستنِ اشیاء به کمک یک کارکر
	Distortion  پیراستنِ اشیاء به کمک یک کارکر
	Trilinear پیراستنِ اشیاء به کمک یک درون یابی

	مایه ها و بافت ها
	ویژه گی هايِ مایه يِ رويِ اشیاء
	ApplyMaterial دادن یک مایه به شیء به کمک تکمه ي
	Diffuse  میزان کردن رنگ
	Specular هاي Highlight میزان کردن
	همانند سازيِ مایه هایی که نور می پراکنند
	Emission و ، Specular ، Diffuse میزان کردن به کمک تنها یک تکمه
	همانند سازيِ رویه هايِ هموار و یکدست
	پردازش یک پوشاننده يِ قاب سیمی بر رويِ شیء هندسی تان
	Shader یکی کردن دو تکمه ي با هم
	آمیختن یک مایه با اشیاء پشتی
	جایگزین کردن کانال هايِ مایه با یک رنگ پایدار
	انداختن بافت ها بر رويِ اشیاء
	UVProject انداختنِ بافت ها بر رويِ اشیاء به کمک تکمه ي
	Project3D انداختنِ بافت ها بر رويِ اشیاء به کمک تکمه ي
	UDIM Patch آوردن ها به درون برنامه

	نورپردازي
	جاي گذاري نورها
	Direct جاي گذاري نورهاي
	جاي گذاريِ نورهايِ نقطه اي
	Spot جاي گذاري نورهاي
	جاي گذاري نورهاي محیطی
	Spot یا نورهايِ ، Point نورهايِ ، Direct جاي گذاري نورهاي
	Nuke به درون برنامه ي FBX آوردن نورها از پرونده هاي
	سایه اندازي
	کار با نُرمال هايِ یک شیء
	3D 2 با نورهايِ D نورپردازي دوباره ي یک نگاره ي

	دوربین ها
	روشِ کار با دوربین ها
	Interactive 3D Camera روش کار با الگوي نمایشی
	روش ویرایش کردن ویژه گی هايِ لنزِ یک دوربین
	Look  کار با درگاه درون رف
	Projection دوربین هاي
	نخست کمی به ریاضی بپردازیم
	Projection Camera Script راه اندازي کردن
	FBX آوردن دوربین ها از پرونده هايِ
	Nuke به درون برنامه يِ .fbx آوردن دوربین ها از یک پرونده ي
	Nuke به درون برنامه يِ Alembic آوردن دوربین ها از پرونده هايِ
	Boujou آوردن دوربین ها از برنامه ي

	تغییر شکل دادن هندسه ي اشیاء ، دوربین ها ، و نورها
	Transform کار با دستگیره هاي
	properties تغییر شکل دادن اشیاء از قابِ تکمه
	تغییر شکل ها و نقطه يِ لولا
	Axis  ایجاد ساختار پدري به اشیاء
	Track به کار بردن ها به یک شیء
	FBX ها از پرونده هاي transform آوردن
	Alembic ها از پرونده هاي Transform آوردن

	3D به یک صحنه ي Motion Blur افزودنِ
	Point Cloud یا ، Axes ، بیرون فرستادن اشیاء هندسی ، دوربین ها ، نورها ها
	3D پردازشِ یک صحنه يِ

	پروژه هایِ stereoscopic
	یک آغاز تنُد و سریع
	script راه اندازي کردن نماها براي
	بارگذاريِ نگاره هايِ چند نمایی
	ترکیب کردن نماهايِ گوناگون در یک بیرون رفت ، هنگامی که نماها در نام هاي پرونده نشانده نشده اند

	به نمایش گذاشتن نماها در پنجره يِ نمایشگر
	برگزیدن نماهایی که می خواهید به آن ها تغییرات بدهید
	جدا کردن نماها
	RotoPaint برگزیدن یک نما براي آماده سازي ، زمانی که دارید با تکمه يِ کار می کنید

	انجام دادن کارکردهاي گوناگون بر روي نماهاي گوناگون
	بیرون کشیدن یک نما براي کارپردازي

	تکثیر دادن تغییراتی که به یک نما داده اید
	Y و X تکثیر کردن ارزش هاي

	عوض کردن جايِ نماها
	برگرداندن نگاره ها به آناگلیف
	تغییر دادنِ همگرایی
	پیش نمایشِ نگاره هايِ استریوسکوپیک
	کردن نگاره هاي استریویی Flipbook

	پردازش کردن نگاره هايِ استریوسکوپیک

	ترکیب بنديِ عمقی
	در باره يِ ترکیب بنديِ عمقی
	یک آغاز تنُد و سریع
	خواندنِ فیلم و ویدئويِ عمق دار
	ساختنِ داده هايِ عمقی
	برگرداندنِ یک سکانسِ تصویري به یک فریمِ عمق دار ، به کمک فریم هايِ درون رفت
	برگرداندنِ یک نگاره ي 2Dبه یک نگاره ي عمق دار
	Depth دوباره رنگ زدن داده ي
	براي درست کردن داده يِ عمق ScanlineRender

	Deep به نمایش گذاشتنِ داده يِ ژرفا در نمودار
	با هم یکی کردن نگاره هايِ عمق دار
	Holdout ساختن ها
	DeepHoldout تخت شده با تکمه ي holdout ساختن یک
	DeepMerge با تکمه ي Deep Holdout ساختن یک

	3D 2 و D ساختن عناصر از نگاره هايِ عمق دار
	2D ساختنِ یک نگاره ي از یک نگاره يِ عمق دار
	از یک نگاره ي عمق دار Point Cloud ساختن یک

	پیرایش کردن داده يِ عمق
	درست کردن رنگ نگاره هايِ عمق دار
	Expression پیرایش کردن نگاره هاي عمق دار با ها

	برش زدن ، تغییر دادن فُرمت ، و تغییر شکل دادن نگاره هايِ عمق دار
	برش زدن نگاره هايِ عمق دار
	تغییر دادن فُرمت نگاره هاي عمق دار
	تغییر شکل دادن نمونه هاي عمقی

	نمونه گیري نگاره هايِ عمق دار
	نوشتنِ داده يِ عمقی

	روشِ کار با فراداده هايِ پرونده
	Nuke فراداده ها در برنامه ي
	دیدن یک فراداده
	سنجشِ فراداده هايِ میانِ درون رفت ها
	پیرایش کردن فراداده ها
	رونوشت برداري کردن فراداده اي از یک درون رفت به درون رفت دیگر و پالایش کردن فراداده
	Time Code افزودنِ یک به فراداده
	پردازش کردن یک فراداده
	TCL هايِ Expression  دسترسی به فراداده ي پرونده به کمک
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